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About the Documentation

IN THIS SECTION

Documentation and Release Notes | xlv
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Documentation Feedback | xlviii
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Use this guide to understand the Junos Space Security Director application - the next generation security
management platform - its capabilities, and features.

Documentation and Release Notes

To obtain the most current version of all Juniper Networks® technical documentation, see the product
documentation page on the Juniper Networks website at https://www.juniper.net/documentation/.

If the information in the latest release notes differs from the information in the documentation, follow the
product Release Notes.

Juniper Networks Books publishes books by Juniper Networks engineers and subject matter experts.
These books go beyond the technical documentation to explore the nuances of network architecture,
deployment, and administration. The current list can be viewed at https://www.juniper.net/books.

Documentation Conventions

Table 1 on page xlvi defines notice icons used in this guide.
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Table 1: Notice Icons

DescriptionMeaningIcon

Indicates important features or instructions.Informational note

Indicates a situation that might result in loss of data or hardware
damage.

Caution

Alerts you to the risk of personal injury or death.Warning

Alerts you to the risk of personal injury from a laser.Laser warning

Indicates helpful information.Tip

Alerts you to a recommended use or implementation.Best practice

Table 2 on page xlvi defines the text and syntax conventions used in this guide.

Table 2: Text and Syntax Conventions

ExamplesDescriptionConvention

To enter configuration mode, type
the configure command:

user@host> configure

Represents text that you type.Bold text like this

user@host> show chassis alarms

No alarms currently active

Represents output that appears on
the terminal screen.

Fixed-width text like this

• A policy term is a named structure
that defines match conditions and
actions.

• Junos OS CLI User Guide

• RFC 1997, BGP Communities
Attribute

• Introduces or emphasizes important
new terms.

• Identifies guide names.

• Identifies RFC and Internet draft
titles.

Italic text like this
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Table 2: Text and Syntax Conventions (continued)

ExamplesDescriptionConvention

Configure the machine’s domain
name:

[edit]
root@# set system domain-name
domain-name

Represents variables (options for
which you substitute a value) in
commands or configuration
statements.

Italic text like this

• To configure a stub area, include
the stub statement at the [edit
protocols ospf area area-id]
hierarchy level.

• The console port is labeled
CONSOLE.

Represents names of configuration
statements, commands, files, and
directories; configuration hierarchy
levels; or labels on routing platform
components.

Text like this

stub <default-metric metric>;Encloses optional keywords or
variables.

< > (angle brackets)

broadcast | multicast

(string1 | string2 | string3)

Indicates a choice between the
mutually exclusive keywords or
variables on either side of the symbol.
The set of choices is often enclosed
in parentheses for clarity.

| (pipe symbol)

rsvp { # Required for dynamic MPLS
only

Indicates a comment specified on the
same line as the configuration
statement to which it applies.

# (pound sign)

community name members [
community-ids ]

Encloses a variable for which you can
substitute one or more values.

[ ] (square brackets)

[edit]
routing-options {
static {
route default {
nexthop address;
retain;

}
}

}

Identifies a level in the configuration
hierarchy.

Indention and braces ( { } )

Identifies a leaf statement at a
configuration hierarchy level.

; (semicolon)

GUI Conventions
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Table 2: Text and Syntax Conventions (continued)

ExamplesDescriptionConvention

• In the Logical Interfaces box, select
All Interfaces.

• To cancel the configuration, click
Cancel.

Represents graphical user interface
(GUI) items you click or select.

Bold text like this

In the configuration editor hierarchy,
select Protocols>Ospf.

Separates levels in a hierarchy of
menu selections.

> (bold right angle bracket)

Documentation Feedback

We encourage you to provide feedback so that we can improve our documentation. You can use either
of the following methods:

• Online feedback system—Click TechLibrary Feedback, on the lower right of any page on the Juniper
Networks TechLibrary site, and do one of the following:

• Click the thumbs-up icon if the information on the page was helpful to you.

• Click the thumbs-down icon if the information on the page was not helpful to you or if you have
suggestions for improvement, and use the pop-up form to provide feedback.

• E-mail—Send your comments to techpubs-comments@juniper.net. Include the document or topic name,
URL or page number, and software version (if applicable).

Requesting Technical Support

Technical product support is available through the Juniper Networks Technical Assistance Center (JTAC).
If you are a customer with an active Juniper Care or Partner Support Services support contract, or are
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covered under warranty, and need post-sales technical support, you can access our tools and resources
online or open a case with JTAC.

• JTAC policies—For a complete understanding of our JTAC procedures and policies, review the JTACUser
Guide located at https://www.juniper.net/us/en/local/pdf/resource-guides/7100059-en.pdf.

• Productwarranties—For productwarranty information, visit https://www.juniper.net/support/warranty/.

• JTAC hours of operation—The JTAC centers have resources available 24 hours a day, 7 days a week,
365 days a year.

Self-Help Online Tools and Resources

For quick and easy problem resolution, Juniper Networks has designed an online self-service portal called
the Customer Support Center (CSC) that provides you with the following features:

• Find CSC offerings: https://www.juniper.net/customers/support/

• Search for known bugs: https://prsearch.juniper.net/

• Find product documentation: https://www.juniper.net/documentation/

• Find solutions and answer questions using our Knowledge Base: https://kb.juniper.net/

• Download the latest versions of software and review release notes:
https://www.juniper.net/customers/csc/software/

• Search technical bulletins for relevant hardware and software notifications:
https://kb.juniper.net/InfoCenter/

• Join and participate in the Juniper Networks Community Forum:
https://www.juniper.net/company/communities/

• Create a service request online: https://myjuniper.juniper.net

To verify service entitlement by product serial number, use our Serial Number Entitlement (SNE) Tool:
https://entitlementsearch.juniper.net/entitlementsearch/

Creating a Service Request with JTAC

You can create a service request with JTAC on the Web or by telephone.

• Visit https://myjuniper.juniper.net.

• Call 1-888-314-JTAC (1-888-314-5822 toll-free in the USA, Canada, and Mexico).

For international or direct-dial options in countries without toll-free numbers, see
https://support.juniper.net/support/requesting-support/.
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Junos Space Security Director Overview

Security Director is a Junos Space management application designed to enable quick, consistent, and
accurate creation, maintenance, and application of network security policies. It features an intuitive GUI
that provides isolation from the underlying Junos Space Platform, allowing security architects, analysts,
and security operators to focus on their jobs. Security Director provides visibility, simplified management,
and actionable security intelligence for applications, users, IP addresses, and threats that help network
managers make informed security decisions.

Security Director presents the security-focused administrator with a tabbed interface: The tabs across the
top of the GUI provide workspaces in which an administrator can perform specific tasks. Table 3 on page 2
shows the names of the tabs along with brief descriptions of what is accessible in that workspace.

Table 3: Tabs and Their Functionality

AccessesTab Name

Graphical security widgets that can be added, removed, and rearranged on a per user
basis. These widgets offer each user a customized view of network security.

Dashboard

Live threat maps and visual analysis of:

• Events received

• User activity

• Alerts and alarms

Monitor

Device discovery and device management.Devices
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Table 3: Tabs and Their Functionality (continued)

AccessesTab Name

Security-related management including:

• Firewall policies

• IPS policies

• NAT policies

• UTM policies

• VPN creation and management

• Shared object management

Configure

Predefined security reports and the ability to create custom reports.Reports

User and role management, logging management, and infrastructure management.Administration

Benefits of Junos Space Security Director

• Offers a single centralized management interface that enables administrators to manage all phases of
the security policy life cycle—stateful firewall, unified threat management (UTM), intrusion prevention,
application firewall (AppFW), VPN, and NAT.

• Provides a simple user interface that enables new users to quickly become proficient.

• Automates the deployment of the most recent policy updates through the Policy Enforcer feature. The
risk of compromise and human error is reduced as network administrators are able to wok with a simple
and concise rule set.

• Enables effective threat management while producing detailed data access and user activity reports. An
action-oriented design enables the network administrator to detect threats across the network as they
occur, quickly block the traffic going to or coming from a specific region, and apply immediate remedial
action with a single click.

• Enables administrators to assess the effectiveness of each firewall rule and quickly identify the unused
rules, which results in better management of the firewall environment.

• Simplifies policy creation andmaintenanceworkflows throughmetadata-based policies, and streamlines
threat remediation workflows through dynamic policy actions.

• Offers a seamless search function when correlating petabytes of data across hundreds of nodes.

3



Access and Log in

If you are working in the Junos Space Platform, you can access Security Director by selecting Security
Director from the Applications drop-down list at the upper left corner of the Space GUI, as shown on the
left side of Figure 1 on page 4.

Figure 1: Security Director Access and Log in

After you log out of the Security Director GUI (or the login timer expires while in Security Director), the
next time you log in the Security Director login screen will appear, as shown on the right side of
Figure 1 on page 4. Once you use the Security Director login screen, that will remain your default login
location unless and until you navigate to the Space Platform URL or return to the Space Platform GUI and
either log out from there or let the login timer expire.

When the Security Director application is accessed for the first time, a getting started guide will overlay
the Security Director Dashboard page. The guide is designed to assist new and longtime users by providing
a quick reference to where functions are located within the new GUI. The guide can be dismissed for
subsequent logins and accessed later through the help button on the right side of the banner.

Using Navigational Elements

For a more personal, helpful, and customizable user experience, Juniper Networks has provided some aids
within the GUI. Table 2 shows a sample of navigation, customization, and help icons.
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Table 4: Navigational Elements

LocationIconElement

Upper left part of main screen below the
Monitor tab. Not visible on the Dashboard.

Breadcrumbs—Trace your location in theGUI. The breadcrumbs
provide a path back to one of the six starting tabs: Dashboard,
Monitor, Devices, Configure, Reports, and Administration.

Various places around the GUI.Info Tips—Hover your mouse over any available question mark
icon for quick pop-up guidance.

Left side of tab bar, below the Juniper
Networks logo.

Show and Hide Left-Nav—Click the hamburger icon to show or
hide the left-nav section.

Upper right corner of some tabular display
windows such as the Reports tab and
Devices tab.

ShowHide Columns—In tabular displays, you can choosewhich
columns are visible by clicking the icon and then selecting the
check boxes on the menu.

Upper right corner of tabular views. Next to
the Show Hide Columns icon.

Table Search—You can click this magnifying glass icon, within
large tabular views, to search for specific text within any of the
visible fields in the display.

Banner Overview

The dark gray bar at the top of the screen is called the Banner. It provides access to system-wide utilities
such as a link back to Junos Space Platform, a global search utility, a domain switcher, a notification center,
a profile management access menu, and a help button.

Figure 2: Banner

Junos Space Platform Link

Figure 3: Junos Space Platform Link

The GUI for Security Director is designed to enhance security focus. Therefore, for administration or other
tasks that are not security related, youwill need away to switch back to the Space PlatformGUI. In Security
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Director, this can be accomplished by simply clicking the Juniper Networks logo in the upper left corner
of the banner.

Search Utility

Figure 4: Search Utility

Sometimes you just need to search for things. Did I already create an address object for the corporate
management network? Is there a URL category for gambling? If you find yourself in need of search
capabilities, the Global Search Utility will fulfill your needs. Type a term into the search field and Security
Director will show you all of the places where that term is found. The results lists are clickable, so that you
can go directly to the found object simply by clicking.

Domain Switcher

Figure 5: Domain Switcher

Security Director supportsmultitenancy in the form of domains. Domains provide a customizable separation
of managed assets and their configuration elements. See Domains Overview for more information.

Notification Center

Figure 6: Notification Center

On the right side of the banner is a bell-shaped icon called the Notification Center. Clicking this icon reveals
lists of the top alerts and alarms in Security Director. Clicking the View All Alarms or View All Alerts links
at the bottom of the drop-down menu takes you to the detail page for the respective topic.

User Functions Menu

Figure 7: User Functions Menu

6



To the right of the Notification Center, there is a head-and-shoulders icon and a field showing the logged
in user. Clicking your user name will allow you to access your user profile or log out of Security Director.

Help Button

Figure 8: Help Button

Access to the online Help system and the Getting Started Guide are available by clicking the right-most
icon on the banner, shaped like a question mark. The help system includes access to a list of supported
web browsers, user interface assistance, as well as links to technical support and full Security Director
documentation.

Search Overview

You can search objects and devices from various tabs using a partial or full name, IP address, or other
values. There are different categories of search in Security Director and supported patterns are regular
expressions, partial word search, special character search, and so on.

Search Patterns

You can use the following regular expressions to search the objects.

• * (multiple character search)—If you do not know the full name of an object, use * at the start or end of
the name.

For example, when you search with test* on the Addresses page, ILP displays the following results:

• test-2-SRX

• test_1-SRX

• ? (single character search)—You can replace a single character with ? in search text.

For example, when you search with test?org?net on the Addresses page, ILP displays test.org.net result.

Search limitations
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• A partial name search with a single character replacement does not work. If the search text is split by
any special character such as - , _ , /, :, ., and ; and if you try to search with a partial name, results will
not be displayed.

For example, if address object name is test-2-SRX, and you try to search test?2, then results will not be
displayed.

However, you can do a full text search including asmany ? in between the name, for example, test?2?S?X.

Search Categories

Global Search

Using global search, users can search any Security Director object including SRX Series devices with a
name or an IP address. Global search checks the search text or IP address across all objects or devices of
Security Director and displays the results in the user interface.

For example, if you create a firewall rule, scheduler, address, and service with same name in Security
Director and search that name using the global search text box, the results are displayed with domains.

Global search results are displayed in the format Name of the Object | Type of the Object | Domain Name.

ILP Search

All objects and devices pages such as, address, service, firewall policy, firewall rule, and so on have search
boxes at the top right corner (ILP search box). You can search using a name, a device IP address, and so
on.

For example, in a firewall rules table, you can search the rule by using a name, a zone, an address, a scheduler
name, and so on.

Column Search

You can perform a granular level of search using column level search in the complex tables, which has
more data, such as firewall, NAT, IPS, VPN policies, rules table, and devices table.

If you click the column search icon placed at the top right corner of the table, near the search icon, the
column search text box is displayed in the user interface. You can filter records using one or more columns.

Item Selector Search

You can use a search text box to select items for inclusion in a rule or policy.

For example, when creating an address or service group, you can first search for the address or service
object. Similarly, in firewall, IPS, and NAT rule creation, source and destination addresses can be searched
in the item selector using a regular expression, a full name, and a partial name.
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Delimiter Search Limitations

The search text should not contain a delimiter that marks the beginning or end, such as a comma, hyphen,
and so on. You can search the object by partial word or with * at the end of the text.

For example, if object names are test-SRX, test-SRX-UK, test-SRX_US, and so on, then you cannot search
with test-, results will not be displayed.

However, if you search with the text test, then the object that contains the name as test (either before or
after a delimiter) is displayed.

Refresh Search Index

If you have any issues while searching for newly added or existing object in any category, such as global,
ILP, and column search, then you can trigger the refresh search index from the Junos Space Network
Management Platform page. Based on the number of objects, such as the number of addresses, service,
and firewall policies in Security Director, the refresh search index might take time.

In Junos Space Network Management Platform page, select Administrator > Application. Right-click
Security Director and click Refresh Search Index. See Figure 9 on page 9.

Figure 9: Refresh Search Index

Wait for about 10-15 minutes, and then try to search objects again in Security Director.
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NOTE: This operation should not be performed frequently. This can impact the overall Security
Director performance.

Main Workspace Overview

The main workspace of Security Director takes up the remainder of the browser window and is divided
by six horizontal tabs just below the Banner. The six tabs are: Dashboard, Monitor, Devices, Configure,
Reports, and Administration. Each workspace and its accessible functions are described later in this
document.

Dashboard

The Dashboard is the main landing page for Security Director. It is the first thing you will see each time
you log in. Therefore, Juniper Networks has provided a means for you to be presented with the network
security information that you are most interested in. You can customize the workspace in your Dashboard
by adding widgets from the carousel below the banner. The placement of, and settings within, widgets are
saved so that anything from device information to firewall event information or from top blocked viruses
to live threat maps can be unique for each user. Once you decide on the widgets that you want to see,
you can close the carousel to regain some screen space.

Figure 10: Security Director Dashboard Tab

Monitor

The Monitor tab provides a workspace in which graphical representations of network traffic, firewall
events, live threats, and network user data are available. There is also detailed data for alerts and alarms
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and job management information. In this workspace, you can review the detailed information needed to
understand what is happening to the managed security devices and traffic in your network.

Figure 11: Security Director Monitor Tab

Devices

The Devices tab provides a workspace in which you can add and manage Security Director devices. There
are several columns of information available by default. This includes live CPU and memory data, and
running software version and platform information. Schema mismatches are easily visible so that you can
correct them before updating a device.

NOTE: Before working with a particular device in Security Director, ensure that the proper DMI
Schema is available. If there is a mismatch between the device’s software image and the schema
version that Security Director is using to manage the device, unexpected behavior will result.
DMI Schema management is performed in the Junos Space Platform Administration workspace.

Figure 12: Security Director Devices Tab
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Configure

The Configure tab is the workspace where all of the security configuration happens. You can configure
firewall, IPS, NAT, and UTM policies, assign policies to devices, create and apply policy schedules, create
and manage VPNs, and create and manage all of the shared objects needed for managing your network
security.

Figure 13: Security Director Configure Tab

Reports

The Reports tab provides a workspace in which you can create and send reports to other interested parties.
The reports available on theDashboard tab are a subset of the reports available here.When run, the report
engine provides both graphic and numeric data for a complete visualization of the log data. Security Director
comes with a predefined set of reports, and you can add your own customized reports from scratch or by
cloning any of the predefined reports.
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Figure 14: Security Director Reports Tab

Administration

The Administration tab provides a workspace in which you can manage role-based access control (RBAC),
review andmanage audit logs, manage logging, review and update the IPS signature database, andmanage
your login profile. Domain RBAC allows system administrators to logically divide Security Director into
sections called domains. Policies, objects, logs, and services created for devices within any one domain
are available for use only within that domain. User access can also be restricted to individual domains. For
more information regarding RBAC, see “Domain RBAC Overview” on page 1316.

Figure 15: Security Director Administration Tab

13



Global Features

Security Director contains assistive workflowwizards that guide you through some of its security functions.
These include a rule-creation wizard and an add-device-profile wizard.

The publishworkflow allows security configurations to be created or changed, assigned to devices, published
and then updated to those devices. Policy changes, whether to IPS, Firewall, or any other managed policy
can be staged by network operations center (NOC) personnel, previewed and approved by network
administrators, and updated to the devices individually or all at once during maintenance windows or as
often as needed by using the publish workflow. Figure 9 shows a sample of a configuration preview that
could be used to review the changes that Security Director would make during the next update.

Cloning allows quick duplication of everything from objects, to rules, to entire policies. When dealing with
complex rules or policies, cloning to make changes can ensure that there is a consistent starting point from
which to make changes.

Figure 16: Configuration Update Preview

The configuration preview is available as CLI commands or as XML.
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Conclusion

Security Director is a security management application designed with speed and scale in mind. Shared
objects can be created and used across many security policies and devices. Firewall policies, NAT policies,
and others can be created, changed, managed, and applied to individual devices or to groups of devices.

RBAC and domain features enable the Security Director administrator to allow access to many levels of
users while restricting the visibility that they have into sensitive security information. Security devices,
users, shared objects, and policies in one domain remain inaccessible to users who do not have access to
that domain. Thus service provider organizations can provide customer isolation, allowing them to diversify
their customer base. User management can be performed locally within Security Director, or remotely
using central user management systems such as RADIUS.

And finally, events received by Security Director are logged and correlated in various ways, providing
graphical and numerical charts that are understandable and actionable. Reports based on this information
can be run and sent directly to stakeholders within an organization. The reports can show security and
user trends over time, helping decision makers to craft concise and accurate security policies.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Dashboard Overview | 20

Overview of Device Discovery in Security Director | 343

Juniper Networks Connected Security Overview

The Juniper Networks Connected Security provides end-to-end network visibility, allowing enterprises to
secure their entire network, both physical and virtual. Using threat detection and policy enforcement, an
Juniper Connected Security solution automates and centrally manages security in a multi-vendor
environment.

The Juniper Connected Security solution is comprised of the following components:

• A threat detection engine—Cloud-based Juniper ATP Cloud detects known and unknown malware.
Known threats are detected using feed information from a variety of sources, including command control
server and GeoIP. Unknown threats are identified using various methods such as sandboxing, machine
learning, and threat deception.

• Centralized policy management—Junos Space Security Director, which alsomanages SRX Series devices,
provides the management interface for the Juniper Connected Security solution called Policy Enforcer.
Policy Enforcer communicateswith Juniper Networks devices and third-party devices across the network,
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globally enforcing security policies and consolidating threat intelligence from different sources. With
monitoring capabilities, it can also act as a sensor, providing visibility for intra- and inter-network
communications.

• Expansive policy enforcement—In a multi-vendor enterprise, Juniper Connected Security enforces
security across Juniper Networks devices, cloud-based solutions, and third-party devices. By
communicating with all enforcement points, Juniper Connected Security can quickly block or quarantine
threat, preventing the spread of bi-lateral attacks within the network.

• User intent-based policies—Create policies according to logical business structures such as users, user
groups, geographical locations, sites, tenants, applications, or threat risks. This allows network devices
(switches, routers, firewalls and other security devices) to share information, resources, andwhen threats
are detected, remediation actions within the network.

With user intent-based policies, you manage clients based on business objectives or user and group
profiles. The following are two examples of a user intent policy:

• Quarantine users in HR in Sunnyvale when they’re infected with malware that has a threat score
greater than 7.

• Block any user inMarketing when they contact a Command and Control (C&C) server that has a threat
score greater than 6 and then send an e-mail to an IT administrator.

Using user intent-based policies allows network devices (switches, routers, firewalls and other security
devices) to share information, resources, and when threats are detected, remediation actions within the
network.

Unlike rule-based policies, which can contain several rules, you can define only one set of parameters
for each user intent-based policy defined on a device.

Benefits of Juniper Networks Connected Security

• Management and visibility - Enables you to view traffic across the network, dynamically deploy security
policies and block threats. Juniper Connected Security manages the entire network infrastructure as a
single enforcement domain, thereby providing enforcement points across the network. Uses machine
learning and datamining tools to offer effective threat management while producing detailed data access
and user activity reports.

• Comprehensive security - Ensures that the same security policies are applied across all of the devices
in the network. It extends security to each layer of the network, including routers, switches, and firewalls.

• Protection from advanced malware - Provides automated offense identification and consolidates the
threat intelligence with threat hunting activities to simplify and focus attention on the highest priority
offenses.

• Automated policy or enforcement orchestration - Provides real-time feedback between the security
firewalls. Reduces the risk of compromise and human error by allowing you to focus on maximizing
security and accelerating operations with a simple, concise rule set.
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• Scalability - Supports up to 15,000 devices.

• Third-party integration - Provides APIs to integrate with the ecosystem partners for capabilities such
as cloud access security, network access control, and endpoint protection, and additional threat intelligence
feeds.

RELATED DOCUMENTATION

Policy Enforcer Overview | 1099

Policy Enforcer Components and Dependencies | 1106

Security Director Insights Overview

Security Director Insights is a single virtual appliance (Service VM) that runs on the VMware vSphere
infrastructure. It facilitates automated security operations. It enables you to take effective actions on
security events logged by Juniper Networks security products. The events that affect a host or events that
are impacted by a particular threat source are presented by Security Director Insights from different
security modules. These events provide instantaneous information about the extent and stage of an attack.
Security Director Insights also detects the hosts and servers under attack by analyzing events that are not
severe enough to block. The application contains an option to verify the incidents using your trusted threat
intelligence providers. After you have verified the incidents, you can take preventive and remedial actions
using the rich capabilities of our security products.

Benefits

• Reduce the number of alerts across disparate security solutions

• Quickly react to active threats with one-click mitigation

• Improve the security operations center (SOC) teams’ ability to focus on the highest priority threats

Security Director Insights Architecture

The Service VM provides the following functionality, as shown in Figure 17 on page 18.
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Figure 17: Security Director Insights Architecture

• The Service VM works with the Security Director ecosystem. The Security Director Insights GUI is
integrated into the Security Director GUI.

• The Log Collector and Policy Enforcer are integrated within the Security Director Insights VM.

NOTE:
• Security Director Insights custom log retention and disk space expansion are currently not
supported.

• Security Director Insights by default supports log storage for a period of 365 days or 80% of
the available disk storage.

RELATED DOCUMENTATION

Add Insights Nodes | 1387
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Overview
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Dashboard Overview

The Junos Space Security Director dashboard provides a unified overview of the system and network
status retrieved from SRX Series devices. You can drag widgets from the carousel at the top of the page
to your workspace, where you can configure them to meet your needs.When you install Security Director
with Junos Space Log Director, the new Log Director dashboard is displayed.

To display the dashboard, select Security Director > Dashboard. The carousel displays all the widget
thumbnails by default. You can customize your dashboard as per your needs. For example, you can configure
a widget to display a graph with the top 10 applications with the most sessions in the last hour.

To add a widget to the Dashboard, drag the widgets from the palette or thumbnail container into the
workspace. Click the refresh icon to update the dashboard or an individual widget. To change the automatic
refresh interval, select an interval from the drop-down list, which ranges from 5 minutes up to 7 days.

You can select a root device, a tenant system device, or a logical system device from theDevices drop-down
list in the widgets. By default, the All option is selected. Maximum of top 10 devices based on the number
of sessions are displayed in the widget.

You can also select the required devices by selecting the Selective option. The data is displayed based on
selected devices. Hover over the top-right corner of the widget to edit, refresh, or remove the widget
details.

The following dashboard widgets supports the option to display data based on the selected device:

• IP Top Source IPs by Volume

• Application Top Application by Volume

• IP Top Users/IP by sessions

• Firewall Top Denials

• Firewall Top Events
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• Firewall Policy Rules with No Hits

• Devices Most Bandwidth by Bytes

• Zones Most Bandwidth by Bytes

• Applications Most Sessions

• IP Top Destinations

• IP Top Sources

• Devices Most Dropped Packets

• Zones Most Dropped Packets

• Devices Most Bandwidth by Packets

• Zones Most Bandwidth by Packets

• Devices Most Sessions

• Devices Most Storage

• NAT Top Src Translation Hits

• NAT Top Dst Translation Hits

In addition, you can use the dashboard to:

• Navigate to the Devices page from the devices widgets by clicking theMore Details link.

• Navigate to the Alarms page from devices most alarms widgets by clicking theMore Details link.

• Navigate to the Events and Logs page from an event-based widget.

The dashboard page automatically adjusts the placement of the widgets to dynamically fit on the browser
window without changing the order of the widgets. You can manually reorder the widgets using the drag
and drop option. The widget can be reordered or moved by holding the top header section of the widget.

NOTE: If you are using Policy Enforcer and ATPCloudwith Security Director, additional widgets
are added to the dashboard. See Policy Enforcer DashboardWidgets for those widget descriptions.

Table 5: Widgets

DescriptionWidget

Displays device count grouped by platform.Devices Count By Platform

Displays device count grouped by Junos OS.Devices Count By OS

Displays device count grouped by the system status (Up/down).Device Count By Status
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Table 5: Widgets (continued)

DescriptionWidget

Displays top requests denied by the firewall based on their source IP
addresses, sorted by count.

Firewall Top Denies

Displays top firewall events of the network traffic, sorted by count.Firewall Top Events

Displays top IPS events of the network traffic, sorted by count.IPS Top Events

Displays the applications with the most sessions.Applications most sessions

Displays top destination IP addresses of the network traffic, sorted by
count.

IP Top Destinations

Displays top source IP addresses of the network traffic, sorted by count.IP Top Sources

Displays devices with maximum CPU utilization, sorted by count.Devices Most CPU Usage

Displays devices with maximum memory utilization, sorted by count.Devices Most Memory Usage

Displays devices with most storage usage, sorted by count.Devices Most Storage

Displays firewall policies with the most rules not hit, sorted by count.Firewall Policy Rules with No Hits

Displays devices consuming maximum bandwidth in bytes.Devices Most Bandwidth by Bytes

Displays zones with maximum throughput rate in bytes, sorted by
incoming and outgoing bytes.

Zones Most Bandwidth by Bytes

Displays firewall devices withmaximum number of packet drops, sorted
by count.

Devices Most Dropped Packets

Displays firewall zones with maximum number of packet drops, sorted
by count.

Zones Most Dropped Packets

Devices with maximum throughput rate in packets, sorted by incoming
and outgoing packets.

Devices Most Bandwidth by Packets

Displays zones with maximum throughput rate in packets, sorted by
incoming and outgoing packets.

Zones Most Bandwidth by Packets

Displays devices with the most number of sessions, sorted by count.Devices Most Sessions
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Table 5: Widgets (continued)

DescriptionWidget

Displays devices with maximum number of alarms, sorted by count.Devices Most Alarms

Displays world map showing total virus event count across countries.Threat Map Virus

Displays world map showing total IPS event count across countries.Threat Map IPS

Displays top applications based on volume or bandwidth.Application Top Application by Volume

Displays top source IP addresses of the network traffic by volume or
bandwidth.

IP Top Source IPs by Volume

Displays top source IP addresses for spams.IP Top Spams By Source IPs

Displays blocked websites, sorted by count.Web Filtering Top Blocked Websites

Displays blocked viruses, sorted by count.Virus Top Blocked

Displays top source IP addresses of the network traffic by sessions.IP Top Source IPs by Sessions

Displays the Network Address Translation (NAT) rule names with most
hits for source NAT.

NAT Top Source Translation Hits

Displays the NAT rule names with most hits for destination NAT.NAT Top Destination Translation Hits

Policy Enforcer adds widgets to the dashboard that provide a summary of all gathered information on
compromised content and hosts. Drag and drop widgets to add them to your dashboard. Mouse over a
widget to refresh, remove, or edit the contents.

In addition, you can use the dashboard to:

• Navigate to the File Scanning page from the Top Scanned Files and Top Infected Files widgets by clicking
the More Details link.

• Navigate to the Hosts page from the Top Compromised Hosts widget by clicking theMore Details link.

• Navigate to the Command and Control Servers page from the C&C Server Malware Source Location
widget.

NOTE: C&C andGeoIP filtering feeds are only available with the Cloud Feed or Premium license.
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Table 6: Policy Enforcer Widgets

DefinitionWidget

A list of the top malware found based on the number of times the malware is
detected over a period of time. Use the arrow to filter by different time frames.

Top Malware Identified

A list of the top compromised hosts based on their associated threat level and
blocked status.

Top Compromised Hosts

A graph of the top infected file types by file extension. Examples: exe, pdf, ini,
zip. Use the arrows to filter by threat level and time frame.

Top Infected File Types

A graph of the top infected file categories. Examples: executables, archived files,
libraries. Use the arrows to filter by threat level and time frame.

Top Infected File Categories

A graph of the top file types scanned for malware. Examples: exe, pdf, ini, zip.
Use the arrows to filter by different time frames.

Top Scanned File Types

A graph of the top file categories scanned for malware. Examples: executables,
archived files, libraries. Use the arrows to filter by different time frames.

Top Scanned File Categories

A color-coded map displaying the location of Command and Control servers or
othermalware sources. Click a location on themap to view the number of detected
sources.

C&C Server and Malware Source

Table 7 on page 24 provides the source of information for each widget type on dashboard.

Table 7: Information Source for the Widgets

SourceWidget TypeWidget Name

syslogSecurityFirewall Top Events

syslogApplicationsApplications Most Sessions

syslogSecurityIP Top Destinations

syslogSecurityIP Top Sources

syslogSecurityTop Firewall Denials

syslogSecurityIPS Top Attacks

syslogSecurityThreatmap Virus
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Table 7: Information Source for the Widgets (continued)

SourceWidget TypeWidget Name

syslogSecurityThreatmap IPS

syslogSecurityNAT Top Source Translation Hits

syslogSecurityNAT Top Destination Translation Hits

syslogSecurityIP Top Spams By Source IPs

syslogSecurityWeb Filtering Top Blocked Websites

syslogSecurityVirus Top Blocked

Application visibilityApplicationApplication Top Application by Volume

Source IP visibilitySecurityTop Source IPs by Volume

Source IP visibilitySecurityTop Source User/IP by Sessions

SRX device pollingDeviceDevices Most CPU Usage

SRX device pollingDeviceDevices Most Memory Usage

SRX device pollingDeviceDevices Most Sessions

SRX device pollingDeviceDevices Most Bandwidth By Bytes

SRX device pollingSecurityZones Most Bandwidth By Bytes

SRX device pollingDeviceDevices Most Dropped Packets

SRX device pollingSecurityZones Most Dropped Packets

SRX device pollingDeviceDevices Most Bandwidth By Packets

SRX device pollingSecurityZones Most Bandwidth By Packets

SRX device pollingDeviceDevices Most Storage

Space Platform/ SD DevicesDeviceDevice Count By Platform

Space Platform/ SD DevicesDeviceDevice Count By OS
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Table 7: Information Source for the Widgets (continued)

SourceWidget TypeWidget Name

Space Platform/ SD DevicesDeviceDevice Count By Status

SRX device pollingDeviceDevice Most Alarms

Firewall Rule Hit countSecurityFirewall policy: Rules with no hits

NOTE: The following widgets are supported for both tenant systems (TSYS) and logical systems
(LSYS):

• Devices Most Sessions

• Devices Most Bandwidth by Bytes

• Zones Most Bandwidth by Bytes

• Devices Most Dropped Packets

• Zones Most Dropped Packets

• Devices Most Bandwidth by Packets

• Zones Most Bandwidth by Packets

• Devices Most Storage

The following widgets are not supported for both LSYS and TSYS:

• Devices Most CPU Usage

• Devices Most Memory Usage

Understanding Role-Based Access Control for the Dashboard

Role-based access control (RBAC) has the following impact on the dashboard:

• You must have Security Analyst or Security Architect role or have permissions equivalent to that role
to access the dashboard.

• You must have the required permissions to edit dashboard widgets. The user role under Administration
> Users & Roles must have Event Viewer > Edit DashBoard option enabled to edit the settings on
dashboard widgets.

• You must have Administration > Users & Roles > Event Viewer > View Device Logs option enabled to
view or read logs.
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Events and Logs Overview

Use the Events and Logs page to get an overall, high-level view of your network environment. You can
view abnormal events, attacks, viruses, or worms when log data is correlated and analyzed.

This page provides administrators with an advanced filtering mechanism and provides visibility into actual
events collected by the Log Collector. Using the time-frame slider, you can instantly focus on areas of
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unusual activity by dragging the time slider to the area of interest to you. The slider and the Custom button
under Time Range remain at the top of each tab. Users select the time range, and then they can decide
how to view the data, using the summary view or detail view tabs.

By default, you can view data for all the devices. To view data for a specific device, click on the link beside
Devices and select a device.

NOTE: Starting in Junos Space Security Director Release 21.2R1, Tenant Systems (TSYS) devices
are also supported.

To access the Event Viewer page selectMonitor > Events & Logs > All Events.

Events & Logs—Summary View

Click Summary View for a brief summary of all the events in your network. At the center of the page is
critical information, including total number of events, viruses found, total number of interfaces that are
down, number of attacks, CPU spikes, and system reboots. This data is refreshed automatically based on
the selected time range. At the bottomof the page is a swim-lane view of different events that are happening
at a specific time. The events include firewall, Web filtering, VPN, content filtering, antispam, antivirus,
IPS, ATP Cloud, Screen, and Apptrack. Each event is color-coded, with darker shades representing a higher
level of activity. Each tabs provide deep information like type, and number of events occurring at that
specific time.

See Table 8 on page 31 the descriptions of the widgets in this view.

Table 8: Events and Logs Summary ViewWidgets

DescriptionWidget

Total number of all the events that includes firewall, webfiltering, IPS, IPSec,
content filtering, antispam, and antivirus events.

Total Events

Total number of virus instances running in the system.Virus Instances

Total number of attacks on the firewall.Attacks

Total number of interfaces that are down.Interface Down

Total number of times a CPU utilization spike has occurred.CPU Spikes

Total number of system reboots.Reboots

Total number of sessions established through firewall.Sessions
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Events & Logs—Detail View

Click Detail View for comprehensive details of events in a tabular format that includes sortable columns.
You can sort the events using the Group by option. For example, you can sort the events based on severity.
The table includes information such as the rule that caused the event, severity for the event, event ID,
traffic information, and how and when the event was detected.

Select Export to CSV option from the grid settings pane to export and download the log data in CSV file.

See Table 9 on page 32 for field descriptions.

Table 9: Events and Logs Detail Columns

DescriptionField

The time when the log was generated on the SRX Series device.Log Generated Time

The time when the log was received on the log collector.Log Received Time

The event name of the logEvent Name

The source country name.Source Country

The source IP address from where the event occurred.Source IP

Destination country name from where the event occurred.Destination Country

The destination IP address of the event.Destination IP

The source port of the event.Source Port

The destination port of the event.Destination Port

The description of the log.Description

Attack name of the log: Trojan, worm, virus, and so on.Attack name

The severity level of the threat.Threat Severity

The policy name in the log.Policy Name

The UTM category of the log.UTM category or Virus Name

Accessed URL name that triggered the event.URL

The event category of the log.Event category
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Table 9: Events and Logs Detail Columns (continued)

DescriptionField

The username of the log.User Name

Action taken for the event: warning, allow, and block.Action

The IP address of the log source.Log Source

The application name from which the events or logs are generatedApplication

The host name in the log.Hostname

The name of the application service. For example, FTP, HTTP, SSH, and
so on.

Service Name

The nested application in the log.Nested Application

The source zone of the log.Source Zone

The destination zone of the log.Destination Zone

The protocol ID in the log.Protocol ID

The role name associated with the log.Roles

The reason for the log generation. For example, a connection tear down
may have an associated reason such as authentication failed.

Reason

The translated source port.NAT Source Port

The translated destination port.NAT Destination Port

The NAT source rule name.NAT Source Rule Name

The NAT destination rule name.NAT Destination Rule Name

The translated (or natted) source IP address. It can contain IPv4 or IPv6
addresses.

NAT Source IP

The translated (also called natted) destination IP address.NAT Destination IP

The traffic session ID of the log.Traffic Session ID
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Table 9: Events and Logs Detail Columns (continued)

DescriptionField

The path name of the log.Path Name

The name of the logical system.Logical system Name

The name of the rule.Rule Name

The name of the All events profile that triggered the event.Profile Name

Hostname of the client.Client Hostname

Information of the malware.Malware Info

The name of the logical system in JSA logs.Logical Subsystem Name

Advanced Search

You can perform advanced search of all events using the search text box present above the grid. It includes
the logical operators as part of the filter string. Enter the search string in the text box and based on your
input, a list of items from the filter context menu is displayed. You can select a value from the list and then
select a valid operator based onwhich youwant to perform the advanced search operation. Press Spacebar
to provide ANDoperator andOR operator. After you have entered the search string, press Enter to display
the search result in the grid.

In the search text box, when you hover over the icon, it displays an example filter condition. When you
start entering the search string, the icon indicates whether the filter string is valid or not. While entering
a search criteria, when you press backspace at any point of time, only one character is deleted.

Starting in Junos Space Security Director Release 19.2R1, in addition to themanual search using keywords,
you can drag and drop the values from non-empty cells in the grid into the event viewer search bar. The
value is added as the search criterion and the search results are displayed. You can drag and drop only
searchable cells. When you hover over the rows in event viewer, searchable cells are displayed with blue
background. If a cell is not searchable, there is no change in the background color. If you drag a searchable
cell without any value or if the value = ’–’, you cannot drop the contents of such cells. If the search bar
already has a search criterion, all the subsequent drag and drop search criteria are prepended by ‘AND’.
After dropping the value in the search bar, the search condition is refreshed in the grid. This applies to
both simple and complex search filters.

You can perform complex filtering using AND and OR logical operators, and brackets to group the search
tokens.

For example: (Name = one and id = 11) or (Name = two and id = 12)
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The precedence level of the AND logical operator is higher thanOR. In the following filter query, Condition2
AND Condition3 is evaluated before the OR operator.

For example: Condition1 OR Condition2 AND Condition3

To override this, use parentheses explicitly. In the below filter query, expression inside the parentheses is
evaluated first.

For example: ( Condition1 OR Condition2 ) AND Condition3

Table 10: Filter Rules

ExampleFilter Rule

Name=test,site is the same as Name=test OR Name=siteEnter a comma for an OR filter.

Source Country = France AND (Event Name =
RT_Flowsession_Close OR Event Category = Firewall)

Enter parentheses to combine AND and OR
functionality.

"San Jose"Enter double quotes for terms with spaces.

Following are some of the examples for event log filters:

• Specific events originating from or landing within United States

Source Country = United States OR Destination Country = United States AND Event Name =
IDP_ATTACK_LOG_EVENT, IDP_ATTACK_LOG_EVENT_LS, IDP_APPDDOS_APP_ATTACK_EVENT_LS,
IDP_APPDDOS_APP_STATE_EVENT, IDP_APPDDOS_APP_STATE_EVENT_LS,
AV_VIRUS_DETECTED_MT, AV_VIRUS_DETECTED, ANTISPAM_SPAM_DETECTED_MT,
ANTISPAM_SPAM_DETECTED_MT_LS, FWAUTH_FTP_USER_AUTH_FAIL,
FWAUTH_FTP_USER_AUTH_FAIL_LS, FWAUTH_HTTP_USER_AUTH_FAIL,
FWAUTH_HTTP_USER_AUTH_FAIL_LS, FWAUTH_TELNET_USER_AUTH_FAIL,
FWAUTH_TELNET_USER_AUTH_FAIL_LS, FWAUTH_WEBAUTH_FAIL,FWAUTH_WEBAUTH_FAIL_LS

• Traffic between zone pairs for policy – IDP2

Source Zone = trust AND Destination Zone = untrust,internal AND Policy Name = IDP2

• Events with specific sources IPs or events hitting htp, tftp, http, and unknown applications coming from
host DC-SRX1400-1 or VSRX-75.

Application = tftp,ftp,http,unknown OR Source IP = 192.168.34.10,192.168.1.26 AND Hostname =
dc-srx1400-1,vsrx-75

Role-Based Access Control for Event Viewer

Role-Based Access Control (RBAC) has the following impact on the Event Viewer:
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• You must have Security Analyst or Security Architect or have permissions equivalent to that role to
access the event viewer.

• You cannot view event logs created in other domains. However, a super user or any user with an
appropriate role who can access a global domain can view logs in a subdomain, if a subdomain is created
with visibility to the parent domain.

• You can only view logs from the devices that you can access and that belong to your domain.

• You can only view, not edit, a policy if you do not have edit permissions.

• The user role underAdministration >Users &Rolesmust have Event Viewer >ViewDevice Logs option
is enabled to view or read logs.

Release History Table

DescriptionRelease

You can perform advanced search of all events using the search text box present above
the grid.
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Creating Alerts

You can use the All Events page to create an alert.

To create an alert:

1. SelectMonitor > Events & Logs > All Events.

2. Click Detail View.
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3. Select data criteria to create an alert:

• Select filter string from the drop-down list.

• Select data aggregation from the Group-By drop-down list.

You can also use existing filters by selecting Filters > Show Saved Filters.

4. Click Save > Create Alert.

The Create Alert Wizard appears.

5. Complete the configuration according to the guidelines provided in Table 11 on page 37.

6. Click Finish.

The Create Alert Wizard shows a summary of your configuration changes. You can edit the individual
configuration parameters by clicking Edit.

7. Click OK to close the window.

Table 11: Create Alert Wizard Settings

GuidelineSetting

General

Enter a unique string of alphanumeric characters, colons, periods, dashes, and
underscores. No spaces are allowed and the maximum length is 63 characters.

Alert Name

Enter a description for the alerts; maximum length is 1024 characters.Alert Description

Displays the type of alert that is system based.Alert Type

Select the Active check box to view only the active alerts.Status

Select the severity level of the alert: Info, minor, major, critical.Severity

Data Criteria

Specify the data criteria based on the Time Period, Group By, and Filter By options.
Filtered data only displays the subset of data that meets the criteria that you specify.

Enter the event threshold value between 1- 1,000,000,000.

Trigger
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Table 11: Create Alert Wizard Settings (continued)

GuidelineSetting

Starting in Junos Space Security Director Release 16.1, you can specify the duration for
triggering an alert.

• Minutes

• Hours

The default duration is 30 minutes and the maximum duration is 24 hours.

Time Span

E-Mail

Select or enter valid usernames or e-mail addresses of the recipients to receive alert
notifications.

Recipients

Enter comments for the alert notification e-mail.Comments

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.1, you can specify the duration
for triggering an alert.
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Creating Reports

You can create a report from the Event Viewer.
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To create a report:

1. SelectMonitor > Events & Logs. Note that every report must have an aggregation point.

2. Select a Group By option to create a report.

3. Select a filter from Filters > Show Saved Filters

4. Select Save > Create Report.

5. Complete the configuration according to the guidelines provided in the Table 12 on page 39.

6. Click Save > Create Report.

7. Click Finish.

Table 12: Report Settings

GuidelinesSettings

General Information

Enter a unique name for the report definition that is a string of alphanumeric characters,
colons, periods, dashes, and underscores. No spaces are allowed and the maximum length
is 29 characters.

Report Name

Enter a description for the report definition; maximum length is 1024 characters.Description

Content

The data criteria for the report is displayed.

The details displayed are:

• Filter String—Selected filter string.

• Group By—Selected group by option.

• Time Span—Duration for which the data is displayed.

Use Data Criteria from
Filters

Schedule

39



Table 12: Report Settings (continued)

GuidelinesSettings

Select the type of report schedule that you want to use:

• Run now–Select this option to schedule and publish the configuration at the current time.

• Schedule at a later time–Select this option if you want to schedule and publish the
configuration at a later time.

Select the recurring schedule for report generation. The available options are:

• Repeat–Select this option to generate the report on an hourly, daily, weekly, monthly, or
yearly basis.

• Every–Select the number of days, weeks, or months for which the recurring report will
be generated.

• Ends–Select the end date and end time for the report.

Add Schedule

Email

Add Email Recipients

• Recipients- Enter or select the e-mail addresses of the recipients. By default, you can
search by first name and select registered users. You can also type in external email
addresses.

• Subject- Enter the subject for the e-mail notification.

• Comment- Enter the comments for the e-mail notification.

NOTE: The reports are not sent if a specified recipient does not have permission for a device
or domain included in the report configuration when the report is generated.

Email Recipients
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Creating Filters

Filters are used to search logs and view information about filter condition, time, or fields in the logs. You
can configure basic and advanced filters to match the filtering conditions. You can either load existing
filters or define a new filter. A filter allows you to enter specific information that must be displayed on the
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Event Viewer page; for example, the columns in the Event Viewer table, the time range, and the aggregation
point. When you change an existing filter or create a new filter, the Event Viewer table is updated
automatically. If filters contain time details, the time range in Event Viewer is updated with the time
specified in the filter.

Filters provide:

• Quick access to critical information—If you are a firewall administrator, youmight have to regularly deny
traffic from a specific application or a specific set of addresses. You might also have to allow or deny
specific application access to some users. To achieve these conditions, you must set user search criteria,
scan through the firewall logs that match that criteria, and display the matching logs.

• Filter sharing among users—Other users in your domain can use the filters you create without modifying
or deleting the filters.

• Filter usage across multiple functional areas—Filters can be used across multiple functional areas such
as the Event Viewer, dashboard, alerts, and reports.

Starting in Junos Space Security Director Release 19.2R1, in addition to themanual search using keywords,
you can drag and drop the values from non-empty cells in the grid into the event viewer search bar. The
value is added as the search criterion and the search results are displayed. You can drag and drop only
searchable cells. When you hover over the rows in event viewer, searchable cells are displayed with blue
background. If a cell is not searchable, there is no change in the background color. If you drag a searchable
cell without any value or if the value = ’–’, you cannot drop the contents of such cells. If the search bar
already has a search criterion, all the subsequent drag and drop search criteria are prepended by ‘AND’.
After dropping the value in the search bar, the search condition is refreshed in the grid. This applies to
both simple and complex search filters.

To create an Event Viewer filter:

1. SelectMonitor > Events & Logs.

2. Click Detail View.

3. Click the filter text field.

The filter keys available are displayed alphabetically in a drop-down list.

4. Type the exact key in the filter text field, or select the key from the drop-down key list.

The key appears in the filter bar. While typing in the values, you are prompted with suggestions in the
drop-down list whenever possible.

In the search text box, an icon displays the example filter condition.When you start entering the search
string, the icon indicates whether the filter string is valid or not.

For example: EventName =
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5. Continue to add filter expressions <key>space <operator> space <value>.

The key appears, along with the value combination in the filter bar.

For example: EventName = LOGIN_FAILED

6. Repeat the Step 4 and Step 5 to add additional filter expressions. Press Enter to provide AND operator
and comma for OR operator.

The available filter keys are displayed alphabetically in the drop-down list.

For example: EventName = LOGIN_FAILED AND SrcIP =

7. Type in the required IP address.

For example: EventName = LOGIN_FAILED AND SrcIP = 192.168.45.350

The term operator AND/OR is displayed in the filter bar to add a different key. Starting in Junos Space
Security Director Release 16.1, the term operator OR is displayed.

8. Click Save > Save Filter.

9. Enter the filter name.

10.Click OK.

The event logs for EventName = LOGIN_FAILED AND SrcIP = 192.168.45.350 are displayed.

Starting in Junos Space Security Director Release 18.4R1, you can perform complex filtering using AND
and OR logical operators and brackets to group the search tokens.

For example: (Name = one and id = 11) or (Name = two and id = 12)

For examples on event log filters, see Advanced Search section in “Events and Logs Overview” on page 30.

NOTE: The filters that you have typed will appear in the filter history until the next session.
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Grouping Events

You can analyze event data by grouping the data based on specific columns using the Group By option on
the toolbar above the table. You can group the events by columns and the Event Log shows the number
of matching events in those groups, presented in descending order.

To group events:

1. SelectMonitor > Events & Logs.

2. Click Details tab.

3. Select the category from the Group by option.
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Using Events and Logs Settings

You can choose log display time and Security Director object settings that meet your requirements.

To use the Event Viewer settings:

1. SelectMonitor > Events & Logs.

2. Select Settings from the grid settings pane.

3. Select the desired log display time:

• Local time zone—Displays logs in the local time zone.

• UTC time zone—Displays logs in the UTC time zone.
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NOTE: By default, the Local time zone option is enabled.

4. To see host names for any objects that match a source or destination IP address, select Resolve IPwith
SD address objects. This option is disabled by default.

5. Click OK.
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Selecting Events and Logs Table Columns

To select Events and Logs table columns:

1. SelectMonitor > Events & Logs.

2. Click Details tab.

3. Select Show or Hide Columns from the grid settings pane.

4. Select the column that you want to show in Events and Logs table.
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Viewing Threats

You can view events that have potential threats.

To view threats:

1. SelectMonitors > Events & Logs.

2. Click Details tab.

3. Select the View only threats check-box.
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Viewing Data for Selected Devices

You can view the data for specific devices or all devices. By default, you can view data for all the devices
in the network.

To view data for a specific device:

1. SelectMonitor > Events & Logs.

The corresponding events page is displayed. The events page is displayed for events such as all events,
firewall events, IPS events, screen events, ATP Cloud events, and Apptrack events.

2. Click All beside Devices.

The Select Devices page is displayed.

3. Click Selective.

All the available devices are displayed.

4. Select devices from the Available column and click the right arrow tomove these devices to the Selected
column.

5. Click OK.

45



The data is displayed in the events page based on the devices selected.
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Using the Detailed Log View

Use the detailed log view to view the complete details of logs. You can view general information, source
information, destination information, and security information of logs.

To use the detailed log view:

1. SelectMonitor > Events & Logs.

2. Click Detail View tab.

3. Select the event row, right-click and then select Showevent details or clickMore > Showevent details.
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Using the Raw Log View

You can view the real-time logs received from the SRX Series devices.

To view the raw logs:

1. SelectMonitor > Events & Logs.

2. Click Details tab.

3. Select the row in the table, right-click and then select Show raw log or clickMore > Show raw log.
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Showing Exact Match

You can view the exact match of the logs based on the selected row.

To view the logs that matched the filter condition:

1. SelectMonitor > Events & Logs.

2. Click Details tab.

3. Select the row in the table, right-click and then select Show exact match or clickMore > Show exact
match.
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Using Filter on Cell Data

Starting in Junos Space Security Director Release 16.1, you can filter data based on a column name and
value.

To filter data:

1. SelectMonitor > Events & Logs.
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2. Click the Detail View tab.

3. Select an event row, right-click on a cell data and then select Filter on cell data.

The search filter string is displayed in the advanced search field. The data in the corresponding column
is filtered based on the filter string.

Click X , to clear the advanced search field.

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.1, you can filter data based on a
column name and value.
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Using Exclude Cell Data

Starting in Junos Space Security Director Release 16.1, you can exclude data based on a column name and
value.

To exclude data:

1. SelectMonitor > Events & Logs.

2. Click the Detail View tab.

3. Select an event row, right-click on a cell data and then select Exclude cell data.

The search filter string is displayed in the advanced search field. The data in the respective column is
excluded based on the filter condition.

Click X to clear the advanced search field.
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Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.1, you can exclude data based on
a column name and value.
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Showing Firewall Policy

Starting in Junos Space Security Director Release 16.1, you can view your configured firewall policy rules.

To view the firewall policy:

1. SelectMonitor > Events & Logs.

2. Click the Detail View tab.

3. Select an event row, right-click on a cell data, or select Show Firewall Policy from theMore list.

The rules grid of the configured firewall policy is displayed.

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.1, you can view your configured
firewall policy rules.
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Showing Source NAT Policy | 50

Showing Destination NAT Policy | 50

Showing Source NAT Policy

Starting in Junos Space Security Director Release 16.1, you can view the configured source NAT policy
rules.

To view the source NAT policy:

1. SelectMonitor > Events & Logs.

2. Click the Detail View tab.

3. Select an event row, right-click on a cell data, or select Show NAT Source Policy from theMore list.

The rules grid of the configured NAT policy is displayed.

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.1, you can view the configured
source NAT policy rules.
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Showing Destination NAT Policy

Starting in Junos Space Security Director Release 16.1, you can view the configured destination NAT policy
rules.

To view the destination NAT policy:

1. SelectMonitor > Events & Logs.
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2. Click the Detail View tab.

3. Select an event row, right-click on a cell data, or select Show NAT Destination Policy from theMore
list.

The rules grid of the configured NAT policy is displayed.

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.1, you can view the configured
destination NAT policy rules.
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Showing Source NAT Policy | 50

Downloading Packets Captured

You can download attack packets captured by SRX Series devices and analyze these packets externally
using tools such as Wireshark, tcpdump, tshark, and so on.

To download the attack packets:

1. SelectMonitor > Events & Logs.

2. Click the Detail View tab.

3. Select an IPS category event row and right-click a cell, or select Download PCAP from the More list.

NOTE: The Download PCAP menu is enabled only if the Event Category is IPS.
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NOTE: PCAPs can be suppressed by the log suppression mechanism, which is enabled by
default. To disable log suppression, see suppression. To configure SRX IDP packet capture,
see Configuring Security Packet Capture.

RELATED DOCUMENTATION
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About the Packets Captured Page | 203

Showing Attack Details

You can view the details of an attack packet that is captured by SRX Series devices.

To view details of an attack packet:

1. SelectMonitor > Events & Logs.

2. Click the Detail View tab.

3. Select an IPS category event row and right-click a cell, or select Show Attack Details from the More
list.
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Using Filters

IN THIS SECTION

Editing Event Viewer Filters | 53

Viewing Saved Filters | 53

Deleting Event Viewer Filters | 55

Filters are used to search logs and view information about filter condition, time, or fields in the logs. You
can configure basic and advanced filters to match the filtering conditions. You can either load existing
filters or define a new filter. A filter allows you to enter specific information that must be displayed on the
Event Viewer page; for example, the columns in the Event Viewer table, the type of graph, the time period,
and the aggregation point. When you change an existing filter or create a new filter, the Event Viewer
table and event graph are updated automatically. If filters contain time details, the time control in Event
Viewer is updated with the time specified in the filter.

You can edit, save, delete, or search filters on the Event Viewer page. To open the filter options, select
Monitor > Events & Logs. Click the filter icon, and select Show Saved Filters.

Editing Event Viewer Filters

To edit an Event Viewer filter:

1. Select a filter.

The filter details are displayed in the filter bar.

2. Edit the filter string.

3. Click Save.

The filter is saved and the database is updated.

Viewing Saved Filters

You can filter the results to display only event logs matching certain criteria.

1. SelectMonitor > Events & Logs

2. Click the filter icon and select Show Saved Filters to view the saved filters.

53



The following are the default filters that are available:

• Top Web Apps

• Top Applications Blocked

• Top URL’s Detected

• Top URL’s Blocked

• Top Viruses Detected

• Top Spam Sources

• Top Services Blocked

• Top Unidentified Applications

• Top Screen Attackers

• Top Screen Victims

• Top Screen Hits

• Top Firewall Deny Sources

• Top Firewall Deny Destinations

• Top Firewall Service Deny

• Top Firewall Events

• Top FW Denies

• Top IPS Attack Detected

• Top IPS Attack Blocked

• Top IPS Attacks by Severity

• Top IPS Attack Sources

• Top IPS Attack Destinations

• Top IPS Events

• Top Webfiltering URLs Detected

• Top Source IPs

• Top Destination IPs
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Deleting Event Viewer Filters

To delete an Event Viewer filter:

1. SelectMonitor > Events & Logs and click the filter icon and select Show Saved Filters.

The View/Load Filters window appears.

2. Select the filter

3. On the top right corner of the window, click the delete button (X).

The delete confirmation window displays the message. Do you want to delete the selected filter?

4. Click Yes to confirm the deletion.

The selected filter is deleted.
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CHAPTER 4

Events and Logs-Firewall

IN THIS CHAPTER
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Firewall Events and Logs Overview

Use the Firewall Events page to view information about security events based on firewall policies. Analyzing
firewall logs yields useful security management information, such as attempts to breach your network and
observing the inherent characteristics of your traffic in real time. Using the time-frame slider, you can
quickly focus on the area of activity that you are most interested in. Once the time range is selected, all
of the data presented in your view is refreshed automatically. You can also use the Custom button to set
a custom time range.

By default, you can view data for all the devices. To view data for a specific device, click on the link beside
Devices and select a device.

There are two ways to view your data. You can select either the Summary tab or the Details tab.

Firewall Events—Summary View

Click Summary View for a brief summary of all the firewall events in your network. The data presented in
the line graph (also known as swim lanes) is refreshed automatically based on the selected time range. The
line graph shows light blue lanes that represent all firewall events and dark blue lanes represent blocked
firewall events.

Below the swim lanes are widgets displaying critical information such as top sources, top destinations, top
users, and top reporting devices. See the Firewall Events Summary Widgets for the descriptions of the
elements appearing in this view.

See Table 13 on page 57 for descriptions of the widgets in this view.
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Table 13: Widgets in Summary View

DescriptionWidget

Top source IP addresses of the network traffic; sorted by event count.Top Sources

Top destination IP addresses of the network traffic; sorted by event count.Top Destinations

Top users of the network traffic; sorted by event count.Top Users

Top reporting devices in the network; sorted by event count.Top Reporting Devices

Firewall Events—Details View

Click the Details View for comprehensive details of events in a tabular format that includes sortable
columns. The table includes information such as the rule that caused the event, severity for the event,
event ID, traffic information, and how and when the event was detected.

See Table 14 on page 57 for descriptions of the columns in this view.

Table 14: Columns in Detail View

DescriptionColumn

The time when the log was received.Time

The event name of the log.Event Name

Source country name from where the event originated.Source Country

The source IP address from where the event occurred.Source IP

The destination country name from where the event occurred.Destination Country

The destination IP address of the event.Destination IP

The source port of the event.Source Port

Destination port of the event.Destination Port

The description of the log.Description

Policy name in the log.Policy name

The username of the log.User Name
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Table 14: Columns in Detail View (continued)

DescriptionColumn

Action taken for the event: warning, allow, and block.Action

IP address of the log source (IPv4 or IPv6).Log Source

The application name from which the events or logs are generated.Application

The host name in the log.Hostname

The name of the application service. For example, FTP, HTTP, SSH, and
so on.

Service Name

The nested application in the log.Nested Application

User traffic received from the zone.Source Zone

The destination zone of the log.Destination Zone

The protocol ID in the log.Protocol ID

Role names associated with the event.Roles

The translated source port.NAT Source Port

The translated destination port.NAT Destination Port

The NAT source rule name.NAT Source Rule Name

The NAT destination rule name.NAT Destination Rule Name

The translated (or natted) source IP address. It can contain IPv4 or IPv6
addresses.

NAT Source IP

The translated (also called natted) destination IP address.NAT Destination IP

The traffic session ID of the log.Traffic Session ID

The rule name of the log.Rule Name
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58



Events and Logs Overview | 30

Creating Firewall Policies | 434

Using Events and Logs Settings | 43

Using the Raw Log View | 46

Using the Detailed Log View | 46

59



CHAPTER 5

Events and Logs-Web Filtering

IN THIS CHAPTER
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Web Filtering Events and Log Overview

Use this page to view information about security events based on Web filtering policies. Web filtering
allows you to permit or block access to specific websites by URL or by URL category using cloud-based
lookups, a local database, or an external Websense server. Analyzing Web filtering logs yields useful
security management information such as users detected accessing restricted URLs and actions taken by
the system. Using the time-frame slider, you can quickly focus on the area of activity that you are most
interested in. Once the time range is selected, all of the data presented in your view is refreshed
automatically. You can also use the Custom button to set a custom time range.

Web Filtering Events—Summary View

Click Summary View for a brief summary of all the Web filtering events in your network. The top of the
page has a swim lane graph of all the Web filtering events against the blocked events.

You can use the widgets at the bottom of the page to view critical information such as top URLs blocked,
top matched profiles, top sources, and top destinations. See Table 15 on page 60 for descriptions of the
widgets in this view.

Table 15: Widgets in Summary View

DescriptionWidget

URL names that are blocked; sorted by event count.Top URLs blocked

Web filtering profile names; sorted by event count.Top Matched Profiles

Top source IP addresses of the network traffic; sorted by event count.Top Sources

Top destination IP addresses of the network traffic; sorted by event count.Top Destinations
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Web Filtering Events—Detail View

Click Detail View for comprehensive details of events in a tabular format that includes sortable columns.
You can aggregate the events using the Group by option. For example, you can group the events based
on source country. The table includes information such as the event name, UTM category, source IP
address, source country and so on.

See Table 16 on page 61 for descriptions of the columns in this view.

Table 16: Columns in Detail View

DescriptionColumn

Time when the event occurred.Time

Event name of the log.Event Name

Source country name from where the event originated.Source Country

Source IP address from where the event occurred (IPv4 or IPv6).Source IP

Destination country name from where the event occurred.Destination Country

Destination IP address of the event (IPv4 or IPv6).Destination IP

Source port of the event.Source Port

Destination port of the event.Destination Port

Description of the log.Description

UTM category of the log: enhanced, local, and redirect.UTM category or Virus Name

Accessed URL name that triggered the event.URL

Action taken for the event: warning, allow, and block.Action

IP address of the log source (IPv4 or IPv6).Log Source

Hostname in the log.Host Name

User traffic received from the zone.Source Zone

Role names associated with the event.Roles

Reason for the log generation. For example, unrestricted access.Reason
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Table 16: Columns in Detail View (continued)

DescriptionColumn

The path name of the log.Path Name

Name of the Web filtering profile that triggered the event.Profile Name
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CHAPTER 6

Events and Logs-VPN
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VPN Events and Logs Overview

Use this page to view information about security events based on IPSec VPN policies. The event viewer
provides a view of all IPsec VPN events.

Using the time-frame slider, you can quickly focus on the area of activity that you are most interested in.
Once the time range is selected, all of the data presented in your view is refreshed automatically. You can
also use the Custom button to set a custom time range.

By default, you can view data for all the devices. To view data for a specific device, click on the link beside
Devices and select a device.

There are two ways to view your data. You can select either the summary view or the detail view.

VPN Events—Summary View

Click Summary View for a brief summary of all the VPN events in your network. The top of the page has
a swim lane graph of all the VPN events. You can use the widgets at the bottom of the page to view critical
information such as top sources, top destinations, and top reporting devices. See Table 17 on page 63 for
descriptions of the widgets in this view.

Table 17: Widgets in Summary View

DescriptionWidget

Top source IP addresses of the network traffic; sorted by event count.Top Sources

Top destination IP addresses of the network traffic; sorted by event count.Top Destinations

Top reporting device IP addresses; sorted by event count.Top Reporting Devices
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VPN Events—Detail View

Click Detail View for comprehensive details of events in a tabular format that includes sortable columns.
You can aggregate the events using the Group by option. For example, you can group the events based
on source country. The table includes information such as the event name, log source, host name, source
country, and so on.

See Table 18 on page 64 for descriptions of columns in this view.

Table 18: Columns in Detail View

DescriptionColumn

Time when the event occurred.Time

Event name of the log.Event Name

Source country name where the event originated.Source Country

Destination country name where the event occurred.Destination Country

Destination port of the event.Destination Port

Description of the log.Description

IP address of the log source (IPv4 or IPv6).Log Source

Hostname in the log.Host Name

Name of the antivirus profile that triggered the event.Rule Name
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CHAPTER 7

Events and Logs-Content Filtering
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Content Filtering Events and Logs Overview

Use this page to view information about security events based on Content filtering policies. The event
viewer provides a view of all content filtering events and how the events are handled by content filter.
This page can be used to view traffic on the network in real time or as a debugging tool to view how
content filtering is operating.

Content filtering provides basic data loss prevention functionality. Content filtering screens traffic based
on MIME type, file extension, protocol commands, and embedded object type. It either permits or blocks
specific commands or extensions on a protocol-by-protocol basis.

Using the time-frame slider, you can quickly focus on the area of activity that you are most interested in.
Once the time range is selected, all of the data presented in your view is refreshed automatically. You can
also use the Custom button to set a custom time range.

There are two ways to view your data. You can select either the summary view or the detail view.

Content Filtering Events—Summary View

Click Summary View for a brief summary of all the content filtering events in your network. The top of
the page has a swim lane graph of all the content filtering events against the blocked events. You can use
thewidgets at the bottom of the page to view critical information such as top blocked protocol commands,
top reasons, and top sources. See Table 19 on page 65 for descriptions of the widgets in this view.

Table 19: Widgets in Summary View

DescriptionWidget

Top command names or file extensions blocked on a protocol-byprotocol
basis.

Top Blocked Protocol commands
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Table 19: Widgets in Summary View (continued)

DescriptionWidget

Top reasons for blocking the content. For example: Inappropriate or harmful
communication.

Top Reasons

Top source IP addresses of the network traffic; sorted by event count.Top Sources

Content Filtering Events—Detail View

Click Detail View for comprehensive details of events in a tabular format that includes sortable columns.
You can aggregate the events using the Group by option. For example, you can group the events based
on source country. The table includes information such as the event name, UTM category, source IP
address, source country, and so on.

See Table 20 on page 66 for descriptions of columns in this view.

Table 20: Columns in Detail View

DescriptionColumn

Time when the event occurred.Time

Event name of the log.Event Name

Source country name from where the event originated.Source Country

Source IP address from where the event occurred (IPv4 or IPv6).Source IP

Description of the log.Description

UTM category of the log: enhanced, local, and redirect.UTM Category or Virus Name

Accessed URL name that triggered the event.URL

Type of traffic. For example, ftp and http.Argument

Action taken for the event: warning, allow, and block.Action

IP address of the log source (IPv4 or IPv6).Log Source

Hostname in the log.Host Name

User traffic received from the zone.Source Zone
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Table 20: Columns in Detail View (continued)

DescriptionColumn

Role names associated with the event.Roles

Reason for the log generation. For example, unrestricted access.Reason

Name of the content filtering profile that triggered the event.Profile Name
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CHAPTER 8

Events and Logs-Antispam
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Antispam Events and Logs Overview

Use this page to view information about security events based on antispam policies. The event viewer
provides a view of all antispam events and the action taken by the antispam scanner.

The antispam scanner inspects and block spam by scanning inbound and outbound SMTP e-mail traffic.
The filtering can be server-based using an external spam block list server or local-based using local lists
(blocklists and allowlists) for matching.

Using the time-frame slider, you can quickly focus on the area of activity that you are most interested in.
Once the time range is selected, all of the data presented in your view is refreshed automatically. You can
also use the Custom button to set a custom time range.

There are two ways to view your data. You can select either the summary view or the detail view.

Antispam Events—Summary View

Click Summary View for a brief summary of all the antispam events in your network. The top of the page
has a swim lane graph of all antispam events.

You can use the widget at the bottom of the page to view source IP addresses of the network traffic;
sorted by event count.

Antispam Events—Detail View

Click Detail View for comprehensive details of events in a tabular format that includes sortable columns.
You can aggregate the events using the Group by option. For example, you can group the events based
on source country. The table includes information such as the event name, UTM category, source IP
address, source country, and so on.

See Table 21 on page 69 for descriptions of columns in this view.
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Table 21: Columns in Detail View

DescriptionColumn

Time when the event occurred.Time

Event name of the log.Event Name

Source country name from where the event originated.Source Country

Source IP address from where the event occurred (IPv4 or IPv6).Source IP

Description of the log.Description

UTM category of the log: enhanced, local, and redirect.UTM Category or Virus Name

Accessed URL name that triggered the event.URL

Action taken for the event: warning, allow, and block.Action

IP address of the log source (IPv4 or IPv6).Log Source

Hostname in the log.Host Name

User traffic received from the zone.Source Zone

Role names associated with the event.Roles

Reason for the log generation. For example, unrestricted access.Reason

Name of the antispam profile that triggered the event.Profile Name
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Events and Logs-Antivirus
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Antivirus Events and Logs Overview

Use this page to view information about security events based on antivirus policies. The event viewer
provides a view of all antivirus events and the action taken by the virus scanner.

The antivirus scanner inspects files transmitted over several protocols to determine if the files exchanged
are malicious (for example, viruses, Trojans, rootkits, and worms).

Using the time-frame slider, you can quickly focus on the area of activity that you are most interested in.
Once the time range is selected, all of the data presented in your view is refreshed automatically. You can
also use the Custom button to set a custom time range.

There are two ways to view your data. You can select either the summary view or the detail view.

Antivirus Events—Summary View

Click Summary View for a brief summary of all the antivirus events in your network. The top of the page
has a swim lane graph of all the antivirus events against the blocked events. You can use the widgets at
the bottom of the page to view critical information such as top blocked protocol commands, top reasons,
and top sources. See Table 22 on page 70 for descriptions of the widgets in this view.

Table 22: Widgets in Summary View

DescriptionWidget

Top source IP addresses of the network traffic; sorted by event count.Top Sources

Top destination IP addresses of the network traffic; sorted by event count.Top Destinations

Top reporting/attacked device IP addresses; sorted by event count.Top Reporting/Attacked Devices
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Table 22: Widgets in Summary View (continued)

DescriptionWidget

Top virus names detected; sorted by event count.Top Viruses

Top source country names where the events originated; sorted by event
count.

Top Source Countries

Top destination country nameswhere the events occurred; sorted by event
count.

Top Destination Countries

Antivirus Events—Detail View

Click Detail View for comprehensive details of events in a tabular format that includes sortable columns.
You can aggregate the events using the Group by option. For example, you can group the events based
on source country. The table includes information such as the event name, UTM category, source IP
address, source country, and so on.

See Table 23 on page 71 for descriptions of columns in this view.

Table 23: Columns in Detail View

DescriptionColumn

Time when the event occurred.Time

Event name of the log.Event Name

Source country name from where the event originated.Source Country

Source IP address from where the event occurred (IPv4 or IPv6).Source IP

Destination country name from where the event occurred.Destination Country

Destination IP address of the event (IPv4 or IPv6).Destination IP

Source port of the event.Source Port

Destination port of the eventDestination Port

Description of the logDescription

UTM category of the log: enhanced, local, and redirect.UTM Category or Virus Name
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Table 23: Columns in Detail View (continued)

DescriptionColumn

Accessed URL name that triggered the event.URL

Action taken for the event: warning, allow, and block.Action

IP address of the log source (IPv4 or IPv6).Log Source

Hostname in the log.Host Name

User traffic received from the zone.Source Zone

Role names associated with the event.Roles

Reason for the log generation. For example, unrestricted access.Reason

Name of the antivirus profile that triggered the event.Profile Name
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CHAPTER 10

Events and Logs-IPS
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IPS Events and Logs Overview

Use the IPS Events page to view information about security events based on IPS policies. Analyzing IPS
logs yields useful security management information, such as abnormal events, attacks, viruses, or worms.

Using the time-frame slider, you can quickly focus on the area of activity that you are most interested in.
Once the time range is selected, all of the data presented in your view is refreshed automatically. You can
also use the custom button to set a custom time range.

By default, you can view data for all the devices. To view data for a specific device, click on the link beside
Devices and select a device.

There are two ways to view your data. You can select either the summary view or the detail view.

IPS Events—Summary View

Click Summary View for a brief summary of all the IPS events in your network. The data presented in the
area graph is refreshed automatically based on the selected time range.

You can use widgets to view critical information such as IPS severities, top sources, top destinations, top
reporting devices, top IPS attacks, top source countries, and top destination countries. See
Table 24 on page 73 for descriptions of the widgets in this view.

Table 24: IPS Events Summary ViewWidgets

DescriptionWidget

IPS severities of the events based on the severity level: high, medium, low.IPS Severities

Top source IP addresses of the network traffic; sorted by the number of event
occurrences.

Top Sources
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Table 24: IPS Events Summary ViewWidgets (continued)

DescriptionWidget

Top destination IP addresses of the network traffic; sorted by the number of
event occurrences.

Top Destinations

Top devices that are attacked by IPS events; sorted by the number of times
users are active on the network.

Top Reporting/Attacked Devices

Top IPS attacks in the network traffic; sorted by the times devices are attacked.Top IPS attacks

Top source countries from where the event source originated; sorted by the
number of IP addresses.

Top Source Countries

Top destination countries targeted for the attack; sorted by the number of
destination IP addresses.

Top Destination Countries

IPS Events—Detail View

Click Detail View for comprehensive details of events in a tabular format that includes sortable columns.
You can sort the events using the Group by option. For example, you can sort the events based on severity.
The table includes information such as the rule that caused the event, severity for the event, event ID,
traffic information, and how and when the event was detected.

NOTE: Packet capture is applicable for IPS packets. See “Packet CaptureOverview” on page 202.

See Table 25 on page 74 for descriptions of columns in this view.

Table 25: IPS Events Detail Columns

DescriptionColumn

The time when the log was received.Time

Event name of the log.Event Name

Source country name from where the event originated.Source Country

Source IP address from where the event occurred.Source IP

Destination country name from where the event occurred.Destination Country
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Table 25: IPS Events Detail Columns (continued)

DescriptionColumn

Destination IP address of the event.Destination IP

Source port of the event.Source Port

Destination port of the event.Destination Port

Description of the log.Description

Attack name of the log: Trojan, worm, virus, and so on.Attack name

The threat severity of the event.Threat Severity

The policy name in the log.Policy Name

Action taken for the event: warning, allow, and block.Action

The IP address of the log source.Log Source

The application name from which the events or logs are generated.Application

The host name in the log.Hostname

The name of the application service. For example, FTP, HTTP, SSH, and
so on.

Service Name

Nested application name in the log.Nested Application

The source zone of the log.Source Zone

The destination zone of the log.Destination Zone

The protocol ID in the log.Protocol ID

Translated source port.NAT Source Port

Translated destination portNAT Destination Port

NAT source IP address of the log.NAT Source IP

NAT destination IP address of the log.NAT Destination IP
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Table 25: IPS Events Detail Columns (continued)

DescriptionColumn

Name of the rule.Rule Name
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CHAPTER 11

Events and Logs-Screen
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Screen Events and Logs Overview

You can use the Screen Events page to view the information about security events based on screen profiles.
Analyzing screen logs yields information such as attack name, action taken, source of an attack, and
destination of an attack.

Using the Time Range slider, you can quickly focus on the area of activity that you are most interested in.
Once the time range is selected, all of the data presented in your view is refreshed automatically. You can
also use the Custom button to set a custom time range.

By default, you can view data for all the devices. To view data for a specific device, click on the link beside
Devices and select a device.

There are two ways to view your data. You can select either the summary view or the detail view.

Screen Events—Summary View

Click Summary View for a brief summary of all Screen events in your network. The data presented in the
area graph is refreshed automatically based on the selected time range.

You can usewidgets to view critical information such as top sources, top destinations, top source countries,
and top destination countries. See Table 26 on page 77 for descriptions of the widgets in this view.

Table 26: Screen Events Summary ViewWidgets

DescriptionWidget

Top source IP addresses of the network traffic; sorted by the number of event
occurrences.

Top Sources

Top destination IP addresses of the network traffic; sorted by the number of
event occurrences.

Top Destinations
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Table 26: Screen Events Summary ViewWidgets (continued)

DescriptionWidget

Top source countries from where the event source originated; sorted by the
number of IP addresses.

Top Source Countries

Top destination countries targeted for the attack; sorted by the number of
destination IP addresses.

Top Destination Countries

Screen Events—Detail View

Click Detail View for comprehensive details of all screen events in a tabular format that includes sortable
columns. You can sort the events using the Group by option. For example, you can sort the events based
on threat severity. The table includes information such as the event name, source country, source IP,
destination country, attack name, and so on.

See Table 27 on page 78 for descriptions of columns in this view.

Table 27: Screen Events Detail View Columns

DescriptionColumn

The time when the log was received.Log Generated Time

Event name of the log.Event Name

Source country name from where the event originated.Source Country

Source IP address from where the event occurred.Source IP

Destination country name from where the event occurred.Destination Country

Attack name of the log.Attack Name

Destination IP address of the event.Destination IP

Source port of the event.Source Port

Destination port of the event.Destination Port

Description of the log.Description

The threat severity of the event.Threat Severity
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Table 27: Screen Events Detail View Columns (continued)

DescriptionColumn

The policy name in the log.Policy Name

Action taken for the event: warning, allow, and block.Action

The IP address of the log source.Log Source

The hostname in the log.Hostname

The source zone of the log.Source Zone

The destination zone of the log.Destination Zone

The protocol ID in the log.Protocol ID
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Events and Logs-ATP Cloud
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ATP Cloud Events and Logs Overview

You can use the ATP Cloud Events page to view the information about security events based on ATP
Cloud policies. Analyzing the ATP Cloud logs yields information such as malware name, action taken,
infected host, source of an attack, and destination of an attack.

Using the Time Range slider, you can quickly focus on the area of activity that you are most interested in.
Once the time range is selected, all of the data presented in your view is refreshed automatically. You can
also use the Custom button to set a custom time range.

By default, you can view data for all the devices. To view data for a specific device, click on the link beside
Devices and select a device.

There are two ways to view your data. You can select either the summary view or the detail view.

ATP Cloud Events—Summary View

Click Summary View for a brief summary of all the ATP Cloud events in your network. The data presented
in the area graph is refreshed automatically based on the selected time range.

You can use widgets to view critical information, such as top infected hosts, top malware, top source
countries, and top destination countries. See Table 28 on page 80 for descriptions of the widgets in this
view.

Table 28: ATP Cloud Events Summary ViewWidgets

DescriptionWidgets

Top infected hosts based on their associated threat level and blocked status.Top Infected Hosts
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Table 28: ATP Cloud Events Summary ViewWidgets (continued)

DescriptionWidgets

Top malware found based on the number of times the malware is detected
over a period of time.

Top Malware

Top source countries from where the event source originated; sorted by the
number of IP addresses.

Top Source Countries

Top destination countries targeted for the attack; sorted by the number of
destination IP addresses.

Top destination countries

ATP Cloud Events—Detail View

Click Detail View for comprehensive details of all ATP Cloud events in a tabular format that includes
sortable columns. You can sort the events using the Group by option. For example, you can sort the events
based on threat severity. The table includes information such as the event name, source country, source
IP, destination country, malware information, and so on.

See Table 29 on page 81 for descriptions of columns in this view.

Table 29: ATP Cloud Events Detail View Columns

DescriptionColumn

The time when the log was received.Log Generated Time

Event name of the log.Event Name

Source country name from where the event originated.Source Country

Source IP address from where the event occurred.Source IP

Destination country name from where the event occurred.Destination Country

The hostname of the client requesting the DHCP server.Client Hostname

Information about the malware.Malware Info

Destination IP address of the event.Destination IP

Source port of the event.Source Port

Destination port of the event.Destination Port
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Table 29: ATP Cloud Events Detail View Columns (continued)

DescriptionColumn

Description of the log.Description

Attack name of the log.Attack Name

The threat severity of the event.Threat Severity

The policy name in the log.Policy Name

Action taken for the event: warning, allow, and block.Action

The IP address of the log source.Log Source

The application from where the events or logs are generated.Application

The hostname in the log.Hostname

The name of the application service. For example, FTP, HTTP, SSH, and
so on.

Service Name

The nested application in the log.Nested Application

The source zone of the log.Source Zone

The destination zone of the log.Destination Zone

The protocol ID in the log.Protocol ID
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CHAPTER 13

Events and Logs-Apptrack

IN THIS CHAPTER
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Apptrack Events and Logs Overview

You can use the Apptrack Events page to view information about security events based on Apptrack
policies. The Apptrack logs helps you analyze the applications, the users using these applications, and
bandwidth consumed by the applications.

Use the Time Range slider, to quickly focus on the area of activity that you are interested in. Once the
time range is selected, the data on the page is refreshed automatically. You can also use the Custom button
to set a custom time range.

By default, you can view data for all the devices. To view data for a specific device, click on the link beside
Devices and select a device.

There are two ways to view your data. You can select either the summary view or the detail view.

Apptrack Events—Summary View

Click Summary View for a brief summary of all the Apptrack events in your network. The data presented
in the area graph is refreshed automatically based on the selected time range.

You can use widgets to view critical information, such as top sources, top destinations, top users, and top
applications. See Table 30 on page 83 for descriptions of the widgets in this view.

Table 30: Apptrack Events Summary ViewWidgets

DescriptionWidgets

Top source IP addresses of the network traffic; sorted by event count.Top Sources

Top destination IP addresses of the network traffic; sorted by event count.Top Destinations
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Table 30: Apptrack Events Summary ViewWidgets (continued)

DescriptionWidgets

Top users of the network traffic; sorted by event count.Top Users

Top applications of the network traffic; sorted by event count.Top Applications

Apptrack Events—Detail View

ClickDetail View for comprehensive details of all Apptrack events in a tabular format that includes sortable
columns. You can sort the events using the Group by option. The table includes information such as the
event name, source country, source IP, destination country, and so on.

See Table 31 on page 84 for descriptions of columns in this view.

Table 31: Apptrack Events Detail View Columns

DescriptionColumn

The time when the log was generated.Log Generated Time

The time when the log was received.Log Received Time

Event name of the log.Event Name

Source country name from where the event originated.Source Country

Source IP address from where the event occurred.Source IP

Destination country name from where the event occurred.Destination Country

Destination IP address of the event.Destination IP

Source port of the event.Source Port

Destination port of the event.Destination Port

Description of the log.Description

The policy name in the log.Policy Name

The event category of the logEvent Category

The username of the log.User Name

84



Table 31: Apptrack Events Detail View Columns (continued)

DescriptionColumn

The IP address of the log source.Log Source

The application from where the events or logs are generated.Application

The hostname in the log.Hostname

The name of the application service. For example, FTP, HTTP, SSH, and
so on.

Service Name

The nested application in the log.Nested Application

The source zone of the log.Source Zone

The destination zone of the log.Destination Zone

The protocol ID in the log.Protocol ID

The reason for the log generation.Reason

The translated source port.NAT Source Port

The translated destination portNAT Destination Port

The NAT source rule name.NAT Source Rule Name

The NAT destination rule name.NAT Destination Rule Name

The translated (or natted) source IP address. It can contain IPv4 or IPv6
addresses.

NAT Source IP

The translated (also called natted) destination IP address.NAT Destination IP

The traffic session ID of the log.Traffic Session ID

The name of the logical system.Logical System Name

The name of the rule.Rule Name

The name of the All events profile that triggered the event.Profile Name
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CHAPTER 14

Threat Prevention-Hosts
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Infected Hosts Overview

The hosts page lists compromised hosts and their associated threat levels. From here, you can monitor
and mitigate malware detections on a per host basis.

NOTE: You must select ATP Cloud realm from the available pulldown.

Compromised hosts are systems forwhich there is a high confidence that attackers have gained unauthorized
access. When a host is compromised, the attacker can do several things to the computer, such as:

• Send junk or spam e-mail to attack other systems or distribute illegal software.

• Collect personal information, such as passwords and account numbers.

Compromised hosts are listed as secure intelligence data feeds (also called information sources.) The data
feed lists the IP address or IP subnet of the host along with a threat level; for example, 130.131.132.133
and threat level 5. Once threats are identified, you can create threat prevention policies to take enforcement
actions on the inbound and outbound traffic on these infected hosts.

Export Data—Click the Export button to download compromised host data to a CSV file. You are prompted
to narrow the data download to a selected time-frame.
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Infected Host Details

Use the host details page to view in-depth information about current threats to a specific host by time
frame. From here you can change the investigation status and the blocked status of the host.

Table 32 on page 88 shows the information provided on the host details page:

Table 32: Threat Level Definitions

DefinitionThreat Level

Clean; no action is required.0

Low threat level. Recommendation: Disable this host.1–3

Medium threat level. Recommendation: Disable this host.4–6

High threat level. Host has been automatically blocked.7–10

• Host Status—Displays the current state by threat level, which could be any of the levels described in the
table above.

• Investigation Status—The following states of investigation are available: Open, In progress, Resolved -
false positive, Resolved - fixed, and Resolved - ignored.

• Policy override for this host—The following options are available: Use configured policy (not included
in infected hosts feed), Always include host in infected hosts feed, Never include host in infected hosts
feed.

NOTE: The blocked status changes in relation to the investigation state. For example, when
a host changes from an open status (Open or In Progress) to one of the resolved statuses, the
blocked status is changed to allowed and the threat level is brought down to 0. Also, when
the investigation status is changed to resolved, an event is added to the log at the bottom of
the page.
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• Host threat level graph—This is a color-coded graphical representation of threats to this host displayed
by time frame. You can change the time frame, and you can slide the graph backward or forward to
zoom in or out on certain times. When you zoom in, you can view individual days within a month.

• Expand time-frame to separate events—Use this check box to stretch a period of time and see the events
spread out individually.

• Past threats—The date and status of past threats to this host are listed here. The time frame set previously
also applies to this list. The description for each event provides details about the threat and the action
taken at the time.
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CHAPTER 15

Threat Prevention-C&C Servers

IN THIS CHAPTER
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Command and Control Servers Overview

The Command and Control (C&C) servers page lists information on servers that have attempted to contact
and compromise hosts on your network. A C&C server is a centralized computer that issues commands
to botnets (compromised networks of computers) and receives reports back from them. Botnets can be
used to gather sensitive information, such as account numbers or credit card information, or to participate
in a distributed denial-of-service (DDoS) attack.

NOTE:
• C&C and Geo IP filtering feeds are only available with ATP Cloud premium license.

• Whenmanaging ATP Cloud with Security Director, you must select ATP Cloud realm from the
available pulldown.

When a host on your network tries to initiate contact with a possible C&C server on the Internet, the SRX
Series device can intercept the traffic and perform an enforcement action based on real-time intelligence
feed information that identifies the C&C server IP address and URL.

• Export Data—Click the Export button to download C&C data to a CSV file. You are prompted to narrow
the data download to a selected time-frame.

• Report False Positives—Click the FP/FN button to launch a new screen which lets you send a report to
Juniper Networks, informing Juniper of a false position or a false negative. Juniper will investigate the
report, however, this does not change the verdict. If you want to make a correction (mark system as
clean) you must do it manually.

Table 33 on page 91 provides the following information available on the C&C page.
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Table 33: Command & Control Server Data Fields

DefinitionField

The IP address of the suspected command and control server.C&C Server

The threat level of the C&C server as determined by an analysis of actions and
behaviors.

C&C Threat Level

The number of times the C&C server has attempted to contact hosts on your
network.

Hits

The country where the C&C server is located.C&C Country

The date and time of the most recent C&C server hit.Last Seen

The protocol (TCP or UDP) the C&C server used to attempt communication.Protocol

The IP address of the host the C&C server attempted to communicate with.Client Host

The action taken on the communication (permitted or blocked).Action
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Command and Control Server Details

Use Command and Control Server Details page to view analysis information and a threat summary for the
C&C server. The following information is displayed for each server.

• Total Hits

• Threat Summary (Threat level, Location, Category, Time last seen)

• Ports and protocols used
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You can filter this information by clicking on the time-frame links: 1 day, 1 week, 1 month, Custom (select
your own time-frame). You can also expand the time-frame to separate events using the slider.

Hosts That have Contacted This C&C Server

This is a list of hosts that have contacted the server. Table 34 on page 92 shows the information provided
in this section:

Table 34: Command & Control Server Contacted Host Data

DefinitionField

The name of the host in contact with the command and control server.Client Host

The IP address of the host in contact with the command and control server.
(Click through to the Host Details page for this host IP.)

Client IP Address

The threat level of the C&C server as determined by an analysis of actions
and behaviors.

C&C Threat Level

The action taken on the communication (permitted or blocked).Action

The protocol (TCP or UDP) the C&C server used to attempt communication.Protocol

The port the C&C server used to attempt communication.Port

The name of the device in contact with the command and control server.Device Name

The date and time of the most recent C&C server hit.Date Seen

The name of the host user in contact with the command and control server.Username

Associated Domains

This is a list of domains the destination IP addresses in the C&C server events resolved to.

Signatures

This is a list of command and control indicators that were detected.
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CHAPTER 16

Threat Prevention-HTTP File Download
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HTTP File Download Overview

A record is maintained of all file metadata sent to the cloud for inspection. These are files downloaded by
hosts and found to be suspicious based on known signatures or URLs. From the main page, click the file’s
signature to view more information, such as file details, what other malware scanners say about this file,
and a complete list of hosts that downloaded this file.

NOTE: When managing Juniper ATP Cloud with Security Director, you must select ATP Cloud
realm from the available pulldown.

Export Data—Click the Export button to download file scanning data to a CSV file. You are prompted to
narrow the data download to a selected time-frame.

Table 35 on page 94 shows the following information available on this page:

Table 35: HTTP Scanning Data Fields

DefinitionField

A unique identifier located at the beginning of a file that provides information on the contents
of the file. The file signature can also contain information that ensures the original data
stored in the file remains intact and has not been modified.

File Signature

The threat score.

NOTE: Click the three vertical dots at the top of the column to filter the information on the
page by threat level.

Threat Level
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Table 35: HTTP Scanning Data Fields (continued)

DefinitionField

The name of the file, including the extension.

NOTE: Enter text in the space at the top of the column to filter the data.

Filename

The time and date of the most recent scan of this file.Last Submitted

The URL from which the file originated.

NOTE: Enter text in the space at the top of the column to filter the data.

URL

The name of file and the type of threat if the verdict is positive for malware. Examples:
Trojan, Application, Adware. If the file is not malware, the verdict is "clean."

NOTE: Enter text in the space at the top of the column to filter the data.

Malware

The type of file. Examples: PDF, executable, document.

NOTE: Enter text in the space at the top of the column to filter the data.

Category
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HTTP File Download Details

Use the File Scanning Details page to view analysis information and malware behavior summaries for the
downloaded file. In the HTTP File Download page, click on the File Signature to go to the File Scanning
Details page. This page is divided into several sections:

Report False Positives—Click the Report False Positive button to launch a new screen which lets you send
a report to Juniper Networks, informing Juniper of a false position or a false negative. Juniper will investigate
the report, however, this does not change the verdict. If you want to make a correction (mark system as
clean) you must do it manually.

Printable View—Click this link to organize the information into a print-ready format.
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The top of the page provides a quick view of the following information (scroll to the right in the UI to see
more boxes):

• Threat Level—This is the threat level assigned (0-10), This box also provides the threat category and the
action taken.

• Top Indicators—In this box, you will find the malware name, the signature it matches, and the IP
address/URL from which the file originated.

• Prevalence—This box provides information on howoften thismalware has been seen, howmany individual
hosts on the network downloaded the file, and the protocol used.

File Summary

Table 36: General Summary Fields

DefinitionField

This is the assigned threat level 0-10. 10 is the most malicious.Threat Level

How often this file has been seen across different customers.Global Prevalence

The time and date of the last scan to detect the suspicious file.Last Scanned

The name of the suspicious file. Examples: unzipper-setup.exe,
20160223158005.exe,, wordmui.msi.

File Name

The type of file. Examples: PDF, executable, document.Category

The size of the downloaded file.File Size

The target operating system of the file. Example. Win32Platform

If possible, ATP Cloud determines the name of the malware.Malware Name

If possible, Juniper ATP Cloud determines the type of threat. Example: Trojan,
Application, Adware.

Malware Type

If possible, Juniper ATPCloud determines the strain ofmalware detected. Example:
Outbrowse.1198, Visicom.E, Flystudio.

Malware Strain

One way to determine whether a file is malware is to calculate a checksum for the
file and then query to see if the file has previously been identified as malware.

sha256 and md5

In the Network Activity section, you can view information in the following tabs:
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• Contacted Domains—If available, lists any domains that were contacted while executing the file in the
Juniper ATP Cloud sandbox.

• Contacted IPs—If available, lists all IPs that were contacted while executing the file, along with the
destination IP’s country, ASN, and reputation. The reputation field is based on Juniper IP intelligence
data destination.

• DNS Activity— This tab lists DNS activity while executing the file, including reverse lookup to find the
domain name of externally contacted servers. This tab also provides the known reputation of the
destination servers.

HTTP Downloads

This is a list of hosts that have downloaded the suspicious file. Click the IP address to be taken to the Host
Details page for this host. Click the Device Serial number to be taken to the Devices page. From there
you can view device versions and version numbers for the Juniper ATP Cloud configuration, including
profile, allowlist, and blocklist versions. You can also view the malware detection connection type for the
device: telemetry, submission, or C&C event.
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CHAPTER 17

Threat Prevention-Email Quarantine and Scanning
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SMTP Quarantine Overview

Access this page from theMonitor menu.

The SMTP quarantine monitor page lists quarantined emails with their threat score and other details
including sender and recipient. You can also take action on quarantined emails here, including releasing
them and adding them to the blocklist.

The following information is available from the Summary View:

Table 37: Blocked Email Summary View

DescriptionField

Use the slider to narrow or increase the time-frame within the selected the
time parameter in the top right: 12 hrs, 24 hrs, 7 days or custom.

Time Range

This lists the total number of emails scanned during the chosen time-frame
and then categorizes them into blocked, quarantined, released, and permitted
emails.

Total Email Scanned

This is a graphical representation of emails, organized by time, with lines for
blocked emails, quarantined and not released emails, and quarantined and
released emails.

Malicious Email Count

This is a graphical representation of emails, organized by time, with lines for
total emails, and emails with one or more attachments.

Emails Scanned
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Table 37: Blocked Email Summary View (continued)

DescriptionField

This is another graphical view of classified emails, organized by percentage
of blocked emails, quarantined and not released emails, and quarantined and
released emails.

Email Classification

The following information is available from the Detail View:

Table 38: Blocked Email Detail View

DescriptionField

The email address of the recipient.Recipient

The email address of the sender.Sender

Click the Read This link to go to the Juniper ATP Cloud quarantine portal
and preview the email.

Subject

The date the email was received.Date

Click on the attachment name to go to the Juniper ATP Cloud file scanning
page where you can view details about the attachment.

Malicious Attachment

The size of the attachment in kilobytes.Size

The threat score of the attachment, 0-10, with 10 being the most malicious.Threat Score

The type of threat found in the attachment, for example, worm or trojan.Threat Name

The action taken, including the date and the person (recipient or administrator)
who took the action.

Action

Using the available buttons on the Details page, you can take the following actions on blocked emails:

• Add domain to blocklist

• Add sender to blocklist

• Release

RELATED DOCUMENTATION
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Email Attachments Scanning Overview

A record is kept of all file metadata sent to the cloud for inspection. These are files downloaded by hosts
and found to be suspicious based on known signatures From the main page, click the file’s signature to
viewmore information, such as file details, what other malware scanners say about this file, and a complete
list of hosts that downloaded this file.

NOTE: You must select ATP Cloud realm from the available pulldown.

Export Data—Click the Export button to download file scanning data to a CSV file. You are prompted to
narrow the data download to a selected time-frame.

Table 39 on page 100 shows the information available on this page.

Table 39: Email Attachments Scanning Data Fields

DefinitionField

A unique identifier located at the beginning of a file that provides information on
the contents of the file. The file signature can also contain information that ensures
the original data stored in the file remains intact and has not been modified.

File Signature

The threat score.Threat Level

The date and time the file was scanned.Date Scanned

The name of the file, including the extension.Filename

The email address of the intended recipient.Recipient

The email address of the sender.Sender

The type of malware found.Malware Name

Indicates whether the file was blocked or permitted.Status

The type of file. Examples: PDF, executable, document.Category

100



RELATED DOCUMENTATION

Email Attachments Scanning Details | 101

SMTP Quarantine Overview | 98

File Scanning Limits | 106

Email Attachments Scanning Details

Use the File Scanning Details page to view analysis information and malware behavior summaries for the
downloaded file. In the Email Attachments page, click on the File Signature to go to the File Scanning
Details page. This page is divided into several sections:

Report False Positives—Click the Report False Positive button to launch a new screen which lets you send
a report to Juniper Networks, informing Juniper of a false position or a false negative. Juniper will investigate
the report, however, this does not change the verdict. If you want to make a correction (mark system as
clean) you must do it manually.

Printable View—Click this link to organize the information into a print-ready format.

The top of the page provides a quick view of the following information (scroll to the right in the UI to see
more boxes):

• Threat Level—This is the threat level assigned (0-10), This box also provides the threat category and the
action taken.

• Top Indicators—In this box, you will find the malware name, the signature it matches, and the IP
address/URL from which the file originated.

• Prevalence—This box provides information on howoften thismalware has been seen, howmany individual
hosts on the network downloaded the file, and the protocol used.

File Summary

Table 40: General Summary Fields

DefinitionField

This is the assigned threat level 0-10. 10 is the most malicious.Threat Level

The action taken based on the threat level and host settings: block or permit.Action Taken

How often this file has been seen across different customers.Global Prevalence

The time and date of the last scan to detect the suspicious file.Last Scanned

101



Table 40: General Summary Fields (continued)

DefinitionField

The name of the suspicious file. Examples: unzipper-setup.exe,
20160223158005.exe,, wordmui.msi.

File Name

The type of file. Examples: PDF, executable, document.Category

The size of the downloaded file.File Size

The target operating system of the file. Example. Win32Platform

If possible, Juniper ATP Cloud determines the name of the malware.Malware Name

If possible, Juniper ATP Cloud determines the type of threat. Example: Trojan,
Application, Adware.

Malware Type

If possible, Juniper ATPCloud determines the strain of malware detected. Example:
Outbrowse.1198, Visicom.E, Flystudio.

Malware Strain

One way to determine whether a file is malware is to calculate a checksum for the
file and then query to see if the file has previously been identified as malware.

sha256 and md5

In the Network Activity section, you can view information in the following tabs:

NOTE: This section will appear blank if there has been no network activity.

• Contacted Domains—If available, lists any domains that were contacted while executing the file in the
Juniper ATP Cloud sandbox.

• Contacted IPs—If available, lists all IPs that were contacted while executing the file, along with the
destination IP’s country, ASN, and reputation. The reputation field is based on Juniper IP intelligence
data destination.

• DNS Activity—This tab lists DNS activity while executing the file, including reverse lookup to find the
domain name of externally contacted servers. This tab also provides the known reputation of the
destination servers.

In the Behavior Details section, you can view the behavior of the file on the system. This includes any
processes that were started, files that were dropped, and network activity seen during the execution of
the file. Dropped files are any additional files that were downloaded and installed by the original file.
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CHAPTER 18

Threat Prevention-IMAP Block
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IMAP Block Overview

The IMAP Blockmonitor page lists blocked emails with their threat score and other details including sender
and recipient. You can also take action on blocked emails here, including releasing them and adding them
to the blocklist.

Table 41 on page 104 shows information available from the Summary View tab.

Table 41: Blocked Email Summary View

DescriptionField

Select the registered Juniper ATP Cloud realm from the list.ATP Cloud Realm

Use the slider to narrow or increase the time-frame within the selected the
time parameter in the top right: 12 hrs, 24 hrs, 7 days or custom.

Time Range

This lists the total number of malicious emails scanned during the chosen
time-frame and then categorizes them into blocked, blocked and not allowed,
quarantined and allowed.

Malicious Email Count

This is a graphical representation of all scanned emails, organized by date.Emails Scanned

Table 42 on page 104 shows information available from the Detail View tab.

Table 42: Blocked Email Detail View

DescriptionField

Specifies the email address of the recipient.Recipient

Specifies the email address of the sender.Sender

104



Table 42: Blocked Email Detail View (continued)

DescriptionField

ClickRead This to go to the Juniper ATPCloud quarantine portal and preview
the email.

Subject

Specifies the date the email was received.Date

Click on the attachment name to go to the Juniper ATP Cloud file scanning
page where you can view details about the attachment.

Malicious Attachment

Specifies the size of the attachment in kilobytes.Size

Specifies the threat score of the attachment, in a scale of 0-10, with 10 being
the most malicious.

Threat Score

Specifies the type of threat found in the attachment, for example, worm or
trojan.

Threat Name

Specifies the action taken, including the date and the person (recipient or
administrator) who took the action.

Action

Using the available buttons on the Details page, you can take the following actions on blocked emails:

• Unblock Attachment for Selected User(s)

• Unblock Attachment for All Users
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Threat Prevention-Manual Upload
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File Scanning Limits

There is a limit to the number of files which can be submitted to the cloud for inspection. This limit is
dictated by the device and license type. When the limit is reached, the file submission process is paused.

NOTE: This limit applies to all files, HTTP and SMTP.

Limit thresholds operate on a sliding scale and are calculated within 24-hour time-frame starting "now."

Premium License (files per day)Free License (files per day)Perimeter Device

1,000200SRX340

2,000300SRX345

5,000500SRX550m

10,0002,500SRX1500

50,0005,000SRX5400

70,0005,000SRX5600

100,0005,000SRX5800

20025vSRX(10mbps)

1,000200vSRX(100mbps)
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Premium License (files per day)Free License (files per day)Perimeter Device

10,0002,500vSRX(1000mbps)

10,0002,500vSRX(2000mbps)

20,0003,000vSRX(4000mbps)

RELATED DOCUMENTATION

Infected Hosts Overview | 87

HTTP File Download Overview | 94

Email Attachments Scanning Overview | 100
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CHAPTER 20

Threat Prevention-Feed Status

IN THIS CHAPTER

Device Feed Status Details | 108

Device Feed Status Details

Use the Device Feed Status page to view the download status of feeds from various feed sources. You
can view the status of feeds for each device.

NOTE: To view the Device Feed Status page, you must have the Threat Management privileges
or predefined roles enabled.

To view the details of the device feed status:

1. SelectMonitor > Threat Prevention > Device Feed Status.

The Device Feed Status page appears.

2. Table 43 on page 108 shows the information provided on the Device Feed Status page.

Table 43: Fields on the Device Feed Status Page

DescriptionColumn Name

Specifies the name of the device.Device Name

Specifies the IP address of the device.IP

Specifies the model of the device mentioned in the Device Name column. For
example, vSRX.

Model
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Table 43: Fields on the Device Feed Status Page (continued)

DescriptionColumn Name

Specifies the name of the feed downloaded to the device.

This also shows the number of feeds downloaded. Click on the number to view
the names of the individual feeds.

Feed Name

Specifies the category of the feed. For example, CC.Feed Category

Specifies the last downloaded date and time of each feed.Last Downloaded

You can click the filter icon to filter the data based on the following fields:

• Device name

• IP address of the device

• Model of the device

• Name of the feed

• Following feed categories:

• C&C

• Allowlist

• Blocklist

• Infected hosts

• Dynamic address

• DDoS

• GeoIP

RELATED DOCUMENTATION

About the Feed Sources Page | 862
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CHAPTER 21

Threat Prevention-All Hosts Status

IN THIS CHAPTER

All Hosts Status Details | 110

All Hosts Status Details

Use the All Hosts Status page to view the enforcement status of infected hosts feeds. The supported host
feeds are custom and Juniper ATP Cloud.

By default, details for both custom and Juniper ATP Cloud hosts are shown. You must select the required
feed type from the Feed Source column.

NOTE: To view the All Hosts Status page, you must have the Threat Management privileges or
predefined roles enabled.

To see the details of all hosts status:

1. SelectMonitor > Threat Prevention > All Hosts Status.

The All Hosts Status page appears.

2. Table 44 on page 110 shows the information provided on the All Hosts Status page.

Table 44: Fields on All Hosts Status Page

DescriptionColumn Name

Specifies the IP address of the feed.IP Address

Specifies the MAC address of the feed.MAC Address

Specifies the name of the feed.Feed Name
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Table 44: Fields on All Hosts Status Page (continued)

DescriptionColumn Name

Specifies type of the feed source.Feed Source

Specifies the action of the infected host. For example: Block or Quarantine.Action

Specifies the enforcement status of the infected host.Enforcement Status

Specifies the name of the Juniper Networks switch used to monitor the feed.Switch Name

Specifies the interface on the switch where the user is connected to a network.Interface Name

Specifies the name of the associated threat prevention policy.

This column is not shown by default. Click ShowHide Column and select this field
to appear on the All Hosts Status page.

Policy Associated

Specifies the Policy Enforcement Group (PEG) associated with the policy.

This column is not shown by default. Click ShowHide Column and select this field
to appear on the All Hosts Status page.

PEG Associated

Specifies the subnet that is added as an endpoint for the PEG.

This column is not shown by default. Click ShowHide Column and select this field
to appear on the All Hosts Status page.

Matched Subnet

Specifies the type of connector used as an enforcement point.Connector Type

Specifies the name of the connector.

This column is not shown by default. Click ShowHide Column and select this field
to appear on the All Hosts Status page.

Connector Name

Specifies the type of endpoints added to a PEG.

This column is not shown by default. Click ShowHide Column and select this field
to appear on the All Hosts Status page.

Endpoint Address Space Type

Specifies the name of an endpoint.

This column is not shown by default. Click ShowHide Column and select this field
to appear on the All Hosts Status page.

Endpoint Address Space Name

You can click the filter icon to filter the data based on the following fields:
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• Feed source type

• Action

• Enforcement status

• Connector type

RELATED DOCUMENTATION

Custom Feed Sources Overview | 888
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CHAPTER 22

Threat Prevention-DDoS Feeds Status

IN THIS CHAPTER

DDoS Feeds Status Details | 113

DDoS Feeds Status Details

Use the DDoS Feeds Status page to view the enforcement status of Distributed Denial of Service (DDoS)
feeds.

In ATP Cloud Only mode, you do not see the DDoS Feeds Status page under Monitor. An error message
is shown that the page is unavailable because the current threat prevention type is set to ATP Cloud only
mode.

NOTE: To view the DDoS Feeds Status page, you must have the Threat Management privileges
or predefined roles enabled.

To view details of DDoS feeds status:

1. SelectMonitor > Threat Prevention > DDoS Feeds Status.

The DDoS Feeds Status page appears.

2. Table 45 on page 113 shows information provided on the DDoS Feeds Status page.

Table 45: Fields on the DDoS Feeds Status Page

DescriptionColumn Name

Specifies the DDoS feed name to monitor the feeds.Feed Name

Specifies the associated site name with the DDoS feedsSite

Specifies the name of the MX router where DDoS is enabled.MX Name
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Table 45: Fields on the DDoS Feeds Status Page (continued)

DescriptionColumn Name

Specifies the IP address of the MX router.MX IP

Specifies the status of the MX router.MX Status

Specifies the action taken for the DDoS profile

To filter the data based on a specific action, click the filter icon and select the required
DDoS profile action from the list.

Action

Specifies the enforcement status of the feed. Hover over the status to view the reason
for that particular status.

To filter the data based on a specific enforcement status, click the filter icon and select
the required enforcement status from list to monitor the feed.

Enforcement Status

Specifies the name of the associated threat prevention policy.Policy

Specifies the Policy Enforcement Group (PEG) associated with the policy.PEG

RELATED DOCUMENTATION

Custom Feed Sources Overview | 888
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CHAPTER 23

Applications

IN THIS CHAPTER

Application Visibility Overview | 115

Blocking Applications and Users | 119

Application Visibility Overview

You can use the Application Visibility page to view information on bandwidth consumption, session
establishment, and the risks associated with your applications.

There are two ways to view your data. You can select either the Chart view or Grid view. By default, the
data is displayed in Chart view.

Chart View

Click the Chart View link for a brief summary of the top 50 applications consuming maximum bandwidth
in your network. The data can be presented graphically as a bubble graph, heat map, or zoomable bubble
graph. The data is refreshed automatically based on the selected time range. You can also use the Custom
button to set a custom time range.

You can hover over your applications to view critical information such as total number of sessions, total
number of blocks, category, bandwidth consumed, risk levels, and characteristics. You can also view the
top five users accessing your application. Sessions appear as links, when you click a link, the All Events
page appears.

Starting in Junos Space Security Director Release 16.1, you can click the View All Users link to show all
the users accessing an application. You also see the User Visibility page in grid view with the correct filter
applied.

Starting in Junos Space Security Director Release 16.1, you can click the View All Users link to show all
the users accessing an application. You also see the User Visibility page in grid view with the correct filter
applied.

Table 46 on page 116 describes the widgets in Chart view.
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Table 46: Application Visibility Chart View Columns

DescriptionField

Shows data for all the devices managed by Security Director. Click Edit to select root
devices, Logical Systems (LSYS) devices, or Tenant Systems (TSYS) devices to view the
result.

All Devices

Select from the following options to view a user’s data:

• Bandwidth - Shows data based on the amount of bandwidth the application has
consumed for a particular time range.

• Number of Sessions - Shows data based on the number of sessions consumed by the
application.

Show By

Select the required time range to view a user’s data.

Use the custom option to choose the time range if you want to view data for more than
one day. The time range is from 00:00 hours to 23:59 hours.

Time Span

Select from the following graphical representations to view an application’s data:

• Bubble Graph

• Heat Map

• Zoomable Bubble Graph

By default, data is shown in the Bubble Graph format.

Select graph

Select from the following options to view the application’s data:

• Risk - Groups by critical, high, unsafe levels, and so on.

• Category - Groups by category such as web, infrastructure, and so on.

Group By

Shows total number of application sessions.Number of Sessions

Shows total number of times the application was blocked.Number of Blocks

Shows bandwidth usage of the application.Bandwidth

Shows risk associated with the application. For example, critical, high, unsafe, and so
on.

Risk Level

Shows category of the application. For example, web, infrastructure, and so on.Category

Shows characteristics of the application. For example, prone to misuse, bandwidth
consumer, capable of tunneling, and so on.

Characteristics

Blocks the user from using the application.Block User(s)
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Table 46: Application Visibility Chart View Columns (continued)

DescriptionField

Blocks the usage of the application.Block Application

Shows all the users accessing the application.View All Users

Grid View

Click the Grid View link for comprehensive details on applications. You can view top users by volume, top
applications by volume, top category by volume, top characteristics by volume, and sessions by risk. You
can also view the data in a tabular format that includes sortable columns. You can sort the applications in
ascending or descending order based on application name, risk level, and so on. Table 47 on page 117
describes thewidgets in this view. Use thesewidgets to get an overall, high-level view of your applications,
users, and the content traversing your network.

Table 47: Application Visibility Grid ViewWidgets

DescriptionWidget

Top users of the application; sorted by bandwidth consumption.Top Users By Volume

Top applications, such as Amazon, Facebook, and so on of the network traffic;
sorted by bandwidth consumption.

Top Apps By Volume

Top category, such as web, infrastructure, and so on of the application; sorted
by bandwidth consumption.

Top Category By Volume

Top behavioral characteristics, such as prone tomisuse, bandwidth consumer,
and so on of the application.

Top Characteristics By Volume

Number of events/sessions received; grouped by risk.Sessions By Risk

Table 48 on page 118 describes the fields in the table below thewidgets. Users are displayed by usernames
or IP addresses. When you click a link, the User Visibility page in Grid view appears with the correct filter
applied. Sessions are also displayed as links and when you click a link, the All Events page appears with all
security events.

You can select an application or a user to perform a block operation.
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Table 48: Detail View of Applications

DescriptionField

Name of the application, such as Amazon, Facebook, and so on.Application Name

Risk associated with the application: critical, high, unsafe, moderate, low, and
unknown.

Risk Level

Total number of users accessing the application.Users

Bandwidth used by the application.Volume

Total number of application sessions.Total Sessions

Total number of sessions blocked.No of Rejects

Category of the application, such as web, infrastructure, and so on.Category

Subcategory of the application. For example, social networking, news, and
advertisements.

Sub Category

Characteristics of the application. For example, prone to misuse, bandwidth
consumer, capable of tunneling.

Characteristics

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.1, you can click the View All Users link
to show all the users accessing an application.

16.1

Starting in Junos Space Security Director Release 16.1, you can click the View All Users link
to show all the users accessing an application.

16.1

RELATED DOCUMENTATION

Blocking Applications and Users | 119

Publishing Policies | 475

User Visibility Overview | 122

Events and Logs Overview | 30

118



Blocking Applications and Users

You can block applications and users based on network access policies, users and their job roles, and time.
The blocking feature offers application control to organizations to accelerate business-critical applications,
stagger non-critical applications, and block undesirable applications.

Blocking applications or users requires policy rules to be edited. View policy changes by clicking the policy
name or view affected devices by clicking the device count. You see only policies permitting this traffic in
the past 30 days.

NOTE: Starting in Junos Space Security Director Release 21.1, when unified policy rules permit
the traffic, selecting block action creates block rules in the appropriate unified policy.

You can block users and applications from the Application Visibility page.

To block an application:

1. SelectMonitor > Applications. The Application Visibility page appears.

2. In Chart view, hover over the application that you want to block.

The application page appears with information on the number of sessions, bandwidth, number of blocks,
risk level, category, characteristics, top five users, view all users link, and options to block applications
and users.

NOTE: You see the number of sessions as links. When you click a link, the All Events page
appears and displays the events that generated those sessions.

Click the View All Users link to display the User Visibility page in Grid view with the correct
filter applied.

NOTE: In Grid view, select an application and click Block Application.

The Block page appears with the application name and the top five users of the application.

3. Click Block Application to block users from accessing the selected application.

The Block Application page appears with the policies that contain the rules required to block the
application. The listed policies will be edited to block all users from accessing the selected application.
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4. Click a policy to preview the policy details.

The Policy Changes Preview page appears with information on the number of rules added, modified,
and deleted. You can preview the policy details. You can attach or add a schedule under the Rule options
column.

5. Click OK.

6. Click Save to save your changes.

7. Click Publish to publish your policies.

8. Click Update to update your policies on devices.

To block a user:

1. SelectMonitor > Applications. The Application Visibility page appears.

2. In Chart view, hover over the application that you want to block.

The application page appears with information on number of sessions, bandwidth, number of blocks,
risk level, category, characteristics, top five users, view all users link, and options to block applications
and users.

NOTE: You see the number of sessions as links. When you click a link, the All Events page
appears and displays the events that generated those sessions.

When you click View All Users link, the User Visibility page in Grid view appears with the
correct filter applied.

NOTE: In Grid view, select an application and clickBlockApplication. The Block page appears
with top five users.

3. Select a user you want to block and click Block User(s).

The Block Users page appears with policies that contain the rules required to block the user from
accessing the selected application.

4. Click a policy to preview the policy changes.
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Starting in Junos Space Security Director 16.1, you can preview the policy details. The Policy Changes
Preview page appears with information on the number of rules added, modified, and deleted. You can
preview the policy details. You can attach or add a schedule under the Rule options column.

5. Click OK.

6. Click Save to save your changes.

7. Click Publish to publish your policies.

8. Click Update to update your policies on devices.

Release History Table

DescriptionRelease

Starting in Junos Space Security Director 16.1, you can preview the policy details. The Policy
Changes Preview page appears with information on the number of rules added, modified, and
deleted.

16.1

RELATED DOCUMENTATION
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CHAPTER 24

Users

IN THIS CHAPTER

User Visibility Overview | 122

Blocking Users and Applications | 125

User Visibility Overview

You can use the User Visibility page to view information related to the bandwidth consumption, session
establishment, and the risks associated with the users.

Starting in Junos Space Security Director Release 16.1, users are displayed on the page by username and,
if the user name is not available, by source IP address.

There are two ways to view your data. You can select either the Chart View or Grid View.

Chart View

By default, the user’s data is shown in the Chart view. It shows the top 50 users consuming maximum
bandwidth in your network. The data can be presented graphically as a bubble graph, heatmap, or zoomable
bubble graph. The data is refreshed automatically based on the selected time range.

You can hover over a username or source IP to view critical information such as total number of sessions
and bandwidth consumed. The sessions are shown as links. When you click a link, the All Events page
appears with all security events.

Starting in Junos Space Security Director Release 16.1, you can view all the applications accessed by the
user by clicking theViewAll Applications link.When you click theViewAll Applications link, the Application
Visibility page in Grid view is displayed with the correct filter applied.

You can block a user or an application.

Table 49 on page 123 shows the different filters you can use to view the user’s data in Chart view.
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Table 49: Chart View Filters

DescriptionFilter Name

Shows data for all the devices managed by Security Director. Click Edit to select root
devices, Logical Systems (LSYS) devices, or Tenant Systems (TSYS) devices to view
the result.

All Devices

Select from the following options to view the user’s data:

• Bandwidth - Shows data based on the amount of bandwidth the user has consumed
for a particular time range.

• Number of Sessions - Shows data based on the number of sessions consumed by
the user.

Show By

Select the required time range to view the user’s data.

Use the custom option to choose the time range if you want to view data for more
than one day. The date range is from 00:00 hours to 23:59 hours.

Time Span

Select from the following graphical representation to view a user’s data:

• Bubble Graph

• Heat Map

• Zoomable Bubble Graph

By default, data is shown in the Bubble Graph format.

Select Graph

Shows total number of user sessions.Number of Sessions

Shows bandwidth usage of the user.Bandwidth

Blocks the user from using the application.Block User

Blocks the usage of the application.Block Application(s)

Shows all the applications accessed by the user.View All Applications

Grid View

ClickGridView to view the user’s data in the tabular format. Table 50 on page 124 and Table 51 on page 124
describe the fields on this page. You can view top users by volume and top applications by volume. Grid
view provides a detailed view of all the users. By default, data is sorted based on the bandwidth usage.
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Table 50: Grid ViewWidgets

DescriptionWidget Name

List the top five users sorted by their bandwidth consumption.Top Users By Volume

List the top five applications being accessed in your network for the
specified time range.

Top Apps By Volume

The sessions and applications are shown as links. When the user clicks a session link, the All Events page
appears with all security events. When the user clicks an application link, the Application Visibility page
in Grid view appears with the correct filter applied.

Table 51: Detailed View of the User

DescriptionField Name

Shows the name of a user.User Name

Shows the bandwidth consumption of a user.Volume

Shows the number of user sessions.Total Sessions

Shows all the applications used by a user for the time range.Applications

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.1, users are displayed on the page by
username and, if the user name is not available, by source IP address.

16.1

Starting in Junos Space SecurityDirector Release 16.1, you can view all the applications accessed
by the user by clicking the View All Applications link.

16.1

RELATED DOCUMENTATION

Blocking Users and Applications | 125

Events and Logs Overview | 30

Application Visibility Overview | 115
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Blocking Users and Applications

Blocking users and applications requires policy rules to be edited. You can view policy changes by clicking
the policy name or view affected devices by clicking the device count. You see only policies permitting
this traffic in the past 30 days.

NOTE: Starting in Junos Space Security Director Release 21.1, when unified policy rules permit
the traffic, selecting block action creates block rules in the appropriate unified policy.

To block a user:

1. SelectMonitor > Users.

The User Visibility page appears.

2. In Chart view, hover over the required user.

The user page appears with information on the bandwidth, number of sessions, top five applications,
view all applications link, and options to block users and applications.

NOTE: You see the number of sessions as links. When you click a link, the All Events page
appears and displays the events that generated those sessions.

Click theViewAll Applications link to display the Application Visibility page in Grid viewwith
correct filter applied.

NOTE: In Grid view, select the IP address or user name and click Block User.

The Block page appears with the username and top five applications.

3. Click Block User to block the selected IP address or username from accessing all applications.

The Block User page appears with policies that contain the rules required to block the user. The listed
policies will be edited to block the selected user from accessing all applications.

4. Click a policy to preview the policy details.

Starting in Junos Space Security Director Release 16.1, you can preview the policy details. The Policy
Changes Preview page appears with information on number of rules added, modified, and deleted. You
can preview the policy details. You can attach or add a schedule under the Rule options column.
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5. Click OK.

6. Click Save to save your changes.

7. Click Publish to publish your policies.

8. Click Update to update your policies on devices.

To block an application:

1. SelectMonitor > Users.

The User Visibility page appears.

2. In Chart view, hover over the required user. The user page appears showing information about the
bandwidth, number of sessions, top five applications, view all applications link, and options to block
user and application.

NOTE: You see the number of sessions as links. When you click a link, the All Events page
appears and displays the events that generated those sessions.

Click theViewAll Applications link to display the Application Visibility page in Grid viewwith
the correct filter applied.

NOTE: In Grid view, select the username and click Block User.

The block page appears with the username and the top five applications.

3. Select an application you want to block and click Block Application(s).

The Block Application page appears with policies that contain the rules required to block the user from
accessing a particular application.

4. Click a policy to preview the policy changes.

The Policy Changes Preview page appears with information on number of rules added, modified, and
deleted. You can preview the policy details. You can attach or add a schedule under the Rule options
column.

5. Click OK.
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6. Click Save to save your changes.

7. Click Publish to publish your policies.

8. Click Update to update your policies on devices.

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.1, you can preview the policy details.
The Policy Changes Previewpage appearswith information on number of rules added,modified,
and deleted.

16.1
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CHAPTER 25

Source IP
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Source IP Visibility Overview

Starting in Junos Space Security Director Release 16.1, you can use the Source IP Visibility page to view
information related to bandwidth consumption, session establishment, and the risks associated with the
source IP addresses.

There are two ways to view your data. You can select either the Chart View link or Grid View link. The
top 50 source IP addresses are displayed for a time span of one day, by default.

Chart View Overview

Click the Chart View link for a brief summary of the top 50 source IP addresses consuming the maximum
bandwidth in your network. The data can be presented graphically as a bubble graph, heatmap, or zoomable
bubble graph. The data is refreshed automatically based on the selected time range.

You can hover over the source IP addresses to view critical information such as total number of sessions,
total bandwidth consumption, and top five applications, bandwidth consumption, and sessions for each
application. To view all the applications of an IP address, click View All Applications.

By default, the data is shown in the chart view. Table 52 on page 128 shows the different filters you can
use to view the source IP address data in chart view.

Table 52: Source IP Visibility—Filters in Chart View

DescriptionFilter

By default, data is shown for all the devices in the network. Click Edit to select root devices,
Logical Systems (LSYS) devices, or Tenant Systems (TSYS) devices to view the result.

All Devices
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Table 52: Source IP Visibility—Filters in Chart View (continued)

DescriptionFilter

Select the following options from the list to view the source IP address data:

• Bandwidth—Shows data based on the amount of bandwidth the source IP address has
consumed for a particular time range.

• Number of Sessions—Shows data based on the number of sessions consumed by the source
IP addresses.

Show By

Select the required time range from the list to view the source IP address data.

Use the Custom option to choose the time range if you want to view data for more than one
day. The date range is from 00:00 hours to 23:59 hours.

Time Span

Select the way you want to view the source IP address data:

• Bubble graph

• Heat map

• Zoomable bubble graph

By default, data is shown in the bubble graph format.

Select Graph

Grid View Overview

Click the Grid View link for comprehensive details of source IP addresses. You can view top source IP
addresses by volume and top applications by volume. You can also view the data in a tabular format that
includes sortable columns. You can sort the source IP addresses in ascending or descending order. Use
the widgets to get an overall, high-level view of your source IP addresses. You can use the detailed view
to get more information about the applications, source IP addresses, and content traversing your network.

The column width, sort order, and column index are continual. The next time you log in, they will be right
where you left them.

Table 53 on page 129 and Table 54 on page 130 describe the fields on this page.

Table 53: Source IP Visibility—Widgets in Grid View

DescriptionWidget

Lists top five IP addresses sorted by their bandwidth consumption.Top IPs By Volume

Lists top five applications being accessed in your network for the specified
time range.

Top Apps By Volume
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Table 54: Source IP Visibility—Detailed View

DescriptionField

Shows the source IP addresses.Source IP

Shows the bandwidth consumption of the source IP address.Volume

Shows the number of sessions of the source IP address. Click this field to see the logs
that contributed to these sessions, in the All Events page.

Total Sessions

Shows all the applications used by the source IP address. Click the application to see
a detailed view of the applications in the Application Visibility page.

Applications

You can invoke the block workflow for any source IP from the grid view.

To invoke the block workflow for a source IP address, you can perform one of the following tasks:

• Select a source IP address and click Block IP. The Block page appears.

• Select a source IP address and click Block User. The Block Users page appears.

• Select a source IP address, and then select the required applications from the Top 5 Applications field
and click Block Application(s). The Block Application page appears.

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.1, you can use the Source IP Visibility
page to view information related to bandwidth consumption, session establishment, and the
risks associated with the source IP addresses.

16.1
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Blocking Source IP Addresses

You can block a source IP address from accessing either all applications or only selected applications by
editing policy rules. Then you can view the policy changes by clicking the policy name or view affected
devices by clicking the device count. Also, you can click the policy to view the affected rules, edit the rules,
and save them, if required.

NOTE: Starting in Junos Space Security Director Release 21.1, when unified policy rules permit
the traffic, selecting block action creates block rules in the appropriate unified policy.

To block the source IP address:

1. SelectMonitor > Source IP.

The Source IP Visibility page appears.

2. In the Chart View, hover over the source IP address for which you want to block applications.

A pop upwindow appears showing the information on the number of sessions, bandwidth consumption,
and top five applications of that particular IP address.

NOTE: Click View All Applications to view all the applications of the source IP address on
the Application Visibility page. You can select an application and block it by clicking Block
Application.

3. Block the source IP address from accessing all applications by clicking Block IP.

The Block Application page appears.

Block the source IP address from accessing a particular application by selecting the application listed
under the Top 5 Applications table, and then click Block Application(s).

The Block User page appears. All the policies that need to be edited to block the IP address from
accessing the applications are listed under the Policy Name column.

4. Select the required policies to edit the rules to block the IP address.

5. Select Run now to immediately publish or update the changes or select Schedule at a later time to
publish or update the changes later.

6. Click Save to save the configuration settings.
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Click Publish to publish the changes.

Click Update to update the changes.

RELATED DOCUMENTATION

Source IP Visibility Overview | 128
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CHAPTER 26

Live Threat Map
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Threat Map Overview

The threat map allows you to visualize geographical regions for incoming and outgoing traffic. You can
view blocked and allowed threat events based on feeds from IPS, antivirus, and antispam engines.
Unsuccessful login attempts for devices are also displayed. An event count for each attack object can be
viewed by clicking a specific geographical location. This is useful for viewing unusual activity that could
indicate a possible attack. If you have deployed your firewall devices across the globe, you can find the
country that is attacking your firewall devices the most by using the threat map.

NOTE: The devices can be root device, logical systems (LSYS), or tenant systems (TSYS).

Threats are color-coded and can be seen at the bottom of the page. You also get a quick view of total
number of threats blocked and allowed, an individual count of threats blocked and allowed for each event,
as well as the top targeted devices, top destination countries, and top source countries.

You can click any individual source or destination point on the map to review information about the threat
events, including the number of threat events, type of threat, time of events, source IP, and destination
IP. You can also perform further analysis of the attack by clicking the attack type and viewing the filtered
list of events from the Event Viewer.

Starting in Junos Space Security Director Release 16.1, you can click a country on the threat map to bring
up the respective country page. You can view the total threat events since midnight, followed by inbound
and outbound threat events. You see the highest top five inbound and outbound IP addresses. You can
also view all IP addresses with the option to block one or more of them. In addition, you can block all traffic
or only the inbound and outbound traffic for the selected country.
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Click View Details to see more details for the country on the right panel. In addition, you can see total
number of inbound and outbound threats for each event.

Table 55 on page 134 describes different types of threats blocked and allowed.

Table 55: Types of Threats

DescriptionAttack

Intrusion detection and prevention (IDP) attacks detected by the IDP module.

The information reported about the attack includes:

• Source of attack

• Destination of attack

• Type of attack

• Session information

• Severity

• Policy information that permitted the traffic.

• Action: traffic permitted or dropped.

IPS Threat Events

E-mail spam that is detected based on the blocklist spam e-mails.

The information reported about the attack includes:

• Source

• Action: E-mail is rejected or allowed.

• Reason for identifying as e-mail spam.

Spam Events

Virus attacks detected by the antivirus engine.

The information reported about the attack includes:

• Source of the infected file

• Destination

• Filename

• URL used for accessing the file

Virus Events

The firewall authentication messages generated due to unauthorized attempts to access the
network. The reported information contains the reason for authentication failure and the
source of the request.

Device
Authentications
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Table 55: Types of Threats (continued)

DescriptionAttack

A type of threat detected by SRX Series devices. The information reported about the attack
includes:

• Attack name

• Action taken

• Source of the attack

• Destination of the attack

Screen

A type of threat detected by SRX Series devices in collaboration with ATP Cloud software.
The information reported about the attack includes:

• Malware name

• Action taken

• Infected host

• Source of the attack

• Destination of the attack

ATP Cloud

NOTE: Threats with unknown geographical IP addresses are displayed as undefined.

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.1, you can click a country on the
threat map to bring up the respective country page.

16.1
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Blocking Threat Events

Starting in Junos Space Security Director Release 16.1, you can block all traffic or block only the inbound
and outbound traffic for a selected country.When you click a country on the threat map, the country page
appears with details on total threat events since midnight, followed by inbound and outbound threat
events. You can see the highest top five inbound and outbound IP addresses. You can select one or more
IP addresses to block.

Blocking an IP address or a country requires policy rules to be edited. View policy changes by clicking the
policy name or view affected devices by clicking the device count. Only policies permitting this traffic in
the past 30 days are shown.

Click View Details to see more details for the country on the right panel. Click View All to view all the
inbound and outbound IP addresses.

NOTE: Starting in Junos Space Security Director Release 21.1, when unified policy rules permit
the traffic, selecting block action creates block rules in the appropriate unified policy.

The following block operations are described below:

• To block IP addresses

• To block all traffic

• To block outbound traffic

• To block inbound traffic

To block IP addresses:

1. SelectMonitor > Threats Map (Live).

A geographical map is displayed with incoming and outgoing traffic.

2. Click a country in the map.

The corresponding country page appears with details on the threat events since midnight, as well as
the highest top five inbound and outbound IP addresses. You can also view the details of the inbound
and outbound events for the selected country.

3. Click the Inbound or the outbound tab, and then select one or more IP addresses.

4. Click Block IP Address.

The Block (Outbound or Inbound) IP Address page appears with policies that contain the rules. The
listed policies are edited to block all inbound or outbound traffic from the selected IP addresses.
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5. Click a policy.

The Policy Preview Changes page appears with the number of rules added, modified, and deleted. You
can preview the policy rules.

6. Click OK to close the Policy Changes Preview page.

7. Click Save to save your changes.

8. Click Publish to publish your changes.

9. Click Update to update your changes.

To block all traffic:

1. SelectMonitor > Threats Map (Live).

A geographical map is displayed with incoming and outgoing traffic.

2. Click a country.

The corresponding country page appears with details on the threat events since midnight, as well as
the highest top five inbound and outbound IP addresses. You can view the details of the inbound and
outbound events for the selected country.

3. Click Block all traffic to block all traffic from the selected country.

The Block all traffic page is displayed with the policies that contain the rules to be edited to block all
the traffic from the selected country.

4. Click a policy.

The Policy Changes Preview page is displayed with the number of rules added, modified, and deleted.
You can preview the rules.

5. Click OK to close the Policy Changes Preview page.

6. Click Save to save your changes.

7. Click Publish to publish your changes.

8. Click Update to update your changes.
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You can block traffic sent from one county to another country (outbound traffic). To block outbound traffic:

1. SelectMonitor > Threats Map (Live).

A geographical map is displayed with incoming and outgoing traffic.

2. Click a country that is sending traffic to another country.

The corresponding country page appears with details on the threat events since midnight, as well as
the highest top five inbound and outbound IP addresses.

3. Click Block outbound.

The Block Outbound page is displayed with the policies that contain the rules to be edited to block all
outbound traffic from the selected country.

4. Click a policy.

The Policy Changes Preview page is displayed with the number of rules added, modified, and deleted.
You can preview the rules.

5. Click OK to close the Policy Changes Preview page.

6. Click Save to save your changes.

7. Click Publish to publish your changes.

8. Click Update to update your changes.

You can block traffic coming to a country from another country (inbound traffic). To block inbound traffic:

1. SelectMonitor > Threats Map (Live).

A geographical map is displayed with incoming and outgoing traffic.

2. Click a country that is receiving traffic from another country.

The corresponding country page appears with details on the threat events since midnight, as well as
the highest top five inbound and outbound IP addresses.

3. Click Block inbound.

The Block Inbound page is displayed with the policies that contain the rules to be edited to block all
the inbound traffic to the destination country.

4. Click a policy.
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The Policy Changes Preview page is displayed with the number of rules added, modified, and deleted.
You can preview the rules.

5. Click OK to close the Policy Changes Preview page.

6. Click Save to save your changes.

7. Click Publish to publish your changes.

8. Click Update to update your changes.

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.1, you can block all traffic or block
only the inbound and outbound traffic for a selected country.

16.1
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CHAPTER 27

Threat Monitoring
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Threat Monitoring Overview

You can monitor and get detailed information about all the top threats detected over time by category
and technology. . Threats are defined as any IPS, antivirus, antispam, device authentication failure, screen,
SecIntel, or Juniper Advanced Threat Prevention Cloud (Juniper ATP Cloud).

Using the time-frame slider, you can instantly focus on areas of unusual activity by dragging the time slider
to the area of interest to you. The slider and the Custom button are available for both Summary View and
Detailed View. You can select the time range and decide how to view the data, using the summary view
or detail view tabs.

You can change the time range by manually moving the time-frame slider in the widget provided or by
clicking the predefined time ranges available in the top right corner of the Threat Monitoring page. The
data will be automatically reloaded with threats that occurred in the newly selected time range.

By default, you can view data for all the devices. To view data for a specific device, click on the link beside
Devices and select one or more devices.

You can view, sort, search, and filter the threat information based on the following:

• Source

• Destination

• Number of instances

• Severity

• Number of instances over time

• How often the target is attacked

• Severity by type of attack

• Network attack interval overtime
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Summary View

Click Summary View for a brief summary of all the threats in the network.

The widgets in the Summary view, displays critical information such as top threats by incident count, top
source countries, top targeted devices, top destination countries, top attackers, top source zones, and top
destination zones.

The following options are available to view the widgets in summary view:

• Bubble Chart - When you select Bubble Chart to view the threats, the incidents are indicated through
color codes.

• Bar Chart - When you select Bar chart, the intensity of the incidents is indicated through bars.

• Grid View – When you select Grid View, the data is shown in a tabular format.

See Table 56 on page 141 for descriptions of the widgets in Summary view.

Table 56: Widgets in the Summary View

DescriptionWidget

Displays all the threats by incident count.Top Threats by Incident Count

Displays the top five source countries under threat.Top Source Countries

Shows the top five devices which are most likely to be under threat.Top Targeted Devices

Displays the top five destination countries under threat.Top Destination Countries

Displays the top five attackers in the network.Top Attackers

Displays the top five source zones under threat.Top Source Zones

Displays the top five destination zones under threat.Top Destination Zones

Detailed View

Click Detail View for comprehensive details of threats in a tabular format that includes sortable columns.
You can select specific parameters from the Group By drop-down menu and can also search and filter a
specific attribute or event from the search window provided. You can now also drag and drop an event
to the search window to apply filters.

Select Show raw log from theMore drop down to view the real time logs received for a specific event
that is selected.
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Select Show event details from theMore drop down menu to view the complete details of logs for a
selected event. You can view general information, source information, destination information, and security
information of logs.

Select Export to CSV option from the grid settings pane to export and download the log data in CSV file.

Select Show Hide Columns from the grid settings pane to show or hide various parameters in the grid.

See Table 57 on page 142 for field descriptions in detail view.

Table 57: Fields in the Detailed view

DescriptionField

The event category of the threat.Event Category

Attack name of the threat.Attack Name

The name of the virus.Virus Name

The URL from which the threat generated.URL

Information of the malware.Malware Info

The severity level of the threat.Threat Severity

The source IP address from where the threat occurred.Source IP

The destination IP address of the threat.Destination IP

The event name of the threat.Event Name

Action taken for the threat: deny, allow, and block.Action

The source zone of the threat.Source Zone

The destination zone of the threat.Destination Zone

The source country name.Source Country

The destination country name from where the threat occurred.Destination Country

The host name of the client.Client Hostname

The name of the application service.Service Name
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Table 57: Fields in the Detailed view (continued)

DescriptionField

The user name of the threat event.User Name

The name of the logical system.Logical System Name

The application name from which the threats are generated.Application

Nested application that is running over the parent application.Nested Application

The source port of the threat.Source Port

Destination port of the threat.Destination Port

The name of the rule.Rule Name

The name of the threat monitoring profile that triggered the event.Profile Name

Role names associated with the threat.Roles

Reason for the generation of the threat.Reason

The translated (or natted) source IP address. It can contain IPv4 or IPv6
addresses.

NAT Source IP

The translated (also called natted) destination IP address.NAT Destination IP

Translated source port.NAT Source Port

Translated destination port.NAT Destination Port

The NAT source rule name.NAT Source Rule Name

The NAT destination rule name.NAT Destination Rule Name

The host name of the targeted device.Hostname

Number that identifies the session.Traffic Session ID

The name of the logical system in JSA logs.Logical Subsystem Name

Description of the threat.Description
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Table 57: Fields in the Detailed view (continued)

DescriptionField

The policy name which triggered the event.Policy Name

IP address of the log source.Log Source

The time when the log was generated.Log Generated Time

The time when the log was received.Log Received Time
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Alerts and Alarms - Overview
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Alerts and Alarms Overview

Alerts and notifications are used to notify administrators about significant events within the system.
Notifications can also be sent through e-mail. Youwill be notifiedwhen predefined network traffic condition
is met. Alert trigger threshold is number of network traffic events crossing a pre-defined threshold within
a period of time. Alarmsworkspace shows active alarms of devices currently managed by Security Director.

Alerts and notifications provide options for:

• Defining alert criteria based on a set of predefined filters. You can use the filters defined in the Filter
Management window on the Event Viewer page to generate alerts.

• Generating an alert message and notifying you when an alert criteria are met.

• Searching for specific alerts on the Generated Alerts page based on alert ID, description, alert definition,
alert type, or recipient e-mail address.

• Supporting event-based alerts.

For example, If you are an administrator, you can define a condition such that if the number of firewall-deny
events crosses a predefined threshold in a given time range for a specific device, you receive an e-mail
alert.

NOTE: If a threshold is crossed and remains so for a long duration, new alerts are not generated.
Alerts are generated again when the number of logs matching the alert criteria drops below the
threshold and crosses the threshold again.
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Understanding Role-Based Access Control for the Alerts and Alert Definitions

NOTE: Youmust have Security Analyst or Security Architect role or have permissions equivalent
to that role to access the alerts and alert definitions.

You must have the following privileges under Administration > Users & Roles > Roles:

• Create Alert Definition under Create Role > Privileges > Alerts > Alert Definitions to create alerts.

• Modify Alert Definition to modify alerts.

• Delete Alert Definition to delete alerts.

• User account under Role Based Access Control to search for user accounts in alert definitions.

RELATED DOCUMENTATION

Creating Alert Definitions | 150

Deleting Alert Definitions | 154

Searching Alert Definitions | 155

Domain RBAC Overview | 1316
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Alerts and Alarms-Alerts
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Deleting an Alert

To delete an alert or multiple alerts:

1. SelectMonitor > Alerts & Alarms > Alerts.

2. Select an alert or multiple alerts for deletion.

3. On the upper left side of the Alerts page, click the delete icon (X).

The delete alert notification is displayed.

4. Click OK.

The alert is deleted.

RELATED DOCUMENTATION

Alerts and Alarms Overview | 145

Creating Alert Definitions | 150

Searching Alerts

To quickly locate an alert use the search option on the upper right side of the Alerts page:
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1. Enter the alert ID, description, or alert name in the search box.

2. Click the search icon.

RELATED DOCUMENTATION

Alerts and Alarms Overview | 145

Creating Alert Definitions | 150

Using Device Alarms | 157

Using Generated Alerts

Use the Generated Alerts page to view the system event-based alerts in response to a configured alert
definition. The generated alerts help you to identify problems that appear in your monitored network
environment. You can view statistics such as the number of critical and non-critical alerts.

Before You Begin

• Read the “Alerts and Alarms Overview” on page 145 topic.

• Review the Generated Alerts main page for an understanding of existing generated alarms. See “Alert
Definitions Main Page Fields” on page 155 for field descriptions.

• You must add the following configuration to the managed SRX devices:

set snmp trap-group sdfm version all
set snmp trap-group sdfm destination-port 10164
set snmp trap-group sdfm categories authentication
set snmp trap-group sdfm categories chassis
set snmp trap-group sdfm categories link
set snmp trap-group sdfm categories routing
set snmp trap-group sdfm categories startup
set snmp trap-group sdfm categories rmon-alarm
set snmp trap-group sdfm categories vrrp-events
set snmp trap-group sdfm categories configuration
set snmp trap-group sdfm categories services
set snmp trap-group sdfm categories chassis-cluster
set snmp trap-group sdfm categories sonet-alarms
set snmp trap-group sdfm targets x.x.x.x (eth0 IP of space)
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To use the Generated Alerts page:

1. SelectMonitor > Alerts & Alarms > Alerts. The Alerts page appears.

2. Use the guidelines provided in Table 58 on page 149 to learn about the page.

Table 58: Generated Alerts

GuidelinesAction

Select the generated alert and then right-click or clickMore > Jump to Events
and Logs. The corresponding events that triggered the alert are displayed.

Jump to Event Viewer

Select the generated alert and then right-click or clickMore > Detail View.Detail View

Select the generated alert and then right-click or clickMore > Clear All Selections.Clear All Selections

RELATED DOCUMENTATION
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Creating Alert Definitions

Use the Alert Definitions page to generate alerts that warn you of problems in yourmonitored environment.
An alert definition consists of data criteria for triggering an alert. An alert is triggered when the event
threshold exceeds the data criteria that is defined.

You can create an alert definition to monitor your data in real time. You can identify issues and attacks
before they impact your network.

For example, if you are an administrator, you can define a condition such that if the number of firewall
deny events crosses a predefined threshold in a given time frame for a specific device, you receive an
email alert.

Before You Begin

• Read the “Alerts and Alarms Overview” on page 145 topic.

• Review the Alert Definitions main page for an understanding of your current data set. See “Alert
Definitions Main Page Fields” on page 155 for field descriptions.

To create an alert definition:

1. SelectMonitor > Alert & Alarms > Alert Definitions.

2. Click the + icon.
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3. Complete the configuration according to the guidelines provided in Table 59 on page 151.

4. Click Ok.

A new alert definition with the configured alert triggering condition is created. You can view the generated
alerts from the alert definition to troubleshoot the issues with your system.

Table 59: Alert Definitions Settings

GuidelineSetting

General

Enter a unique string of alphanumeric characters, colons, periods, dashes, and
underscores. No spaces are allowed and the maximum length is 63 characters.

Alert Name

Enter a description for the alerts; maximum length is 1024 characters.Alert Description

Displays the type of alert that is system based.Alert Type

Select the Active check box to view only the active alerts.Status

Select the severity level of the alert: Info, minor, major, critical.Severity

Devices

Select all devices or specific devices. By default, data is displayed for all the devices
in the network.

If you choose the Selective option, select devices from the Available column and click
the right arrow to move these devices to the Selected column and click OK.

Select Devices

Trigger

Specifies the data criteria from the list of default and user-created filters that are
saved from the Event Viewer.

To add saved filters:

• Click the Use data criteria from filters link. The Add Saved Filters page appears.

• Select the filters to be added.

• Click OK.

Data Criteria

Specify the time period for triggering an alert.Time Span
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Table 59: Alert Definitions Settings (continued)

GuidelineSetting

Enter the event threshold (number of logs for each category). An alert triggers if the
number exceeds the specified threshold.

Number of Events

Recipient(s)

Specify the e-mail addresses for the recipients of the alert notification.E-mail address(es)

Enter a custom string for identifying the type of alert in the alert notification e-mail.Custom Message
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Editing Alert Definitions

To edit an alert definition:

1. Select Alerts & Alarms > Alert Definitions.

2. Select the alert.

3. On the upper right side of the Alert Definitions page, click the pencil icon.

The alert definitions options are displayed. See Table 60 on page 152 for options available for editing.

4. Click OK.

Table 60: Alert Definitions Settings

GuidelineSetting

General
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Table 60: Alert Definitions Settings (continued)

GuidelineSetting

Enter a unique string of alphanumeric characters, colons, periods, dashes, and
underscores. No spaces are allowed and the maximum length is 63 characters.

Alert Name

Enter a description for the alerts; maximum length is 1024 characters.Alert Description

Displays the type of alert that is system based.Alert Type

Select the Active check box to view only the active alerts.Status

Select the severity level of the alert: Info, minor, major, critical.Severity

Devices

Select all devices or specific devices. By default, data is displayed for all the devices
in the network.

If you choose the Selective option, select devices from the Available column and click
the right arrow to move these devices to the Selected column and click OK.

Select Devices

Trigger

Specifies the data criteria based on the Time period, Group By, and Filter By option.
Filtered data only displays the subset of data that meets the criteria that you specify.

To edit the data criteria:

• Click the Edit data criteria from filters link. The Add Saved Filters page appears.

• Select the filters to be added.

• Click OK.

Data Criteria

Specify the time period for triggering an alert.Time Span

Enter the event threshold (number of logs for each category). An alert triggers if the
number exceeds the specified threshold.

Number of Events

Recipient(s)

Specify the e-mail addresses for the recipients of the alert notification.Email address(es)

Enter a custom string for identifying the type of alert in the alert notification e-mail.Custom Message
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Cloning Alert Definition

You can clone an existing alert definition.

To clone an alert definition:

1. SelectMonitor > Alerts & Alarms > Alert Definitions.

2. Right-click an alert, or select Clone from theMore link.

The Clone window appears with editable fields.

3. Click OK to save your changes.
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Deleting Alert Definitions

To delete an alert definition or multiple alert definitions:

1. SelectMonitor > Alerts & Alarms > Alert Definitions.

2. Select an alert definition or multiple alert definitions for deletion.

3. On the upper left side of the Alert Definitions page, click the delete icon (X).
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The delete alert definition notification is displayed.

4. Click OK.

The alert definition is deleted.
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Searching Alert Definitions

To quickly locate an alert definition, use the search option on the upper right side of the Alert Definitions
page:

1. Enter the alert definition name, description, or recipient name in the search box.

2. Click the search icon.

RELATED DOCUMENTATION
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Alert Definitions Main Page Fields

Use this page to understand the alert definitions. Table 61 on page 155 describes the fields on this page.

Table 61: Alert Definition Main Page Field

DescriptionField

Provides the option to select the available alerts.Select

Specifies the name of the alert.Alert Name
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Table 61: Alert Definition Main Page Field (continued)

DescriptionField

Specifies the description of the alert.Alert Description

Specifies the filter generating the alerts.Filter

Specifies the recipients of the alerts generated from the alert definitions.Recipients

Specifies the active alerts.Active
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Using Device Alarms

Use this page to view system-generated alarms. Alarms provide information about the status and the
health state of the system. The alarms received from the Junos Space platform are viewed from Security
Director. These generated alarms can help you to troubleshoot issues associated with your system.

NOTE: On the right side of the banner is a bell-shaped icon called the Notification Center.
Clicking this icon reveals lists of the most recent critical alerts and alarms in Security Director.
Clicking theViewAll Alarms orViewAll Alerts link takes you to the detail page for the respective
topic.

Before You Begin

• Read the “Alerts and Alarms Overview” on page 145 topic.

• Configure the SRX Series devices to send SNMP traps to the Junos Space platform. The alarms displayed
are new alarms based on the SNMP traps received by Security Director.

• In case of Space cluster, the SNMP target should be the eth0 IP address of all the nodes in Space cluster.

• The existing alarms prior to SNMP target configuration will not be displayed in Security Director.

• To view the alarms in Security Director, add the following configuration to the managed SRX Series
devices through the CLI:

set snmp trap-group sdfm version all

set snmp trap-group sdfm destination-port 10164
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set snmp trap-group sdfm categories authentication

set snmp trap-group sdfm categories chassis

set snmp trap-group sdfm categories link

set snmp trap-group sdfm categories routing

set snmp trap-group sdfm categories startup

set snmp trap-group sdfm categories rmon-alarm

set snmp trap-group sdfm categories vrrp-events

set snmp trap-group sdfm categories configuration

set snmp trap-group sdfm categories services

set snmp trap-group sdfm categories chassis-cluster

set snmp trap-group sdfm categories sonet-alarms

set snmp trap-group sdfm targets x.x.x.x (eth0 IP of space)

• Review the Device Alarmsmain page for an understanding of existing device alarms. See “Device Alarms
Main Page Fields” on page 159 for field descriptions.

To use the Device Alarms page:

1. SelectMonitor > Alerts & Alarms > Alarms. The Alarms page appears.

2. Use the guidelines provided in Table 62 on page 158 to learn about the page.

Table 62: Generated Alarms

GuidelinesAction

Select the generated alarm and then right click or clickMore >Detail View.View Alarm Details
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Device Alarms Main Page Fields

Use this page to view system-generated alarms.

Table 63 on page 159 describes the fields on this page.

Table 63: Device Alarms Main Page Fields

DescriptionField

Name of the alarm. For example, authentication failure.Alarm Name

Description of the alarm.Alarm Description

IP address of the device that reported the alarm.Reporting Device

Severity level of the alarm: Critical, Major, Minor, and Information.Severity

Date and time when the alarm was generated.Last Updated
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IPsec VPNMonitoring Overview

You can view the status of IPsec VPNs and their tunnels between device endpoints after configuring,
publishing, and updating them in Security Director. The status is displayed in dashboard and tabular format.
The number of tunnels for each VPN depends on the type of VPN. You can view the tunnel status of IPsec
VPNs configured on devices that are managed by Security Director.

Starting in Junos Space Security Director Release 20.3, you can monitor the status of remote VPNs.

NOTE: Security Director cannot monitor the tunnel status if the VPN is configured between a
Juniper and a non-Juniper (extranet) device.

IPsec VPN monitoring micro-service runs at specified intervals and updates the status of the IPsec VPN
tunnel as up or down. It polls log collector data every 5 minutes by default and SRX Series device every 6
hours.

The following configuration should be done to send all the logs including KMD logs to Security Director
log collector:

set system syslog host <IP> any any

set system syslog host <IP> structured-data

160



Here, IP is the log collector IP and any anymeans all the system logs will be sent to Security Director Log
Collector.

Figure 18 on page 161 shows the overview page. It displays the dashboards for monitoring current VPNs,
its tunnels, and historical tunnel status pattern in the past.

In theMonitored Tunnels dashboard, you can view the total number of IPsec VPN tunnels and the number
of tunnels that are up and down. Each block is a tunnel and is sorted by both modified date and created
date. Modified tunnels appears first followed by created tunnels. You can hover over each block to view
the tunnel endpoints, status, when the tunnel was created and modified, and the IP addresses of the
devices. If the status is down, then a reason is also displayed.

In the VPNs Overview dashboard, you can view the number of IPsec VPNs and their status. Hover over
the chart to view the status as up or down.

In the No. of Monitored Tunnels Flipped Up/Down dashboard, you can select a duration from the period
drop-down list to view the tunnel status pattern in the past. Based on the selected duration, a time range
and graph are displayed with the tunnel status data. Hover over the graph to view the number of tunnels
and its status during a particular time slot.

Figure 18: Overview Page

Figure 19 on page 162 shows theMonitored Tunnels page. It displays tunnel statistics in tabular format. It
shows the IPsec VPNs and displays their tunnel status as up, down, or unknown. A reason is provided only
for tunnels with a down status. You also see devices and their endpoints.
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Figure 19: Monitored Tunnels

Figure 20 on page 162 shows the Devices page. It displays IPsec VPN statistics in tabular format. It shows
all the VPNs and their types, all the devices in a VPN, total number of tunnels, and the number of tunnels
that are down.

Figure 20: Devices Page

In previous releases of Security Director, network administrators had to analyze the VPN logs on an SRX
Series device to check the status of VPNs and their tunnels. It required administrators to have expertise
in parsing VPN logs to get the information they needed. Network Administrators can now view the IPsec
VPN and its tunnel status directly in Security Director. A reason is displayed in the Security Director user
interface when a tunnel is down.

RELATED DOCUMENTATION

IPsec VPN Overview | 899

Publishing IPsec VPNs | 975

162



Updating IPSec VPN | 976

About the Overview Page | 163

Managing Monitored and Unmonitored VPNs | 165

About the Monitored Tunnels Page | 166

About the Devices Page | 167

About the Overview Page

To access this page, selectMonitor > VPN > Overview.

Use the Overview page to view the total number of monitored IPsec VPNs, tunnels, their status as either
up or down, and historical tunnel data over time, ranging from 30 minutes to 2 months.

Starting in Junos Space Security Director Release 20.3, you can monitor the status of remote VPNs.

Tasks You Can Perform

You can perform the following tasks from this page:

• Manage monitored and unmonitored VPNs. See “Managing Monitored and Unmonitored VPNs” on
page 165.

• View current tunnel details in the Monitored Tunnels dashboard.

• View current VPN details in the VPNs Overview dashboard.

• View historical tunnel data in the No. of Monitored Tunnels Flipped Up/Down dashboard.

Field Descriptions

Table 64 on page 163 provides guidelines on using the dashboard widgets on the Overview page.

Table 64: Dashboard Widgets on the Overview Page

DescriptionDashboardWidgets
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Table 64: Dashboard Widgets on the Overview Page (continued)

DescriptionDashboardWidgets

You can view the total number of IPsec VPN tunnels and the number of tunnels that are up
and down. Each block is a tunnel and is sorted by bothmodified date and created date.Modified
tunnels appears first followed by created tunnels. You can hover over each block to view the
tunnel endpoints, status, when the tunnel was created and modified, and the IP addresses of
the devices. If the status is down, then a reason is also displayed.

Click the refresh icon on the right top corner of the dashboard to refresh the details.

Click View Event Logs to navigate to the All Events page to view information for security
events based on IPsec VPN profiles.

ClickMore details to navigate to theMonitored Tunnels page to view the same data in tabular
format.

Monitored Tunnels

You can view the number of IPsec VPNs and their status. Hover over the chart to view the
status as up or down.

ClickMore details to navigate to the Devices page to view more details about the devices in
the VPN and the tunnel status.

Click the refresh icon on the right top corner of the dashboard to refresh the details.

VPNs Overview

You can select a duration from the period drop-down list to view the tunnel status pattern in
the past. Based on the selected duration, a time range and graph are displayed with the tunnel
status data. Hover over the graph to view the number of tunnels and its status during a
particular time slot.

Each duration displays a fixed number of slots and static data is displayed for these slots.

Click the refresh icon on the right top corner of the dashboard to refresh the details.

ClickMore details to view the data in the Monitored Tunnels page.

No. of Monitored
Tunnels Flipped
Up/Down
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Managing Monitored and Unmonitored VPNs

You can select IPsec VPNs for which you want to monitor status. You can view the total number of
monitored VPNs in the Overview page. You can select VPNs that you want to start and stop monitoring
in the Manage Monitoring VPNs page.

To start and stop monitoring VPNs:

1. SelectMonitor > VPN >Overview.

2. Click Edit.

The Manage Monitoring VPNs page is displayed.

3. Select All to monitor the status of all the VPNs. Select Any to monitor the status of specific VPNs.

4. If you selectAny, then you can select IPsec VPNs and use the > or < arrow tomove them fromMonitored
VPNs to Unmonitored VPNs and vice versa. You can enter an IPsec VPN to search for in the text box.

5. Click OK.

You can view the total number of VPNs monitored in the Overview page.
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About the Monitored Tunnels Page

To access this page, selectMonitor > VPN > Tunnels.

Use the Monitored Tunnels page to view tunnel statistics in tabular format. It shows the IPsec VPNs and
displays their tunnel status as up, down, or unknown. A reason is provided only for tunnels with a down
status. You also see devices and their endpoints.

Starting in Junos Space Security Director Release 20.3, you can monitor the tunnel statistics of remote
VPNs.

Tasks You Can Perform

You can perform the following tasks from this page:

• View tunnel statistics such as VPN name, tunnel status, and so on in a tabular format.

Field Descriptions

Table 65 on page 166 provides guidelines on using the fields on the Monitored Tunnels page.

Table 65: Fields on the Monitored Tunnels Page

DescriptionFields

Specifies the name of the IPsec VPN. Click the name to navigate to the IPsec VPNs
page.

VPN Name

Specifies the status of the tunnel: Up, Down, or Unknown.Tunnel Status

Specifies a reason when the tunnel status is down.Reason

Specifies the IPv4 address of the source device.Device 1

Specifies the name of endpoint 1.End Point 1

Specifies the IPv4 address of the destination device.Device 2

Specifies the name of endpoint 2.End Point 2

Specifies the date and time when the tunnel was created.Created
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Table 65: Fields on the Monitored Tunnels Page (continued)

DescriptionFields

Specifies the date and time when the last poll was performed for a tunnel.

IPsec VPN monitoring micro-service polls log collector data every 5 minutes and
SRX Series device every 6 hours.

Last Refresh Time
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About the Devices Page

To access this page, selectMonitor > VPN > VPNs.

Use the Devices page to view IPsec VPN statistics in tabular format. It shows all the VPNs and their types,
all the devices in a VPN, total number of tunnels, and the number of tunnels that are down.

Starting in Junos Space Security Director Release 20.3, you can monitor the statistics of remote VPNs.

Tasks You Can Perform

You can perform the following tasks from this page:

• View IPsec VPN statistics, such as name, type, and so on.

• Filter the data in the table based on the VPN name and its type. Click the filter icon and enter the filter
criteria.

Field Descriptions

Table 66 on page 168 provides guidelines on using the fields on the Devices page.
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Table 66: Fields on the Devices Page

DescriptionField

Specifies the IPsec VPN name.

Click > displayed beside the name to view the devices in the VPN.

Name

Specifies the type of VPN, such as site-to-site, full-mesh, or hub-and-spoke.Type

Specifies the total number of tunnels in each device.No. Tunnels

Specifies the number of tunnels that are down.Tunnels Down
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CHAPTER 33

Insights

IN THIS CHAPTER

How to Monitor Incidents | 169

How to Monitor Mitigation | 175

How to Monitor Incidents

Use the Incidents page to view all incidents related to an endpoint in a user timeline view. To access the
Incidents page, selectMonitor > Insights > Incidents.

There are two ways to view your data. You can select either the Grid view or the Plot view. By default,
the data is displayed in Grid view. In the Timeline section, you can select a log parser from the list to view
log data in the timeline graph. You can zoom in, zoom out, show all data, and refresh the data.

Grid View

Click Grid View for a comprehensive details about incidents. You can view the incident ID, state of the
incident, progression, and so on. You can expand an incident to view more details and create ServiceNow
tickets if required, as shown in Figure 21 on page 170.
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Figure 21: Grid View for Incidents

After you create a ticket, the status of the incident changes to Acknowledged, as shown in
Figure 22 on page 171

170



Figure 22: Incidents Status Changed

Table 67 on page 171 describes different fields available in this view. You can view data for a custom time
range, last 24 hours, last week, last month, and last year.

Table 67: Fields on the Grid View Page

DescriptionField Name

Specifies the status of the ServiceNow ticket. After you create a ServiceNow
ticket, the status shows Acknowledged, as shown in Figure 22 on page 171.

Status

Specifies the incident ID.Incident ID

Specifies the threat metric and severity rating.Risk

Specifies the progression of an incidentProgression

Specifies the IP address of the targeted host.Threat Target

Specifies the timestamp of the incident.Date & Time

In the Status column, click > to see additional details (apart from details provided in Table 67 on page 171)
about an incident, such as:
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• Hostname—If Juniper Identity Management Service (JIMS) is configured, the hostname is shown.

• Username—If JIMS is configured, the username is shown.

• IP address

• Number of events that contributed to an incident

• Fully qualified domain name (FQDN)

• Threat severity value

• Number of threat sources associated with the Incident

Table 68 on page 172 explains the other options available for each incident.

Table 68: Options for Each Incident

DescriptionOption

Select Incident Details to see the following information about an incident:

• Name of the incident

• Source IP address of the incident

• Date and time of the event

• Vendor response for the event

• Name of the log parser

• Progression details

• Detection method

• Endpoint IP address

• Raw log of the event

• Starting and ending severity levels

Incident Details

SelectMitigate Incident to enable the mitigation if it’s disabled and vice versa.

To mitigate incidents, you must have already configured ATP Cloud or Policy Enforcer. For more
information about mitigation settings, see “Configure Mitigation Settings” on page 1399

Mitigate Incident
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Table 68: Options for Each Incident (continued)

DescriptionOption

You can create a ServiceNow ticket for an incident. Youmust have already configured ServiceNow
settings to create a ServiceNow ticket. See “About the ServiceNow Configuration Page” on
page 1404.

To create a ServiceNow ticket:

1. Select Create Ticket.

The Create ServiceNow Ticket page appears, as shown in Figure 23 on page 173.

Figure 23: Create ServiceNow Ticket Page

2. In the Urgency field, select the priority of the ticket from the list.

3. In the Short description field, provide a short description about the incident.

4. In the Description field, provide a more detailed description about the incident.

5. Click Submit.

Create Ticket

Plot View

Click the Plot View link for a brief summary of incidents represented in a soar bubble chart. Each bubble
represents a host and the bubble size is proportional to the number of threats, as shown in
Figure 24 on page 174.
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Figure 24: Incident Plot View

You can view data for a custom time range, last 24 hours, last week, last month, and last year.

Timeline View

You can view all incidents on a timeline graph. Hover over each event to seemore details about an incident.
In the Select Log Parser(s) list, you can select the required log parser. You can select either one or all the
log parsers. By default, the timeline graph shows all of the configured vendors in the log source.

Click Show All to see all events associated with an endpoint in the selected time range.

You can enable the Cluster option to cluster events belonging to the same time, as shown in
Figure 25 on page 174.

Figure 25: Cluster View of Incidents

You can also zoom in, zoom out, and reset the data in the timeline graph. The reset option shows events
for the corresponding incidents.
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How to Monitor Mitigation

Using the Mitigation page, you can view the list of endpoints and threat sources that are mitigated by
Security Director Insights. To access this page, selectMonitor > Insights >Mitigation. You can select an
event and disable the mitigation, if enabled, and vice versa, as shown in Figure 26 on page 175.

Figure 26: Mitigation Page

You can mitigate threat source IP addresses through ATP Cloud or Policy Enforcer. You must configure
ATP Cloud or Policy Enforcer to enable the mitigation. For more information about mitigation settings,
see “Configure Mitigation Settings” on page 1399.

You can perform the following actions from the Mitigation page:

• Source IP filtering—Select the Source IP Filtering option to view only the threat source IP addresses
that are mitigated by Security Director Insights.

• Endpoint IP filtering—Select the Endpoint IP Filtering option to view only the endpoint IP addresses
that are mitigated by Security Director Insights.

• Search—You can search for data based on the mitigation status, threat source or target IP addresses,
and detection date.

• Enable mitigation—If mitigation is disabled for an IP address, select an event for which you want to
enable mitigation and click Enable Mitigation. The Status column shows whether the enable task is
successful.

• Disable mitigation—If you want to disable mitigation for an IP address, select an event for which you
want to disable mitigation and click Disable Mitigation. The Status column shows whether the disable
task is successful or not.
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CHAPTER 34

Job Management

IN THIS CHAPTER

Using Job Management in Security Director | 177

Overview of Jobs in Security Director | 179

Archiving and Purging Jobs in Security Director | 179

Viewing the Details of a Job in Security Director | 181

Canceling Jobs in Security Director | 183

Reassigning Jobs in Security Director | 184

Rescheduling and Modifying the Recurrence of Jobs in Security Director | 186

Retrying a Failed Job on Devices in Security Director | 187

Exporting the Details of a Job in Security Director | 189

Job Management Main Page Fields | 191

Using Job Management in Security Director

Use the Job Management page to view all jobs that have been scheduled to run or have run from Junos
Space Security Director. By default, jobs are sorted by the Scheduled Start Time column. Depending on
your user account settings, you can view all jobs or only your jobs.

Before You Begin

• Read the “Overview of Jobs in Security Director” on page 179 topic.

• Review the JobManagement main page for an understanding of the existing jobs See “JobManagement
Main Page Fields” on page 191 for field descriptions.

To use the Job Management page:

1. SelectMonitor > Job Management.

The Job Management page appears.

2. Use the guidelines provided in Table 69 on page 178 to learn about the page.
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Table 69: Job Management Page Actions

GuidelineAction

Double-click a job or click the Detailed View icon that appears when you mouse
over the job to view the details of that job.

The Job Details page appears displaying the details of the audit log. See “Viewing
the Details of a Job in Security Director” on page 181.

View the details of a job

Click the Archive/Purge icon in the toolbar to purge jobs after archiving them.

The Archive/Purge Jobs page appears. See “Archiving and Purging Jobs in Security
Director” on page 179.

Archive and purge audit logs

Select one or more scheduled or in-progress jobs. From the right-click or More
menu, and select Cancel Jobs. See “Canceling Jobs in Security Director” on page 183.

Cancel jobs

Reassign scheduled or recurring jobs of one user to another user. See “Reassigning
Jobs in Security Director” on page 184.

Reassign Jobs

Reschedule a scheduled job or modify the recurrence settings of a job. See
“Rescheduling and Modifying the Recurrence of Jobs in Security Director” on
page 186.

Reschedule a job or modify the
recurrence settings of a job

Retry jobs that did not complete successfully on devices on which they were
configured to re-run. See “Retrying a Failed Job on Devices in Security Director” on
page 187.

Retry on Failed Devices
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Overview of Jobs in Security Director

A job is an action that is performed on any object that is managed by Junos Space, such as a device, service,
or user. The Job Management page lets you monitor the status of jobs that have run or are scheduled to
run in Junos Space. Jobs can be scheduled to run immediately or in the future.

Depending on the settings in your user account or remote profile, you can view only your own jobs or all
jobs.

NOTE: A user with the Super Administrator or Job Administrator role assigned can view all jobs
triggered by all users.

Junos Space maintains a history of job status for all jobs. When a job is initiated from a workspace, Junos
Space assigns a unique ID to that job, which serves to identify the job (along with the job type) on the Job
Management page. The following is a list of some of the job types supported in Security Director:

• Discover Network Elements

• Audit Log Archive/Purge

• Export Roles

• Export Device Configuration

• Add Application

• Resync Network Elements

• Role Assignment

• Delete Device

RELATED DOCUMENTATION
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Archiving and Purging Jobs in Security Director

The Archive/Purge Jobs page enables you to archive and then purge jobs. You can purge jobs before a
specified date and time. Jobs can be archived locally (on any node that is in the UP state) or to a remote
server. When you archive jobs locally, the archive files are stored in the default /var/lib/mysql/archive
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directory on the active Junos Space node. When you archive jobs to a remote server, the archive files are
stored in the directory that you specify.

To archive and purge jobs:

1. SelectMonitor > Job Management.

The Job Management page appears.

2. Click the Archive/Purge icon.

The Archive / Purge Jobs page appears.

3. Specify the jobs to be archived and purged according to the guidelines provided in Table 70 on page 180.

4. Click OK.

A job is triggered and you are taken to the Job Management page. After a few seconds, the Job Detail:
Job Archive and Purge page pops up displaying details of the job.

5. Click OK to close the Job Details page.

You are returned to the Job Management page.

Table 70: Archive/Purge Jobs Settings

GuidelineSetting

Specify a date and time (in MM/DD/YYYY and HH:MM:SS formats) before which jobs
should be archived and purged.

NOTE: You specify the time in the local time zone of the client computer, but the jobs
are purged according to the time zone configured on the Junos Space server.

Archive Jobs Before

Specify whether jobs are archived locally (on the active node) or on a remote server.Archive Mode

Select the job type from the list to archive jobs of that type, or select the All option to
archive all jobs, and then purge them from the database.

Jobs that are already initiated or completed in Junos Space appear in the Job Type list.
Jobs that are in progress or scheduled are not archived

Job Type

Enter the username of the user on the remote server.Username

Enter the password of the user on the remote server.Password

Reenter the password of the user on the remote server.Confirm Password
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Table 70: Archive/Purge Jobs Settings (continued)

GuidelineSetting

Enter the IPv4 or IPv6 address of the remote server.

NOTE:
• Depending on whether the Junos Space fabric is configured with only IPv4 addresses
or both IPv4 and IPv6 addresses, Junos Space Platform allows you to enter an IPv4
address or either an IPv4 or IPv6 address respectively for the remote server.

• The IPv4 and IPv6 addresses that you use must be valid addresses. Refer to
http://www.iana.org/assignments/ipv4-address-space for the list of restricted IPv4
addresses and http://www.iana.org/assignments/ipv6-address-space for the list of
restricted IPv6 addresses.

Remote Server IP Address

Enter the full path of the directory (ending with /) on the remote server where the jobs
will be archived.

NOTE: The directory must already exist on the remote server.

Remote Server Directory

Select this check box to purge jobs from all domains to which you have access.Purge jobs from all
accessible domains

Specify whether the archive and purge operation should be run immediately or later.

If you specify that the operation should be run later, you must specify a start date and
time (in MM/DD/YYYY and HH:MM:SS 24-hour or AM/PM formats) for the archive and
purge operation.

Type
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Viewing the Details of a Job in Security Director

You can view the details of a job, which allows you to view information about the job at a quick glance on
one page, from the Job Management page.

To view the details of a job:

1. SelectMonitor > Job Management.
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The Job Management page appears.

2. Double-click the job for which you want to view the details. Alternatively, select the job and from the
More or right-click menu, select View Job Details.

The Job Details page appears. The fields displayed vary depending on the job:

• For a Discover Network Elements job, the IP Address and Hostname fields are displayed.

• For some jobs, the details of the job are displayed in a table. For example, for device discovery jobs,
the device targets and their statuses are displayed; for network resynchronization jobs, the device
IP addresses and their status are displayed.

• For some jobs, like Export Roles, ResyncNetwork Elements, and so on, you can export the job details.

• For some jobs, you can retrigger the failed job or retry the job on failed targets and you can schedule
jobs to run immediately or later.

Table 71 on page 182 describes some of the fields on the Job Details page.

3. Click OK.

You are returned to the Job Management page.

Table 71: Job Details Fields

DescriptionField

Type of job. Job types indicate what tasks or operations are performed.Job Type

ID of the job.Job ID

Name of the job. For most jobs, the name is the job type with the job ID appended.
However, for some jobs, the job name is supplied by the user as part of the workflow.

Job Name

State of job execution:

• Scheduled–Job is scheduled to run in the future.

• Success–Job completed successfully.

• Failure–Job failed and was terminated.

• In Progress–Job is in progress.

• Canceled–Job was canceled by a user.

• Pending–Job is pending.

Job State

Percentage of the job that is completed.Percent

Username of the owner who initiated the job.User or Owner
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Table 71: Job Details Fields (continued)

DescriptionField

Date and time when the job is scheduled to start.

NOTE: The time is stored as UTC time in the database but mapped to the local time
zone of the client from which the UI is accessed.

Scheduled Start Time

Time when Junos Space Platform begins to execute the job. In most cases, the actual
start time is the same as the scheduled start time.

Actual Start Time

Time when the job was completed or terminated if the job execution failed.End Time

Operations executed for the job.Summary
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Canceling Jobs in Security Director

You can cancel jobs that are scheduled for execution as long as they are in the Scheduled, In Progress, or
Pending state. You can also cancel jobs that are not completed for a long time or jobs that are hindering
the execution of other jobs in the queue.

If you are a user who is assigned the privileges of a Job Administrator, you can cancel jobs scheduled by
any user. If you are a user who is assigned the privileges of a Job User, you can cancel only those jobs that
are scheduled by you. If you are assigned a role that does not allow you to cancel any job, you cannot
cancel any job in the Jobs workspace.

183



NOTE:
• If Junos Space determines that the job operation cannot be interrupted, the job runs to
completion; otherwise, the job is canceled.

• When you cancel jobs that are in-progress, some tasks associated with the job might be
completed, depending on the stage at which you canceled the job. The status of the job on
the Job Management page appears as Cancelled.

To cancel one or more jobs:

1. SelectMonitor > Job Management.

The Job Management page appears.

2. Select the jobs that you want to cancel. From the right-click or More menu, select Cancel Jobs.

The Cancel Job page appears, displaying the list of jobs selected for cancelation.

3. Click Yes to confirm that you want to cancel the selected jobs.

You are returned to the Job Management and the status of the jobs that were canceled changes to
Cancelled.
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Reassigning Jobs in Security Director

You can reassign jobs owned by a user to another user within the same domain from the JobManagement
page.When you reassign a job, you transfer the ownership of the jobs from one user to another. To reassign
the jobs of one user to another user, you must be assigned the privileges of a Job Administrator.

One scenario for reassigning jobs is if a user who is the owner of scheduled jobs is deleted from Junos
Space. The jobs for that owner are canceled, so you can reassign the scheduled jobs to another user.
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NOTE: You can reassign only scheduled and recurring jobs. You cannot reassign jobs that are
completed, pending, in progress, or canceled.

To reassign one or more jobs:

1. SelectMonitor > Job Management.

The Job Management page appears.

2. Select the jobs that you want to reassign. From the right-click or More menu, select Reassign Jobs.

The Reassign Jobs page appears, displaying the list of users to whom you can reassign the jobs.

3. Select the user to whom you want to reassign the jobs.

4. Click OK to reassign the jobs.

The Reassign Jobs Warning page appears asking you to confirm the reassignment.

NOTE: If the user to whom you have reassigned the jobs does not have the proper privileges,
then a message indicating that the jobs cannot be reassigned because of role restrictions is
displayed along with the list of jobs that cannot be reassigned. Click OK to close the page
and go to the Job Management page.

5. Click Confirm.

You are returned to the JobManagement page, and a statusmessage about the reassignment is displayed
at the top of the page.
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Rescheduling and Modifying the Recurrence of Jobs in Security Director

You can reschedule a job and modify its recurrence from the Job Management page. You can reschedule
and modify jobs only in the following cases:

• The job supports scheduling and recurrence, and it is currently in the Scheduled state.

• The schedule of a job in the Failed or Success state is a recurring job

• The job was created as a recurring job. This behavior is true for all scheduled jobs except the following:

• Backing up configuration files

• Backing up the MySQL and PostGreSQL database

• Generating reports

To reschedule and modify the recurrence of jobs triggered by any user in Junos Space Platform, you must
be assigned the privileges of a Job Administrator. However, you can reschedule or modify the recurrence
settings of jobs that are scheduled by you.

To reschedule and modify the recurrence of a scheduled job:

1. SelectMonitor > Job Management.

The Job Management page appears.

2. Select the jobs that you want to reschedule. From the right-click orMore menu, select Reschedule Job.

The Reschedule Job page appears.

3. Modify the schedule and the recurrence settings for the job according to the guidelines provided in
Table 72 on page 186.

4. Click OK to reschedule the job.

You are returned to the Job Management page.

Table 72: Reschedule Job Settings

GuidelineSetting

Specify whether the job should be run immediately or later. If you specify that the operation
should be run later, you must specify a start date and time (in MM/DD/YYYY and HH:MM:SS
24-hour or AM/PM formats) for the job.

Type

Specify whether the job should be done on a recurring basis.Recurrence
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Table 72: Reschedule Job Settings (continued)

GuidelineSetting

Specify the periodicity of the recurrence:

• Minutes

• Hourly

• Daily

• Weekly

• Monthly

• Yearly

Repeat

Specify the period at which the job reschedule should recur. For example, if you specified a
periodicity in hours (Hourly), enter the number of hours after which the job retry should recur.

Every

Specify one or more days on which you want the job to recur.

NOTE: This field is displayed only when you specify a weekly periodicity (Weekly).

On

Specify one of the following:

• Select Never to continue (without an end date) the recurring operation at the specified
recurrence interval.

• Select On and specify a date and time on which to stop the recurring operation.

Ends

Displays a summary of the recurrence.Summary
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Retrying a Failed Job on Devices in Security Director

You can retry jobs that did not complete successfully on devices where they were configured to run from
the JobManagement page. Retrying a failed job allows you to save time because you do not need to create
the job again and execute it, but can retry the failed job.

The following jobs can be retried if they fail:
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• Deploy Configuration

• Discover Network Elements

• Reboot Devices

• Resynchronize Network Elements

To retry a job on the devices on which it failed:

1. SelectMonitor > Job Management.

The Job Management page appears.

2. Select the job that you want to retry. From the right-click orMore menu, select Retry on failed devices.

The Retry on Job-Name page appears, displaying the list of devices on which you can retry the job.

3. Specify the parameters for the job retry according to the guidelines provided in Table 73 on page 188.

4. Click OK to retry the jobs.

The Job Details page appears displaying the details of the job.

5. Click OK.

You are returned to the Job Management page.

Table 73: Retry Job Settings

GuidelineSetting

Specify whether the job should be run immediately or later. If you specify that the operation
should be run later, you must specify a start date and time (in MM/DD/YYYY and HH:MM:SS
24-hour or AM/PM formats) for the job.

Type

Specify whether the job should be done on a recurring basis.

This field is displayed if the job was created as a recurring job.

Recurrence

Specify the periodicity of the recurrence:

• Minutes

• Hourly

• Daily (default)

• Weekly

• Monthly

• Yearly

Repeat
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Table 73: Retry Job Settings (continued)

GuidelineSetting

Specify the period at which the job retry should recur. For example, if you specified a periodicity
in hours (Hourly), enter the number of hours after which the job retry should recur.

Every

Specify one or more days on which you want the job to recur.

NOTE: This field is displayed only when you specify a weekly periodicity (Weekly).

The day on which the retry is scheduled is disabled. For example, if you scheduled the retry on
aWednesday, thenWed is selected by default and disabled. You can select other days by enabling
the corresponding check boxes.

On

Specify one of the following:

• Select Never to continue (without an end date) the recurring operation at the specified
recurrence interval.

• Select On and specify a date and time on which to stop the recurring operation.

Ends

Displays a summary of the recurrence.Summary

RELATED DOCUMENTATION

Overview of Jobs in Security Director | 179

Using Job Management in Security Director | 177

Exporting the Details of a Job in Security Director

You export the details of a job if you want to view the details of a job in an external application or e-mail
the information. You can export the details of the following jobs as a comma-separated values (CSV) file:

• Delete Device

• Export Physical Inventory

• Resync Network Elements

• Reboot Devices

• Discover Network Elements

• Upload RSA Keys
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• Export View active configuration

• Resolve key conflict

To export the details of a job:

1. SelectMonitor > Job Management.

The Job Management page appears.

2. Double-click the job for which you want to view the details. Alternatively, select the job and from the
More or right-click menu, select View Job Details.

The Job Details page appears.

3. Click the Export icon.

After a few seconds, a dialog box pops up.

4. Select whether to open the file directly or save the file to your client.

5. Click OK.

The file is opened or saved depending on the option that you chose.

6. Click OK.

You are returned to the Job Management page.

RELATED DOCUMENTATION
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Job Management Main Page Fields

Use this page to view, cancel, reassign, and reschedule jobs. You can also archive and purge jobs and retry
jobs that failed. You can filter and sort the jobs displayed, and view details of each job. Table 74 on page 191
describes the fields on this page.

Table 74: Job Management Main Page Fields

DescriptionField

ID of the job.Job ID

Name of the job. For most jobs, the name is the job type with the job ID appended.
However, for some jobs, the job name is supplied by the user as part of the workflow.

Name

Percentage of the job that is completed.Percent

State of job execution:

• Scheduled—Job is scheduled to run in the future.

• Success—Job completed successfully.

• Failure—Job failed and was terminated.

• In Progress—Job is in progress.

• Canceled—Job was canceled by a user.

State

Type of job. Job types indicate what tasks or operations are performed.Job Type

Objects on which a job is performed or is scheduled to be performed.Parameters

Operations executed for the job.Summary

Date and time when the job is scheduled to start.

NOTE: The time is stored as UTC time in the database but mapped to the local time
zone of the client from which the UI is accessed.

Scheduled Start Time

Time when Junos Space Platform begins to execute the job. In most cases, the actual
start time is the same as the scheduled start time.

Actual Start Time

Time when the job was completed or terminated if the job execution failed.End Time

Username of the owner who initiated the job.Owner

Domain from which the user initiated the job.Domain
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Table 74: Job Management Main Page Fields (continued)

DescriptionField

Scheduled recurrence of the job.Recurrence

For a job that was retried, Job ID of the original job.Retry Group ID

For a job that was retried, Job ID of the previous retry job.Previous Retry
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CHAPTER 35

Audit Logs

IN THIS CHAPTER
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Exporting Audit Logs in Security Director | 198

Viewing the Details of an Audit Log in Security Director | 199

Audit Logs Main Page Fields | 200

Using Audit Logs in Security Director

Use the Audit Logs page to track login history, device management tasks, services that were provisioned
on devices, and other user-initiated tasks. Tasks that are not initiated by users, such as device-driven
activities like resynchronization of network elements, are not recorded in audit logs.

Before You Begin

• Read the “Understanding Audit Logs in Security Director” on page 194 topic.

• Review the Audit Logs main page for an understanding of the existing audit logs. See “Audit Logs Main
Page Fields” on page 200 descriptions.

To use the Audit Logs page:

1. SelectMonitor > Audit Logs.

The Audit Logs page appears.

2. Use the guidelines provided in Table 75 on page 194 to learn about the page.
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Table 75: Audit Logs Page Actions

GuidelineAction

Double-click an audit log entry or click the Detailed View icon that appears when you
mouse over the audit log entry to view the details of that audit log.

The Audit Log Details page appears displaying the details of the audit log. See “Viewing
the Details of an Audit Log in Security Director” on page 199.

View the details of an audit
log

Click the Archive/Purge icon in the toolbar to purge audit logs without archiving them
or purge audit logs after archiving them.

The Archive/Purge Audit Logs page appears. See “Purging or Archiving and Purging
Audit Logs in Security Director” on page 195.

Purge or archive and purge
audit logs

Click the Export button to export audit logs as a comma-separated values (CSV) file.
The Export Audit Log page appears displaying options for exporting the audit logs. See
“Exporting Audit Logs in Security Director” on page 198.

Export audit logs

RELATED DOCUMENTATION
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Understanding Audit Logs in Security Director

The Audit Logs feature in Security Director enables you to track login history, device management tasks,
services that were provisioned on devices, and other user-initiated tasks. Tasks that are not initiated by
users, such as device-driven activities like resynchronization of network elements, are not recorded in
audit logs.

Administrators can use audit logs to review events. For example, administrators can identify the user
accounts associatedwith an event, determine the chronological sequence of events—that is, what happened
before and during an event—, and so on.

NOTE: Security Director also tracks all externally initiated non-READ REST APIs, and login and
logout APIs.

Administrators can sort and filter audit logs. For example, administrators can use audit log filtering to track
user accounts that were added on a specific date, track configuration changes across a particular type of
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device, view services that were provisioned on specific devices, monitor user login and logout activities
over time, and so on.

NOTE: To use the audit log service tomonitor user requests and track changes initiated by users,
you must be assigned the Audit Log Administrator role.

You can manage the volume of audit log data stored by purging log files from the Junos Space database
without archiving them or by purging log files after archiving them.When you archive logs before purging
them, the archived log files are saved in a single file in compressed comma-separated values (CSV) format
(extension .csv.gz). Audit logs can be archived locally (on the active node in the Junos Space fabric) or to
a remote server.When you archive data locally, the archived log files are saved in the /var/lib/mysql/archive
directory on the active Junos Space node.

You can schedule the purging of audit logs (with or without prior archiving) for a later date and schedule
the purging on a recurring basis.

You can export audit logs in CSV format without purging them from the system.

RELATED DOCUMENTATION
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Purging or Archiving and Purging Audit Logs in Security Director

Junos Space enables you tomanage the volume of audit log data stored by purging log files from the Junos
Space database without archiving them or by purging log files after archiving them. You can purge audit
logs before a specified date and time or audit logs that are older than a specified number of days. Audit
logs can be archived locally (on any node that is in the UP state) or to a remote server.

To purge or archive and purge audit logs:

1. SelectMonitor > Audit Logs.

The Audit Logs page appears.

2. Click the Archive/Purge button.

The Archive / Purge Audit Logs page appears.
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3. Specify the audit logs to be purged, or archived and purged, according to the guidelines provided in
Table 76 on page 196.

4. Click OK.

The Audit Log Archive/Purge page appears asking you to confirm the purge, or archive and purge,
operation.

5. Click Yes to continue with the purge, or archive and purge, operation.

The Job Detail: Audit Log Archive/Purge page appears displaying the details of the job.

6. Click OK to close the Job Details page.

You are returned to the Audit Logs page.

Table 76: Archive/Purge Audit Logs Settings

GuidelineSetting

Specify a date and time (in MM/DD/YYYY and HH:MM:SS formats) before which audit
logs should be purged or that audit logs that are older than a specified number of days
should be purged.

NOTE: You specify the time in the local time zone of the client computer but the audit
logs are purged according to the time zone configured on the Junos Space server.

Purge Logs

Select this check box to purge audit logs from all domains to which you have access. By
default, audit logs are purged only from a domain that you accessed, so this check box is
cleared.

Purge audit logs from all
accessible domains

Select this check box to archive audit logs before they are purged. This check box is selected
by default.

CAUTION: If you choose not to archive the audit logs before purging, the audit logs are
deleted from the Junos Space database and cannot be recovered.

Archive logs before
purge

Specify whether audit logs are archived locally (on the active node) or on a remote server.Archive Mode

Enter a valid username of a user on the remote server. The username and password will
be used to access the remote server.

Username

Enter a valid password of the user on the remote server.Password

Reenter the password of the user on the remote server.Confirm Password
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Table 76: Archive/Purge Audit Logs Settings (continued)

GuidelineSetting

Enter the IPv4 address of the remote server.Remote Server IP
Address

Enter the full path of the directory (ending with /) on the remote server where the audit
logs will be archived.

NOTE: The directory must already exist on the remote server.

Remote ServerDirectory

Specify whether the purge, or archive and purge, operation should be run immediately or
later.

If you specify that the operation should be run later, you must specify a start date and time
(in MM/DD/YYYY and HH:MM:SS 24-hour or AM/PM formats) for the purge or archive
and purge operation.

Type

Specify whether the purge, or archive and purge, operation should be done on a recurring
basis.

NOTE: This field is enabled only when you specify (in the Purge Logs field) that audit logs
that are older than a specified number of days should be purged.

Recurrence

Specify the periodicity of the recurrence:

• Minutes

• Hourly

• Daily (Default)

• Weekly

• Monthly

• Yearly

Repeat

Specify the period atwhich the purge should recur. For example, if you specified a periodicity
in hours (Hourly), enter the number of hours after which the purge should recur.

Every

Specify one or more days on which you want the purge to recur.

NOTE:
• This field is displayed only when you specify a weekly periodicity (Weekly).

• The day on which the purge is scheduled is disabled. For example, if you scheduled a job
on a Wednesday, then Wed is selected by default and disabled. You can select other
days by enabling the corresponding check boxes.

On
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Table 76: Archive/Purge Audit Logs Settings (continued)

GuidelineSetting

Specify one of the following:

• Select Never to continue (without an end date) the recurring purge operation at the
specified recurrence interval.

• Select On and specify a date and time on which to stop the recurring purge operation.

Ends

Displays a summary of the recurrence.Summary
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Exporting Audit Logs in Security Director

You can export audit logs, as a comma-separated values (CSV) file, without purging the logs from the
database. You can then view the exported audit logs in a separate application and analyze the logs as
needed.

To export audit logs:

1. SelectMonitor > Audit Logs.

The Audit Logs page appears.

2. Click the Export button.

The Export Audit Logs page appears.

3. Specify the audit logs to be exported according to the guidelines provided in Table 77 on page 199.

4. Click OK to close the Export Audit Logs page.

You are returned to the Audit Logs page. After a few seconds, a dialog box pops up.

5. Select whether to open the file directly or save the file to your client.
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The Export Audit Logs page appears.

6. Click OK.

The file is opened or saved depending on the option that you chose.

Table 77: Export Audit Logs Settings

GuidelineSetting

Select which one of the following options to determine which audit logs are exported:

• Export all audit logs

• Export audit logs displayed in the Audit Logs page—This is the default.

• Export audit logs in a specified period—If you select this option, you must specify the
period using the Start date and time and End date and time fields.

Export Type

Enter the date and time (in MM/DD/YYYY and HH:MM:SS 24-hour or AM/PM formats)
from which the audit logs should be exported.

Start date and time

Enter the date and time (in MM/DD/YYYY and HH:MM:SS 24-hour or AM/PM formats)
up to which the audit logs should be exported.

End date and time

RELATED DOCUMENTATION
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Viewing the Details of an Audit Log in Security Director

You can view the details of audit logs from the Audit Logs page.

To view the details of an audit log:

1. SelectMonitor > Audit Logs.

The Audit Logs page appears.

2. Double-click the audit log entry for which you want to view the details.

The Audit Log Details page appears. The fields on this page are a subset of the fields on the Audit Logs
page. See “Audit Logs Main Page Fields” on page 200 for an explanation of the fields.
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3. Click OK to close the Audit Log Details page.

You are returned to the Audit Logs page.

RELATED DOCUMENTATION
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Audit Logs Main Page Fields

Use this page to view and export audit logs. You can also purge or archive and purge audit logs. You can
filter and sort the audit logs displayed, and view details of each audit log entry. Table 78 on page 200
describes the fields on this page.

Table 78: Audit Logs Main Page Fields

DescriptionField

ID of the audit log entry.ID

Username of the initiator of the task.Username

IP address of the client from which the user initiated the task.User IP

Domain from which the user initiated the task.Domain

Name of the application from which the user initiated the task:

• Displays Network Management Platform for tasks initiated for Junos Space Network
Management Platform features.

• Displays Security Director for tasks was initiated for Security Director features.

Application

Name of the task that triggered the audit log. For example, Create User, Modify User, Import
Roles, Login, and so on.

Task

Timestamp for the audit log file, which is stored in UTC time in the database but mapped
to the local time zone of the client computer.

Timestamp
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Table 78: Audit Logs Main Page Fields (continued)

DescriptionField

Result of the task that triggered the audit log:

• Success—Job is completed successfully.

• Failure—Job failed and is terminated.

• Job Scheduled—Job is scheduled but has not yet started.

• Recurring Job Scheduled—Job scheduled with recurrence.

Result

Description of the audit log.Description

ID of the job-based task. Click the job-id link to view information about the job in the Job
Management page.

Job ID

RELATED DOCUMENTATION
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CHAPTER 36

Packet Capture

IN THIS CHAPTER
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Setting the Purge Policy | 205

Packet Capture Overview

The packet capture tool captures IDP attack packets sent by SRX Series devices. It is installed as part of
Security Director installation and runs on the Junos Space Network Management setup. You can use it to
help you analyze network traffic and troubleshoot network problems.

Based on a preconfigured set of rules, SRX Series devices classify the packets as normal or an attack.When
there is an attack, an SRX Series device sends the attack packets to the Junos SpaceNetworkManagement
Platform. Youmust configure the SRX Series device to send the attack packets to the Junos SpaceNetwork
Management Platform.

Junos Space Network Management Platform runs a load balancer bound with a Virtual IP address. You
must configure SRX Series devices with the Virtual IP address as the destination for forwarding captured
packets. Junos Space Network Management Platform receives those packets and stores them. You can
view the attack information and download packets that constitute the attack from the Security Director
application.

The ports that are opened between the SRX Series devices and Security Director are:

• Port 2050 (UDP) - Used to receive attack packets sent by SRX series devices.

• Port 2051 (TCP) - Used by Security Director to fetch the attack packets stored in Junos Space Network
Management Platform database.

For information on modifying the IPS configuration on SRX Series devices, see “Modifying the IPS
Configuration for Security Devices” on page 302.
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NOTE: Packet capture is applicable only for IPS packets.

Network administrators and security engineers use packet capture to perform the following tasks:

• Monitor network traffic and analyze traffic patterns.

• Identify and troubleshoot network problems.

• Detect security breaches in the network, such as unauthorized intrusions, spyware activity, or ping scans.

This tool captures the entire packet, including the Layer 2 header, and saves the contents to the Junos
SpaceNetworkManagement PlatformDatabase in .pcap format. You can download attack packets captured
by SRX Series devices and analyze these packets externally using tools such asWireshark, tcpdump, tshark,
and so on.

NOTE: PCAPs can be suppressed by the log suppressionmechanism, which is enabled by default.
To disable log suppression, see suppression. To configure SRX IDP packet capture, see Configuring
Security Packet Capture.
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About the Packets Captured Page

To access this page, clickMonitor > Packet Capture.

Use the Packets Captured page to view all the packets captured by SRX Series devices, and then download
the attack packets.
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Tasks You Can Perform

You can perform the following tasks from this page:

• Download the packets captured. ClickDownload to download the packet capture file. To download the
attack packets from the Event Viewer, see “Downloading Packets Captured” on page 51.

• Set purge policy. See “Setting the Purge Policy” on page 205.

• View the attack details. See “Viewing Policy and Shared Object Details” on page 669.

• Filter the packets based on attack name, date, and time of attack. Click the filter drop-down list and
enter the filter criteria to filter the packets.

Field Descriptions

Table 79 on page 204 provides guidelines on using the fields on the Packets Captured page. You can sort
the attack packets in ascending or descending order based on attack name, system time, and attack time.

Table 79: Fields on the Packets Captured Page

DescriptionField

Name of the attack packet.Attack Name

ID of the captured packet.Packets ID

IP address of the SRX Series device that captured the packet.Device IP

Time when the system received the packet from the SRX Series device.System Time Stamp

Time when the attack occurred.Attack Time Stamp

Link to download the packet capture file.Download
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Setting the Purge Policy

The purge policy enables you to purge the attack packets from the database based on the configured days
or the storage space. Junos Space Security Director deletes packets when either of the conditions is met.
You can set the purge policy based on the time and storage.

To set the purge policy:

1. SelectMonitor > Packet Capture.

The Packets Captured page is displayed.

2. Click Purge.

The Set Purge Policy page is displayed.

3. Enter the details according to the guidelines in Table 80 on page 205.

4. Click OK.

Table 80: Purge Policy Setting

DescriptionField

Number of days an attack entry is available in the database. The default
number of days is 60.

Time-based policy (days)

Maximum space that the database can occupy. The default storage space
is 500 MB.

Storage-based policy (MB)

NOTE: Cleanup takes place once every day at 1 AM.
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NSX Inventory-Security Groups
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About the Security Groups Page

To access this page, select Security Director > Monitor > NSX Inventory > Security Groups.

Use the Security Groups page to view a list of security groups obtained from NSX and the corresponding
dynamic address groups created by Security Director.

The security groups updates are automatically synchronized by Security Director.

Tasks You Can Perform

You can perform the following task from this page:

• View members of the security group.

Field Descriptions

Table 81 on page 206 provides guidelines on using the fields on the Security Groups page.

Table 81: Fields on the Security Groups Page

DescriptionField

Specifies the name of the NSX Manager from which the corresponding security group is
obtained.

NSX Manager

Specifies the name of the security group.Name
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Table 81: Fields on the Security Groups Page (continued)

DescriptionField

Click View to view the list of VMs belonging to a security group.

If the vCenter is associatedwith theNSXManager, themembers list shows the VMnames
with IPv4 and IPv6 addresses.

Members

Specifies the name of a dynamic address group created for each security group.

The dynamic address group name is created in the format <NSXManager name>-<security
group name>.

DAG Name

Specifies the definition of a security group.Definition

RELATED DOCUMENTATION

About the NSX Managers Page | 376

View Members of a Security Group

Use the View Members page to view the list of VMs belonging to a security group.

To view the list of virtual machines:

1. SelectMonitor > NSX Inventory > Security Groups.

The Security Groups page appears.

2. In the Members column, click View.

The View Members page appears. Table 82 on page 207 describes the fields on this page.

Table 82: Fields on the View Members Page

DescriptionField

Specifies the name of the security group.Security Group

Specifies the name of the VM that belongs to the security group.VM Name

Specifies the IPv4 address of the VM.IP Address
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Table 82: Fields on the View Members Page (continued)

DescriptionField

Specifies the IPv6 address of the VM.IPv6 Address
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vCenter Server Inventory-Virtual Machines
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About the Virtual Machines Page

To access this page, select Security Director > Monitor > vCenter Server Inventory > Virtual Machines.

Use the Virtual Machines page to view the complete list of VMs that are dynamically fetched by the
associated vCenter.

Tasks You Can Perform

You can perform the following tasks from this page:

• View security groups associated with each VM.

• View a list of vNICs for each VM and the network that each of vNIC is linked to.

Field Descriptions

Table 83 on page 209 provides guidelines on using the fields on the Virtual Machines page.

Table 83: Fields on the Virtual Machines Page

DescriptionField

Specifies the name of the VM.VM Name

Specifies the vCenter details.vCenter
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Table 83: Fields on the Virtual Machines Page (continued)

DescriptionField

Specifies the operating system on each VM. For example: Red Hat, CentOS, and
so on.

OS on VM

Click View to view a list of security groups associated with each VM.Security Groups

Click View to view a list of vNICs for each VM with their corresponding IPv4 and
IPv6 addresses.

Network Details

Specifies whether the VM is switched on or off.State

Specifies whether the VM is connected to the ESXi host or not.Status

RELATED DOCUMENTATION

About the NSX Managers Page | 376

View Network Details of a Virtual Machine

Use the View Network Details page to view the network details of a virtual machine(VM) such as name
of the virtual Network Interface Card (NIC) or the network adapter and the IPv4 and IPv6 addresses of
each NIC.

To view the network details:

1. SelectMonitor > vCenter Server Inventory > Virtual Machines.

The Virtual Machines page appears.

2. In the Network Details column, click View.

The View Network Details page appears. Table 84 on page 210 provides the guidelines on using the
fields on this page.

Table 84: Fields on the View Networks Details Page

DescriptionField

Specifies the IP address of the VM.Virtual Machine
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Table 84: Fields on the View Networks Details Page (continued)

DescriptionField

Specifies the name of a vNIC or network adapter.vNIC

Specifies the IPv4 address of a vNIC.IPv4

Specifies the IPv6 address of a vNIC.IPv6
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View Security Groups of a Virtual Machine

Use the Security Groups page to view the list of security groups assigned to a virtual machine (VM).

To view the list of security groups:

1. SelectMonitor > vCenter Server Inventory > Virtual Machines.

The Virtual Machines page appears.

2. In the Security Groups column, click View.

The Security Groups page appears. Table 85 on page 211 describes fields on this page.

Table 85: Fields on the Security Groups Page

DescriptionField

Specifies the IP address of the VM.Virtual Machine

Specifies the name of the security group to which a VM belongs.Security Group

RELATED DOCUMENTATION

About the NSX Managers Page | 376

211



4
PART

Devices

Security Devices | 213

Device Discovery | 343

Secure Fabric | 353

NSX Managers | 365

vCenter Servers | 415

Licenses | 417



CHAPTER 39

Security Devices

IN THIS CHAPTER

Using Features in Security Devices | 214

Security Devices Overview | 217

Updating Security-Specific Configurations or Services on Devices | 218

Resynchronizing Managed Devices with the Network in Security Director | 219

Performing Commit Check | 219

Logical Systems Overview | 221

Tenant Systems Overview | 221

Create a Logical System | 222

Create a Tenant System | 227

Uploading Authentication Keys to Devices in Security Director | 232

Modifying the Configuration of Security Devices | 234

Modifying the Basic Configuration for Security Devices | 237

Modifying the Static Routes Configuration for Security Devices | 248

Modifying the Routing Instances Configuration for Security Devices | 253

Modifying the Physical Interfaces Configuration for Security Devices | 256

Modifying the Syslog Configuration for Security Devices | 261

Modifying the Security Logging Configuration for Security Devices | 269

Modifying the Link Aggregation for Security Devices | 275

Modifying the User Management Configuration for Security Devices | 279

Modifying the Screens Configuration for Security Devices | 288

Modifying the Zones Configuration for Security Devices | 298

Modifying the IPS Configuration for Security Devices | 302

Modifying the SSL Initiation Profile for Security Devices | 304

Modifying the ICAP Redirect Profile for Security Devices | 306

Configuring Aruba ClearPass for Security Devices | 310

Configuring APBR Tunables for Security Devices | 313

Modifying the Express Path Configuration for Security Devices | 314

Modifying the Device Information Source Configuration for Security Devices | 316

213



Viewing the Active Configuration of a Device in Security Director | 317

Deleting Devices in Security Director | 319

Rebooting Devices in Security Director | 320

Resolving Key Conflicts in Security Director | 322

Launching a Web User Interface of a Device in Security Director | 323

Connecting to a Device by Using SSH in Security Director | 324

Importing Security Policies to Security Director | 325

Importing Device Changes | 327

Viewing Device Changes | 327

Viewing and Exporting Device Inventory Details in Security Director | 328

Previewing Device Configurations | 332

Refreshing Device Certificates | 333

Assigning Security Devices to Domains | 334

Acknowledging Device SSH Fingerprints in Security Director | 335

Viewing Security Device Details | 337

Security Devices Main Page Fields | 337

Using Features in Security Devices

Use the Security Devices page to view the devices managed by Junos Space Security Director.

Before You Begin

• Read the “Security Devices Overview” on page 217 topic.

• Review the Security Devices main page for an understanding of the existing devices. See “Security
Devices Main Page Fields” on page 337 for field descriptions.

To use the Security Devices page:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Use the guidelines provided in Table 86 on page 215 to learn about the page.
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Table 86: Security Devices Page Actions

GuidelineAction

Right-click a device and select View Device Details from the shortcut menu, or click the
Detailed View icon, which appears when you mouse over a device entry, to view the details
of that device. The Device Detail page appears displaying the basic information about the
device, the services on the device, the device status, andmonitoring information. See “Viewing
Security Device Details” on page 337.

View the details of a
device

Select one or more devices and click Update Changes to update all security-specific
configurations or pending services on the selected devices. The Update page appears. See
“Updating Security-Specific Configurations or Services on Devices” on page 218.

Update Changes

Select the devices that you want to resynchronize. Click the Resynchronize with Network
button, or from the More or right-click menu, select Operations > Resynchronize with
Network. The Resynchronize Devices page appears. See “ResynchronizingManagedDevices
with the Network in Security Director” on page 219.

Resynchronize with
Network

Click the Upload Keys button to upload authentication keys to the devices. See “Uploading
Authentication Keys to Devices in Security Director” on page 232.

Upload Keys

Select one or more devices and, from the More or shortcut menu, select Configuration >
Modify Configuration to modify the configuration on the selected device. The Modify
Configuration page appears. See “Modifying the Configuration of Security Devices” on
page 234.

Modify Configuration

Select one or more devices. From theMore or right-click menu, select Configuration > View
Active Configuration. The ViewActive Configuration page appears. See “Viewing the Active
Configuration of a Device in Security Director” on page 317.

View Active
Configuration

Select a device and, from the More or shortcut menu, select Configuration > Modify
Configuration and then click Preview Configuration to preview the configuration changes
that will be pushed to the security device. You can preview the changes in either CLI or XML
format. See “Previewing Device Configurations” on page 332.

Preview Configuration

Select one or more devices. From the More or right-click menu, selectOperations > Delete
Devices to delete the selected devices. The Delete Devices page appears. See “Deleting
Devices in Security Director” on page 319.

Delete Devices

Select the devices that you want to reboot. From the More or right-click menu, select
Operations > Reboot Devices. The Reboot Devices page appears. See “Rebooting Devices
in Security Director” on page 320.

Reboot Devices
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Table 86: Security Devices Page Actions (continued)

GuidelineAction

To resolve key conflicts on one or more devices, select the devices. From the More or
right-click menu, select Operations > Resolve Key Conflict. The Resolve Key Conflict page
appears. See “Resolving Key Conflicts in Security Director” on page 322.

NOTE: This menu entry is enabled only if a device has a key conflict.

Resolve Key Conflict

To access the device WebUI of the device to manage it directly, select the device for which
you want to launch theWeb UI. From the More or right-click menu, select Access > Launch
Device WebUI. The Juniper Web Device Manager page appears in a separate browser tab
orwindow. See “Launching aWebUser Interface of aDevice in SecurityDirector” on page 323.

Launch Device WebUI

Select the device to which you want to connect. From the More or right-click menu, select
Access > SSH to Device. The SSH to Device page appears. See “Connecting to a Device by
Using SSH in Security Director” on page 324.

SSH To Device

Select a device and, from the More or shortcut menu, select Device Change to do the
following tasks:

• Select Import Device Change to import out-of-band changes, which are made on the
device and managed by Security Director. See “Importing Device Changes” on page 327.

• Select View Device Change to check the status of the security configuration changes,
either in CLI or XML format. See “Viewing Device Changes” on page 327.

These changes are made on the device and managed by Security Director.

Device Change

To view the physical inventory, and physical and logical interfaces, on the device, select one
or more devices, and from the More or right-click menu, select View Inventory Details.

The subsequent page appears with the Physical Inventory tab highlighted. See “Viewing and
Exporting Device Inventory Details in Security Director” on page 328.

View InventoryDetails

Select a device and, from the More or shortcut menu, select Import to import firewall, NAT,
and IPS policies from a security device to Security Director. Resolve any conflicts, if needed.
See “Importing Security Policies to Security Director” on page 325.

Import Configuration

Select a device and, from the More or shortcut menu, select Refresh Certificate for device
certificate synchronization. See “Refreshing Device Certificates” on page 333.

Refresh Certificate

To assign devices to a domain, select one or more devices and, from the More or shortcut
menu, select Assign Device to Domain. See “Assigning Security Devices to Domains” on
page 334.

Assign Device to
Domain
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Table 86: Security Devices Page Actions (continued)

GuidelineAction

To acknowledge the SSH fingerprints received from the device or resolve any SSH fingerprint
conflicts between the fingerprints stored in the Junos Space database and that on the device,
select one or more devices. From theMore or right-click menu, select Acknowledge Device
Fingerprint. See “Acknowledging Device SSH Fingerprints in Security Director” on page 335.

NOTE: This menu entry is visible only when a device has a fingerprint conflict.

Acknowledge Device
Fingerprint

RELATED DOCUMENTATION

Creating Device Discovery Profiles in Security Director | 344

Security Devices Overview

You can use Junos Space Security Director to simplify the management of security devices running Junos
OS. If you have multiple devices in your network, you can manage them in one place from the Security
Devices page.

To manage devices using Security Director, you must first discover the devices by using the Device
Discovery workflow. After you discover your devices, you can manage them using the Security Devices
page. You can view information about the device such as the device schema version, CPU and storage,
and different status information for the device. For more information, see “Security Devices Main Page
Fields” on page 337.

You can also perform various actions such as uploading keys, modifying the device configuration, updating
devices, viewing and importing device changes, viewing the inventory details, and so on. See “Using Features
in Security Devices” on page 214.

RELATED DOCUMENTATION

Security Devices Main Page Fields | 337

Using Features in Security Devices | 214

Overview of Device Discovery in Security Director | 343

217



Updating Security-Specific Configurations or Services on Devices

You can update all security-specific configurations or pending multiple services on the selected devices.

To update the changes:

1. Select Devices > Security Devices.

2. Select a device and then clickMore.

3. Click Update Changes.

The Update page appears.

You can also right-click the selected device and select Update Changes.

4. Enable policy rematch to allow the firewall to keep its existing sessions during a policy update from
Security Director.

5. Enable the required service types to update the selected policies on the device. For example, enable
Firewall Policy to update the firewall policies on the device.

6. Select Run now to update the configuration or pending services on the selected device at that time.

7. Select Schedule at a later time to update the configuration or pending services on the selected device
at the specified time. Complete the following tasks:

1. Choose a date from the date picker by clicking the date picker icon.

2. Enter the time.

3. Select the time format from the drop-down menu.

8. Click Update.

All the security-specific configurations or pending services on the selected devices are updated.

RELATED DOCUMENTATION

Importing Security Policies to Security Director | 325

Previewing Device Configurations | 332

Refreshing Device Certificates | 333

Importing Device Changes | 327
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Viewing Device Changes | 327

Resynchronizing Managed Devices with the Network in Security Director

You canmanually resynchronize amanaged device at any time.When you resynchronize amanaged device,
the configuration changes made on the device are synchronized with the Junos Space database. For
example, when a managed device is updated by a device administrator using the CLI or the GUI of the
device and you trigger a manual resynchronization, the device configuration in the Junos Space database
is synchronized with the configuration on the physical device.

To resynchronize one or more devices:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices that you want to resynchronize. Click the Resynchronize with Network button, or
from the More or right-click menu, select Operations > Resynchronize with Network.

The Resynchronize Devices page appears listing the devices to be resynchronized.

3. Click OK to confirm the resynchronization.

The Job Details: Resync Network Elements page appears pops up displaying details of the
resynchronization job.

4. Click OK to close the Job Details page.

You are returned to the Security Devices page.

RELATED DOCUMENTATION

Using Features in Security Devices | 214

Security Devices Overview | 217

Performing Commit Check

You can verify the syntax of the configuration changes for firewall, NAT, IPS, VPN, and APBR before the
configuration is pushed to the security devices.
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To perform commit check on one or more devices:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select one or more devices and click Commit Check button.

The Commit Check page appears.

NOTE: If you select a device with connection status as up, configuration status as In sync,
and pending service as some valid service, then only commit check will be enabled for a
device.

3. Enable the service types for which you want to execute the commit check.

4. Click OK to complete the commit check.

The Job Details page appears with the status of commit check for the first device in the grid.

5. Click OK to close the Job Details page.

NOTE: To check the job details for commit check on all the selected devices, selectMonitor
> Job Management. The devices with no pending services shows the state as failure.

RELATED DOCUMENTATION

Using Features in Security Devices | 214

Security Devices Overview | 217
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Logical Systems Overview

Starting in Security Director Release 18.2R1, you can create logical systems in Security Director. Logical
systems for SRX Series devices enable you to partition a single device into secure contexts. Each logical
system has its own discrete administrative domain, logical interfaces, routing instances, security firewall
and other security features. By transforming an SRX Series device into amultitenant logical systems device,
you can give various departments, organizations, customers, and partners—depending on your
environment—private use of portions of its resources and a private view of the device.

To distribute security resources across logical systems, you can create security profiles that specify the
type and amount of resources to be allocated to a logical system. After creating security profiles, you can
bind them to logical systems. The logical systems are defined largely by the resources allocated to them,
including security components, interfaces, routing instances, static routes, and dynamic routing protocols.
You cannot create a logical system without assigning a security profile to it. You can configure a single
security profile to assign resources to a specific logical system or use the same security profile for more
than one logical system.

For detailed information about understanding logical systems, see Logical Systems and Tenant Systems User
Guide for Security Devices.

RELATED DOCUMENTATION

Create a Logical System | 222

Tenant Systems Overview

A tenant system logically partitions the physical firewall into separate and isolated logical firewall. Although
similar to logical systems, tenant systems have much higher scalability and fewer routing features. Each
tenant system on a device allows you to control a discrete administrative domain for security services. By
transforming your device into a multitenant system, you can provide various departments, organizations,
customers, and partners—depending on your environment—private and logically separated use of system
resources and tenant-specific views of security configuration. A primary administrator creates andmanages
all the tenant systems.

To distribute security resources across tenant systems, you can create security profiles that specify the
type and amount of resources to be allocated to a tenant system. After creating security profiles, you can
bind them to tenant systems. The tenant systems are defined largely by the resources allocated to them,
including security components, interfaces, routing instances, static routes, and dynamic routing protocols.
You cannot create a tenant system without assigning a security profile to it. You can configure a single
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security profile to assign resources to a specific tenant system or use the same security profile for more
than one tenant system.

For detailed information about understanding tenant systems, see Logical Systems and Tenant SystemsUser
Guide for Security Devices.

RELATED DOCUMENTATION

Create a Tenant System | 227

Create a Logical System

IN THIS SECTION

Add Logical Systems in Bulk | 222

Add Individual Logical System at a Time | 223

You can add logical systems in bulk or add individual logical system at a time.

Add Logical Systems in Bulk

To add logical systems in bulk:

1. Select Devices > Security Devices.

The Security Devices page is displayed.

2. Select a root device, right-click and select Create Logical System.

The Create Logical System (LSYS) page is displayed.

3. Click Add Bulk LSYS.

The Add Bulk Logical System (LSYS) page is displayed.

4. Complete the configuration according to the guidelines given in Table 87 on page 224.

5. Click Add.
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The Create Logical System (LSYS) page is displayed. Review the logical system details.

6. Select the logical system and click the pencil icon to modify the details, if required.

You can also provide the user class and interface for logical systems. Logical System configuration
parameters cannot be edited after you click Preview Configuration or Create.

7. Click Create to create the logical system.

The Job Details page is displayed with update logical system device job and its status.

8. Click OK.

If the job is successful, the logical system is created and displayed in the Security Devices page. The
root device name is displayed beside the logical system device name. You can click on the logical system
device name link to see the root device details.

Add Individual Logical System at a Time

Alternatively, you can create individual logical systems at a time. To create individual logical system at a
time:

1. Select Devices > Security Devices.

The Security Devices page is displayed.

2. Select a root device, right-click and select Create Logical System.

The Create Logical System (LSYS) page is displayed.

3. Click the + icon.

The Create Logical System (LSYS) page is displayed.

4. Complete the configuration according to the guidelines given in Table 87 on page 224.

5. Click Add.

The Create Logical System (LSYS) page is displayed. Review the logical system details.

6. Select the logical system and click the pencil icon to modify the details, if required.

Logical System configuration parameters cannot be edited after you click Preview Configuration or
Create.

7. Click Create to create the logical system.
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The Job Details page is displayed with update logical system device job and its status.

8. Click OK.

If the job is successful, the created logical system is displayed in the Security Devices page. The name
of the root device is displayed beside the logical system device name. You can click on the root device
name to see the root device details.

Table 87: Add Bulk Logical System

DescriptionParameters

A logical systemname can be amaximumof 63 characters and can include alphanumeric characters,
dashes, and underscores.

Logical System
Name

Select the number of logical systems that you want to create.

You can create a maximum of 31 logical systems.

NOTE: The logical system name uses the number as prefix for the selected count. You can review
the details of the logical system and modify the name, if required.

Number of
LSYS(s)

Enter the routing instance name. A routing instance system name can be a maximum of 63
characters and can include alphanumeric characters and dashes.

Routing Instance
Name

Select the routing instance type from the list.Routing Instance
Type
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Table 87: Add Bulk Logical System (continued)

DescriptionParameters

To distribute security resources across logical systems, you can create security profiles that specify
the type and amount of resources to be allocated. You can create security profile and bind it to
more than one logical system, if you want to allocate the same type and amount of resources to
them.

When a device is discovered in Security Director for the first time, you can see the list of security
profiles, if any, while creating a logical system. Alternatively, you can create security profiles in
Security Director.

A security profile is mandatory to create a Logical system. Each security profile contains resources
with a range based on the devices. You can manage the resources by allocating reserved and
maximum values.

Select a security profile, which will be bound to the logical system.

To create a security profile:

1. Click the + icon.

The Create Security Profile page is displayed.

2. Complete the configuration according to the guidelines given in Table 88 on page 226.

3. Click Save.

The Job Details page is displayed with the status of update security profile job. If the job is
successful, the security profile is created.

To edit the security profile, select a security profile and click the pencil icon.

NOTE: You can configure up to 32 security profiles on an SRX Series device running logical
systems. When you reach the limit, you can delete the empty profiles. If you want to delete a
profile which is assigned to a logical system, then first assign some other profile to the logical
system and then delete the profile. Otherwise, you cannot delete a profile and commit fails on
the device.

Security Profiles

Select a user class. Each user is assigned to a class, which defines the user permissions.

NOTE: User class details section is available only when you create an individual logical system
at a time. When you create a logical system in bulk, you can provide the user class when you edit
the logical system as mentioned in 6 in “Add Logical Systems in Bulk” on page 222.

User Class Details
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Table 87: Add Bulk Logical System (continued)

DescriptionParameters

Select an interface.

To add logical interface:

1. Click Add Logical Interface.

The corresponding logical interfaces page is displayed.

2. Click the + icon.

The Add Logical Interface page is displayed.

3. Enter the following details:

• Logical Interface Unit—Enter the name of the logical interface, which must be a number
from 0 through 2147483647.

• Description—Enter a valid description for logical interface. The maximum limit is 255
characters.

• VLAN ID—Select the VLAN ID. If the VLAN tagging is enabled, then the VLAN ID is
mandatory.

• IPv4 address—Enter the IPv4 address and the subnet mask.

• IPv6 address—Enter the IPv6 address and the subnet mask.

NOTE: User class details section is available only when you create individual logical system at a
time. When you create logical systems in bulk, you can provide the user class when you edit the
logical system as mentioned in 6 in “Add Logical Systems in Bulk” on page 222.

Assign Interfaces

Table 88: Security Profile

DescriptionParameters

General Settings

Enter a valid unique name. The name must contain only letters and numbers. Note that the
security profile name must be unique for the selected root device.

Security Profile Name

Select the type of resource and allocate the reserved and maximum value for the selected
resource.

Each security profile contains resources with a range based on the devices. You can manage
the resources by allocating reserved and maximum values.

Resource Allocation

It guarantees that the specified resource is always available to the logical system. If a reserved
quota is not configured for a resource, the default value is 0.

Reserved
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Table 88: Security Profile (continued)

DescriptionParameters

If a logical system requires more resource than reserved amount allows, it can utilize resources
configured for the global maximum amount if they are available—if they are not allocated to
other logical systems. The maximum allowed quota specifies the portion of the free global
resources that the logical system can use. The maximum allowed quota does not guarantee
that the amount specified for the resource in the security profile is available.

If a maximum allowed quota is not configured for a resource, the global system quota for the
resource is used as a default value. Global system quotas are platform-dependent.

Maximum

RELATED DOCUMENTATION

Logical Systems Overview | 221

Create a Tenant System

IN THIS SECTION

Add Tenant Systems in Bulk | 227

Add Individual Tenant System at a Time | 228

You can add tenant systems in bulk or add individual tenant system at a time.

Add Tenant Systems in Bulk

To add tenant systems in bulk:

1. Select Devices > Security Devices.

The Security Devices page is displayed.

2. Select a root device, right-click and select Create Tenant System.

The Create Tenant System (TSYS) page is displayed.
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3. Click Add Bulk TSYS.

The Add Bulk Tenant System (TSYS) page is displayed.

4. Complete the configuration according to the guidelines given in Table 89 on page 229.

5. Click Add.

The Create Tenant System (TSYS) page is displayed. Review the tenant system details.

6. Select the tenant system and click the pencil icon to modify the details, if required.

You can also provide the user class and interface for tenant systems. Tenant System configuration
parameters cannot be edited after you click Preview Configuration or Create.

7. Click Create to create the tenant system.

The Job Details page is displayed with update tenant system device job and its status.

8. Click OK.

If the job is successful, the tenant system is created and displayed in the Security Devices page. The
root device name is displayed beside the tenant system device name. You can click on the tenant system
device name link to see the device details.

Add Individual Tenant System at a Time

Alternatively, you can create individual tenant systems at a time. To create individual tenant system at a
time:

1. Select Devices > Security Devices.

The Security Devices page is displayed.

2. Select a root device, right-click and select Create Tenant System.

The Create Tenant System (TSYS) page is displayed.

3. Click the + icon.

The Create Tenant System (TSYS) page is displayed.

4. Complete the configuration according to the guidelines given in Table 89 on page 229.

5. Click Add.

The Create Tenant System (TSYS) page is displayed. Review the tenant system details.
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6. Select the tenant system and click the pencil icon to modify the details, if required.

Tenant System configuration parameters cannot be edited after you click Preview Configuration or
Create.

7. Click Create to create the tenant system.

The Job Details page is displayed with update tenant system device job and its status.

8. Click OK.

If the job is successful, the created tenant system is displayed in the Security Devices page. The name
of the root device is displayed beside the tenant system device name. You can click on the root device
name to see the root device details.

Table 89: Add Bulk Tenant System

DescriptionParameters

General Details

A tenant system name can be amaximumof 63 characters
and can include alphanumeric characters, dashes, and
underscores.

Tenant System Name

Select the number of tenant systems that you want to
create.

You can create a maximum of 499 tenant systems.

NOTE: The tenant systemname uses the number as prefix
for the selected count. You can review the details of the
tenant system and modify the name, if required.

Number of TSYS(s)

Enter the routing instance name. A routing instance system
name can be a maximum of 63 characters and can include
alphanumeric characters and dashes.

Routing Instance Name

Select the routing instance type from the list.Routing Instance Type

Security Profiles
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Table 89: Add Bulk Tenant System (continued)

DescriptionParameters

To distribute security resources across tenant systems,
you can create security profiles that specify the type and
amount of resources to be allocated. You can create
security profile and bind it tomore than one tenant system,
if you want to allocate the same type and amount of
resources to them.

When a device is discovered in Security Director for the
first time, you can see the list of security profiles, if any,
while creating a tenant system. Alternatively, you can
create security profiles in Security Director.

A security profile is mandatory to create a tenant system.
Each security profile contains resourceswith a range based
on the devices. You can manage the resources by
allocating reserved and maximum values.

Select a security profile, which will be bound to the tenant
system.

To create a security profile:

1. Click the + icon.

The Create Security Profile page is displayed.

2. Complete the configuration according to the guidelines
given in Table 90 on page 232.

3. Click Save.

The Job Details page is displayed with the status of
update security profile job. If the job is successful, the
security profile is created.

To edit the security profile, select a security profile and
click the pencil icon.
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Table 89: Add Bulk Tenant System (continued)

DescriptionParameters

Select a user class. Each user is assigned to a class, which
defines the user permissions.

NOTE: User class details section is available only when
you create individual tenant system at a time. When you
create a tenant system in bulk, you can provide the user
class when you edit the tenant system as mentioned in 6
in “Add Tenant Systems in Bulk” on page 227.

User Class Details

Select an interface.

To add logical interface:

1. Click Add Logical Interface.

The corresponding logical interfaces page is displayed.

2. Click the + icon.

The Add Logical Interface page is displayed.

3. Enter the following details:

• Logical Interface Unit—Enter the name of the logical
interface, which must be a number from 0 through
2147483647.

• Description—Enter a valid description for logical
interface. The maximum limit is 255 characters.

• VLAN ID—Select the VLAN ID. If the VLAN tagging
is enabled, then the VLAN ID is mandatory.

• IPv4 address—Enter the IPv4 address and the subnet
mask.

• IPv6 address—Enter the IPv6 address and the subnet
mask.

NOTE: User class details section is available only when
you create individual tenant system at a time. When you
create tenant systems in bulk, you can provide the user
class when you edit the tenant system as mentioned in 6
in “Add Tenant Systems in Bulk” on page 227.

Assign Interfaces
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Table 90: Security Profile

DescriptionParameters

General Settings

Enter a valid unique name. The name must contain only letters and numbers. Note that the
security profile name must be unique for the selected root device.

Security Profile Name

Select the type of resource and allocate the reserved and maximum value for the selected
resource.

Each security profile contains resources with a range based on the devices. You can manage
the resources by allocating reserved and maximum values.

Resource Allocation

It guarantees that the specified resource amount is always available to the logical system. If
a reserved quota is not configured for a resource, the default value is 0.

Reserved

If a logical system requires more resource than its reserved amount allows, it can utilize
resources configured for the global maximum amount if they are available—if they are not
allocated to other logical systems. The maximum allowed quota specifies the portion of the
free global resources that the logical system can use. The maximum allowed quota does not
guarantee that the amount specified for the resource in the security profile is available.

If a maximum allowed quota is not configured for a resource, the global system quota for the
resource is used as a default value. Global system quotas are platform-dependent.

Maximum

RELATED DOCUMENTATION

Tenant Systems Overview | 221

Uploading Authentication Keys to Devices in Security Director

You can authenticate a device by using credentials (username and password) or by key-based authentication.
Junos Space supports RSA keys for key-based authentication. In the Security Devices page, you can upload
authentication keys to one or more devices.

NOTE: You can generate the authentication keys from the Fabric page in the Administration
workspace of Junos Space Network Management Platform.
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To upload authentication keys to one or more devices:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Click the Upload Keys button.

The Upload Keys page appears.

3. Specify the parameters for uploading keys according to the guidelines provided in Table 91 on page 233.

4. Click OK to confirm the key upload.

The Job Details: Upload RSA keys page appears, displaying details of the uploaded job.

5. Click OK to close the Job Details page.

You are returned to the Security Devices page.

Table 91: Upload Keys Settings

GuidelineSetting

Upload Keys

Specify how you want to upload keys:

• Select Add Manually to add the device details and authentication keys manually.

• Select Import from CSV to import the device details and authentication keys from
a comma-separated values (CSV) file.

Click the CSV Sample link to view or download a sample CSV file.

Upload Type

Click Browse to browse for and select a CSV file.

The CSV file that you selected is displayed in this field. Click Next to continue.

CSV File

Select either the IP address or hostname of the device as the upload type.Add Manually

Enter the IPv4 or IPv6 address of the device.IP Address

Enter the hostname of the device.Hostname

Enter the username (of the device administrator) to be used for device authentication.Device Admin

Enter the password (of the device administrator) to be used for device authentication.

Click Next to continue.

Password
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Table 91: Upload Keys Settings (continued)

GuidelineSetting

Select this check box to authorize a different user on the target device.Authorize as different user

Specify the username to be used for uploading.

If the username that you specify does not exist on the device, a user with this username
is created and the key is uploaded for this user.

If you do not specify a username, the key is uploaded for the device administrator.

Click Next to continue.

User on Device

Authentication keys will be uploaded to the following devices

The list of devices on which authentication keys will be loaded is displayed.

Click Back to return to the previous section or Finish to go to a summary page.

RELATED DOCUMENTATION

Using Features in Security Devices | 214

Security Devices Overview | 217

Modifying the Configuration of Security Devices

You can use the Modify Configuration page to modify the configuration of one or more managed devices.
You cannot modify the configuration of unmanaged devices, devices of the TCA Series family, and devices
with the configuration status “waiting for deployment.”

To modify the configuration of one or more security devices:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices whose configuration you want to modify.

3. From the More or right-click menu, select Configuration > Modify Configuration.
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The Modify Configuration page appears with the Basic Setup section selected by default. See
Table 92 on page 236 for the configurations that you can modify.

NOTE: Depending on whether you selected one device or more than one device, the
configuration that you can modify differs. If you select only one device, all sections can be
modified. If you select more than one device, only the Basic Setup, Syslog, and Security
Logging sections can be modified; in addition, configuration parameters that are unique to
the device, such as hostname, cannot be modified.

4. After you have modified the configuration, you can perform the following actions:

• Click the Save button to save the configuration changes that you made. The changes that you made
are saved to the Junos Space database and you are returned to the Security Devices page.

• Click thePreviewChanges button to preview the changes that youmade. The PreviewConfiguration
Changes page appears with the CLI tab selected by default. The CLI tab displays the Junos OS
commands corresponding to the changes that you made. For an XML view of the configuration, click
the XML tab. Click Close to close the page and you are returned to the Modify Configuration page.

• Click the Save andDeploy button to save the configuration changes and deploy the saved configuration
to the device.

• If the configurationwas notmodified, theDeploy Configuration page appears displaying amessage
indicating that no changes were made. Click OK to close the page.

You are returned to the Modify Configuration page.

• If the configuration was modified, then the changes are saved to the Junos Space database and
the Deploy Configuration page appears.

• In the Type field, specify whether you want to deploy the configuration immediately or deploy
the configuration later. If you choose to deploy the configuration later, you must specify a date
and time in the DD/MM/YYYY HH:MM:SS AM/PM/24-hour formats.

• Click OK.

The Job Details: Deploy Configuration page appears displaying the details of the job.

• Click OK to close the Job Details page.

You are returned to the Security Devices page.

• Click Cancel to discard the configuration changes that you made. The changes are discarded and you
are returned to the Security Devices page

235



NOTE: For tenant systems, you can modify configurations such as routing instances, physical
interfaces, security logging, access profile, screens, zones, and ICAP redirect.

For logical systems, you can modify configurations such as static routes, routing instances,
physical interfaces, security logging, screens, zones, SSL initiation, and ICAP redirect.

Table 92: Modify Configuration

ActionConfiguration

See “Modifying the Basic Configuration for Security Devices” on page 237.Basic Setup

See “Modifying the Static Routes Configuration for Security Devices” on page 248.Static Routes

See “Modifying the Routing Instances Configuration for Security Devices” on
page 253.

Routing Instances

See “Modifying the Physical Interfaces Configuration for Security Devices” on
page 256.

Physical Interfaces

See “Modifying the Syslog Configuration for Security Devices” on page 261.Syslog

See “Modifying the Security Logging Configuration for Security Devices” on
page 269.

Security Logging

See “Modifying the Link Aggregation for Security Devices” on page 275.Link Aggregation

See “Modifying the User Management Configuration for Security Devices” on
page 279.

User Management

See “Modifying the Screens Configuration for Security Devices” on page 288.Screens

See “Modifying the Zones Configuration for Security Devices” on page 298.Zones

See “Modifying the IPS Configuration for Security Devices” on page 302.IPS

See “Modifying the SSL Initiation Profile for Security Devices” on page 304.SSL Initiation

See “Modifying the ICAP Redirect Profile for Security Devices” on page 306.ICAP Redirect

See “Configuring Aruba ClearPass for Security Devices” on page 310.Aruba ClearPass

See “Modifying the Express Path Configuration for Security Devices” on page 314.Express Path
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Table 92: Modify Configuration (continued)

ActionConfiguration

See “Configuring APBR Tunables for Security Devices” on page 313.APBR-Tunables

See “Modifying theDevice Information Source Configuration for Security Devices”
on page 316.

Device Information

RELATED DOCUMENTATION

Using Features in Security Devices | 214

Security Devices Overview | 217

Modifying the Basic Configuration for Security Devices

You can use the Basic Setup section on the Modify Configuration page to modify the basic configuration
for a device. You can modify settings related to hostname and device name, system time, basic protocols,
users, DNS, and SNMP.

NOTE: Refer to the JunosOSdocumentation at https://www.juniper.net/documentation/en_US/
release-independent/junos/information-products/pathway-pages/junos/product/ for a particular
release and device. There you can find detailed information on the configuration parameters for
that device.

To modify the basic configuration:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices to modify configuration.

3. From the More or right-click menu, select Configuration > Modify Configuration.

The Modify Configuration page appears with the Basic Setup section selected by default.
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4. Modify the configuration according to the guidelines provided in Table 93 on page 238.

5. After modifying the configuration, you can cancel the changes, save the changes, preview the changes,
or save the changes and deploy the configuration on the device. See “Modifying the Configuration of
Security Devices” on page 234.

Table 93: Basic Setup

GuidelineSetting

Modify the hostname of the device.Hostname

Modify the domain name in which the device is located.Domain Name

Enter an alphanumeric password. It must be from 6 up to 128 characters long. It can include
uppercase letters, lowercase letters, numbers, punctuationmarks, and other special characters.

Root Password

Re-enter the password for the root user.Confirm Password

Configure a Domain Name System (DNS) for a device. Specify a server that the device can
use to resolve hostnames into addresses.

To add a DNS Server:

1. Click + icon.

The Add DNS Server page is displayed.

2. Enter the IPv4 or IPv6 address of the DNS Server.

3. Click OK.

If the fields entered are valid, a DNS server is created and a confirmation message is
displayed at the top of the Modify Configuration page.

You can also edit or delete the DNS Server.

DNS Server
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Table 93: Basic Setup (continued)

GuidelineSetting

Specifies the DNS domain name.

To include the domain name of the device in a DNS search:

1. Click + icon.

The Add Domain Name page is displayed.

2. Enter the domain name.

Enter a string with an alphanumeric character. You can include underscores, hyphen, slash,
and dot. Spaces are not allowed.

3. Click OK.

You can also edit or delete the existing DNS names.

Domain Search

System Time Setting

Select the local time zone in which the device is located.Time Zone

Specifies themethod the device uses to set the system time. SyncwithNTP Server synchronizes
the system time with the NTP server that you select.

Time Source
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Table 93: Basic Setup (continued)

GuidelineSetting

Existing NTP servers are displayed in a table with the server name, authentication key, NTP
server version, and whether the server is preferred (True) or not (False). You can perform the
following actions:

• Add an NTP Server:

1. Click + to add an NTP server.
The Add NTP Server page is displayed.

2. Complete the configuration according to the guidelines provided in Table 94 on page 247.

3. Click OK.
If the fields entered are valid, an NTP server is created and a confirmation message is
displayed at the top of the Modify Configuration page.

• Modify NTP server settings—Select an NTP server and click the pencil icon to modify the
settings.

The Edit NTP Server page appears, showing the same fields that are presented when you
create an NTP server. You can modify some of the fields on this page. See
Table 94 on page 247 for an explanation of the fields.

• Delete NTP servers—Select one or more NTP servers and click the X icon to delete the NTP
servers.

TheWarning page appears. Click Yes to confirm the deletion. The selected NTP servers are
deleted.

NTP Server

Management Access Configuration

Select the checkbox to enable Web API configuration.Web API

Select the checkbox to enable web API client.Client

Provides the address of permitted HTTP or HTTPS request originators.

To add a hostname:

1. Click + icon.

The Add WebAPI Hostname page is displayed.

2. Enter the IPv4 address of the request originator.

3. Click OK.

To edit the hostname, select the hostname and click the pencil icon. Click the delete icon to
delete the hostname.

Host Name
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Table 93: Basic Setup (continued)

GuidelineSetting

Select the checkbox to enable unencrypted HTTP connection settings.HTTP

Select a HTTP port. Provides TCP ports for incoming HTTP connections. The range is from 1
through 65535.

HTTP Port

Select the checkbox to enable encrypted HTTPS connection settings.HTTPS

Select a HTTPs port. Provides TCP ports for incoming HTTPS connections. The range is from
1 through 65535.

HTTPS Port

Specifies the certificate that you want to use to secure the connection from the HTTPS
certificates list when you enable HTTPs for Web API.

Select an option:

• Default—Specifies the default certificate to be used.

• PKI Certificate—Specifies the name of the certificate that is generated by public key
infrastructure (PKI).

PKI Certificate—Select the PKI certificate for HTTPS of Web API.

• Local Certificate—Specifies the name of the local certificate.

• Upload Certificate—Browse and upload the certificate.

• Certificate Path—Displays the file path of the uploaded certificate.

• Certificate Key—Browse and upload the certificate key.

• Certificate Key Path—Displays the file path of the uploaded certificate key.

Certificate Type

Select the checkbox to provide the user credential details.User

Enter the username.Name

Enter the password.Password

Select the checkbox to enable REST API. Allows RPC execution over HTTP(S) connection.REST API

Select the checkbox to enable REST API explorer.Explorer

Select the checkbox to specify the allowed source IP addresses and maximum number of
simultaneous connections for the REST API process.

Control
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Table 93: Basic Setup (continued)

GuidelineSetting

Specifies the source IP address for the REST API process.

To add the source IP address for the REST API process:

1. Click + icon.

The Add Allowed Source page is displayed.

2. Enter the IPv4 address of the source.

3. Click OK.

Allowed Sources

Select the maximum number of simultaneous connections for the REST API process.Connection Limit

Select the checkbox to enable unencrypted HTTP connections for REST API.HTTP

Provides addresses for the incoming connections for HTTP of REST API.

To add the address:

1. Click + icon.

The Add Address page is displayed.

2. Enter the IPv4 address.

3. Click OK.

Address

Select the HTTP port. Provides port to accept HTTP connections for REST API. The range is
from 1024 through 65535.

HTTP Port

Select the checkbox to enable encrypted HTTPS connections for REST API.HTTPS
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Table 93: Basic Setup (continued)

GuidelineSetting

Provides addresses for the incoming connections for HTTPS of REST API.

To add the address:

1. Click + icon.

The Add Address page is displayed.

2. Enter the IPv4 address.

3. Click OK.

Address

Select the port to accept the HTTPS connection of REST API. The range is 1024 through
65535.

HTTPS Port

Select the Cipher suites in order of your preference and click the right arrow to add.

Provides the Cipher suites for HTTPS of REST API.

Cipher List

Select the server certificate for HTTPS of REST API.Server Certificate

Specifies the certificate name to secure HTTPS connections.

To add a local certificate:

1. Click the + icon.

The Add Local Certificate page is displayed.

2. Enter the name and certificate content.

3. Click OK.

Select the certificate and click pencil icon to edit the certificate. Click the delete icon to delete
the certificate.

Certificate

System Services

Select the checkbox to allow FTP file transfers to and from the device.FTP File Transfers

Select the checkbox to allow SSH access to the device.SSH Access

Select the checkbox to allow telnet access to the device.Telnet Login
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Table 93: Basic Setup (continued)

GuidelineSetting

Select the checkbox to enable network configuration protocol connections.NetConf Session

Select the checkbox to enable the network configuration protocol sessions compliant to RFC
4741.

RFC Complaint

Select the checkbox to enable network configuration protocol connections over SSH
connections.

NetConf -> SSH

Select the checkbox to enable unencrypted HTTP connection settings.HTTP Services

Select the TCP port for incoming HTTPS connections. The range is 1 through 65535.HTTP Port

Select interfaces that acccept http access.Interface

Select the checkbox to enable encrypted HTTPS connection settings.HTTPS Services

Select interfaces that acccept https access.Interface

Select the certificate that youwant to use to secure the connection from theHTTPS certificates
list.

This is applicable only if you allow HTTPS Services.

• local-certificate—Specifies the name of the local certificate to use.

• pki-local-certificate—Specifies the name of the certificate that is generated by public key
infrastructure (PKI).

• system-generated-certificate—Specifies the automatically generated self-signed certificate
for enabling HTTPS services.

HTTPS Certificate

Select the TCP port for incoming HTTPS connections. The range is from 1 through 65535.

This is applicable only if you allow HTTPS Services.

HTTPS Port

SNMP

Enter the location information where the device is physically located such as a lab name or a
rack name.

Location

Enter the contact information such as name and phone number of an administrator of the
system.

Contact Information

Enter the description for the system.System Description
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Table 93: Basic Setup (continued)

GuidelineSetting

Enter theMAC address of Ethernetmanagement port 0. The local engine ID is unique identifier
of an SNMPv3 engine for system identification. The local engine ID contains a prefix and a
suffix. The prefix is formatted according to specifications defined in RFC 3411. The suffix is
defined by the local engine ID. The local engine ID suffix is the MAC address of Ethernet
management port 0.

Local Engine ID

Existing SNMP communities are displayed in a table with the name and authorization for each
community. You can perform the following actions:

• Add an SNMP community:

1. Click + to add an SNMP community on the device.
The Add SNMP Community page appears.

2. Specify the following fields:
• Name—Specify the name of the SNMP community string.

• Authorization—Select the authorization for the SNMP community. If you select
read-only, the user can read the information from the device by using the SNMPGET
command. If you select read-write, in addition to reading the information, the user
can also modify the configuration on the device using the SNMP SET command.

3. Click OK.
If the fields entered are valid, an SNMP community is created and a confirmationmessage
is displayed at the top of the Modify Configuration page.

• Modify an SNMP community—Select an SNMP community and click the pencil icon to
modify the settings.

The Edit SNMPCommunity page appears, showing the same fields that are presentedwhen
you create an SNMP community. You can modify some of the fields on this page. See the
preceding bullet for an explanation of the fields.

• Delete SNMP community entries—Select one or more SNMP community entries and click
the X icon to delete the communities.

The Warning page appears. Click Yes to confirm the deletion. The selected SNMP
communities are deleted.

Community
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Table 93: Basic Setup (continued)

GuidelineSetting

Existing SNMP trap groups are displayed in a table with the name and category for each trap
group. You can perform the following actions:

• Add an SNMP trap group

1. Click + to add an SNMP trap group on the device.
The Add SNMP Trap Group page appears.

2. In the Name field, specify the name of the SNMP trap group.

3. Select the SNMP trap types or categories to be associated with the trap group.

4. Click OK.
If the fields entered are valid, an SNMP trap group is created and a confirmationmessage
is displayed at the top of the Modify Configuration page.

• Modify an SNMP trap group—Select an SNMP trap group and click the pencil icon tomodify
the settings.

The Edit SNMP Trap Group page appears, showing the same fields that are presented when
you create an SNMP trap group. You can modify some of the fields on this page. See the
preceding bullet for an explanation of the fields.

• Delete SNMP trap groups—Select one or more trap groups and click the X icon to delete
the trap groups.

The Warning page appears. Click Yes to confirm the deletion. The selected SNMP trap
group are deleted.

Trap Group

Select the checkbox to enable the SNMP health monitor on the device. The health monitor
periodically checks the following key indicators of device health:

• Percentage of file storage used

• Percentage of Routing Engine CPU used

• Percentage of Routing Engine memory used

• Percentage of memory used for each system process

• Percentage of CPU used by the forwarding process

• Percentage of memory used for temporary storage by the forwarding process

Health Monitoring

Select an interval to specify the sampling frequency interval, in seconds, over which the key
health indicators are sampled and comparedwith the rising and falling thresholds. For example,
if you configure the interval as 100 seconds, the values are checked every 100 seconds.

The range is from 1 through 24855. The default value is 300 seconds.

Interval
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Table 93: Basic Setup (continued)

GuidelineSetting

Select a value at which you want SNMP to generate an event (trap and system log message)
when the value of a sampled indicator reaches or exceeds the rising threshold value. For
example, if the rising threshold is 90, SNMP generates an event when the value of any key
indicator reaches or exceeds 90 seconds.

The range is from 1 through 100. The default value is 90 seconds.

Rising Threshold

Select a value at which you want SNMP to generate an event (trap and system log message)
when the value of a sampled indicator reaches or falls below the falling threshold value. For
example, if the falling threshold is 80, SNMP generates an event when the value of any key
indicator is 80 seconds or less.

The range is from 0 through 100. The default value is 80 seconds.

Falling Threshold

Table 94: Add NTP Server Settings

GuidelineSetting

Specify the name or IP address of the remote NTP server.Name

Specify the key number used to encrypt authentication fields in all packets sent to the
NTP server.

Key

Specify the version number used in outgoing NTP server packets.Version

Specify the NTP server as the preferred server if you configured more than one.Prefer

Enter the routing instance through which the server is reachable.Routing Instance
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Modifying the Static Routes Configuration for Security Devices

You can use the Static Routes section on the Modify Configuration page to view, create, edit, or delete
static routes on the device. You can activate or deactivate a static route or toggle the status of one or
more static routes.

NOTE: Refer to the Junos OS documentation (available at http://www.juniper.net/
documentation/en_US/release-independent/junos/information-products/pathway-pages/junos/
product/) for a particular release and device. There you can find detailed information on the
configuration parameters for that device.

To modify the static routes configuration:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices whose configuration you want to modify.

3. From the More or right-click menu, select Configuration > Modify Configuration.

The Modify Configuration page appears.

4. Click the Static Routes link in the left-navigation menu.

The Static Routes section on the Modify Configuration page is displayed. The existing static routes are
displayed in a table. The actions that you can perform in this page are provided in Table 95 on page 249.

5. After modifying the configuration, you can cancel the changes, save the changes, preview the changes,
or save the changes and deploy the configuration on the device. See “Modifying the Configuration of
Security Devices” on page 234.
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Table 95: Static Routes Actions

GuidelineAction

Click the + icon to create a static route.

The Create Static Route page appears. Complete the configuration according to the
guidelines provided in Table 96 on page 250 and click OK.

The static route is created and you are returned to the Static Routes section on theModify
Configuration page.

NOTE: You must configure either a next hop or a next table for each static route that you
configure.

Create a static route

Select a static route and click the pencil icon.

The Edit Static Route page appears, showing the same fields that are presented when you
create a static route. You can modify some of the fields on this page. See
Table 96 on page 250 for an explanation of the fields. After you have modified the static
route, click OK.

The changes are saved and you are returned to the Static Routes section on the Modify
Configuration page.

Modify a static route

Select one or more static routes and click the X icon to delete the routes.

The Warning page appears. Click Yes to confirm the deletion. The selected static routes
are deleted.

Delete static routes

Select one or more deactivated static routes. From the More or right-click menu, select
Activate.

The static routes are activated and their status is changed to Activated.

Activate static routes

Select one or more activated static routes. From the More or right-click menu, select
Deactivate.

The static routes are deactivated and their status is changed to Deactivated.

Deactivate static routes

Select one or more static routes. From the More or right-click menu, select Toggle.

The activated static routes are deactivated and the deactivated static routes are activated.

NOTE: The Toggle option is enabled only when the selected static routes are a mix of
activated and deactivated records.

Toggle the status of a
static route
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Table 96: Create Static Route Settings

GuidelineSetting

Basic Information

Select the type of IP address (IPv4 or IPv6).

Enter the IPv4 or IPv6 address depending on the type of IP address specified.IP Address

Enter the subnet for the IPv4 address or the prefix for the IPv6 address.Subnet

Next Hop

You can perform the following actions in this field:

• Add a next hop—

1. Click + to add a next hop on the device.
The Create Next Hop page appears.

2. Complete the configuration according to the guidelines provided in Table 97 on page 252.

3. Click OK.
If the fields entered are valid, a next hop is created the entry is displayed in the table.

• Modify next hop settings—Select a next hop and click the pencil icon to modify the settings.

The Edit Next Hop page appears, showing the same fields that are presented when you
create a next hop. See Table 97 on page 252 for an explanation of the fields.

• Delete next hop entries—Select one or more next hops and click the X icon to delete the
next hops.

TheWarning page appears. Click Yes to confirm the deletion. The selected next hop entries
are deleted.

Next Hop

Qualified Next Hop
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Table 96: Create Static Route Settings (continued)

GuidelineSetting

You can perform the following actions in this field:

• Add a next hop—

1. Click + to add a qualified next hop on the device.
The Create Qualified Next Hop page appears.

2. Complete the configuration according to the guidelines provided in Table 98 on page 252.

3. Click OK.
If the fields entered are valid, a qualified next hop is created the entry is displayed in the
table.

• Modify qualified next hop settings—Select a qualified next hop and click the pencil icon to
modify the settings.

The Edit QualifiedNext Hop page appears, showing the same fields that are presentedwhen
you create a qualified next hop. See Table 98 on page 252 for an explanation of the fields.

• Delete qualified next hop entries—Select one or more qualified next hops and click the X
icon to delete the qualified next hops.

The Warning page appears. Click Yes to confirm the deletion. The selected qualified next
hop entries are deleted.

Next Table

Select the name of next routing table to the destination.Next Table

Advanced Options

Enter a preference for the next hop; the lower the number the higher the route preference.

Range: 0 through 2,147,483,647

Preference

Enter a metric value, which signifies the cost for an access route, for the next hop.

Range: 0 through 2,147,483,647

Metric

Specify that packets addressed to this destination are dropped and ICMP (or ICMPv6)
unreachable messages are not sent to the originator of the packet.

Discard

Specify whether indirectly-connected next hops should be resolved (Resolve) or not (No
Resolve). Select None if no action is required.

Resolve Choices

Specify whether the route should be deleted from the forwarding table (No Retain) or retained
(Retain) when the routing protocol process shuts down normally. Select None if no action is
required.

Retain Choices
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Table 96: Create Static Route Settings (continued)

GuidelineSetting

Specify whether the route should be installed in the forwarding table or not. Select None if
no action is required.

Install Choices

Specify whether the route should be readvertised by routing protocols or not. Select None if
no action is required.

Readvertise Choices

Table 97: Create Next Hop Settings

GuidelineSetting

Specify the next hop as an IP address or an interface name.

Enter an IPv4 or IPv6 address for the next hop depending on the type of IP address
specified for the static route.

IP Address

Select the interface name to be used as the next hop.Interface

Table 98: Create Qualified Next Hop Settings

GuidelineSetting

Specify the qualified next hop as an IP address or an interface name.

Enter an IPv4 or IPv6 address for the qualified next hop depending on the type of IP address
specified for the static route.

IP Address

Select the interface name to be used as the qualified next hop.Interface

Enter a preference for the qualified next hop; the lower the number the higher the route
preference.

Range: 0 through 2,147,483,647

Preference

Enter a metric value, which signifies the cost for an access route, for the qualified next
hop.

Range: 0 through 2,147,483,647

Metric
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Modifying the Routing Instances Configuration for Security Devices

You can use the Routing Instances section on theModify Configuration page to view, create, edit, or delete
routing instances on the device. You can activate or deactivate a routing instance or toggle the status of
one or more routing instances.

NOTE: Refer to the Junos OS documentation (available at http://www.juniper.net/
documentation/en_US/release-independent/junos/information-products/pathway-pages/junos/
product/) for a particular release and device. There you can find detailed information on the
configuration parameters for that device.

To modify the routing instances configuration:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices whose configuration you want to modify.

3. From the More or right-click menu, select Configuration > Modify Configuration.

The Modify Configuration page appears.

4. Click the Routing Instances link in the left-navigation menu.

The Routing Instances section on the Modify Configuration page is displayed. The existing routing
instances are displayed in a table. The actions that you can perform in this page are provided in
Table 99 on page 254.

5. After modifying the configuration, you can cancel the changes, save the changes, preview the changes,
or save the changes and deploy the configuration on the device. See “Modifying the Configuration of
Security Devices” on page 234.
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Table 99: Routing Instances Actions

GuidelineAction

NOTE: For tenant systems, new routing instance cannot be created.

Click the + icon to create a routing instance.

The Create Routing Instance page appears. Complete the configuration according to
the guidelines provided in Table 100 on page 255 and click OK.

The routing instance is created and you are returned to the Routing Instances section
on the Modify Configuration page.

Create a routing instance

Select a routing instance and click the pencil icon.

The Edit Routing Instance page appears, showing the same fields that are presented
when you create a routing instance. You can modify some of the fields on this page.
See Table 100 on page 255 for an explanation of the fields. After you havemodified the
routing instance, click OK.

The changes are saved and you are returned to the Routing Instances section on the
Modify Configuration page.

Modify a routing instance

Select one or more routing instances and click the X icon to delete the routes.

The Warning page appears. Click Yes to confirm the deletion. The selected routing
instances are deleted.

Delete routing instances

View or configure static routes for the routing instance by clicking the view/configure
link in the Static Route column. The Static Routes page appears. The field and actions
on this page are the same as the ones in the Static Routes section on the Modify
Configuration page. See “Modifying the Static Routes Configuration for SecurityDevices”
on page 248.

View or configure static
routes for an existing
routing instance

Select one or more deactivated routing instances. From the More or right-click menu,
select Activate.

The routing instances are activated and their status is changed to Activated.

Activate routing instances

Select one or more activated routing instances. From the More or right-click menu,
select Deactivate.

The routing instances are deactivated and their status is changed to Deactivated.

Deactivate routing instances
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Table 99: Routing Instances Actions (continued)

GuidelineAction

Select one or more routing instances. From theMore or right-click menu, select Toggle.

The activated routing instances are deactivated and the deactivated routing instances
are activated.

NOTE: The Toggle option is enabled only when the selected routing instances are a
mix of activated and deactivated records.

Toggle the status of a
routing instance

NOTE: For tenant systems, new routing instance cannot be created.

Table 100: Create Routing Instance Settings

GuidelineSetting

Enter a name for the routing instance; no special characters are allowed and the keyword
default cannot be used. The routing instance name must be unique and must contain a
corresponding IP unicast table.

Name

Enter a description for the routing instance. We recommend that you enter a maximum of
255 characters.

Description

From the interfaces displayed in the Available column, select one or more interfaces to
associate with the routing instance.

Interfaces
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Modifying the Physical Interfaces Configuration for Security Devices

You can use the Physical Interfaces section on theModify Configuration page to view andmodify physical
interfaces on the device. You can also view, add, modify, or delete logical interfaces associated with the
physical interfaces.

NOTE: Refer to the Junos OS documentation (available at http://www.juniper.net/
documentation/en_US/release-independent/junos/information-products/pathway-pages/junos/
product/) for a particular release and device. There you can find detailed information on the
configuration parameters for that device.

To modify physical interfaces:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices to modify configuration.

3. From the More or right-click menu, select Configuration > Modify Configuration.

The Modify Configuration page appears.

4. Click Physical Interfaces in the left-navigation menu.

The Physical Interfaces section on the Modify Configuration page is displayed. The existing physical
interfaces are displayed in a table. The actions that you can perform in this page are provided in
Table 101 on page 257.

5. After modifying the configuration, you can cancel the changes, save the changes, preview the changes,
or save the changes and deploy the configuration on the device. See “Modifying the Configuration of
Security Devices” on page 234.
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Table 101: Physical Interfaces Actions

GuidelineAction

Select a physical interface and click the pencil icon.

The Edit Physical Interface page appears. You can modify some of the fields on this page. See
Table 102 on page 258 for an explanation of the fields. After you have modified the physical
interface, click OK.

The changes are saved and you are returned to the Physical Interfaces section on the Modify
Configuration page.

Modify a physical
interface

View or configure the logical interfaces associated with a physical interface by clicking the
View/Configure link in the Logical Interfaces column.

The Logical Interfaces page appears, displaying the list of logical interfaces associated with the
physical interface. You can perform the following actions on this page:

• Create a logical interface—Click the + icon to create a logical interface.

The Create Logical interface page appears. Complete the configuration according to the
guidelines provided in Table 103 on page 258 and click OK.

The logical interface is created and you are returned to the Logical Interfaces page.

• Modify a logical interface—Select a logical interface and click the pencil icon to modify the
settings.

The Edit Logical Interface page appears, showing the same fields that are presented when you
create an logical interface. You can modify some of the fields on this page. See
Table 103 on page 258 for an explanation of the fields.

After you have modified the logical interface, click OK. The changes are saved and you are
returned to the Logical Interfaces page.

• Delete logical interfaces—Select one or more logical interfaces and click the X icon to delete
the logical interfaces.

The Warning page appears. Click Yes to confirm the deletion. The selected logical interfaces
are deleted.

• Activate logical interfaces—Select one or more deactivated logical interfaces. From the More
or right-click menu, select Activate.

The logical interfaces are activated and their status is changed to Activated.

• Deactivate logical interfaces—Select one or more activated logical interfaces. From the More
or right-click menu, select Deactivate.

The logical interfaces are deactivated and their status is changed to Deactivated

• Toggle the status of a logical interface—Select one or more logical interfaces. From the More
or right-click menu, select Toggle.

The activated logical interfaces are deactivated and the deactivated logical interfaces are
activated.

View or configure
the logical
interfaces
associated with a
physical interface
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Table 101: Physical Interfaces Actions (continued)

GuidelineAction

Table 102: Edit Physical Interface Settings

GuidelineSetting

Basic Information

Enter the description of the physical interface. We recommend that you enter a
maximum of 255 characters.

Description

Specify the maximum transmission unit (MTU) on the physical interface.

Range: 256 through 9216

MTU

Select the speed (in MBps) at which the data transfer occurs in the interface.Speed

Advanced Options

Select this check box to enable VLAN tagging for the physical interface or clear the
check box to disable VLAN tagging for the physical interface.

Enable VLAN Tagging

Table 103: Create Logical Interface Settings

GuidelineSetting

Basic Information

Enter the name of the logical interface, which must be a number from 0 through 2,147,483,647.Name

Enter the description of the logical interface. We recommend that you enter a maximum of 255
characters.

Description

Enter the VLAN ID for the 802.1q VLAN tags. Range: 0 through 4096.VLAN ID

IPv4 Address
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Table 103: Create Logical Interface Settings (continued)

GuidelineSetting

You can do the following:

• Add an IPv4 Address—Click the + icon to add an IPv4 address for the logical interface.

The Add—Address (IPv4) page appears. Complete the configuration according to the guidelines
provided in Table 104 on page 260 and click OK.

The IPv4 address is added and you are returned to the Create Logical Interface page.

• Modify an IPv4 address—Select an IPv4 address and click the pencil icon tomodify the IPv4 address.

The Edit—Address (IPv4) page appears, showing the same fields that are presented when you add
an IPv4 address. You can modify some of the fields on this page. See Table 104 on page 260 for an
explanation of the fields.

After you have modified the IPv4 address entry, click OK. The changes are saved and you are
returned to the Create Logical Interface page.

• Delete IPv4 addresses—Select one or more IPv4 addresses and click the X icon to delete the IPv4
addresses.

The Confirm Delete page appears. Click Yes to confirm the deletion. The selected IPv4 addresses
are deleted.

IPv6 Addresses

You can do the following:

• Add an IPv6 Address—Click the + icon to add an IPv6 address for the logical interface.

The Add—Address (IPv6) page appears. Complete the configuration according to the guidelines
provided in Table 105 on page 260 and click OK.

The IPv6 address is added and you are returned to the Create Logical Interface page.

• Modify an IPv6 address—Select an IPv6 address and click the pencil icon tomodify the IPv6 address.

The Edit—Address (IPv6) page appears, showing the same fields that are presented when you add
an IPv6 address. You can modify some of the fields on this page. See Table 105 on page 260 for an
explanation of the fields.

After you have modified the IPv6 address entry, click OK. The changes are saved and you are
returned to the Create Logical Interface page.

• Delete IPv6 addresses—Select one or more IPv6 addresses and click the X icon to delete the IPv6
addresses.

The Confirm Delete page appears. Click Yes to confirm the deletion. The selected IPv6 addresses
are deleted.
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Table 104: Add – Address (IPv4) Settings

GuidelineSetting

Enter an IPv4 address for the logical interface.IP Address

Enter the subnet for the IPv4 address.Subnet

Select this check box to specify that the IPv4 address is the primary address of the protocol
on the logical interface. If the logical unit has more than one IP address, the primary IP address
is used by default as the source address when packet transfer originates from the interface
and the destination address does not indicate the subnet.

Primary

Select this check box to specify that the IPv4 address is the preferred address for the logical
interface. If you configure more than one IP address on the same subnet, the preferred source
address is chosen by default as the source address when you initiate frame transfers to
destinations on the subnet

Preferred

Table 105: Add – Address (IPv6) Settings

GuidelineSetting

Enter an IPv6 address for the logical interface.IP Address

Enter the subnet for the IPv6 address.

Range: 0 through 128

Subnet

Select this check box to specify that the IPv6 address is the primary address of the protocol
on the logical interface. If the logical unit has more than one IP address, the primary IP address
is used by default as the source address when packet transfer originates from the interface
and the destination address does not indicate the subnet.

Primary

Select this check box to specify that the IPv6 address is the preferred address for the logical
interface. If you configure more than one IP address on the same subnet, the preferred source
address is chosen by default as the source address when you initiate frame transfers to
destinations on the subnet

Preferred
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Modifying the Syslog Configuration for Security Devices

You can use the Syslog section on the Modify Configuration page to view and modify the parameters
related to system logging on the device.

NOTE: Refer to the Junos OS documentation (available at http://www.juniper.net/
documentation/en_US/release-independent/junos/information-products/pathway-pages/junos/
product/) for a particular release and device. There you can find detailed information on the
configuration parameters for that device.

To modify the system log parameters:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices whose configuration you want to modify.

3. From the More or right-click menu, select Configuration >Modify Configuration.

The Modify Configuration page appears.

4. Click the Syslog link in the left-navigation menu.

The Syslog section on the Modify Configuration page is displayed.

5. Modify the configuration according to the guidelines provided in Table 106 on page 261.

6. After modifying the configuration, you can cancel the changes, save the changes, preview the changes,
or save the changes and deploy the configuration on the device. See “Modifying the Configuration of
Security Devices” on page 234.

Table 106: Syslog Settings

GuidelineSetting

General Settings
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Table 106: Syslog Settings (continued)

GuidelineSetting

Specify whether the time format should be included in system logmessages generated for the device.
By default, the timestamp specifies the month, day, hour, minute, and second at which the message
was logged.

If you select Enable, you can specify whether the milliseconds are included in the timestamp, the
year is included in the timestamp, or both themilliseconds and the year are included in the timestamp.

Time Format

Specify the IPv4 or IPv6 address to be used as the source address that is included in system log
messages.

Source
Address

Configure the time interval (in minutes) at which Junos Space checks for the system log file size.
When the log file size exceeds the previously specified size limit, the log file is archived and a new
log file is created. The range is 1 through 59 and the default is 15 minutes.

Log Rotation
Frequency

Select this check box if you do not want to suppress syslog messages that were logged earlier. This
check box is cleared by default.

Allow
Duplicates

Host Configuration

The existing host configuration entries are displayed in a table. You can do the following:

• Create a host configuration:

1. Click the + icon to create a host configuration
The Create Host Configuration page appears.

2. Complete the configuration according to the guidelines provided in Table 107 on page 264.

3. Click OK.
The host is created and you are returned to the Modify Configuration page.

• Modify a host configuration—Select a host configuration and click the pencil icon to modify the
settings.

The Edit Host Configuration page appears, showing the same fields that are presented when you
create a host configuration. You can modify some of the fields on this page. Refer to
Table 107 on page 264 for an explanation of the fields.

After you have modified the host configuration, click OK.

The changes are saved and you are returned to the Modify Configuration page.

• Delete host configurations—Select one or more host configurations and click the X icon to delete
the host configurations.

TheWarning page appears. Click Yes to confirm the deletion. The selected host configurations are
deleted.

File Configuration
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Table 106: Syslog Settings (continued)

GuidelineSetting

The existing file configuration entries are displayed in a table. You can do the following:

• Create a file configuration:

1. Click the + icon to create a file configuration.
The Create File Configuration page appears.

2. Complete the configuration according to the guidelines provided in Table 108 on page 266.

3. Click OK.
The file is created and you are returned to the Modify Configuration page.

• Modify a file configuration—Select a file configuration and click the pencil icon to modify the
settings.

The Edit File Configuration page appears, showing the same fields that are presented when you
create a file configuration. You can modify some of the fields on this page. Refer to
Table 108 on page 266 for an explanation of the fields.

After you have modified the file configuration, click OK.

The changes are saved and you are returned to the Modify Configuration page.

• Delete file configurations—Select one or more file configurations and click the X icon to delete the
file configurations.

The Warning page appears. Click Yes to confirm the deletion. The selected file configurations are
deleted.

User Configuration
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Table 106: Syslog Settings (continued)

GuidelineSetting

The existing user configuration entries are displayed in a table. You can do the following:

• Create a user configuration:

1. Click the + icon to create a user configuration
The Create User Configuration page appears.

2. Complete the configuration according to the guidelines provided in Table 109 on page 267.

3. Click OK.
The user configuration is created and you are returned to the Modify Configuration page.

• Modify a user configuration—Select a user configuration and click the pencil icon to modify the
settings.

The Edit User Configuration page appears, showing the same fields that are presented when you
create a file configuration. You can modify some of the fields on this page. Refer to
Table 109 on page 267 for an explanation of the fields.

After you have modified the user configuration, click OK.

The changes are saved and you are returned to the Modify Configuration page.

• Delete user configurations—Select one or more user configurations and click the X icon to delete
the user configurations.

TheWarning page appears. Click Yes to confirm the deletion. The selected user configurations are
deleted.

Table 107: Create Host Configuration Settings

GuidelineSetting

Select the name of the host to be notified when the system log matches the condition specified.Name

Enter a regular expression up to a maximum of 255 characters that must appear or must not appear in a message for
the messages to be logged to a host.

Match

Contents
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Table 107: Create Host Configuration Settings (continued)

GuidelineSetting

The table displays the existing facility and severity configured for system log messages. You can perform the following
actions:

• Click the + icon to configure the facility and severity levels of messages to be logged in the remote destination.

The Create Contents page appears.

Complete the configuration according to the guidelines provided in Table 110 on page 268 and click OK.

The system logmessage's facility and severity levels are created and you are returned to the Create Host Configuration
page.

• Select an entry and click the pencil icon to modify the facility and severity levels of messages to be logged in the
remote destination.

The Edit Contents page appears showing the same fields that are presented when you configure the facility and
severity levels of messages to be logged in the remote destination. Refer to Table 110 on page 268 for an explanation
of the fields.

After you have modified the system log message's facility and severity levels that are associated with the host, click
OK.

The changes are saved and you are returned to the Create Host Configuration page.

• Select one or more configured facility and severity levels, and click the X icon to delete the entries.

The Warning page appears. Click Yes to confirm the deletion. The selected facility and severity levels are deleted.

Advanced Options

Select this check box if you want to allow repeated messages in the system log output. By default, this check box is
cleared, which means that repeated messages are not logged in the output.

Allow
Duplicates

Select this check box to include the priority, which is a combination of the facility and severity, in syslog messages.Explicit
Priority

Specify an alternative facility thatwill replace the default facility usedwhenmessages are directed to a remote destination.
For more information, see the
http://www.juniper.net/documentation/en_US/junos/topics/reference/general/syslog-facilities-remote-logging.html
topic.

Facility
Override

Specify the prefix to be used for all syslog messages for the specified host.Log Prefix

Specify the IPv4 or IPv6 address to be used as the source address that is included in system log messages for the host.Source
Address

Specify the port number for the remote syslog folder.

The range is 0 through 65,535 and the default is 514.

Port
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Table 107: Create Host Configuration Settings (continued)

GuidelineSetting

Select this check box to log messages to a file in structured-data format instead of the standard Junos OS format. The
structured-data format complies with IETF RFC 5424. By default, this check box is selected.

Select the Brief check box to suppress the English language text that appears by default at the end of a message to
describe the error or event. By default this check box is cleared.

Structured
Data

Table 108: Create File Configuration Settings

GuidelineSetting

Enter the name of the file in which the data should be logged. The filenamemust not contain spaces,
and it can contain some special characters ($ ^ < > @ # ! * - = _ .).

Name

Enter a regular expression up to a maximum of 255 characters that must appear or must not appear
in a message for the messages to be logged to a file.

Match

Contents

The table displays the existing facility and severity configured for system log messages. You can
perform the following actions:

• Click the + icon to configure the facility and severity levels of messages to be logged in the remote
destination.

The Create Contents page appears.

Complete the configuration according to the guidelines provided in Table 110 on page 268 and
click OK.

The system log message's facility and severity levels are created and you are returned to the
Create File Configuration page.

• Select an entry and click the pencil icon to modify the facility and severity levels of messages to
be logged in the remote destination.

The Edit Contents page appears showing the same fields that are presented when you configure
the facility and severity levels of messages to be logged in the remote destination. Refer to
Table 110 on page 268 for an explanation of the fields.

After you have modified the system log message's facility and severity levels that are associated
with the file, click OK.

The changes are saved and you are returned to the Create File Configuration page.

• Select one or more configured facility and severity levels, and click the X icon to delete the entries.

The Warning page appears. Click Yes to confirm the deletion. The selected facility and severity
levels are deleted.

Advanced Options
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Table 108: Create File Configuration Settings (continued)

GuidelineSetting

Select this check box to include the priority, which is a combination of the facility and severity, in
syslog messages.

Explicit Priority

Select this check box to log messages to a file in structured-data format instead of the standard
Junos OS format. The structured-data format complies with IETF RFC 5424. By default, this check
box is selected.

Select the Brief check box to suppress the English language text that appears by default at the end
of a message to describe the error or event. By default this check box is cleared.

Structured
Data

Table 109: Create User Configuration Settings

GuidelineSetting

Enter the Junos OS username of the user whose terminal session is to receive system log messages.
The username must not contain spaces, and it can contain some special characters (_ .).

Name

Enter a regular expression up to a maximum of 255 characters that must appear or must not appear
in a message for the messages to be logged to a user terminal.

Match

Contents
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Table 109: Create User Configuration Settings (continued)

GuidelineSetting

The table displays the existing facility and severity configured for system log messages. You can
perform the following actions:

• Click the + icon to configure the facility and severity levels of messages to be logged in the remote
destination.

The Create Contents page appears.

Complete the configuration according to the guidelines provided in Table 110 on page 268 and
click OK.

The system logmessage's facility and severity levels are created and you are returned to the Create
User Configuration page.

• Select an entry and click the pencil icon to modify the facility and severity levels of messages to
be logged in the remote destination.

The Edit Contents page appears showing the same fields that are presented when you configure
the facility and severity levels of messages to be logged in the remote destination. Refer to
Table 110 on page 268 for an explanation of the fields.

After you have modified the system log message's facility and severity levels that are associated
with the user, click OK.

The changes are saved and you are returned to the Create User Configuration page.

• Select one or more configured facility and severity levels, and click the X icon to delete the entries.

The Warning page appears. Click Yes to confirm the deletion. The selected facility and severity
levels are deleted.

Advanced Options

Select this check box if you want to allow repeated messages in the system log output. By default,
this check box is cleared, which means that repeated messages are not logged in the output.

Allow
Duplicates

Table 110: Create Contents Settings

GuidelineSetting

Select the facility to which the system log message belongs. Each system log message belongs to
a facility, which categorizes messages based on the source by which they are generated, such as
a software process, or that relate to a similar condition or activity, such as authentication attempts.

Facility

Select the severity level for the system logmessage. Each systemmessage is pre-assigned a severity
level, which indicates how seriously the triggering event affects routing platform functions.When
you configure logging for a facility and destination, you specify a severity level for each facility.

Severity

After you’ve configured the Syslogs on the SRX Series devices, Security Director can receive those logs.

268



For adding Log Collector as a special node using Security Director Log Collector, click here.

For adding Log Collector as a special node using JSA Log Collector, click here.
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Modifying the Security Logging Configuration for Security Devices

You can use the Security Logging section on the Modify Configuration page to view and modify the
parameters related to security logging on the device.

NOTE: Refer to the Junos OS documentation (available at http://www.juniper.net/
documentation/en_US/release-independent/junos/information-products/pathway-pages/junos/
product/) for a particular release and device. There you can find detailed information on the
configuration parameters for that device.

To modify the security logging parameters:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices whose configuration you want to modify.

3. From the More or right-click menu, select Configuration >Modify Configuration.

The Modify Configuration page appears.

4. Click the Security Logging link in the left-navigation menu.

The Security Logging section on the Modify Configuration page is displayed.
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5. Modify the configuration according to the guidelines provided in Table 111 on page 270.

6. After modifying the configuration, you can cancel the changes, save the changes, preview the changes,
or save the changes and deploy the configuration on the device. See “Modifying the Configuration of
Security Devices” on page 234.

Table 111: Security Logging Settings

GuidelineSetting

General Settings

Select how security logs are processed and exported:

• Stream—Specify that security logs are processed directly in the forwarding plane.

• Event—Specify that security logs are processed directly in the control plane.

Mode

Select the source type as Address or Interface.Source Type

If the Source Type is Address, specify the IPv4 or IPv6 address to be used as the source address
when exporting security logs.

If the Source Type is Interface, specify the interface to be used as the source interface when
exporting security logs.

Source
Address/Source
Interface

Specify the security log format for the device:

• Syslog—Unstructured Junos OS system logs.

• Sd-syslog—Structured Junos OS system logs.

• Binary—Non-ASCII (binary) Junos OS system logs.

Format

Select this check box to disable security logging for the device. This check box is cleared by
default.

Disable Logging

Select this check box to include the UTC timestamp in the security logs. This check box is cleared
by default.

UTC Timestamp

For the event mode, specify the rate (in logs per second) at which event logs are processed by
the control plane.

Range: 1 through 1500.

Event Rate

Stream
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Table 111: Security Logging Settings (continued)

GuidelineSetting

The existing stream configuration entries are displayed in a table. You can do the following:

• Create a stream configuration–Click the + icon to create a stream configuration.

The Create Stream Configuration page appears. Complete the configuration according to the
guidelines provided in Table 112 on page 272 and click OK.

The stream configuration is created and you are returned to the Security Logging page.

• Modify a stream configuration–Select a stream configuration and click the pencil icon

The Edit Stream configuration page appears, showing the same fields that are presentedwhen
you create a stream configuration. You can modify some of the fields on this page. Refer to
Table 112 on page 272 for an explanation of the fields.

After you have modified the stream configuration, click OK. The changes are saved and you
are returned to the Security Logging page.

• Delete stream configurations–Select one or more stream configurations and click the X icon
to delete the stream configurations.

The Warning page appears. Click Yes to confirm the deletion. The selected stream
configurations are deleted.

File

Specify the filename for the binary log file.File Name

Specify the file path for the binary log file.File Path

Specify the maximum size (in MB) of the binary log file.

Range: 1 through 10.

File Size

Specify the maximum number of binary log files.

Range: 2 through 10.

Maximum No. of
Files

Cache

Specify the maximum number of security log entries to keep in memory. The range is 1 through
4,294,967,295 and the default is 1000.

Limit
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Table 111: Security Logging Settings (continued)

GuidelineSetting

The existing exclude configuration entries are displayed in a table. An exclude configuration is
a list of auditable events that can be excluded from the audit log. You can do the following:

• Create an exclude configuration–Click the + icon to create an exclude configuration.

The Create Exclude Configuration page appears. Complete the configuration according to the
guidelines provided in Table 113 on page 273 and click OK.

The exclude configuration is created and you are returned to the Security Logging page.

• Modify an exclude configuration–Select an exclude configuration and click the pencil icon.

The Edit Exclude Configuration page appears, showing the same fields that are presented
when you create an exclude configuration. You can modify some of the fields on this page.
Refer to Table 113 on page 273 for an explanation of the fields.

After you have modified the exclude configuration, click OK.

The changes are saved and you are returned to the Security Logging page.

• Delete exclude configurations–Select one or more exclude configurations and click the X icon
to delete the exclude configurations.

The Warning page appears. Click Yes to confirm the deletion. The selected exclude
configurations are deleted.

Exclude

Table 112: Create Stream Configuration Settings

GuidelineSetting

Enter the name of the security log stream, which should be a string containing alphanumeric
characters and some special characters (_ .).

Name

Specify the IPv4 or IPv6 address of the server to which the security logs will be streamed.Host

Enter the port number for the system log listening port.

The range is 0 through 65,535 and the default is 514.

Port

Select the severity threshold for security logs.

Only the logs with the specified severity threshold are logged.

Severity

Select the category of events to be logged.Category
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Table 112: Create Stream Configuration Settings (continued)

GuidelineSetting

Specify the format of the security log for the device:

• Syslog–Unstructured Junos OS system logs.

• Sd-syslog–Structured Junos OS system logs.

• welf–Web Trends Extended Log Format.

Format

Table 113: Create Exclude Configuration Settings

GuidelineSetting

Specify the name of the exclude configuration.Name

Destination Filters

Specify the destination IPv4 or IPv6 address from which security alarms are not included
in the audit log.

IP Address

Specify the destination port number from which security alarms are not included in the
audit log.

The range is 0 through 4,294,967,295.

Port

Source Filters

Specify the source IPv4 or IPv6 address from which security alarms are not included in
the audit log.

IP Address

Specify the source port number from which security alarms are not included in the audit
log.

The range is 0 through 4,294,967,295.

Port

Other Filters

Enter the event ID of the security event.

The audit log does not include security alarms for the specified event ID.

Event ID

Select this check box to restrict the logging only to failed events. By default, this check
box is cleared, which means failed and successful events are logged.

Failure

Enter the name of the interface fromwhich security alarms are not included in the security
log.

Interface
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Table 113: Create Exclude Configuration Settings (continued)

GuidelineSetting

Enter the name of the security policy for which security alarms are not included in the
security log.

Policy Name

Enter the name of the process (that is generating the events) for which security alarms
are not included in the security log.

Process

Enter the name of the protocol for which security alarms are not included in the security
log.

Protocol

Select this check box to restrict the logging only to successful events. By default, this check
box is cleared, which means failed and successful events are logged.

Success

Enter the username of the authenticated user for which security alarms that are enabled
by the user are not included in the security log.

Username

After you’ve configured the security logs on the SRX Series devices, Security Director can receive those
logs.

For adding Log Collector as a special node using Security Director Log Collector, click here.

For adding Log Collector as a special node using JSA Log Collector, click here.
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Modifying the Link Aggregation for Security Devices

You can combine multiple Ethernet interfaces to form a single link layer interface, known as a Link
Aggregation Group (LAG). This page enables you to create, edit, and delete LAG configuration profiles and
also includes Global Settings, AE Interface, Logical Interface, Admin Status, Link status, VLAN Tagging,
and so on.

NOTE: Refer to the Junos OS documentation (available at http://www.juniper.net/
documentation/en_US/release-independent/junos/information-products/pathway-pages/junos/
product/) for a particular release and device. There you can find detailed information on the
configuration parameters for that device.

To modify Link Aggregation profile:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select a device to modify the configuration.

3. From the More or right-click menu, select Configuration >Modify Configuration.

The Modify Configuration page appears.

4. Click the Link Aggregation link in the left-navigation menu.

The Link Aggregation page is displayed. The existing Link Aggregation profiles if any are displayed in
the table.

See Table 114 on page 275 for the list of actions that you can perform in this page.

5. After modifying the configuration, you can cancel the changes, save the changes, preview the changes,
or save the changes and deploy the configuration on the device. See “Modifying the Configuration of
Security Devices” on page 234.

Table 114: Link Aggregation Actions

ActionField

Click to add a Global Settings to a Link Aggregation profile.

The Global Settings page appears. Complete the configuration according to the
guidelines provided in Table 115 on page 276 and click OK.

Global Settings
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Table 114: Link Aggregation Actions (continued)

ActionField

Click to add a logical interface for the security devices. You can add an Aggregated
Ethernet (AE) interface followed by a logical interface to a device.

The Add Logical Interface page appears. Complete the configuration according to the
guidelines provided in Table 116 on page 276 and click OK.

Add Logical Interface

Click to enable or disable an existing Link Aggregation profile.Enable/Disable

Click + to add an AE Interface. The Add AE Interface page appears.

Complete the configuration according to the guidelines provided in
Table 117 on page 277 and click OK.

Create an Aggregated
Ethernet (AE) Interface

Select a Link Aggregation profile and click the pencil icon.

The Modify AE Interface page appears, which shows the same fields as create a SSL
Initiation Profile. You can modify some of the fields on this page. See
Table 117 on page 277 for more details on the fields. Click OK to save the changes.

Modify an AE Interface

Select one or more interfaces that you want to delete, and click the bin icon to delete
the profiles.

The Warning page appears. Click Yes to confirm the deletion.

Delete an AE Interface

Select to show or hide various parameters in the grid.Show Hide Columns

Table 115: Global Settings Action

GuidelineField

Enter the device count. This is the number of Aggregated Ethernet devices.

NOTE: The range is 1 through 128.

Device Count

Table 116: Logical Interface Settings

GuidlineField

General

Displays the AE Interface name that you have selected from the table.AE Interface Name
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Table 116: Logical Interface Settings (continued)

GuidlineField

Enter a valid logical interface. The range is 0 to 65535.

NOTE: By default, the value will be 0, unless VLAN tagging is enabled. You
must enable VLAN tagging if you want to enter a value greater than zero.

Logical Interface Unit

Enter a valid description for logical interface. The maximum limit being 255
characters.

Description

Enter the VLAN ID. The range is 0 to 4094.

NOTE: If the VLAN tagging is enabled, then the VLAN ID is mandatory.

VLAN ID

IPV4 Address

Select + to add an IPV4 address for the logical interface.Add an IPV4 Address

Enter a valid IPV4 address.IPV4 Address

Enter a valid subnet mask for IPV4 address.Subnet Mask

IPV6 Address

Select + to add an IPV6 address for logical interface.Add an IPV6 Address

Enter a valid IPV6 address.IPV6 Address

Enter a valid subnet mask for IPV6 address.Subnet Mask

Table 117: AE Interface Settings

GuidelinesField

Global Settings

Enter the name of the aggregated interface. If an aggregated interface already exists,
then the field is displayed as read-only.

AE Name

Select the interface available for aggregation and move to Selected column using right
arrow.

NOTE: Only interfaces that are configuredwith the same speed can be selected together
for a LAG.

Interfaces
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Table 117: AE Interface Settings (continued)

GuidelinesField

Advanced Settings

Specifies global Link Aggregation Control Protocol configuration.LACP Configuration

Select the mode in which Link Aggregation Control Protocol packets are exchanged
between the interfaces. The modes are:

• Active—Indicates that the interface initiates transmission of LACP packets

• Passive—Indicates that the interface only responds to LACP packets.

LACP Mode

Select transmission rates of link aggregation control PDUs. The options are:

• Fast—Transmits link aggregation control PDUs every second.

• Slow—Transmits link aggregation control PDUs every 30 seconds.

Periodic

Select the priority level that you associate with the LAG. Select the priority level that
you want to associate with the LAG by clicking the arrow button.

The range is 0 to 65535.

System Priority

Enable the option to protect the link. You can configure only two member links for an
aggregated Ethernet interface, that is, one active and one standby.

Link Protection

Select an option. It specifies not to switch links when higher priority link is available.Non Revertive

Enter a description of the LAG.Description

Select to enable VLAN tagging for a LAG.VLAN Tagging
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Modifying the User Management Configuration for Security Devices

You can use the User Management section on the Modify Configuration page to modify the user details,
authentication methods, password settings, access profile, and so on.

NOTE: Refer to the Junos OS documentation (available at https://www.juniper.net/
documentation/en_US/release-independent/junos/information-products/pathway-pages/junos/
product/) for a particular release and device. There you can find detailed information on the
configuration parameters for that device.

To modify the basic configuration:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices to modify configuration.

3. From the More or right-click menu, select Configuration > Modify Configuration.

The Modify Configuration page appears with the Basic Setup section selected by default.

4. Click User Management in the left-navigation menu.

The User Management section on the Modify Configuration page is displayed.

5. Modify the configuration according to the guidelines provided in Table 118 on page 280.

6. After modifying the configuration, you can cancel the changes, save the changes, preview the changes,
or save the changes and deploy the configuration on the device. See “Modifying the Configuration of
Security Devices” on page 234.
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Table 118: User Management

GuidelineSetting

Provides the users details to the device’s local database. Existing users are displayed
in a table with their username, full name, login type, and user type.

To add a user:

1. Click + icon.

The Add User page is displayed.

2. Enter the details as follows:

• User Type—

• Select Root to add the user to the root device.

• Select LSYS to add the user to the logical systems device.

• Select TSYS to add the user to the tenant systems device.

• LSYS/TSYS—Select a logical system/tenant system device to which the user will
have access.

NOTE: This field is displayed only if you have selected user type as LSYS/TSYS.

• Username—Enter the username of the user (up to 64 characters) on the device.
Do not include spaces, colons, or commas in the username.

• User ID—Enter a user ID, which is a numeric identifier that is associated with the
username.

If you do not assign a user ID to a username, the system automatically assigns
one when the configuration is pushed to the device.

Range: 100 through 64,000

• Full Name—Enter the full name of the user on the device; all alphanumeric
characters are allowed except colon (:).

• Password—Enter a password that is a minimum of six characters long and that
must contain at least one uppercase letter, one lowercase letter, one number,
and one special character.

• Confirm password—Re-enter the login password for the user.

• Login Type—Select the login type of the user, which defines the access privileges
for a user. The following login types are available:

• Super-user—All permissions

• Operator—Clear, network, reset, trace, and view permissions

• Read-only—View permissions

• Unauthorized—No permissions

User Details
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Table 118: User Management (continued)

GuidelineSetting

3. Click OK.

If the fields entered are valid, a user is created and a confirmation message is
displayed at the top of the Modify Configuration page.

To edit the information of a user, select it and click pencil icon. Then edit the user
details in the Edit User dialog box and click OK.

To delete an existing user, select it and click delete icon.

Specifies the authentication method the device should use to authenticate users.

To add the authentication order:

1. Click the + icon.

The Add Authentication Order page is displayed.

2. Select the authentication order.

3. Click OK.

Authentication Methods

Select the checkbox to specify the details of RADIUS servers.

To configure RADIUS Servers:

1. Click the + icon.

The Add RADIUS server page is displayed.

2. Enter the following details:

• IP Address—Enter the 32–bit IP address of the server.

• Password—Enter the password for the server.

• Confirm Password—Re-enter the password for the server

• Server Port—Enter an appropriate port.

• Source IP Address—Enter the source IP address of the server.

• Retry Attempts—Specify the number of times that the server should try to verify
the user’s credentials.

3. Click OK.

Select a radius server and click pencil icon to edit the radius server. Click delete to
delete the radius server.

RADIUS Servers
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Table 118: User Management (continued)

GuidelineSetting

Select the checkbox to provide the details of TACACS+ server.

To configure a TACACS+ server:

1. Click the + icon.

The Add TACACS+ server page is displayed.

2. Enter the following details:

• IP Address—Enter the 32–bit IP address of the server.

• Password—Enter the password for the server.

• Confirm Password—Re-enter the secret password for the server.

• Server Port—Enter an appropriate port.

The port range is from 1 through 65535. The default value is 1812.

• Source IP Address—Enter the source IP address of the server.

• Timeout—Specify the amount of time (in seconds) the device should wait for a
response from the server.

Timeout period range is from 1 to 90 seconds. The default value is 3 seconds.

3. Click OK.

Select an IP address and click the pencil icon to edit the server details and click delete
to delete the server details.

TACACS+ Servers

Password Settings

Select the minimum number of old passwords that must not be same as the new
password.

The range is from 1 through 20.

Minimum Reuse

Select the maximum password length.

The range is from 20 through 128.

Maximum Length

Select the minimum password length.

The range is from 6 through 20.

Minimum Length

Access Profile
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Table 118: User Management (continued)

GuidelineSetting

You can configure the Lightweight Directory Access Protocol (LDAP) for SRX Series
devices.

To create an access profile:

1. Click the + icon.

The Add Access Profile page is displayed.

2. Configure the parameters according to the guidelines in Table 119 on page 284.

3. Click OK.

Create an access profile

To add an address pool:

1. Click the + icon.

The Add Address Pool page is displayed.

2. Enter the IPv4 address pool name.

3. Click OK.

Address pool

FW Authentication - Pass Through Settings

Select the profile that the policies can use to authenticate users.Default Profile

FTP Banners

Enter the login prompt for users logging in using FTP.Login

Enter a successful login prompt for users logging in using FTP.Success

Enter a failed login prompt for users logging in using FTP.Fail

Telnet Banners

Enter the login prompt for users logging in using Telnet.Login

Enter a successful login prompt for users logging in using Telnet.Success

Enter a failed login prompt for users logging in using Telnet.Fail
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Table 118: User Management (continued)

GuidelineSetting

HTTP Banners

Enter the login prompt for users logging in using HTTP.Login

Enter a successful login prompt for users logging in using HTTP.Success

Enter a failed login prompt for users logging in using HTTP.Fail

FW Authentication - Web Authentication Settings

Select the profile that the policies can use to authenticate users.Default Profile

Enter a message that will be displayed on a successful login for users logging in using
Web authentication.

Success

Table 119: Access Profile

DescriptionSetting

General Settings

Enter a unique string of alphanumeric characters, colons, periods, dashes, and
underscores. Maximum length is 64 characters.

Access Profile Name

Authentication Order
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Table 119: Access Profile (continued)

DescriptionSetting

Configure the order in which the user tries different authentication methods during
login. For each login attempt, the method for authentication starts with the first one,
until the password matches.

Select the following authentication methods:

• NONE—No authentication for the specified user.

• LDAP—The SRX Series device uses this protocol to get user and group information
necessary to implement the integrated user firewall feature.

• Password—Use a locally configured password in the access profile.

• Radius—Use RADIUS authentication services.

If RADIUS servers fails to respond or return a reject response, try password
authentication, because it is explicitly configured in the authentication order.

• Secure ID—Configure the RSA SecurID authentication.

Users can enter either static or dynamic passwords as their credentials. A dynamic
password is a combination of a user’s PIN and a randomly generated token that is
valid for a short period of time (approximately one minute). A static password is
configured for the user on the SecurID server. For example, the SecurID server
administrator might set a temporary static password for a user who has lost SecurID
token.

Order 1

Configure the next authentication method if the authentication method included in
the authentication Order 1 is not available, or if the authentication is available but
returns a reject response.

Select the authentication method from the list and click Next.

Order 2

Authentication Type
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Table 119: Access Profile (continued)

DescriptionSetting

To add entity requesting access.

1. Click the + icon.

The Add Entity Requesting Access page is displayed.

2. Enter the following details:

• User Name—Enter the user name.

• Password—Enter the password.

• Confirm Password—Re-enter the password.

• XAUTH IPAddress—Enter the IPv4 address of the external authentication server
to verify the authentication user account.

• Groups—Enter the group name to store several user accounts together on the
external authentication servers.

• Address Assignment—Select the address pool.

3. Click OK.

You can select the username and edit or delete it.

Entity Requesting Access

Configure the LDAP server for authentication.

To add the LDAP server:

1. Click the + icon.

The Add LDAP Server page is displayed.

2. Enter the following details:

• Address—Enter the IPv4 address or hostname of the LDAP authentication server.

• Port—Select the port number on which to contact the LDAP server. Range is
from 1 to 65535.

• Retry—Select the number of retries that a device can attempt to contact an
LDAP server. Range is from 1 to 10 seconds.

• Routing Instance—Enter the routing instance used to send LDAP packets to
the LDAP server.

• Source Address—Enter a source IP address for each configured LDAP server.

• Timeout—Select the amount of time that the local device waits to receive a
response from an LDAP server. The range is from 3 to 90 seconds.

3. Click OK.

LDAP Server

286



Table 119: Access Profile (continued)

DescriptionSetting

LDAP Options

Enter the base distinguished name that defines the user.Base Distinguished Name

Select the amount of time that elapses before the primary server is contacted if a
backup server is being used.

The range is from 60 to 4294967295.

Revert Interval

Additional Details

Select the checkbox to assemble user’s LDAP distinguished name (DN) using a common
name identifier, username, and base distinguished name.

Assemble

Enter the common name identifier used as a prefix for the username during the assembly
of the users distinguished name.

Common Name

Select the checkbox to enable the search option.Search

Enter the name of the filter to find the user’s LDAP distinguished name.Search Filter

Select the checkbox to perform an LDAP administrator search. By default, the search
is an anonymous search.

Admin Search

Enter the distinguished name of an administrative user. The distinguished name is used
for performing the LDAP search.

Distinguished Name

Configure the plain-text password for the administrative user.Password
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Modifying the Screens Configuration for Security Devices

You can use the Screens section on the Modify Configuration page to modify the security screen
configuration for a device. You can modify settings related to screen name, denial of service, anomalies,
and reconnaissance.

NOTE: Refer to the Junos OS documentation (available at http://www.juniper.net/
documentation/en_US/release-independent/junos/information-products/pathway-pages/junos/
product/) for a particular release and device. There you can find detailed information on the
configuration parameters for that device.

To modify the screens parameters:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices whose configuration you want to modify.

3. From the More or right-click menu, select Configuration >Modify Configuration.

The Modify Configuration page appears.

4. Click the Screens.

The Screens page appears.

5. For the SRX Series devices, modify the configuration according to the guidelines provided in
Table 120 on page 288.

Starting Junos Space Security Director Release 16.2, you can configure screens for MX Series routers.
For the MX Series routers, modify the configuration according to the guidelines provided in
Table 121 on page 294.

6. After modifying the configuration, you can cancel the changes, save the changes, preview the changes,
or save the changes and deploy the configuration on the device. See “Modifying the Configuration of
Security Devices” on page 234.

Table 120: Screens for SRX Series Devices

GuidelineSetting

Modify the name of the screen.Name

Modify the description of the screen.Description
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Table 120: Screens for SRX Series Devices (continued)

GuidelineSetting

Select this check box to generate an alarm when detecting an attack but not to block the
attack.

Generate alarms
without dropping
packets

Denial of Service

Select this option to prevent land attacks, where an attacker sends spoofed IP packets with
headers containing the target’s IP address for the source and destination IP address.

Combining the SYN flood defense with IP spoofing protection prevents land attacks

Land attack
protection

Select this option to prevent a teardrop attack, which exploits the reassembly of fragmented
IP packets. The device drops any packets that have such a discrepancy.

Teardrop attack
protection

Select this option to block any ICMP packet that has the More Fragments flag set or that has
an offset value.

Because ICMP packets contain very short messages, there is no legitimate reason for ICMP
packets to be fragmented. If an ICMP packet is so large that it must be fragmented, something
is amiss.

ICMP fragment
protection

Select this option to prevent a ping-of-death attack, which occurs when sending IP packets
exceeding the maximum allowed size (65,535 bytes).

Although the TCP/IP specification requires a specific packet size, many ping implementations
allow larger packet sizes. Larger packets can trigger a range of adverse system reactions,
including crashing, freezing, and restarting.

Ping of death attack
protection

Select this option to drop ICMP packets with a length greater than 1024 bytes.Large size ICMP
packet protection

Select this option to deny IP fragments on a security zone and to block all IP packet fragments
that are received at interfaces bound to that zone.

Block fragment traffic

Select this option to prevent a SYN-ACK-ACK attack, which occurs when the attacker
establishes multiple telnet sessions without allowing each session to terminate.

After the number of connections from the same IP address reaches the SYN-ACK-ACK proxy
threshold, the device rejects further connection requests from that IP address.

SYN-ACK-ACKproxy
protection
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Table 120: Screens for SRX Series Devices (continued)

GuidelineSetting

Select this option to detect attacks in Windows NetBIOS communications.

Each WinNuke attack triggers an attack log entry in the event alarm log. WinNuke is a DoS
attack targeting any computer on the Internet running Windows.

WinNuke attack
protection

Anomalies

Select this option to detect and drop any packet with an incorrectly formatted IP option in
the IP packet header (IPv4 or IPv6). The device records the event in the screen counters list
for the ingress interface.

Bad option

Select this option to detect packets where the optional header field is IP option 2 (security),
and the event is recorded in the screen counters list for the ingress interface.

Security

Select this option to discard all received IP frames with protocol numbers greater than 137
for IPv4 and 139 for IPv6. These protocol numbers are undefined or reserved.

Unknown protocol

Select this option to detect packets where the optional header field is IP option 9 (strict source
routing), and the event is recorded in the screen counters list for the ingress interface.

This option specifies the complete route list for a packet to take on its journey from source
to destination. The last address in the list replaces the address in the destination field.

Strict source route

Select this option either to block any packets set with loose or strict source route options or
to detect such packets and then record the event in the counters list for the ingress interface.

Source routing allows users at the source of an IP packet transmission to specify the IP
addresses of the devices that they want an IP packet to take on its way to its destination.

Source route

Select this option to detect packets where the optional header field is IP option 4 (Internet
timestamp), and the event is recorded in the screen counters list for the ingress interface.
This option records the time (in Universal Time) when each network device receives the packet
during its trip from the point of origin to its destination.

Timestamp

Select this option to detect packets where the optional header field is IP option 8 (stream ID),
and the event is recorded in the screen counters list for the ingress interface.

This option provides a way for the 16-bit SATNET stream identifier to be carried through
networks that do not support streams.

Stream
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Table 120: Screens for SRX Series Devices (continued)

GuidelineSetting

Select this option to detect packets where the optional header field is IP option 3 (loose source
routing), and the event is recorded in the screen counters list for the ingress interface.

This option specifies a partial route list for a packet to take on its journey from source to
destination.

Loose source route

Select this option to detect packets where the optional header field is IP option 7 (record
route), and the event is recorded in the screen counters list for the ingress interface.

This option records the IP addresses of the network devices along the path that the IP packet
travels

Record route

Select this option to detect packets where the optional IP header field indicates that the
packet has been fragmented and the SYN flag is set in the TCP header.

A fragmented SYN packet is anomalous, and, as such, it is suspect. To be cautious, block such
unknown elements from entering your protected network.

SYN fragment
protection

Select this option to detect an illegal combination of flags that attackers can use to consume
sessions on the target device.

Both the SYN and FIN control flags are not normally set in the same TCP segment header.
The SYN flag synchronizes sequence numbers to initiate a TCP connection. The FIN flag
indicates the end of data transmission to finish a TCP connection. Their purposes aremutually
exclusive. A TCP header with the SYN and FIN flags set is anomalous TCP behavior, causing
various responses from the recipient, depending on the OS.

SYN and FIN flags set
protection

Select this option to detect an illegal combination of flags and to reject packets that have this
combination.

Because a TCP header with the FIN flag set but not the ACK flag is anomalous TCP behavior,
there is no uniform response to this. The OS might respond by sending a TCP segment with
the RST flag set.

Fin flag without ACK
flag set protection

Flood Defense
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Table 120: Screens for SRX Series Devices (continued)

GuidelineSetting

Set the number of concurrent sessions that can be initiated from a source IP address.

When you set a source-based session limit, it can:

• Stem an attack such as the Nimda virus (which is actually both a virus and a worm) that
infects a server and then begins generating massive amounts of traffic from that server.
Because all the virus-generated traffic originates from the same IP address, a source-based
session limit ensures that the firewall can control such excessive amounts of traffic.

• Mitigate attempts to fill up the firewall's session table if all the connection attempts originate
from the same source IP address.

Limit sessions from
the same source

Set the number of concurrent sessions that can be directed to a single destination IP address.
This ensures that the device allows only an acceptable number of concurrent connection
requests–no matter what the source–to reach any one host.

Limit sessions from
the same destination

Select this option to prevent an ICMP flood attack, where ICMP echo requests use all resources
in responding, such that valid network traffic can no longer be processed.

The threshold value defines the number of ICMP packets per second allowed to ping the
same destination address before the device rejects further ICMP packets.

ICMP flood
protection

Select this option to prevent a UDP flood attack, where an attacker sends IP packets containing
UDP datagrams to slow down resources, such that valid connections can no longer be handled.

The threshold value defines the number of UDP packets per second allowed to ping the same
destination IP address or port pair. When the number of packets exceeds this value within
any 1-second period, the device generates an alarm and drops subsequent packets for the
remainder of that second.

UDP flood protection

Select this option to prevent a SYN flood attack, where the connecting host continuously
sends TCP SYN requests without replying to the corresponding ACK responses.

When the number of SYN segments per second exceeds the set threshold, the device will
either start proxying incoming SYN segments by replyingwith SYN/ACK segments and storing
the incomplete connection requests in a connection queue, or it will drop the packets.

SYN flood protection

Set the number of SYN packets per second (pps) required to trigger a SYN proxy response.
The default value is 200 pps, and you can set the attack threshold from 1 to 500,000 pps.

Although you can set the threshold to any number, you need to know the normal traffic
patterns at your site to set an appropriate threshold for it. For example, if for an e-business
site that normally gets 20,000 SYN segments per second, youmight want to set the threshold
to 30,000 pps. If a smaller site normally gets 20 SYN segments per second, youmight consider
setting the threshold to 40 pps.

Attack Threshold
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Table 120: Screens for SRX Series Devices (continued)

GuidelineSetting

Set the number of proxied, half-completed TCP connection requests per second after which
the device enters an alarm in the event log.

The value you set for an alarm threshold triggers an alarm when the number of proxied,
half-completed connection requests to the same destination address per second exceeds that
value.

Alarm Threshold

Set the number of SYN segments that the device can receive per second from a single source
IP address before the device begins dropping connection requests from that source. The
default value is 4000 per second, and you can set the source threshold from 4 to 500,000
per second.

Tracking a SYN flood by source address uses different detection parameters from tracking a
SYN flood by destination address.When you set a SYN attack threshold and a source threshold,
you put both the basic SYN flood protection mechanism and the source-based SYN flood
tracking mechanism in effect.

Source Threshold

Set the number of SYN segments received per second for a single destination IP address
before the device begins dropping connection requests to that destination. The default value
is 4000 per second, and you can set the destination threshold from 4 to 1,000,000 per second.

If a protected host runs multiple services, you might want to set a threshold based on
destination IP address only—regardless of the destination port number.

DestinationThreshold

Set the maximum length of time before a half-completed connection is dropped from the
queue. The default value is 20 seconds, and you can set the timeout from 1 to 50 seconds.
When either a source or destination threshold is not configured, the systemwill use the default
threshold value.

You can decrease the timeout value until you see any connections dropped during normal
traffic conditions.

Timeout

Reconnaissance

Select this option to prevent an IP spoofing attack, where an invalid source address is inserted
in the packet header to make the packet appear to come from a trusted source.

The mechanism to detect IP spoofing relies on route table entries. When the device detects
the packet with a spoofed source IP address, it discards the packet.

IP spoofing
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Table 120: Screens for SRX Series Devices (continued)

GuidelineSetting

Select this option to prevent an IP sweep attack, where an attacker sends ICMP echo requests
(pings) to multiple destination addresses. If a target host replies, the reply reveals the target’s
IP address to the attacker. If the device receives 10 ICMP echo requests within the number
of microseconds specified in this statement, then it flags this as an IP sweep attack and rejects
the eleventh and all further ICMP packets from that host for the remainder of the second.

The threshold value defines the maximum number of microseconds during which up to 10
ICMP echo requests from the same host are allowed into the device.

IP sweep

Select this option to prevent a TCP sweep attack, where an attacker sends TCP SYN packets
to the target device as part of the TCP handshake. If the device responds to those packets,
then the attacker gets an indication that a port in the target device is open, which makes the
port vulnerable to attack. If a remote host sends TCP packets to 10 addresses in 0.005 seconds
(5000 microseconds), then the device flags this as a TCP sweep attack.

TCP sweep

Select this option to prevent a UDP sweep attack, where an attacker sends UDP packets to
the target device. If the device responds to those packets, then the attacker gets an indication
that a port in the target device is open, which makes the port vulnerable to attack. If a remote
host sends UDP packets to 10 addresses in 0.005 seconds (5000 microseconds), then the
device flags this as an UDP sweep attack.

UDP sweep

Select this option to prevent a port scan attack, where the available services are scanned in
the hopes that at least one port will respond, thus identifying a service to target.

A port scan occurswhen one source IP address sends IP packets containing TCP SYN segments
to 10 different destination ports within a defined interval. The default interval is 5000
microseconds.

Port scan

Table 121: Screens for MX Series Routers

GuidelineSetting

Modify the name of the screen.Name

Specify the direction in which the rule match is applied.

The following options are available:

• Input—Apply the rule match on the input side of the interface.

• Output—Apply the rule match on the output side of the interface.

• Input-Output—Apply the rule match bidirectionally.

Match
Direction
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Table 121: Screens for MX Series Routers (continued)

GuidelineSetting

Select a service set from the list that you have already created to define a collection of services to be
performed by an Adaptive Services interface (AS) or Multiservices line cards (MS-DPC, MS-MIC, and
MS-MPC).

Service Set

Rule Settings

• By Source—Enable this option to limit sessions based on numbers generated from the configured
source (IP or subnet) or application.

• Max Sessions Allowed—Enter themaximumnumber of open sessions per application or IP address.

• Max Packets Allowed—Enter themaximum peak packets per second per application or IP address.

• Rate Per Second—Enter themaximumnumber of sessions per second per application or IP address.

• ByDestination—Enable this option to limit sessions based on numbers generated from the configured
destination (IP or subnet) or application.

• Max Sessions Allowed—Enter themaximumnumber of open sessions per application or IP address.

• Max Packets Allowed—Enter themaximum peak packets per second per application or IP address.

• Rate Per Second—Enter themaximumnumber of sessions per second per application or IP address.

• By Pair—Enable this option to apply limit to paired stateful firewall and NAT flows (forward and
reverse).

• Max Sessions Allowed—Enter themaximumnumber of open sessions per application or IP address.

• Max Packets Allowed—Enter themaximum peak packets per second per application or IP address.

• Rate Per Second—Enter themaximumnumber of sessions per second per application or IP address.

• TCP SYN Defense—Enable this option to prevent a SYN flood attack, where the connecting host
continuously send TCP SYN requests without replying to the corresponding ACK responses.

• TCP SYN Fragment—Enable this option to detect packets where the option IP header field indicates
that the packet has been fragmented and the SYN field is set in the TCP header.

• TCP Winnuke—Enable this option to detect attacks in Windows NetBIOS communications. Each
WinNuke attack triggers an attack log entry in the event alarm log.

TCP
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Table 121: Screens for MX Series Routers (continued)

GuidelineSetting

Configure the following parameters for UDP:

• By Source—Enable this option to limit sessions based on numbers generated from the configured
source (IP or subnet) or application.

• Max Sessions Allowed—Enter themaximumnumber of open sessions per application or IP address.

• Max Packets Allowed—Enter themaximum peak packets per second per application or IP address.

• Rate Per Second—Enter themaximumnumber of sessions per second per application or IP address.

• ByDestination—Enable this option to limit sessions based on numbers generated from the configured
destination (IP or subnet) or application.

• Max Sessions Allowed—Enter themaximumnumber of open sessions per application or IP address.

• Max Packets Allowed—Enter themaximum peak packets per second per application or IP address.

• Rate Per Second—Enter themaximumnumber of sessions per second per application or IP address.

• By Pair—Enable this option to apply limit to paired stateful firewall and NAT flows (forward and
reverse).

• Max Sessions Allowed—Enter themaximumnumber of open sessions per application or IP address.

• Max Packets Allowed—Enter themaximum peak packets per second per application or IP address.

• Rate Per Second—Enter themaximumnumber of sessions per second per application or IP address.

UDP

Configure the following parameters for ICMP:

• By Source—Enable this option to limit sessions based on numbers generated from the configured
source (IP or subnet) or application.

• Max Sessions Allowed—Enter themaximumnumber of open sessions per application or IP address.

• Max Packets Allowed—Enter themaximum peak packets per second per application or IP address.

• Rate Per Second—Enter themaximumnumber of sessions per second per application or IP address.

• ByDestination—Enable this option to limit sessions based on numbers generated from the configured
destination (IP or subnet) or application.

• Max Sessions Allowed—Enter themaximumnumber of open sessions per application or IP address.

• Max Packets Allowed—Enter themaximum peak packets per second per application or IP address.

• Rate Per Second—Enter themaximumnumber of sessions per second per application or IP address.

• By Pair—Enable this option to apply limit to paired stateful firewall and NAT flows (forward and
reverse).

• Max Sessions Allowed—Enter themaximumnumber of open sessions per application or IP address.

• Max Packets Allowed—Enter themaximum peak packets per second per application or IP address.

• Rate Per Second—Enter themaximumnumber of sessions per second per application or IP address.

ICMP
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Table 121: Screens for MX Series Routers (continued)

GuidelineSetting

• By Source—Enable this option to limit sessions based on numbers generated from the configured
source (IP or subnet) or application.

• Max Sessions Allowed—Enter themaximumnumber of open sessions per application or IP address.

• ByDestination—Enable this option to limit sessions based on numbers generated from the configured
destination (IP or subnet) or application.

• Max Sessions Allowed—Enter themaximumnumber of open sessions per application or IP address.

Limit Session
(Cumulative)

• By Source—Enable this option to limit sessions based on numbers generated from the configured
source (IP or subnet) or application.

• Rate Per Second—Enter themaximumnumber of sessions per second per application or IP address.

• ByDestination—Enable this option to limit sessions based on numbers generated from the configured
destination (IP or subnet) or application.

• Rate Per Second—Enter themaximumnumber of sessions per second per application or IP address.

Limit Session
(Per Second)

Release History Table

DescriptionRelease

Starting Junos Space Security Director Release 16.2, you can configure screens for MX
Series routers.

16.2

RELATED DOCUMENTATION

Modifying the Configuration of Security Devices | 234

Using Features in Security Devices | 214

Security Devices Overview | 217
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Modifying the Zones Configuration for Security Devices

You can use the Zones section on theModify Configuration page tomodify the security zone configuration
for a device. You canmodify settings related to zone name, system services, protocols, application tracking,
and associate screen to the zone.

NOTE: Refer to the Junos OS documentation (available at http://www.juniper.net/
documentation/en_US/release-independent/junos/information-products/pathway-pages/junos/
product/) for a particular release and device. There you can find detailed information on the
configuration parameters for that device.

To modify the zones parameters:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices whose configuration you want to modify.

3. From the More or right-click menu, select Configuration >Modify Configuration.

The Modify Configuration page appears.

4. Click the Screens.

The Screens page appears.

5. Modify the configuration according to the guidelines provided in Table 122 on page 298.

6. After modifying the configuration, you can cancel the changes, save the changes, preview the changes,
or save the changes and deploy the configuration on the device. See “Modifying the Configuration of
Security Devices” on page 234.

Table 122: Zones Settings

GuidelineSetting

Modify the zone name.Name

Modify the description of the zone.Description
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Table 122: Zones Settings (continued)

GuidelineSetting

Enable this option to maintain the application usage statistics on a device.

By default, when each session closes, application track generates a message that provides the byte
and packet counts and duration of the session, and then sends the message to the syslog host
device.

Application
Tracking

Select the interfaces from the Available column to include in the selected list for the zones.Interfaces

System Services
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Table 122: Zones Settings (continued)

GuidelineSetting

Select this option to disable specific incoming system service traffic, but only when the all system
services option is defined.

The following system services are supported:

• all—Enable traffic from the defined system services available on the Routing Engine (RE). Use the
Is Except option to disallow specific system services.

• any-service—Enable all system services on the entire port range including the system services
that are not defined.

• dns—Enable incoming DNS services.

• finger—Enable incoming finger traffic.

• ftp—Enable incoming FTP traffic.

• http—Enable incoming Web authentication traffic.

• https—Enable incoming Web authentication traffic over Secure Sockets Layer (SSL).

• ident-reset—Enable the access that has been blocked by an unacknowledged identification
request.

• ike—Enable Internet Key Exchange (IKE) traffic.

• Isping—Enable label switched path ping service.

• netconf—Enable incoming NETCONF service.

• ntp—Enable incoming Network Time Protocol (NTP) traffic.

• ping—Allow the device to respond to ICMP echo requests.

• r2cp—Enable incoming Radio Router Control Protocol traffic.

• reverse-ssh—Reverse SSH traffic.

• reverse-telnet—Reverse Telnet traffic.

• rlogin—Enable incoming rlogin (remote login) traffic.

• rpm—Enable incoming real-time performance monitoring (RPM) traffic.

• rsh—Enable incoming remote shell (rsh) traffic.

• sip—Enable incoming Session Initiation Protocol traffic.

• snmp—Enable incoming SNMP traffic (UDP port 161).

• snmp-trap—Enable incoming SNMP traps (UDP port 162).

• ssh—Enable incoming SSH traffic.

• telnet—Enable incoming Telnet traffic.

• tftp—Enable TFTP services.

• traceroute—Enable incoming traceroute traffic (UDP port 33434).

• xnm-clear-text—Enable incoming Junos XML protocol traffic for all specified interfaces.

• xnm-ssl—Enable incoming Junos XML protocol-over-SSL traffic for all specified interfaces.

Is Except
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Table 122: Zones Settings (continued)

GuidelineSetting

Protocols

Select this option to disable specific incoming protocol traffic, but only when the all protocol option
is defined.

The following protocols are supported:

• all—Enable traffic from all possible protocols available. Use the Is Except option to disallow specific
protocols.

• bfd—Enable incoming Bidirectional Forwarding Detection (BFD) protocol traffic.

• bgp—Enable incoming BGP traffic.

• dvmrp—Enable incoming Distance Vector Multicast Routing Protocol (DVMRP) traffic.

• igmp—Enable incoming Internet Group Management Protocol (IGMP) traffic.

• ldp—Enable incoming LDP traffic (UDP and TCP port 646).

• msdp—Enable incoming Multicast Source Discovery Protocol (MSDP) traffic.

• nhrp—Enable incoming Next Hop Resolution Protocol (NHRP) traffic.

• ospf—Enable incoming OSPF traffic.

• ospf3—Enable incoming OSPF version 3 traffic.

• pgm—Enable incoming Pragmatic General Multicast (PGM) protocol traffic (IP protocol number
113).

• pim—Enable incoming Protocol Independent Multicast (PIM) traffic.

• rip—Enable incoming RIP traffic.

• ripng—Enable incoming RIP next generation traffic.

• router-discovery—Enable incoming router discovery traffic.

• rsvp—Enable incoming RSVP traffic (IP protocol number 46).

• sap—Enable incoming Session Announcement Protocol (SAP) traffic. SAP always listens on
224.2.127.254:9875. New addresses and ports can be added dynamically. This information must
be propagated to the Packet Forwarding Engine (PFE).

• vrrp—Enable incoming Virtual Router Redundancy Protocol (VRRP) traffic.

Is Except

Traffic Control Options

Enable this option to send a TCP packet with the RST (reset) flag set to 1 in response to a TCP
packet with any flag other than SYN set and that does not belong to an existing session.

TCP Rst

Select a security screen for a security zone to detect and block various kinds of traffic that the
device determines as potentially harmful.

Screen
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Table 122: Zones Settings (continued)

GuidelineSetting

Display the selected interfaces and system services and protocols for the interface.Interface
Services and
Protocols

RELATED DOCUMENTATION

Modifying the Configuration of Security Devices | 234

Using Features in Security Devices | 214

Security Devices Overview | 217

Modifying the IPS Configuration for Security Devices

You can use the IPS section on the Modify Configuration page to modify the sensor configuration for a
device. You must configure the SRX Series device to send attack packets to the Junos Space Network
Management Platform. Select the device and configure the parameters such as host IP address for receiving
packets, source IP address, maximum sessions, threshold logging interval, total memory, and port.

NOTE: Refer to the JunosOSdocumentation available at http://www.juniper.net/documentation/
en_US/release-independent/junos/information-products/pathway-pages/junos/product/ for
detailed information on the configuration parameters for a device.

To modify packet log parameters:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select a device to modify the configuration.

3. From the More or right-click menu, select Configuration >Modify Configuration.

The Modify Configuration page appears.

4. Select IPS.
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The Sensor Configuration screen appears.

5. Modify the configuration according to the guidelines provided in Table 123 on page 303.

Table 123: Sensor Configuration Details

GuidelinesSetting

The Virtual IP address of the Junos Space Network Management Platform server for
SRX Series devices to send packets.

Host IP for receiving packets

The interface IP address of the SRX Series device through which packets are sent.Source address

The maximum number of packet capture sessions expressed as a percentage of the
IDP session capacity for the device.

Max Sessions

The minimum time interval in minutes between log messages for maximum sessions
or memory reached.

Threshold logging interval

Themaximum amount of memory allocated to capture packets for a device. This value
is expressed as a percentage of the memory available on the device.

Total Memory

The port number of the server for SRX Series devices to send the packet capture
object.

The port is 2050, which is opened on Junos Space Network Management Platform
server on installing Security Director to receive packets from SRX series devices.

Port

RELATED DOCUMENTATION

Packet Capture Overview | 202

About the Packets Captured Page | 203
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Modifying the SSL Initiation Profile for Security Devices

You can use the SSL Initiation Profile section on the Modify Configuration page to create, edit and delete
SSL Initiation Profile. The profile contains the settings for the SSL-initiated connections. This includes the
list of supported ciphers and their priority, the supported versions of SSL/TLS, certificates and a few other
options.

NOTE: Refer to the Junos OS documentation (available at http://www.juniper.net/
documentation/en_US/release-independent/junos/information-products/pathway-pages/junos/
product/) for a particular release and device. There you can find detailed information on the
configuration parameters for that device.

To modify SSL Initiation profile:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select a device to modify the configuration.

3. From the More or right-click menu, select Configuration >Modify Configuration.

The Modify Configuration page appears.

4. Click the SSL Initiation link in the left-navigation menu.

The SSL Initiation Profile page is displayed. The existing SSL Initiation profiles if any are displayed in
the table.

See Table 124 on page 304 for the list of actions that you can perform in this page.

5. After modifying the configuration, you can cancel the changes, save the changes, preview the changes,
or save the changes and deploy the configuration on the device. See “Modifying the Configuration of
Security Devices” on page 234.

Table 124: SSL Initiation Profile Actions

DescriptionAction

Click the + icon to create a SSL Initiation Profile.

The Add SSL Initiation Profile page appears. Complete the configuration according
to the guidelines provided in Table 125 on page 305 and click OK.

Create a SSL Initiation Profile
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Table 124: SSL Initiation Profile Actions (continued)

DescriptionAction

Select a SSL Initiation profile and click the pencil icon.

The Modify SSL Initiation Profile page appears, which shows the same fields as
create a SSL Initiation Profile. You can modify some of the fields on this page. See
Table 125 on page 305 for more details on the fields. ClickOK to save the changes.

Modify a SSL Initiation Profile

Select one or more SSL Initiation Profiles that you want to delete, and click the bin
icon to delete the profiles.

The Warning page appears. Click Yes to confirm the deletion.

Delete a SSL Initiation Profile

Select to show or hide various parameters in the grid.Show Hide Columns

Table 125: Create SSL Initiation Profile

ActionField

General Information

Enter a name for the SSL Initiation Profile.Name

Select the Allow check box to enable flow tracing for the profile.Flow Tracing

Select the accepted protocol SSL version.Protocol Version

Select the preferred cipher depending on the key strength.Preferred Ciphers

Select the Allow check box to enable SSL session cache.Session Cache

Certificate

Select an effective client certificate for the client.Client Certificate

Action

Select the Allow check box to ignore server authentication failure completely.Server Authentication Failure

Select the Allow check box to disable CRL validation. Certificate Revocation
List (CRL) validation on SRX Series device involves checking for revoked
certificates from servers.

CRL Validation

Select an action if CRL information is not present. You can allow or drop the
sessions when a CRL information is not available.

Action
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Table 125: Create SSL Initiation Profile (continued)

ActionField

Select the Allow check box to allow the sessions when a certificate is revoked,
and the revocation reason is on hold.

Hold Instruction Code

RELATED DOCUMENTATION

Modifying the Configuration of Security Devices | 234

Using Features in Security Devices | 214

Security Devices Overview | 217

Modifying the ICAP Redirect Profile for Security Devices

You can use the ICAP Redirect Profile section onModify configuration page to configure the ICAP redirect
profile. You can create, edit or delete an ICAP Redirect Profile. The ICAP server profile allows the ICAP
server to process request messages, response messages, fallback options, and so on, for the permitted
traffic.

NOTE: Refer to the Junos OS documentation (available at http://www.juniper.net/
documentation/en_US/release-independent/junos/information-products/pathway-pages/junos/
product/) for a particular release and device. There you can find detailed information on the
configuration parameters for that device.

To modify ICAP Redirect Profile:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select a device to modify the configuration.

3. From the More option or right-click menu, select Configuration >Modify Configuration.

The Modify Configuration page appears.

4. Click the ICAP Redirect link in the left-navigation menu.
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The ICAP Redirect Profile page is displayed. The existing ICAP Redirect profiles if any, are displayed in
the table.

See Table 126 on page 307 for the list of actions that you can perform in this page.

5. After modifying the configuration, you can cancel the changes, save the changes, preview the changes,
or save the changes and deploy the configuration on the device. See “Modifying the Configuration of
Security Devices” on page 234.

Table 126: ICAP Redirect Profile actions

DescriptionAction

Click the + icon to create an ICAP Redirect Profile.

The Add ICAP Redirect Profile page appears. Complete the configuration according
to the guidelines provided in Table 127 on page 307 and click OK.

Create an ICAP Redirect Profile

Select an ICAP Redirect profile from the table and click the pencil icon.

The Modify ICAP Redirect Profile page appears, which shows the same fields as
create an ICAP Redirect Profile page. You can modify some of the fields on this
page. See Table 127 on page 307 for more details on the fields. ClickOK to save the
changes.

Modify an ICAP Redirect Profile

Select one or more ICAP Redirect profiles that you want to delete, and click the bin
icon to delete the profiles.

The Warning page appears. Click Yes to confirm the deletion.

Delete an ICAP Redirect Profile

Select to show or hide various parameters in the grid table.Show Hide Columns

Table 127: Create an ICAP Redirect Profile

ActionField

Enter a valid ICAP service profile name.Name

Enter the server response timeout in milliseconds. Timeout is the interval after which the
server is considered inactive if there is no response from the server.

The range is 100 through 50000.

Timeout

HTTPRedirectOption

Select the Allow check box to enable redirect service on HTTP request.Request
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Table 127: Create an ICAP Redirect Profile (continued)

ActionField

Select the Allow check box to enable redirect service on HTTP response.Response

You can perform the following actions on this page:

• Create an ICAP Redirect Server— Click the + icon to create an ICAP Redirect Server.

The Create ICAP Redirect Server page appears. Complete the configuration according
to the guidelines provided in Table 128 on page 308 and click OK.

The ICAP Redirect Server is created and you are returned to the ICAP Redirect Profile
page.

• Edit an ICAP Redirect Server— Select an ICAP Redirect Server and click the pencil icon
to modify the settings.

The Modify ICAP Redirect Server page appears, showing the same fields that are
presented when you create an ICAP Redirect Server. You can modify some of the fields
on this page. See Table 128 on page 308 for an explanation of the fields.

After you have modified the ICAP Redirect Server, clickOK. The changes are saved and
you are returned to the ICAP Redirect Server Profile page.

ICAP Server

Fallback Option

Select a valid timeout option from the dropdown list.

Request an action to the server in an event of failure, when you do not receive response
within a specified time period.

Timeout Action

Select a connectivity action from the list when there is connection issue and request cannot
be sent out.

Connectivity Action

Select a default action from the list to be taken when there are cases other than Timeout
and Connectivity issue..

Default Action

Table 128: Create an ICAP Redirect Server Settings

GuidelineSetting

Enter an ICAP Redirect server name.Name
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Table 128: Create an ICAP Redirect Server Settings (continued)

GuidelineSetting

Select the type of host, name or IP address.

• Host Name– Enter a valid host name.

NOTE: Host name appears when you select host type as name.

• Host IP– Enter a valid host IP address.

NOTE: Host IP address appears when you select host type as IP

Host Type

Enter a valid ICAP server listening port.Port

Enter the number of connections to create the ICAP service.Sockets

Authentication

Specify the type of authentication.Authorization Type

Select the type of credential for the authentication.

The available options are:

• ASCII, and

• Base64.

Credential Type

Based on the Credential Type that you choose, enter the ASCII string or Base64
string.

Credential

URI

Enter the path to the service that handles Request Modification (REQMOD)
requests.

Request MOD

Enter the path to the service that handles Response Modification (RESPMOD)
requests.

Response MOD

Select a virtual router that is used for launching the service.Routing Instance

Select a SSL initiation profile.SSL Initiation Profile

RELATED DOCUMENTATION
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Configuring Aruba ClearPass for Security Devices

Use the Aruba Clear Pass page to configure the Aruba ClearPass as the authentication source for the
integrated ClearPass authentication and enforcement feature. The SRX Series device and Aruba ClearPass
collaborate to protect your network resources by enforcing security at the user identity level and controlling
user access to the Internet.

The ClearPass Policy Manager (CPPM) can authenticate users across wired, wireless, and VPN
infrastructures. The integrated ClearPass feature allows the CPPM and the SRX Series device to collaborate
in multiple environments in which they are deployed together.

To configure Aruba ClearPass:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices whose configuration you want to modify.

3. From the More or right-click menu, select Configuration >Modify Configuration.

The Modify Configuration page appears.

4. Click ArubaClearPass in the left-navigation menu.

The Aruba Clear Pass section on the Modify Configuration page is displayed.

5. Specify the parameters for configuring Aruba ClearPass according to the guidelines provided in
Table 129 on page 310.

6. After modifying the configuration, you can cancel the changes, save the changes, preview the changes,
or save the changes and deploy the configuration on the device. See “Modifying the Configuration of
Security Devices” on page 234.

Table 129: Fields on the Aruba Clear Pass Page

DescriptionField

Select the name of the Aruba ClearPass from the list.Name
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Table 129: Fields on the Aruba Clear Pass Page (continued)

DescriptionField

Set the timeout interval after which the idle entries in the ClearPass authentication table expire.

The timout interval begins from when the user authentication entry is added to the ClearPass
authentication table. If a value of 0 is specified, the entries will never expire. Range is 10 through
1440 minutes.

Authentication
Entry Timeout

Enter the expiry time in minutes to apply to invalid authentication entries in the SRX Series
authentication table for Windows active directory or Aruba ClearPass authentication sources.
Range is 0 through 1440 minutes.

The invalid authentication entry timeout setting is different from the general authentication entry
timeout setting. It allows you to protect invalid user authentication entries in an authentication
table from expiring before the user can be validated.

Invalid
Authentication
Entry Timeout

Enable this option to turn off the user query functionwithout deleting the user query configuration.No User Query

Enable this option to allow the SRX Series device to query the ClearPass webserver for
authentication and identity information for an individual user, whose information was not posted
to the SRX Series device by ClearPass.

User Query

Enter the client ID that the SRX Series device requires to obtain an access token for the Integrated
ClearPass Authentication and Enforcement user query function. Range is 1 through 64.

If it is configured, the user query function allows the SRX Series device to query the CPPM for
authentication and identity information about individual users when it does not receive this
information from the CPPM through the SRX Series Web API daemon (webapi).

Client ID

Specify the certificate file that the SRX Series device uses to verify the Clearpass server’s certificate
for the SSL connection that is used for the user query function. As the ClearPass administrator,
you must export the certificate of the server from the CPPM and import it to the SRX Series
device. Later, you must configure the ca-certificate path and the certificate filename on the SRX
Series device. For example, /var/tmp/RADIUSServerCertificate.crt.

CA Certificate

Specify the client secret used with the client ID that the SRX Series device requires to obtain an
access token for the Integrated ClearPass Authentication and Enforcement user query function.
The client secret must be consistent with the client secret configured on the CPPM. Range is 1
through 128.

Client Secret
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Table 129: Fields on the Aruba Clear Pass Page (continued)

DescriptionField

Enter the amount of time for the SRX Series device to delay before sending queries to the Aruba
ClearPass PolicyManager (CPPM) for authentication and identity information for individual users.
Range: 0 through 60 seconds.

After the delay timeout expires, the SRX Series device sends the query to the CPPM and creates
a pending entry for the user in the Routing Engine authentication table. During this period, any
arriving traffic matches the default policy whose action on the traffic you can configure.

Delay Query
Time

Enter the query-api to specify the path of the URL that the SRX Series device uses to query the
ClearPass Policy Manager (CPPM) webserver for authentication and identity information for an
individual user.

Consider the following query-api example: api/v1/insight/endpoint/ip/$IP$.

The SRX Series device generates the complete URL for the user query request by combining the
query-api string with the connection method (HTTPS) and the CPPM webserver IP address
({$server}).

https://{$server}/api/v1/insight/endpoint/ip/$IP$

In this example, the SRX Series device replaces the variables with the following values resulting
in a specific URL request for the individual user:
https://203.0.113.76/api/v1/insight/endpoint/ip/192.0.2.98.

Query API

Enter the token API that is used in generating the URL for acquiring an access token. The token
API is combined with the connection method and the IP address of the ClearPass webserver to
produce the complete URL used for acquiring an access token.

For example, if the token API is oauth, the connection method is HTTPS, and the IP address of
the ClearPass webserver is 192.0.2.199, the complete URL for acquiring an access token would
be https://192.0.2.199/api/oauth. This is a required parameter. There is no default value.

Token API

Web Server

Enter the IPv4 address of the ClearPass webserver to communicate with the SRX Series device.

The SRX Series device requests user authentication and identity information for an individual user
from the ClearPass webserver whose address is configured. If you configure the user query
function, the SRX Series device can obtain this information for a specific user when it does not
receive it from the ClearPass Policy Manager through Web API POST requests.

Address

Enter the server name of the ClearPass webserver to communicate with the SRX Series device.Server Name
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Table 129: Fields on the Aruba Clear Pass Page (continued)

DescriptionField

Select the TCP port of the SRX Series device to use for incoming HTTP or HTTPS connection
requests initiated by the ClearPass Policy Manager (CPPM).

Port

Select the application protocol used for the SRX Series device connection to the ClearPass Policy
Manager (CPPM) for user query requests. Default is HTTPS.

You identify the connection protocol as part of the configuration that identifies the CPPM server.
The user query function allows the SRX Series device to request from theCPPMuser authentication
and identity information for an individual user.

• HTTP—Protocol that the CPPM uses to connect to the SRX Series device.

• HTTPS—Secure version of the protocol that the CPPMuses to connect to the SRX Series device.

Connect Method
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Configuring APBR Tunables for Security Devices

Use the APBR-Tunables page to configure the advanced policy-based (APBR) routing options to streamline
the traffic handling. Fine-tuning the APBR configuration such as limiting route changes and terminating
sessions are required to avoid the excessive transitions due to route changes.

To configure the APBR Tunables:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select a device whose configuration you want to modify.

3. From the More or right-click menu, select Configuration >Modify Configuration.

The Modify Configuration page appears.

4. Click APBR-Tunables from the left-navigation menu.
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The APBR-Tunables page appears.

5. Configure the parameters as per the guidelines provided in Table 130 on page 314.

6. Click Save to save the changes, Preview Changes to preview the configuration changes, Save and
Deploy to save the configuration and update changes to the device, or Cancel to discard the changes.
See “Modifying the Configuration of Security Devices” on page 234.

Table 130: Fields on the APBR Tunables Page

DescriptionField

Configure the threshold for limiting the number of times a route can change for a
session. The default value is 1.

Range is 0-5.

Max route change

Enable this option to terminate the session instead of allowing traffic to traverse
through the same route bypassing APBR.

By default, this option is disabled.

Drop on zone mismatch

Enable logging to record events that occur on the device for APBR-related operations.

By default, the logging is disabled.

Enable Log
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Modifying the Express Path Configuration for Security Devices

Express path (formerly known as services offloading) is a mechanism for processing fast-path packets in
the network processor instead of in the Services Processing Unit (SPU). Express path considerably reduces
packet-processing latency by 500–600 percent.

You can use the Express Path section on the Modify Configuration page to view, create, edit, or delete
Flexible PIC Concentrator (FPC) details on a device. You can toggle the status of one or more express
paths. Express path is supported only on SRX5400, SRX5600, SRX5800, and rootLsys devices.
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NOTE: Refer to the Junos OS documentation (available at https://www.juniper.net/
documentation/en_US/release-independent/junos/information-products/pathway-pages/junos/
product/) for a particular release and device. There you can find detailed information on the
configuration parameters for that device.

To modify the express path configuration:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices whose configuration you want to modify. ClickMore or use the right-click menu
and select Configuration >Modify Configuration.

The Modify Configuration page appears.

3. Click the ExpressPath link in the left-navigation menu.

The Express Path section on the Modify Configuration page is displayed. The actions that you can
perform in this page are provided in Table 131 on page 315.

4. After modifying the configuration, you can cancel, save, preview, or save the changes and deploy the
configuration on the device. See “Modifying the Configuration of Security Devices” on page 234.

Table 131: Express Path Actions

GuidelinesAction

Click the + icon to add FPC details.

The Add FPCDetails page appears. Complete the configuration according to the guidelines
provided in Table 132 on page 316 and click OK.

The FPC details are created and you are returned to the Express Path section on theModify
Configuration page.

Add FPC details

Select an express path and click the pencil icon.

The Edit FPC Details page appears, showing the same fields that are presented when you
create an express path. See Table 132 on page 316 for a description of the fields. After you
have modified the express path, click OK.

The changes are saved and you are returned to Express Path section on the Modify
Configuration page.

Edit FPC details
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Table 131: Express Path Actions (continued)

GuidelinesAction

Select one or more express paths and click the X icon to delete the routes.

The Warning page appears. Click Yes to confirm the deletion. The selected express paths
are deleted.

Delete express path

Select one or more express paths. ClickMore or use the right-click menu and select Toggle.

The activated express paths are deactivated and the deactivated express paths are activated.

NOTE: The Toggle option is enabled only when the selected express paths are a mix of
activated and deactivated records.

Toggle the status of an
express path

Table 132: Fields on the Add FPC Details Page

Enter a valid FPC slot number, which can be a value from 0 through 127.FPC Slot Number

Select this option to enable session cache on an I/O Card (IOC).np-cache
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Modifying theDevice InformationSourceConfiguration for SecurityDevices

Use theDevice Information Source page to configure the authentication source. Supported authentication
sources include Active Directory and third-party network access systems.

The SRX Series device obtains the device identity information for authenticated devices from the
authentication source. After the SRX Series device obtains the device information, it creates a device
identity authentication table to store device identity entries. The SRX Series device searches the device
identity authentication table for a device match when traffic issuing from a user’s device arrives at the
SRX Series device. If it finds a match, the SRX Series device searches for a matching security policy. If it
finds a matching security policy, the security policy’s action is applied to the traffic.
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NOTE: Refer to the Junos OS documentation (available at https://www.juniper.net/
documentation/en_US/release-independent/junos/information-products/pathway-pages/junos/
product/) for a particular release and device. There you can find detailed information on the
configuration parameters for that device.

To modify the authentication source:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices whose configuration you want to modify.

3. ClickMore or use the right-click menu and select Configuration >Modify Configuration.

The Modify Configuration page appears.

4. Click the Authentication Source link in the left-navigation menu.

The Device Information Source page is displayed.

5. Select an authentication source.

6. After modifying the configuration, cancel the changes, save the changes, preview the changes, or save
the changes and deploy the configuration on the device. See “Modifying the Configuration of Security
Devices” on page 234.

Viewing the Active Configuration of a Device in Security Director

You can view the active configuration of one or more devices on the Security Devices page.

To view the active configuration:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select one or more devices. From the More or right-click menu, select Configuration > View Active
Configuration.
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The ViewActive Configuration page appears, displaying the active configuration on the selected devices.
The left pane displays the Junos OS configuration statement hierarchy and the right pane displays the
CLI and XML views of the configuration; the CLI configuration is displayed by default.

3. Select the actions that you want to perform by using the guidelines provided in Table 133 on page 318.

4. Click Close to close the page.

You are returned to the Security Devices page.

Table 133: View Active Configuration Page Actions

GuidelineAction

Click the right arrow to expand the configuration and the down arrow to collapse
the configuration.

Navigate the configuration

Enter a search term in the text box in the left pane and mouse over the right side
of the text box and click the magnifying glass icon.

The configuration statements that match the search text are displayed in the left
pane. Select one or more check boxes to view the CLI corresponding to the search
results.

Search the configuration

Click the gears icon in the left pane to modify the configuration display settings on
the View Active Configuration page.

The Modify Custom Settings page appears. Configure the settings according to the
guidelines provided in Table 134 on page 319.

Click Save to save your changes.

You are taken to the ViewActive Configuration pagewhere the settings are applied.

Customize the configuration
display settings

Click the CLI tab to view the configuration as it appears on the device CLI. This is
the default view.

View the configuration as it
appears in the CLI

Click the XML tab to view the configuration in XML format.View the configuration in XML
format

Select the check box for a configuration statement to view the details of the
configuration stanza in the CLI or XML tabs.

If you have configured the option to select multiple configuration statements, then
you can viewmore than one configuration stanza by selectingmultiple check boxes.

View selected parts of the
configuration
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Table 133: View Active Configuration Page Actions (continued)

GuidelineAction

Click Export All to export the configuration for all the devices displayed.

The Job Details: Export Device Configuration page appears, displaying the status
of the job.

Click theDownload link to download the configuration (in ZIP format) to your local
client.

Click OK to close the Job Details page. You are returned to the View Active
Configuration page.

Export the configuration

Table 134: Modify Custom Settings

GuidelineSetting

Select this check box if you want to view more than one configuration statement
hierarchy at the same time.

This check box is clear by default.

Multi Select

Select this check box to view the configuration statement in alphabetical order.Alphabetical Ordering
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Deleting Devices in Security Director

You can delete security devices from the Security Devices page. Deleting a device removes all device
configuration and device inventory information from the Junos Space database. If provisioning services
are associated with a device that you want to delete, you must remove the provisioning services before
deleting the device.
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To delete devices:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices that you want to delete. From the More or right-click menu, select Operations >
Delete Devices.

The Delete Devices page appears displaying the devices selected for deletion.

3. Click OK to confirm the deletion.

The JobDetails: Delete Device page appears displaying information about the job. If the job is successful,
Junos Space deletes all device configuration and inventory information for the selected devices from
the database.

4. Click OK to close the Job Details page.

You are returned to the Security Devices page.
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Rebooting Devices in Security Director

You can reboot security devices from the Security Devices page. You can also reboot virtual chassis setups,
dual Routing Engine (RE) setups, and cluster setups. However, you cannot reboot logical systems (LSYS)
or tenant systems (TSYS) devices in Security Director.

NOTE: You can only reboot devices for which the connection status is Up.
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To reboot devices:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices that you want to reboot. From the More or right-click menu, select Operations >
Reboot Devices.

The Reboot Devices page appears displaying the devices selected for rebooting

3. Specify the parameters for rebooting devices according to the guidelines provided in
Table 135 on page 321.

4. Click OK to reboot the devices.

The Job Detail: Reboot Devices appears displaying the details of the job.

5. Click OK to close the Job Details page.

You are returned to the Security Devices page.

NOTE: You can view the job results from the Job Management page. If some of the devices fail
to reboot, you can use the Retry on Failed Devices action to retry rebooting the devices that
failed to reboot. See “Retrying a Failed Job on Devices in Security Director” on page 187.

Table 135: Reboot Devices Settings

GuidelineSetting

Select this check box if you want the devices to be powered off after the reboot.Power off device after
reboot

Enter a message that will be broadcast to users who are logged in to the devices being
rebooted.

Message

Specify whether the devices should be rebooted immediately or later. If you specify
that the operation should be run later, you must specify a start date and time (in
MM/DD/YYYY and HH:MM:SS 24-hour or AM/PM formats) for the reboot operation.

Type

RELATED DOCUMENTATION
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Resolving Key Conflicts in Security Director

Devices connect to Junos Space using an RSA key. When the device is disconnected or is down, a new
RSA key can be generated from the Administration workspace of the Junos Space Network Management
Platform. However, when the device comes back online, it will not be able to reconnect to Junos Space
using this key. The Authentication Status column on the Security Devices page shows when the device is
in the Key Conflict state. You can use the Resolve Key Conflict action in such instances to resolve the key
conflict by providing the authentication credentials for the device.

To resolve key conflicts in one or more devices:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices. From the More or right-click menu, select Operations > Resolve Key Conflict.

The Resolve Key Conflict page appears displaying the list of devices you selected.

3. For each device listed, select the device, click the Edit button, and enter the parameters according to
the guidelines provided in Table 136 on page 322.

4. Click the Upload button.

The Job Details: Upload RSA Keys page appears displaying the status of the job. The information about
the devices and the status of the upload for each device is displayed in a table.

5. Click OK to close the Job Details page.

You are returned to the Security Devices page.

Table 136: Resolve Key Conflict Settings

GuidelineSetting

Displays the IPv4 or IPv6 address of the device.IP Address

Enter the username of the user on the device.Username

Enter the corresponding password for user on the device.Password
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Launching a Web User Interface of a Device in Security Director

You can access theWebUser Interface of a device tomanage it directly from Security Director. The device
should have the required Web UI components installed and enabled.

NOTE: Once launched, theWebUI appears in a new tab in your browser. Ensure that you enable
pop-ups on your browser for the device for which the Web UI is being launched.

To launch the Web UI of a device:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the device for which you want to launch the Web UI. From the More or right-click menu, select
Access > Launch Device WebUI.

The Juniper Web Device Manager page appears in a new tab or browser window.

3. Specify the login credentials according to the guidelines provided in Table 137 on page 323.

4. Click Log In to log in to the device.

If the authentication credentials are correct, you are logged in to the device and can perform the desired
operations on the device.

Table 137: Juniper Web Device Manager Settings

GuidelineSetting

Username of the user on the device.Username

Password of the user on the device.Password
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Connecting to a Device by Using SSH in Security Director

You can establish an SSH connection to a device from the Security Devices page. You can also establish
multiple SSH sessions to the same device. A new SSH terminal window is opened for every new connection
to the device.

CAUTION: Some browser plug-ins might cause undesirable behavior in open SSH
windows; disabling such plug-ins might resolve the issue.

Before you open an SSH session to connect to a managed device, ensure that:

• You have the privileges of a Super Administrator or Device Manager.

• The status of the managed device is UP.

NOTE: Once launched, the SSH window appears in a new window. Ensure that you enable
pop-ups on your browser for the device for which the application is being launched.

To connect to a device by using SSH:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the device to which you want to connect. From the More or right-click menu, select Access >
SSH to Device.

The SSH to Device page appears in a new tab or browser window.

3. Specify the login credentials according to the guidelines provided in Table 138 on page 325.

4. Click Connect to log in to the device..

Junos Space validates the fingerprint stored in the database with that on the device. If the fingerprints
on the device match the fingerprints in the database, the SSH terminal is displayed. If the fingerprints
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do not match, you need to acknowledge the device SSH fingerprints. See “Resolving Key Conflicts in
Security Director” on page 322.

5. Terminate the SSH session by typing exit at the command prompt, and then press Enter.

6. Click the X button in the browser window or tab to close the SSH window.

Table 138: SSH to Device Settings

GuidelineSetting

Displays the IP address of the device.IP Address

Enter the username of the user on the device.Username

Enter the corresponding password for user on the device.Password
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Importing Security Policies to Security Director

Security Director enables you to import firewall, NAT, and IPS policies from a device. All objects supported
by Security Director are imported during the policy import process.

To import a device configuration to Security Director:

1. Select Devices > Security Devices.

2. Select a device and then clickMore.

3. Click Import.

The Import Configuration page appears.

You can also right-click the selected device and select Import.

4. Select the policy to be imported to Security Director.
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5. Click Next.

6. Resolve any conflicts after you verify the information, if needed.

NOTE: Security Director creates a new policy each time you import one. If a policy with the
same name but a different definition exists, then conflicts arise.

7. Click Finish.

Security Director displays a summary of the configuration changes.

8. Click the Summary Report link.

The summary report is downloaded as a ZIP file. This summary report .zip file contains the complete
rules report as a PDF.

9. Click OK to complete the import process.

The Job Details page appears with the import success details.

NOTE: You can download the summary report from Job Details page. Click Download
Summary. The summary report is downloaded in the ZIP format.

10.Click OK.
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Importing Device Changes

You can import out-of-band changes, which are made on the device and managed by Security Director.

To import the device changes:

1. Select Devices > Security Devices

2. Select a device and then clickMore.

3. Select Device Change > Import Device Change.

The Import Device Change page appears.

You can also right-click the selected device and select Device Change > Import Device Change.

4. Select the policy to be imported.

5. Click Next.

6. Resolve any conflicts after you verify the information, if needed.

7. Click Finish.

Security Director displays a summary of the configuration changes.
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Viewing Device Changes

You can check the status of the security configuration changes, either in CLI or XML format.
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To view the device changes:

1. Select Devices > Security Devices.

2. Select a device and then clickMore.

3. Click Device Change > View Device Change.

The View Device Change page appears.

You can also right-click the selected device and select Device Change > View Device Change.

4. Enable the required service types to preview the selected policies on the device. For example, enable
Firewall Policy to preview the firewall policies on the device.

5. Click OK.

The View Configuration for x page appears, where, x is the configuration change name. For example,
View configuration for 1002009SecGW01.

6. Select CLI or XML tab to check the status of the security configuration changes in the preferred format.

7. Click OK.

The configuration changes are displayed in both the CLI and XML tabs. You can push the configurations
to the device after validating the changes.
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Viewing and Exporting Device Inventory Details in Security Director

You canmanage the device inventory from the Security Devices page. The device inventory is synchronized
with the Junos Space database after the device is discovered. The device is resynchronized with Junos
Space every time there is a change on the device (if Junos Space is the System of Record) or if you trigger
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a manual resynchronization. When the device is synchronized, the device inventory in the Junos Space
database matches the inventory on the device.

To view and export device inventory details:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select one or more devices. From the More or right-click menu, select View Inventory Details.

The inventory details for the devices that you selected are displayed on a new page with three tabs:
Physical Inventory, Physical Interfaces, and Logical Interfaces. The Physical Inventory tab is selected
by default. Table 139 on page 330 displays the fields on the Physical Inventory tab.

3. Click the export icon on the Physical Inventory tab to export the physical inventory details.

The Job Details: Export Physical Inventory page appears, displaying details of the job. When the job
completes, click the Download link to download the inventory details.

Click OK to close the Job Details page.

4. Click the Physical Interfaces tab to view the inventory details for the physical interfaces on the devices.
Table 140 on page 330 displays the fields on the Physical Interfaces tab.

5. Click the export icon on the Physical Interfaces tab to export the physical interface details.

The Job Details: Export Physical Interface page appears, displaying details of the job. When the job
completes, click the Download link to download the interface details.

Click OK to close the Job Details page.

6. Click the Logical Interfaces tab to view the inventory details for the logical interfaces on the devices.
Table 141 on page 331 displays the fields on the Logical Interfaces tab.

7. Click the export icon on the Logical Interfaces tab to export the logical interface details.

The Job Details: Export Logical Interface page appears, displaying details of the job. When the job
completes, click the Download link to download the interface details.

Click OK to close the Job Details page.

NOTE: Physical inventory is not applicable for Logical Systems (LSYS) and Tenant Systems (TSYS).
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Table 139: Physical Inventory Tab Fields

DescriptionField

Type of module on the device.Module

Name of the device.Device Name

Model number of the device component.Model Number

Model of the device.Model

Part number of the device.Part Number

Part number of the optical module installed on the device.Vendor Part Number

Material number of the optical module installed on the device.Vendor Material Number

Revision number of the device.Revision

Serial number of the device component.Serial Number

Status of the component: Online or Offline. The status is updated during
periodic resynchronization of configuration information and on notification.

Status

Domain to which the device is assigned.Domain

Description of the component.Description

Table 140: Physical Interfaces Tab Fields

DescriptionField

Name of the device.Device Name

Standard information about the interface, in the format type-/fpc/pic/port, where
type is the media type that identifies the network device; for example, ge-0/0/6.

Physical Interface Name

IPv4 address of the interface.IP Address

IPv6 address of the interface, if configured.IPv6 address

Link to the table of logical interfaces for the device.

Click View to view the logical interfaces for the corresponding physical interface.

Logical Interfaces
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Table 140: Physical Interfaces Tab Fields (continued)

DescriptionField

MAC address of the device.MAC Address

Operational status of the interface: up or down.Operational Status

Admin status of the interface: up or down.Admin Status

Link level type of the physical interface.Link Level Type

Physical interface link type: full duplex or half duplex.Link Type

Speed (in MBps) at which the data transfer occurs in the interface.Speed

Maximum transmission unit size (in bytes) on the physical interface.MTU

An optional description for this interface configured on the device. It can be any
text string of 512 or fewer characters. Any longer string is truncated to 512. If no
description was configured, this field is blank.

Description

Domain to which the device is assigned.Domain

Table 141: Logical Interfaces Tab Fields

DescriptionField

Name of the device.Device Name

Standard information about the interface, in the format type- /fpc/pic/port.logical
interface, where type is themedia type that identifies the network device; for example,
ge-0/0/6.135.

Interface Name

IP address for the logical interface.IP Address

IPv6 address for the interface, if configured.IPv6 Address

Encapsulation type used on the logical interface.Encapsulation

VLAN ID for the logical interface.VLAN

An optional description for this interface configured on the device. It can be any
text string of 512 or fewer characters. Any longer string is truncated to 512. If no
description was configured, this field is blank.

Description
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Table 141: Logical Interfaces Tab Fields (continued)

DescriptionField

Domain to which the device is assigned.Domain
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Previewing Device Configurations

You can preview the configuration changes that will be pushed to the security device. You can preview
the changes in either CLI or XML format.

To preview the configuration changes:

1. Select Devices > Security Devices.

2. Select a device and then clickMore.

3. Click Configuration and then select Preview Changes.

You can also right-click the selected device and select Configuration > Preview Changes.

4. Enable the required service types to preview the selected policies on the device. For example, enable
Firewall Policy to preview the firewall policies on the device.

5. Click OK.

The View Configuration for x page appears, where, x is the configuration change name. For example,
View configuration for 1002009SecGW01.

6. Select either the CLI or XML tab to check the status of the security configuration changes in the
preferred format.

7. Click OK.

The configuration changes are displayed in both the CLI and XML tabs. You can push the configurations
to the device after validating the changes.
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NOTE: If the configuration changes are more than 2 MB, you can download the CLI
configuration in PDF format.
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Refreshing Device Certificates

You can refresh the certificate of a device to authenticate VPN and SSL.When you add a device manually,
you need to synchronize the certificate, which can be done on more than one device at a time.

NOTE: You can refresh the device certificates for root device and LSYS device.

To refresh the device certificate:

1. Select Devices > Security Devices.

2. Select device you want to refresh the certificate and then clickMore.

3. Click Refresh Certificate.

The Refresh Device Certificates page appears.

You can also right-click the selected device and select Refresh Certificate.

4. Select the device(s) for certificate synchronization and click OK.

The Job Details page appears and provides the status of the certificate synchronization.

5. Click View.
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The list of available certificates on the device appears.

6. Click OK.

Refreshing the device certificate process is complete.
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Assigning Security Devices to Domains

You can assign devices to domains from the Security Devices page. By default, devices belong to the
domain in which you are present when you run the device discovery profile.

To assign devices to a domain:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select the devices that you want to assign to one or more domains. From theMore or right-click menu,
select Assign Device to Domain.

The Assign Device to Domains page appears, displaying the list of domains to which you can assign
the devices.

3. Select one or more domains by clicking the check boxes corresponding to the domains.

4. Specify whether warnings should be ignored for logical systems or tenant systems by selecting the
Ignore Warnings check box.

5. Click Assign.

The Assign Objects to Domain Status page appears, displaying the status of the domain assignment.
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NOTE: Although the status of the domain assignment is displayed as success, when the
IgnoreWarnings check box is selected it is possible that the selected devices are not assigned
to the domain. You can verify if the assign to domain action was successful or not by viewing
the corresponding audit log entry in the Audit Log page in Junos SpaceNetworkManagement
Platform. If the assignment was unsuccessful, you can find out the reasons from the audit
log entry, rectify the problem, and retry the assignment.

6. Click OK.

You are returned to the Security Devices page.
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Acknowledging Device SSH Fingerprints in Security Director

You use the Acknowledge Device Fingerprint action to acknowledge the SSH fingerprints received from
the device or to resolve any SSH fingerprint conflicts between the fingerprints stored in the Junos Space
database and that on the device. This action is enabled only if the Authentication Status column on the
Security Devices page displays one of the following statuses: Credentials Based – Unverified; Key Based
– Unverified; Key Conflict – Unverified; or Fingerprint Conflict.

To acknowledge SSH fingerprints in one or more devices:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Select one ormore devices. From theMore or right-clickmenu, selectAcknowledgeDevice Fingerprint.

The Acknowledge Device Fingerprint page appears, displaying the list of devices you selected.
Table 142 on page 336 displays the fields on this page.

3. For each device listed, select the device, click the Edit button, and enter the new fingerprint of the
device in the New Fingerprint field.
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The fingerprint must be a string of 16 octets in hexadecimal format with numbers and lowercase letters
separated by colons.

4. Click OK.

The Confirm Acknowledge page appears asking you to confirm the fingerprint modification.

5. Click Yes.

The Job Details: Acknowledge Device Fingerprint page appears, displaying details of the job. If a
fingerprint entered for a device is in the valid format, then that fingerprint is updated in the Junos Space
database.

6. Click OK to close the Job Details page.

You are returned to the Security Devices page.

Table 142: Acknowledge Device Fingerprint Settings

DescriptionField

Displays the hostname of the device.Hostname

Displays the IPv4 or IPv6 address of the device.IP Address

Displays the authentication status of the device.Authentication Status

If the Authentication Status column displays Fingerprint Conflict, this field displays the
current fingerprint value of the device as stored in the Junos Space database. This field
does not display any value if the Authentication Status column displays Key Conflict –
Unverified; Key Based – Unverified; or Credentials Based – Unverified.

Fingerprint

Displays the new fingerprint value received from the device if the Authentication Status
field displays Fingerprint Conflict. Displays the current fingerprint value of the device as
stored in the Junos Space database if the Authentication Status field displays Key Conflict
– Unverified; Key Based – Unverified; or Credentials Based - Unverified

New Fingerprint
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Viewing Security Device Details

You can view the general details and license details of security devices.

To view the details of a device:

1. Select Devices > Security Devices.

The Security Devices page appears.

2. Right-click a device and select ViewDevice Details from the shortcut menu. Alternatively, mouse over
a device entry and click the Detailed View icon that appears.

The Device Detail page appears.

You can view the device details in the General tab. The fields displayed in the General tab are a subset
of the fields displayed on the SecurityDevices page. See “SecurityDevicesMain Page Fields” on page 337
for details.

You can view the license details such as license name, license validity start date, license expiry date,
status of the license, and whether the license is active. Click Push License to deploy a license on the
device. See “Managing Licenses” on page 423.

3. Click OK.

You are returned to the Security Devices page.

RELATED DOCUMENTATION

Using Features in Security Devices | 214

Security Devices Overview | 217

Security Devices Main Page Fields

Use this page to view the security devices managed by Junos Space. You can perform various actions such
as uploading keys, modifying the device configuration, updating devices, viewing and importing device
changes, viewing the inventory details, and so on. You can filter and sort the devices displayed, and view
the details of each device. Table 143 on page 338 describes the fields on this page.
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Table 143: Security Devices Main Page Fields

DescriptionField

Name of the managed device.

You can view both LSYS and TSYS devices. Click on the link to view the device list.

Device Name

IP address of the device.IP Address

Operating system firmware version running on the device (This field displays Unknown for an
unmanaged device.)

OS Version

DeviceManagement Interface (DMI) schema version that Junos Space uses for the device. (This
field displays Unknown for an unmanaged device.)

Schema Version

Average CPU usage of a device that displays the CPU usage of both a control plane and a
forwarding plane. Starting in Junos Space Security Director Release 16.1, for an SRX Series
chassis cluster, you can view the usage of an individual user’s CPU. Hover over the CPU meter
to view the usage as a percentage.

CPU

Average partition usage of a device. Starting in Junos Space Security Director Release 16.1R1,
for an SRX Series chassis cluster, you can view the usage of an individual user’s partition. Hover
over the storage meter to view the usage as a percentage.

Storage

Authentication status of the device:

• Key Based—The authentication key was successfully uploaded.

• Credential Based—A key uploadwas not attempted; log in to this device with your credentials.

• Key Based - Unverified—The new fingerprint on the device is not updated in the Junos Space
database.

• Key Conflict - Unverified—Key upload was unsuccessful, the new fingerprint on the device
is not updated in the Junos Space database.

• Credentials Based - Unverified—The new fingerprint on the device is not updated in the Junos
Space database.

• Key Conflict—The device was not available; the key upload was unsuccessful.

• Fingerprint Conflict—The fingerprint stored in the Junos Space database differs from the
fingerprint on the device.

• NA—The device is unmanaged.

Authentication
Status
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Table 143: Security Devices Main Page Fields (continued)

DescriptionField

Connection status of the device in Junos Space. Different values are displayed in network as
system of record (SOR) and Junos Space as SOR modes:

• Up—The device is connected to Junos Space. When the connection status is up, in network
as SORmode, the Configuration Status is Out Of Sync, Synchronizing, In Sync, or Sync Failed.
In Junos Space as SOR mode, the status is In Sync, Device Changed, Space Changed, Both
Changed, or Unknown (which usually means connecting).

• Down—The device is not connected to Junos Space. When the Connection status is down,
the Configuration Status is None or Connecting.

• NA—The device is unmanaged.

Connection Status

Type of source from where threat feeds are received.Feed Source

Status of the feed source.Feed Source Status

• In Sync

• SD Changed

• Device Changed

• SD Changed, Device Changed

Managed Status

Model number of the device (For an unmanaged device, the platform details are discovered
through SNMP. If the platform details cannot be discovered, the field displays Unknown.)

Platform

List of the policy names that are assigned and published. Versioning information is included for
firewall and NAT policies.

Pending Services
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Table 143: Security Devices Main Page Fields (continued)

DescriptionField

Current state of the device configuration:

• Connecting—Junos Space has sent a connection remote procedure call (RPC) and is waiting
for the first connection from the device.

• Undefined—The device is in this state only for a short period when Junos Space is set as the
SOR.

• Unknown—This state occurs in the following cases:

• When the device disconnects from Junos Space. The device status remains Unknown until
the device reconnects to Junos Space and the configuration status of the device is checked
against the Junos Space database. It will be in this state until the device connects

• If Junos Space is trying to push or synchronize changes to the device based on theworkflow
for accepting or rejecting out-of-band changes on the device and the push or synchronize
fails.

• In Sync—The synchronization operation has completed successfully; Junos Space and the
device are synchronized.

• None—The device is discovered, but Junos Space has not yet sent a connection RPC.

• Out Of Sync—In network as SOR mode, the device has connected to Junos Space, but the
synchronization operation has not been initiated, or an out-of-band configuration change on
the device was detected and auto-resynchronization is disabled or has not yet started.

• Sync Failed—The synchronization operation failed.

• Synchronizing—The synchronization operation has started as a result of device discovery, a
manual resynchronization operation, or an automatic resynchronization operation.

• Space Changed—In Junos Space as SOR mode, there are changes made to the device
configuration from Junos Space.

• Device Changed—In Junos Space as SOR mode, there are changes made to the device
configuration from the device CLI.

• Space &Device Changed—In Junos Space as SORmode, there are changesmade to the device
configuration from the device CLI and Junos Space. Neither automatic nor manual
resynchronization is available.

• In-RMA—The configuration of the defective device is maintained in Junos Space so that the
device can be reconnected and managed when it is replaced.

• Reactivating—The defective device has been replaced and the reactivation of the replacement
device to bring it back under management has started.

• Reactivate Failed—The operation to reactivate the device has failed.

• Unmanaged—The device is unmanaged.

• Waiting for deployment—The modeled device is unreachable and needs to be activated.

• Modeled—The device is modeled.

Configuration
Status
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Table 143: Security Devices Main Page Fields (continued)

DescriptionField

Average RAM usage of a device that displays the RAM usage of both a control plane and a
forwarding plane. Starting in Junos Space Security Director Release 16.1R1, for an SRX Series
chassis cluster, you can view the usage of an individual user’s RAM. Hover over the RAMmeter
to view the usage as a percentage.

RAM

Device family of the selected device. (For an unmanaged device, this is the same as the vendor
name provided. The field displays Unknown if no vendor name was provided and if SNMP is
not used or has failed.)

Device Family

Serial number of the device chassis (This field displays Unknown for an unmanaged device.)Serial Number

List of all assigned services: firewall, NAT, IPS, and VPN. When a device is assigned to any
firewall policy including NAT, IPS and VPN, the policy name is displayed.

Assigned Services

List of the policy names that are published and updated to the device (this includes policy names
for firewall, NAT, IPS, and VPN). Versioning information is included for firewall and NAT policies.

Installed Services

• Up

• Down

Fab Link Status

• Up

• Down

Control Link Status

Domain to which the device belongs.Domain

Date and time when the device was last rebooted manually (that is, the device status changes
from Down to Up) or from Junos Space.

Last Rebooted
Time

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.1, for an SRX Series chassis cluster, you
can view the usage of an individual user’s CPU.

16.1

Starting in Junos Space Security Director Release 16.1R1, for an SRX Series chassis cluster, you
can view the usage of an individual user’s partition.

16.1

Starting in Junos Space Security Director Release 16.1R1, for an SRX Series chassis cluster, you
can view the usage of an individual user’s RAM.

16.1
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CHAPTER 40

Device Discovery

IN THIS CHAPTER
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Editing, Cloning, and Deleting Device Discovery Profiles in Security Director | 347

Running a Device Discovery Profile in Security Director | 349

Viewing the Device Discovery Profile Details in Security Director | 350

Device Discovery Main Page Fields | 352

Overview of Device Discovery in Security Director

You use the device discovery feature to add devices to Junos Space. Device discovery is the process of
finding a device and then synchronizing the device inventory and configuration with the Junos Space
database. To use device discovery, Junos Space must be connected to the device.

You discover devices in Junos Space Security Director by creating and using a device discovery profile. A
device discovery profile contains information about discovery targets, probes used to discover devices,
credentials for authentication, and device SSH fingerprints, and is used to discover, authenticate, and
connect to the device.

During discovery, Junos Space connects to the physical device and retrieves the running configuration
and the status information of the device. To connect with and configure devices, Junos Space uses the
Juniper Networks Device Management Interface (DMI), which is an extension of the NETCONF network
configuration protocol.

To discover network devices, Junos Space uses SSH, and (optionally) ping, and SNMP protocols.

NOTE: Starting in Junos Space Security Director Release 16.2, Security Director discovers both
SRX Series devices and MX Series routers.
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Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.2, Security Director discovers both
SRX Series devices and MX Series routers.

16.2

RELATED DOCUMENTATION
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Creating Device Discovery Profiles in Security Director

Use this page to configure a device discovery profile that you can use to discover devices.

Device discovery is the process of finding a device and then synchronizing the device inventory and
configurationwith the Junos Space database. To use device discovery, Junos Spacemust be able to connect
to the device.

Before You Begin

• Read the “Overview of Device Discovery in Security Director” on page 343 topic.

• Review the Discovery Profiles main page to view the existing discovery profiles. See “Device Discovery
Main Page Fields” on page 352 for field descriptions.

To configure a device discovery profile:

1. Select Devices > Device Discovery.

The Device Discovery page appears.

2. Click the + icon.

The Create Discovery Profile page appears.

3. Complete the configuration according to the guidelines provided in Table 144 on page 345.

NOTE: Fields marked with * are mandatory
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4. Click OK.

A new device discovery profile is created and you are returned to the Device Discovery page. A Job
Details page pops up after a few seconds and displays the details of the job scheduled.

5. Click OK to close the Job Details page.

Table 144: Discovery Profile Settings

DescriptionSetting

Add Device Discovery Target

Enter a unique string containing only alphanumeric characters, spaces, and some
special characters (- _ .). The name cannot start with a space and the maximum length
is 32 characters.

Discovery Profile Name

Specify whether the discovery parameters are entered manually or by using a
comma-separated values (CSV) file.

Discovery Parameters

Select one of the options to specify the device targets, based on whether you want
to discover a single device or multiple devices.

Target Type

Select either IP address or hostname for the target type.

If the target type is IP address, then enter the IPv4 or IPv6 address of the device that
you want to discover based on the IP mode enabled in Junos Space Network
Management Platform.

If the target type is hostname, then enter the hostname of the device that you want
to discover.

Click Next to continue.

Target Details

Enter the starting IPv4 or IPv6 address of the range of IP addresses for the devices
that you want to discover.

Start IP Address

Enter the ending IPv4 or IPv6 address of the range of IP addresses for the devices
that you want to discover.

NOTE: The maximum number of IP addresses for any target type is 1024.

Click Next to continue.

End IP Address

Enter the IPv4 or IPv6 address or the IP address and prefix of the subnet to which the
devices that you want to discover belong.

IP Subnet
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Table 144: Discovery Profile Settings (continued)

DescriptionSetting

Enter the subnet mask of the subnet to which the devices that you want to discover
belong. If you enter a prefix in the preceding field, this field displays the subnet mask
calculated based on the prefix.

Click Next to continue.

Subnet

Specify Probes

Select this check box to use ping during the device discovery process. If you select
this check box, you must configure devices to respond to ping requests.

Use Ping

Select this check box to use SNMP during the device discovery process. If you select
this check box, you must configure SNMP on the devices being discovered.

Click Back to return to the previous section or Next to continue.

Use SNMP

Select the SNMP version (V1/V2C, or V3).SNMP Version

For SNMP V1 or V2C, specify the SNMP community string.

Click Back to return to the previous section or Next to continue.

Community

For SNMP V3, specify the username used for authentication.Username

For SNMP V3, specify the type of authentication used (MD5, SHA1, or None).Authentication Type

For MD5 or SHA1 as the authentication type, specify the authentication password to
be used.

Authenticated Password

For SNMP V3, specify the type of privacy to be used (AES128, DES, or None).Privacy Type

For AES128 or DES as the privacy type, specify the privacy password to be used.

Click Back to return to the previous section or Next to continue.

Privacy Password

Specify Credentials

Specify whether you want to use credential-based or key-based authentication.Authentication Type

Specify the username for credential-based or key-based authentication.

Click Back to return to the previous section or Next to continue.

Username
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Table 144: Discovery Profile Settings (continued)

DescriptionSetting

For credential-based authentication, specify the password for logging in to the device.Password

For credential-based authentication, reenter the password for confirmation.

Click Back to return to the previous section or Next to continue.

Confirm Password

Specify Device Fingerprint

Specify the device fingerprint for each device target. The fingerprint must be a string
of 16 octets in hexadecimal format with numbers and lowercase letters separated by
colons. This is an optional step.

Click Back to return to the previous section or Next to continue.

Specify Device Fingerprint

Schedule Discovery Job

Specify whether you want to run the device discovery job immediately or schedule it
for a later date and time.

Type

Select this check box if you want the device discovery job to recur and specify the
details of the recurrence.

Recurrence

Select this check box if you want to import and publish policies into the Junos Space
database after the devices are discovered and managed by Junos Space.

Click Back to return to the previous section or Finish to go to a summary page.

Import policies automatically
after device(s) being
discovered successfully
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Editing, Cloning, andDeletingDeviceDiscovery Profiles in SecurityDirector

You can edit, clone, and delete discovery profiles from the Device Discovery page. You clone a device
discovery profile to easily create a new discovery profile. You delete discovery profiles that are not used.
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Editing Device Discovery Profiles

To edit a device discovery profile:

1. Select Devices > Device Discovery.

The Device Discovery page appears.

2. Select the discovery profile that you want to edit, and click the pencil icon.

The Edit Discovery Profile page appears, showing the same fields that are presented when you create
a discovery profile.

3. Edit the discovery profile fields as needed.

NOTE: Some fields cannot be edited.

4. Click OK to save the changes.

The changes are saved and you are returned to the Device Discovery page. A Job Details page pops
up after a few seconds and displays the details of the job scheduled.

5. Click OK to close the Job Details page.

Cloning Device Discovery Profile

To clone a device discovery profile:

1. Select Devices > Device Discovery.

The Device Discovery page appears.

2. Select the discovery profile that you want to clone, and click the Clone button or select Clone from
the More or right-click menu.

The CloneDiscovery Profile page appears, showing the same fields that are presentedwhen you create
a discovery profile.

3. Modify the discovery profile fields as needed.

4. Click OK to save the changes.
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The cloned discovery profile is created and you are returned to the Device Discovery page. A message
indicating that the device discovery profile was cloned is displayed at the top of the page. A Job Details
page pops up after a few seconds and displays the details of the job scheduled.

5. Click OK to close the Job Details page.

You are returned to the Device Discovery page

Deleting Device Discovery Profiles

To delete one or more device discovery profiles:

1. Select Devices > Device Discovery.

The Device Discovery page appears.

2. Select the device discovery profiles that you want to delete, and click the X icon.

A warning dialog box appears asking you to confirm the deletion.

3. Click Yes to delete the selected device discovery profiles.

The device discovery profiles are deleted and you are returned to the Device Discovery page.
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Running a Device Discovery Profile in Security Director

In the Device Discovery page, you can run a device discovery profile immediately in order to discover
devices.

If you previously created a device discovery profile that was scheduled to run later and you now want to
run the discovery profile immediately, this feature enables you to do so without modifying the profile.

To run a device discovery profile immediately:

1. Select Devices > Device Discovery.

349



The Device Discovery page appears.

2. Select the device discovery profile and click the Run Now button.

A device discovery job is triggered. After a few seconds, the Job Details page appears displaying
information on the job.

3. Click OK to close the Job Details page.

You are returned to the Device Discovery page.

RELATED DOCUMENTATION
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Viewing the Device Discovery Profile Details in Security Director

You can view the details of device discovery profiles, which allows you to view information about a device
discovery profile at a quick glance on one page, from the Device Discovery page.

To configure a device discovery profile:

1. Select Devices > Device Discovery.

The Device Discovery page appears.

2. Double-click the discovery profile for which you want to view the details. Alternatively, select the
discovery profile and from the More or right-click menu, select View.

The View Discovery Profile page appears. Table 145 on page 350 describes the fields on this page.

3. Click OK.

You are returned to the Device Discovery page

Table 145: View Discovery Profile Page Fields

DescriptionField

Device Target

Name of the device discovery profileDiscovery Profile Name
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Table 145: View Discovery Profile Page Fields (continued)

DescriptionField

Indicates the type of target used to discover devices (IP address, IP address range,
IP subnet, hostname, or imported from a comma-separated values (CSV) file).

Target Type

Indicates the value of the specified target type. For example, if the target type
is IP range, then the IP address range is displayed.

Target Details

Probes

Indicates whether ping is enabled for device discovery or not.Use Ping

Indicates whether SNMP is enabled for device discovery or not.Use SNMP

If SNMP is enabled, indicates the version of SNMP used for device discovery.SNMP Version

Displays the community string used for SNMPv1 and SNMPv2c.Community

For SNMPv3, indicates the username of the user that is used for authentication
on the device.

Username

Indicates the type of privacy used for SNMPv3.Privacy Type

Indicates whether key-based authentication is used or not.Key-Based

Credentials

Indicates whether the authentication is credential-based or key-based.Authentication Type

Displays the username for credential-based or key-based authentication.Username

Fingerprints

Displays the hostname or IP address of the device.Hostname/IP

Displays the fingerprint for the device.Fingerprint
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Device Discovery Main Page Fields

Use this page to view, create, edit, clone, and delete device discovery profiles. You can filter and sort the
device discovery profiles displayed, and view details of each device discovery profile.Table 146 on page 352
describes the fields on this page.

Table 146: Device Discovery Main Page Fields

DescriptionField

Name of the device discovery profileDevice Discovery Profile

Indicates the type of target used to discover devices (IP address, IP address range,
IP subnet, hostname, or imported from a comma-separated values (CSV) file).

Target Type

Indicates the value of the specified target type. For example, if the target type is IP
range, then the IP address range is displayed.

Target Details

Indicates the version of the SNMP probes used.Probes

Indicates the username of the user that is used for authentication on the device.Username

Indicates whether key-based authentication is used or not.Key-Based

Indicates the date and time at which the device discovery profile is scheduled to run.Schedule

If the recurrence is configured for the device discovery profile, this field displays the
recurrence details.

Recurrence
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CHAPTER 41

Secure Fabric

IN THIS CHAPTER
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Creating Secure Fabric and Sites

You can create sites within your secure fabric from the secure fabric page.

Before You Begin

• Plan out your sites in advance. A site is a grouping of network devices, including firewalls and switches,
that contribute to threat prevention.

• Keep in mind that when you create a site, you must identify the perimeter firewalls so you can enroll
them with Juniper ATP Cloud/JATP.

• If you want to enforce an infected host policy within the network, you must assign a switch to the site.

• SRX Series devices cannot belong to multiple sites.

• MX Series devices associated with tenants can belong to multiple sites.

• Sites that are associated with tenants do not need switches as enforcement points.

• Switches and connectors cannot be added to the same site.
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To create a site within your secure fabric:

1. Select Devices>Secure Fabric.

2. Click the + icon.

3. Complete the configuration by using the guidelines in Table 147 on page 354 below.

4. Click OK.

5. Create a new site and add an enforcement point to a site.

Table 147: Create Site Page Fields

DescriptionField

Enter a unique string that must begin with an alphanumeric character and can include
underscores; no spaces allowed; 63-characters maximum.

Site

Select a tenant.Tenant

Enter a description;maximum length is 1024 characters. You shouldmake this description
as useful as possible for all administrators.

Description

WARNING: If you add certain SRX SeriesDevices to your Secure Fabric as enforcement
points, you may see a warning that the device(s) must be reconfigured in enhanced
mode and require a reboot. Here is a list of SRX models that may require rebooting
for enhanced mode after being registered with Policy Enforcer/Juniper ATP
Cloud/JATP.

• SRX340

• SRX345

• SRX650

• SRX240h2

• SRX320

• SRX300

• SRX550
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Secure Fabric Overview

Secure Fabric is a collection of sites which contain network devices (switches, routers, firewalls, and other
security devices), used in policy enforcement groups.When threat prevention policies are applied to policy
enforcement groups, the system automatically discovers to which sites those groups belong. This is how
threat prevention is aggregated across your secure fabric.

• Add Enforcement Points—Click the Add Enforcement Points link to add Firewalls, Switches, and/or
Connectors. There is a one-to-one mapping between devices with sites. If a device is mapped to a site,
you cannot use the same device to map to a different site. The connector can be mapped to multiple
sites. To filter by type, click the three vertical dots beside the search field and select the check box for
the device type. See “Creating Secure Fabric and Sites” on page 353 for more information.

• Drag and Drop Enforcement Points—From the main page, you can select enforcement points and drag
them to other sites to include them there. When you drag, the enforcement point is disenrolled from
the current site and gets enrolled to the new site where the enforcement point is dropped.

You can either have switches or a connector as enforcement points and not both. However, you can
drag a switch and add to a site that already has a switch or SRX Series device.

Table 148 on page 355 shows fields on the Secure Fabric page.

Table 148: Secure Fabric Page Fields

DescriptionField

Specifies the name of the secure fabric site.Site

Specifies the name of the secure fabric tenant.Tenant
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Table 148: Secure Fabric Page Fields (continued)

DescriptionField

Specifies the enforcement points for that particular site, if enforcement points are already
added. If not added, click Add Enforcement Points to add Firewalls, Switches, or Connectors
as enforcement points.

A firewall icon is shown against some of the devices to indicate that they are the perimeter
firewalls.

For connectors, if you hover over the enforcement point, a tool tip is shown listing the
corresponding vSRX devices with IP addresses and descriptions.

NOTE: If tenant is configured to the site, onlyMX Series device can be added as enforcement
points.

Enforcement Points

Specifies the IP address of the enforcement point, if the enforecement point is available.IP

Specifies the type of the enforcement point. For example, vSRX, QFX, Connector.Model

Specifies the feed source to Policy Enforcer.Feed Source

Specifies the status of the Juniper ATP Cloud enrollment.

The Success status with a warning symbol indicates that the device is enabled for cloud feeds
only and there is no support for malware capability and enhanced mode. This field will be
blank if the device fails to disenroll Juniper ATP Cloud.

If the status is Failed, click Retry to enroll the device with Juniper ATP Cloud again. You can
hover over the Failed status to see the corresponding job details. The device enroll retry
option is available only when the status is Failed.

ATP Cloud Enroll
Status

Specifies the date on which the Secure Fabric page was last updated.Last Updated

Specifies the description that you had entered at the time of creating a secure fabric site.Description
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Adding Enforcement Points

Use the Add Enforcement Points page to assign devices to a site and indicate which devices are perimeter
firewalls. To enroll a device with Juniper ATP Cloud/JATP, youmust assign one or more perimeter firewalls
to each site.

NOTE:
• When a connector instance is assigned to a site, that particular connector instance will not be
listed as available enforcement point for other sites.

• If you want to enforce an infected host policy within the network, you must assign a switch
to the site.

• Assigning a device to the site will cause a change in the device configuration.

To add firewalls, switches, or connectors as an enforcement point:

1. Select Devices>Secure Fabric.

The Secure Fabric page appears.

2. Select the required site for which you want to add enforcement points, and click Add Enforcement
Points.

The Add Enforcement Points page appears.

3. Complete the configuration as shown in Table 149 on page 358.

4. Click OK.
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Table 149: Fields on the Add Enforcement Points Page

DescriptionField

All device types are displayed in the list. To filter by type, click the four vertical dots beside the search
field and select the check box for the device type.

To include a device, select the check box beside the device in the Unassigned Devices list and click
the > icon to move them to the Selected list. The devices in the Selected list will be included in the
site.

There is a one-to-one mapping between SRX Series devices and connectors with sites. If a device or
a connector is mapped to a site, you cannot use the same device or a connector to map to a different
site.

NOTE: Firewall devices are automatically enrolled with Juniper ATP Cloud/JATP as part of this step.
Nomanual enrollment is required. The exceptions are “no selection” mode and Cloud Feeds only mode
where Juniper ATP Cloud/JATP is not available and therefore no enrollment takes place. (see “Juniper
ATP Cloud Configuration Type Overview” on page 1113)

The name of the connector type is shown as a tool tip when you hover over the name.

NOTE: If a site is associated with a tenant, only MX Series devices are listed. Only those MX Series
devices are listed that have the VRF associated with the tenant that the site is associated with.

Enforcement
points
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Table 149: Fields on the Add Enforcement Points Page (continued)

DescriptionField

Select the edge firewall devices connecting the network to the internet. These devices will receive
the threat feeds. Only firewall (SRX, vSRX) or router devices (MX) that you choose in the Enforcement
Points field appear in the Perimeter Device field. You can have SRX Series and MX Series devices in
the same site and select both as perimeter devices.

You must configure MX Series router as a perimeter device to download Command & Control (C&C),
allowlist, blocklist from Policy Enforcer. In the Juniper ATP Cloud/JATP with Juniper Connected
Security mode, if you choose a MX Series router as a perimeter firewall device, the MX Series router
is not enrolled to Juniper ATP Cloud/JATP. The Policy Enforcer URL is configured to the device and
this enables the device to request and receive feeds from Policy Enforcer.

NOTE: The policies to take action based on the feed are not configured in Policy Enforcer. The policies
have to be manually configured on the MX Series device.

Among the listed devices, you can choose which device to consider as a perimeter firewall. Only the
perimeter firewall devices are enrolled to Juniper ATP Cloud/JATP. If you do not choose any firewall
device as a perimeter firewall, all firewall devices listed in this field are enrolled to Juniper ATP
Cloud/JATP as perimeter firewalls by default.

You can delete devices manually from the field. However, all the firewall devices are still available in
the list to include later. To remove firewall devices permanently from list, you must move the firewall
devices from the Selected column to the Available column in the Enforcement points field.

In any Juniper ATP Cloud/JATP configuration types, if there is a firewall device assigned to a site, it
is mandatory to assign one of those devices as a perimeter firewall. If there are no firewall devices
assigned to a site, the perimeter firewall list will be empty.

When you enroll a connector instance to Policy Enforcer, the connector instance provides few vSRX
Series devices. These vSRX devices are discovered by Policy Enforcer in Junos Space. Hover over the
connector instances appearing in the Secure Fabric page to view the details of the corresponding
vSRX devices. The vSRX Series devices associated with a connector are not shown in the Perimeter
Firewall field. However, they are considered as perimeter firewalls.

NOTE: If a branch SRX Series device is added and selected as a perimeter firewall, system reboots
and a warning message is shown before rebooting the system.

Perimeter
Device
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Editing or Deleting a Secure Fabric

You can edit or delete a secure fabric from the secure fabric main page.

To edit or delete a secure fabric:

1. Select Devices > Secure Fabric.

The secure fabric page appears.

2. Select the secure fabric you want to edit or delete and then right-click.

• Select Edit to modify your secure fabric. The secure fabric configuration page appears. Make the
changes and click OK.

• Select Delete to remove your secure fabric. An alert message appears verifying that you want to
delete your selection. Click Yes to delete your selection.
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Logical System and Virtual Routing and Forwarding Instance Overview

Starting in Policy Enforcer Release 20.1R1, you can create a tenant representing an enterprise and you
can assign a Virtual Routing and Forwarding (VRF) instance to a tenant. The custom feed sends feeds to
Policy Enforcer at the logical system (LSYS) and VRF instance levels on the MX Series device. The VRF
instance is dedicated to handling traffic within the tenant's private network. You can route the traffic on
the tenant’s private network from the VRF instance on the MX Series device at one site to the same VRF
instance on another MX Series device at a different site. The MX Series device supports multiple VRF
instances assigned to different tenants. Therefore, a device can be shared with multiple tenants.

NOTE: In Policy Enforcer Release 20.1R1, onlyMXSeries devices support LSYS andVRF instance.
Also, only root logical system is supported. All the sites of a realm are either with tenants or
without tenants.

When a tenant is created, a VRF instance is assigned to the tenant. When a site is associated with the
tenant, only those devices that have the VRF instance associated with the tenant can be added to the site.
When you associate a sitewith a realm in Juniper ATPCloud/JATP, the tenant receives the feeds configured
for the realm. TheMXSeries device performs policy enforcement based on tenant system and the associated
Juniper ATP Cloud/JATP realm.

On an MX Series device, VRF instance based feeds such as C&C, allowlist, and blocklist are supported
through custom feeds as shown in Figure 27 on page 362.

NOTE: If you want to use the C&C global feed from ATP Cloud/JATP, then custom feed for
C&C should not be configured in Policy Enforcer.

For, example: VRFx and VRFy are associated with tenants on MX device 1. Custom feed for tenant 1
(VRFx) and custom feed for tenant 2 (VRFy) are associated to each tenant. The custom feed provides LSYS
and VRF instance information. When the device requests for a feed, Policy Enforcer provides all the feed
data associated with the device (global without VRF instance information) in addition to all the data for
the VRF instances configured on the device that are associated with the tenants configured on Policy
Enforcer.
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Figure 27: LSYS and VRF Instance Support
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About the Secure Fabric Tenants Page

To access this page, click Devices > Secure Fabric > Tenants.

Starting in Policy Enforcer Release 20.1R1, you can create a tenant representing an enterprise. When a
tenant is created, a VRF instance is assigned to the tenant.

Tasks You Can Perform

You can perform the following tasks from this page:

• Create a tenant. See “Create Secure Fabric Tenants” on page 364.

You can also modify and delete a tenant.

Field Descriptions

Table 150 on page 363 provides guidelines on using the fields on the Secure Fabric Tenants page.

Table 150: Fields on the Secure Fabric Tenants Page

DescriptionField

Specifies the name of the tenant.Tenant

Specifies the root logical system.LDOM

Specifies the VRF created on the MX Series device.VRF

Specifies the name of the sites.Sites
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Create Secure Fabric Tenants

To create a tenant within your secure fabric:

1. Select Devices > Secure Fabric > Tenants.

2. Click the + icon.

3. Complete the configuration using the guidelines in Table 151 on page 364.

4. Click OK.

A tenant is created. After the tenant is created, it can be associated to a site.

Table 151: Create Tenant

GuidelinesField

Enter a unique string thatmust beginwith an alphanumeric character and can include
underscores; no spaces allowed; 63-character maximum.

Name

By default, the root logical system is selected, which you cannot edit. In Policy
Enforcer Release 20.1R1, only root logical system is supported.

LDOM

Enter the virtual routing and forwarding (VRF) instance name, which is created on
the MX Series device.

VRF

To edit a tenant, select a tenant and click the pencil icon.

To delete a tenant, select the delete icon. If a tenant is associated to a site, the tenant cannot be deleted.
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This section presents an overview of how Juniper Networks vSRX Virtual Services Gateway integrates in
the VMware NSX environment as an advanced security service with Junos Space Security Director as its
security manager.

VMware NSX Overview

VMware NSX is VMware’s network virtualization platform for the software-defined data center (SDDC).
Similar in concept to server virtualization, network virtualization decouples network functions from physical
devices. With VMware NSX, existing networks are immediately ready to deploy a software-defined data
center. This enables data center operators to create, provision, and manage their networks with greater
agility and operational efficiency. VMware NSX is completely managed by the VMware vCenter Server
through the VMware vSphere Web Client.

The VMware NSX network virtualization platform is security orientated. The NSX Distributed Firewall
(DFW) on all ESXi hosts to provide a set of kernel-based Layer 2 (L2) through Layer 4 (L4) stateful firewall
features inside the ESXi hypervisor to deliver segmentation within each virtual network. Every virtual
machine (VM) running in a VMware NSX environment can be protected with a full stateful firewall at a
granular level. DFW operates at the vNIC of each individual VM.

VMware NSX, however, does not provide advanced L4 through L7 security services which are critical to
provide complete protection in a SDDCenvironment. Environments that require advanced, application-level
network security capabilities can leverage VMware NSX to distribute, enable, and enforce advanced
network security services in a virtualized network context.

You can add the vSRX Virtual Services Gateway as a partner security service in the VMware NSX
environment. The vSRX security service is managed by the Junos Space Security Director and VMware
NSX Manager to deliver a complete and integrated virtual security solution for your SDDC environment.
The vSRX provides advanced security services, including intrusion detection and prevention (IDP), and
application control and visibility services through AppSecure.

DFW implements a stateful traffic steering mechanism that identifies what traffic should be sent to the
vSRX VM. The protected VMs and the security service vSRX VM run on the same physical ESXi host.

vSRX Integration with NSX Manager and Junos Space Security Director

To deploy the advanced security features of the vSRX Virtual Services Gateway in the VMware NSX
environment, the Junos Space Security Director, vSRX, and NSX Manager operate together as a joint
solution to fully automate the provisioning and deployment of the vSRX to protect applications and data
from advanced cyberattacks.

Integration of the vSRXVM in the VMwareNSX environment involves usewith the followingmanagement
software:

• Junos Space Security Director—The centralized security management platform responsible for service
registration and configuration of each vSRX instance. The Security Director provides youwith the ability
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to manage a distributed network of virtualized and physical firewalls from a single location. The Security
Director functions as the management interface between the NSX Manager and the vSRX Services
Gateway. Security Director manages the firewall policies on all vSRX instances.

• NSX Manager—The centralized network management component of VMware NSX. The NSX Manager
provides integration with the VMware vCenter Server, which enables you to manage the VMware NSX
environment through VMware vCenter. All VMware NSX operations and configuration is done through
VMware vCenter, which communicates with the NSXManager through Representational State Transfer
(REST) APIs to delegate tasks to the responsible owner. The NSX Manager is always associated with a
VMware vCenter Server.

The NSX Manager is added as a registered device in the Security Director and communication is
bidirectionally synchronized by the Junos Space Policy Enforcer between the twomanagement platforms.
All shared objects (such as security groups) are synchronized between the NSX Manager and Security
Director. This includes the IP addresses of all VMs in ESXi hosts, including the vSRX agent VMs. The
Security Director creates an address group for each security group synchronized from the NSX Manager,
along with the addresses of each member of the security group. The security groups discovered from the
NSXManager are mapped to dynamic address groups (DAG) in the Security Director. The Policy Enforcer
retains the mapping of all IP addresses between security groups and dynamic address groups.

The vSRX Services Gateway is deployed as a partner service appliance in the VMware NSX environment.
vSRX agent VMs are deployed for each ESXi host in a cluster. You use security policies to direct all VM
traffic in an ESXi host through the vSRX VM (the Juniper security service) for L4 through L7 advanced
security analysis.

High-Level Workflow

Figure 28 on page 368 provides a high-level workflow of how the NSX Manager, Security Director, and
vSRX interact to deploy vSRX as a security service in the VMware NSX environment.
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Figure 28: vSRX, Security Director, and VMware NSX Integration Workflow
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1. The Junos Space SecurityDirector initiates communicationwith theNSXManager. The SecurityDirector
discovers, registers, and adds the NSX Manager as a device in its database. The Security Director also
deploys the vSRX instance from the .ovf file and registers it as a security service. The NSX Manager
and its inventory of shared objects (for example, security groups) and addresses are then synchronized
with the Security Director. The registration process uses the Policy Enforcer to enable bidirectional
communication between the Security Director and the NSX Manager.

2. The NSX Manager deploys the registered vSRX instance as a Juniper security service for each ESXi
host in a vSphere cluster. The deployment is based on the vSRX .ovf file. Whenever an ESXi host is
added to a vSphere cluster, NSX Manager creates a vSRX agent VM in the new ESXi host. The same
process occurs if an ESXi host is removed from a vSphere cluster.

3. After the vSRX agent VM is provisioned as a security service on each ESXi host in a vSphere cluster,
NSXManager notifies Security Director by using REST API callbacks. The Security Director pushes the
initial boot configurations and Junos OS configuration policies to each vSRX agent VM to support the
NSX security group. The Security Director is aware of the NSX security groups and corresponding
address groups, and all deployed vSRX agent VMs are automatically discovered (one per ESXi host).

Security policies redirect relevant network traffic originating from the VMs in a specific security group
in the ESXi hosts in a vSphere cluster to the Juniper security service vSRX agent VM in each ESXi host
for further analysis.
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4. The vCenter Server and the NSXManager continue to send real-time updates on changes in the virtual
environment to Security Director.

5. The Security Director dynamically synchronizes the object database to all vSRX agent VMs deployed
in ESXi clusters. Security groups discovered fromNSXManager aremapped to a dynamic address group
(DAG) in Security Director. The Security Director manages the firewall policies on the vSRX agent VMs.
Using the Security Director, you create advanced security service policies (for example, an application
firewall policy or an IPS policy) and push those policies to each vSRX agent VM in an ESXi host.

RELATED DOCUMENTATION

NSX

VMware NSX Data Sheet

Junos Space Security Director

vSRX

Understanding Juniper Connected Security for VMwareNSX-T Integration

IN THIS SECTION

VMware NSX-T Overview | 369

vSRX Integration with NSX-T Manager and Junos Space Security Director | 370

High-Level Workflow | 371

This section presents an overview of how Juniper Networks vSRX Virtual Services Gateway integrates in
the VMware NSX-T environment as an advanced security service with Junos Space Security Director as
its security manager.

VMware NSX-T Overview

VMwareNSX-T is VMware’s network virtualization platform for the SoftwareDefinedData Center (SDDC).
Like server virtualization, network virtualization de-couples the network functions from the physical devices.
VMwareNSX-T is designed to address application frameworks and architectures that have heterogeneous
endpoints and technology stacks. VMware NSX-T is not directly coupled with vShpere and therefore it
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supports various Hypervisors, Containers, BareMetal, and public clouds such as AmazonWeb Service and
Azure.With VMwareNSX-T, you can design hybrid cloud for organizationswhere critical data and services
are hosted within private cloud and web services or high availability application in Public clouds.

VMware NSX-T is the latest generation of VMware’s network virtualization product series. NSX-T is the
successor to NSX-V. NSX-T supports third-party Hypervisors and next generation overlay encapsulation
protocols such as Generic Network Virtualization Encapsulation (Geneve). NSX-T acts as a network
Hypervisor that allows software abstraction of various network services that include logical switch
(segments), logical routers (Tier-0 or Tier-1 Gateway), logical firewalls, logical load balancers, and logical
VPNs.

VMware NSX-T provides L2-L4 stateful firewall features, network segmentations, multi tenancy support,
L2/L3 VPN, load balancer, DHCP, source/destination NAT and many more services at Edge Gateway.
VMware NSX-T provides framework to integrate the advanced security services as North-South at Edge
Gateway.

Each virtual machine running in NSX-T environment can be protected with a full stateful firewall engine
at a very granular level policy. Such policies can be application specific including services. vSRX runs as a
service virtual machine and provides advanced services such as L4 to L7 services.

To deploy the advanced security features of the vSRX Virtual Services Gateway in the VMware NSX-T
environment, the Junos Space Security Director, vSRX, andNSX-TManager operate together as a solution
to fully automate the provisioning and deployment of the vSRX to protect applications and data from
advanced cyberattacks.

vSRX Integration with NSX-T Manager and Junos Space Security Director

To deploy the advanced security features of the vSRX Virtual Services Gateway in the VMware NSX-T
environment, the Junos Space Security Director, vSRX, and NSX-T Manager operate together as a joint
solution to fully automate the provisioning and deployment of the vSRX to protect applications and data
from advanced cyberattacks.

Integration of the vSRXVM in theVMwareNSX-T environment involves usewith the followingmanagement
software:

• Junos Space Security Director—The centralized security management platform responsible for service
registration and configuration of each vSRX instance. The Security Director provides youwith the ability
to manage a distributed network of virtualized and physical firewalls from a single location. The Security
Director functions as the management interface between the NSX-T Manager and the vSRX Services
Gateway. Security Director manages the firewall policies on all vSRX instances.

• NSX-T Manager—The centralized network management component of VMware NSX.

The NSX-T Manager is added as a registered device in the Security Director and communication is
bidirectionally synchronized by the Junos Space Policy Enforcer between the twomanagement platforms.
All shared objects (such as security groups) are synchronized between the NSX-T Manager and Security

370



Director. This includes the IP addresses of all VMs, including the vSRX agent VMs. Security Director creates
an address group for each security group synchronized from theNSX-TManager, alongwith the addresses
of each member of the security group. The security groups discovered from the NSX-T Manager are
mapped to dynamic address groups (DAG) in Security Director. Policy Enforcer retains the mapping of all
IP addresses between security groups and dynamic address groups.

The vSRX Services Gateway is deployed as a partner service appliance in the VMwareNSX-T environment.
Use the security policies to direct all VM traffic through the vSRX VM for L4 through L7 advanced security
analysis.

High-Level Workflow

Figure 29 on page 371 provides a high-level workflow of how the NSX-T Manager, Security Director, and
vSRX interact to deploy vSRX as a security service in the VMware NSX-T environment.

Figure 29: vSRX, Security Director, and VMware NSX-T Integration Workflow

g3
01

44
5

NSX-T Manager
Security Director/

Policy Enforcer

OVF

1

2 3

4

NSX Edge Cluster

vSRX

1. The Junos Space Security Director initiates communication with the NSX-T Manager. The Security
Director discovers, registers, and adds the NSX-T Manager as a device in its database. The Security
Director also deploys the vSRX instance from the .ovf file and registers it as a security service. The
NSX-T Manager and its inventory of shared objects (for example, security groups) and addresses are
then synchronized with the Security Director. The registration process uses Policy Enforcer to enable
bidirectional communication between Security Director and the NSX-T Manager.

2. The NSX-T Manager deploys the registered vSRX instance as a Juniper security service to the NSX
Edge Cluster. The deployment is based on the vSRX .ovf file.
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3. After the vSRX agent VM is provisioned as a security service, NSX-TManager notifies Security Director
by using REST API callbacks. Security Director pushes the initial boot configurations and Junos OS
configuration policies to each vSRX agent VM to support the NSX-T security group. Security Director
is aware of the NSX-T security groups and corresponding address groups, and all deployed vSRX agent
VMs are automatically discovered.

Security policies redirect relevant network traffic originating from the VMs in a specific security group
to the Juniper security service vSRX agent VM for further analysis.

The Security Director dynamically synchronizes the object database to all vSRX agent VMs deployed
inNSX Edge Cluster. Security groups discovered fromNSX-TManager aremapped to a dynamic address
group (DAG) in Security Director. The Security Director manages the firewall policies on the vSRX agent
VMs. Using Security Director, you create advanced security service policies (for example, an application
firewall policy or an IPS policy) and then push those policies.

4. The NSX-T Manager continue to send real-time updates on changes in the virtual environment to
Security Director.

RELATED DOCUMENTATION

VMware NSX-T Data Sheet

Junos Space Security Director

vSRX

Before You Deploy vSRX in VMware NSX Environment

Before you begin deploying the vSRXVirtual Services Gateway as an advanced security service in VMware
NSX:

• Download the .ovf file of the vSRX software image from Juniper Networks website and save it to the
Policy Enforcer. The vSRX OVF URL automatically appears in the Register Security Service page of the
Security Director when you register the vSRX virtual machine (VM) as a Juniper security service on the
NSX Manager.

• Obtain the Juniper SDSN for NSX license key (see Juniper SDSN for VMware NSX Licensing).

• Install two or more VMware ESXi hosts. See the VMware documentation for details.

• Install the VMware vCenter Server on aWindows VMor physical server, or deploy the VMware vCenter
Server Appliance. Connect to the vCenter Server from the vSphere Web Client. See the VMware
documentation for details.
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• Create a vSphere distributed switch (VDS) in the vSphere environment, add each ESXi host to a common
VDS, and then configure the ESXi hosts in a vSphere cluster. For each host cluster that will participate
in NSX, all hosts within the cluster must be attached to a common VDS. See the VMware documentation
for details.

• Deploy VMs on each ESXi host by using the vSphere Web Client. See the VMware documentation for
details.

• Install the VMware NSXManager in your vCenter Server environment by using the vSphereWeb Client.
TheNSXManager is the centralized networkmanagement component of NSX, and is installed as a virtual
appliance on any ESXi host in your vCenter Server environment. It provides an aggregated system view.
See the VMware documentation for details.

NOTE: Ensure that NSX Manager is configured in single vCenter Mode and not in multiple
vCenter mode. See the VMware documentation for details.

NOTE: Juniper Networks devices require a license to activate the feature. To understandmore
about VMWare NSX Licensing, see, Licenses for Network Management. Please refer to the
Licensing Guide for general information about License Management.

Table 152 on page 373 lists the system software requirement specifications for the components of a vSRX,
Security Director, and VMware NSX integration.

Table 152: System Software Specifications for vSRX in VMware NSX Environment

SpecificationComponent

6.0 Update 3 or laterVMware ESXi Server

6.3.1 or laterVMware vCenter Server

6.3.1 or later

NOTE: For sites that are running vSphere 6.5, vSphere 6.5a is
the minimum supported version with NSX for vSphere 6.3.0.

VMware NSX for vSphere

6.3.1 or laterVMware NSX Manager

3.10.x or laterLinux Kernel

17.1 or laterJunos Space Security Director
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Table 152: System Software Specifications for vSRX in VMware NSX Environment (continued)

SpecificationComponent

17.1 or laterJunos Space Policy Enforcer

Junos OS Release vSRX 15.1X49-D101 or latervSRX

4 GBMemory

16 GB (IDE or SCSI drives)Disk space

2 vCPUsvCPUs

A single vNIC for management traffic. Network traffic is
forwarded to the vSRX over a Virtual Machine Communication
Interface (VMCI) communication channel by the ESXi
hypervisor.

NOTE: VMCI is not a network interface (NIC) but a
VMWare-proprietary device for Host toGuest Communication.

vNICs

RELATED DOCUMENTATION

VMware NSX for vSphere 6.2 Documentation Center

VMware vSphere 6 Documentation

vSphere Installation and Setup

Before You Deploy vSRX in VMware NSX-T Environment

Before you begin deploying the vSRXVirtual Services Gateway as an advanced security service in VMware
NSX-T:

• Download the .ovf file of the vSRX software image from Juniper Networks website and save it to the
Policy Enforcer. The vSRX OVF URL automatically appears in the Register Security Service page of the
Security Director when you register the vSRX virtual machine (VM) as a Juniper security service on the
NSX-T Manager.

• Obtain the Juniper SDSN for NSX license key (see Juniper SDSN for VMware NSX Licensing).
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• Install the VMware vCenter Server on aWindows VMor physical server, or deploy the VMware vCenter
Server Appliance. Connect to the vCenter Server from the vSphere Web Client. See the VMware
documentation for details.

• Install NSX-T Manager. NSX-T manager can be installed on ESXI or KVM servers. See the VMware
documentation for details.

NOTE: Juniper Networks devices require a license to activate the feature. To understandmore
about VMWare NSX Licensing, see, Licenses for Network Management. Please refer to the
Licensing Guide for general information about License Management.

Table 152 on page 373 lists the system software requirement specifications for the components of a vSRX,
Security Director, and VMware NSX-T Manager.

Table 153: System Software Specifications for vSRX in VMware NSX Environment

SpecificationComponent

6.5 and 6.7VMware ESXi Server

6.7 and 7.0VMware vCenter Server

3.0VMware NSX-T Manager

21.1 or laterJunos Space Security Director

21.1 or laterJunos Space Policy Enforcer

Junos OS Release vSRX 3.0 21.1 or latervSRX

4 GBMemory

16 GB (IDE or SCSI drives)Disk space

2 vCPUsvCPUs

A single vNIC for management traffic. Network traffic is
forwarded to the vSRX over a Virtual Machine Communication
Interface (VMCI) communication channel by the ESXi
hypervisor.

NOTE: VMCI is not a network interface (NIC) but a
VMWare-proprietary device for Host toGuest Communication.

vNICs
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About the NSX Managers Page

To access this page, click Security Director > Devices > NSX Managers.

Use the NSX Managers page to discover the NSX Manager and perform service registration of the vSRX
VMwith theNSXManager. TheNSXManager is added as a device in the Security Director and its inventory
is synchronized with Security Director.

When you add an NSXManager in Security Director, the NSXManagement RESTful API configures Policy
Enforcer as a system log server in NSXManager. The system log server handler runs in the Policy Enforcer
virtual machine. On receiving the security group membership changes from system log, the system log
service handler parses the system log and extracts the changed security group details. The security policies
with rules having themodified security groups (dynamic address groups) as source or destination addresses
are filtered and the perimeter firewall devices assigned to those policies are obtained. A remote procedure
call (RPC) is sent to those perimeter firewall devices to update the dynamic address groups. The perimeter
firewall devices then obtains and update the IP address feeds from Policy Enforcer.

Before you Begin

1. Install the Policy Enforcer Release OVA image.

a. After the installation is complete, log in to the Policy Enforcer VM through SSH. Run the service
commands to verify the status of the following services:

 service nsxmicro status

 service  sd_event_listener status

 service nsx_callback_listener status

 service  ssh_listener status

b. If services are stopped, initiate the services again by running the following commands:

 service nsxmicro start

 service  sd_event_listener start

 service nsx_callback_listener start

 service  ssh_listener start

2. Select Security Director > Administration > Policy Enforcer > Settings, and add Policy Enforcer to
Security Director. For more information, see Identifying the Policy Enforcer VirtualMachine In Security
Director.
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3. Download the SSHKey. Copy the vSRXOVA file to the Policy Enforcer VM alongwith the downloaded
SSH key. See “Download the SSH Key File” on page 378.

4. Obtain the vSRX license key before adding the NSX Manager to the Security Director.

Tasks You Can Perform

You can perform the following tasks from this page:

• Download the SSH Key. See “Download the SSH Key File” on page 378.

• Add the NSX Manager. See “Add the NSX Manager” on page 380.

• Register security services. See “Registering Security Services” on page 382.

• Synchronize the NSX inventory.

Field Descriptions

Table 154 on page 377 provides guidelines on using the fields on the NSX Managers page.

Table 154: Fields on the NSX Managers Page

DescriptionField

Specifies the hostname or the IPv4 address of the NSX Manager.Hostname/IP Address

Specifies the name of the NSX Manager.Name

Specifies the hostname or the IP address of the vCenter associated with the
NSX Manager that is automatically fetched by Security Director.

Associated vCenter

Specifies the connection status of an associated vCenter.Associated vCenter Status

Specifies the registration status of the security services.ServiceManager Registration Status

Specifies the service definition of a selected NSX Manager.

Click View to view the service definition.

Services

Specifies the port number of the NSX Manager.Port

Specifies the username of the NSX Manager. The user must have the
administrator privileges to access the NSX Manager.

Username

Specifies the connection status of the NSX Manager.Connection Status
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RELATED DOCUMENTATION

Add the NSX Manager | 380

Download the SSH Key File

IN THIS SECTION

Copy vSRX OVA Image File to Policy Enforcer from Linux Machines | 378

Copy vSRX OVA Image File to Policy Enforcer from MAC Machines | 379

You must copy the vSRX OVA image to the Policy Enforcer virtual machine (VM) before adding the NSX
Manager.

Use the Upload Image page to download the SSH key file and copy the vSRXOVA file to the Policy Enforcer
VM by using the SFTP command with the downloaded SSH key. You must perform this as a first step
before adding the NSX Manager.

To download the SSH key:

1. Select Security Director > Devices > NSX Managers.

The NSX Managers page appears.

2. Click Download SSH Key.

The Download SSH Key page appears.

3. Click Download SSH Key.

The SSH key is downloaded and saved in your local drive.

Copy vSRX OVA Image File to Policy Enforcer from Linux Machines

To copy the vSRX OVA file to a Policy Enforcer VM from a Linux machine:

1. Copy the downloaded SSH key file to the same directory where the vSRX OVA image file is saved.

2. Navigate to the directory path where vSRX OVA and SSH key files are located.
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3. Run the chmod 600 <<SSHKEYFILE>> command to change the permission of the SSH key file.

4. Run the following commands:

• sftp -o “IdentityFile=<<SSHKEYFILE>>" nsxmicro@<<pe_ipaddress>>

• cd publish

• put <<VSRX OVA FILE>>

The vSRX OVA file will be copied to the Policy Enforcer VM after sometime.

5. After the vSRXOVA file is copied, you can add the NSXManager and register its services in the Security
Director.

Copy vSRX OVA Image File to Policy Enforcer from MACMachines

To copy the vSRX OVA file to a Policy Enforcer VM from a MAC machine:

1. Copy the downloaded SSH key file to the same directory where the vSRX OVA image file is saved.

2. Navigate to the directory path where vSRX OVA and SSH key files are located.

3. Run the chmod 600 <<SSHKEYFILE>> command to change the permission of the SSH key file.

4. Run the following commands:

• sftp –i sshkey nsxmicro@<pe_ip>

• cd publish

• put *<<VSRX OVA FILE>>

The vSRX OVA file will be copied to the Policy Enforcer VM after sometime.

5. After the vSRXOVA file is copied, you can add the NSXManager and register its services in the Security
Director.

RELATED DOCUMENTATION

Understanding Juniper Connected Security for VMware NSX Integration | 365

Before You Deploy vSRX in VMware NSX Environment | 372

About the NSX Managers Page | 376

Add the NSX Manager | 380
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Add the NSX Manager

Use the Add NSX Manager page to add the NSX Manager in to the Security Director database. Based on
the NSX details provided, the Security Director automatically fetches the associated VMware vCenter
Server hostname from NSX.

To add a NSX Manager:

1. Select Devices > NSXManagers.

The NSX Managers page appears.

2. Click the add icon (+).

The Add NSX Manager page appears.

3. Complete the configuration by using the guidelines in Table 155 on page 380.

4. Click Finish to complete the configuration.

After adding the NSX Manager, you must register the vSRX VM as a Juniper security service with the
NSX Manager. See “Registering Security Services” on page 382.

Table 155: Fields on the Add NSX Manager Page

DescriptionField

Enter the name of the NSX manager.Name

Enter the IPv4 address of the NSX manager.Host

Enter the port number of the NSXManager. The NSXManager and Security Director use
SSL to communicate on TCP port 443.

Port

Enter the username of the NSX Manager to allow Security Director to authenticate the
communication.

Username

Enter the password of the NSX Manager to allow Security Director to authenticate the
communication.

Password

Enter a description about the NSX Manager; you can use a maximum of 255 characters.Description

View the SSL certificate required to authenticate the NSX Manager.SSL Certificate

Select this option to accept the SSL certificate. This is a mandatory field.Accept SSL Certificate
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Table 155: Fields on the Add NSX Manager Page (continued)

DescriptionField

Select an option: NSX-V or NSX-T.

VMwareNSX-T is the latest generation of VMware’s network virtualization product series.
NSX-T is the successor to NSX-V. NSX-T supports third-party Hypervisors and next
generation overlay encapsulation protocols such as Generic Network Virtualization
Encapsulation (Geneve).

Type

Select the type of perimeter firewall for your datacenter.

• East-West Firewall—vSRX is spawned in each ESX server of VMware NSX for the
east-west traffic. This provides east-west security for members of the security groups
within a datacenter.

• North-South Firewall—Perimeter firewall for the north-south traffic. This provides a
consistent north-south security for members of the security groups, if the members
move across datacenters.

You can select both the types or any one of the firewall types.

NOTE: Firewall Type is applicable only if you select the Type as NSX-V.

Firewall Type

Service Manager Registration

Enter the username of Security Director to allow the NSX Manager to authenticate its
communication with Security Director.

SD Username

Enter the password of Security Director to allow the NSX Manager to authenticate its
communication with Security Director.

SD Password

Enter the license key of vSRX VM.License Key

Associated vCenter - vCenter Server

To add multiple vCenter servers:

Click the + icon.

The Associate vCenter page is displayed.

Enter the IPv4 address of the VMware vCenter Server.Host

Enter the port number of the VMware vCenter Server. Default: 443Port

Enter the usernameof theVMware vCenter Server. SecurityDirector uses these credentials
to discover the vCenter server and fetch the VM inventory details.

Username
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Table 155: Fields on the Add NSX Manager Page (continued)

DescriptionField

Enter the password of theVMware vCenter Server. SecurityDirector uses these credentials
to discover the vCenter Server and fetch the VM inventory details.

Password

View the SSL certificate required to authenticate the vCenter Server.SSL Certificate

Select this option to accept the SSL certificate. This is a mandatory field.Accept SSL Certificate

RELATED DOCUMENTATION

About the NSX Managers Page | 376

Registering Security Services

Use the Register Security Service page in Security Director to register a Juniper security service on a
specific NSX Manager. After registering the security service from Security Director, log in to the vCenter
server and deploy the service from NSX.

To register the Juniper security service:

1. Select Devices > NSXManagers.

The NSX Managers page appears.

2. Select the NSX Manager for which service needs to be registered.

3. From the More list or right-click menu, select Register Security Service.

The Register Security Service page appears.

4. Complete the configuration by using the guidelines in Table 156 on page 383.

5. Click Register to complete the registration.

A confirmation message appears to indicate if registration is successful or not.
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Table 156: Fields on the Register Security Service Page

DescriptionField

Enter the name for the Juniper Security Service.Service Name

The vSRX OVF image that you have copied to the Policy Enforcer VM is listed here.
Select the vSRX OVF image from the list.

vSRX OVF URL

Enter the root password of the vSRX instance.

The same root password is set for all the vSRX VMs deployed in NSX.

vSRX Root Password

Enter the root password of the vSRX instance for confirmation.Confirm Password

The default firewall type is North-South.

North-South—It is the perimeter firewall for the north-south traffic. This provides a
consistent north-south security for members of the security groups, if the members
move across datacenters.

NOTE: The Firewall Type field is applicable only if the NSX Manager type is NSX-T.

Firewall Type

RELATED DOCUMENTATION

About the NSX Managers Page | 376

Editing NSX Managers

Use the Edit NSX Manager page to edit the information of an already discovered NSX Manager.

To edit the NSX Manager:

1. Select Devices > NSXManagers.

The NSX Manager page appears listing all the discovered NSX Managers.

2. Select the NSX Manager that you want to edit, and click the pencil icon.

The Edit NSX Manager page appears, showing the same fields that are displayed when you add the
NSX Manager.

3. Edit the NSX Manager fields as needed.
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The changes are saved and you are returned to the NSX Managers landing page.

RELATED DOCUMENTATION

Add the NSX Manager | 380

Viewing Service Definitions

Use the Service Definitions page to view the list of services registered for the NSX Manager.

To view the service definitions:

1. Select Devices > NSXManagers.

The NSX Manager page appears listing all the discovered NSX Managers.

2. In the Services column, click View to view the service definitions for the required NSX Manager.

The Service Definitions page appears. Table 157 on page 384 provides the guidelines on using the fields
on this page.

Table 157: Field on the Service Definitions Page

DescriptionField

Specifies the name of the registered service.Service Name

Specifies the vSRX OVF URL.OVF URL

Specifies the version of the service.Version

RELATED DOCUMENTATION

Add the NSX Manager | 380
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Deleting the NSX Manager

Use the Delete NSX Manager option to delete the NSX Manager from the Security Director inventory.
Along with NSX Manager, the associated vCenter server is also deleted.
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Before You Begin

Before you delete the NSX Manager, perform the following steps:

1. Unbind all bindings of network object from a service profile in VMWare vCenter Server.

• Log in to the vSphere Web Client through the VMware vCenter Server.

• Select Networking & Security > Service Definitions.

The Service Definitions page appears.

• Double-click on the Juniper service.

The respective service page appears, as shown in Figure 30 on page 386.

Figure 30: Service Instances Page

• In the left pane, click on the global instance > Service Profiles > Juniper Vendor Template.

The Juniper Networks Template page for the selected service appears.

• Select the template and from the Actions list, select Apply to Objects.

The Apply to Network Objects page appears.

• Remove the object associated with a service profile by moving the object listed under Selected
Objects column to Available Objects column.

2. Delete the redirect policy in VMWare vCenter Server.

• Select Networking & Security > Service Composer.
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The Service Composer page appears.

• In the Security Policies tab, right-click the security policy and select Delete.

The security policy along with corresponding firewall rules are deleted.

3. Delete the deployed services in VMWare vCenter Server.

• Select Networking & Security > Installation.

The Installation page appears.

• In the Service Deployments tab, right-click on the service name and select Delete.

The deployed service is deleted.

4. Deregister the service definition in VMWare vCenter Server.

• Select Networking & Security > Service Definitions.

The Service Definitions page appears.

• Double-click on the Juniper service.

The respective service page appears.

• In the left pane, click on the global instance > Service Profiles > Juniper Vendor Template.

The Juniper Networks Template page for the selected service appears.

• In the Related Object tab, right-click on the template and click Delete.

• Select Service Definitions in the left pane.

The Service Definitions page appears.

• In the Service tab, right-click on the service and click Delete.

The Remove service definition pop-up message appears to confirm the delete operation. Enable the
Delete service manager option and click Yes.

To delete the NSX Manager:

1. Select Devices > NSXManagers.

The NSX Manager page appears.

2. Select the NSX Manager that you want to delete.

3. From the More list, or right-click menu, select Delete NSX Manager.

A confirmation message appears to confirm the deletion.
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NOTE: You cannot delete NSX Manager if the security service is already deployed in NSX.

4. Click Yes to confirm the deletion.

The NSX Manager and its associated vCenter server are deleted from the Security Director inventory.

NOTE: You cannot delete a NSX Manager if there is a NSX Secure Fabric. You must first delete
the Secure Fabric. See “Editing or Deleting a Secure Fabric” on page 360.

RELATED DOCUMENTATION
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Before You Deploy vSRX in VMware NSX Environment | 372
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Registering Security Services | 382

Deploying the vSRX as an Advanced Security Service in a VMware NSX Environment | 390

Delete the NSX-T Manager

You can delete the NSX-TManager and its associated vCenter server from the Security Director inventory.
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Before You Begin

Before you delete the NSX-T Manager, perform the following steps:

1. Unbind all bindings of network object from a service profile.

• Log in to the VMware NSX-T Manager.

• Select System > Service Deployment.

• In the Deployment tab, select the deployed partner service that you want to delete.

The corresponding service details are displayed.

• From the Actions list, select Delete.

The delete deployment service confirmation page appears.

• Click DELETE to delete the deployed service.

If the action is successful, the deployed service is deleted.

To delete the NSX-T Manager from Security Director:

1. Select Devices > NSXManagers.

The NSX Manager page appears.

2. Select the NSX-T Manager that you want to delete.

3. From the More list, or right-click menu, select Delete NSX Manager.

A confirmation message appears to confirm the deletion.

NOTE: You cannot delete NSX-T Manager from Security Director if the security service is
already deployed in the NSX-T Manager.

4. Click Yes to confirm the deletion.

TheNSX-TManager and its associated vCenter server are deleted from the Security Director inventory.

NOTE: You cannot delete NSX-TManager if there is a NSX Secure Fabric. You must first delete
the Secure Fabric. See “Editing or Deleting a Secure Fabric” on page 360.
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RELATED DOCUMENTATION

About the NSX Managers Page | 376

Deploying the vSRX as an Advanced Security Service in a VMware NSX
Environment

IN THIS SECTION

Creating a Security Group (VMware vCenter Server) | 390

Discovering the NSX Manager and Registering vSRX as a Security Service in vSphere cluster | 392

Deploying vSRX as a Security Service on a vSphere Cluster (VMware vCenter Server) | 397

Verifying vSRX Agent VM Deployment in Security Director | 401

Automatic Creation of Security Policy in the NSX Environment to Direct Traffic Through the vSRX Agent
VMs (VMware vCenter Server) | 403

Use the following procedures to deploy the vSRX as an advanced security service virtual machine (VM) in
the VMware NSX environment. The vSRX VM is deployed in conjunction with Juniper Networks Junos
Space Security Director and VMware NSX Manager. In each procedure you are instructed whether to
perform the steps in the NSX Manager (from the VMware vCenter Server) or in the vSphere cluster. For
example, you create the security group using the NSX Manager, but the discovery of devices happens in
the vSphere cluster.

The deployment steps are performed in the following sequence :

Creating a Security Group (VMware vCenter Server)

You create a security group by using the NSX Manager from the VMware vCenter Server. Each security
group is a logical collection of objects from your vSphere inventory. These objects include VMs that you
want to be members in the same security group and to which you will apply the vSRX as a Juniper security
service. You can apply an advanced security service policy to all the objects contained in a security group.
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To create a security group from the VMware vCenter Server:

1. Log in to the vSphere Web Client through the VMware vCenter Server.

2. From the vSphereWeb Client, clickHosts and Clusters to view hosts and clusters in the vSphereWeb
Client inventory. From the Summary tab, you can verify the vSphere cluster and the VMs associated
as part of this cluster. All VMs are part of the VXLAN network and can communicate over this VLAN.

3. From the vSphere Web Client, click Networking & Security and then click Service Composer. The
Service Composer appears. From the Service Composer, click the Security Groups tab.

4. Click the Add Security Group icon to create a new security group that contains the specific VMs you
want as members of the same group, as shown in Figure 31 on page 391.

Figure 31: Create a New Security Group Page

5. Type a name and description for the security group and then click Next.

6. On the Define dynamic membership page, define the criteria that an object must meet for it to be
added to the security group you are creating. You can define a dynamic group membership criteria for
the VMs that are to be part of each security group. For example, VM membership in a security group
can be tagged by name. You define the exact membership criteria that you want to use to group VMs.
Group membership is associated dynamically at runtime.
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Click Next.

7. On the Select objects to include page, select the tab for the resources you want to include in this
security group. Click Next.

8. On the Select objects to exclude page, select the tab for the resources you want to exclude from this
security group. Click Next.

9. Click Finish to complete creating the security group.

Discovering the NSX Manager and Registering vSRX as a Security Service in vSphere cluster

You use the Junos Space vSphere cluster to discover the NSX Manager and perform service registration
of the vSRX VM with the NSX Manager. The NSX Manager is added as a device in the Security Director,
and its inventory is synchronized with the Security Director.

NOTE: Ensure that SNMP is disabled in the Security Director while performing device discovery
for the vSRX agent VM. If SNMP is enabled in Security Director, the vSRX agent VM discovery
operation fails.

To discover the NSX Manager from the Security Director:

1. Select Security Director > Devices > NSX Managers.

The NSX Managers page appears.

2. Click the Add icon (+) to add the NSX Manager to the Security Director.

The Add NSX Manager page appears, as shown in Figure 32 on page 393.
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Figure 32: Add NSX Manager Page

3. In the NSX Manager section, enter the following information:

• Name—Enter the name of the NSX Manager.

• Host—Enter the IP address of the NSX Manager.

• Port—Enter the port number of the NSX Manager. The NSX Manager and Security Director use SSL
to communicate on TCP port 443.

• Username, Password—Enter the username and password of the NSX Manager that are required for
communication to be authenticated by the Security Director.

• Description—Enter a description for the NSX Manager you are to add to the Security Director.

• SSL Certificate—View the SSL certificate to authenticate the NSX Manager and select the Accept
SSL Certificate option to accept the SSL certificate.

This is a mandatory field to discover the NSX Manager. The SSL Certificate field appears once you
enter the NSX details.

4. Click Next.

5. In the Service Manager Registration section, enter the following details about the Security Director:

• SD Username, SD Password—Enter the username and password of Security Director to allow the
NSX Manager to authenticate communication to the Security Director.
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• License Key—Enter the license key for the previously procured Juniper SDSN for NSX license (see
Juniper SDSN for VMware NSX Licensing for background details).

6. Click Next.

7. In the vCenter Server section, provide the following details about the vCenter Server:

• Host—Enter the IP address of the VMWare vCenter Server.

• Port—Enter the port number of the VMWare vCenter Server. By default, 443 is used.

• Username, Password—Enter the username and password of the VMware vCenter Server. Security
Director uses these credentials to discover the vCenter Server and fetch the VM inventory details.

• SSL Certificate—View the SSL certificate to authenticate the vCenter Server and select the Accept
SSL Certificate option to accept the SSL certificate. To discover the vCenter Server, it is mandatory
to accept the certificate.

8. Click Finish.

The Summary page of configuration changes appears. Click OK to add the NSX Manager. When you
return to the NSX Managers page, you will see the discovered NSX Manager listed, as shown in
Figure 33 on page 394.

Figure 33: NSX Managers Page

After adding the NSXManager, you must register the vSRX VM as a Juniper security service with the NSX
Manager.

394



To register the vSRX instance as a Juniper security service:

1. Select the NSX Manager for which service needs to be registered, right-click or from the More list,
select Register Security Service.

The Register Security Service page appears, as shown in Figure 34 on page 395.

Figure 34: Register Security Service Page

2. In the Service Name field, enter the name of the Juniper security service.

3. From the vSRXOVFURL list, select the available vSRXOVF image that you copied to the Policy Enforcer
machine.

4. In the vSRX Root Password field, enter the root password of the vSRX instance. The same root password
will be set for all the vSRX instances deployed in NSX.

5. In the Description field, enter a description.

6. Click Register.

A confirmation message indicates whether the registration is successful or not.

The vSRX instance registered as a new service in the vSphereWeb Client environment. The vSRX is added
as a network service that can be deployed by the NSX Manager.
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In the vSphere Web Client, verify the following:

• Click Networking & Security and then click Service Definitions. Click the Services tab and verify that
<service-name> v1.0 is listed in the table (the newly registered vSRXVM) alongwith the Security Director
as the Service Manager, as shown in Figure 35 on page 396.

Figure 35: Service Definitions Page

• Click the Service Managers tab and verify that the Security Director is listed with a status of In Service,
as shown in Figure 36 on page 397.
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Figure 36: vSphere Web Client Service Manager Page

The NSX Manager and its inventory are now synchronized with the Security Director. All shared objects
(such as security groups) are synchronized between the NSX Manager and Security Director. The shared
objects include the IP addresses of all VMs in ESXi hosts, including the vSRX agent VMs. Security Director
creates a dynamic address group(DAG) for each security group synchronized from theNSXManager, along
with the addresses of each member of the security group.

After you register a Juniper security service in the NSX Manager, the NSX Manager uses the vSRX agent
VM to communicate the service status. The NSX Manager transmits messages to the Security Director
when any changes or activities are happening in the NSXManager that are related to the Juniper security
service.

Deploying vSRX as a Security Service on a vSphere Cluster (VMware vCenter Server)

The next step is to deploy the Juniper security service on a vSphere cluster. You perform this action as a
new service deployment, selecting the Juniper security service and the specific vSphere cluster on which
you want the vSRX agent VM deployed.

Before you deploy the vSRX agent VM as a security service on the vSphere cluster, you must create a
static IP pool with a primary DNS for the vSRX. To create the static IP pool:

397



Create a static IP pool with a primary DNS for the vSRX. This is a mandatory step before you deploy the
vSRX agent VM.

1. From the vSphere Web Client, select Networking & Security and then NSX Managers.

2. In the Navigator column, select the name of the NSX Manager and clickManage > Grouping Objects
> IP Pools.

3. Click the Add icon (+) to add the static IP pool.

The Add Static IP Pool page appears, as shown in Figure 37 on page 398.

Figure 37: Add Static IP Pool Page

4. In the Name field, provide a name for the IP pool.

5. In the Gateway field, provide a default gateway IP address.

6. In the Prefix Length field, provide a prefix length of the DNS.

7. Provide the primary and secondary DNS and the DNS suffix . This is a mandatory field.

8. In the Static IP Pool field, provide the IP address ranges to be included in the pool.

9. Click OK.

A new IP pool is created for the vSRX to be deployed.
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To deploy the vSRX agent VM as a security service for a vSphere cluster:

1. From the vSphere Web Client, click Networking & Security and then click Installation.

The Installation page appears.

2. Click the Service Deployments tab and then click the New Service Deployment (+) icon. The Deploy
Network & Security Services page appears, as shown in Figure 38 on page 399.

Figure 38: Deploy Network and Security Services Page

3. From the Select services & schedule page, select <service-name> v1.0 as the service to deploy and then
click Next.

4. From the Select clusters page, select the data center and one or more clusters onwhich the vSRX agent
VM is to be deployed, and then click Next.

5. From the Select storage and Management Network page:

• Select the datastore on which to allocate shared storage for the vSRX agent VM, as shown in
Figure 39 on page 400. ESXi hosts should be configured so that they can access shared storage. If you
select Specified on-host, ensure that the datastore for the ESXi host is specified in the Agent VM
Settings of the ESXi host in the cluster. See the VMware documentation for details.
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Figure 39: Select Storage and Management Network Page

• Select the network that you intend to use for traffic to the vSRX agent VM. If you select Specified
on-host, ensure that the network to be used is specified in theAgentVMSettings >Network property
of the ESXi host in the cluster. See the VMware documentation for details.

NOTE: The datastore and network must be configured for each ESXi host in the cluster.

For IP assignment, you can choose an IP pool to assign a range of IP addresses from a selected static
IP pool or create a new static IP pool.

6. Click Next to access the Ready to complete page, and then click Finish to publish the changes and
deploy the vSRX agent VM security services to the specified cluster. From the Service Deployments
tab, you will see that the Juniper security service has been successfully deployed on the selected
vSphere cluster.

7. From the vSphere Web Client, click Hosts and Clusters and verify that vSRX agent VMs are listed as
service-name v1.0 in the vSphere Web Client inventory and created for each ESXi host in the vSphere
cluster.
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NOTE: service-name is the name provided at the time of service registration.

8. The Security Director automatically discovers all the deployed vSRX VM agents by using the
device-initiated discovery. A new firewall and IPS group policies are created and all devices are assigned
to these group policies.

NOTE: The Security Director creates predefined IPS policies with a single IPS template. You
can either add more IPS templates or convert the predefined IPS policies to custom IPS
policies.

When you add an ESXi host in the vSphere cluster, NSXManager automatically detects that the new ESXi
host and adds the Juniper security service vSRX agent VM for it.

Verifying vSRX Agent VM Deployment in Security Director

In the Security Director, based on the NSX Manager discovery, NSX security groups are automatically
synchronized with Security Director. For each service group in NSX Manager, Security Director creates a
corresponding dynamic address group.

To verify that the vSRX agent VMs have been properly deployed:

1. Select Security Director > Devices > NSX Managers.

The NSX Managers page appears with the discovered NSX Manager and the vSRX instance registered
as a new service in the vSphere Web Client environment.

2. Select Security Director >Monitor > NSX Inventory > Security Groups.

The Security Groups page appears listing all the security groups obtained from NSX and the
corresponding dynamic address groups created by the Security Director, as shown in
Figure 40 on page 402.
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Figure 40: Security Groups Page

3. Select Security Director >Monitor > vCenter Server Inventory > Virtual Machines.

The Virtual Machines page appears, listing the VMs that are dynamically fetched by the associated
vCenter, as shown in Figure 41 on page 403. You can view the security groups associated with each
VM. Also, you can view security groups associated with each VM.
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Figure 41: Virtual Machines Page

Automatic Creation of Security Policy in the NSX Environment to Direct Traffic Through the
vSRX Agent VMs (VMware vCenter Server)

After you deploy vSRX agent VM security services to the ESXi hosts in a vSphere cluster, security policies
are automatically created to redirect any network traffic originating from the VMs in a specific security
group to the Juniper security service vSRX agent VM residing in the ESXi host for further analysis.

To direct the traffic to the vSRX agent VMs in each ESXi host by using the automatically created security
policies:

1. In the Security Director, install the IPS signature to all the vSRX VM agents.

2. On the Firewall and IPS Policies page, add new rules to the automatically created firewall or IPS policies
with respective dynamic address groups, as shown in Figure 42 on page 404. You can also use the
application firewalls in the firewall rules.
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Figure 42: Firewall Policy Rules Page

3. After creating policy rules, publish and update the firewall and IPS policies.

4. After the firewall and IPS policies are successfully updated in the Security Director, log in to the vSphere
Web Client to verify the security policies in NSX Manager.

SelectNetwork&Security >NSXManagers, and theNavigator column, select theNSXManager name.
The security policies are automatically created in NSX Manager by Security Director, as shown
Figure 43 on page 404.

Figure 43: NSX Security Groups Page

5. From the vSphere Web Client, select Networking & Security and then select Firewall.

The Firewall page appears.
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6. In the right pane, select the Partner Security Services tab to view the complete list of automatically
created security policies from the Security Director, as shown in Figure 44 on page 405.

Figure 44: Firewall Page

7. The corresponding traffic now goes through the vSRX VM agent.

When you return to Security Director >Devices > Security Devices, you can view the active configuration
for the vSRX agent VMs, as shown in Figure 45 on page 405.

Figure 45: Security Devices Page

TheNSXManager is aware of the security groups that the Juniper security service monitors. If any changes
occur in the security group, the NSX Manager notifies the Security Director about those changes. If
membership changes, the NSX Manager notifies the Security Director of the changes and the Security
Director updates its database based on the new membership.
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Use the following procedures to deploy the vSRX as an advanced security service virtual machine (VM) in
the VMware NSX-T environment. The vSRX VM is deployed in conjunction with Juniper Networks Junos
Space Security Director and VMware NSX-T Manager.

Create a Security Group

You can create a security group by using the VMware NSX-T Manager. Each security group is a logical
collection of objects which include VMs that you want to be members in the same security group and to
which you will apply the vSRX as a Juniper security service. You can apply an advanced security service
policy to all the objects contained in a security group.

To create a security group:

1. Log in to the VMware NSX-T Manager.

2. Select Inventory > Groups.

3. Click ADD GROUP icon to create a new security group that contains the specific VMs you want as
members of the same group, as shown in Figure 46 on page 407.
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Figure 46: Add Groups Page

4. Type a group name and then click Set members.

5. On the Select Members page, define the criteria that an object must meet for it to be added to the
security group you are creating. You can define a dynamic group membership criteria for the VMs that
are to be part of each security group. For example, VM membership in a security group can be tagged
by name. You define the exact membership criteria that you want to use to group VMs. Group
membership is associated dynamically at runtime.

6. Click Apply to complete creating the security group.

Discover the NSX-T Manager and Register vSRX as a Security Service

The NSX-T Manager is added as a device in Security Director, and its inventory is synchronized with
Security Director.

NOTE: Ensure that SNMP is disabled in Security Director while performing device discovery for
the vSRX agent VM. If SNMP is enabled in Security Director, the vSRX agent VM discovery
operation fails.

To discover the NSX-T Manager from Security Director:

1. Select Security Director > Devices > NSX Managers.

The NSX Managers page appears.

2. Click the Add icon (+) to add the NSX Manager to Security Director.

The Add NSX Manager page appears, as shown in Figure 47 on page 408.
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Figure 47: Add NSX Manager Page

3. In the NSX Manager section, enter the following information:

• Name—Enter the name of the NSX Manager.

• Host—Enter the IP address of the NSX Manager.

• Port—Enter the port number of the NSX Manager. The NSX Manager and Security Director use SSL
to communicate on TCP port 443.

• Username, Password—Enter the username and password of the NSX Manager that are required for
communication to be authenticated by the Security Director.

• Description—Enter a description for the NSX Manager you are to add to the Security Director.

• Type—Select NSX-T.

NSX-T is the successor to the NSX-V product. VMware NSX-T is the latest generation of VMware’s
network virtualization product series.

4. Click Next.

5. In the Service Manager Registration section, enter the following details about the Security Director:

• SD Username, SD Password—Enter the username and password of Security Director to allow the
NSX-T Manager to authenticate communication to the Security Director.

• License Key—Enter the license key for the previously procured Juniper SDSN for NSX license (see
Juniper SDSN for VMware NSX Licensing for details).

6. Click Next.
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7. In the vCenter Server section, click the + icon to add vCenter servers. Provide the following details on
the Associate vCenter page:

• Host—Enter the IP address of the VMWare vCenter Server.

• Port—Enter the port number of the VMWare vCenter Server. By default, 443 is used.

• Username, Password—Enter the username and password of the VMware vCenter Server. Security
Director uses these credentials to discover the vCenter Server and fetch the VM inventory details.

8. Click Finish.

The Summary page of configuration changes appears. ClickOK to add the NSX-T Manager. When you
return to the NSX Managers page, you will see the discovered NSX-T Manager listed.

After adding the NSX-T Manager, you must register the vSRX VM as a Juniper security service with the
NSX-T Manager.

To register the vSRX instance as a Juniper security service:

1. Select the NSX-T Manager for which service needs to be registered, right-click or from the More list,
select Register Security Service.

The Register Security Service page appears, as shown in Figure 48 on page 409.

Figure 48: Register Security Service Page

2. In the Service Name field, enter the name of the Juniper security service.
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3. From the vSRXOVFURL list, select the available vSRXOVF image that you copied to the Policy Enforcer
machine.

4. In the vSRX Root Password field, enter the root password of the vSRX instance. The same root password
will be set for all the vSRX instances deployed in NSX.

5. Select the firewall type as North-South. This is the perimeter firewall for the north-south traffic. This
provides a consistent north-south security for members of the security groups, if the members move
across datacenters.

6. Click Register.

A confirmation message indicates whether the registration is successful or not.

The vSRX is added as a network service that can be deployed by the NSX-T Manager.

In the VMware NSX-T Manager, verify the following:

• Select System > Service Deployments and then select the CATALOG tab. Verify that the service name
provided while registering the Security Service is listed in the table (the newly registered vSRX VM) as
shown in Figure 49 on page 410.

Figure 49: Service Definition

The NSX-TManager and its inventory are now synchronized with the Security Director. All shared objects
(such as security groups) are synchronized between the NSX-TManager and Security Director. The shared
objects include the IP addresses of all VMs, including the vSRX agent VMs. Security Director creates a
dynamic address group(DAG) for each security group synchronized from the NSX-T Manager, along with
the addresses of each member of the security group.
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After you register a Juniper security service in the NSX-T Manager, the NSX-T Manager uses the vSRX
agent VM to communicate the service status. The NSX-TManager transmits messages to Security Director
when any changes or activities are happening in the NSX-TManager that are related to the Juniper security
service.

Deploy vSRX as a Security Service

The next step is to deploy the Juniper security service.

To deploy the vSRX agent VM as a security service:

1. Select System > Service Deployments and then click the DEPLOYMENT tab.

2. Select the partner service as the registered service and then click Deploy Service.

a. Enter the service deployment name.

b. Select the attachment point as Tier1 gateway or Tier 0 gateway.

c. Select the Compute Manager as vCenter.

d. Select the Cluster on which the vSRX agent VM is to be deployed.

e. Select the datastore on which to allocate shared storage for the vSRX agent VM.

f. Click Set and then provide the network details such as, primary interface network, primary interface
IP, primary gateway address, primary subnet mask and click Save.

3. Click SAVE to deploy the vSRX agent VM as a security service.

The Security Director automatically discovers all the deployed vSRX VM agents by using the
device-initiated discovery. A new firewall and IPS group policies are created and all devices are assigned
to these group policies.

NOTE:
• The Security Director creates predefined IPS policies with a single IPS template. You can
either addmore IPS templates or convert the predefined IPS policies to custom IPS policies.

• You must register different service for each service deployment.
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Verify vSRX Agent VM Deployment in Security Director

In Security Director, based on the NSX Manager discovery, NSX security groups are automatically
synchronized with Security Director. For each service group in NSX Manager, Security Director creates a
corresponding dynamic address group.

To verify that the vSRX agent VMs have been deployed:

1. Select Security Director > Devices > NSX Managers.

The NSX Managers page appears with the discovered NSX Manager and the vSRX instance registered
as a new service.

2. Select Security Director >Monitor > NSX Inventory > Security Groups.

The Security Groups page appears listing all the security groups obtained from NSX and the
corresponding dynamic address groups created by the Security Director.

3. Select Security Director >Monitor > vCenter Server Inventory > Virtual Machines.

The Virtual Machines page appears, listing the VMs that are dynamically fetched by the associated
vCenter, as shown in Figure 41 on page 403. You can view the security groups associated with each
VM. Also, you can view security groups associated with each VM.

Figure 50: Virtual Machines Page
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Automatic Creation of Security Policy in the NSX-T Environment to Direct Traffic Through the
vSRX Agent VMs

After you deploy vSRX agent VM security services, security policies are automatically created to redirect
any network traffic originating from the VMs in a specific security group to the Juniper security service
vSRX agent VM for further analysis.

To direct the traffic to the vSRX agent VMs by using the automatically created security policies:

1. In Security Director, install the IPS signature to all the vSRX VM agents.

2. On the Firewall and IPS Policies page, add new rules to the automatically created firewall or IPS policies
with respective dynamic address groups. You can also use the application firewalls in the firewall rules.

3. After creating policy rules, publish and update the firewall and IPS policies.

4. After the firewall and IPS policies are successfully updated in the Security Director, log in to the VMware
NSX-T Manager to verify the security policies.

Select Security > Network Introspection (N-S). The security policies are automatically created from
Security Director, as shown Figure 51 on page 413.

Figure 51: Network Introspection (N-S)

When you return to Security Director >Devices > Security Devices, you can view the active configuration
for the vSRX agent VMs, as shown in Figure 45 on page 405.
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Figure 52: Security Devices Page

The NSX-T Manager is aware of the security groups that the Juniper security service monitors. If any
changes occur in the security group, the NSX-T Manager notifies Security Director about those changes.
If membership changes, NSX-T Manager notifies Security Director of the changes and Security Director
updates its database based on the new membership.
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CHAPTER 43

vCenter Servers

IN THIS CHAPTER
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About the vCenter Servers Page

To access this page, select Security Director > Devices > vCenter Servers.

VMWare NSX Manager is always associated to a vCenter Server. Based on the NSX Manager discovered
by Security Director, the NSX service automatically fetches the associated vCenter server hostname. The
NSX service uses the specific vCenter credentials provided by the user at the time of adding the NSX
Manager, to connect to vCenter and obtain any required inventory from it.

Use the vCenter Servers page to view details of an associated vCenter Server.

Tasks You Can Perform

You can perform the following task from this page:

• Synchronize any changes to the inventory objects in vCenter with the vCenter database.

Field Descriptions

Table 158 on page 415 provides guidelines on using the fields on the vCenter Servers page.

Table 158: Fields on the vCenter Servers Page

DescriptionField

Specifies the hostname of the associated vCenter Server.Host Name

Specifies the port number of the vCenter server.Port

Specifies the connection status of NSX Manager and associated vCenter server.Connection Status
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CHAPTER 44

Licenses

IN THIS CHAPTER
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Managing Licenses | 423

About the Licenses Page

To access this page, click Devices > Licenses.

You can manage the licenses for features such as antispam, antivirus, IDP signature, Juniper Advanced
Threat Prevention Cloud (Juniper ATP Cloud), unified threat management (UTM) and also VSRX (Virtual
Appliance). You can deploy the license from Security Director and view the license details such as total
number of installed licenses, used licenses, expired licences, and so on.

Tasks You Can Perform

You can perform the following tasks from this page:

• View the license details. See “License Management Overview” on page 421.

• Deploy the license on devices. See “Managing Licenses” on page 423.

Field Descriptions

Table 159 on page 417 provides guidelines on using the fields on the License page.

Table 159: Fields on the Licenses Page

DescriptionField

The name of the device.Device Name

The IP address of the device.Device IP
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Table 159: Fields on the Licenses Page (continued)

DescriptionField

Device family of the selected device. For the unmanaged device, this is the same as the provided
vendor name. The field displays Unknown if the vendor name is not available and if SNMP is not
used or has failed.

Device Family

Connection status of the device in Junos Space Network Management Platform.

• Up—The device is connected to Junos Space Network Management Platform.

• Down—The device is not connected to Junos Space Network Management Platform.When the
connection status is down, the configuration status is None or Connecting.

• NA—The device is unmanaged.

Connection

The device on which the feature license is deployed. The device can be an SRX Series device or a
vSRX device.

For the unmanaged device, this is same as the provided vendor name. The field displays Unknown
if the vendor name is not available and if SNMP is not used or has failed.

Platform

The status of the device managed by Security Director.Managed Status
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Table 159: Fields on the Licenses Page (continued)

DescriptionField

Configuration
Status
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Table 159: Fields on the Licenses Page (continued)

DescriptionField

Current state of the device configuration.

• Connecting—Junos Space has sent a connection remote procedure call (RPC) and is waiting for
the first connection from the device.

• Undefined—The device is in this state only for a short period when Junos Space Network
Management Platform is set as the system of record (SOR).

• Unknown—This state occurs in the following cases:
When the device disconnects from Junos SpaceNetworkManagement Platform. The device
status remains Unknown until the device reconnects to Junos Space NetworkManagement

•

Platform and the configuration status of the device is checked against the Junos Space
Network Management Platform database. It will be in this state until the device connects.

• If Junos Space Network Management Platform is trying to push or synchronize changes to
the device based on the workflow for accepting or rejecting out-of-band changes on the
device and the push or synchronize fails.

• In Sync—The synchronization operation has completed successfully; Junos Space Network
Management Platform and the device are synchronized.

• None—The device is discovered, but Junos Space NetworkManagement Platform has not yet
sent a connection RPC.

• Out Of Sync—In network as SOR mode, the device is connected to Junos Space Network
Management Platform, but the synchronization operation is not initiated, or an out-of-band
configuration change on the device was detected and auto-resynchronization is disabled or
has not yet started.

• Sync Failed—The synchronization operation failed.

• Synchronizing—The synchronization operation has started as a result of device discovery, a
manual resynchronization operation, or an automatic resynchronization operation.

• Space Changed—In Junos Space Network Management Platform as SOR mode, there are
changes made to the device configuration from Junos Space NetworkManagement Platform.

• Device Changed—In Junos Space Network Management Platform as SOR mode, there are
changes made to the device configuration from the device CLI.

• Space & Device Changed—In Junos Space Network Management Platform as SOR mode,
there are changes made to the device configuration from the device CLI and Junos Space
NetworkManagement Platform. Neither automatic normanual resynchronization is available.

• In-RMA—The configuration of the defective device is maintained in Junos Space Network
Management Platform so that the device can be reconnected andmanagedwhen it is replaced.

• Reactivating—The defective device is replaced and the reactivation of the replacement device
to bring it back under management has started.

• Reactivate Failed—The operation to reactivate the device has failed.

• Unmanaged—The device is unmanaged.

• Waiting for deployment—The modeled device is unreachable and needs to be activated.
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Table 159: Fields on the Licenses Page (continued)

DescriptionField

Modeled—The device is modeled.•

Shows the validity of the license.Anti Spam

Shows the validity of the license.Anti Virus

Shows the validity of the license.IDP Signature

Shows the validity of the license.ATP Cloud

Shows the validity of the license.UTM

Shows the validity of the license.VSRX
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Managing Licenses | 423.

License Management Overview

Starting in Junos Space Security Director Release 19.4R1, you can manage the licenses for features such
as antispam, antivirus, IDP signature, Juniper Advanced Threat Prevention Cloud (Juniper ATP Cloud),
unified threat management (UTM), and also for VSRX (Virtual Appliance). You can deploy the license on
the device(s) managed by Security Director and view the history of pushed licenses. You can either select
a single SRX Series device or a multiple VSRX devices to deploy the license. Each license allows you to run
the corresponding advanced software feature(s) on a single device.

You can view the following license information of devices managed by Security Director:

• Total Licenses—Total number of licenses installed on devices managed by Security Director.

• Used—Number of licenses currently being used on the device. If a feature license exists and the feature
is configured on a device, then the license is considered as a used license.

• Expired—Number of expired licenses.

• Expiring—Number of licenses that are about to expire within 30 days.
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You can hover over the numbers in the Licenses page to view the device and license details. You can view
all devices that are discovered and managed by Security Director, with installed license details. You can
use the View By option to filter the license details. You can also search, sort, or filter the license details
using parameters such as device name, device IP address, device family, platform, expired licenses, licenses
that are going to expire, and so on. You can go back to the default view anytime by selecting the Reset to
Default View option.

Different icons are shown to indicate if the license is valid, expiring, or expired.

NOTE:
• If the validity of the license is more than 30 days, then feature license status is shown in green
icon.

• If the validity of the license is less than 30 days, then feature license status is shown in yellow
icon.

• If the license has expired, then feature license status is shown in red icon.

You can push the license on devices managed by Security Director and view the history of pushed licenses
on devices.

You can configure the schedule for polling devices for license details. If you want to send notification
regarding licenses that are about to expire, you can enable the license notification settings and add the
e-mail recipients. E-mail will be sent to the configured recipient with license expiry details.

Based on RBAC permission, you can perform actions such as view license information, deploy license on
devices, view the history of pushed licenses, view license information of a specific device, and modify the
notification settings. By default, Pre defined Roles for “Super Administrator, Security Architect and Security
Analyst” have the permissions to perform all actions. Where as “Security Operator Read Only” can only
view the license information.

User-defined (customized) roles can perform appropriate actions who are assigned the Super Administrator
or Security Architect or Security Analyst or Security Operator Read Only or by a role with the Create
License Management Privileges which you can find under Security Director Devices option in Create Role
page.

Benefits

• It’s easy to view the license statistics and take necessary actions.

• You know which license is installed on a particular device along with the license status.

• You can easily deploy license from Security Director to one or more device(s).
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You can install the license manually on the selected devices from Security Director. You can push the
license by either selecting a single SRX Series device or multiple VSRX devices at a time. Each license can
have one feature or multiple features and is valid on a single device. You can push the license on a device
either by uploading a license file or by copying and pasting the license key.

Deploy a License on a Device

To deploy a license on a device:

1. Select Devices > Licenses.

The Licenses page is displayed.

2. Select a device and click Push License.

The Push License page is displayed.

3. Select an option to deploy the license:

• Upload license file—You can browse and upload a license file as a .txt file.

• Copy/Paste license details—You can copy the license key from the license file and paste it in the
textbox. You must not edit the key.

4. Select Push License.

The job details are displayed. You can see the status of the Job in the Job Management page.

5. Click OK.
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View the License Push History Details

To view the history of deployed license details:

1. Select Devices > Licenses.

The Licenses page is displayed.

2. Select a device and click Push History.

The Push History page is displayed with details of the license deployed on the selected device.

3. Click OK.
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Firewall Policies Overview

Security Director provides you with two types of firewall policies:

• Device Policy—Type of firewall policy that is created per device. This type of policy is used when you
want to push a unique firewall policy configuration per device. You can create device rules for a device
firewall policy.

Security Director views a logical system or a tenant system like it does any other security device, and it
takes ownership of the security configuration of the logical system or tenant system. In Security Director,
each logical system or tenant system is managed as a unique security device.

During a device assignment for a device policy, only devices from the current domain are listed.

NOTE: If Security Director discovers the root logical system, the root lsys discovers all other
user lsys inside the device.

Security Director allows a device to have a device-specify policy and to be part of multiple group policies.
Rules for a device are updated in the following order:

• Rules within Policies Applied Before 'Device Specific Policies'

• Rules within Device-Specific Policies

• Rules within Policies Applied After 'Device Specific Policies'

Rules within Policies Applied Before 'Device Specific Policies' take priority and cannot be overridden.
However, you can override rules within Policies Applied After 'Device Specific Policies' by adding an
overriding rule in the Device-Specific Policies. In an enterprise scenario, “common-must-enforce” rules
can be assigned to a device from the Policies Applied Before ‘Device Specific Policies’, and
“common-nice-to-have” rules can be assigned to a device from the Policies AppliedAfter ‘Device Specific
Policies’.

NOTE: An exception can be added on a per device basis in “Device-Specific Policies” . For a
complete list of rules applied to a device, select Configure > Firewall Policy > Devices. Select
a device to view rules associated with that device.

All devices policy enables rules to be enforced globally to all the devices managed by Security Director.
All devices policy is part of the Global domain and is visible in all the child domains if the view parent is
enabled.

• Group—Type of firewall policy that is shared with multiple devices. This type of policy is used when you
want to update a specific firewall policy configuration to a large set of devices. You can select the policy
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placement to be before device specific or after device specific. When a group firewall policy is updated
on the devices, the rules are updated in the following order:

• Rules within Policies Applied Before 'Device Specific Policies'

• Rules within Device-Specific Policies

• Rules within Policies Applied After 'Device Specific Policies'

During a device assignment for a group policy, only devices from the current and child domains (with
view parent enabled) are listed. Devices in the child domain with view parent disabled are not listed.
Not all the group policies of the Global domain are visible in the child domain. Group policies of the
Global domain (including All device policy) are not visible to the child domain, if the view parent of that
child domain is disabled. Only the group policies of the Global domain, which has devices from the child
domain assigned to it, are visible in the child domain. If there is a group policy in global domain with
devices from both D1 and the Global domains assigned to it, only this group policy of the Global domain
is visible in the D1 domain along with only the D1 domain devices. No other devices, that is the
Device-Exception policy, of the Global domain is visible in the D1 domain.

You cannot edit a group policy of the Global domain from the child domain. This is true for All Devices
policy as well. Modifying the policy, deletion of the policy, managing a snapshot, snapshot policy and
acquiring the policy lock is also not allowed. Similarly, you cannot perform these actions on the
Device-Exception policy of the D1 domain from the Global domain. You can prioritize group policies
from the current domain. Group policies from the other domains are not listed.

NOTE: Group policies applied before (Pre) or after (Post) Device Specific Policies via Security
Director:

• Works separately for Global-based and Zone-based policies.

• Do not alter the Junos-SRX policy precedence order as stated in “Policy Ordering Overview”
on page 431.

The basic settings of a firewall policy are obtained from the policy profile. The basic settings include log
options, firewall authentication schemes, and traffic redirection options.

Firewall policies are displayed in a tabular view. You can select a policy and apply rules either inline or
using the + icon. For more information, see “Creating Firewall Policy Rules” on page 438.

Starting in Junos Space Security Director Release 19.3R1, you can assign IPS policy to the standard firewall
policy rule. The CLI is generated for the IPS policy along with the standard firewall policy (to which the
IPS policy is assigned) for devices with Junos OS Release 18.2 onward. Since the IPS policy name is directly
used in the firewall policy rule, the [edit security idp active-policy policy-name] statement is deprecated
in Junos OS Release 18.2 onward. You can import and convert the deprecated active policy CLI into a new
CLI from Security Director. You can import the IPS policy for the deprecated active-policy for Junos OS
version 18.2 and later. After the IPS policy is imported, the rules associated with the firewall policy for the
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device is updated with IPS policy details. On subsequent update from Security Director, you can see the
new firewall policy CLIs, in preview, to attach IDP and the same can be updated to device.

NOTE:
• In a device with Junos OS Release 18.2, you must assign same IPS policy to all the rules in the
firewall policy, otherwise commit fails.

• In a device with Junos OS Release 18.3 onward, you can assign different IPS policy to the rules
in the firewall policy. You must set a default IDP policy, otherwise commit fails.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Firewall Policies Best Practices | 437

Assigning Policies and Profiles to Domains | 521

Publishing Policies | 475

Configure a Default IDP Policy | 502

Policy Ordering Overview

By default, new policies go to the end of a policy lookup list. Therefore, it is possible for one policy to
eclipse or overshadow another policy. The order of configured policies is significant in how the device
handles traffic. Policy look up is performed in the order that policies are configured. The first policy that
matches the traffic is used. If a specific policy is listed after a general policy, it is highly probable that the
specific policy will not be used.

For example, if you have two policies configured for the same source zone, destination zone, source IP
address, and destination IP address, but one policy has permit-all and one has permit-mail, the policy with
permit-mail would never be matched if it is listed after the policy with permit-all.

Because policies execute in the order of their appearance, you must be aware of the following:

• Policy order is important.

• Newly created policies go to the end of the policy list.

• You can change the order of policies.

• The last policy in the policy list is the default policy, which has the default action of denying all traffic.
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Reordering a Policy

You can correct policy overshadowing by simply reversing the order of the policies, putting the more
specific one first.

NOTE: Policy ordering is extremely important in Virtual Private Networks (VPN) environments.
Listing a VPN or encryption policy first ensures that VPN traffic reaches the encryption policy,
not a general permit policy.

The S. No. (sequence number) column on the Zone Policy page allows you to reorder the policies:

• Use the S. No. column to type a number to change the policy order.

• Drag and drop a selected policy from one location to another.

The sequence number changes as you drag the policy or manually type a new sequence number. The
sequence numbers of all the policies below the newly moved policy also change.

NOTE: The drag and drop feature is disabled if you have filtered the policy list.

Order of Precedence for Policy Matches

For policy matches, it is important to understand how the firewall evaluates policies. Juniper calls a security
policy context the policy that is within the same source-destination zone pair. For instance, all policies
within source zone trust and destination zone untrust are in the same context . Figure 1 shows the order
in which policies are looked up.
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Figure 53: Policy Lookup

In terms of context precedence, SRX Series devices support the following order of precedence:

1. Match intrazone policies: The initial packet in an unknown session is evaluated to determine if the
source and destination zones are the same. This occurs if both the ingress and egress interfaces are in
the same zone. This context match has the highest precedence and is matched first.

2. Match interzone policies: If the session does not match an intrazone context or policy, then the next
policy is for a source zone and destination zone context. If the contextmatches, then the policies within
that context are evaluated for a match. Interzone policies are only evaluated if there is no matching
intrazone policy match.

3. Global policies: If there is no policymatch for either intrazone or interzone policies, then the next policy
match is the global policy. A global policy matches any zone context, but it has the same match criteria
for the policies as any other security policy (for example, source IP address, destination address, services,
user object, and so forth). It is the last policy set that is evaluated after intrazone and interzone policies.

4. Default action: this action is taken if there is no match on intrazone, interzone, or global policies.
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RELATED DOCUMENTATION

Firewall Policies Overview | 429

Creating Firewall Policies | 434

Creating Firewall Policies

Use the Create Firewall Policies page to configure group or device policies that determine all the network
resources within your organization and that identify the required security level for those resources.

Before You Begin

• Read the Firewall Policies Overview topic.

• Review the firewall policies main page for an understanding of your current data set. See “Firewall Policies
Main Page Fields” on page 480 for field descriptions.

• Create source (from-zone) and destination (to-zone) zones.

• Create addresses and address sets.

• Create services (applications) and service sets (application sets).

To create a firewall policy:

1. Select Configure > Firewall Policy > Standard Policies.

The Standard Policies page is displayed.

2. Click the + icon.

3. Complete the configuration according to the guidelines provided in Table 160 on page 435.

4. Click OK. A firewall policy is created. You can click on the policy to assign rules inline or select the
policy and click the + icon to configure policy rules. See “Creating Firewall Policy Rules” on page 438.

A new policy is created according to your configuration. You can use this policy to assign rules, profiles,
and schedules, To enable a policy, you must assign it to a domain. See “Assigning Policies and Profiles to
Domains” on page 521.

434



Table 160: Firewall Policy Settings

GuidelineSetting

General Information

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores.
Maximum length is 255 characters.

Name

Enter a description for the group policy rules; maximum length is 255 characters. Comments
entered in this field are sent to the device.

Description

Policy Options

Select a profile for the policy:

• Log Session Init—Record entries for session start events. A traffic log that records session start
events does not include bytes sent and received or session duration, but you can use the log to
verify when the session was initially created.

• Log Session Close—Record entries for session close events. A traffic log that records session
close information also lists a reason for the end of the session.

• All Logging Enabled—Logs are created for both session initiation and session closing. Logs can
be used for troubleshooting.

• All Logging Disabled—Logs are not recorded for both session initiation and session closing.

Profile

Select the type of policy you want to create:

• Group Policy—Firewall policy that is shared with multiple devices. This type of policy is used
when you want to update a specific firewall policy configuration to a large set of devices. You
can create group prerules, group postrules, and device rules for a group policy.

• Device Policy—Firewall policy that is created per device. This type of policy is used when you
want to push a unique firewall policy configuration per device. You can create device rules for
a device firewall policy. During a device assignment for a device policy, only devices from the
current domain are listed.

Type

Device Selection
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Table 160: Firewall Policy Settings (continued)

GuidelineSetting

Starting Junos Space Security Director Release 16.2, both SRX Series devices andMX Series routers
are listed. When a policy is published to a device, device-specific rules are published to the
appropriate SRX Series devices or MX Series routers.

Select the devices on which the group policy will be published. For a group policy, you can include
both SRX Series devices andMX Series routers. Select devices from the Available column and click
the right arrow to move these devices to the Selected column. For device only policy, select the
device with which you want to associate the policy.

NOTE: You can also search for devices by entering the device name, device IP address, or device
tags in the Search fields in the Devices area. Once the searched devices appear, you can move
them to the Selected pane.

NOTE: Starting in Junos Space Security Director Release 20.1R1, logical system (LSYS) is supported
on devices running Junos OS Release 18.3 and later.

Starting in Junos Space Security Director Release 21.2R1, tenant system (TSYS) is supported on
devices running Junos OS Release 18.3 and later for SRX Series devices and Junos OS Release
20.1 and later for VSRX Series devices.

Devices

Policy Sequence

(For Group Policy only). Select Before Device Specific Policies or After Device Specific Policies.
This decides the policy order when the devices policy configuration information is updated on the
devices.

Policy Placement

(For Group Policy only). Select this option to specify the order number for the policy. Policy lookup
is performed in the order that the policies are configured. The first policy that matches the traffic
is used. For more information, see “Policy Ordering Overview” on page 431.

Policy Sequence
No.

Release History Table

DescriptionRelease

Starting Junos Space Security Director Release 16.2, both SRX Series devices and MX
Series routers are listed.

16.2

RELATED DOCUMENTATION

Firewall Policies Overview | 429

Firewall Policies Best Practices | 437
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Creating Firewall Policy Rules | 438

Policy Ordering Overview | 431

Publishing Policies | 475

Firewall Policies Best Practices

A secure network is vital to a business. To secure a network, a network administrator must create a security
policy that outlines all of the network resources within that business and the required security level for
those resources. The policy applies the security rules to the transit traffic within a context (source zone
and destination zone) and each policy is uniquely identified by its name. The traffic is classified bymatching
source and destination zones, source and destination addresses, and the service (application) that the
traffic carries in its protocol headers with the policy database in the data plane.

Configuring security policies to enforce traffic rules in a network can be relatively easy but requires careful
consideration. There are several best practices to use when defining an effective firewall policy to ensure
better use of system memory and to optimize policy configuration:

1. Use least privilege policies—Make the firewall rules as tight as possible in terms of match criteria and
permitting traffic. Only permit traffic that is allowed by your organizational policy and deny all other
traffic. This is true for both ingress and egress traffic, meaning traffic from the Internet to internal
resources and also traffic from internal resources to the Internet. A least privilege security policy helps
to minimize the attack surface, making other controls more effective.

2. Segment logically—Zone-based firewalls allow you to place different interfaces into different zones.
This allows you to design your network such that you can place resources in amanner where the firewall
can enforce controls (interzone and intrazone policies).

3. Place specific firewall rules first—Place themost explicit firewall rules at the top of the rule base because
traffic is matched starting at the top of the rulebase and going down with the first match.

4. Use address sets where possible—Address sets simplify administration of firewall policies. They allow
you to group large sets of objects so that you can address them as a single object in a security policy.
The more rules you can reference to the address sets, the easier it is to make changes because most
organizations have logical objects that can be grouped

Use single prefixes for source and destination addresses. For example, instead of using /32 addresses
and adding each address separately, use a large subnet that covers most of the IP addresses you require.
Use fewer IPv6 addresses because IPv6 addresses consume more memory.

5. Use service sets where possible—Service sets simplify administration of firewall policies. They allow
you to group large sets of objects so that you can address them as a single object in a security policy.
Use service “any” whenever possible. Each time you define an individual service in the policy, you can
use additional memory.
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6. Use fewer zone pairs in policy configurations—Each source and destination zone uses about 16,048
bytes of memory. We recommend using global policies wherever possible. Global policies provide you
with the flexibility to perform action on traffic without the restrictions of zone specifications.

7. Use explicit drop rules—To ensure that undesired traffic does not leak through a security policy, place
an any-any-any drop rule at the bottom of each security zone context (for example, source zone to
destination zone) along with a global policy. This does not mean that you should not define your firewall
rules, it simply provides a catch-all mechanism for capturing unclassified traffic.

8. Use logging—We highly recommend that you log on all firewall policies. Logging provides you with an
audit trail of all network activity, which helps in troubleshooting and diagnosis. Unless you are
troubleshooting, it is best to use the Log on Session Close option instead of the Log on Session
Initialization option. Session Close logs include a great deal more information about the session; this
information is useful for diagnostic purposes.

9. Use Network Time Protocol (NTP)—NTP is a widely used protocol used to synchronize the clocks of
routers and other hardware devices on the Internet. If any of the device clocks is wrong, then not only
logs and troubleshooting information can be incorrect, but also security policy objects such as schedulers
can have unintended results.

10.Check memory utilization—Check your memory usage before and after compiling policies.

RELATED DOCUMENTATION

Firewall Policies Overview | 429

Creating Firewall Policies | 434

Creating Firewall Policy Rules

Use the Create Rule page to configure firewall rules that control transit traffic within a context (source
zone to destination zone). The traffic is classified by matching its source and destination zones, the source
and destination addresses, and the application that the traffic carries in its protocol headers with the policy
database.

Security Director allows a device to have a device-specific policy and to be part of multiple group policies.
Rules for a device are updated in this order:

• Rules within Policies Applied Before 'Device Specific Policies'

• Rules within Device-Specific Policies

• Rules within Policies Applied After 'Device Specific Policies'
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Rules within Policies Applied Before 'Device Specific Policies' take priority and cannot be overridden.
However, you can override rules within Policies Applied After 'Device Specific Policies' by adding an
overriding rule in the Device-Specific Policies. In an enterprise scenario, “common-must-enforce” rules
can be assigned to a device from the Policies Applied Before ‘Device Specific Policies’, and
“common-nice-to-have” rules can be assigned to a device from the Policies Applied After ‘Device Specific
Policies’.

NOTE: An exception can be added on a per device basis in “Device-Specific Policies” . For a
complete list of rules applied to a device, select Configure > Firewall Policy > Devices. Select a
device to view rules associated with that device.

Before You Begin

• Read the Overview Firewall Policies topic.

• Review the Firewall Rules main page for an understanding of your current data set. See “Firewall Policy
Rules Main Page Fields” on page 481 for field descriptions.

To configure a firewall policy rule:

1. Select Configure > Firewall Policy.

2. Select the policy for which you want to define rules and click the + icon.

The Create Rules page appears.

NOTE: To edit and create rules inline, click the policy to make the fields editable.

3. Complete the configuration according to the guidelines provided in Table 161 on page 439.

4. Click OK.

The rules you configured are associated with the selected policy.

Table 161: Firewall Policy Rules Setting

GuidelineSetting

General Information
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Table 161: Firewall Policy Rules Setting (continued)

GuidelineSetting

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores. No
spaces are allowed and the; maximum length is 63 characters.

Rule Name

Enter a description for the policy rules; maximum length is 1024 characters. Comments entered
in this field are sent to the device.

Description

Identify the traffic that the rule applies to

For SRX Series devices, specify a source zone (from-zone) to define the context for the policy.
Zone policies are applied on traffic entering one security zone (source zone) to another security
zone (destination zone). This combination of a source zone and a destination zone is called a
context.

Starting in Junos Space Security Director Release 16.2, for MX Series routers, the source zone
field acts as an ingress interface from where the packet enters. The match direction is input, if
the packet is entering the interface. The match direction is output, if the packet is leaving the
interface. Configure the ingress key by selecting the aggregated multiservices (AMS) value.

Starting in Junos Space Security Director Release 16.2, polymorphic zones can be used as source
zone and destination zone, when you assign SRX Series devices and MX Series routers to the
same group policy.

(Source) Zone
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Table 161: Firewall Policy Rules Setting (continued)

GuidelineSetting

Enter one or more address names or address set names. Click Select to add source addresses.

On the Source Address page:

• Include Any Address—Add any address to the firewall rule.

• Include Specific—Add the selected source address to the rule.

When you add an NSXmanager, the security groups are synchronized and the corresponding
dynamic address groups (DAG) are created in Security Director database. For your NSX
manager, select the required DAGs from the list.

• Exclude Specific—Exempt the selected source addresses from the rule.

• By Metadata Filter—Choose the matching address of a user-defined metadata as the source
address.

• Metadata Filter—Click the field to select the required metadata from the list. The matching
addresses are filtered and listed in the Matched Address field.

• Matched Addresses—Lists the addresses matching the selected metadata. This address is
used as a source address.
For every metadata expression, a unique dynamic address group (DAG) is created. This
DAG has the feed server URL pointing to the feed server URL of Security Director.

Office 365 is now included in the list of third party feeds to push Microsoft Office 365
services endpoint information (IP addresses) to the SRX Series device. This feed works
differently from other feeds and requires certain configuration parameters, including a
pre-defined name of “ipfilter_office365”. You must enable the Office 365 feed in Juniper
ATP Cloud. To understand how to enable the Office 365 feed in Juniper ATP Cloud and
create aDAGon the SRX Series device that refers to the ipfilter_office365 feed, see Enabling
Third Party Threat Feeds.

Configure the feed server URL by using the following CLI command to each SRX Series
device or vSRX that acts on the metadata based policies.

set security dynamic-address feed-server <SD IP Address> hostname <SD IP Address>

See “Creating Addresses and Address Groups” on page 1026.

(Source) Address(es)
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Table 161: Firewall Policy Rules Setting (continued)

GuidelineSetting

Specify the source identity (users and roles) to be used as match criteria for the policy. You can
have different policy rules based on user roles and user groups.

Click Select to specify source identities to permit or deny. On the User ID page, you can select
a user identity from the available list or you can add a new identity by clicking Add New User
ID.

To delete a user identity from the Security Director database, click Delete User ID and select
a value from the drop-down list, which is not configured in any policy. If you try to delete a user
identity which is configured in a policy, a messagewith its reference ID and user ID are displayed.

NOTE: The user IDswhich are only created in Security Director are displayed in the drop-down
list.

(Source) User ID

Select an end user profile from the list. The firewall policy rule is applied to it.

When traffic from device A arrives at an SRX Series device, the SRX Series obtains the IP address
of device A from the first traffic packet and uses it to search the device identity authentication
table for a matching device identity entry. Then it matches that device identity profile with a
security policy whose End User Profile field specifies the device identity profile name. If a match
is found, the security policy is applied to traffic issuing from device A.

(Source) End User
Profile

For SRX Series devices, specify a destination zone (to-zone) to define the context for the policy.
Zone policies are applied on traffic entering one security zone (source zone) to another security
zone (destination zone). This combination of a source zone and a destination zone is called a
context.

Starting in Junos Space Security Director Release 16.2, for MX Series routers, this field acts as
an egress interface from where the packet enters. The match direction is input, if the packet is
entering the interface. The match direction is output, if the packet is leaving the interface.
Configure the egress key by selecting the aggregated multiservices (AMS) value.

Polymorphic zones can be used as source zone and destination zone, when you assign SRX
Series devices and MX Series routers to the same group policy.

(Destination) Zone
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Table 161: Firewall Policy Rules Setting (continued)

GuidelineSetting

Select one or more address names or address sets. Click Select to add destination addresses.

On the Destination Address page:

• Select the Include option to add the selected destination addresses or any address to the
rule.

• Select the Exclude option to exempt the selected destination addresses from the rule.

• Select the By Metadata Filter option to choose the matching address of a user-defined
metadata as the destination address.

• Metadata Filter—Click the field to select the required metadata from the list. The matching
addresses are filtered and listed in the Matched Address field.

• Matched Addresses—Lists the addresses matching the selected metadata. This address is
used as a destination address.
For every metadata expression, a unique dynamic address group(DAG) is created. This
DAG has the feed server URL pointing to the feed server URL of Security Director.

Office 365 is now included in the list of third party feeds to push Microsoft Office 365
services endpoint information (IP addresses) to the SRX Series device. This feed works
differently from other feeds and requires certain configuration parameters, including a
pre-defined name of “ipfilter_office365”. You must enable the Office 365 feed in Juniper
ATP Cloud. To understand how to enable the Office 365 feed in Juniper ATP Cloud and
create aDAGon the SRX Series device that refers to the ipfilter_office365 feed, see Enabling
Third Party Threat Feeds.

Configure the feed server URL by using the following CLI command to each SRX Series
device or vSRX that acts on the metadata based policies.

set security dynamic-address feed-server <SD IP Address> hostname <SD IP Address>

See “Creating Addresses and Address Groups” on page 1026.

(Destination)
Address(es)

Select one or more predefined or custom URL category as a match criterion. URL category is
supported on devices running Junos OS Release 18.4R3 and later.

Click Select to select a URL category. Select one or more predefined or custom URL categories
from the Available list and move them to the Selected list. Click OK.

(Destination) URL
Category

Select one or more service (application) names. Select the Include, Any Service to disable the
any option in the services list builder. Clear the Any Service check box to permit or deny services
from the services list builder available column. Click Add New Service to create a service. See
“Creating Services and Service Groups” on page 1040.

(Service Protocols)
Services

Click the + icon to add the application signatures. You can add both predefined and custom
application signatures.

Application
Signatures
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Table 161: Firewall Policy Rules Setting (continued)

GuidelineSetting

Advanced Security

Action applies to all traffic that matches the specified criteria.

• Deny—Device silently drops all packets for the session and does not send any active control
messages such as TCP Resets or ICMP unreachable.

• Reject—Device sends a TCP reset if the protocol is TCP, and device sends an ICMP reset if
the protocols are UDP, ICMP, or any other IP protocol. This option is useful when facing
trusted resources so that the applications do not waste time waiting for timeouts and instead
get the active message.

• Permit—Device permits traffic using the type of firewall authentication you applied to the
policy.

• Tunnel—Device permits traffic using the type of VPN tunneling options you applied to the
policy.

Rule Action
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Table 161: Firewall Policy Rules Setting (continued)

GuidelineSetting

Advanced Security
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Table 161: Firewall Policy Rules Setting (continued)

GuidelineSetting

Firewall policies provide a core layer of security that ensures that network traffic is restricted
to only that which a policy dictates through its match criteria.

Firewall policies provide a core layer of security that ensures that network traffic is restricted
to only that which a policy dictates through its match criteria. When the traditional policy is not
enough, select application identification components to create an advanced security profile for
the policy:

• App Firewall—Select this option to enforce traditional firewall controls on the traffic while
layering application firewall to ensure that applications conform not only to the port
information but also to what is transmitted between a client and a server. You can permit,
deny, and reject applications. There is also a special redirect feature for HTTP and HTTPS.

Click the Add New link to create application firewall policy and click Add New APPFW Rule
to create rules. See “Creating Application Firewall Policies” on page 548.

• SSL Forward Proxy—Select this option to enable an application-level protocol that provides
encryption technology for the Internet.

Click Add Forward Proxy to create SSL Forward Proxy Profiles. See “Creating SSL Forward
Proxy Profiles” on page 580.

Click Add Reverse Proxy to create SSL Reverse Proxy Profiles. See “Creating SSL Reverse
Proxy Profiles” on page 588.

• IPS—Select the IPS value as On or Off.

• IPS Policy—Provides support for IPS policy within the standard firewall policy. Select an IPS
policy to assign to the firewall policy. IPS policies that are not assigned to any device are
listed in the drop-down.

For devices with JunosOS Release 18.2 onward, CLI configuration for the assigned IPS policy
is generated along with the standard firewall policy.

NOTE: The rule action should be Permit.

• In Junos OS Release 18.1 and earlier, if you have configured a policy with both IPS as On
or Off and an IPS policy, Security Director ignores the IPS policy and sends only IPS On
CLI command to the device.

• In Junos OS Release 18.2 and later, if you have configured a policy with both IPS as On or
Off and an IPS Policy, Security Director ignores the IPS On CLI command and sends only
the IPS policy CLI command to the device.

• UTM—Select this option to define Layer 7 protection against client-side threats.

Click Add New to create UTM policies. See “Creating UTM Policies” on page 762.

• SecureWebProxy—Select a secureWeb proxy profile created in “Create a SecureWeb Proxy
Profile” on page 532.

You can use secureWeb proxy to enable traffic for selected applications to bypass the external
proxy server and sent directly to a webserver.

446



Table 161: Firewall Policy Rules Setting (continued)

GuidelineSetting

Threat Prevention Policy—Select an option to provide protection and monitoring for the
selected threat profiles, including command and control servers, infected hosts, andmalware.

•

NOTE: For creating inline application firewall policy, SSL proxy profiles, and UTM, the rule
action must be permit.

Juniper ATP Cloud Adaptive Threat Profiling allows SRX Series devices to generate, propagate,
and consume threat feeds based on their own advanced detection and policy-match events.

Starting in Junos Space Security Director Release 21.2, you can configure a firewall policy with
source and destination addresses as threat types, which injects the source IP address and
destination IP address into the selected threat feed when traffic matches the rule. Threat feed
can be leveraged by other devices as a dynamic-address-group (DAG).

Add Source IP to Feed—Select a security feed from the list. The source IP address is added to
the threat feed when the traffic matches the rule.

Add Destination IP to Feed—Select a security feed from the list. The destination IP address is
added to the threat feed when the traffic matches the rule.

NOTE: To use these fields, first enroll the devices in ATP Cloud and then configure Policy
Enforcer to display feeds in the drop-down list.

Threat Profiling

Rule Options

Select a default profile or a custom profile, or you can inherit a policy profile from another
policy. Policy profile specifies the basic settings of a security policy. See “Creating Firewall Policy
Profiles” on page 513.

Profile

Policy schedules allow you to define when a policy is active, and thus are an implicit match
criterion. You can define the day of the week and the time of the day when the policy is active.
For instance, you can define a security policy that opens or closes access based on business
hours. Multiple schedulers can be applied to different policies, but only one scheduler can be
active per policy. Select a pre-saved schedule and the schedule options are populated with the
selected schedule’s data. Click New to create another schedule.

Schedule

Rule Analysis

Select this option if you want to analyze your rules to avoid any anomalies.New Rule, Perform
Analysis

Rule Placement
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Table 161: Firewall Policy Rules Setting (continued)

GuidelineSetting

Displays the sequence number and the order in which the rule is placed.Location/Sequence

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.2, for MX Series routers, the source zone
field acts as an ingress interface from where the packet enters.

16.2

Starting in Junos Space Security Director Release 16.2, polymorphic zones can be used as source
zone and destination zone, when you assign SRX Series devices and MX Series routers to the
same group policy.

16.2

Starting in Junos Space Security Director Release 16.2, for MX Series routers, this field acts as
an egress interface from where the packet enters.

16.2
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Rule Base Overview

In Security Director, you can configure one type or both types (zone-based or global) of rule bases for
each policy. All zone-based rules are grouped under Zone and all devices rules are grouped under Global.
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If devices are assigned to a policy that does not have one of the rule bases under its management, Security
Director still interprets that rule base as being in its scope. For example, if you configure firewall policies
out of band on a device in an unmanaged rule base, Security Director deletes those policies. If you do not
select the previously configured rule base in the Security Director modify workflow for the policy, Security
Director automatically deletes all rules in the policy in the next publish and update.

Example: Removing a Previously Managed Rule Base

You can remove a managed device from Security Director. To remove a previously managed rule base
when no other policies are published on the device except the existing policy, follow these guidelines:

• Do not select the Manage Global Policy option to modify a device policy in Security Director.

Security Director deletes the global rule base in the design data of the Security Director application.

• Publish a policy and update the device. The update deletes all global rules from the device.

On successful update, the all-devices policy for the device is removed fromSecurityDirectormanagement.

NOTE: Security Director will continue to delete any all-devices policy configured on the device
through the CLI at subsequent publish updates.

Policy Analysis

Over a period of time, firewall rule bases can become inefficient as rules become disorganized, causing
some rules to become ineffective. This primarily occurs because of a lack of timely notification given to
end users when new rules, or changed rules, are added, which can adversely affect the other rules in the
rule base.

This problem can be addressed by analyzing the policy and reporting the anomalies in the rules of a policy
to the end user. Policy analysis reports on shadowing and redundant anomalies in a rule; these reports are
available in PDF format. Also, policy analysis finds the anomaly between the address and the service of
the rules.

Policy analysis helps you to analyze the firewall rule base for policies managed by Security Director, and
it identifies the firewall rules that contain the following issues:

• Shadowing—Occurs when a rule higher in the order of the rule base matches with all the packets of a
rule lower in the order of the rule base. The shadowed rule is never activated. The possible solution is
to reorder the rules, or disable or delete one of the rules. The anomaly calculation is not made for disabled
rules.

• Redundant—Occurswhen there are two ormore rules that perform the same action on the same packets
along with the same settings or configurations. The solution is to disable or delete the redundant rules.
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The policy analysis report is generated in PDF format and can be sent through e-mail tomultiple recipients.
The reports contain a summary and a pie chart showing all anomalies. You can schedule the report
generation.

The following list shows the policy analysis behavior for different types of firewall policies:

• All devices policy—Analyzes all the rules present in the firewall policy landing page, within the all-devices
policy.

• Group policy—Analyzes all the rules present in the firewall policy landing page, within the group policy
including the all-devices policy rules.

• Device policy—Analyzes all the rules present in the firewall policy landing page, within the device policy
including the all-devices policy rules. If you want to analyze all the rules present on a device, you must
generate the report by clicking the device policy.

• Device exception policy—Analyzes all the rules present in the firewall policy landing page, within the
device exception policy including all-device.

Policy analysis is not performed in the following scenarios:

• Disabled rules are not considered for the policy analysis calculation.

• Apart from the Address (source and destination) and Service columns, no other columns in the firewall
landing page are considered for the policy analysis calculation.

• Variable address, wild card address, and exclude address are not considered for the policy analysis
calculation.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Creating Firewall Policy Rules | 438

Firewall Policies Best Practices | 437

Firewall Policy Locking Modes

IN THIS SECTION

Manually Locking a Policy | 451

Manually unlocking a Policy | 452

Switching Manual Lock to Automatic Lock for a policy | 452
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Starting in Security Director Release 18.3R1, you can manually lock a policy. By default, the locking mode
for policies is automatic and policies are automatically locked when you start editing the rules. When you
leave the rules editing page, the policy is automatically unlocked. The timeout interval for automatic locking
is 15 minutes.

However, if required, you can choose the option to manually lock a policy. There is no timeout interval in
case of manual lock. When you lock the policy and leave the page or log out, the policy remains locked.
After you have completed editing the policy, you can unlock the policy and it then becomes available to
other users for editing. The policy can be unlocked by the same user or by any other user with the same
RBAC permissions. Only those users who have the permission to lock or unlock a policy are able to toggle
between automatic mode and manual mode.

Manually Locking a Policy

To manually lock a policy:

1. Select Configure>Policy-Name Policy>Policies.

2. SelectManual Mode from the Locking list.

A warning message is displayed.

3. Click Yes to toggle the locking mode.

All the existing locks in the policies are released and the user is switched to manual mode.

4. Right-click the policy that you want to edit, or select Lock Policy from the More list.

A message is displayed for confirmation.

5. Click Yes to lock the policy.

The policy will be locked. You can see a lock icon next to the check box on the policies page.

NOTE: In the manual mode, if the user starts to edit the policy without manually locking it, the
policy is locked by the system like in auto mode. However, the user must manually unlock the
policy and then it will be available for other users for editing.
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Manually unlocking a Policy

To manually unlock a policy:

1. Select Configure>Policy-Name Policy>Policies.

2. Right-click the policy that you want to unlock, or select Unlock Policy from the More list.

A message is displayed for confirmation.

3. Click Yes to unlock the policy.

The policy will be unlocked. The lock icon next to the check box will disappear.

NOTE: If User1 has locked a policy and User2 with the same RBAC capability unlocks the same
policy, then a message is displayed that any unsaved changes made by User1 will be lost.

Switching Manual Lock to Automatic Lock for a policy

While switching from manual lock to automatic lock and vice versa, all the existing locks in the policies
will be released.

To switch to automatic locking mode:

1. Select Configure>Policy-Name Policy>Policies.

2. Select Auto Mode from the Locking list.

A warning message is displayed.

3. Click Yes to toggle the locking mode.

All the existing locks in the policies are released and the user is switched to Auto mode.

NOTE: In the auto mode, the policies are automatically locked when a user starts editing the
rules.

RELATED DOCUMENTATION

452



Creating Firewall Policy Rules | 438

Rule Operations on Filtered Rules Overview

You can perform various rule operations on the filtered list of rules. For example, consider a policy having
seven rules such as a, b, c, d, e, f, and g in an order inside a rule group. After filtering, if only second and
sixth rules are filtered, that is only rules b and f,

The following table explains the various rule operations on the filtered rules.

DescriptionRule Operation

Group policies are sorted alphabetically in ascending order.Alphabetical A-Z

Group policies are sorted alphabetically in descending order.Alphabetical A-Z

Group policies are sorted in the order Low, Medium, and High. For the same
priorities, the higher precedence number is placed in the top. For example, Low
3 has lower precedence than Low 2.

Group Priority (High-Low)

Group policies are sorted in the order Low, Medium, and High. For the same
priorities, the higher precedence number is placed in the top. For example, Low
3 has lower precedence than Low 2.

Group Priority (Low-High)

Policies are listed based on creation time. The policy created first is placed at the
top.

Created Time

Last modified policies are placed at the bottom(last).Modified Time

NOTE: You cannot set the precedence value greater than the available precedence values that
are assigned to the available priority policies. Based on the priority of the policies, the precedence
values are applied.

RELATED DOCUMENTATION

Firewall Policies Overview | 429

Creating Firewall Policies | 434
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Create and Manage Policy Versions

IN THIS SECTION

Create Policy Snapshots | 454

Manage Policy Versions | 455

Roll Back Policy Versions | 455

Compare Policy Versions | 456

Delete Policy Versions | 456

You create a policy version by taking a snapshot of another policy. You can create versions for all types
of policies including All Devices, Group, Device, and Device exceptions.

The maximum number of versions maintained for any policy is 60. If the maximum limit is reached, you
must delete the unwanted versions before saving a new version. Versioning and rollback are independent
operations for each policy.

For example, if you take a snapshot of a group firewall policy, or roll back to a previous firewall policy
version, it does not change the version for all device policy rules; you must separately version each policy
rule.

Create Policy Snapshots

To create a policy version:

1. Select Configure>Firewall Policy>Policies.

2. Select the check box next to the policy for which you are taking a snapshot, and then right-click the
policy or clickMore.

A list of actions appears.

3. SelectManage/Rollback Policy.

The Manage Version page appears.

4. Click Create Snapshot.
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The Snapshot Policy page appears.

5. Enter your comments in the Comments field, and click Create to take a snapshot. The Snapshot Policy
window appears, showing the status of the version as it is created.

NOTE: During policy publish, Security Director takes an automatic snapshot of the policy.

Manage Policy Versions

You can view or manage all available versions of a selected policy. You can perform the following tasks
on the snapshots:

• Roll back to a specific version.

• View the differences between any two versions (including the current version) of the policy

• Delete one or more versions from the system.

Roll Back Policy Versions

To roll back the selected version so it becomes the current version:

1. Select Configure>Firewall Policy>Policies.

2. Select the check box next to the policy for which you are rolling back a version, and then right-click
the policy or clickMore.

A list of actions appears.

3. SelectManage/Rollback Policy.

The Manage Version page appears.

4. Select the version that you want to make as the current version, and click Rollback.

The rollback operation replaces all the rules and rule groups of the current version with rules and rule
groups from the selected version. For all the shared objects, Object Conflict Resolution (OCR) is done.
If there are any conflicts between the versioned data and the current objects in the system, the OCR
window is displayed.
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5. After finishing any conflict resolution, click Next to view the OCR summary report.

6. Click Finish to replace the current policy with the versioned data. A summary of the snapshot policy is
shown by clicking Snapshot.

Compare Policy Versions

To compare two different versions of a policy:

1. Select Configure>Firewall Policy>Policies.

2. Select the check box next to the policy for which you want to compare versions, and then right-click
the policy or clickMore.

A list of actions appears

3. SelectManage/Rollback Policy.

The Manage Version page appears.

4. Select the versions to be compared, and click Compare. You can only compare two versions at a time.

The Compare Versions page appears.

5. Click Compare to view the results.

A Compare Versions results window appears showing the differences between the selected versions.

The Compare Versions results window has the following sections:

• Policy Property Changes—Shows policy changes for the modified rules.

• Rule Changes—Displays rules that are added, modified, or deleted.

• Column Changes—Shows the differences between the column content for modified rules.

Delete Policy Versions

To delete a policy version:

1. Select Configure>Firewall Policy>Policies.

2. Right-click the policy or profile or clickMore.

A list of actions appears.
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3. ClickManage/Rollback Policy.

The Manage Version page appears.

4. Select the policy version you want to delete and click Delete.

A warning message is displayed.

5. Click Yes to confirm the deletion.

The selected policy version is deleted.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Assigning Devices to Policies

Once you create a group or device policy, you can assign devices to it.

To assign devices to a policy:

1. Select Configure >Policy-Name Policy> Policies.

The Policies landing page appears.

2. Right-click the policy to which you want to assign devices, or select Assign Devices from the More
menu.

The Assign Devices page appears. The Name field shows the name of the selected policy and is not
editable.

3. Select the Show only devices without policy assigned check box.

Only devices that are not assigned to any policy are displayed in the Device Selection section.

4. Select the devices you want to add to the policy from the Available column and click the right arrow
to move these devices to the Selected column.
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NOTE: There is an option to search for devices in the Selected column on the Assign Devices
page. By default, all selected devices are sorted in a list and you can search for devices again,
if required.

5. Click OK to assign the selected devices to the selected policy.

NOTE: If you do not have permission to certain devices, those devices are not visible while
assigning devices to a new or existing policy.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Comparing Policies

Security Director enables you to compare two policies.

To compare any two policies:

1. Select Configure and select the landing page for the type of policy that you want to compare. For
example, Select Firewall Policies.

2. From the landing page, right-click the policy or clickMore.

A list of actions appears.

3. Select Compare Policy to compare with other policies.

The Compare Policy page appears.

4. Select the policy to compare with, and click OK.

The compare result of the two policies are displayed.

RELATED DOCUMENTATION

458



Creating Firewall Policies | 434

Creating NAT Policies | 707

Creating IPS Policies | 640

Export Policies

IN THIS SECTION

Export a policy to PDF | 459

Export a policy to a ZIP file: | 459

Starting in Security Director Release 16.1, you can export any policies (firewall, IPS, or NAT) in a PDF or
ZIP file from their respective Policies landing page.

NOTE: Policies can either be exported as PDF or ZIP file. The policies exported as ZIP file are
in XML format.

Export a policy to PDF

1. Select Configure > Firewall Policy > Policies.

The Policies landing page appears.

2. Right-click the policy you want to export or select Export Policy to PDF from the More menu.

The Export Policy to PDF page appears.

3. Click Export.

The selected policy details are exported into a PDF file.

Export a policy to a ZIP file:

1. Select Configure > Firewall Policy > Policies.

The Policies landing page appears.
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2. Right-click the policy you want to export or select Export Policy to Zip File from the More menu.

The Export Policy page appears.

3. Click Export.

The selected policy details are exported into a ZIP file.

Release History Table

DescriptionRelease

Starting in Security Director Release 16.1, you can export any policies (firewall, IPS, or NAT)
in a PDF or ZIP file from their respective Policies landing page.

16.1

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Creating Custom Columns

Starting Security Director Release 15.2, you can create a custom column. This is used for tracking specific
notes on rules such as internal ticket numbers, changes to firewall policy rules, changes in rule ownership,
and so on. The custom column is a user-defined column that is appended to the other columns on the
rules page of any firewall policy. Data in these columns can be captured and saved in the same way as in
the other columns.

Once you enter or modify data in a custom column, you can search the data. Security Director searches
for the data and displays the results with the policy details and the rules that have the custom column
data.

NOTE: To create, edit, or delete custom columns, assign the predefined or user-defined role
with the appropriate custom column privileges to the users.
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To create a custom column for firewall policies:

1. Select Configure > Firewall Policy > Policies.

The policies page appears.

2. Right-click a policy or selectManage Custom Columns from the More list.

The Manage Custom Columns page appears.

3. Click the + icon to create a custom column.

The Add Custom Column page appears.

4. Enter the following details:

a. Name—Enter a unique string of alphanumeric characters, periods, dashes, spaces, and underscores.
The maximum length is 32 characters. This is a mandatory field.

b. Validation Pattern—Enter the regular expression to validate the entered data. For example, the
typical e-mail regular expression looks like this:

^[_A-Za-z0-9-]+(\\.[_A-Za-z0-9-]+)*@[A-Za-z0-9]+(\\.[A-Za-z0-9]+)*(\\.[A-Za-z]{2,})$.

This is an optional field. However, if you do not provide the regular expression, the custom column
data will not be validated.

NOTE: Security Director uses the following parameters to validate custom column data:

• Explicit regular expression—The optional regular expression property is defined for the
current custom column.

• Implicit length check—The maximum length of the data must be 256 characters. It is
applicable to all custom columns.

5. Click OK to create the custom column.

The new custom column is listed in the Manage Custom Columns page.

NOTE: You can create a maximum of three custom columns.

You can view the columns that you create on the rules page of any firewall policy. Click a policy name
to view the rules associated with the policy. The new custom columns appear at the end of the grid on
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the rules page. The custom columns are not specific to a policy and are visible on rules pages of all the
firewall policies.

NOTE:
• You can edit the data in the custom column and the corresponding policy rules through an
inline edit.

• Custom columns are exported when a firewall policy is exported.

Release History Table

DescriptionRelease

Starting Security Director Release 15.2, you can create a custom column. This is used for
tracking specific notes on rules such as internal ticket numbers, changes to firewall policy rules,
changes in rule ownership, and so on

15.2

RELATED DOCUMENTATION
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Creating Firewall Policies | 434

Creating Firewall Policy Rules | 438

Promoting to Group Policy

If your policy type is a device policy, then you can promote the policy to a group policy.

To promote a device policy to a group policy:

1. Select Configure > Firewall Policy.

The Policies page is displayed.

2. Select a policy, right-click the policy or select Promote to Group Policy from the More list.

The Promote to Group Policy page is displayed.
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NOTE: The Promote to Group Policy option is enabled only when the policy type is device
policy.

3. Enter the parameters according to the guidelines in Table 162 on page 463.

4. Click OK.

The policy is promoted from device policy to group policy.

Table 162: Promoting a device policy to a group policy

DescriptionField

General Information

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores.
Maximum length is 255 characters.

Name

Enter a description for the group policy rules; maximum length is 255 characters. Comments
entered in this field are sent to the device.

Description

Policy Options

Select a profile for the policy:

• Log Session Init—Record entries for session start events. A traffic log that records session
start events does not include bytes sent and received or session duration. You can use the
log to verify when the session was initially created.

• Log Session Close—Record entries for session close events. A traffic log that records session
close information also lists a reason for the end of the session.

• All Logging Enabled—Logs are created for both session initiation and session closing. Logs
can be used for troubleshooting.

• All Logging Disabled—Logs are not recorded for both session initiation and session closing.

Profile

Policy Sequence

This is applicable for Group Policy only. Select Before device-specific policies or After
device-specific policies. This decides the policy order when the devices policy configuration
information is updated on the devices.

Placement
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Table 162: Promoting a device policy to a group policy (continued)

DescriptionField

This is applicable for Group Policy only. Select this option to specify the order number for the
policy. Policy lookup is performed in the order that the policies are configured. The first policy
that matches the traffic is used. For more information, see “Policy Ordering Overview” on
page 431.

Sequence No.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Converting Standard Policy to Unified Policy

You can convert a traditional firewall policy to a unified policy. Unified policies are security policies that
enable you to use the dynamic applications as match conditions as part of the existing 5-tuple or 6-tuple
(5-tuple with user firewall) match conditions to detect application changes over time. If the traffic matches
the security policy rule, one or more actions defined in the policy are applied to the traffic.

To convert a standard firewall policy to a unified policy:

1. Select Configure>Firewall Policy>Standard Policies.

The Standard Policies page appears.

2. Right-click a policy and select Convert to Unified Policy or select Convert to Unified Policy from the
More list.

The Policy Conversion page appears.

3. Select an application signature value:

• None—By default the value of the dynamic application signatures is set to None. In this case, the
value of service is retained in all rules in the policy.

• Any—The value of the service is set to junos-defaults. This enables the firewall policy to use default
protocols and ports of dynamic applications.

4. Select an IDP policy.

If you select an IDP policy during conversion, all firewall policy rules with IPS ON will be set to OFF
and the selected IDP policy will be assigned to the firewall policy rule. If you do not select an IDP policy
during conversion, firewall policy rules with IPS ON will be retained as is.
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5. Click OK.

A job is created to convert the standard policy to an unified policy.

6. Select Run now to run the job immediately or Schedule at a later time to run the job at a specified date
and time.

The Conversion page is displayed.

7. Click the job ID to view the details of the job on the job management page.

NOTE:
• Starting in Junos Space Security Director Release 20.1 onward, you can convert a standard
policy with application firewall configuration to unified policy.

RELATED DOCUMENTATION

Unified Policy Overview | 486

Probe Latest Policy Hits

You can probe latest policy hits to get the latest policy hit count. The hit count is incremented by 1 each
time an entry is matched. When you click the Probe Latest Policy Hits option, Security Director sends a
remote procedure call (RPC) <get-security-policies-hit-count></get-security-policies-hit-count> to device
and the device responds with the hit-count details. This hit-count information is stored in the
PolicyHitCountEntity table in Security Director database.

To probe the latest policy hits:

1. Select Configure > Firewall Policies > Standard/Unified Policies.

2. Right-click a policy and select Probe Latest Policy Hits.

The Job Details page is displayed with the status and hit count details.

You can view the hit count on the policy rules page. See “Firewall Policy Rules Main Page Fields” on
page 481.
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NOTE: By default, the Enable Policy Hit Count Data Collection option is enabled and the policy
hit count is automatically probed everyday at 2 AM. To modify the hit count settings in Junos
Space Network Management Platform, seeModifying Settings of Junos Space Applications.

To reset the hit count for all the rules in a policy, right click the policy in Security Director and
select Reset Policy Hits for All Rules. Resetting sets the current hit count to zero for all the rules
in the policy.

RELATED DOCUMENTATION

Using Job Management in Security Director | 177

Disable Firewall Policy Rules with No Hits Over a Specified Duration | 466

Disable Firewall Policy Rules Based on Hits Over a Specified Duration

IN THIS SECTION

Configure the Application Settings | 467

Disable Rules Based on Hits | 467

Starting in Junos Space Security Director Release 20.3R1, you can disable firewall policy rules that have
not been hit for a specified duration. By disabling rules, you’ll notice performance improvement while
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updating policies on devices. You’ll need to first configure the option in Junos SpaceNetworkManagement
Platform and then disable the rules from Security Director.

Configure the Application Settings

By default, the option to disable firewall policy rules with no hits, is disabled in Junos Space Network
Management Platform. Youmust enable the Security Director application settings in Junos Space Network
Management Platform. EnableDisable policy rules with no hits over a specified duration option and enter
the number of days for which you want to disable the firewall policy rules with no hits. SeeModifying
Settings of Junos Space Applications.

Disable Rules Based on Hits

After you have enabledDisable policy rules with no hits over a specified duration option and entered the
days to disable rules with no hits in Junos Space Network Management Platform, you can disable firewall
policy rules from Security Director.

Before You Begin

Right-click a policy and select Probe Latest Policy Hits to get the latest policy hit count. See “Probe Latest
Policy Hits” on page 465.

To disable firewall policy rules based on hits:

1. Select Security Director > Configure > <Standard/ Unified Policies>

The corresponding policies page is displayed.

2. Right-click a policy and select Disable Rules Based on Hits.

A confirmation message to disable the policy rules that have not been hit for the configured number
of days is displayed.

3. Click Yes to disable the policy rules.

The Disable Rules Based on Hits page is displayed.

4. Click the job ID link to view the job status on the Job Management page.

The rules are disabled based on the last hit date on the Hit Count Details page. If the hit date exceeds the
number of days configured, the rule is disabled. See “Firewall Policy Rules Main Page Fields” on page 481.

NOTE: The rules which are not hit for a single time, will not display the last hit date in the Hit
Count Details page and therefore such rules will not be disabled.
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A snapshot of the operation is captured so that you can roll back to the previous policy version, if required.
See “Create and Manage Policy Versions” on page 454.

RELATED DOCUMENTATION

Using Job Management in Security Director | 177

Probe Latest Policy Hits | 465

Viewing and SynchronizingOut-of-Band Firewall Policy ChangesManually

IN THIS SECTION

Viewing Out-of-Band Firewall Policy Changes | 469

Importing Out-of-Band Firewall Policy Changes Manually | 469

Starting in Junos Space Security Director Release 19.2R1, when there is an out-of-band firewall policy
change in the device, you can see an icon next to the corresponding policy in device-specific and group
firewall policies in Security Director. You can manually synchronize the out-of-band changes for a
device-specific policy, only when the automatic synchronization is disabled.

When you hover over the icon next to the policy, the tooltip indicates the out-of-band changes. Out-of-band
firewall policy changes are applicable for both standard and unified firewall policies.

When a device is discovered in Security Director, the Managed Status is displayed as Managed in the
Security Devices page. For manual synchronization of out-of-band policy changes, the managed status of
the device must be SD Changed, Device Changed, or In Sync. For this, you must update the device atleast
once from Security Director. In case of logical systems (LSYS) or tenant systems (TSYS), root device may
show the status as Device Changed if a policy is assigned to it. Update the root device so that the status
is In Sync.
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NOTE: Out-of-band changes are not supported if more than one policy is assigned to a device
or if rules are configured in All Devices Policy Pre/Post policies.

Viewing Out-of-Band Firewall Policy Changes

To view out-of-band firewall policy changes:

1. Select Configure > Firewall Policy > Policies.

The policies page appears. An icon is displayed for the policies indicating the out-of-band policy changes.

2. Right-click the policy or select View Device Policy Changes from the More menu.

The Out of Band Changes page appears.

3. Click View to view the configuration changes for a device in CLI and XML format.

The view configuration page for the device is displayed.

After viewing the changes, you can choose to import or reject the out-of-band changes from the device.

4. Click OK.

NOTE: To reject all the out-of-band changes, select Reject all changes option. The icon next
to the policy will be cleared and the policy changes from the device will not be imported into
Security Director. During the subsequent update from Security Director, the out-of-band
changes will be overwritten in the device.

To import the out-of-band changes to Security Director, see “Importing Out-of-Band Firewall
Policy Changes Manually” on page 469.

Importing Out-of-Band Firewall Policy Changes Manually

To import out-of-band firewall policy changes:

1. Select Configure > Firewall Policy > Policies.

The policies page appears. An icon is displayed for the policies indicating the out-of-band policy changes.

2. Right-click the policy or select View Device Policy Changes from the More menu.
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The Out of Band Changes page appears.

3. Select Select Changes from Device to accept the out of band firewall policy changes from a device.

4. Select a device and click OK.

NOTE: In the case of group policy, you can view all the devices where the policy is associated,
but you can select only one device and import the changes. After selecting a device, click
Affected Devices to see all the devices where the policy is assigned.

In case of both, group policy and device specific policy, an icon is seen next to the device(s)
indicating the out-of-band changes.

The Import Device Configuration Changes page appears.

5. Select the firewall policy and click Next.

Objects with conflicts are displayed, if any.

6. Select objects and choose a conflict resolution type. Resolve any conflicts after you verify the
information, if needed.

7. Click Finish.

A summary of the configuration changes is displayed.

You can download the summary report as a ZIP file. The summaryreport.zip file contains the complete
rules report as a PDF.

8. Click OK to complete the import process.

The Job Details page is displayed with status of the import job.

9. Click OK.

The policies page is displayed with an icon which indicates that the policy was edited and needs
publishing to the device.

10.Click Publish to publish the changes.

During the subsequent update from Security Director, the out-of-band changes will be overwritten in
the device(s).
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RELATED DOCUMENTATION

Out-of-Band Changes Overview | 1384

About the Policy Sync Settings Page | 1382

Viewing the Details of a Job in Security Director | 181

Importing Policies

Starting in Security Director Release 16.1, you can import policy details from a ZIP file to Security Director.

NOTE:
• You can import zipped policies that are in XML format. The XML format of the policy must
match with the export policy zip format.

• The import ZIP file must contain policy details of the same Security Director release. You
cannot import policy details of the previous release to the current release.

To import policy details:

1. Select Configure >Policy-Name Policy > Policies.

The Policies landing page appears.

2. Select Import Policy From ZIP File from the More menu.

The Select ZIP File page appears.

3. Click Browse to browse to a location where a ZIP file containing policy details is saved.

4. Select the ZIP file and click OK.

If there are any conflicts with the imported objects, Object Conflict Resolution (OCR) is done. The OCR
window displays all the conflicts.

5. After resolving the conflicts, click Next to view the OCR summary report.

6. Click Finish to import the ZIP file.

A progress bar appears showing the status of the file upload. Once the import is successful, the policy
details are shown on the Policies page.
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Release History Table

DescriptionRelease

Starting in Security Director Release 16.1, you can import policy details from a ZIP file
to Security Director.

16.1

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Delete and Replace Policies and Objects

IN THIS SECTION

Delete Policies and Objects | 472

Replace Policies and Objects | 473

You can delete or replace policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Delete Policies and Objects

To delete a policy or a shared object:

1. Select Configure > Firewall Policy > Policies.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to delete, and then select the minus sign (-).

An alert message appears verifying that you want to delete your selection.
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3. Click Yes to delete your selection.

NOTE: Before you delete a policy from Security Director, you must ensure that the policy is
unassigned from all assigned devices.

Replace Policies and Objects

You can select one or more shared objects and replace them with other objects of the same type.

To replace one or more object:

1. Select Configure > Shared Objects > Addresses, Services, or Variables.

The addresses, services, or variables page appears.

2. Right-click the shared object that you want to replace, or click Replace from the More list.

You can replace a single object or multiple objects. If the selected object is used in any policy, a warning
message appears before they are replaced.

3. Click Yes to continue the replacement operation.

RELATED DOCUMENTATION
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Unassigning Devices from Policies

Once you create a device policy, you can remove the assigned device from it. This allows you to add a
preferred device at any time to a device policy. This option is not available for a group policy.

To remove an assigned device from a device policy:

1. Select Configure > Policy-Name > Policies.

The Policies landing page appears.

2. Select a device policy and click More.
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3. Click Unassign Devices. You can also right-click a policy and select Unassign Devices.

The Unassign Device page appears with a confirmation message.

4. Click Yes.

The assigned device is removed for the selected device policy.

RELATED DOCUMENTATION
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Edit and Clone Policies and Objects

IN THIS SECTION

Edit Policies or Objects | 474

Clone Policies or Objects | 475

You can edit or clone policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Edit Policies or Objects

To edit a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to edit, and then click the pencil icon.

The Edit window appears, showing the same options as when creating a new policy or object.
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3. Click OK to save your changes.

NOTE: After the published firewall policy rules are edited and saved, you see an icon next to
the check box for each saved policy rule on the Firewall Policies page. When you hover over the
icon, a message appears, indicating that the policy was edited and needs to be pushed to the
device. For updating the policy, see “Updating Policies on Devices” on page 478.

Clone Policies or Objects

To clone a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to clone, or select Clone from the More list.

The Clone window appears with editable fields.

3. Click OK to save your changes.

RELATED DOCUMENTATION
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Publishing Policies

When you publish rules, the process takes into account the priority and precedence values set on the
policy and the order of rules on the device. Rules are published in the order of their priority groups, with
prerules in the High priority group publishing first, before prerules in theMedium and Low priority groups.

If you change the priority or precedence of a published policy, the policy must be republished for the
changes to take effect. Sometimes, changing priority or precedence in one policy can affect other policies
in the same priority group. However, such policies do not need to be republished in order for their changes
in priority or precedence to take effect for the policies that are implicitly changed by the explicit changes
to the republished policy.
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To publish a policy:

1. Select Configure > Policy-Name Policy > Policies.

2. Select the policy that you want to publish and click Publish. The Publish Policy page appears.

3. Select the check boxes next to the devices to which the policy changes will be published.

NOTE: You can search for a specific device on which the policy is published by entering the
search criteria in the search field. You can search the devices by their name and IP address.

4. Select Schedule at a later time if you want to schedule and publish the configuration later.

5. Select Run now if you want to apply the configuration immediately.

6. Click Publish. The Affected Devices page displays the devices on which the policies will be published.

RELATED DOCUMENTATION
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Showing Duplicate Policies and Objects

To display duplicate objects:

1. Select the check box beside the object(s).

2. Right click and select ShowDuplicates. Alternatively, select ShowDuplicates from theMore drop-down
menu.

The Show Duplicates page appears.

3. Select the check box beside the duplicate object, click Delete and confirm to remove it.
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To merge duplicate object:
Select the check box beside the duplicate object, selectMerge from theMore drop-down menu.

To find the usage of a duplicate object:
Select the check box beside the duplicate object, select Find Usage from theMore drop-down menu.

RELATED DOCUMENTATION
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Show and Delete Unused Policies and Objects

IN THIS SECTION

Show Unused Policies and Objects | 477

Delete Unused Policies and Objects | 478

You can show or delete unused policies and objects in your network configurations.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Show Unused Policies and Objects

You can view all unwanted policies or objects that are not used anywhere in your network to take
appropriate action.

To show unused policies or objects:

1. Select Configure and select the landing page for type of policy or object you are showing.

2. From the landing page, clickMore.
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A list of actions appears.

3. Select Show Unused.

A list of unused objects (not referenced in any policy) and unused policies appear on the page.

Delete Unused Policies and Objects

You can clear all unwanted policies or objects that are not used anywhere in your network.

To delete unused policies or objects:

1. Select Configure and select the landing page for type of policy or object you are deleting.

2. Select the check boxes beside the items that you want to delete. Right-click on the policy or object or
click More from the landing page.

A list of actions appears.

3. Select Delete Unused.

A confirmation window appears before you can delete the unused policies or objects.

4. Click Yes to confirm the deletion.

All unused policies or objects are deleted.

RELATED DOCUMENTATION
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Updating Policies on Devices

When you finish creating and verifying your security configurations, you can publish these configurations
and keep them ready to be pushed to the security devices. Security Director helps you push all the security
configurations to the devices all at once by providing a single interface that is intuitive.

The Publish workflow provides the ability to save and publish different services to be updated at a later
time to the appropriate firewalls (during the down time). This permits administrators to review their firewall,
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VPN, and NAT policies before updating the device. This saves administrators troubleshooting time, avoid
errors, and saves costs associatedwith errors. Verify and tweak your security configurations before updating
them to the device by viewing the CLI and XML version of the configuration in the Publish workflow. This
approach helps you keep the configurations ready and update these configurations to the devices during
the maintenance window.

When you publish rules, the process takes into account the priority and precedence values set on the
policy and the order of rules on the device. Rules are published in the order of their priority groups, with
prerules in the High priority group publishing first, before prerules in theMedium and Low priority groups.

If you change the priority or precedence of a published policy, the policy must be republished for the
changes to take effect. Sometimes, changing priority or precedence in one policy can affect other policies
in the same priority group. However, such policies do not need to be republished in order for their changes
in priority or precedence to take effect for the policies that are implicitly changed by the explicit changes
to the republished policy.

To update a policy:

1. Select Configure > Policy-Name Policy > Policies. Select the policy that you want to update and click
Update. The Update Policy page appears.

2. Select the policy that you want to update and click Update. The Update Policy page appears.

3. Select the check boxes next to the devices to which the policy changes will be published.

NOTE: You can search for a specific device on which the policy is published by entering the
search criteria in the search field. You can search the devices by their name and IP address.

4. Select Schedule at a later time if you want to schedule and publish the configuration later.

5. Select Run now if you want to apply the configuration immediately.

6. Click Publish. The Affected Devices page displays the devices on which the policies will be published.

RELATED DOCUMENTATION
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Publishing Policies | 653

Firewall Policies Main Page Fields

Use the Firewall Policy page to view andmanage all device, group, and global policies associated with your
devices. You can filter and sort this information to get a better understanding of what youwant to configure.
Table 1 describes the fields on this page.

Table 163: Firewall Policies Main Page Fields

DescriptionField

Order number for the policy.Seq.

Name of the firewall policy; maximum length is 63 characters.Name

Type of policy: group, device, all-devices, or global.Type

Number of rules associated with the policy.Rule Count

Number of devices associated with the policy.Device Count

Displays the publish state of the firewall policy configuration.

• Not Published—Firewall policy is created but not published.

• Published—Configuration is published to all devices associated with the policy.

• Partially Published—Configuration is published to a few devices associated with the
firewall policy.

• Re-publish Required—Modifications are made to the firewall policy configuration after
it is published.

Publish State

Description of the firewall policy; maximum length is 1024 characters.Description

RELATED DOCUMENTATION
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Firewall Policy Rules Main Page Fields

Use this page to get an overall, high-level view of your firewall policy rules settings. Details help you keep
track of the number and order of rules per policy. You can filter and sort this information to get a better
understanding of what you want to view. Table 164 on page 481 describes the fields on this page.

Table 164: Firewall Policy Rules Main Page Fields

DescriptionField

Order number for the policy. Policy lookup is performed in the order that the policies are configured.
The first policy that matches the traffic is used.

Seq.

Displays how often a particular policy is used based on traffic flow. The hit count is the number of
hits since the last reset. Click on the hit count value to view the details on the Hit Count Details page.

Example: The hit count is especially useful when you are using a large policy set and youwant to verify
which rules are highly used and which ones are rarely used. If you see that some of the rules are not
being used, you can verify that the rules are not being shadowed by another policy. This helps you
manage the device without having to generate traffic manually.

Hit Count

Unique name for the rule.Rule Name

Source zone (to-zone) that defines the context for the policy. Zone policies are applied on traffic
entering one security zone (source zone) to another security zone (destination zone). This combination
of a source zone and a destination zone is called a context.

For example, all policies within source zone trust and destination zone untrust are in the same context.

Src. Zone

Address names or address set names to be used as match criteria for incoming traffic.

We recommend that you create address sets instead of using multiple address entries. For example,
If your organization has common requirements for similar types of access across different rules,
leveraging groups can be advantageous.

You can have any number of objects with a set (for example, host, network, DNS, wildcard, and so
forth)

Src. Address

Users and roles to be used as match criteria for the policy.

You can have different policy rules based on the user role and user group.

If you specify the source identity in any policy within the zone pair, then user and role information is
retrieved before policy lookup can proceed. (If all policies in the zone pair are set to any or have no
entry in the Source Identity field, user and role information is not required and only the other five
standard match criteria are used for policy lookup.)

Src. ID
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Table 164: Firewall Policy Rules Main Page Fields (continued)

DescriptionField

Destination zone (from-zone) that defines the context for the policy.

Zone policies are applied on traffic entering one security zone (source zone) to another security zone
(destination zone). This combination of a source zone and a destination zone is called a context.

For example, all policies within source zone trust and destination zone untrust are in the same context.

Dest. Zone

Address names or address set names to be used as match criteria for outgoing traffic.

We recommend that you create address sets instead of using multiple address entries.

For example, if your organization has common requirements for similar types of access across different
rules, leveraging groups can be advantageous.

You can have any number of objects with a set (for example, host, network, DNS, wildcard, and so
forth).

Dest.
Address

The service (application) name in the match criteria has one or more service or service sets.

We recommend that you create a service set and refer to the name of the set in a policy instead of
using multiple individual service names.

For example, for a group of employees, you can create a service set that contains all the approved
services. Service objects allow you to specify objects to be used in the match criteria of security
policies. You can set numerous attributes to help define what the match criteria of this object should
be.

Service

Action applies to all traffic that matches the specified criteria.

• Deny—Device silently drops all packets for the session and does not send any active control messages
such as TCP Resets or ICMP unreachable.

• Reject—Device sends a TCP Reset if the protocol is TCP and ICMP Reset if the protocols are UDP,
ICMP, or any other IP protocol. This option is useful when facing trusted resources so that the
applications do not waste time waiting for timeouts and instead get the active message.

• Permit—Device permits traffic using the type of firewall authentication you applied to the policy.

• Tunnel—Device permits traffic using the type of VPN tunneling options you applied to the policy.

Action

Starting in Junos Space Security Director Release 16.1, the address and service objects can be created,
managed, dragged and dropped to the required rules from the firewall policy rules page. Apart from
addresses and services, you can also drag and drop zones. From the Shared Objects list, select Show
Addresses or Show Services to see the required shared objects. To create a new address or service object,
click the plus sign (+). You can alsomodify, delete, andmanage these objects. You can search for any object
by it’s name and IP address in the search field available in the top right corner.
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You can dragmore than one object and drop on the respective columns of any policy rule. Security Director
ensures that objects are dropped in the supported columns and it does not permit to drop under any other
columns. The drag and drop of objects is supported on the source address, destination address, source
zone, destination zone, and service columns. A single address or multiple addresses can be dragged and
dropped from source address field to destination address field of same rule or across rules. Similarly, single
or multiple services and zones can also be dragged and dropped across rules. To view multiple objects in
an address, zone, or service column, click the small horizontal triangle to expand the columns.

You can also drag and drop rules to a single rulegroup or across multiple rulegroups.

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.1, the address and service objects can be
created, managed, dragged and dropped to the required rules from the firewall policy rules page.
Apart from addresses and services, you can also drag and drop zones.

16.1
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CHAPTER 46

Firewall Policy-Unified Policies

IN THIS CHAPTER

About the Unified Policies Page | 484

Unified Policy Overview | 486

Creating Unified Firewall Policies | 487

Creating Unified Firewall Policy Rules | 490

Configuring a Default SSL Proxy Profile | 498

Configure a Default IDP Policy | 502

About the Unified Policies Page

To access this page, click Configure>Firewall Policy>Unified Policies.

Unified policies are security policies that enable you to use dynamic applications asmatch conditions along
with the existing 5-tuple or 6-tuple (with user firewall) match conditions to detect application changes
over time. If the traffic matches the security policy rule, one or more actions defined in the policy are
applied to the traffic.

Tasks You Can Perform

You can perform the following tasks from this page:

• Create a unified firewall policy. See “Creating Unified Firewall Policies” on page 487.

• Create a unified firewall policy rule. See “Creating Unified Firewall Policy Rules” on page 490.

• Manually lock the unified firewall policy. See “Firewall Policy Locking Modes” on page 450.

• Configure a default SSL proxy profile. See “Configuring a Default SSL Proxy Profile” on page 498.

• Compare policies. See “Comparing Policies” on page 458.

• Create and manage policy versions. See “Create and Manage Policy Versions” on page 454.

• Export policies. See “Export Policies” on page 459.

• Create custom columns. See “Creating Custom Columns” on page 460.

484



• Promote a device policy to group policy. See “Promoting to Group Policy” on page 462.

• Create rule name template. See “Creating Rule Name Template” on page 729.

• Edit and clone policies and objects. See “Edit and Clone Policies and Objects” on page 474.

• Assign policies and profiles to domains. See “Assigning Policies and Profiles to Domains” on page 668.

• Publish and update the unified firewall policy. See “Publishing Policies” on page 475 and “Updating Policies
on Devices” on page 478.

Field Descriptions

Table 165 on page 485 provides guidelines on using the fields on the Unified Policies page.

Table 165: Fields on the Unified Policies Page

DescriptionField

Order number for the policy.Seq

Name of the firewall policy; maximum length is 63 characters.Name

Rules associated with the policy.Rules

Devices associated with the policy.Devices

Displays the publish state of the Unified policy configuration.

• Not Published—Firewall policy is created but not published.

• Published—Configuration is published to all devices associated with the policy.

• Partially Published—Configuration is published to a few devices associated with the
firewall policy.

• Re-publish Required—Modifications are made to the firewall policy configuration
after it is published.

Publish State

The date and time when the policy was modified.Last Modified

The user who created the policy.Created By

The user who modified the policy.Modified By

The user domain.Domain
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Unified Policy Overview

Unified policies are security policies that enable you to use the dynamic applications as match conditions
alongwith the existing 5-tuple or 6-tuple (with user firewall) match conditions to detect application changes
over time. If the traffic matches the security policy rule, one or more actions defined in the policy are
applied to the traffic.

By adding dynamic applications to the match criteria, the data traffic is classified based on the Layer 7
application inspection results. Application ID (AppID) identifies dynamic or real-time Layer 4 through Layer
7 applications. After an application is identified and the matching policy is found, then the actions such as
permit, deny, reject, or deny and redirect are applied according to the policy.

A unified policy leverages the information fromAppID tomatch the application and take action as specified
in the firewall policy. In an unified policy configuration, you can use a predefined dynamic application or
a user-defined custom application from the application identification signature package asmatch condition.

NOTE: Configuring dynamic applications as match criteria in a security policy is not mandatory.

You can configure an unified policy with dynamic application options such as none, include any service,
and include specific. When you configure a value for dynamic application other than none, the default
value of service is junos-defaults.

The junos-defaults group contains preconfigured statements that include predefined values for common
applications. As the default protocols and ports are inherited from junos-defaults, there is no requirement
to explicitly configure the ports and protocols, thus simplifying the security policy configuration. If the
application does not include default ports and protocols, then the application uses the default ports and
protocols of the dependent application. The junos-defaults optionmust be configured alongwith a dynamic
application. If you configure the junos-defaults option without specifying any dynamic application, then
an error message is displayed.

A redirect profile can be configured within an unified policy. When a policy blocks HTTP or HTTPS traffic
with a deny and reject action, you can define a response in an unified policy to notify the connected clients.
When you configure the redirect option, you can specify the custom message or the URL to which the
client is redirected.

Starting in Junos Space Security Director Release 19.3R1, you can assign IPS policy to the unified firewall
policy rule. The CLI is generated for the IPS policy along with the unified firewall policy (to which the IPS
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policy is assigned) for devices with Junos OS Release 18.2 onward. The IPS policy name is directly used
in the firewall policy rule, therefore the [edit security idp active-policy policy-name] statement is deprecated
in Junos OS Release 18.2 onward. You can import and convert the deprecated active policy CLI into a new
CLI from Security Director. You can import the IPS policy for the deprecated active-policy for Junos OS
version 18.2 and later. After the IPS policy is imported, the rules associated with the firewall policy for the
device is updated with IPS policy details. On subsequent update from Security Director, you can see the
new firewall policy CLIs, in preview, to attach IDP and the same can be updated to device.

NOTE:
• In a device with Junos OS Release 18.2, you must assign same IPS policy to all the rules in the
firewall policy, otherwise commit fails.

• In a device with Junos OS Release 18.3 onward, you can assign different IPS policy to the rules
in the firewall policy. You must set a default IDP policy, otherwise commit fails.
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Creating Unified Firewall Policies

You can configure group or device policies that determine all the network resourceswithin your organization
and that identify the required security level for those resources.

NOTE: Any device having standard and unified policies can be imported to unified policies.

Before You Begin

• Create source (from-zone) and destination (to-zone) zones.

• Create addresses and address sets.

• Create services (applications) and service sets (application sets).
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To create a unified firewall policy:

1. Select Configure>Firewall Policy>Unified Policies.

2. Click the + icon.

3. Complete the configuration according to the guidelines provided in Table 166 on page 488.

4. Click OK. A unified firewall policy is created. Select the policy and click the + icon to configure policy
rules. See “Creating Firewall Policy Rules” on page 438.

A policy is created according to your configuration. You can use this policy to assign rules, profiles, and
schedules, To enable a policy, you must assign it to a domain. See “Assigning Policies and Profiles to
Domains” on page 521.

Table 166: Unified Firewall Policy Settings

GuidelineSetting

General Information

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores.Maximum
length is 255 characters.

Name

Enter a description for the group policy rules; maximum length is 255 characters. Comments entered
in this field are sent to the device.

Description

Policy Options

Select a profile for the policy:

• Log Session Init—Record entries for session start events. A traffic log that records session start
events does not include bytes sent and received or session duration, but you can use the log to
verify when the session was initially created.

• Log Session Close—Record entries for session close events. A traffic log that records session
close information also lists a reason for the end of the session.

• All Logging Enabled—Logs are created for both session initiation and session closing. Logs can
be used for troubleshooting.

• All Logging Disabled—Logs are not recorded for both session initiation and session closing.

Profile
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Table 166: Unified Firewall Policy Settings (continued)

GuidelineSetting

Select the type of policy you want to create:

• Group Policy—Firewall policy that is shared with multiple devices. This type of policy is used
when you want to update a specific firewall policy configuration to a large set of devices. You
can create group prerules, group postrules, and device rules for a group policy.

• Device Policy—Firewall policy that is created per device. This type of policy is used when you
want to push a unique firewall policy configuration per device. You can create device rules for a
device firewall policy. During a device assignment for a device policy, only devices from the
current domain are listed.

Type

Device Selection

Starting Junos Space Security Director Release 16.2, both SRX Series devices andMX Series routers
are listed. When a policy is published to a device, device-specific rules are published to the
appropriate SRX Series devices or MX Series routers.

Select the devices on which the group policy will be published. For a group policy, you can include
both SRX Series devices and MX Series routers. Select devices from the Available column and click
the right arrow to move these devices to the Selected column. For device only policy, select the
device with which you want to associate the policy.

NOTE: You can also search for devices by entering the device name, device IP address, or device
tags in the Search fields in the Devices area. Once the searched devices appear, you canmove them
to the Selected pane.

You can assign devices with Junos OS Release 18.2 onward.

NOTE: Starting in Junos Space Security Director Release 20.1R1, logical system (LSYS) is supported
on devices running Junos OS Release 18.3 and later.

Starting in Junos Space Security Director Release 21.2R1, tenant system (TSYS) is supported on
devices running Junos OS Release 18.3 and later for SRX Series devices and Junos OS Release 20.1
and later for VSRX Series devices.

Devices

Policy Sequence

This is applicable for Group Policy only. Select Before Device Specific Policies or After Device
Specific Policies. This decides the policy order when the devices policy configuration information
is updated on the devices.

Policy
Placement

This is applicable for Group Policy only. Select this option to specify the order number for the policy.
Policy lookup is performed in the order that the policies are configured. The first policy that matches
the traffic is used. For more information, see “Policy Ordering Overview” on page 431.

Policy Sequence
No.
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Release History Table

DescriptionRelease

Starting Junos Space Security Director Release 16.2, both SRX Series devices and MX
Series routers are listed.

16.2
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Creating Unified Firewall Policy Rules

Use the Create Rule page to configure firewall rules that control transit traffic within a context (source
zone to destination zone). The traffic is classified by matching its source and destination zones, the source
and destination addresses, and the application that the traffic carries in its protocol headers with the policy
database.

Security Director allows a device to have a device-specific policy and to be part of multiple group policies.
Rules for a device are updated in this order:

• Rules within Policies Applied Before 'Device Specific Policies'

• Rules within Device-Specific Policies

• Rules within Policies Applied After 'Device Specific Policies'

Rules within Policies Applied Before 'Device Specific Policies' take priority and cannot be overridden.
However, you can override rules within Policies Applied After 'Device Specific Policies' by adding an
overriding rule in the Device-Specific Policies. In an enterprise scenario, “common-must-enforce” rules
can be assigned to a device from the Policies Applied Before ‘Device Specific Policies’, and
“common-nice-to-have” rules can be assigned to a device from the Policies Applied After ‘Device Specific
Policies’.

NOTE: An exception can be added on a per device basis in “Device-Specific Policies” . For a
complete list of rules applied to a device, select Configure > Firewall Policy > Devices. Select a
device to view rules associated with that device.
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To configure a firewall unified policy rule:

1. Select Configure>Firewall Policy>Unified Policies.

2. Select the policy for which you want to define rules and click the + icon.

The Create Rule page appears.

NOTE: To edit the rules inline, click the policy to make the fields editable.

3. Complete the configuration according to the guidelines provided in Table 167 on page 491.

4. Click OK.

The rules you configured are associated with the selected policy.

Table 167: Firewall Unified Policy Rules Setting

GuidelineSetting

General Information

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores. No
spaces are allowed and the; maximum length is 63 characters.

Rule Name

Enter a description for the policy rules; maximum length is 1024 characters. Comments entered
in this field are sent to the device.

Description

Identify the traffic that the rule applies to

For SRX Series devices, specify a source zone (from-zone) to define the context for the policy.
Zone policies are applied on traffic entering one security zone (source zone) to another security
zone (destination zone). This combination of a source zone and a destination zone is called a
context.

Starting in Junos Space Security Director Release 16.2, for MX Series routers, the source zone
field acts as an ingress interface from where the packet enters. The match direction is input, if
the packet is entering the interface. The match direction is output, if the packet is leaving the
interface. Configure the ingress key by selecting the aggregated multiservices (AMS) value.

Starting in Junos Space Security Director Release 16.2, polymorphic zones can be used as source
zone and destination zone, when you assign SRX Series devices and MX Series routers to the
same group policy.

(Source) Zone
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Table 167: Firewall Unified Policy Rules Setting (continued)

GuidelineSetting

Enter one or more address names or address set names. Click Select to add source addresses.

On the Source Address page:

• Select the Include option to add the selected source addresses or any address to the rule.

• Select the Exclude option to exempt the selected source addresses from the rule.

• Select the By Metadata Filter option to choose the matching address of a user-defined
metadata as the source address.

• Metadata Filter—Click the field to select the required metadata from the list. The matching
addresses are filtered and listed in the Matched Address field.

• Matched Addresses—Lists the addresses matching the selected metadata. This address is
used as a source address.
For every metadata expression, a unique dynamic address group(DAG) is created. This
DAG has the feed server URL pointing to the feed server URL of Security Director.

Office 365 is now included in the list of third party feeds to push Microsoft Office 365
services endpoint information (IP addresses) to the SRX Series device. This feed works
differently from other feeds and requires certain configuration parameters, including a
pre-defined name of “ipfilter_office365”. You must enable the Office 365 feed in Juniper
ATP Cloud. To understand how to enable the Office 365 feed in Juniper ATP Cloud and
create aDAGon the SRX Series device that refers to the ipfilter_office365 feed, see Enabling
Third Party Threat Feeds.

Configure the feed server URL by using the following CLI command to each SRX Series
device or vSRX that acts on the metadata based policies.

set security dynamic-address feed-server <SD IP Address> hostname <SD IP Address>

See “Creating Addresses and Address Groups” on page 1026.

(Source) Address(es)

Specify the source identity (users and roles) to be used as match criteria for the policy. You can
have different policy rules based on user roles and user groups.

Click Select to specify source identities to permit or deny. On the User ID page, you can select
a user identity from the available list or you can add a new identity by clicking Add New User
ID.

To delete a user identity from the Security Director database, click Delete User ID and select
a value from the drop-down list, which is not configured in any policy. If you try to delete a user
identity which is configured in a policy, a messagewith its reference ID and user ID are displayed.

NOTE: The user IDswhich are only created in Security Director are displayed in the drop-down
list.

(Source) User ID
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Table 167: Firewall Unified Policy Rules Setting (continued)

GuidelineSetting

Select an end user profile from the list. The firewall policy rule is applied to it.

When traffic from device A arrives at an SRX Series device, the SRX Series obtains the IP address
of device A from the first traffic packet and uses it to search the device identity authentication
table for a matching device identity entry. Then it matches that device identity profile with a
security policy whose End User Profile field specifies the device identity profile name. If a match
is found, the security policy is applied to traffic issuing from device A.

(Source) End User
Profile

For SRX Series devices, specify a destination zone (to-zone) to define the context for the policy.
Zone policies are applied on traffic entering one security zone (source zone) to another security
zone (destination zone). This combination of a source zone and a destination zone is called a
context.

Starting in Junos Space Security Director Release 16.2, for MX Series routers, this field acts as
an egress interface from where the packet enters. The match direction is input, if the packet is
entering the interface. The match direction is output, if the packet is leaving the interface.
Configure the egress key by selecting the aggregated multiservices (AMS) value.

Polymorphic zones can be used as source zone and destination zone, when you assign SRX
Series devices and MX Series routers to the same group policy.

(Destination) Zone
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Table 167: Firewall Unified Policy Rules Setting (continued)

GuidelineSetting

Select one or more address names or address sets. Click Select to add destination addresses.

On the Destination Address page:

• Select the Include option to add the selected destination addresses or any address to the
rule.

• Select the Exclude option to exempt the selected destination addresses from the rule.

• Select the By Metadata Filter option to choose the matching address of a user-defined
metadata as the destination address.

• Metadata Filter—Click the field to select the required metadata from the list. The matching
addresses are filtered and listed in the Matched Address field.

• Matched Addresses—Lists the addresses matching the selected metadata. This address is
used as a destination address.
For every metadata expression, a unique dynamic address group(DAG) is created. This
DAG has the feed server URL pointing to the feed server URL of Security Director.

Office 365 is now included in the list of third party feeds to push Microsoft Office 365
services endpoint information (IP addresses) to the SRX Series device. This feed works
differently from other feeds and requires certain configuration parameters, including a
pre-defined name of “ipfilter_office365”. You must enable the Office 365 feed in Juniper
ATP Cloud. To understand how to enable the Office 365 feed in Juniper ATP Cloud and
create aDAGon the SRX Series device that refers to the ipfilter_office365 feed, see Enabling
Third Party Threat Feeds.

Configure the feed server URL by using the following CLI command to each SRX Series
device or vSRX that acts on the metadata based policies.

set security dynamic-address feed-server <SD IP Address> hostname <SD IP Address>

See “Creating Addresses and Address Groups” on page 1026.

(Destination)
Address(es)

Select one or more predefined or custom URL category as a match criterion. URL category is
supported on devices running Junos OS Release 18.4R3 and later.

Click Select to select a URL category. Select one or more predefined or custom URL categories
from the Available list and move them to the Selected list. Click OK.

(Destination) URL
Category
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Table 167: Firewall Unified Policy Rules Setting (continued)

GuidelineSetting

Configure the dynamic application with one of the following values:

• None—Configuring the dynamic application as “None” ignores classification results from
AppID and does not use the dynamic application in security policy lookups. Within the list of
potential match policies, if any policy is configured with a dynamic application as “None”, this
policy is matched as the final policy. If Layer 7 policies are configured, deep packet inspection
for the traffic is initiated.

When upgrading Security Director release (where dynamic applications were not supported),
all the traditional policies are considered to be policies with the dynamic application configured
as none.

• Include Any Service—Configuring the dynamic application as “Include Any Service” installs
the policy with the application as a wildcard (default). If an application cannot be specified,
configure “Include Any Service” as the default application. Data traffic that matches the
parameters in a unified policy matches the policy regardless of the application type.

If this option is selected, then the default service value is junos-defaults.

• Include Specific—Add specific predefined or custom application signatures by clicking + icon.

If this option is selected, then the default service value is junos-defaults.

Application
Signature

Select one or more service (application) names. Select the Include Any Service to disable the
any option in the services list builder. Select Include Specific to permit or deny services from
the services list builder available column. Click AddNewService to create a service. See “Creating
Services and Service Groups” on page 1040. Select Default to have the service value as
junos-default.

When user configures a value for dynamic application other than None, the default value of
service is junos-default.

(Service Protocols)
Services

Advanced Security

Action applies to all traffic that matches the specified criteria.

• Deny—Device silently drops all packets for the session and does not send any active control
messages such as TCP Resets or ICMP unreachable.

• Reject—Device sends a TCP reset if the protocol is TCP, and device sends an ICMP reset if
the protocols are UDP, ICMP, or any other IP protocol. This option is useful when facing
trusted resources so that the applications do not waste time waiting for timeouts and instead
get the active message.

• Permit—Device permits traffic using the type of firewall authentication you applied to the
policy.

• Deny and Redirect—Device sends a block message with reject reason or a redirect URL to
the user.

Rule Action
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Table 167: Firewall Unified Policy Rules Setting (continued)

GuidelineSetting

Select the redirect profile from the list. This field is displayed only when the action is Deny and
Redirect.

Redirect Profile

Firewall policies provide a core layer of security that ensures that network traffic is restricted
to only that which a policy dictates through its match criteria. When the traditional policy is not
enough, select application identification components to create an advanced security profile for
the policy:

NOTE: For using advanced security options, the rule action must be permit.

• SSL Proxy—Select this option to enable an application-level protocol that provides encryption
technology for the Internet.

Click Add Forward Proxy to create SSL Forward Proxy Profiles. See “Creating SSL Forward
Proxy Profiles” on page 580.

Click Add Reverse Proxy to create SSL Reverse Proxy Profiles. See “Creating SSL Reverse
Proxy Profiles” on page 588.

• UTM—Select this option to define Layer 7 protection against client-side threats.

Click Add New to create UTM policies. See “Creating UTM Policies” on page 762.

• Threat Prevention Policy—Select an option to provide protection and monitoring for the
selected threat profiles, including command and control servers, infected hosts, andmalware.

• IPS Policy—Provides support for IPS policy within unified firewall policy. Select an IPS policy
to assign to the firewall policy. This is supported on devices with Junos OS Release 18.2 and
later. IPS policies that are not assigned to any device are listed in the drop-down.

NOTE: The rule action should be Permit.

For devices with Junos OS Release 18.2 onward, CLI is generated for the assigned IPS policy
along with the unified firewall policy.

Advanced Security
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Table 167: Firewall Unified Policy Rules Setting (continued)

GuidelineSetting

Juniper ATP Cloud Adaptive Threat Profiling allows SRX Series devices to generate, propagate,
and consume threat feeds based on their own advanced detection and policy-match events.

Starting in Junos Space Security Director Release 21.2, you can configure a firewall policy with
source and destination addresses as threat types, which injects the source IP address and
destination IP address into the selected threat feed when traffic matches the rule. Threat feed
can be leveraged by other devices as a dynamic-address-group (DAG).

Add Source IP to Feed—Select a security feed from the list. The source IP address is added to
the threat feed when the traffic matches the rule.

Add Destination IP to Feed—Select a security feed from the list. The destination IP address is
added to the threat feed when the traffic matches the rule.

NOTE: To use these fields, first enroll the devices in ATP Cloud and then configure Policy
Enforcer to display feeds in the drop-down list.

Threat Profiling

Rule Options

Select a default profile or a custom profile, or you can inherit a policy profile from another
policy. Policy profile specifies the basic settings of a security policy. See “Creating Firewall Policy
Profiles” on page 513.

Profile

Policy schedules allow you to define when a policy is active, and thus are an implicit match
criterion. You can define the day of the week and the time of the day when the policy is active.
For instance, you can define a security policy that opens or closes access based on business
hours. Multiple schedulers can be applied to different policies, but only one scheduler can be
active per policy. Select a pre-saved schedule and the schedule options are populated with the
selected schedule’s data. Click Add New to create another schedule.

Schedule

Automated Rule Analysis and Placement

Select this option if you want to analyze rules to avoid any anomalies.

NOTE: All rules with dynamic application “None” is evaluated first.

To view the analysis report, click View Analysis Report.

Rule Analysis

Rule Placement

Displays the sequence number and the order in which the rule is placed.

To view rule placement in a Policy, click View Placement Inside Policy.

Location/Sequence
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Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.2, for MX Series routers, the source zone
field acts as an ingress interface from where the packet enters.

16.2

Starting in Junos Space Security Director Release 16.2, polymorphic zones can be used as source
zone and destination zone, when you assign SRX Series devices and MX Series routers to the
same group policy.

16.2

Starting in Junos Space Security Director Release 16.2, for MX Series routers, this field acts as
an egress interface from where the packet enters.

16.2

RELATED DOCUMENTATION

About the Unified Policies Page | 484

Unified Policy Overview | 486

Creating Unified Firewall Policies | 487

Configuring a Default SSL Proxy Profile

IN THIS SECTION

Creating a default SSL Proxy Profile | 499

Editing a Default SSL Proxy Profile | 500

Updating a Default SSL Profile on a Device | 500

Deleting a Default SSL Proxy Profile | 501

You can configure a default profile for an SSL proxy to manage conflicts when a security policy lookup
returns a list of policies before the final application is identified. The initial policy lookup phase occurs prior
to identifying a dynamic application. If there are multiple policies present in the potential policy list that
contain different SSL proxy profiles, then the SRX Series device applies the default profile until a suitable
match is established. You can configure a default SSL proxy profile for both SSL forward and reverse proxy.
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The sessions are dropped in case of policy conflicts, if the default SSL proxy profile is not available.

Creating a default SSL Proxy Profile

To create a default SSL proxy profile:

1. Select Configure > Firewall Policy > <Standard/Unified> Policies.

The policies page is displayed.

2. Click Global Options.

The Global Options page is displayed.

3. Click + icon to create default SSL proxy profile.

The Create SSL Proxy page is displayed.

4. Configure the parameters according to the guidelines in Table 168 on page 499.

5. Click OK.

The default SSL proxy profile is added. If the selected profile is already available as default, then an
error message is displayed.

Table 168: Create SSL Proxy

DescriptionFields

Default SSL

Select a reverse proxy profile or a forward proxy profile as the default SSL
proxy profile.

Profile

Enter a description for the default SSL proxy profile.Description

Device Selection

Select the devices on which the default SSL proxy profile is applied.Device Selection
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Editing a Default SSL Proxy Profile

To edit a default SSL Proxy profile:

1. Select Configure > Firewall Policy > <Standard/Unified> Policies.

The policies page is displayed.

2. Click Global Options.

The Global Options page is displayed.

3. Select a default SSL proxy profile, right-click and select Edit or click the pencil icon.

4. Edit the fields and click OK.

Updating a Default SSL Profile on a Device

To update a default SSL proxy on a device:

1. Select Configure > Firewall Policy > <Standard/Unified> Policies.

The policies page is displayed.

2. Click Global Options.

The Global Options page is displayed.

3. Select a default SSL profile and click Update.

The Update SSL Proxy page is displayed.

4. Select a proxy and click Update.

You can view the configuration in the CLI and XML formats for the corresponding device.

NOTE: Before updating default SSL proxy, atleast one firewall rule must be configured with SSL
proxy and deployed on the device. Only then you can update a default SSL profile successfully.
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Deleting a Default SSL Proxy Profile

To delete a default SSL proxy profile:

1. Select Configure > Firewall Policy > <Standard/Unified> Policies.

The policies page is displayed.

2. Click Global Options.

The Global Options page is displayed.

3. Select a default SSL proxy profile and click Delete. Delete option is also available when you right-click
an SSL Proxy Profile or click More.

The Delete SSL Profile page is displayed.

4. Select an option to delete the default SSL profile from Security Director or from both Security Director
and the device.

5. Click OK.

A confirmation message is displayed.

6. Click Yes to delete the default SSL proxy profile.

NOTE: When a device is imported with the default SSL proxy configuration, the default SSL
proxy configured is listed in the Global options page.

RELATED DOCUMENTATION

Creating SSL Forward Proxy Profiles | 580

Creating SSL Reverse Proxy Profiles | 588
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Configure a Default IDP Policy

IN THIS SECTION

Create a Default IDP Policy | 502

Edit a Default IDP Policy | 503

Delete a Default IDP Policy | 503

If multiple IPS policies are configured for a session and when policy conflict occurs, the device applies the
default IPS policy for that session and thus resolves any policy conflicts.

If a device has multiple IPS policies attached to standard or unified firewall policy rules, then you must
configure a default IPS policy. If a device has more than one IPS policies, but is not attached to any standard
or unified firewall policy, then a default IPS policy is not mandatory.

Create a Default IDP Policy

To create a default IDP policy:

1. Select Configure > Firewall Policy > <Standard/Unified> Policies.

The policies page is displayed.

2. Click Global Options.

The Global Options page is displayed.

3. Click the IDP Default tab.

4. Click the + icon to create a default IDP policy.

The Create IDP Default page is displayed.

5. Configure the parameters according to the guidelines in Table 169 on page 503.

6. Click OK.

The default IDP policy for the selected device (s) is created.
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Table 169: Create IDP Default

DescriptionFields

Select an IPS policy, which you want to set as default.IDP Profile

Enter a description for the default IDP policy.Description

Select the devices on which the default IDP policy is applied.Device Selection

Edit a Default IDP Policy

To edit a default IDP profile:

1. Select Configure > Firewall Policy > <Standard/Unified> Policies.

The policies page is displayed.

2. Click Global Options.

The Global Options page is displayed.

3. Click the IDP Default tab.

4. Select a default IDP policy, right-click and select Edit or click the pencil icon.

5. Edit the fields and click OK.

Delete a Default IDP Policy

To delete a default IDP policy:

1. Select Configure > Firewall Policy > <Standard/Unified> policies.

The policies page is displayed.

2. Click Global Options.

The Global Options page is displayed.

3. Select the IDP policy and clickDelete. Delete option is also available when you right-click an IDP policy.

The pop up with a confirmation message is displayed.

4. Click Yes to delete the default IDP policy.
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RELATED DOCUMENTATION

Understanding IPS Policies | 672

Creating Unified Firewall Policy Rules | 490

Creating Firewall Policy Rules | 438
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CHAPTER 47

Firewall Policy-Devices

IN THIS CHAPTER

Devices with Firewall Policies Main Page Fields | 505

Devices with Firewall Policies Main Page Fields

Use this page to get an overall, high-level view of your firewall policy device settings. You can also use
this page to view detailed information on the number of rules and policies assigned per device. Details
help you keep track of the number and order of rules per policy and of all the policies that are assigned to
a specific device. You can filter and sort this information to get a better understanding of what you want
to view. Table 170 on page 505 describes the fields on this page.

Table 170: Devices with Firewall Policies Main Page Fields

DescriptionField

Name of the device.Device Name

Total number of rules of all the policies assigned to the device. Click the link to view
the rules order that is deployed on the device.

Number of Rules

IP address of the device.IP Address

Displays the supported device name. For example: SRX Series, vSRX, MX Series.Platform

Total number of NAT policies assigned to the device.Number of Policies

List of all assigned services: firewall, NAT, IPS, and VPN. When a device is assigned
to any firewall policy including NAT, IPS and VPN, the policy name is shown in this
column.

Assigned Services

List of the policy names that are assigned and published. Versioning information is
included for firewall and NAT policies.

Pending Services
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Table 170: Devices with Firewall Policies Main Page Fields (continued)

DescriptionField

List of the policy names that are published and updated to the device (this includes
policy names for firewall, NAT, IPS, and VPN). Versioning information is included
for firewall and NAT policies.

Installed Services

RELATED DOCUMENTATION

Firewall Policies Overview | 429

Creating Firewall Policies | 434
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CHAPTER 48

Firewall Policy-Schedules

IN THIS CHAPTER

Schedules Overview | 507

Creating Schedules | 508

Schedules Main Page Fields | 509

Schedules Overview

A schedule allows a policy to be active for a specified duration. If you want a policy to be active during a
scheduled time, you must first create a schedule for that policy or link the policy to an existing schedule.
When a schedule timeout expires, the associated policy is deactivated and all sessions associated with the
policy are also timed out.

If a policy contains a reference to a schedule, that schedule determines when the policy is active. When
a policy is active, it can be used as a possible match for traffic. A schedule lets you restrict access to, or
remove a restriction from a resource, for a period of time.

A schedule uses the following guidelines:

• A schedule can have multiple policies associated with it; however, a policy cannot be associated with
multiple schedules.

• A policy remains active as long as the schedule it refers to is also active.

A schedule can be active during a single time slot, as specified by a start date and time, and a stop date
and time.

• A schedule can be active forever (recurrent), but only as specified by the daily schedule. The schedule
on a specific day (time slot) takes priority over the daily schedule.

• A scheduler can be active during a time slot, as specified by the weekday schedule.

• A scheduler be active within two different time slots (daily or for a specified duration).

RELATED DOCUMENTATION
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Creating Schedules | 508

Firewall Policies Overview | 429

Firewall Policies Best Practices | 437

Creating Schedules

Use schedules to activate a policy at a regular time and for a specified duration. You can define a schedule
for a single or recurrent time slot during which a policy is active.

Before You Begin

• Read the Schedules Overview topic.

• Review the schedules main page for an understanding of your current data set. See “Schedules Main
Page Fields” on page 509 for field descriptions.

To create policy schedules:

1. Select Configure > Firewall Policy > Schedules.

2. Click Create.

3. Complete the configuration according to the guidelines provided in Table 171 on page 508.

4. Click OK.

A new schedule is created. You can use this schedule to activate firewall policies for the times and dates
configured in your schedules.

Table 171: Schedules Settings

GuidelinesSettings

General

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores. No
spaces are allowed and the; maximum length is 63 characters.

Name

Enter a string of alphanumeric characters that cannot contain special characters (such as &, <,
>, and \n). Maximum length is 900 characters.

Description

Dates

508



Table 171: Schedules Settings (continued)

GuidelinesSettings

Select Ongoing if you want your schedules to always be active.

Select Custom to configure two sets of start and end dates for a single schedule. A schedule
can be active during a single time slot, as specified by a start date and time, and a stop date and
time. For the first set, enter dates in the Start Date and End Date fields. Youmust enter the days
in MM/DD/YYYY format.

A scheduler will be active within two different time slots if Second Start Date and time and
Second End Date and time are entered. For the second set of the schedule, enter the start date
in the Second Start Date field and enter the end date in the Second End Date field.

Date Range

Times

Select Specify Time to enter specific days and times.

Create a schedule to be active daily or for any specific times of the day.

Click on a specific day to specify time options for an entire day, to exclude a specific day, or to
enter time ranges for the selected day. You must enter the time in HH:MM:SS format.

For example, if you click on Monday, you get a dialog box that allows you to specify whether
you want the schedule to be active all dayMonday, excludeMonday from the schedule, or have
the schedule be active at specific times.

Time Ranges

Daily Options

RELATED DOCUMENTATION

Schedules Overview | 507

Firewall Policies Overview | 429

Schedules Main Page Fields

Use the Schedules page to create, view, and delete schedules. A schedule allows you to restrict access to
a resource, or remove a restriction to a resource, for a specified period of time. You can filter and sort this
information to get a better understanding of what you want to configure. Table 1 describes the fields on
this page.
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Table 172: Schedules Main Page Fields

DescriptionField

Name of the schedule; maximum length is 63 characters.Name

Description for the schedule; maximum length is 900 characters.Description

Number of rules associated with the policy.Rule Count

Shows whether the schedule is active always or on specific start and end dates. Dates
appear in MM/DD/YYYY format.

Date Ranges

Shows whether the schedule is active daily, are any days excluded, or it is only active
for specific times of the day. Times appear in HH:MM:SS format.

Time Ranges

RELATED DOCUMENTATION

Schedules Overview | 507

Creating Schedules | 508

Creating Firewall Policies | 434
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CHAPTER 49

Firewall Policy-Profiles

IN THIS CHAPTER

Understanding Firewall Policy Profiles | 511

Understanding Captive Portal Support for Unauthenticated Browser Users | 512

Creating Firewall Policy Profiles | 513

Edit and Clone Policies and Objects | 519

Delete and Replace Policies and Objects | 520

Assigning Policies and Profiles to Domains | 521

Viewing Policy and Shared Object Details | 522

Firewall Policy Profiles Main Page Fields | 523

Understanding Firewall Policy Profiles

When a firewall policy profile is created, Security Director creates an object in the Security Director
database that represents the firewall policy profile. You can use this object in the security policies.

The following are the Juniper Networks predefined firewall policy profiles:

• All Logging Enabled—All logging options are enabled. Logging is enabled at session initiation and at the
close of the session.

• All Logging Disabled—All logging options are disabled.

• Log Session Close—Logging of events is enabled when sessions are closed.

• Log Session Init—Logging of events is enabled when sessions are created.

NOTE: You cannot modify or delete Juniper Networks predefined firewall policy profiles. You
can only clone them and create new firewall policy profiles.

You can create an object, which defines the user defined policy profiles for the following settings:

• Log options:
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• Log at session initiation

• Log at the close of a session

• Enable counting for the number of packets, bytes, and sessions that enter the firewall for a given policy

• Alarm threshold options

• Firewall authentication advance settings:

• Service offload

• Pass-through authentication

• Web authentication

• User firewall authentication

• Infranet authentication

• Traffic redirection options:

• No traffic redirection

• Redirect WX—WX redirection for packets that arrive from the LAN

• Reverse Redirect WX—WX redirection for the reverse flow of packets that arrive from the WAN

• TCP-SYN Check and TCP Sequence Check—TCP session options for firewall policy profile

RELATED DOCUMENTATION

Creating Firewall Policy Profiles | 513

Assigning Policies and Profiles to Domains | 521

Viewing Policy and Shared Object Details | 522

Understanding Captive Portal Support for Unauthenticated Browser Users

When an unauthenticated user requests access to an SRX Series protected resource using an HTTP or
HTTPS browser, the SRX Series device presents the user with a captive portal interface to allow the user
to authenticate. Normally, this process occurs without interference. However, prior to introduction of this
feature, HTTP or HTTPS-basedworkstation services running in the background, such asMicrosoft updates
and control checks, could trigger captive portal authentication before the HTTP or HTTPS browser-based
user’s access request did. The situation posed a race condition. If a background process triggered captive
portal first, the SRX Series device presented it with a “401 Unauthorized” page. The service discarded the
page without informing the browser, and the browser user was never presented with the authentication
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portal. The SRX Series device did not support simultaneous authentication from the same source IP address
on different SPUs.

The SRX Series device now supports simultaneous HTTP or HTTPS pass through authentication across
multiple SPUs, including support for web-redirect authentication. If an HTTP or HTTPS packet arrives
while the SPU is querying the Captive Portal (CP), the SRX Series device queues the packet to be handled
later.

Starting in Junos Space Security Director Release 17.1, Security Director supports Auth Only Browser and
Auth User Agent parameters to give you high control over how HTTP or HTTPS traffic is handled.

• Auth Only Browser—Authenticate only browser traffic. If you specify this parameter, the SRX Series
device distinguishes HTTP or HTTPS browser traffic from other HTTP or HTTPS traffic. The SRX Series
device does not respond to non-browser traffic. You can use the auth-user-agent parameter in conjunction
with this control to further ensure that the HTTP traffic is from a browser.

• Auth User Agent—Authenticate HTTP or HTTPS traffic based on the User-Agent field in the HTTP or
HTTPS browser header. You can specify one user-agent value per configuration. The SRX Series device
checks the user-agent value that you specify against the User-Agent field in the HTTP or HTTPS browser
header for amatch to determine if the traffic is HTTPorHTTPS browser-based. You can use this parameter
with the Auth Only Browser parameter or individually for both Pass Through and User Firewall
authentication types.

RELATED DOCUMENTATION

Understanding Firewall Policy Profiles | 511

Creating Firewall Policy Profiles | 513

Creating Firewall Policy Profiles

Use this page to create an object that specifies the basic settings of a security policy. You can configure
the following basic settings using a policy profile:

• Log options

• Firewall authentication schemes

• Traffic redirection options

When a policy profile is created, Junos Space creates an object in the Junos Space database to represent
the policy profile. You can use this object to create security policies.

513



The security policies enforce rules for transit traffic, in terms of what traffic can pass through the firewall,
and the actions that need to take place on traffic as it passes through the firewall. Also, you can control
the traffic flow from zone to zone by defining the kinds of traffic permitted to pass from specified sources
to specified destinations at scheduled times.

Before You Begin

• Read the “Understanding Firewall Policy Profiles” on page 511 topic.

• Create zones.

• Create an application (or application set) that indicates that the policy applies to traffic of that type.

• Create the policy.

• Create schedulers if you plan to use them for your policies.

• Review the policy profiles main page for an understanding of your current data set. See “Firewall Policy
Profiles Main Page Fields” on page 523 for field descriptions.

To configure a policy profile:

1. Select Configure > Firewall Policy > Profiles.

2. Click the + icon.

3. Complete the configuration according to the guidelines provided in the Table 173 on page 514.

4. Click OK.

A new policy profile with the predefined policy configurations is created. You can use this object in security
policies.

Table 173: Firewall Policy Profile Settings

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores.
No spaces are allowed and the maximum length is 63 characters.

Name

Enter a description for the policy profile; maximum length is 1024 characters.Description

Select a Security Director device template to use the predefined device-deployable
configuration by replacing the variables with actual values and evaluating the control logic
statements.

Template

Logging

514



Table 173: Firewall Policy Profile Settings (continued)

GuidelinesSettings

Select this option to enable logging of events when sessions are created.Session Initiate

Select this option to enable logging of events when sessions are closed.

When logging is enabled, the system logs at session close time by default.

Session Close

Select this option to enable counting. Once enabled, the number of packets, bytes, and
sessions that enter the device for a given policy are counted.

You can configure counts in an individual policy.

Count

Alarm Threshold

Enter the alarm threshold, in bytes per second, of all network traffic the policy allows to pass
through the device in both directions from client to server and server to client.

The range is from 0 through 4,294,967,295.

Bytes to be Logged

Enter the alarm threshold, in kilobytes per minute, of all network traffic the policy allows to
pass through the device in both directions from client to server and server to client.

The range is from 0 through 4,294,967,295.

Count Value

Authentication

Select an option to restrict or permit users individually or in groups:

• None—Allows user without any authentication to restrict or permit clients.

• Pass Through—Allows user to use an FTP, Telnet, or HTTP client to access the IP address
of the protected resource in another zone. Subsequent traffic from the user or host is
allowed or denied based on the result of this authentication.

• Web—Policy allows access to users who have previously been authenticated by Web
authentication.

• User Firewall—Uses the username and role information to determine whether to permit
or deny a user's session or traffic.

• Infranet—Pushes the user and role information for all authenticated users from the Access
Control Service.

Authentication Type

Authentication Type - Pass Through

Enter the names of the users or user groups in a profile for whom this policy allows access.
If you do not specify any users or user groups, then any user who is successfully authenticated
is allowed access.

Client Name

515



Table 173: Firewall Policy Profile Settings (continued)

GuidelinesSettings

Enable an option to redirect HTTP request:

• Redirect to web—Redirects an HTTP request to the device and redirect the client system
to awebpage for authentication. This allows users an easier authentication process because
they need to know only the name or IP address of the resource they are trying to access.

• Redirect to HTTPS—Redirects unauthenticated HTTP requests to the internal HTTPS
webserver of the device.

Client Direction

Enter a name for the access profile to be used for authentication.Access Profile Name

Enable this option to configure the firewall authentication to ignore non browser
HTTP/HTTPS traffic.

This ensures that the unauthenticated users issuing access requests through HTTP/HTTPS
browsers are presented with a captive portal interface to allow them to authenticate. By
default, firewall authentication responds to all HTTP/HTTPS traffic.

Auth Only Browser

Specify a user agent value to bematched against values specified in the browser’s User-Agent
header field that identifies the traffic as HTTP/HTTPS browser traffic. You can specify only
one user agent value for a security policy configuration. The value must not contain spaces.
The length of the string must be 17 characters or less. For example, you can specify Opera
to be verified against the browser’s User-Agent field for a match.

You can either use this parameter for the Pass Through or User Firewall authentication types
or in conjunction with the Auth Only Browser parameter.

Auth User Agent

Authentication Type - Web

Enter the names of the users or user groups who have already beenWeb authenticated and
for whom this policy allows access. Web authentication must be enabled on one of the
addresses on the interface to which the HTTP request is redirected.

Client Name

Authentication Type - User Firewall

Enter a domain name for firewall authentication in the event that theWindowsManagement
Instrumentation client (WMIC) is not available to get IP-to-user mapping for the integrated
user firewall feature.

The maximum length is 63 characters.

Domain Name

Enter a name for the access profile to be used for authentication.Access Profile Name
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Table 173: Firewall Policy Profile Settings (continued)

GuidelinesSettings

Enable this option to configure the firewall authentication to ignore non browser
HTTP/HTTPS traffic.

This ensures that the unauthenticated users issuing access requests through HTTP/HTTPS
browsers are presented with a captive portal interface to allow them to authenticate. By
default, firewall authentication responds to all HTTP/HTTPS traffic.

Auth Only Browser

Specify a user agent value to bematched against values specified in the browser’s User-Agent
header field that identifies the traffic as HTTP/HTTPS browser traffic. You can specify only
one user agent value for a security policy configuration. The value must not contain spaces.
The length of the string must be 17 characters or less. For example, you can specify Opera
to be verified against the browser’s User-Agent field for a match.

You can either use this parameter for the Pass Through or User Firewall authentication types
or in conjunction with the Auth Only Browser parameter.

Auth User Agent

Authentication Type - User Infranet

Enter a URL for the webpage to which the client is directed. For example:
https://www.juniper.net/.

Redirect URL

Select an option to redirect encrypted or unencrypted traffic:

• None—To not redirect any traffic

• All Traffic—To redirect the encrypted traffic

• Unauthenticated Traffic—To redirect the unencrypted traffic

Redirect Options

Advance Settings

Enable this option to process fast-path packets in the network processor instead of in the
Services Processing Unit (SPU). When performing the policy check, the SPU verifies if the
traffic is qualified for services offloading.

Datacenter SRX
Acceleration

Select an option to specify whether the traffic permitted by the policy is limited to packets
where the destination IP address has been translated by means of a destination NAT rule
or to packets where the destination IP address has not been translated:

• DropUntranslated—You do notwant to translate the destination address. Traffic permitted
by the policy is limited to packets where the destination IP address has not been translated.

• Drop Translated—You want to translate the destination address. Traffic permitted by the
policy is limited to packets where the destination IP address has been translated bymeans
of a destination NAT rule.

Destination Address
Translation
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Table 173: Firewall Policy Profile Settings (continued)

GuidelinesSettings

Select an option to define the acceleration policy forWX redirection of packets to theWXC
Integrated Service Module (ISM 200) for WAN acceleration:

• None—You want traffic to be redirected

• Redirect WX—You want to enable Wx redirection for packets that arrive from the LAN

• Reverse RedirectWX—Youwant to enableWX redirection for the reverse flow of packets
that arrive from the WAN.

During the redirection process, the direction of theWX packet and its type determine further
processing of the packet.

Redirect Options

TCP-Session Options

Enable this option for the device to reject TCP segments with non-SYN flags set unless they
belong to an established session.

TCP-SYN

Enable this option to monitor the TCP byte sequence counter and to validate the trusted
acknowledgment number against the untrusted sequence number.

TCP Sequence

Enable this option to increase the network transmission speed.Window Scale

Select the TCP maximum segment size (MSS) for packets arriving at the ingress interface
(initial direction). If the value in the packet is higher than the one you select, the configured
value overrides the TCP MSS value in the incoming packet.

The range is 64 through 65535.

Initial TCP MSS

Select the TCP maximum segment size (MSS) for packets that match a specific policy and
travel in the reverse direction of a session. If the value in the packet is higher than the one
you select, the configured value replaces the TCP MSS value.

The range is 64 through 65535.

Reverse TCP MSS

RELATED DOCUMENTATION
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Understanding Captive Portal Support for Unauthenticated Browser Users | 512

Assigning Policies and Profiles to Domains | 521

Viewing Policy and Shared Object Details | 522
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Edit and Clone Policies and Objects

IN THIS SECTION

Edit Policies or Objects | 519

Clone Policies or Objects | 520

You can edit or clone policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Edit Policies or Objects

To edit a policy or a shared objects:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to edit, and then click the pencil icon.

The Edit window appears, showing the same options as when creating a new policy or object.

3. Click OK to save your changes.

NOTE: After the published firewall policy rules are edited and saved, you see an icon next to
the check box for each saved policy rule on the Firewall Policies page. When you hover over the
icon, a message appears, indicating that the policy was edited and needs to be pushed to the
device. For updating the policy, see “Updating Policies on Devices” on page 478.

519



Clone Policies or Objects

To clone a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to clone, or select Clone from the More list.

The Clone window appears with editable fields.

3. Click OK to save your changes.

RELATED DOCUMENTATION

Creating Firewall Policy Profiles | 513

Delete and Replace Policies and Objects

IN THIS SECTION

Delete Policies and Objects | 520

Replace Policies and Objects | 521

You can delete or replace policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Delete Policies and Objects

To delete a policy or a shared object:

1. Select Configure > Policies or Shared Objects.
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The policies or shared objects page appears.

2. Select the policy or shared object that you want to delete, and then select the minus sign (-).

An alert message appears verifying that you want to delete your selection.

3. Click Yes to delete your selection.

Replace Policies and Objects

You can select one or more shared objects and replace them with other objects of the same type.

To replace one or more object:

1. Select Configure > Shared Objects > Addresses, Services, or Variables.

The addresses, services, or variables page appears.

2. Right-click the shared object that you want to replace, or click Replace from the More list.

You can replace a single object or multiple objects. If the selected object is used in any policy, a warning
message appears before they are replaced.

3. Click Yes to continue the replacement operation.

RELATED DOCUMENTATION

Creating Firewall Policy Profiles | 513

Assigning Policies and Profiles to Domains

You can assign or reassign policies or profiles to different domainswhen it is first configured andwhenever
you want to implement a change. You can assign only one policy or profile at a time. Before assigning a
policy or profile to another domain, Security Director checks for the validity of the move. If the move is
not acceptable, a warning message appears.
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To assign a policy or profile to a domain:

1. Select Configure and select the landing page for the type of policy or profile that you are assigning to
a domain.

2. From the landing page, right-click the policy or profile or clickMore.

A list of actions appears.

3. Select Assign <Policy or Profile> to Domain.

The Assign <Policy or Profile> to Domain page appears.

NOTE: <Policy or Profile> is the name of the policy or profile that you are assigning to a
domain.

4. Select the required items to assign to a domain.

5. Enable this option to ignore warning messages, if any.

6. Click Assign.

A policy or profile is assigned to a domain.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Creating NAT Policies | 707

Creating IPS Policies | 640

Viewing Policy and Shared Object Details

On a policy or a shared object landing page, you can get a detailed view of the existing policies or objects.
The Detail View page lists all the configured parameters of a policy or an object. The Landing page of a
policy or shared object lists only some of the configured parameters and not all. The Detail View option
helps you to get a consolidated view of all the configured parameters.
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NOTE: The detailed view is in read-only mode; you cannot edit any fields.

To see a detailed view of the policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to see the detailed view for, or selectDetail View
from the More list.

The Detail View page appears showing the configuration information, the user who created that
particular policy or shared object, and the last updated information.

You can also get a detailed view by hovering over the name and clicking the Detailed View icon before
the policy or shared object name.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Creating IPS Policies | 640

Creating NAT Policies | 707

Firewall Policy Profiles Main Page Fields

Use the firewall policy profiles main page to get an overall, high-level view of your policy profile settings.
You can filter and sort this information to get a better understanding of what you want to configure.
Table 174 on page 523 describes the fields on this page.

Table 174: Firewall Policy Profiles Main Page Fields

DescriptionField

Name of the policy profile.Name

Description of the policy profile.Description

Login name of the operator who last modified the firewall policy profile.Last Updated By

Time when the firewall policy profile was last updated .Last Updated Time
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Table 174: Firewall Policy Profiles Main Page Fields (continued)

DescriptionField

Domain name of the security device. This information is auto-populated once
you select the device. For example: global, system.

Domain

RELATED DOCUMENTATION

Understanding Firewall Policy Profiles | 511

Creating Firewall Policy Profiles | 513
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CHAPTER 50

Firewall Policy-Templates

IN THIS CHAPTER

Understanding Firewall Policy Templates | 525

Creating Firewall Policy Templates | 525

Edit and Clone Policies and Objects | 527

Delete and Replace Policies and Objects | 528

Firewall Policy Templates Main Page Fields | 529

Understanding Firewall Policy Templates

With the firewall policy template feature, you can use a CLI-based template editor to send configuration
details tomultiple devices. Because it is DeviceManagement Interface (DMI) schema-driven, this template
is used to generate a device deployable configuration by replacing the parameterized elements (variables)
with actual values and evaluating the control logic statements.

When you do not have an object in Security Director for a firewall policy, you can create template with
the Junos CLI. After you create a template, you can add it in firewall policy and then refer it in rules. When
you deploy the firewall policy, all the assigned devices are also deployed. This template is based on the
Junos Space CLI quick templates.

RELATED DOCUMENTATION

Creating Firewall Policy Templates | 525

Creating Firewall Policy Templates

Use this page to manage and create policy templates. You can use a CLI-based template editor to send
configuration details to multiple devices. The template editor is a text-editing area, where you can type
or paste Junos OS CLI commands.
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Before You Begin

• Read the “Understanding Firewall Policy Templates” on page 525 topic.

• Have a basic understanding of Junos OS CLI commands.

• Review the Firewall Policy Templates main page for an understanding of your current data set. See
“Firewall Policy Templates Main Page Fields” on page 529 for field descriptions.

• Create source (from-zone) and destination (to-zone) zones.

To configure a firewall policy template:

1. Select Configure > Firewall Policy > Templates.

2. Click the + icon.

3. Complete the configuration according to the guidelines provided in Table 175 on page 526.

4. Click OK.

A new firewall policy device template with your configurations is created. Create a policy profile and
associate the template in the policy profile. After associating the template, the policy profile can be referred
in the firewall rules or firewall policies.

Table 175: Firewall Policy Template Settings

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons, periods, dashes, and
underscores. No spaces are allowed and the maximum length is 63 characters.

Name

Enter a description for the firewall policy device template; maximum length is 1024
characters.

Description

Displays the autopopulated Juniper Networks SRX Series or LN Series devices as the
device family. For example, SRX/vSRX/LN.

Device Family

Select a Junos schema release running on the device. For example, 11.4R2.4.Release Number

Enter or copy the Junos OS CLI commands to send configuration details to multiple
devices.

Template Editor

Click the link to validate the configuration on the device. This ensures that the device
template is semantically correct.

Validate
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Understanding Firewall Policy Templates | 525

Edit and Clone Policies and Objects

IN THIS SECTION

Edit Policies or Objects | 527

Clone Policies or Objects | 528

You can edit or clone policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Edit Policies or Objects

To edit a policy or a shared objects:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to edit, and then click the pencil icon.

The Edit window appears, showing the same options as when creating a new policy or object.

3. Click OK to save your changes.

NOTE: After the published firewall policy rules are edited and saved, you see an icon next to
the check box for each saved policy rule on the Firewall Policies page. When you hover over the
icon, a message appears, indicating that the policy was edited and needs to be pushed to the
device. For updating the policy, see “Updating Policies on Devices” on page 478.
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Clone Policies or Objects

To clone a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to clone, or select Clone from the More list.

The Clone window appears with editable fields.

3. Click OK to save your changes.

RELATED DOCUMENTATION

Creating Firewall Policy Templates | 525

Delete and Replace Policies and Objects

IN THIS SECTION

Delete Policies and Objects | 528

Replace Policies and Objects | 529

You can delete or replace policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Delete Policies and Objects

To delete a policy or a shared object:

1. Select Configure > Policies or Shared Objects.
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The policies or shared objects page appears.

2. Select the policy or shared object that you want to delete, and then select the minus sign (-).

An alert message appears verifying that you want to delete your selection.

3. Click Yes to delete your selection.

Replace Policies and Objects

You can select one or more shared objects and replace them with other objects of the same type.

To replace one or more object:

1. Select Configure > Shared Objects > Addresses, Services, or Variables.

The addresses, services, or variables page appears.

2. Right-click the shared object that you want to replace, or click Replace from the More list.

You can replace a single object or multiple objects. If the selected object is used in any policy, a warning
message appears before they are replaced.

3. Click Yes to continue the replacement operation.

RELATED DOCUMENTATION

Creating Firewall Policy Templates | 525

Firewall Policy Templates Main Page Fields

Use the Firewall Policy Templates main page to get an overall, high-level view of your device template
settings. You can filter and sort this information to get a better understanding ofwhat youwant to configure.
Table 176 on page 529 describes the fields on this page.

Table 176: Firewall Policy Templates Main Page Fields

DescriptionField

Name of the template; maximum length is 63 characters.Name

Displays the type of the firewall policy template.Template Type
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Table 176: Firewall Policy Templates Main Page Fields (continued)

DescriptionField

Description of the template.Description

Junos OS version running on the device.OS Version

Login name of the operator who last modified the template .Last Updated By

Time when the template was last updated .Last Updated Time

Domain name of security device, which is autopopulated once you select the
device. For example: global, system.

Domain

RELATED DOCUMENTATION

Understanding Firewall Policy Templates | 525

Creating Firewall Policy Templates | 525
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CHAPTER 51

Firewall Policy-Secure Web Proxy

IN THIS CHAPTER

About the Secure Web Proxy Page | 531

Create a Secure Web Proxy Profile | 532

Edit, Clone, and Delete a Secure Web Proxy Profile | 534

Assign Secure Web Proxy Profile to a Domain | 535

Find Secure Web Proxy Profile Usage Details | 536

About the Secure Web Proxy Page

To access this page, click Configure > Firewall Policy > Secure Web Proxy.

Starting in Junos Space Security Director Release 21.1R1, you can use secureWeb proxy to enable traffic
for the selected dynamic applications to bypass the external proxy server and sent directly to a webserver.
Unified policy can co-exist with the secure Web proxy.

You must define a Web proxy profile by specifying external proxy server details and dynamic application.
You can associate this secure Web proxy profile with standard/unified firewall policy rule for advanced
security. The traffic matching the firewall rule is sent to the configured external proxy server on the rule,
unless the selected dynamic application matches.

Tasks You Can Perform

You can perform the following tasks from this page:

• Create a secure Web proxy profile. See “Create a Secure Web Proxy Profile” on page 532.

• Clone, edit, and delete a Web proxy profile. See “Edit, Clone, and Delete a Secure Web Proxy Profile”
on page 534.

• Find usage of a secureWeb proxy profile. See “Find Usage of a SecureWeb Proxy Profile” on page 536.

• Show and delete unused profiles. See “Show and Delete Unused Policies and Objects” on page 477.

• Assign a secure Web proxy profile to a domain. See “Assign Secure Web Proxy Profile to a Domain” on
page 535.
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Field Descriptions

Table 177 on page 532 provides guidelines on using the fields on the Secure Web Proxy page.

Table 177: Fields on the Secure Web Proxy Page

DescriptionField

Specifies the name of the secure Web proxy profile.Name

Specifies the description of the secure Web proxy profile.Description

If enabled, drops the Web proxy session on DNS error.Drop on DNS Error

Specifies the name of the external proxy server.Proxy Address

Specifies the dynamic Web application.Dynamic Web Application

Specifies the domain name.Domain

RELATED DOCUMENTATION

For more details on Secure Web Proxy, see Junos documentation.

Create a Secure Web Proxy Profile

To configure secure Web proxy on the SRX Series device, define a Web proxy profile with external proxy
server details and dynamic application.

1. Select Configure > Firewall Policy > Secure Web Proxy.

The Secure Web Proxy page is displayed.

2. Click the + icon.

The Create Secure Web Proxy Profile page is displayed.

3. Configure the values according to the guidelines provided in Table 178 on page 533.

4. Click OK.
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If the operation is successful, the newly created secure web proxy profile is listed on the Secure Web
Proxy page.

You can use the newly created secure web proxy in the standard firewall policy rule for advanced
security.

Table 178: Secure Web Proxy Profile

DescriptionFields

Enter the name of the secure Web proxy profile.Name

Enter the description of the secure Web proxy profile.Description

Enable to drop the Web proxy session on DNS error.Drop on DNS error

To add application signatures:

a. Click the + icon.

The Add Application Signatures page is displayed.

b. Select an application signature(s).

c. Click OK.

Dynamic Web Application

To create a proxy address:

a. Click the + icon.

The Create Proxy Address page is displayed.

b. Enter the name of the external proxy server.

c. Enter the IP address of the external proxy server.

d. Enter the prefix. The value must be 1 through 32 for IPv4 and 1 through 128 for
IPv6.

e. Enter the port number of the external proxy server.

f. Click OK.

Proxy Address
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About the Secure Web Proxy Page | 531

Edit, Clone, and Delete a Secure Web Proxy Profile

IN THIS SECTION

Edit a Secure Web Proxy Profile | 534

Clone a Secure Web Proxy Profile | 534

Delete a Secure Web Proxy Profile | 535

You can edit, clone, and delete a secure Web proxy profile.

Edit a Secure Web Proxy Profile

1. Select Configure > Firewall Policy > Secure Web Proxy.

The Secure Web Proxy page is displayed.

2. Select a profile, right-click and then select Edit or you can select a profile and click the pencil icon.

The Modify Secure Web Proxy Profile page is displayed.

3. Modify the parameters by following the guidelines provided in “Create a Secure Web Proxy Profile”
on page 532.

4. Click OK.

Clone a Secure Web Proxy Profile

1. Select Configure > Firewall Policy > Secure Web Proxy.

The Secure Web Proxy page is displayed.

2. Select a profile, right-click or select Clone from the More list.

The Clone SecureWeb Proxy Profile page is displayed with the values that you provided while creating
the secure Web proxy profile.
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3. Enter a new name for the profile andmodify the parameters following the guidelines provided in “Create
a Secure Web Proxy Profile” on page 532.

4. Click OK.

A confirmation message appears indicating the status of the clone operation.

Delete a Secure Web Proxy Profile

1. Select Configure > Firewall Policy > Secure Web Proxy.

The Secure Web Proxy page is displayed.

2. Select a profile, right-click and then select Delete or you can select a profile and click the delete icon.

A confirmation message is displayed.

3. Click Yes to delete the secure Web proxy profile.

Delete operation fails if the secure Web proxy profile is used in any standard firewall policy rule. You
must remove the associations before deleting the secure Web proxy profile.

RELATED DOCUMENTATION

About the Secure Web Proxy Page | 531

Assign Secure Web Proxy Profile to a Domain

You can assign profiles to a domain when they are first configured or when you want to implement a
change. Security Director checks domain validity, before assigning a profile to another domain.

1. Select Configure > Firewall Policy > Secure Web Proxy.

The Secure Web Proxy page is displayed.

2. Select a profile, right-click or select Assign Secure Web Proxy Profile to Domain from the More list.

The Assign Secure Web Proxy Profile to Domain page is displayed.

3. Select a domain to assign the profile.

4. Click OK.
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The status of Secure Web Proxy Profile objects assignments to the selected domain is displayed.

5. Click Close.

The assigned domain is displayed in the Domain column on the Secure Web Proxy page.

RELATED DOCUMENTATION

About the Secure Web Proxy Page | 531

Find Secure Web Proxy Profile Usage Details

You can find the secure Web proxy profile usage details in a firewall policy.

1. Select Configure > Firewall Policy > Secure Web Proxy.

The Secure Web Proxy page is displayed.

2. Right-click a secure web proxy profile and select Find Usage.

The Search Results page is displayed with the secure web proxy profile names and its usage details.

RELATED DOCUMENTATION

About the Secure Web Proxy Page | 531
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Environment
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Environment Variables and Conditions Overview

You can use environment variables and conditions to configure dynamic policy actions for your firewall
policy rules.With traditional firewall rules, if youwant to block all outbound traffic, then youmust manually
modify the action of the rules from permit to deny. Similarly, if you want to allow all traffic, you modify
the action from deny to permit. When handling critical events, going through hundreds of firewall policy
rules and modifying them is both time consuming and inefficient. Further, when the event is over, you
might need to revert those rule settings to the previously configured values.

To avoid such manual configurations to the firewall rules and to improve your control over configurations,
as a network administrator, you can define environment variables and apply conditions by using these
variables. Based on the conditions that you define, certain preconfigured actions are taken on the firewall
policy rules dynamically.

Along with the action, you can define certain advanced security properties. You can also disable the rules
based on the action and change the logging options.

Table 179 on page 537 and Table 180 on page 538 show examples of the usage of custom-defined
environment variables and rule actions based on variable values.

Table 179: Example of Custom-Defined Environment Variables

Current ValueDefault ValuePossible ValueTypeEnvironment Variable

HighLowLow, Medium, HighStringThreat Level
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Table 180: Example of Rule Actions Based on Variable Values

IPSFirewallServiceDestinationSourceRule #

NoneIf (ThreatLevel= High)
Deny Else Permit

httpInternet videoEmployeem

If (ThreatLevel=High)
Adv_profile Else
Std_Profile

PermitDBDBZoneWebZonen

Table 181 on page 538 shows an example of how conditions are used. In the Environment Condition column,
the condition is first evaluated to identify the related set of action the system will take. For example, if
the value of the ThreatLevel environment variable isMedium at any point of time, the system automatically
enables the intrusion prevention system (IPS) service for the corresponding traffic.

Table 181: Example of Environment Condition

Other Actions
Firewall
Action

Environment
Condition

Destination
Traffic Match
Criteria

Source Traffic
Match
Criteria

Rule
Number

LOGPERMITThreatLevel=LowMyCriticalServersAny1000

LOG
IPS_STD_PROFILE

PERMITThreatLevel=Medium

LOGDENYThreatLevel=High

Benefits of Environment Variables and Conditions

• Simplifies the task of creating, in advance, different security actions that the security team can take to
test the system’s behavior under different environmental conditions.

• Reduces the time required to react to security threats or situations and take the required actions. During
critical situations, security administrators must focus on identifying the attacks and, with environment
variables configured, they do not have to spend toomuch time and effort in manipulating the rules table.

• Reduces the probability of manual errors, especially during critical events when a large number of firewall
policy rules need to be edited.

• Helps reduce business risks by streamlining security operations for normal conditions aswell as for other
dynamic conditions.
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About the Environment Page

To access this page, click Configure > Environment.

Use the Environment page to configure and manage the environment variables and its conditions to
dynamically change firewall rule actions.

Every time the environment changes, you do not have to go through the entire rule configuration. Instead,
rules are modified dynamically when the environment changes; you are required to only update the value
of the variables.

Typically, network administrators configure environment variables and conditions.

Tasks You Can Perform

You can perform the following tasks from the Environment page:

• Create a new environment variable from the Variables tab. See “Creating a New Environment Variable”
on page 541.

• Edit or delete the environment variable from the Variables tab. See “Editing and Deleting Environment
Variables” on page 542.

You can perform the following tasks from the Environment page:

• Create a new environment condition from the Environment Conditions tab. See “Creating a New
Environment Condition” on page 544.

• Edit or delete the environment condition from the Environment Conditions tab. See “Editing andDeleting
Environment Conditions” on page 545.

Field Descriptions

Table 182 on page 540 provides guidelines on using the fields on the Environment Variables page.
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Table 182: Fields on the Environment Page

DescriptionField

Variables tab

Specifies the name of the environment variable.Variable

Specifies the user-defined values for each variable to secure the network situation.Possible Values

Specifies the current value of the variable.Current Value

Specifies the environment conditions where the variable is used and the number
of rules assigned to that condition.

Click the number of conditions or rules for more information.

Used In

Specifies the last modified date and time of the variable.Last Changed On

Environment Conditions tab

Specifies the name of the condition.

The green dot before the condition name means that the condition is active.

Condition Name

Specifies the environment variables used in that particular condition.Variables Used

Specifies the current state of the condition. For example, active or inactive.Current State

Specifies the number of rules that matches the condition.Used In

Shows the number of times the condition was active.Activated Count

Specifies the date and time of the state change from active to inactive and vice
versa.

Status Changed On
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Creating a New Environment Variable

Use the Create a New Environment Variable page to define the new environment variables and assign the
threat levels. These variables are used to define the environment conditions.

To create a new environment variable:

1. Select Configure > Environment.

The Environment page appears.

2. Select the Variables tab and click the + icon.

The Create New Environment Variable page appears.

3. Complete the configuration by using the guidelines in Table 183 on page 541.

4. Click Save to save the configuration or Cancel to discard the configuration.

Use these environment variables to define the environment conditions. You can create a new condition
or edit the existing condition to use these variables.

Table 183: Fields on the Create New Environment Variable Page

DescriptionField

Enter a unique string of alphanumeric characters, colons, periods, dashes, and
underscores. No spaces are allowed; maximum length is 63 characters.

Variable Name

Select the type of possible values.

• Numbers—Select this option to provide a list of numbers.

• Number Range—Select this option to define a number range for the possible values.

• Text—Select this option to provide the string as a possible value.

Possible Value Type

Enter the list of possible values, based on the possible value type that you have selected.
For example, high, medium, low, 2, 4, or 1 to 6.

Possible Values

Select the default possible value for the environment variable from the list.Default Value

Select the current possible value for the environment variable from the list. If nothing
is defined, the default value is considered the current value.

Current Value (optional)
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Editing and Deleting Environment Variables
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You can edit or delete the environment variables from the Variables tab.

Editing Environment Variables

To edit an environment variable:

1. Select Configure > Environment.

The Environment page appears.

2. Select the variable that you want to edit, and then click the pencil icon.

The Edit Environment Variable page appears showing the same options that were used to create a new
variable.

3. Changing the variable values might impact the actions of certain rules. To view the affected rules, click
click here in the Change Impact section.

The Policy Change List page appears listing the affected firewall polices with rules. Click the rules to
preview the changes.

4. Click Save to save your changes.
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The Policy Change List page appears listing the rules that are modified because of the variable update.

5. Click Publish and Update to update the modified rules to the device.

Deleting an Environment Variable

You can only delete variables that are not used in any condition. If you try to delete a variable in use, you
will receive a failure message with a link to view the list of conditions that have used the selected variable.

To delete a variable that is not used in any condition:

1. Select Configure > Environment.

The Environment page appears.

2. Select the variable that you want to delete, and then select the delete icon (X).

An alert message appears confirming the delete operation.

3. Click Yes to delete your selection.

If the variable is not used in any condition, then the delete operation is successful. Otherwise you see
a failure message.
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Creating a New Environment Condition

Use the Create New Environment Condition page to create a new environment condition using the
environment variables.

To create a new environment condition:

1. Select Configure > Environment.

The Environment page appears.

2. Select the Environment Conditions tab and click the + icon.

The Create New Environment Condition page appears.

3. Complete the configuration by using the guidelines in Table 184 on page 544.

4. Click Save to save the configuration or Cancel to discard the configuration.

After defining a new condition, youmust apply it to the firewall policy rules. After assigning these conditions
to the rules, publish and update to the device.

Table 184: Fields on the Create New Environment Condition Page

DescriptionField

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores.
No spaces are allowed; maximum length is 63 characters.

Condition Name

Enter a description for the environment condition; maximum length is 255 characters.Description

Click the field and select the environment variable and the required possible values.

You can choose one or more variables in a combination. For example, use ’=’ or ’!=’ operator
to apply OR condition for the possible values. You can choose the AND operator, for the
AND condition.

Condition

Security administrators can now use the conditional evaluators based on the environment variables in the
firewall policy. Security Director auto-calculates the changes to the relevant rules and based on the
administrator’s approval, pushes out these changes to the entire network as required.

For example, the firewall policy rule table is updated with environment conditions, as shown in
Table 185 on page 545. If the ThreatLevel is Orange at a point of time, the system enables IPS service
automatically for the corresponding traffic.
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Table 185: Firewall Rule with a Condition

Other Actions
Firewall
Action(s)

Environmental
Condition

Destination
Traffic Match
Criteria

Source
TrafficMatch
Criteria

Rule
Number

LOGPERMITThreatLevel=GREENMyCriticalServersAny1000

LOG
IPS_STD_PROFILE

PERMITThreatLevel=ORANGE

LOGDENYThreatLevel=RED
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You can edit or delete the environment conditions from the Environment Conditions tab.
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Editing an Environment Condition

To edit an environment condition:

1. Select Configure > Environment.

The Environment page appears.

2. In the Environment Conditions tab, select the condition that you want to edit, and then click the pencil
icon.

The Edit Environment Condition page appears displaying the same options that were used to create a
new condition.

3. Click Save to save the changes or Cancel to discard the changes.

Deleting an Environment Condition

To delete an environment condition:

1. Select Configure > Environment.

The Environment page appears.

2. In the Environment Conditions tab, select the condition that you want to delete, and then select the
delete icon (X).

An alert message appears confirming the delete operation.

3. Click Yes to delete your selection.
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Application Firewall Policy-Policies
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Understanding Application Firewall Policies

Many dynamic applications use HTTP static ports to tunnel non-HTTP traffic through the network. Such
applications can permit traffic that might not be adequately controlled by standard network firewall policies,
leading to a security threat. Standard policies function based on IP addresses and ports, and therefore are
not effectivewith these dynamic applications. To avoid these security issues, an additional security control
for policies was introduced that functions based on the application ID.

The security policies provide firewall security functionality by enforcing rules for the traffic, which pass
through the device, is permitted or denied based on the action defined in the rules. The application firewall
port in the policies provides additional security control for dynamic applications.

An application firewall provides the following features:

• Permits, rejects, or denies traffic based on the application in use.

• Identifies not only HTTP but also any application running on top of it, letting you properly enforce
policies. For example, an application firewall rule could block HTTP traffic from Facebook but allowWeb
access to HTTP traffic from MS Outlook.

The application firewall policy is defined by a collection of rule sets. A rule set defines the rules that match
the application ID detected, based on the application signature. After you create an application firewall
policy by adding rules, you can select that policy to be the active policy on your device.
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The application firewall policy identifies the application ID as an unknown application ID under the following
circumstances:

• No application ID matches the traffic.

• The system encounters an error when identifying the application.

• Application ID is not identified during failover sessions.

When the application ID is identified as unknown, the traffic is processed based on the action defined in
the unknown rule in the rule set. When there is no rule defined for unknown in the rule set, the default
rule is applied for unknown dynamic applications.
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Creating Application Firewall Policies

Use the Application Firewall Policies page to configure an application firewall policy and to specify the
rule set to be applied to it.

An application firewall:

• Permits, rejects, or denies traffic based on the application of the traffic.

• Consists of one or more rule sets that specify match criteria and the action to be taken for matching
traffic.

• Identifies not only HTTP but also any application running on top of it, letting you properly enforce
policies. For example, an application firewall rule could block HTTP traffic from Facebook but allowWeb
access to HTTP traffic from MS Outlook.

Before You Begin

• Read the “Understanding Application Firewall Policies” on page 547 topic.

• Have a basic understanding of firewall rules.

• Have a basic understanding of an application (or application set) that indicates that the policy applies to
traffic that matches it.

• Review the application firewall policies main page for an understanding of your current data set. See
“Application Firewall Policies Main Page Fields” on page 556 for field descriptions.
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To configure an application firewall policy, you must create a policy and then add rules to it. To create an
application firewall policy:

1. Select Configure > Application Firewall Policy > Policies.

2. Click the + icon.

3. Complete the configuration according to the guidelines provided in the Table 186 on page 549.

4. Click OK.

To add rules to the application firewall policy:

1. Click Add Rules for the policy you created.

2. Click +.

3. Complete the configuration according to the guidelines provided in the Table 187 on page 549.

4. Click OK.

A new application firewall policy with your configurations is created. You can add rules to this policy to
provide additional security.

Table 186: Application Firewall Policies Settings

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons, periods, dashes, and
underscores. No spaces are allowed and the maximum length is 63 characters.

Name

Enter a description for the policy; maximum length is 1024 characters.Description

Table 187: Add Rule Settings

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores.
No spaces are allowed and the maximum length is 63 characters.

Rule Name

Select an option to add or delete an application signature.

Select one or more available application signatures to add to the rules.

Application Signatures
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Table 187: Add Rule Settings (continued)

GuidelinesSettings

Select an option to specify different actions for encrypted and unencrypted SSL traffic:

• Any—Matches both encrypted and unencrypted SSL traffic.

• Yes—Matches encrypted SSL traffic only.

• No—Matches unencrypted SSL traffic only.

Encryption

Select an option for any traffic that matches the application firewall rule set:

• Permit—Allows the traffic at the firewall.

• Deny—Blocks traffic, closes the session, and logs the event from an application firewall.
By default, no message is returned to the client. But you can choose to send a message.

• Reject—Drops traffic with amessage to the client, closes the session, and logs the event
from an application firewall.

Action

Select whether or not to notify clients when drop or reject actions are logged from an
application firewall:

• Yes—Displays a default message or customized message, or redirects the clients for
denied HTTP or HTTPS traffic. All other traffic is dropped silently.

• No—No message is sent to the client.

Notify user on blocking
(Deny or Reject)

Select an option for any traffic that does not match any defined application firewall rule:

• Permit—Allows the traffic at the firewall.

• Deny—Blocks the traffic and the device drops the packet. By default, no message is
returned to the client but you can choose to send a message.

• Reject—Drops the traffic. By default the device drops the packet and returns a TCP
reset (RST) message to the source host and to the server in some cases. For UDP or
other protocol traffic, an ICMP unreachable message is returned to both client and
server.

Default Action—Default
Action for other
applications (not
matching any rule)

Select an option to provide a text explanation to the client, redirect the client to an
informative webpage, or do nothing after a reject or deny action from an application
firewall:

• Not Configured—No message is returned to the client.

• CustomMessage—Enter text to display with splash screen to inform the client that the
traffic has been blocked.

• Redirect URL—Enter URL to redirect the client to a custom webpage instead of the
default splash screen. For example: https://www.juniper.net/.

Block Message—Block
Message Type
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Delete and Replace Policies and Objects
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You can delete or replace policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Delete Policies and Objects

To delete a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to delete, and then select the minus sign (-).

An alert message appears verifying that you want to delete your selection.

3. Click Yes to delete your selection.

Replace Policies and Objects

You can select one or more shared objects and replace them with other objects of the same type.
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To replace one or more object:

1. Select Configure > Shared Objects > Addresses, Services, or Variables.

The addresses, services, or variables page appears.

2. Right-click the shared object that you want to replace, or click Replace from the More list.

You can replace a single object or multiple objects. If the selected object is used in any policy, a warning
message appears before they are replaced.

3. Click Yes to continue the replacement operation.
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Edit and Clone Policies and Objects
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You can edit or clone policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Edit Policies or Objects

To edit a policy or a shared objects:

1. Select Configure > Policies or Shared Objects.
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The policies or shared objects page appears.

2. Select the policy or shared object that you want to edit, and then click the pencil icon.

The Edit window appears, showing the same options as when creating a new policy or object.

3. Click OK to save your changes.

NOTE: After the published firewall policy rules are edited and saved, you see an icon next to
the check box for each saved policy rule on the Firewall Policies page. When you hover over the
icon, a message appears, indicating that the policy was edited and needs to be pushed to the
device. For updating the policy, see “Updating Policies on Devices” on page 478.

Clone Policies or Objects

To clone a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to clone, or select Clone from the More list.

The Clone window appears with editable fields.

3. Click OK to save your changes.
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Show and Delete Unused Policies and Objects
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You can show or delete unused policies and objects in your network configurations.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Show Unused Policies and Objects

You can view all unwanted policies or objects that are not used anywhere in your network to take
appropriate action.

To show unused policies or objects:

1. Select Configure and select the landing page for type of policy or object you are showing.

2. From the landing page, clickMore.

A list of actions appears.

3. Select Show Unused.

A list of unused objects (not referenced in any policy) and unused policies appear on the page.

Delete Unused Policies and Objects

You can clear all unwanted policies or objects that are not used anywhere in your network.
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To delete unused policies or objects:

1. Select Configure and select the landing page for type of policy or object you are deleting.

2. Select the check boxes beside the items that you want to delete. Right-click on the policy or object or
click More from the landing page.

A list of actions appears.

3. Select Delete Unused.

A confirmation window appears before you can delete the unused policies or objects.

4. Click Yes to confirm the deletion.

All unused policies or objects are deleted.
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Finding Usages for Policies and Objects

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

You can find usages for policies or objects and take appropriate action.

To find policies or objects usages:

1. Select Configure > and select the landing page for the policy or object for which you want to find
usages.

The policies or shared objects page appears

2. Right-click the policy or object or clickMore.

3. Select Find Usage. The usage window appears, showing the usage of the selected policy or object.
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Application Firewall Policies Main Page Fields

Use the application firewall policies main page to get an overall, high-level view of your application firewall
policy settings. You can filter and sort this information to get a better understanding of what you want to
configure. Table 188 on page 556describes the fields on this page.

Table 188: Application Firewall Policies Main Page Fields

DescriptionField

Name of the application firewall policy; maximum length is 63 characters.Name

Action taken for any traffic thatmatches one of the specified applications. For example:
Reject, Permit, Deny.

Default Action

The match criteria, including dynamic applications, and the action to be taken for
matching traffic.

Rules

The type and content in a block message profile defined in the rule set. For example:
Text, URL.

Block Message Type

Either a text explanation to the client or a URL redirect of the client to an informative
webpage. Occurs when traffic is blocked by a reject action or a deny action from an
application firewall.

BlockMessage/Redirect URL

Domain name of the security device. This information is autopopulated once you
select the device. For example: global, system.

Domain

Description of the application firewall policy.Description

RELATED DOCUMENTATION

Understanding Application Firewall Policies | 547

Creating Application Firewall Policies | 548

556



CHAPTER 54

Application Firewall Policy-Signatures
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Understanding Custom Application Signatures

IN THIS SECTION

ICMP-Based Mapping | 558

Address-Based Mapping | 558

IP Protocol-Based Mapping | 559

Layer 7-Based Signatures | 559

Application identification supports user-defined custom application signatures and signature groups.
Custom application signatures are unique to your environment and are not part of the predefined application
packagewhen you install them into the device. The custom application signatures are pushed to the device
when you publish or update and subsequently, you can use them in the application firewall policy rules
only.

The custom application signatures are required:

• To control traffic particular to an environment

• To bring visibility for unknown or unclassified applications by developing custom applications
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• To identify applications over Layer 7 that are transiting or temporary applications, and to achieve further
granularity of known applications

• To perform QoS for your specific application

Starting in Junos Space Security Director 17.1, you can create the custom application identification for all
devices running JunosOSRelease 15.1X49-D40 and later. You can use the custom application identification
in the application firewall policies similar to the predefined application identifications. If the custom
application identifications are not supported by a device, Security Director shows an error during the policy
publish or the configuration preview.

You can import the custom application signatures from a device and also push the created custom application
signatures to a device, by using the publish and update workflow.

NOTE:
• You can use the custom application signatures only in the application firewall policy rules.

• Security Director and device configurations must be in sync for the application visibility to
work with the custom application signatures.

SRX Series devices support the following types of custom signatures:

ICMP-Based Mapping

The ICMPmapping techniquemaps standard ICMPmessage types and optional codes to a unique application
name. This mapping technique lets you differentiate between various types of ICMP messages.

Address-Based Mapping

Layer 3 and Layer 4 address mapping defines an application by the IP address and optional port range of
the traffic.

To ensure adequate security, use addressmappingwhen the configuration of your private network predicts
application traffic to or from trusted servers. Address mapping provides efficiency and accuracy in handling
traffic from a known application.

With Layer 3 and Layer 4 address-based custom applications, you canmatch the IP address and port range
to destination IP address and port. When IP address and port are configured, they must match the
destination tuples (IP address and port range) of the packet.

For example, consider a Session Initiation Protocol (SIP) server that initiates sessions from its known port
5060. Because all traffic from this IP address and port is generated by only the SIP application, the SIP
application can be mapped to an IP address of the server and port 5060 for application identification. In
this way, all traffic with this IP address and port is identified as SIP application traffic.
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IP Protocol-Based Mapping

Standard IP protocol numbers can map an application to IP traffic. As with address mapping, to ensure an
adequate security, use IP protocol mapping only in your private network for trusted servers.

Layer 7-Based Signatures

Layer 7 custom signatures define an application running over TCP or UDP or Layer 7 applications. Layer
7-based custom application signatures are required for the identification of multiple applications running
on the same Layer 7 protocols. For example, applications such as Facebook and YahooMessenger can run
over HTTP, but there is a need to identify them as two different applications running on the same Layer
7 protocol. The custom signature is cacheable for Layer 7 signatures only. You can createmultiple signatures
and each signature can contain multiple members up to maximum of 15 members.

Layer 7-based custom application signatures detect applications based on the patterns in HTTP contexts.
However, someHTTP sessions are encrypted in SSL, also called Transport Layer Security (TLS). Application
identification can extract the server name information or the server certification from the TLS or SSL
sessions. It can also detect patterns in TCP or UDP payload in Layer 7 applications.

Release History Table

DescriptionRelease

Starting in Junos Space Security Director 17.1, you can create the custom application
identification for all devices running Junos OS Release 15.1X49-D40 and later.

17.1

RELATED DOCUMENTATION

Creating Application Signatures | 559

Editing, Cloning, and Deleting Custom Application Signatures | 564

Creating Application Signatures

Application identification supports custom application signatures to detect applications as they pass through
the device. When you configure custom signatures, make sure that your signatures are unique. Use the
Create Application Signature page to create custom application signatures for applications based on ICMP,
IP protocol, IP address, and Layer 7.

Before you begin creating the custom application signatures:

• Make sure you have downloaded the application signature database package.

559



• The SRX Series device must be running Junos OS Release 15.1X49-D40 or later.

To create the custom application signatures:

1. Select Configure > Application Firewall Policy > Signatures.

The Application Signatures Page appears.

2. From the Create list, select Signature.

The Create Application Signature page appears.

3. Complete the configuration by using the guidelines in Table 189 on page 560.

4. Click OK to complete the configuration or Cancel to discard the configuration.

Table 189: Fields on the Create Application Signature Page

DescriptionField

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores. No spaces are allowed;
maximum length is 63 characters.

Name

Enter a description for the custom application signature; maximum length is 255 characters.Description

Specify the order for the custom application. Lower order has higher priority.

This option is used when multiple custom applications of the same type match the same traffic. However, you cannot
use this option to prioritize among different type of applications such as TCP stream-based applications against TCP
port-based applications or IP address-based applications against port-based applications.

Order

Select the priority from the list over other signature applications.Priority

ICMP Mapping

Specify the Internet Control Message Protocol (ICMP) value for an application to match. The ICMP mapping technique
maps standard ICMP message types and optional codes to a unique application name. This mapping technique lets you
differentiate between various types of ICMP messages.

Select the numerical value of an ICMP type. The type field identifies the ICMP message.

ICMP Type

Select the numerical value of an ICMP code. The code field provides further information about the associated type field.ICMP Code

IP Protocol Mapping

560



Table 189: Fields on the Create Application Signature Page (continued)

DescriptionField

Select the IP protocol value for an application tomatch. Standard IP protocol numbers canmap an application to IP traffic.
To ensure an adequate security similar to address mapping, use IP protocol mapping only in your private network for
trusted servers.

IP Protocol

Address Mapping

Use the Add Address Mapping page to create an address mapping that defines an application by the IP address and the
port range of the traffic.

Add
Address
Mapping

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores. No spaces are allowed;
maximum length is 63 characters.

Name

Enter an IPv4 or IPv6 address of the application for address mapping.IP Address

Enter an IPv4 or IPV6 address prefixes for a classless addressing.CIDR

Enter the TCP port range for the application. Example: 1-200.TCP Port
Range

Enter the UDP port range for the application. Example: 1-200.UDP Port
Range

L7 Signature

Set this option to TRUE to enable caching of application identification results. By enabling this option, you can cache the
application detection result in an ASC table. If there is an entry in the ASC table, based on the destination IP address,
protocol, and the port, you can identify AppID without sending the packet again to engine.

Cacheable

Select a protocol over which L7 signatures are added. The available options are:

• Over HTTP

• Over SSL

• Over TCP

• Over UDP

Add L7
Signature

Shows the type of protocol that you have selected to add the L7 signature.Over
Protocol

Enter the name of the custom application signature; maximum length is 63 characters.Signature
Name
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Table 189: Fields on the Create Application Signature Page (continued)

DescriptionField

Enter the port range for the selected protocol. Range is 1-65535.Port Range

Click the + sign to add members for a custom application signature. You can add maximum of 15 members.Add
Members

Member name for a custom application signature. Custom signatures can containmultiplemembers that define attributes
for an application. (The supported member name range is m01 through m15.)

Member
Name

Select the context for matching the application running over TCP, UDP, or Layer 7.

The available options are:

• http-get-url-parsed-param-parsed—The decoded and normalizedGETURL in anHTTP request alongwith the decoded
CGI parameters (if any).

• http-header-content-type—The content-type header in an HTTP transaction.

• http-header-cookie—The cookie header in an HTTP transaction.

• http-header-host—The host header in an HTTP transaction.

• http-header-user-agent—The user-agent header in an HTTP transaction.

• http-post-url-parsed-param-parsed—The decoded and normalized POST URL in an HTTP request along with the
decoded CGI parameters (if any).

• http-post-variable-parsed—The decoded POST URL or form data variables.

• http-url-parsed—The decoded and normalized URL in an HTTP request.

• http-url-parsed-param-parsed—The decoded and normalized URL in an HTTP request along with the decoded CGI
parameters (if any).

• ssl-server-name—Server name in the TLS server name extension or the SSL server certificate. This is also known as
Server Name Indication (SNI).

• stream—TCP or UDP stream data.

Context
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Table 189: Fields on the Create Application Signature Page (continued)

DescriptionField

Select the connection direction of the packets to match pattern from the list. Combinations other than those mentioned
in Table 190 on page 563 is not supported.

Table 190: Supported Context-Direction Combination

DirectionContext

client-to-serverhttp-get-url-parsed-param-parsed

client-to-serverhttp-header-host

client-to-serverhttp-header-user-agent

client-to-serverhttp-post-url-parsed-param-parsed

client-to-serverhttp-post-variable-parsed

client-to-serverhttp-url-parsed

client-to-serverhttp-url-parsed-param-parsed

any/client-to-server/server-to-clienthttp-header-content-type

any/client-to-server/server-to-clienthttp-header-cookie

client-to-serverssl-server-name

any/client-to-server/server-to-clientstream

Direction

(Optional) Enter the Deterministic Finite Automaton (DFA) pattern matched on the context. The DFA pattern specifies
the pattern to be matched for the signature. Maximum length is 128 characters.

Pattern
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Editing, Cloning, and Deleting Custom Application Signatures

IN THIS SECTION

Editing Custom Application Signatures | 564

Cloning Custom Application Signatures | 565

Deleting Custom Application Signatures | 565

You can edit, clone, and delete the custom application signatures from the Application Signatures page.
You clone a custom application signature to easily create a custom application signature. You delete the
unused custom application signatures.

Editing Custom Application Signatures

To edit a custom application signature:

1. Select Configure > Application Firewall Policy > Signatures.

The Application Signatures page appears.

2. Select the custom application signature that you want to edit, and click the pencil icon.

The Edit Application Signatures page appears, showing the same fields that are displayed when you
create a custom application signature.

3. Edit the application signatures fields as needed.

4. Click OK to save the changes.

The changes are saved and you are returned to the Application Signatures page.
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Cloning Custom Application Signatures

To clone a custom application signature:

1. Select Configure > Application Firewall Policy > Signatures.

The Application Signatures page appears.

2. Select the custom application signature that you want to clone, and click the Clone button or select
Clone from the More or right-click menu.

The Clone Application Signature page appears, showing the same fields that are displayed when you
create a custom application signature.

3. Modify the application signature fields as needed.

4. Click OK to save the changes.

The cloned custom application signature is created and you are returned to the Application Signatures
page.

Deleting Custom Application Signatures

To delete one or more custom application signatures:

1. Select Configure > Application Firewall Policy > Signatures.

The Application Signatures page appears.

2. Select the custom application signature that you want to delete, and click the X icon.

A warning dialog box appears asking you to confirm the deletion.

3. Click Yes to delete the selected custom application signatures.

The custom application signatures are deleted and you are returned to the Application Signature page.

RELATED DOCUMENTATION
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Creating Application Signature Groups

Juniper Networks regularly updates the predefined application signature database, making it available to
subscribers on the Juniper Networks website. This package includes signature definitions of known
application objects that can be used to identify applications for tracking, firewall policies, quality-of-service
prioritization, and Intrusion Prevention System (IPS).

Use the Application Signature page to view application signatures that are already downloaded and to
create custom application signature groups. The application signature page displays the name, object type,
category and subcategory, risk, and characteristics of the signature. You can create custom application
signature groups with a set of similar signatures for consistent reuse when defining policies.

NOTE: As of JunosOS Release 12.1x47 and later, the nested applications are called applications,
with the same details converted as the members of application signature. These application
signatures are called ngAppIDs. The Application Signature page shows only the ngAppID2.0
applications and application groups.

Before You Begin

• Make sure you have downloaded the application signature database package.

• Make sure that the latest updates have been applied.

• Review theApplication Signaturemain page for an understanding of your current data set. See “Application
Signatures Main Page Fields” on page 567 for field descriptions.

Application identification supports custom application signatures to detect applications as they pass through
the device.When you configure custom signature groups, make sure that your signature groups are unique.

To configure application signature groups:

1. Select Configure > Application Firewall Policy >Signatures.

2. Click the + icon.

3. Complete the configuration according to the guidelines provided in Table 191 on page 567.

4. Click OK to save.
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Table 191: Application Signature Group Settings

GuidelineSetting

Enter a unique name that is a string of alphanumeric characters, colons, periods, dashes,
and underscores. No spaces are allowed and maximum length is 63 characters.

Name

Click the + icon to add signatures to your application group. On the Add Application
Signatures page, select the check boxes next to the signatures you want to add to the
group.

Group Members

RELATED DOCUMENTATION

Creating Application Firewall Policies | 548

Creating Firewall Policies | 434

Application Signatures Main Page Fields

Use the application signatures main page to get an overall, high-level view of your application signature
settings. You can perform column wise filter and sort this information to get a better understanding of
what you want to configure.

Starting in Junos Space Security Director Release 18.4R1, when you click the filter icon, a drop-down list
is available for category and subcategory columns. You can select any value and the grid is reloaded with
the filtered category and subcategory.

Table 192 on page 567 describes the fields on this page.

Table 192: Application Signatures Main Page Fields

DescriptionField

Name of the application signature; maximum length is 63 characters.Name

Signature type, either application signature or application signature group.Object Type

UTM category of the application signature.Category

UTM subcategory of the application signature.Sub Category

Level of risk of the application signature.Risk

567



Table 192: Application Signatures Main Page Fields (continued)

DescriptionField

One or more characteristics of the application signature.Characteristic

Device compatibility version.Device Compatibility

A list of predefined application signatures and a list of custom application
signatures that you created.

Predefined/Custom

IP addresses associated with domain names.Domain

RELATED DOCUMENTATION
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CHAPTER 55

Application Firewall Policy-Redirect Profiles

IN THIS CHAPTER

About the Redirect Profiles Page | 569

Adding a Redirect Profile | 570

Cloning, Editing, and Deleting Redirect Profiles | 571

About the Redirect Profiles Page

To access this page, click Configure>Application Firewall Policy>Redirect Profiles.

You can create a redirect profile to provide a reason for the policy action or to redirect the user request
to an informative webpage. After you configure the redirect profiles for a policy, when a policy blocks
HTTP or HTTPS traffic with a deny or reject action, a message or redirect URL is sent to the user. You can
customize the redirect action by adding the text message or specify the URL towhich the user is redirected.
When the redirect message option is specified, a message notifies the user that the traffic has been blocked
and also the reason for blocking the traffic.

Tasks You Can Perform

You can perform the following tasks from this page:

• Add a redirect profile. See “Adding a Redirect Profile” on page 570.

• Edit, Clone, andDelete a redirect profile. See “Cloning, Editing, andDeleting Redirect Profiles” on page 571.

Field Descriptions

Table 193 on page 569 provides guidelines on using the fields on the Redirect Profile page.

Table 193: Fields on the Redirect Profile Page

DescriptionField
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Table 193: Fields on the Redirect Profile Page (continued)

DescriptionField

Name of the profile.Name

The message type, that is, Text or Redirect URL, which is displayed after a reject and
deny action.

Block Message Type

The custom text or the URL of the webpage to which the user is redirected.

If custom-text is specified, both the default block message and the custom-defined
block message are displayed. Custom text is inserted below the default message,
which includes username, Application Firewall has blocked your request to application
application name at dest-ip:dest-port accessed from src-ip:src-port.

Block Message/Redirect URL

The domain of the profile.Domain

The description of the profile.Description

RELATED DOCUMENTATION

Adding a Redirect Profile | 570

Adding a Redirect Profile

You can add a redirect profile and configure a custom block message or redirect URL.

To add a redirect profile:

1. Select Configure>Application Firewall Policy>Redirect Profiles.

The Redirect Profiles page is displayed.

2. Click the + icon.

The Add Redirect Profile page appears.

3. Configure according to the guidelines in Table 194 on page 571.

4. Click OK.

A profile is created and displayed on the redirect profiles page.
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Table 194: Add Redirect Profile

DescriptionField

Enter the name of the redirect profile.Name

Enter the description of the Redirect Profile.Description

Select the block message type:

• Text—If custom text is specified, both the default block message and the
custom-defined block message are displayed.

• Redirect URL—The URL of the webpage to which the client is redirected. The
URL must start with http or https. For example: http://www.juniper.net.

Block Message Type

Enter the block message or redirect URLBlock Message/Redirect URL

RELATED DOCUMENTATION
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Cloning, Editing, and Deleting Redirect Profiles

IN THIS SECTION

Cloning Redirect Profiles | 571

Editing Redirect Profile | 572

Deleting Redirect Profile | 572

Cloning Redirect Profiles

To clone a redirect profile:

1. Select Configure>Application Firewall Policy>Redirect Profiles.

The Redirect Profiles page is displayed.

2. Right-click a policy or click More and select Clone.
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The Clone Redirect Profile page is displayed.

3. Edit the details and click OK.

Editing Redirect Profile

To edit a redirect profile:

1. Select Configure>Application Firewall Policy>Redirect Profiles.

The Redirect Profiles page is displayed.

2. Right-click a policy and select Edit or click pencil icon.

The Edit Redirect Profile page is displayed.

3. Edit the details and click OK.

Deleting Redirect Profile

To delete a redirect profile:

1. Select Configure>Application Firewall Policy>Redirect Profiles.

The Redirect Profiles page is displayed.

2. Select a policy and click delete icon.

A warning message is displayed.

3. Click Yes to delete the selected redirect profile.

RELATED DOCUMENTATION
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CHAPTER 56

SSL Profiles

IN THIS CHAPTER
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SSL Reverse Proxy Overview | 586

Creating SSL Reverse Proxy Profiles | 588

SSL Forward Proxy Overview

Secure Sockets Layer (SSL) is an application-level protocol that provides encryption technology for the
Internet. SSL, also called Transport Layer Security (TLS), ensures the secure transmission of data between
a client and a server through a combination of privacy, authentication, confidentiality, and data integrity.
SSL relies on certificates and private-public key exchange pairs for this level of security.

Server authentication guards against fraudulent transmissions by enabling a Web browser to validate the
identity of aWeb server. Confidentiality mechanisms ensure that communications are private. SSL enforces
confidentiality by encrypting data to prevent unauthorized users from eavesdropping on electronic
communications. Finally, message integrity ensures that the contents of a communication have not been
tampered with.

SSL forward proxy is a transparent proxy; that is, it performs SSL encryption and decryption between the
client and the server, but neither the server nor the client can detect its presence. SSL forward proxy
ensures that it has the keys to encrypt and decrypt the payload:

• For the server, SSL forward proxy acts as a client—Because SSL forward proxy generates the shared
pre-primary key, it determines the keys to encrypt and decrypt.

• For the client, SSL forward proxy acts as a server—SSL forward proxy first authenticates the original
server and replaces the public key in the original server certificate with a key that is known to it. It then
generates a new certificate by replacing the original issuer of the certificate with its own identity and
signs this new certificate with its own public key (provided as a part of the proxy profile configuration).
When the client accepts such a certificate, it sends a shared pre-primary key encrypted with the public
key on the certificate. Because SSL forward proxy replaced the original key with its own key, it is able
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to receive the shared pre-primary key. Decryption and encryption take place in each direction (client
and server), and the keys are different for both encryption and decryption.

Figure 54 on page 574 depicts how SSL inspection (on an existing SRX Series IPS module) is typically used
to protect servers. SSL inspection requires access to private keys used by the servers so that the SRX
Series device can decrypt the encrypted traffic.

Figure 54: SSL Inspection on an Existing SRX Series Device

Figure 55 on page 575 shows how SSL forward proxy works on an encrypted payload. When application
firewall (AppFW), intrusion prevention system (IPS), or application tracking (AppTrack) is configured, SSL
forward proxy acts as an SSL server terminating the SSL session from the client and a new SSL session is
established to the server. The device decrypts and then re-encrypts all SSL forward proxy traffic. SSL
forward proxy uses the following services:

• SSL-T-SSL terminator on the client side.

• SSL-I-SSL initiator on the server side.

• Configured AppFW, IPS, or AppTrack services use the decrypted SSL sessions.
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NOTE: If none of the services (AppFW, IPS, or AppTrack) are configured, then SSL forward proxy
services are bypassed even if an SSL proxy profile is attached to a firewall policy. IPS does not
perform SSL inspection on a session if SSL forward proxy is enabled for that session. That is, if
both SSL inspection and SSL forward proxy are enabled on a session, SSL forward proxy always
takes precedence.

Figure 55: SSL Proxy on an Encrypted Payload

Supported Ciphers in Proxy Mode

AnSSL cipher comprises encryption ciphers, authenticationmethod, and compression. Table 195on page 576
displays a list of supported ciphers. NULL ciphers are excluded.

The following SSL protocols are supported:

• SSLv3

• TLS1
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Table 195: Supported Ciphers in Proxy Mode

Message IntegrityData Encryption
Key Exchange
AlgorithmSSL Cipher

Message Digest 5
(MD5) hash

128-bit RC4RSA key exchangeRSA_WITH_RC4_128_MD5

Secure Hash
Algorithm (SHA)
hash

128-bit RC4RSA key exchangeRSA_WITH_RC4_128_SHA

SHA hashDES CBCRSA key exchangeRSA_WITH_DES_CBC_SHA

SHA hash3DES EDE/CBCRSA key exchangeRSA_WITH_3DES_EDE_CBC_SHA

SHA hash128-bit AES/CBCRSA key exchangeRSA_WITH_AES_128_CBC_SHA

SHA hash256-bit AES/CBCRSA key exchangeRSA_WITH_AES_256_CBC_SHA

MD5 hash40-bit RC4RSA-exportRSA_EXPORT_WITH_RC4_40_MD5

SHA hash40-bit DES/CBCRSA-exportRSA_EXPORT_WITH_DES40_CBC_SHA

SHA hashDES/CBCRSA 1024 bit exportRSA_EXPORT1024_WITH_DES_CBC_SHA

MD5 hash56-bit RC4RSA 1024 bit exportRSA_EXPORT1024_WITH_RC4_56_MD5

SHA hash56-bit RC4RSA 1024 bit exportRSA_EXPORT1024_WITH_RC4_56_SHA

SHA384 hash256-bit AES/GCMRSA key exchangeRSA-WITH-AES-256-GCM-SHA384

SHA256 hash256-bit AES/CBCRSA key exchangeRSA-WITH-AES-256-CBC-SHA256

SHA256 hash128-bit AES/GCMRSA key exchangeRSA-WITH-AES-128-GCM-SHA256

SHA256 hash128-bit AES/CBCRSA key exchangeRSA-WITH-AES-128-CBC-SHA256

Server Authentication

Implicit trust between the client and the device (because the client accepts the certificate generated by
the device) is an important aspect of SSL proxy. It is extremely important that server authentication is not
compromised; however, in reality, self-signed certificates and certificates with anomalies are in abundance.
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Anomalies can include expired certificates, instances of common name not matching a domain name, and
so forth.

Server authentication is governed by selecting the Ignore Server Authentication option in the SSL forward
proxy profile.

If the Ignore Server Authentication option is not selected, the following scenarios occur:

• If authentication succeeds, a new certificate is generated by replacing the keys and changing the issuer
name to the issuer name that is configured in the root CA certificate in the proxy profile.

• If authentication fails, the connection is dropped.

If the Ignore Server Authentication option is defined as an action in the SSL forward proxy profile, the
following scenarios occur:

• If the certificate is self-signed, a new certificate is generated by replacing the keys only. The issuer name
is not changed. This ensures that the client browser displays a warning that the certificate is not valid.

• If the certificate has expired or if the common name does not match the domain name, a new certificate
is generated by replacing the keys and changing the issuer name to SSL-PROXY:
DUMMY_CERT:GENERATED DUE TO SRVR AUTH FAILURE. This ensures that the client browser
displays a warning that the certificate is not valid.

Trusted CA List

SSL forward proxy ensures secure transmission of data between a client and a server. Before establishing
a secure connection, SSL forward proxy checks certificate authority (CA) certificates to verify signatures
on server certificates. For this reason, a reasonable list of trusted CA certificates is required to effectively
authenticate servers.

Ignore Server Authentication

You can use the Ignore Server Authentication option to ignore server authentication completely. In this
case, SSL forward proxy ignores errors encountered during the server certificate verification process (such
as CA signature verification failure, self-signed certificates, and certificate expiry).

We do not recommend this option for authentication, because configuring it results in websites not being
authenticated at all. However, you can use this option to effectively identify the root cause for dropped
SSL sessions.

Root CA

In a public key infrastructure (PKI) hierarchy, the root CA is at the top of the trust path. The root CA
identifies the server certificate as a trusted certificate.
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Session Resumption

An SSL session refers to the set of parameters and encryption keys created by performing a full handshake.
A connection is the conversation or active data transfer that occurs within the session. The computational
overhead of a complete SSL handshake and generation of primary keys is considerable. In short-lived
sessions, the time taken for the SSL handshake can be more than the time for data transfer. To improve
throughput and still maintain an appropriate level of security, SSL session resumption provides a session
caching mechanism so that session information, such as the pre-primary secret key and agreed-upon
ciphers, can be cached for both the client and server. The cached information is identified by a session ID.
In subsequent connections both parties agree to use the session ID to retrieve the information rather than
create a new pre-primary secret key. Session resumption shortens the handshake process and accelerates
SSL transactions.

SSL Proxy Logs

When logging is enabled in an SSL proxy profile, SSL proxy can generate the messages shown in
Table 196 on page 578.

Table 196: SSL Proxy Logs

DescriptionLog Type

Logs generated when a session is dropped by SSL proxy.SSL_PROXY_SSL_SESSION_DROP

Logs generated when a session is processed by SSL proxy even
after encountering some minor errors.

SSL_PROXY_SSL_SESSION_ALLOW

Logs generated if non-SSL sessions are initially mistaken as SSL
sessions.

SSL_PROXY_SESSION_IGNORE

Logs generated when a session is allowlisted.SSL_PROXY_SESSION_ALLOWLIST

Logs used for reporting errors.SSL_PROXY_ERROR

Logs used for reporting warnings.SSL_PROXY_WARNING

Logs used for reporting general information.SSL_PROXY_INFO

All logs contain similar information; the message field contains the reason for the log generation. One of
three prefixes shown in Table 197 on page 579 identifies the source of the message. Other fields are
descriptively labeled.
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Table 197: SSL Proxy Log Prefixes

DescriptionPrefix

Logs generated due to errors related to the device or an action taken as part of the
SSL proxy profile. Most logs fall into this category.

system

Logs generated during the handshaking process if an error is detected by the openssl
library.

openssl error

Logs generated during the handshaking process if an error is detected in the certificate
(x509 related errors).

certificate error

Perfect Forward Secrecy

Perfect Forward Secrecy is a specific key agreement protocol that provides assurance that your session
keys are not compromised even if the private key of the server is compromised. By generating a unique
session key for every session a user initiates, even if a single session keys gets compromised does not
affect any data other than that exchanged in a specific session protected by that particular key.

The Elliptic Curve DHE (ECDHE) cipher suits are supported to enable the perfect forward secrecy on SSL
forward proxy. The SSL forward proxy still uses RSA for authentication. However, it uses ECDiffie-Hellman
ephemeral key exchange to agree on a shared secret.

ECDHE cipher suites are faster than the DHE counterparts and therefore, the SSL forward proxy supports
only ECDHE cipher suits. The ECDHE cipher suits are based on the elliptic curve cryptography which
allows you to achieve the same level of security than RSA with smaller keys. For example, a 224 bit elliptic
curve is as secure as a 2048 bit RSA key.

Table 198 on page 579 shows the supported ECDHE cipher suits.

Table 198: Supported ECDHE Cipher Suits

Message
IntegrityData Encryption

Key Exchange
AlgorithmSSL Cipher

SHA 384 hash256-bit AES/GCMECDHE RSAECDHE-RSA-WITH-AES-256-GCM-SHA384

SHA 384 hash256-bit AES/CBCECDHE RSAECDHE-RSA-WITH-AES-256-CBC-SHA384

SHA hash256-bit AES/CBCECDHE RSAECDHE-RSA-WITH-AES-256-CBC-SHA

SHA hash3DES AES/EDE/CBCECDHE RSAECDHE-RSA-WITH-AES-3DES-EDE-CBC-SHA

SHA 256 hash128-bit AES/GCMECDHE RSAECDHE-RSA-WITH-AES-128-GCM-SHA256
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Table 198: Supported ECDHE Cipher Suits (continued)

Message
IntegrityData Encryption

Key Exchange
AlgorithmSSL Cipher

SHA 256 hash128-bit AES/CBCECDHE RSAECDHE-RSA-WITH-AES-128-CBC-SHA256

SHA hash128-bit AES/CBCECDHE RSAECDHE-RSA-WITH-AES-128-CBC-SHA

RELATED DOCUMENTATION

Creating SSL Forward Proxy Profiles | 580

Creating Firewall Policies | 434

Creating SSL Forward Proxy Profiles

Use the SSL Forward Proxy Profile page to view andmanage SSL proxy profile details. SSL proxy is enabled
as an application service within a security policy. You specify the traffic that you want the SSL proxy
enabled on as match criteria and then specify the SSL proxy profile to be applied to the traffic.

NOTE: Starting in Junos Space Security Director Release 21.2, SSL Forward Proxy is supported
for Logical Systems (LSYS) devices also.

Before You Begin

• Read the SSL Forward Proxy Overview topic.

• Review the SSL Forward Proxy Profile main page for an understanding of your current data set. See “SSL
Forward Proxy Profile Main Page Fields” on page 585 for field descriptions.

To create an SSL forward proxy profile:

1. Select Configure > SSL Profiles> SSL Proxy Profiles.

The SSL Proxy Profiles page appears.

2. Select Forward Proxy from the Create list.
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3. Complete the configuration according to the guidelines provided in Table 199 on page 581.

4. Click OK.

An SSL forward proxy profile is created that can be assigned to a firewall policy for advanced security
options.

NOTE: If none of the services (AppFW, IDP, or AppTrack) are configured, then SSL proxy services
are bypassed even if an SSL proxy profile is attached to a firewall policy.

Table 199: SSL Forward Proxy Profile Settings

GuidelineSetting

General Information

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores. No
spaces are allowed; maximum length is 63 characters.

Name

Enter a description for the SSL forward proxy profile; maximum length is 1024 characters.Description

Select a preferred cipher. Ciphers are divided into the following categories depending on their key
strength.

• Custom—Configure custom cipher suite and order of preference.

• Medium—Use ciphers with key strength of 128 bits or greater.

• Strong—Use ciphers with key strength of 168 bits or greater.

• Weak—Use ciphers with key strength of 40 bits or greater.

PreferredCipher
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Table 199: SSL Forward Proxy Profile Settings (continued)

GuidelineSetting

Select the set of ciphers the SSH server can use to perform encryption and decryption functions.
If this option is not configured, the server accepts any supported suite that is available.

The available custom ciphers are:

• rsa-with-RC4-128-md5—RSA, 128- bit RC4, MD5 hash

• rsa-with-RC4-128-sha—RSA, 128-bit RC4, SHA hash

• rsa-with-des-cbc-sha—RSA, DES/CBC, SHA hash

• rsa-with-3DES-ede-cbc-sha—RSA, 3DES EDE/CBC, SHA hash

• rsa-with-aes-128-cbc-sha—RSA, 128-bit AES/CBC, SHA hash

• rsa-with-aes-256-cbc-sha—RSA, 256 bit AES/CBC, SHA hash

• rsa-export-with-rc4-40-md5—RSA-export, 40 bit RC4, MD5 hash

• rsa-export-with-des40-cbc-sha—RSA-export, 40 bit DES/CBC, SHA hash

• rsa-export1024-with-des-cbc-sha—RSA 1024 bit export, DES/CBC, SHA hash

• rsa-export1024-with-rc4-56-md5—RSA 1024 bit export, 56 bit RC4, MD5 hash

• rsa-export1024-with-rc4-56-sha—RSA 1024 bit export, 56 bit RC4, SHA hash

• rsa-with-aes-256-gcm-sha384—RSA, 256 bit AES/GCM, SHA384 hash

• rsa-with-aes-256-cbc-sha256—RSA, 256 bit AES/CBC, SHA256 hash

• rsa-with-aes-128-gcm-sha256—RSA, 128 bit AES/GCM, SHA256 hash

• rsa-with-aes-128-cbc-sha256—RSA, 256 bit AES/CBC, SHA256 hash

• ecdhe-rsa-with-aes-256-gcm-sha384—ECDHE, RSA, 256 bit AES/GCM, SHA384 hash

• ecdhe-rsa-with-aes-256-cbc-sha384—ECDHE, RSA, 256 bit AES/CBC, SHA384 hash

• ecdhe-rsa-with-aes-256-cbc-sha—ECDHE, RSA, 256 bit AES/CBC, SHA hash

• ecdhe-rsa-with-aes-3des-ede-cbc-sha—ECDHE, RSA, 3DES, EDE/CBC, SHA hash

• ecdhe-rsa-with-aes-128-gcm-sha256—ECDHE, RSA, 128 bit AES/GCM, SHA256 hash

• ecdhe-rsa-with-aes-128-cbc-sha256—ECDHE, RSA, 128 bit AES/CBC, SHA256 hash

• ecdhe-rsa-with-aes-128-cbc-sha—ECDHE, RSA, 128 bit AES/CBC, SHA hash

Custom Ciphers

Select this option to enable flow trace for troubleshooting policy-related issues.Flow Trace
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Table 199: SSL Forward Proxy Profile Settings (continued)

GuidelineSetting

Select or add a root certificate. In a public key infrastructure (PKI) hierarchy, the root CA is at the
top of the trust path. The root CA identifies the server certificate as a trusted certificate.

Click Add for a new root certificate. On the Add page, select a device and the trusted CAs to
associate to the root certificate.

NOTE: To view the SSL certificates in Security Director, selectDevices>Security Devices, choose
the relevant device, right-click the device or select Refresh Certificate from the More menu. Once
the refresh certificate job is completed, you can see SSL certificates.

Make sure the device configuration is in sync with Security Director. If the device configuration is
out of sync in security devices, resynchronize network and then proceed with refresh certificates.

Root Certificate

Select addresses to create allowlists that bypass SSL forward proxy processing.

Because SSL encryption and decryption are complicated and expensive procedures, network
administrators can selectively bypass SSL proxy processing for some sessions. Such sessions mostly
include connections and transactions with trusted servers or domains with which network
administrators are very familiar. There are also legal requirements to exempt financial and banking
sites. Such exemptions are achieved by configuring the IP addresses or domain names of the servers
under allowlists.

Exempted
Address

Starting in Junos Space Security Director Release 16.2, you can select URL categories to create
allowlists that bypass SSL forward proxy processing.

These URL categories are exempted during SSL inspection. Only the predefined URL categories
can be selected for the exemption.

NOTE: Ensure to filter with Enhancedwhen you select exempted URL categories in the SSL profile.

Exempted URL
Categories

Actions

Select this option to ignore server authentication completely.

In this case, SSL forward proxy ignores errors encountered during the server certificate verification
process (such as CA signature verification failure, self-signed certificates, and certificate expiry).

We do not recommend this option for authentication, because configuring it results in websites
not being authenticated at all. However, you can use this option to effectively identify the root
cause for dropped SSL sessions.

Server
Authentication
Failure
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Table 199: SSL Forward Proxy Profile Settings (continued)

GuidelineSetting

Select the Disable Session Resumption option if you do not want session resumption.

To improve throughput and still maintain an appropriate level of security, SSL session resumption
provides a session caching mechanism so that session information, such as the pre-primary secret
key and agreed-upon ciphers, can be cached for both the client and server.

Session
Resumption

Select this option to generate logs. You can choose to log all events, warnings, general information,
errors, or different sessions (allowlisted, allowed, dropped, or ignored).

Log

After a session is created and SSL tunnel transport has been established, a change in SSL parameters
requires renegotiation. SSL forward proxy supports both secure (RFC 5746) and nonsecure (TLS
v1.0 and SSL v3) renegotiation.

Select one of the following options if a change in SSL parameters requires renegotiation:

• None (selected by default)

• Allow

• Allow-secure

• Drop

When session resumption is enabled, session renegotiation is useful in the following situations:

• Cipher keys need to be refreshed after a prolonged SSL session.

• Stronger ciphers need to be applied for a more secure connection.

Renegotiation

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.2, you can select URL categories to
create allowlists that bypass SSL forward proxy processing.

16.2

RELATED DOCUMENTATION
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SSL Forward Proxy Profile Main Page Fields

Use the SSL Forward Proxy Profile page to view andmanage SSL proxy profile details. SSL proxy is enabled
as an application service within a security policy. You specify the traffic that you want the SSL proxy
enabled on as match criteria and then specify the SSL proxy profile to be applied to the traffic. You can
filter and sort this information to get a better understanding ofwhat youwant to view. Table 200 on page 585
describes the fields on this page.

Table 200: SSL Forward Proxy Profile Main Page Fields

DescriptionField

Unique string of alphanumeric characters, colons, periods, dashes, and underscores; no
spaces allowed; 63-character maximum.

Name

Ciphers are divided into three categories depending on their key strength. Strong ciphers
are 168 bits or greater; medium ciphers are 128 bits or greater; and weak ciphers are
40 bits or greater. The default is custom, which allows you to configure your own cipher
suite.

Preferred Cipher

Ciphers selected from each of the categories (Strong, Medium, Weak) to form a custom
cipher suite.

Custom Ciphers

Addresses that are selected to bypass SSL forward proxy processing. This allows you to
create allowlists and avoid the expense and complication of SSL encryption.

Exempted Address

This option ignores errors encountered during the server certificate verification process
(such as CA signature verification failure, self-signed certificates, and certificate expiry).

Server Authentication
Failure

This option enables or disables depending on whether you want session resumption
(session caching mechanism).

Session Resumption

Domain name to which the SSL forward proxy profile is associated. The IP addresses
associated with domain names are dynamic and can change at any time.

Domain

Description for the SSL proxy profile; maximum length is 1024 characters.Description

RELATED DOCUMENTATION
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SSL Reverse Proxy Overview

A reverse proxy is a common type of proxy server, which is accessible from the public network. Reverse
proxies are managed by the web service, and they are accessed by clients from the public internet.

You can configure the SSL reverse proxy to protect your SSL-enabled web servers against client-to-server
attacks from malicious clients. This functions by loading the SSL private key of the webserver onto the
SRX Series device to protect your web servers against threats from clients that you do not control. For
example, if an external user on the internet is trying to access a corporate web server, they initiate the
HTTPS connection to the web server. The SSL reverse proxy profile has the private key details and it
intercepts the traffic and sends the decrypted payload info to other L7 services enabled in the security
policy, for example, IDP for attack detection.

Like forward proxy, reverse proxy requires a profile to be configured at the firewall rule level. In addition,
you must also configure server certificates with private keys for reverse proxy. During an SSL handshake,
the SSL proxy performs a lookup for a matching server private key in its server private key hash table
database. If the lookup is successful, the handshake continues. Otherwise, SSL proxy terminates the hand
shake. Reverse proxy does not intercept server certificates. It forwards the actual server certificate/chain
as is to the client without modifying it. Intercepting the server certificate occurs only with forward proxy.

Figure 56 on page 587 shows how SSL reverse proxy works on an encrypted payload. When application
firewall (AppFW), intrusion prevention system (IPS), or application tracking (AppTrack) is configured, SSL
reverse proxy acts as an SSL server terminating the SSL session from the client and a new SSL session is
established to the server. The device decrypts and then re-encrypts all SSL reverse proxy traffic. SSL
reverse proxy uses the following services:

• SSL-T-SSL terminator on the client side

• SSL-I-SSL initiator on the server side

• Configured AppFW, IPS, or AppTrack services use the decrypted SSL sessions
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Figure 56: SSL Reverse Proxy on an Encrypted Payload
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Benefits of Reverse Proxy

• A Reverse proxy can hide the existence and characteristics of origin servers.

• A reverse proxy can distribute the load from incoming requests to several servers, with each server
supporting its own application area.

RELATED DOCUMENTATION
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Creating SSL Reverse Proxy Profiles

Use the SSL Reverse Proxy Profiles page to configure the SSL reverse proxy to protect your SSL-enabled
web servers against client-to-server attacks frommalicious clients. This functions by loading the SSL private
key onto the SRX Series device to protect your clients against threats from web servers that you do not
control. For example, if an external user on the internet is trying to access a corporate web server, they
initiate the HTTPS connection to the web server. The IPS policy which has the private key of the web
server intercepts the traffic, inspects it for attacks, and if no attacks are present, it forwards it onto the
destination web server.

NOTE: Starting in Junos Space Security Director Release 21.2, SSL Reverse Proxy is supported
for Logical Systems (LSYS) devices also.

To create an SSL reverse proxy profile:

1. Select Configure > SSL Profiles> SSL Proxy Profiles.

The SSL Proxy Profiles page appears.

2. Select Reverse Proxy from the Create list.

3. Complete the configuration according to the guidelines provide in Table 201 on page 588.

4. Click OK.

An SSL reverse proxy profile is created that can be assigned to a firewall policy for advanced security
options.

Table 201: Fields on the Create SSL Reverse Proxy Profile Page

DescriptionField

General Information

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores. No
spaces are allowed; maximum length is 63 characters.

Name

Enter a description for the SSL forward proxy profile; maximum length is 1024 characters.Description
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Table 201: Fields on the Create SSL Reverse Proxy Profile Page (continued)

DescriptionField

Select a preferred cipher. Ciphers are divided into the following categories depending on their key
strength.

• Custom—Configure custom cipher suite and order of preference.

• Medium—Use ciphers with key strength of 128 bits or greater.

• Strong—Use ciphers with key strength of 168 bits or greater.

• Weak—Use ciphers with key strength of 40 bits or greater.

Preferred
Cipher

Select the set of ciphers the SSH server can use to perform encryption and decryption functions.
If this option is not configured, the server accepts any supported suite that is available.

The available custom ciphers are:

• rsa-with-RC4-128-md5—RSA, 128- bit RC4, MD5 hash

• rsa-with-RC4-128-sha—RSA, 128-bit RC4, SHA hash

• rsa-with-des-cbc-sha—RSA, DES/CBC, SHA hash

• rsa-with-3DES-ede-cbc-sha—RSA, 3DES EDE/CBC, SHA hash

• rsa-with-aes-128-cbc-sha—RSA, 128-bit AES/CBC, SHA hash

• rsa-with-aes-256-cbc-sha—RSA, 256 bit AES/CBC, SHA hash

• rsa-export-with-rc4-40-md5—RSA-export, 40 bit RC4, MD5 hash

• rsa-export-with-des40-cbc-sha—RSA-export, 40 bit DES/CBC, SHA hash

• rsa-export1024-with-des-cbc-sha—RSA 1024 bit export, DES/CBC, SHA hash

• rsa-export1024-with-rc4-56-md5—RSA 1024 bit export, 56 bit RC4, MD5 hash

• rsa-export1024-with-rc4-56-sha—RSA 1024 bit export, 56 bit RC4, SHA hash

• rsa-with-aes-256-gcm-sha384—RSA, 256 bit AES/GCM, SHA384 hash

• rsa-with-aes-256-cbc-sha256—RSA, 256 bit AES/CBC, SHA256 hash

• rsa-with-aes-128-gcm-sha256—RSA, 128 bit AES/GCM, SHA256 hash

• rsa-with-aes-128-cbc-sha256—RSA, 256 bit AES/CBC, SHA256 hash

• ecdhe-rsa-with-aes-256-gcm-sha384—ECDHE, RSA, 256 bit AES/GCM, SHA384 hash

• ecdhe-rsa-with-aes-256-cbc-sha384—ECDHE, RSA, 256 bit AES/CBC, SHA384 hash

• ecdhe-rsa-with-aes-256-cbc-sha—ECDHE, RSA, 256 bit AES/CBC, SHA hash

• ecdhe-rsa-with-aes-3des-ede-cbc-sha—ECDHE, RSA, 3DES, EDE/CBC, SHA hash

• ecdhe-rsa-with-aes-128-gcm-sha256—ECDHE, RSA, 128 bit AES/GCM, SHA256 hash

• ecdhe-rsa-with-aes-128-cbc-sha256—ECDHE, RSA, 128 bit AES/CBC, SHA256 hash

• ecdhe-rsa-with-aes-128-cbc-sha—ECDHE, RSA, 128 bit AES/CBC, SHA hash

Custom Ciphers

Select this option to enable flow trace for troubleshooting policy-related issues.Flow Trace
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Table 201: Fields on the Create SSL Reverse Proxy Profile Page (continued)

DescriptionField

Specify the server certificate identifier.

Select the required SRX Series device from the list and assign the server certificate identifier.

NOTE: To view the SSL certificates in Security Director, selectDevices>Security Devices, choose
the relevant device, right-click the device or select Refresh Certificate from the More menu. Once
the refresh certificate job is completed, you can see SSL certificates.

Make sure the device configuration is in sync with Security Director. If the device configuration is
out of sync in security devices, resynchronize network and then proceed with refresh certificates.

Server
Certificate

Select addresses to create allowlists that bypass SSL forward proxy processing.

Because SSL encryption and decryption are complicated and expensive procedures, network
administrators can selectively bypass SSL proxy processing for some sessions. Such sessions mostly
include connections and transactions with trusted servers or domains with which network
administrators are very familiar. There are also legal requirements to exempt financial and banking
sites. Such exemptions are achieved by configuring the IP addresses or domain names of the servers
under allowlists.

Exempted
Address

Starting in Junos Space Security Director Release 16.2, you can select URL categories to create
allowlists that bypass SSL forward proxy processing.

These URL categories are exempted during SSL inspection. Only the predefined URL categories
can be selected for the exemption.

Exempted URL
Categories

Actions

Select the Disable Session Resumption option if you do not want session resumption.

To improve throughput and still maintain an appropriate level of security, SSL session resumption
provides a session caching mechanism so that session information, such as the pre-primary secret
key and agreed-upon ciphers, can be cached for both the client and server.

Session
Resumption

Select this option to generate logs. You can choose to log all events, warnings, general information,
errors, or different sessions (allowlisted, allowed, dropped, or ignored).

Log
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Table 201: Fields on the Create SSL Reverse Proxy Profile Page (continued)

DescriptionField

After a session is created and SSL tunnel transport has been established, a change in SSL parameters
requires renegotiation. SSL forward proxy supports both secure (RFC 5746) and nonsecure (TLS
v1.0 and SSL v3) renegotiation.

Select one of the following options if a change in SSL parameters requires renegotiation:

• None (selected by default)

• Allow

• Allow-secure

• Drop

When session resumption is enabled, session renegotiation is useful in the following situations:

• Cipher keys need to be refreshed after a prolonged SSL session.

• Stronger ciphers need to be applied for a more secure connection.

Renegotiation

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.2, you can select URL categories to
create allowlists that bypass SSL forward proxy processing.

16.2
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About the Active Directory Profile Page
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To access this page, click Configure > User Firewall Management > Active Directory.

Starting in Junos Space Security Director Release 16.1, you can use the Active Directory Profile page to
configure the Active Directory profile as an authentication server.

Tasks You can Perform

You can perform the following tasks from this page:

• Create an Active Directory profile. See “Creating Active Directory Profiles” on page 594.

• Modify or delete an existing Active Directory profile. See “Editing and Deleting Active Directory Profiles”
on page 599.

• Deploy the Active Directory profile to SRX Series devices. See “Deploying the Active Directory Profile
to SRX Series Devices” on page 598.
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Field Descriptions

Table 202 on page 593 provides guidelines on using the fields on the Active Directory page.

Table 202: Fields on the Active Directory Profile Page

DescriptionField

Specifies the name of the Active Directory.Name

Describes the Active Directory.Description

Specifies the domain for which the status is displayed.

Example: Global

Domain

Lists the assigned devices for a directory.

Example: SRX

Devices

Specifies the domains of the Active Directory.

Example: domain.net

Active Directory Domains

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.1, you can use the Active Directory
Profile page to configure the Active Directory profile as an authentication server.

16.1
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Creating Active Directory Profiles

Use the Create Active Directory Profile page to configure the IP address-to-user mapping information and
the user-to-group mapping information to access the LDAP server.

To create an Active Directory profile:

1. Select Configure > User Firewall Management > Active Directory.

The Active Directory Profile page appears.

2. Click the + icon.

3. Complete the configuration by using the guidelines in Table 203 on page 594.

4. Click Finish.

A Summary page providing a preview of the complete configuration appears.

5. Click OK to complete the configuration or Back to make any modifications.

Table 203: Fields on the Create Active Directory Profile Page

DescriptionField

General Information

Enter a unique string of alphanumeric characters, colons,
periods, dashes, and underscores.Maximum length is 255
characters.

Name

Enter a description for the Active Directory profile;
maximum length is 255 characters.

Description

Enable the manual on-demand probing of a domain PC as
an alternate method for the SRX Series device to retrieve
address-to-user mapping information.

By default, themanual on-demand probing is not enabled.

On Demand Probe

Timeout
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Table 203: Fields on the Create Active Directory Profile Page (continued)

DescriptionField

Set the timeout to 0 to avoid having the user's entry being
removed from the authentication table after the timeout.

Note that when a user is no longer active, a timer is started
for that user’s entry in the Active Directory authentication
table. When the time is up, the user’s entry is removed
from the table. Entries in the table remain active as long
as there are sessions associated with the entry.

The default authentication entry timeout is thirty minutes.
To disable timeout, set the interval to zero. The range is
10 through 1440 minutes.

Authentication Entry Timeout

Configure the number of seconds that the domain PC has
to respond to the SRX Series device’s query through
Windows Management Instrumentation (WMI) or
Distributed Component Object Module (DCOM).

If no response is received from the domain PC within the
wmi-timeoutinterval, the probe fails and the system either
creates an invalid authentication entry or updates the
existing authentication entry as invalid. If an authentication
table entry already exists for the probed IP address, and
no response is received from the domain PC within the
wmi-timeout interval, the probe fails and that entry is
deleted from the table.

The range is 3 through 120 seconds.

WMI Timeout

Filter

Set the range of IP addresses that must be monitored or
not monitored.

• Include—Specify to include IP addresses from the
Available column.

• Exclude—Specify to exclude IP addresses from the
Available column.

Click Add New Address to create a new IP address and
add it as either include or exclude from monitoring.

Filter

Add Domain Settings
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Table 203: Fields on the Create Active Directory Profile Page (continued)

DescriptionField

Enter the name of the domain; the length of the name
ranges from 1 through 64 characters. The SRX Series
device can have the integrated user firewall configured in
a maximum of two domains.

Example: example.net

Domain Name

Enter a description for the LDAP server domain; maximum
length is 255 characters.

Description

Enter the Active Directory account name. The range is 1
through 64 characters.

Example: administrator

Username

Enter the password of the Active Directory account. The
range is 1 through 128 characters.

Example: $ABC123

Password

Click the plus(+) sign to create new domain controllers.

• Domain Controller Name— Name can range from 1
through 64 characters. A maximum of 10 domain
controllers can be configured.

• IP Address—IP address of the domain controller.

Domain Controller(s)

User Group Mapping(LDAP)

Specify the IP address of the LDAP server. If no address
is specified, the system uses one of the configured Active
Directory domain controllers.

Example: 192.0.2.15

IP Address

Specify the port number of the LDAP server. If no port
number is specified, the system uses port 389 for plaintext
or port 636 for encrypted text.

Port

Enter the LDAP base distinguished name (DN).

Example: DC=example,DC=net

Base DN
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Table 203: Fields on the Create Active Directory Profile Page (continued)

DescriptionField

Enter the username of the LDAP account. If no username
is specified, the system will use the configured domain
controller’s username.

Example: administrator

Username

Enter the password for the account. If no password is
specified, the system uses the configured domain
controller’s password.

Example: xxxxx

Password

Enable Secure Sockets Layer (SSL) to ensure secure
transmission with the LDAP server. Disabled by default,
then the password is sent in plaintext.

Use SSL

Specify the algorithm used while the SRX Series device
communicates with the LDAP server. By default simple is
selected to configure simple(plaintext) authentication
mode.

Authentication Algorithm

IP-User Mapping

Enable the method of discovering IP address-to-user
mappings.

• WMI—Windows Management Instrumentation (WMI)
is the discovery method used to access the domain
controller.

Discovery Method

Enter the scanning interval at which the SRX Series device
scans the event log on the domain controller. The range
is 5 through 60 seconds.

Event Log Scanning Interval

Enter the time of the earliest event log on the domain
controller that the SRX Series device will initially scan.
This scan applies to the initial deployment only. After
WMIC and the user identification start working, the SRX
Series device scans only the latest event log.

The range is 1 through 168 hours.

Initial Event Log TimeSpan

Assign Device
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Table 203: Fields on the Create Active Directory Profile Page (continued)

DescriptionField

Select these devices from the Available column andmove
them to the Selected column.

You can also search for the devices in the search field in
both the Available and Selected columns. You can search
these devices by entering the device name, device IP
address, or device tag.

Device
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Deploying the Active Directory Profile to SRX Series Devices

To deploy the active directory profile to SRX Series devices:

1. Select Configure > User Firewall Management > Active Directory.

The Active Directory Profile page appears.

2. Select the active directory profile that you want to deploy, and click Update.

The Update Active Directory Profile page appears. See Table 204 on page 599 to view more details.

3. Select the required SRX Series device to deploy the active directory profile, and click Update.

A new job is created.

4. Click the job ID to see the update status.

The Job Management page appears showing the state of the updated job. You can also view the
deployed active directory profile information under the Parameters column.
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Table 204: Update Active Directory Profile Page Fields

DescriptionColumn Name

Name of the SRX Series device.Device Name

The active directory profile configuration can be viewed in either CLI or XML by
clicking View.

Configuration

Configuration status of the device. The different configuration states for a device
are as follows:

• Synchronizing—During the device update, the status is shown as Synchronizing.

• Sync Failed—The synchronization operation failed.

• In Sync—The synchronization operation completed successfully; SecurityDirector
and the device are synchronized.

Configuration Status

Connection status of the device. The status shows either UP or Down.Connection Status

Domain of the user.Domain

IP address of the device.Device IP

Platform of the device. For example, SRX Series, vSRX.Platform

Junos OS version running on the device.OS Version
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Editing and Deleting Active Directory Profiles

IN THIS SECTION
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You can edit and delete Active Directory profiles. This topic contains the following sections:

Editing Active Directory Profiles

To edit an Active Directory profile:

1. Select Configure > User Firewall Management > Active Directory.

The Active Directory Profile page appears listing the existing Active Directory profiles.

2. Select the Active Directory profile that you want to edit, right-click and select Edit Active Directory
Profile, or click the pencil icon.

The Edit Active Directory Profile page appears, showing the same options as when creating a new
Active Directory profile.

3. Click Finish after completing editing.

Deleting Active Directory Profiles

To delete an Active Directory profile from all devices:

1. Select Configure > User Firewall Management > Active Directory.

The Active Directory Profile page appears listing the existing Active Directory profiles.

2. Select the active directory profile that youwant to delete, right-click and selectDelete ActiveDirectory
Profile, or click the delete icon.

This deletes the selected active directory profile from all the SRX Series devices. An alert message
appears verifying that you want to delete your selection.

3. Click Yes to delete your selection.

You can unassign a device and delete the Active Directory profile from it.

To unassign a device:

1. Select Configure > User Firewall Management > Active Directory.

The Active Directory Profile page appears listing the existing access profiles.

2. Select the active directory profile that you want to edit, right-click and select Edit Active Directory
Profile, or click the pencil icon.
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The Edit Active Directory Profile page appears, showing the same options as when creating a new
access profile.

3. Go to the Assign Device section.

4. Move the required device(s) listed under the Selected column to the Available column.

5. Click Finish.

The active directory profile configuration is deleted from the selected device(s).

RELATED DOCUMENTATION
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CHAPTER 58

User Firewall Management-Access Profile
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Access Profile Overview

Access profiles enable access configuration on the network—this consists of authentication configuration
and accounting configuration. Security Director supports Remote Authentication Dial In User Service
(RADIUS), Lightweight Directory Access Protocol (LDAP), and local authentication service as authentication
methods. Authentication prevents unauthorized devices and users from gaining access to your network.
Accounting servers collect and send information used for billing, auditing, and reporting.

SRX Series devices use the LDAP service to get user and group information necessary to implement the
integrated user firewall feature. The SRX Series device acts as an LDAP client communicating with an
LDAP server. In a common implementation scenario, the domain controller acts as the LDAP server. The
LDAP module in the SRX Series device, by default, queries the Active Directory in the domain controller.

The SRX Series device downloads user and group lists from the LDAP server. The device also queries the
LDAP server for user and group updates. The SRX Series device downloads a first-level, user-to-group
mapping relationship and then calculates a full user-to-group mapping.

By default, the LDAP authenticationmethod uses simple authentication. The client’s username and password
are sent to the LDAP server in plaintext. Keep in mind that the password is clear and can be read from the
network.

To avoid exposing the password, you can use simple authentication within an encrypted channel, namely
Secure Sockets layer (SSL), as long as the LDAP server supports LDAP over SSL. After enabling SSL, the
data sent from the LDAP server to the SRX Series device is encrypted.
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The LDAP server’s username, password, IP address, and port are all optional, but they can be configured.

• If the username and password are not configured, the system uses the configured domain controller’s
username and password.

• If the LDAP server’s IP address is not configured, the system uses the address of one of the configured
Active Directory domain controllers.

• If the port is not configured, the system uses port 389 for plaintext or port 636 for encrypted text.

RADIUS is a networking protocol that provides centralized authentication, authorization, and accounting
(AAA) management for computers to connect and use a network service. By default, RADIUS servers are
used for both accounting and authentication. From Security Director, you can create and manage RADIUS
profiles that configure RADIUS server settings.

With local authentication, you can configure a password for each user allowed to log in to the controller
or switch.
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About the Access Profile Page

IN THIS SECTION

Tasks You Can Perform | 604

Field Descriptions | 604

To access this page, click Configure > User Firewall Management > Access Profile.

You can use the Access Profile page to configure the Lightweight Directory Access Protocol (LDAP) for
SRX Series devices that use the integrated user firewall feature. The SRX Series device acts as an LDAP
client communicating with an LDAP server.
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Starting in Junos Space Security Director Release 20.3, RADIUS server and Local Authentication service
are also supported.

Tasks You Can Perform

You can perform the following tasks from this page:

• Create an access profile. See “Creating Access Profiles” on page 605.

• Modify or delete an existing access profile. See “Editing and Deleting Access Profiles” on page 612.

• Deploy the access profile to SRX Series devices. See “Deploying the Access Profile to SRX Series Devices”
on page 610.

Field Descriptions

Table 205 on page 604 provides guidelines on using the fields on the Access Profile page.

Table 205: Access Profile Main Page Fields

DescriptionField

Name of the access profile.Name

Shows the order in which Junos OS tries different authentication methods
when verifying that a client can access the devices.

Authentication Order

Shows the next authentication method if the authentication method included
in the authentication order option is not available, or if the authentication is
available but returns a reject response.

Authentication Order 2

Describes the access profile.Description

Specifies the IP address of the local users.Local Users

Specifies the IP address of the RADIUS authentication server.RADIUS Server (Address)

Specifies the IP address of the LDAP authentication server.LDAP Server (Address)

Specifies the domain for which the status is displayed.Domain

Lists the assigned devices for a profile.Devices

Shows the series of basic properties that define the user. For example, in the
base distinguished name o=juniper, c=us, where o for organization, and c stands
for country.

LDAP Options (Base Distinguished
Name)
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Creating Access Profiles

Use the Access Profile page to configure LDAP server, RADIUS server, and local authentication service.

To create access profile:

1. Select Configure > User Firewall Management > Access Profile.

The Access Profile page is displayed.

2. Click the + icon.

The Create Access Profile page is displayed.

3. Complete the configuration by using the guidelines in Table 206 on page 605.

4. Click Finish.

A Summary page providing a preview of the complete configuration is shown.

5. Click OK to complete the configuration or Back to make any modifications.

Table 206: Access Profile Configuration Parameters

DescriptionField

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores.Maximum
length is 255 characters.

Access Profile
Name

Enter a description for the access profile; maximum length is 255 characters.Description

Select the device type as either Root or Tenant Systems (TSYS).Device Type

Assign Device
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Table 206: Access Profile Configuration Parameters (continued)

DescriptionField

Select these devices from the Available column and move them to the Selected column.

You can also search for the devices in the search field in both the Available and Selected columns.
You can search these devices by entering the device name, device IP address, or device tag.

Device

Authentication
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Table 206: Access Profile Configuration Parameters (continued)

DescriptionField

Select Local to configure local authentication services.

Select an address pool for allocation to users.

An address pool is a set of Internet Protocol (IP) addresses available for allocation to users, such as
in host configurations with the DHCP. An address-assignment pool supports IPv4 address. You can
create centralized IPv4 address pools independent of the client applications that use the pools.

To create an address pool:

1. Click Create Address Pool.

The Create Address Pool page is displayed.

2. Enter the following details:

• Pool Name—Enter the name of the address pool.

• Network Address—Enter the network address used by the address pool.

• Primary DNS Server-Enter the primary DNS IP address.

• Secondary DNS Server—Enter the secondary DNS IP address.

• Primary WINS Server—Enter the primary Windows IP address.

• Secondary WINS Server—Enter the secondary Windows IP address.

Click the + icon to configure a named range of IPv4 addresses, usedwithin an address-assignment
pool. Enter the lower and upper limit of an address range.

To create a new local authentication user:

1. Click +.

The Create Local Authentication User page appears.

2. Enter the following details:

• User Name—Enter the user name of the user requesting access.

• Password—Enter the user password.

• XAUTH IP Address—Enter the IPv4 address for the client.

• Group—Enter the group name to store several user accounts together.

3. Click OK to save changes.

To edit, select the local authentication user configuration and click the pencil icon.

To delete, select the local authentication user configuration and click the delete icon.

Local
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Table 206: Access Profile Configuration Parameters (continued)

DescriptionField

Select RADIUS to configure RADIUS authentication services.

To create a new RADIUS server:

1. Click +.

The Create RADIUS Server page appears.

2. Enter the following details:

• Address—Enter the IPv4 address of the RADIUS server.

• Secret—Enter the secret password to access the RADIUS server.

• Port—Enter the port number on which to contact the RADIUS server.

Range is 1 through 65535. Default is 1812.

• Retry—Enter the number of retries that a device can attempt to contact a RADIUS server.

Range is 1 through 100 seconds.

• Routing Instance—Enter the routing instance name.

• Source Address—Enter a source IP address configured on one of the device’s interfaces.

• Timeout—Enter the amount of time that the local device waits to receive a response from a
RADIUS authentication server.

Range is 1 through 1000 seconds.

3. Click OK to save changes.

To edit, select the RADIUS server configuration and click the pencil icon.

To delete, select the RADIUS server configuration and click the delete icon.

RADIUS
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Table 206: Access Profile Configuration Parameters (continued)

DescriptionField

Select LDAP to configure LDAP authentication services.

To create a new LDAP server:

1. Click +.

The Create LDAP Server page appears.

2. Enter the following details:

• Address—Enter the IPv4 address of the LDAP server.

• Port—Enter the port number on which to contact the LDAP server.

Range is 1 through 65535. Default is 389.

• Retry—Enter the number of retries that a device can attempt to contact an LDAP server.

Range is 1 through 10 seconds.

• Routing Instance—Enter the routing instance name.

• Source Address—Enter a source IP address configured on one of the device’s interfaces.

• Timeout—Enter the amount of time that the local device waits to receive a response from an
LDAP authentication server.

Range is 3 through 90.

3. Click OK to save changes.

To edit, select the LDAP server configuration and click the pencil icon.

To delete, select the LDAP server configuration and click the delete icon.

LDAP

LDAP Options

Specify the base distinguished name that defines the user.Base
Distinguished
Name

Specify the amount of time that elapses before the primary server is contacted if a backup server
is being used.

Revert Interval

Select assemble or search.

Assemble specifies that a user’s LDAP distinguished name (DN) is assembled using a common name
identifier, the username, and base distinguished name.

Search specifies that a search is used to get a user's LDAP distinguished name (DN). The search is
performed based on the search filter and the part typed in by the user during authentication.

LDAP Option
Type
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Table 206: Access Profile Configuration Parameters (continued)

DescriptionField

Authentication Order

Configure the order in which the different user authentication methods are tried when a user
attempts to log in. For each login attempt, the method for authentication starts with the first one,
until the password matches.

The method can be one or more of the following:

• NONE—No authentication for the specified user.

• Local—Use local authentication services.

• LDAP—The SRX Series device uses this protocol to get user and group information necessary to
implement the integrated user firewall feature.

• Radius—Use RADIUS authentication services.

If RADIUS servers fail to respond or return a reject response, try password authentication, because
it is explicitly configured in the authentication order.

Order 1

Configure the next authenticationmethod if the authenticationmethod included in the authentication
order option is not available, or if the authentication is available but returns a reject response.

Order 2
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Deploying the Access Profile to SRX Series Devices

To deploy the access profile to SRX Series devices:

1. Select Configure > User Firewall Management > Access Profile.

The Access Profile page appears.

2. Select the access profile that you want to deploy, and click Update.

The Update Access Profile page appears. See Table 207 on page 611 for more information.
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3. Select the required SRX Series device to deploy the access profile, and click Update.

A new job is created.

4. Click the job ID to see the update status.

The Job Management page appears showing the state of the updated job. You can also view the
deployed access profile information under the Parameters column.

Table 207: Update Access Profile Page Fields

DescriptionColumn Name

Name of the SRX Series device.Device Name

The access profile configuration can be viewed in either CLI or XML by clicking
View.

Configuration

Configuration status of the device. The different configuration states for a device
are as follows:

• Synchronizing—During the device update, the status is shown as Synchronizing.

• Sync Failed—The synchronization operation failed.

• In Sync—The synchronization operation completed successfully; SecurityDirector
and the device are synchronized.

Configuration Status

Connection status of the device. The status shows either UP or Down.Connection Status

Domain of the user.Domain

IP address of the device.Device IP

Platform of the device. For example, SRX Series, vSRX.Platform

Junos OS version running on the device.OS Version
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Editing and Deleting Access Profiles

IN THIS SECTION
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You can edit and delete access profiles. This topic contains the following sections:

Editing Access Profiles

To edit an access profile:

1. Select Configure > User Firewall Management > Access Profile.

The Access Profile page appears listing the existing access profiles.

2. Select the access profile that you want to edit, right-click and select Edit Access Profile, or click the
pencil icon.

The Edit Access Profile page appears, showing the same options as when creating a new access profile.

3. Click Finish after completing editing.

Deleting Access Profiles

To delete an access profile from all devices:

1. Select Configure > User Firewall Management > Access Profile.

The Access Profile page appears listing the existing access profiles.

2. Select the access profile that you want to delete, right-click and select Delete Access Profile, or click
the delete icon.

This deletes the selected access profile from all the SRX Series devices. An alert message appears
verifying that you want to delete your selection.

3. Click Yes to delete your selection.
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To delete an access profile from selected devices:

1. Select Configure > User Firewall Management > Access Profile.

The Access Profile page appears listing the existing access profiles.

2. Select the access profile that you want to edit, right-click and select Edit Access Profile, or click the
pencil icon.

The Edit Access Profile page appears, showing the same options as when creating a new access profile.

3. Go to the Assign Device section.

4. Move the required device(s) listed under the Selected column to the Available column.

5. Click Finish.

The access profile configuration is deleted from the selected device(s).
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CHAPTER 59

User Firewall Management-Address Pools

IN THIS CHAPTER
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About the Address Pool Page

To access this page, click Configure > User Firewall Management > Address Pools.

An address pool is a set of Internet Protocol (IP) addresses available for allocation to users, such as in host
configurations with the DHCP. An address-assignment pool supports IPv4 address. You can create
centralized IPv4 address pools independent of the client applications that use the pools.

Tasks You Can Perform

You can perform the following tasks from this page:

• Create an address pool. See “Create Address Pool” on page 615.

• Edit and clone an address pool. See “Edit and Delete Address Pool” on page 616.

Field Descriptions

Table 208 on page 614 provides guidelines on using the fields on the Address Pool page.

Table 208: Fields on the Address Pool Page

DescriptionField

Specifies the address pool name.Name

Specifies the network address.Network Address
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Table 208: Fields on the Address Pool Page (continued)

DescriptionField

Specifies the primary DNS IP address.Primary DNS

Specifies the secondary DNS IP address.Secondary DNS

Specifies the primary Windows IP address.Primary WINS

Specifies the secondary Windows IP address.Secondary WINS

Specifies the address range name.Address Ranges

Create Address Pool

An address pool is a set of Internet Protocol (IP) addresses available for allocation to users, such as in host
configurations with the DHCP. An address-assignment pool supports IPv4 address. You can create
centralized IPv4 address pools independent of the client applications that use the pools.

To create an address pool:

1. Click the + icon.

The Create Address Pool page is displayed.

2. Configure according to the guidelines in Table 209 on page 615.

3. Click the + icon to configure a named range of IPv4 addresses, usedwithin an address-assignment pool.

4. Enter the lower and upper limit of an address range.

5. Click OK.

Table 209: Address Pool Configuration Parameters

DescriptionField

General

Enter the name of the address pool.Pool Name

Enter the network address used by the address pool.Network Address
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Table 209: Address Pool Configuration Parameters (continued)

DescriptionField

XAUTH Attributes

Enter the primary DNS IP address.Primary DNS Server

Enter the secondary DNS IP address.Secondary DNS Server

Enter the primary Windows IP address.Primary WINS Server

Enter the secondary Windows IP address.Secondary WINS Server
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You can edit and delete an address pool.

Edit an Address Pool

To edit an address pool:

1. Select Configure > User Firewall Management > Address Pools.

The Address Pool page is displayed.

2. Select an address pool and click the pencil icon or right-click and select Edit Address Pool.

The Edit Address Pool page is displayed.
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3. Edit the required fields.

4. Click OK.

Delete an Address Pool

To delete an address pool:

1. Select Configure > User Firewall Management > Address Pools.

The Address Pool page is displayed.

2. Select an address pool and click the delete icon or right-click and select Delete Address Pool.

A pop-up is displayed with a confirmation message.

3. Click Yes to delete the address object.
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CHAPTER 60

User Firewall Management-Identity Management
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Juniper Identity Management Service Overview
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Juniper Identity Management Service (JIMS) provides a robust and scalable user identification and IP
address mapping implementationwhich includes endpoint context andmachine ID. JIMS collects advanced
user identities from different authentication sources for SRX Series devices.

Security Director is used to push the JIMS configuration to SRX Series devices. You can use JIMS to obtain
IP address or usermapping and device information. SRX Series devices generate the authentication entries
for user firewall.

SRX Series devices communicate with JIMS through HTTP or HTTPS connection. Use HTTP connection
for debugging and HTTPS for deployments. SRX Series devices consist of primary and secondary JIMS
configurations. These devices must always query the primary JIMS. The secondary JIMS is available as a
fall back option with limited resources. The secondary JIMS must be used when the HTTP GET query or
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number of queries to the primary JIMS fails. SRX Series devices constantly scrutinize the failed primary
JIMS and revert to the primary JIMS, once it is up and running.

When you request a JIMS report, the SRX Series device specifies the timestamp. JIMS forms a HTTPS
response from the earliest known report since the requested timestamp. SRX Series devices request for
the maximum number of reports to include in the response from JIMS. Along with the requested reports,
JIMS always returns a cookie. In the subsequent requests to JIMs, SRX Series devices include cookies
instead of timestamp to indicate the same context, same beginning timestamp, and to resume the same
response from where it has stopped the previous time.

NOTE:
• IP and user mapping information might be inaccurate, if the user identities in JIMS are cleared,
delayed, or missing.

• SRX firewall authentication can also push the authentication entries to JIMS.

The SRX Series device communicates with JIMS through HTTP or HTTPS messages to obtain the access
token and query for user identities. The following different query modes are available and all queries can
happen simultaneously.

Access Token Query

JIMS requires OAuth 2.0 protocol to authenticate or authorize. The SRX Series device user query function
requires an access token to query the JIMS server. The SRX Series device uses the client credentials such
as client ID and client secret to obtain an access token. These parameters must be consistent with the API
client configured on JIMS.

Batch or Periodic Query

At the beginning, SRX Series device sends the batch queries to JIMS sequentially to obtain all the expected
user identities. When there are no more entries in JIMS, SRX Series device periodically queries for the
newly generated reports with the configured interval.

The timestamp is mentioned in the query to restart the response. The timestamp is expected in the query
under the following circumstances:

• SRX Series device queries the JIMS server for the first time

• SRX Series device switches over to the secondary JIMS

• SRX Series device does the error recovery because of an internal error or upon receiving error response
from JIMS

For all the other cases, SRX Series device provides the received cookie information in the query instead
of a timestamp.
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IP Address Query

SRX Series device can provide another query to JIMS specifying the IP addess, if it has missed the data
for the existing IP address flow. If there are many IP address queries in the queue, SRX Series device can
keep multiple concurrent HTTP or HTTPS connections with JIMS to increase the throughput. However,
the number of concurrent connections are restricted to less than or equal to 20 connections to reduce
the load on JIMS.

User Mapping Query

SRX Series device can engage Captive Portal to obtain the user ID to authenticate the user. Once the user
is authenticated, SRX Series device can issue another query to JIMS specifying the user ID and IP address
to obtain user information. The firewall authentication uses the
https://<JIMS>/<query-api>/user/ip=<ip>&id=<id>&domain=<domain> API to push an authentication
success entry to JIMS with the user IP, user ID, and the domain. JIMS responds with the user information.

The difference between the IP address query and user query is that the IP address query does not have
the user ID. Both these queries insert the user information to the internal cache of JIMS , and all SRX
devices are updated with user information.
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About the Identity Management Profile Page

To access this page, click Configure > User Firewall Management > Identity Management.

Use the Identity Management Profile page to obtain advanced user identity from different authentication
sources for SRX Series devices.

Tasks You Can Perform

You can perform the following tasks from this page:

• Create the identity management profile. See “Creating Identity Management Profiles” on page 621.
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• Edit, clone, and delete an existing identity management profile. See “Editing, Cloning, and Deleting
Identity Management Profiles” on page 625.

• Deploy the identity management profile. See “Updating the Identity Management Profile to SRX Series
Devices” on page 627.

Field Descriptions

Table 210 on page 621 provides guidelines on using the fields on the Identity Management Profile page.

Table 210: Fields on the Identity Management Profile Page

DescriptionField

Specifies the name of the identity management profile.Name

Specifies the description for the identity management profile.Description

Specifies the IP address of the primary Juniper IdentityManagement System (JIMS).Primary IP Address

Specifies the active directory domains required for SRX Series devices.Domain

Specifies the name of a SRX Series device.Devices
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Creating Identity Management Profiles

Use the Create Identity Management Profile page to create a JIMS profile and to obtain user identities.
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To create an identity management profile:

1. Select Configure > User Firewall Management > Identity Management Profile.

The Identity Management Profile page appears.

2. Click the + sign.

The Create Identity Management Profile page appears.

3. Complete the configuration by using the guidelines in Table 211 on page 622.

4. Click Finish.

Table 211: Fields on the Create Identity Management Profile Page

DescriptionField

General Information

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores.
Maximum length is 255 characters.

Name

Enter a description for the identity management profile; maximum length is 255 characters.Description

General Information—Connection for Primary and Secondary Identity

Select the application protocol from the list used for the SRX Series device connection to
Juniper Identity Management System (JIMS). You identify the connection protocol along
with the configuration that identifies JIMS . The user query function allows the SRX Series
device to request user authentication and identity information for an individual user from
JIMS.

• HTTP—Protocol that JIMS uses to connect to the SRX Series device.

• HTTPS—Secure version of the protocol that JIMS uses to connect to the SRX Series
device.

If the connection type option is not configured, HTTPS is used by default.

Connection Type

Select the connection port of the JIMS server, from the list. Default port number is 443.
The range is 1 to 65535.

Port

Enter a valid IPv4 address of the primary JIMS server.

SRX Series devices always query the primary JIMS to obtain the user identities.

Primary IP Address
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Table 211: Fields on the Create Identity Management Profile Page (continued)

DescriptionField

Enter the certificate of the primary JIMS server. The SRX Series device uses this certificate
to verify the certificate of the JIMS server for the SSL connection that is used for the user
query function. For example: ’/var/tmp/RADIUSServerCertificate.crt’

When SRX Series device does not receive the information from JIMS through the Web
API POST requests, user query enables the SRX Series device to query JIMS for
authentication and identity information for an individual user.

Primary CA Certificate

Enable this option to use the secondary JIMS server as a fallback when the primary JIMS
server fails. By default, this option is disabled.

Secondary Identity

Enter a valid IPv4 address of the secondary JIMS server.

The secondary JIMS is available as a fall back option with limited resources. Use the
secondary JIMSwhen the HTTPGET query or number of queries to the primary JIMS fails.

Secondary IP Address

Enter the certificate of the secondary JIMS server. The SRX Series device uses this certificate
to verify the JIMS server certificate for the SSL connection, used for the user query function.

SecondaryCACertificate

Enter the token API used to generate the URL to acquire an access token. The token API
is combined with the connection method and the IP address of JIMS to produce the
complete URL used to acquire an access token.

For example, if the token API is oauth, the connectionmethod is HTTPS, and the IP address
of JIMS is 192.0.2.199, the complete URL to acquire an access token would be
https://192.0.2.199/api/oauth. This is a required parameter.

The default token API is oauth_token/oauth.

Token API

Enter the query API to specify the path of the URL that the SRX Series device uses to
query JIMS for an individual user. For the SRX Series device to be able to make a request,
you must have configured the query API to obtain an access token.

The SRX Series device generates the complete URL for the user query request by combining
the query API string with the connection method (HTTP/HTTPS) and the JIMS IP address.

Query API

Advanced Settings—Batch Query

Enable this option to specify the maximum number of reports to include in the JIMS
response. The minimum number of reports is 100.

Items per Batch

Enable this option to configure the time interval, in seconds, for SRX Series devices to
periodically query JIMS for the newly generated user identities.

Query Interval
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Table 211: Fields on the Create Identity Management Profile Page (continued)

DescriptionField

Advanced Settings—IP Query

Enter the time in seconds for the SRX Series device to delay before sending the individual
IP queries to JIMS for authentication and identity information for individual users.

After the delay timeout expires, the SRX Series device sends the query to JIMS and creates
a pending entry for the user in the Routing Engine authentication table.

Range: 0 through 60 seconds

Query Delay Time

Enable this option to disable the IP address query function that is enabled by default.No IP Query

Advanced Settings—Authentication Timeout

Enter the timeout interval after which, the idle entries in the JIMS authentication table
expire. If a value of 0 is specified, the entries will never expire. Default is 60 minutes.

The timeout interval begins when the user authentication entry is added to the JIMS
authentication table.

Authentication Entry
Timeout

Assign Devices—Add Assign Devices

Select the SRX Series device from the list for JIMS to send the report on user identities.Device Name

Enter the client ID that the SRX Series device requires to obtain an access token for the
JIMS user query function. The client ID must be consistent with the API client configured
on JIMS.

Client ID

Enter the client secret used with the client ID that the SRX Series device requires to obtain
an access token. The client secret must be consistent with the API client configured on
JIMS.

Client Secret
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Editing, Cloning, and Deleting Identity Management Profiles
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You can edit, clone, and delete the identity management profiles from the Identity Management Profiles
page. You clone an identity management profile to easily create a identity management profile. You can
delete the unused identity management profiles.

Editing Identity Management Profiles

To edit an identity management profile:

1. Select Configure > User Firewall Management > Identity Management Profile.

The Identity Management Profile page appears.

2. Select the identity management profile that you want to edit, and click the pencil icon.

The Edit Identity Management Profile page appears, showing the same fields that are displayed when
you create an identity management profile.

3. Edit the identity management profile fields as needed.

The changes are saved and you are returned to the Identity Management Profile landing page.

Cloning Identity Management Profiles

To clone an identity management profile:

1. Select Configure > User Firewall Management > Identity Management Profile.

The Identity Management Profile page appears.

2. Select the identity management profile that you want to clone, and select Clone from the More list or
right-click menu..
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The Clone IdentityManagement Profile page appears, showing the same fields that are displayedwhen
you create an identity management profile.

3. Modify the identity management profile fields as needed.

4. Click OK to save the changes.

The cloned identity management profile is created and you are returned to the Identity Management
Profile page.

Deleting Identity Management Profiles

To delete one or more identity management profiles:

1. Select Configure > User Firewall Management > Identity Management Profile.

The Identity Management Profile page appears.

2. Select the identity management profile that you want to delete, and click the X icon.

A warning dialog box appears asking you to confirm the deletion.

3. Click Yes to delete the selected identity management profiles.

The identity management profiles are deleted and you are returned to the IdentityManagement Profile
page.
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Updating the Identity Management Profile to SRX Series Devices

To update the identity management profiles to SRX Series devices:

1. Select Configure > User Firewall Management > Identity Management Profile.

The Identity Management Profile page appears.

2. Select the identity management profile that you want to update, and click Update.

The Update Identity Management Profile page appears. See Table 212 on page 627 for more details.

3. Select the required SRX Series device to update the identity management profile, and click Update.

A new job is created.

4. Click the job ID to see the update status

The Job Management page appears showing the state of the updated job.

Table 212: Fields on the Update Identity Management Profile page

DescriptionColumn Name

Name of the SRX Series device.Device Name

You can view the identity management profile configuration in CLI or XML by
clicking View.

Configuration

Configuration status of the device. The different configuration states for a SRX
Series device are as follows:

• Synchronizing—During the device update, the status is shown as Synchronizing.

• Sync Failed—The synchronization operation failed.

• In Sync—The synchronization operation completed successfully; SecurityDirector
and the device are synchronized.

Configuration Status

Connection status of the device. The status shows either UP or Down.Connection Status

Domain of the user.Domain

IP address of the device.Device IP

Platform of the device. For example, SRX Series, vSRX.Platform

Junos OS version running on the device.OS Version

627



RELATED DOCUMENTATION

Juniper Identity Management Service Overview | 618

About the Identity Management Profile Page | 620

Creating Identity Management Profiles | 621

Editing, Cloning, and Deleting Identity Management Profiles | 625

628



CHAPTER 61

User Firewall Management-End User Profile
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End User Profile Overview

An end user profile is a device identity profile. It is a collection of attributes that are characteristics of a
specific group of devices, or of a specific device, depending on the attributes configured in the profile. The
Packet Forwarding Engine of the SRX Series device maps the IP address of a device to the device identity
profile. This feature supportsMicrosoftWindows Active Directory and third-party network access control
(NAC) systems as authentication sources.

When traffic from device A arrives at an SRX Series device, the SRX Series device obtains the IP address
of device A from the first traffic packet and uses it to search the device identity authentication table for
a matching device identity entry. Then it matches that device identity profile with a security policy whose
End User Profile field specifies the device identity profile name. If a match is found, the security policy is
applied to traffic issuing from device A.

The same device identity profile can also apply to other devices sharing the same attributes. However, to
apply the same security policy, the device and its traffic must match all other fields in the security policy.

A device identity profile must contain a domain name. It might contain more than one set of attributes,
but it must contain at least one value in each attribute.

The end user profile feature is useful when you cannot or do notwant to use user identity to control access
to network resources. The device identity feature allows you to use the identity of a device and its attributes
to control access to network resources instead of the identity of the user of that device. You might want
to control network access based on the device identity for various reasons. For example, you might allow
users to use their own devices (BYOD) to access network resources and you do not want to use captive
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portal authentication. Also, some companies might have older switches that do not support 802.1, or they
might not have a NAC system.
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About the End User Profile Page

To access this page, select Configure > User Firewall Management > End User Profile.

Use the End User Profile page to create an end user profile by specifying the name of the profile, one or
more of its attributes, and the name of the active directory domain towhich the SRX Series device belongs.

NOTE: It is mandatory to specify the device attributes and the domain that the device belongs
to.

Tasks You Can Perform

You can perform the following tasks from this page:

• Create an end user profile. See “Creating an End User Profile” on page 631.

• Edit and delete an end user profile. See “Edit and Delete End User Profile” on page 633.

• Clone, view details, and find policies that use a specific end user profile. See “EndUser Profile Operations”
on page 634.

Field Descriptions

Table 213 on page 631 provides guidelines on using the fields on the End User Profile page.
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Table 213: Fields on the End User Profile Page

DescriptionField

Specifies the name of the end user profile.Name

Specifies the name of the domain to which the device belongs; for example, domain1.Device Domain

Specifies one or more values for predefined attributes, such as name, category,
manufacturer, type, operating system, and version of the operating system. You can
create custom attributes as well.

Attributes

Specifies a description for the end user profile.Description

Specifies the domain of the user.Domain
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Creating an End User Profile

Use the Create End User Profile page to create an end user profile. You can apply the end user profile to
the firewall policy rules.

To create an end user profile:

1. Select Configure > User Firewall Management > End User Profile.

The End User Profile page is displayed.

2. Click the + icon.

The Create End User Profile page is displayed.

3. Complete the configuration according to the guidelines provided in Table 214 on page 632.

4. Click OK to create an end user profile or Cancel to discard the profile.
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An end user profile is created in the End User Profile page. While creating firewall policy rules, you can
select an end user profile. When traffic arrives from a device, it matches that device identity profile
with a security policy whose End User Profile field specifies the device identity profile name. If a match
is found, the security policy is applied to traffic issuing from the device.

Table 214: Fields on the Create End User Profile Page

DescriptionField

Enter a unique string of alphanumeric characters, dashes, and underscores. No spaces are
allowed. Maximum length is 64 characters.

Name

Enter a description of the end user profile; maximum length is 1024 characters.Description

Enter a device domain name to which the SRX Series device belongs, using a string of
alphanumeric characters, dashes, and underscores.

Device Domain

Add Attributes

Click the + icon.

The Add Attributes page is displayed. Use this page to add a predefined attribute or create
a custom attribute. You can specify one or more values to an attribute and click OK.

To edit the attributes, click the pencil icon and edit the details.

Select an attribute, either predefined or custom.

Click Create to create a custom attribute.

Attribute Type

Enter one or more values to the attribute, separated by commas. Attribute value must be a
string consisting of letters, numbers, dashes, underscores, and dots. Maximum length is 64
characters.

Maximum attribute values allowed for an attribute-type are 20. Each value should be less
than 64 characters.

The maximum attribute values per profile are 100.

Attribute Value

Create New Attribute Type

In the Add Attribute page, click Create to create unique custom attribute types.

The Create New Attribute Type page is displayed.

Enter a unique attribute type name. It can be a string of alphanumeric characters, dashes,
and underscores. No spaces are allowed. Maximum length is 64 characters.

Attribute Type
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End User Profile Operations | 634

Creating Firewall Policy Rules | 438

Edit and Delete End User Profile

IN THIS SECTION

Edit End User Profile | 633

Delete End User Profile | 633

You can edit an end user profile and delete an unused profile.

Edit End User Profile

To edit an end user profile:

1. Select Configure > User Firewall Management > End User Profile.

The End User Profile page is displayed.

2. Select a profile that you want to edit and click the pencil icon.

The Edit End User Profile page is displayed, showing the same options as when creating a new end
user profile.

3. Edit the details and click OK to save your changes.

Delete End User Profile

To delete an end user profile:

1. Select Configure > User Firewall Management > End User Profile.

The End User Profile page is displayed.

633



2. Select a profile and click X icon.

A confirmation message appears to verify that you want to delete your selection.

3. Click Yes to delete your selection.
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End User Profile Operations

IN THIS SECTION

Cloning an End User Profile | 634

Finding a Profile That Uses a Specific End User Profile | 635

Viewing Details of an End User Profile | 635

You can clone an end user profile, find policies that use a specific end user profile, and view details of an
end user profile.

Cloning an End User Profile

You can clone an end user profile to easily create a similar profile.

1. Select Configure > User Firewall Management > End User Profile.

The End User Profile page is displayed.

2. Select an end user profile. ClickMore or use the right-click menu and select Clone.

The Clone End User Profile page appears with editable fields.
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3. Click OK to save your changes.

Finding a Profile That Uses a Specific End User Profile

You can search for the policies that are using an end user profile.

1. Select Configure > User Firewall Management > End User Profile.

The End User Profile page is displayed.

2. Select an end user profile. ClickMore or use the right-click menu and select Find Usage.

A search result page is displayed with the firewall policies that are using the selected end user profile.
Click the policy link to navigate to the Firewall Policy page.

Viewing Details of an End User Profile

You can view all the details of a profile, such as profile name, device domain, and attribute type and value.

1. Select Configure > User Firewall Management > End User Profile.

The End User Profile page is displayed.

2. Select an end user profile and clickMore or use the right-click menu and select Detailed View.

The End User Profile Details page is displayed.

3. Click Close to close the page.
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CHAPTER 62

IPS Policy-Policies
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Understanding IPS Policies

An Intrusion prevention system (IPS) policy enables you to selectively enforce various attack detection
and prevention techniques on network traffic passing through an IPS-enabled device. There are two types
of policy options:

• Group Policy—select this option, when you want to push a configuration to a group of devices. You can
create rules for a group policy.

During a device assignment for a group policy, only devices from the current and child domains (with
view parent enabled) are listed. Devices in the child domain with view parent disabled are not listed.
Not all the group policies of the Global domain are visible in the child domain. Group policies of the
Global domain (including All device policy) are not visible to the child domain, if the view parent of that
child domain is disabled. Only the group policies of the Global domain, which has devices from the child
domain assigned to it, are visible in the child domain. If there is a group policy in global domain with
devices from both D1 and the Global domains assigned to it, only this group policy of the Global domain
is visible in the D1 domain along with only the D1 domain devices. No other devices, that is the
Device-Exception policy, of the Global domain is visible in the D1 domain.

You cannot edit a group policy of the Global domain from the child domain. This is true for All Devices
policy as well. Modifying the policy, deletion of the policy, managing a snapshot, snapshot policy and
acquiring the policy lock is also not allowed. Similarly, you cannot perform these actions on the
Device-Exception policy of the D1 domain from the Global domain. You can prioritize group policies
from the current domain. Group policies from the other domains are not listed.

• Device Policy—Select this option, when you want to push a unique IPS policy configuration per device.
You can create device rules for a device IPS policy.

Security Director views a logical system or tenant system like it does any other security device, and it
takes ownership of the security configuration of the logical system or tenant system. In Security Director,
each logical system or tenant system is managed as a unique security device.

During a device assignment for a device policy, only devices from the current domain are listed.

NOTE: If Security Director discovers the root logical system, the root LSYS discovers all other
user LSYS and TSYS inside the device.

An IPS policy consists of rulebases and each rulebase contains a set of rules. It allows you to define policy
rules tomatch a section of traffic based on a zone, network, and application, and then take active or passive
preventive actions on that traffic.

An IPS rulebase protects your network from attacks by using attack objects to detect known and unknown
attacks. It detects attacks based on stateful signature and protocol anomalies.
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An exempt rulebase works in conjunction with the IPS rulebase. You must have rules in the IPS rulebase
before you can create exempt rules. If traffic matches a rule in the IPS rulebase, the IPS policy attempts
to match the traffic against the exempt rulebase before performing the specified action or creating a log
record for the event. If the IPS policy detects traffic that matches the source or destination pair and the
attack objects specified in the exempt rulebase, it automatically exempts that traffic from attack detection.

Configure an exempt rulebase in the following conditions:

• When an IPS rule uses an attack object group that contains one or more attack objects that produce
false positives or irrelevant log records.

• When you want to exclude a specific source, destination, or source-destination pair from matching an
IPS rule. This prevents IPS from generating unnecessary alarms.

After you create an IPS policy by adding rules in one or more rulebases, you can publish or update the
policy. You can also view a list of security devices with IPS policies assigned to them. This list assists you
in viewing the details of all the IPS policies and rules assigned per device.

IPS Policy Support for Unified and Standard Firewall Policy

Starting in Junos Space Security Director Release 19.3, you can assign IPS policy to the standard and
unified firewall policies. With the support of IPS policy within firewall policy:

• All the IPS matches will now be handled within the standard or unified firewall policies unless explicit
source, destination, or application is defined in the IPS policy.

• You need not configure source or destination address, source and destination-except, from and to zone,
or application, as thematch happens in the firewall policy. However, you can configurematch conditions
in IPS policy to achieve additional granularity.

• Initial firewall policy match might result in single or multiple policy matches. As a part of session interest
check, IPS will be enabled if IPS policy is present in any of the matched rules.

NOTE: For devices with Junos OS Release 18.2, single IPS policy is supported in the firewall
policy rules. For devices with Junos OS Release 18.3 onward, multiple IPS policies are supported
in the firewall policy rules.

If you have configured a traditional firewall policy (with 5-tuples matching condition or dynamic-application
configured as none) and an unified policy (with 6-tuple matching condition), the traditional firewall policy
matches the traffic first, prior to the unified policy.

When you configure a unified policy with a dynamic application as one of the matching condition, the
configuration eliminates the additional steps involved in IPS policy configuration. All the IPS policy
configurations are handled within the unified firewall policy and simplifies the task of configuring IPS policy
to detect any attack or intrusions for a given session.
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From Junos OS Release 18.2 onward, the CLI configuration for IPS policy is generated along with the
standard or unified firewall policy, to which the IPS policy is attached.

Multiple IPS Policies for Unified and Standard Firewall Policies

When an SRX Series device is configured with standard and unified firewall policies, you can configure
multiple IPS policies and set one of those policies as the default policy. If multiple IPS policies are configured
for a session and when policy conflict occurs, the device applies the default IPS policy for that session and
thus resolves any policy conflicts.

NOTE: If you have configured two or more IPS policies in a firewall policy, then you must
configure the default IPS policy.

The initial security policy lookup phase, which occurs prior to a dynamic application being identified, might
result in multiple potential policy matches. IPS is enabled on the session if at least one of the matched
security policies have an IPS policy configured.

If only one IPS policy is configured in the potential policy list, then that IPS policy is applied for the session.
If there are multiple IPS policies configured for a session in the potential policy list, then the SRX Series
device applies the IPS policy that is configured as the default IPS policy.

IPS in Logical Systems

Starting in Junos Space Security Director Release 20.1R1, an IPS policy enables you to selectively enforce
various attack detection and prevention techniques on network traffic passing through a logical system
(LSYS).

You can configure IPS policies at the root level. Configuring an IPS policy for LSYS is similar to configuring
an IPS policy on a device that is not configured for LSYS. This can include the configuration of custom
attack objects. IPS policy templates installed in root LSYS are visible and used by all LSYS. Specify an IPS
policy in the security profile that is bound to a LSYS. Although you can configure multiple IPS policies, a
LSYS can have only one active IPS policy at a time. For user LSYS, you can either bind the same IPS policy
to multiple user LSYS or bind a unique IPS policy to each user LSYS.

If you have configured more than one IPS policy in a security policy, then configuring default IPS policy
configuration is mandatory. If the IPS policy is not configured for a user LSYS, the default IPS policy
configured is used.

You must install the IPS signature license at the root level. Once IPS is enabled at the root level, it can be
used with any LSYS on the device. A single IPS security package is installed for all LSYS on the device at
the root level. The download and install options can only be executed at the root level. The same version
of the IPS attack database is shared by all LSYS.
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NOTE: Devices running Junos OS Release 18.3 onward supports IPS for Logical System.

To configure IPS policy in a firewall policy and to import a firewall policy that has IPS policy configured,
see the In Focus Guide.

RELATED DOCUMENTATION

Creating IPS Policies | 640

Creating IPS Policy Rules | 642

Publishing Policies | 653

Updating Policies on Devices | 654

Assigning Policies and Profiles to Domains | 668

Configure a Default IDP Policy | 502

Creating IPS Policies

Use this page to define how your device handles network traffic and to define policy rules. It allows you
to enforce various attack detection and prevention techniques on traffic traversing your network.

Before You Begin

• Read the “Understanding IPS Policies” on page 637 topic.

• Configure network interfaces and security zones.

• Enable intrusion prevention system (IPS) in security policies.

• Review the IPS Policies main page for an understanding of your current data set. See “IPS Policies Main
Page Fields” on page 670 for field descriptions.

To configure an IPS policy:

1. Select Configure > IPS Policy > Policies.

2. Click the + icon.
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3. Complete the configuration according to the guidelines provided in the Table 215 on page 641.

4. Click OK.

A new IPS policy with your configurations is created. After you create an IPS policy, add rules in one
or more rulebases and publish the policy. For more information on the IPS policy rules, see “Creating
IPS Policy Rules” on page 642 To enable the IPS policy, apply it to a domain, see “Assigning Policies and
Profiles to Domains” on page 668.

Table 215: IPS Policy Settings

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores.
No spaces are allowed and the maximum length is 255 characters.

Name

Enter a description for the IPS policy; maximum length is 2048 characters.Description

Policy Options

Select Advanced to create a policy that allows you to modify custom IPS rules independent
of the predefined template. In addition, you can start with a predefined template that copies
the predefined rules to your policy, and then edit or delete the rules as necessary.

Configuration Mode

Select the predefined and custom policy templates from the Available column to include in
the selected list for grouping all rules.

Policy Templates

Select an option either to update a specific firewall policy configuration to a large set of
devices or to push a unique firewall policy configuration per device:

• Group Policy—Use this optionwhen youwant to push a configuration to a group of devices.
You can create rules for a group policy.

• Device Policy—Use this option when you want to push a unique IPS policy configuration
per device. You can create device rules for a device IPS policy.

Type

Device Selection
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Table 215: IPS Policy Settings (continued)

GuidelinesSettings

If you selected device policy template type, then select a device on which the policy will be
published.

If you selected group policy template type, then select the devices from the Available column
to include in the selected list for the group policy that will be published.

You can assign devices with Junos OS Release until 18.1. You must assign devices with Junos
OS Release 18.2 onward from firewall policies.

NOTE: Starting in Junos Space Security Director Release 20.1R1, logical system (LSYS) is
supported on devices running Junos OS Release 18.3 and later.

Starting in Junos Space Security Director Release 21.2R1, tenant system (TSYS) is supported
on devices running Junos OS Release 18.3 and later for SRX Series devices and Junos OS
Release 20.1 and later for VSRX Series devices.

Devices

Policy Sequence

Select an option to display or place the policy you have created before or after the
device-specific policies.

Placement

Select this option to specify the policy sequence number. This number identifies the location
of your policy in relation to the entire sequence.

Sequence No.

Move and place the policy to your preferred sequence in the list. This helps you to organize
your policy in the required sequence.

Select Policy
Sequence

RELATED DOCUMENTATION

Understanding IPS Policies | 672

Creating IPS Policy Rules

Use this page to create intrusion prevention system (IPS) rules that define actions to be taken when the
matching traffic pattern is found. You can add, edit, or delete rules to an IPS policy.

You can use the predefined IPS templates while creating an IPS policy. These templates contain rules that
use default actions associated with attack objects. You can customize these templates to work on your
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network by selecting your own source and destination addresses and choosing IPS actions that reflect
your security needs.

IPS rules protect your network from attacks by using attack objects to detect known and unknown attacks
based on stateful signature and protocol anomalies. IPS exempt rules prevent unnecessary alarms from
being generated.

Before You Begin

• Read the “Understanding IPS Policies” on page 672 topic.

• Read the “Understanding IPS Policy Templates” on page 696 topic.

• Create IPS policies and IPS policy templates. See “Creating IPS Policies” on page 640 and “Creating IPS
Policy Templates” on page 697.

To configure an IPS policy rule:

1. Select Configure > IPS Policy > Policies > or Templates.

2. Click the Add Rules link in the created policy.

3. Click Create and then select IPS Rule or Exempt Rule.

4. Complete the configuration according to the guidelines provided in Table 216 on page 643 and
Table 217 on page 649.

5. Click Publish.

A new IPS rule with your configuration is created. You can use this rule in an IPS policy or an IPS policy
template.

Table 216: IPS Policy Rule Settings

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores.
No spaces are allowed and the maximum length is 255 characters.

Name

Display the rule of the specified type. For example, IPS, Exempt.IPS Type

Click the Source Zone field and configure the source zone editor settings.Src. Zone

Source Zone Editor
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Table 216: IPS Policy Rule Settings (continued)

GuidelinesSettings

Select any zone for the source. You can also use zone exceptions to specify unique to zones
for each device. Specify any tomonitor network traffic originating from any zone. The default
value is any.

Zone

Click the Source Address field and configure the source address settings.Src. Address

Source Address

Include or exclude addresses from the selected address list for the rule. You can also select
to include any of the IP addresses of the source objects.

Address Selection

Select one ormore available IP addresses from the Available column to include in the selected
list for the rule.

Addresses

Click the button to add a new source address.Add New Source
Address

Click the Destination Zone field and configure the destination zone editor settings.Dest. Zone

Destination Zone Editor

Select any zone for the destination. You can also use zone exceptions to specify unique from
zones for each device. Specify any to monitor network traffic to any zone. The default value
is any.

Zone

Click the Destination Address field and configure the destination address settings.Dest. Address

Destination Address

Include or exclude addresses from the selected address list for the rule. You can also select
to include any of the IP addresses of the source objects.

Address Selection

Select one ormore available IP addresses from the Available column to include in the selected
list for the policy rule.

Addresses

Click the button to add a new destination address.Add New Destination
Address

Click the Service field and configure the service editor settings.Service

Service Editor
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Table 216: IPS Policy Rule Settings (continued)

GuidelinesSettings

Select an available services for the policy rule. For example:

• ftp—FTP allows the sending and receiving of files between machines.

• ssh—SSH is a program to log into another computer over a network through strong
authentication and secure communications on a channel that is not secure.

• Web—Policy allows access to users who have previously been authenticated by Web
authentication.

• User Firewall—Uses the username and role information to determine whether to permit
or deny a user's session or traffic.

• Infranet—Pushes the user and role information for all authenticated users from the Access
Control Service.

The default value is Default.A service in Security Director refers to an application on a device,
such as Domain Name System (DNS). Services are based on protocols and ports and when
added to a policy can be applied across all devices managed by Security Director.

Services

Click the button to add a new service.Add New Service

Click the IPS Signature field and configure the IPS signature settings.IPS Signature

IPS Signature

Select one or more available IPS signatures from the Available column to include in the
selected list for the policy rule.

IPS Signatures

Click the button to add a new IPS signature.AddNew IPS Signature

Click the Action field and configure the action settings.Action

Action
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Table 216: IPS Policy Rule Settings (continued)

GuidelinesSettings

Select an option for the action you want IPS to take when the monitored traffic matches
the attack objects specified in the rules:

• No Action—Does not take action. Use this action when you only want to generate logs
for some traffic.

• Ignore—Stops scanning traffic for the rest of the connection if an attack match is found.
IPS disables the rulebase for the specific connection.

NOTE: This action does not mean ignore an attack.

• Drop Packet—Drops a matching packet before it can reach its destination but does not
close the connection. Use this action to drop packets for attacks in traffic that is prone to
spoofing, such as UDP traffic. Dropping a connection for such traffic could result in a
denial of service that prevents you from receiving traffic from a legitimate source IP
address.

• Drop Connection—Drops all packets associated with the connection, preventing traffic
for the connection from reaching its destination. Use this action to drop connections for
traffic that is not prone to spoofing.

• Close Client—Closes the connection and sends an RST packet to the client but not to the
server.

• Close Server—Closes the connection and sends an RST packet to the server but not to
the client.

• Close Client and Server—Closes the connection and sends an RST packet to both the client
and the server.

• Recommended—Gives a list of all attack objects that Juniper Networks considers to be
serious threats, organized into categories. For example, severity groups attack objects by
the severity assigned to the attack.

• Diffserv Marking—Assigns the indicated Differentiated Services code point (DSCP) value
to the packet in an attack, then passes the packet on normally.

When you select Diffserv Marking, you need to enter code value.

• Code Point for Diffserv Marking—Enter a code point value. Based on the DSCP value,
behavior aggregate classifiers set the forwarding class and loss priority for the traffic
deciding the forwarding treatment the traffic receives.

NOTE: The DSCP value is not applied to the first packet that is detected as an attack, but
is applied to subsequent packets.

Action

Click the Notification field and configure the notification settings.Notification Opt.

Notification Opt.
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Table 216: IPS Policy Rule Settings (continued)

GuidelinesSettings

Enable this option to log attacks.Attack Logging

Enable this option to add an alert flag to an attack log.Alert Flag

Enable this option to log packet capture when a rule matches.Log Packets

Enter the number of packets processed before the attack is captured.Packets Before

Enter the number of packets processed after the attack is captured.Packets After

Enter the time limit for capturing post-attack packets for a session.

No packet capture is conducted after the timeout has expired. Range is from 0 through 1800
seconds.

Post Window Timeout

Click the IP Action field and configure the IP action settings.IP Action Opt.

IP Action Opt.

Select an option to apply actions on future connections that use the same IP action attributes:

• None—Does not take any action against future traffic.

• IP Notify—Does not take any action against future traffic but logs the event. This is the
default.

• IP Close—Closes any new sessions matching this IP action rule by sending RST packets to
the client and server.

• IP Block—All packets of any session matching the IP action rule are dropped silently.

When traffic matches multiple rules, the most severe IP action of all matched rules is
applied. The most severe IP action is the Close Session action, the next in severity is the
Drop/Block Session action, and then the Notify action.

IP Action
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Table 216: IPS Policy Rule Settings (continued)

GuidelinesSettings

Select an option to block future connections:

• None—Does not match any traffic.

• Destination Address—Matches traffic based on the destination address of the attack
traffic.

• Service—For TCP and UDP, matches traffic based on the source address, source port,
destination address, and destination port of the attack traffic. This is the default.

• Source Address—Matches traffic based on the source address of the attack traffic.

• Source Zone—Matches traffic based on the source zone of the attack traffic.

• Source Zone Address—Matches traffic based on the source zone and source address of
the attack traffic.

• Zone Service—Matches traffic based on the source zone, destination address, destination
port, and protocol of the attack traffic.

IP Target

Enable this option to refresh the IP action timeout so it does not expire when future
connections match the IP action filter.

Refresh Timeout

Enter the number of seconds that you want the IP action to remain in effect after a traffic
match.

Default value is 0 seconds and the range is from 0 through 64,800 seconds.

Timeout Value

Enable this option to log information about the IP action against the traffic that matches a
rule.

Log Taken

Enable this option to generate a log event on the IP action filter.Log Creation

Click the Additional field and configure the additional settings.Additional Opt.

Additional Opt.

Select a severity level to override the inherited attack severity in the rules. Levels, in order
of increasing severity, are info, warning, minor, major, and critical. The most dangerous level
is critical, which attempts to crash your server or gain control of your network. Informational
is the least dangerous level and is used by network administrators to discover holes in their
security systems.

Severity

Enable this option to set a terminal rule flag. The device stops matching rules for a session
when a terminal rule is matched.

Terminal

Enter a description for the IPS policy rule; maximum length is 4096 characters.Description
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Table 217: IPS Policy Templates Rule Settings

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores.
No spaces are allowed and the maximum length is 63 characters.

Name

Display the rule of the specified type. For example, IPS, Exempt.IPS Type

Click the IPS Signature field and configure the IPS signature settings.IPS Signature

IPS Signature

Select one ormore available IPS signatures from the Available column to include in the selected
list for the policy rule.

IPS Signatures

Click the button to add a new IPS signature.Add New IPS
Signature

Click the Action field and configure the action settings.Action

Action
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Table 217: IPS Policy Templates Rule Settings (continued)

GuidelinesSettings

Select an option for the action you want IPS to take when the monitored traffic matches the
attack objects specified in the rules:

• No Action—Does not take action. Use this action when you only want to generate logs for
some traffic.

• Ignore—Stops scanning traffic for the rest of the connection if an attack match is found. IPS
disables the rulebase for the specific connection.

NOTE: This action does not mean ignore an attack.

• Drop Packet—Drops amatching packet before it can reach its destination but does not close
the connection. Use this action to drop packets for attacks in traffic that is prone to spoofing,
such as UDP traffic. Dropping a connection for such traffic could result in a denial of service
that prevents you from receiving traffic from a legitimate source IP address.

• Drop Connection—Drops all packets associated with the connection, preventing traffic for
the connection from reaching its destination. Use this action to drop connections for traffic
that is not prone to spoofing.

• Close Client—Closes the connection and sends an RST packet to the client but not to the
server.

• Close Server—Closes the connection and sends an RST packet to the server but not to the
client.

• Close Client and Server—Closes the connection and sends an RST packet to both the client
and the server.

• Recommended—Gives a list of all attack objects that Juniper Networks considers to be
serious threats, organized into categories. For example, severity groups attack objects by
the severity assigned to the attack.

• Diffserv Marking—Assigns the indicated Differentiated Services code point (DSCP) value
to the packet in an attack, then passes the packet on normally.

When you select Diffserv Marking, you need to enter code value.

• Code Point for Diffserv Marking—Enter a code point value. Based on the DSCP value,
behavior aggregate classifiers set the forwarding class and loss priority for the traffic
deciding the forwarding treatment the traffic receives.

NOTE: The DSCP value is not applied to the first packet that is detected as an attack, but is
applied to subsequent packets.

Action

Click the Notification field and configure the notification settings.Notification Opt.

Notification Opt.

Enable this option to log attacks.Attack Logging
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Table 217: IPS Policy Templates Rule Settings (continued)

GuidelinesSettings

Enable this option to add an alert flag to an attack log.Alert Flag

Enable this option to log packet capture when a rule matches.Log Packets

Enter the number of packets processed before the attack is captured.Packets Before

Enter the number of packets processed after the attack is captured.Packets After

Enter the time limit for capturing post-attack packets for a session.

No packet capture is conducted after the timeout has expired. Range is from 0 through 1800
seconds.

Post Window
Timeout

Click the IP Action field and configure the IP action settings.IP Action Opt.

IP Action Opt.

Select an option to apply actions on future connections that use the same IP action attributes:

• None—Does not take any action against future traffic.

• IP Notify—Does not take any action against future traffic but logs the event. This is the
default.

• IP Close—Closes any new sessions matching this IP action rule by sending RST packets to
the client and server.

• IP Block—All packets of any session matching the IP action rule are dropped silently.

When traffic matchesmultiple rules, themost severe IP action of all matched rules is applied.
The most severe IP action is the Close Session action, the next in severity is the Drop/Block
Session action, and then the Notify action.

IP Action

Select an option to block future connections:

• None—Does not match any traffic.

• Destination Address—Matches traffic based on the destination address of the attack traffic.

• Service—For TCP and UDP, matches traffic based on the source address, source port,
destination address, and destination port of the attack traffic. This is the default.

• Source Address—Matches traffic based on the source address of the attack traffic.

• Source Zone—Matches traffic based on the source zone of the attack traffic.

• Source Zone Address—Matches traffic based on the source zone and source address of the
attack traffic.

• Zone Service—Matches traffic based on the source zone, destination address, destination
port, and protocol of the attack traffic.

IP Target
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Table 217: IPS Policy Templates Rule Settings (continued)

GuidelinesSettings

Enable this option to refresh the IP action timeout so it does not expirewhen future connections
match the IP action filter.

Refresh Timeout

Enter the number of seconds that you want the IP action to remain in effect after a traffic
match.

Default value is 0 seconds and the range is from 0 through 64,800 seconds.

Timeout Value

Enable this option to log information about the IP action against the traffic that matches a
rule.

Log Taken

Enable this option to generate a log event on the IP action filter.Log Creation

Click the Additional field and configure the additional settings.Additional Opt.

Additional Opt.

Select a severity level to override the inherited attack severity in the rules. Levels, in order of
increasing severity, are info, warning, minor, major, and critical. The most dangerous level is
critical, which attempts to crash your server or gain control of your network. Informational is
the least dangerous level and is used by network administrators to discover holes in their
security systems.

Severity

Enable this option to set a terminal rule flag. The device stops matching rules for a session
when a terminal rule is matched.

Terminal

Enter a description for the IPS policy rule; maximum length is 1024 characters.Description
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Publishing Policies

When you publish rules, the process takes into account the priority and precedence values set on the
policy and the order of rules on the device. Rules are published in the order of their priority groups, with
prerules in the High priority group publishing first, before prerules in theMedium and Low priority groups.

If you change the priority or precedence of a published policy, the policy must be republished for the
changes to take effect. Sometimes, changing priority or precedence in one policy can affect other policies
in the same priority group. However, such policies do not need to be republished in order for their changes
in priority or precedence to take effect for the policies that are implicitly changed by the explicit changes
to the republished policy.

To publish a policy:

1. Select Configure > Policy-Name Policy > Policies.

2. Select the policy that you want to publish and click Publish. The Publish Policy page appears.

3. Select the check boxes next to the devices to which the policy changes will be published.

NOTE: You can search for a specific device on which the policy is published by entering the
search criteria in the search field. You can search the devices by their name and IP address.

4. Select Schedule at a later time if you want to schedule and publish the configuration later.

5. Select Run now if you want to apply the configuration immediately.

6. Click Publish. The Affected Devices page displays the devices on which the policies will be published.
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Updating Policies on Devices

When you publish rules, the process takes into account the priority and precedence values set on the
policy and the order of rules on the device. Rules are published in the order of their priority groups, with
prerules in the High priority group publishing first, before prerules in theMedium and Low priority groups.

If you change the priority or precedence of a published policy, the policy must be republished for the
changes to take effect. Sometimes, changing priority or precedence in one policy can affect other policies
in the same priority group. However, such policies do not need to be republished in order for their changes
in priority or precedence to take effect for the policies that are implicitly changed by the explicit changes
to the republished policy.

To update a policy:

1. Select Configure >Policy-Name Policy> Policies.

2. Select the policy that you want to update and click Update. The Update Policy page appears.

3. Select the check boxes next to the devices to which the policy changes will be published.

NOTE: You can search for a specific device on which the policy is published by entering the
search criteria in the search field. You can search the devices by their name and IP address.

4. Select Schedule at a later time if you want to schedule and publish the configuration later.

5. Select Run now if you want to apply the configuration immediately.

6. Click Publish. The Affected Devices page displays the devices on which the policies will be published.
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Assigning Devices to Policies

Once you create a group or device policy, you can assign devices to it.

To assign devices to a policy:

1. Select Configure >Policy-Name Policy > Policies.

The Policies landing page appears.

2. Right-click the policy to which you want to assign devices, or select Assign Devices from the More
menu.

The Assign Devices page appears. The Name field shows the name of the selected policy and is not
editable.

3. Select the Show only devices without policy assigned check box.

Only devices that are not assigned to any policy are displayed in the Device Selection section.

4. Select the devices you want to add to the policy from the Available column and click the right arrow
tomove these devices to the Selected column. You cannot assign devices with JunosOS Release greater
than 18.1. You must assign devices with Junos OS Release 18.2 onward from firewall policies.

NOTE: There is an option to search for devices in the Selected column on the Assign Devices
page. By default, all selected devices are sorted in a list and you can search for devices again,
if required.

5. Click OK to assign the selected devices to the selected policy.

NOTE: If you do not have permission to certain devices, those devices are not visible while
assigning devices to a new or existing policy.
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Create and Manage Policy Versions

IN THIS SECTION

Create Policy Snapshots | 656

Manage Policy Versions | 657

Roll Back Policy Versions | 657

Compare Policy Versions | 658

Delete Policy Versions | 658

You create a policy version by taking a snapshot of another policy. You can create versions for all types
of policies including All Devices, Group, Device, and Device exceptions.

The maximum number of versions maintained for any policy is 60. If the maximum limit is reached, you
must delete the unwanted versions before saving a new version. Versioning and rollback are independent
operations for each policy.

For example, if you take a snapshot of a group firewall policy, or roll back to a previous firewall policy
version, it does not change the version for all device policy rules; you must separately version each policy
rule.

Create Policy Snapshots

To create a policy version:

1. Select Configure > IPS Policy > Policies.

2. Select the check box next to the policy for which you are taking a snapshot, and then right-click the
policy or clickMore.

A list of actions appears.

3. SelectManage/Rollback Policy.

The Manage Version page appears.

4. Click Create Snapshot.
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The Snapshot Policy page appears.

5. Enter your comments in the Comments field, and click Create to take a snapshot. The Snapshot Policy
window appears, showing the status of the version as it is created.

NOTE: During policy publish, Security Director takes an automatic snapshot of the policy.

Manage Policy Versions

You can view or manage all available versions of a selected policy. You can perform the following tasks
on the snapshots:

• Roll back to a specific version.

• View the differences between any two versions (including the current version) of the policy

• Delete one or more versions from the system.

Roll Back Policy Versions

To roll back the selected version so it becomes the current version:

1. Select Configure > IPS Policy > Policies.

2. Select the check box next to the policy for which you are rolling back a version, and then right-click
the policy or clickMore.

A list of actions appears.

3. SelectManage/Rollback Policy.

The Manage Version page appears.

4. Select the version that you want to make as the current version, and click Rollback.

The rollback operation replaces all the rules and rule groups of the current version with rules and rule
groups from the selected version. For all the shared objects, Object Conflict Resolution (OCR) is done.
If there are any conflicts between the versioned data and the current objects in the system, the OCR
window is displayed.

657



5. After finishing any conflict resolution, click Next to view the OCR summary report.

6. Click Finish to replace the current policy with the versioned data. A summary of the snapshot policy is
shown by clicking Snapshot.

Compare Policy Versions

To compare two different versions of a policy:

1. Select Configure > IPS Policy > Policies.

2. Select the check box next to the policy for which you want to compare versions, and then right-click
the policy or clickMore.

A list of actions appears

3. SelectManage/Rollback Policy.

The Manage Version page appears.

4. Select the versions to be compared, and click Compare. You can only compare two versions at a time.

The Compare Versions page appears.

5. Click Compare to view the results.

A Compare Versions results window appears showing the differences between the selected versions.

The Compare Versions results window has the following sections:

• Policy Property Changes—Shows policy changes for the modified rules.

• Rule Changes—Displays rules that are added, modified, or deleted.

• Column Changes—Shows the differences between the column content for modified rules.

Delete Policy Versions

To delete a policy version:

1. Select Configure > IPS Policy > Policies.

2. Right-click the policy or profile or clickMore.

A list of actions appears.

658



3. ClickManage/Rollback Policy.

The Manage Version page appears.

4. Select the policy version you want to delete and click Delete.

A warning message is displayed.

5. Click Yes to confirm the deletion.

The selected policy version is deleted.

RELATED DOCUMENTATION
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Creating Rule Name Template

Rule name template provides a mechanism to control the rule name generation based on the rule name
template. You can use the rule name templates for all types of rules in Firewall, NAT, and IPS policies.

To create a rule name template for policies:

1. Select Configure > Policies.

The Policies page appears.

2. Right-click the policy you want to take a snapshot, or select Rule Name Template Builder from the
More list.

3. The Rule Name Template Builder page appears.

Select the Enable check box to use the rule name template.

4. Select the compliance mode.

a. Strict Mode—Warns the user with an error message.

b. Weak Mode—Warns the user with a warning message.

5. Click the plus sign (+) to add a new template builder name.

You can define a template for a new or cloned rule with the following variables:
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• Action

• Constant String

• Custom String

• Date (YYYYMMDD format)

• Date Short

• Egress

• Ingress

• Rule Type

• Time (HHmmss format)

• Time (HHMM format)

• User ID

6. Click OK to create a new rule name template.
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Starting in Security Director Release 16.1, you can export any policies (firewall, IPS, or NAT) in a PDF or
ZIP file from their respective Policies landing page.

Export a policy to PDF

1. Select Configure > IPS Policy > Policies.

The IPS Policies page appears.

2. Right-click the policy you want to export or select Export Policy to PDF from the More menu.

The Export Policy to PDF page appears.

3. Click Export.

The selected policy details are exported into a PDF file.

Export a policy to a ZIP file:

1. Select Configure > IPS Policy > Policies.

The IPS Policies page appears.

2. Right-click the policy you want to export or select Export Policy to Zip File from the More menu.

The Export Policy page appears.

3. Click Export.

The selected policy details are exported into a ZIP file.

Release History Table

DescriptionRelease

Starting in Security Director Release 16.1, you can export any policies (firewall, IPS, or NAT)
in a PDF or ZIP file from their respective Policies landing page.

16.1
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Unassigning Devices to Policies

Once you create a device policy, you can remove the assigned device from it. This allows you to add a
preferred device at any time to a device policy. This option is not available for a group policy.

To remove an assigned devices from a device policy:

1. Select Configure >Policy-Name > Policies.

The Policies landing page appears.

2. Select a device policy and then clickMore.

3. Click Unassign Devices.

The Unassign Device page appears with a confirmation message.

You can also right-click a policy and select Unassign Devices.

4. Click Yes.

The assigned device is removed for the selected device policy.
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Starting in Junos Space Security Director Release 19.4R1, when there is an out-of-band IPS policy change
in the device, you can see an icon next to the corresponding policy in device-specific and group IPS policies
in Security Director. You can manually synchronize the out-of-band changes for a device-specific policy,
only when the automatic synchronization is disabled.

When you hover over the icon next to the policy, the tooltip indicates the out-of-band changes.

NOTE: For devices running Junos OS Release 18.2 and later, you can synchronize the IPS policy
changes from standard or unified firewall policies page. For devices with Junos OS Release 18.1
and earlier, you can synchronize the IPS policy changes from the IPS Policies page.

When a device is discovered in Security Director, the Managed Status is displayed as Managed in the
Security Devices page. For manual synchronization of out-of-band policy changes, the managed status of
the device must be SD Changed, Device Changed, or In Sync. For this, you must update the device atleast
once from Security Director. In case of logical system (LSYS) or tenant system (TSYS), root device may
show the status as Device Changed if a policy is assigned to it. Update the root device so that the status
is In Sync.

NOTE: Out-of-band changes are not supported if more than one policy is assigned to a device
or if rules are configured in All Devices Policy Pre/Post policies.

Viewing Out-of-Band IPS Policy Changes

To view out-of-band IPS policy changes:

1. Select Configure > IPS Policy > Policies.

The IPS Policies page appears. An icon is displayed for the policies indicating the out-of-band policy
changes.

2. Right-click the policy or select View Device Policy Changes from the More menu.

The Out of Band Changes page appears.

3. Click View to view the configuration changes for a device in CLI and XML format.

The view configuration page for the device is displayed.

After viewing the changes, you can choose to import or reject the out-of-band changes from the device.

4. Click OK.
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NOTE: To reject all the out-of-band changes, select Reject all changes option. The icon next
to the policy will be cleared and the policy changes from the device will not be imported into
Security Director. During the subsequent update from Security Director, the out-of-band
changes will be overwritten in the device.

To import the out-of-band changes to Security Director, see “Importing Out-of-Band IPS
Policy Changes Manually” on page 664.

Importing Out-of-Band IPS Policy Changes Manually

To import out-of-band IPS policy changes:

1. Select Configure > IPS Policy > Policies.

The IPS Policies page appears. An icon is displayed for the policies indicating the out-of-band policy
changes.

2. Right-click the policy or select View Device Policy Changes from the More menu.

The Out of Band Changes page appears.

3. Select Select Changes from Device to accept the out of band IPS policy changes from a device.

4. Select a device and click OK.

NOTE: In the case of group policy, you can view all the devices where the policy is associated,
but you can select only one device and import the changes. After selecting a device, click
Affected Devices to see all the devices where the policy is assigned.

In case of both, group policy and device specific policy, an icon is seen next to the device(s)
indicating the out-of-band changes.

The Import Device Configuration Changes page appears.

5. Select the IPS policy and click Next.

Objects with conflicts are displayed, if any.

6. Select objects and choose a conflict resolution type. Resolve any conflicts after you verify the
information, if needed.
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7. Click Finish.

A summary of the configuration changes is displayed.

You can download the summary report as a ZIP file. The summaryreport.zip file contains the complete
rules report as a PDF.

8. Click OK to complete the import process.

The Job Details page is displayed with status of the import job.

9. Click OK.

The policies page is displayed with an icon which indicates that the policy was edited and needs
publishing to the device.

10.Click Publish to publish the changes.

During the subsequent update from Security Director, the out-of-band changes will be overwritten in
the device(s).
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Edit and Clone Policies and Objects
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Edit Policies or Objects | 666

Clone Policies or Objects | 666

You can edit or clone policies and objects from the policies and shared objects main page.
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NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Edit Policies or Objects

To edit a policy or a shared objects:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to edit, and then click the pencil icon.

The Edit window appears, showing the same options as when creating a new policy or object.

3. Click OK to save your changes.

NOTE: After the published firewall policy rules are edited and saved, you see an icon next to
the check box for each saved policy rule on the Firewall Policies page. When you hover over the
icon, a message appears, indicating that the policy was edited and needs to be pushed to the
device. For updating the policy, see “Updating Policies on Devices” on page 478.

Clone Policies or Objects

To clone a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to clone, or select Clone from the More list.

The Clone window appears with editable fields.

3. Click OK to save your changes.

RELATED DOCUMENTATION
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Creating IPS Policies | 640

Delete and Replace Policies and Objects

IN THIS SECTION

Delete Policies and Objects | 667

Replace Policies and Objects | 667

You can delete or replace policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Delete Policies and Objects

To delete a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to delete, and then select the minus sign (-).

An alert message appears verifying that you want to delete your selection.

3. Click Yes to delete your selection.

Replace Policies and Objects

You can select one or more shared objects and replace them with other objects of the same type.

To replace one or more object:

1. Select Configure > Shared Objects > Addresses, Services, or Variables.

The addresses, services, or variables page appears.
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2. Right-click the shared object that you want to replace, or click Replace from the More list.

You can replace a single object or multiple objects. If the selected object is used in any policy, a warning
message appears before they are replaced.

3. Click Yes to continue the replacement operation.

RELATED DOCUMENTATION
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Assigning Policies and Profiles to Domains

You can assign or reassign policies or profiles to different domainswhen it is first configured andwhenever
you want to implement a change. You can assign only one policy or profile at a time. Before assigning a
policy or profile to another domain, Security Director checks for the validity of the move. If the move is
not acceptable, a warning message appears.

To assign a policy or profile to a domain:

1. Select Configure and select the landing page for the type of policy or profile that you are assigning to
a domain.

2. From the landing page, right-click the policy or profile or clickMore.

A list of actions appears.

3. Select Assign <Policy or Profile> to Domain.

The Assign <Policy or Profile> to Domain page appears.

NOTE: <Policy or Profile> is the name of the policy or profile that you are assigning to a
domain.

4. Select the required items to assign to a domain.

5. Enable this option to ignore warning messages, if any.

6. Click Assign.
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A policy or profile is assigned to a domain.

RELATED DOCUMENTATION
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Viewing Policy and Shared Object Details

On a policy or a shared object landing page, you can get a detailed view of the existing policies or objects.
The Detail View page lists all the configured parameters of a policy or an object. The Landing page of a
policy or shared object lists only some of the configured parameters and not all. The Detail View option
helps you to get a consolidated view of all the configured parameters.

NOTE: The detailed view is in read-only mode; you cannot edit any fields.

To see a detailed view of the policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to see the detailed view for, or selectDetail View
from the More list.

The Detail View page appears showing the configuration information, the user who created that
particular policy or shared object, and the last updated information.

You can also get a detailed view by hovering over the name and clicking the Detailed View icon before
the policy or shared object name.
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IPS Policies Main Page Fields

Use the IPS Policies main page to get an overall, high-level view of your IPS policy settings. You can filter
and sort this information to get a better understanding ofwhat youwant to configure. Table 218 on page 670
describes the fields on this page.

Table 218: IPS Policies Main Page Fields

DescriptionField

Policy sequence number in relation to the entire sequence.Seq.

Name of the IPS policy.Name

Total number of rules created for an IPS policy.Rules

Total number of devices on which the IPS policy is published.Devices

Displays the status of the IPS policy configuration.

• Not Published—IPS policy is created but not published.

• Published—Configuration is published to all devices involved in the policy.

• Partially Published—Configuration is published to only fewer devices involved in the
IPS policy.

• Re-publish Required—Modifications are made to the IPS policy configuration after it
is published.

Publish State

Login name of the operator who created the IPS policy .Created By

Time when the IPS policy was last modified .Last Modified

Login name of the operator who last modified the IPS policy .Modified By

Domain name of security device, which is autopopulated once you select the device. For
example: global, system.

Domain
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CHAPTER 63

IPS Policy-Devices
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Understanding IPS Policies

An Intrusion prevention system (IPS) policy enables you to selectively enforce various attack detection
and prevention techniques on network traffic passing through an IPS-enabled device. There are two types
of policy options:

• Group Policy—select this option, when you want to push a configuration to a group of devices. You can
create rules for a group policy.

During a device assignment for a group policy, only devices from the current and child domains (with
view parent enabled) are listed. Devices in the child domain with view parent disabled are not listed.
Not all the group policies of the Global domain are visible in the child domain. Group policies of the
Global domain (including All device policy) are not visible to the child domain, if the view parent of that
child domain is disabled. Only the group policies of the Global domain, which has devices from the child
domain assigned to it, are visible in the child domain. If there is a group policy in global domain with
devices from both D1 and the Global domains assigned to it, only this group policy of the Global domain
is visible in the D1 domain along with only the D1 domain devices. No other devices, that is the
Device-Exception policy, of the Global domain is visible in the D1 domain.

You cannot edit a group policy of the Global domain from the child domain. This is true for All Devices
policy as well. Modifying the policy, deletion of the policy, managing a snapshot, snapshot policy and
acquiring the policy lock is also not allowed. Similarly, you cannot perform these actions on the
Device-Exception policy of the D1 domain from the Global domain. You can prioritize group policies
from the current domain. Group policies from the other domains are not listed.

• Device Policy—Select this option, when you want to push a unique IPS policy configuration per device.
You can create device rules for a device IPS policy.

Security Director views a logical system or tenant system like it does any other security device, and it
takes ownership of the security configuration of the logical system or tenant system. In Security Director,
each logical system or tenant system is managed as a unique security device.

During a device assignment for a device policy, only devices from the current domain are listed.

NOTE: If Security Director discovers the root logical system, the root LSYS discovers all other
user LSYS and TSYS inside the device.

An IPS policy consists of rulebases and each rulebase contains a set of rules. It allows you to define policy
rules tomatch a section of traffic based on a zone, network, and application, and then take active or passive
preventive actions on that traffic.

An IPS rulebase protects your network from attacks by using attack objects to detect known and unknown
attacks. It detects attacks based on stateful signature and protocol anomalies.
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An exempt rulebase works in conjunction with the IPS rulebase. You must have rules in the IPS rulebase
before you can create exempt rules. If traffic matches a rule in the IPS rulebase, the IPS policy attempts
to match the traffic against the exempt rulebase before performing the specified action or creating a log
record for the event. If the IPS policy detects traffic that matches the source or destination pair and the
attack objects specified in the exempt rulebase, it automatically exempts that traffic from attack detection.

Configure an exempt rulebase in the following conditions:

• When an IPS rule uses an attack object group that contains one or more attack objects that produce
false positives or irrelevant log records.

• When you want to exclude a specific source, destination, or source-destination pair from matching an
IPS rule. This prevents IPS from generating unnecessary alarms.

After you create an IPS policy by adding rules in one or more rulebases, you can publish or update the
policy. You can also view a list of security devices with IPS policies assigned to them. This list assists you
in viewing the details of all the IPS policies and rules assigned per device.
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Devices with IPS Policies Main Page Fields

Use this page to get an overall, high-level view of your IPS policy device settings. This page helps you track
the number of rules, and the order of the rules, of all the policies that are assigned to a device. You can
filter and sort this information to get a better understanding ofwhat youwant to view. Table 219 on page 673
describes the fields on this page.

Table 219: Devices with IPS Policies Main Page Fields

DescriptionField

Name of the device.Device Name

Total number of rules of all the policies assigned to the device. Click the link to
view the rules order that is deployed on the device.

Rules
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Table 219: Devices with IPS Policies Main Page Fields (continued)

DescriptionField

IP address of the device.IP Address

Displays the supported device name. For example: SRX Series, vSRX.Platform

Displays the policy name when a device is assigned to an IPS policy.Assigned Services

Displays the versioning information for the IPS policy.Pending Services

Displays the policies that are published and updated to the device.Installed Services

Domain name of security device, which is autopopulated once you select the
device. For example: global, system.

Domain
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IPS Policy-Signatures
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Understanding IPS Signatures

The intrusion prevention system (IPS) compares traffic against signatures of known threats and blocks
traffic when a threat is detected. Network intrusions are attacks on, or other misuses of, network resources.
To detect such activity, IPS uses signatures. A signature specifies the types of network intrusions that you
want the device to detect and report. Whenever a matching traffic pattern to a signature is found, IPS
triggers the alarm and blocks the traffic from reaching its destination. The signature database is one of the
major components of IPS. It contains definitions of different objects, such as attack objects, application
signature objects, and service objects, which are used in defining IPS policy rules.

To keep IPS policies organized and manageable, attack objects can be grouped. An attack object group
can contain one or more types of attack objects. Junos OS supports the following three types of attack
groups:

• IPS signature—Contains objects present in the signature database.

• Dynamic group—Contains attack objects based on certain matching criteria. During a signature update,
dynamic group membership is automatically updated based on the matching criteria for that group. For
example, you can dynamically group the attacks related to a specific application using dynamic attack
group filters.

• Static group—Contains a list of attacks that are specified in the attack definition.
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Signature attack objects use a stateful attack signature (a pattern that always exists within a specific section
of the attack) to detect known attacks. They also include:

• The protocol or service used to perpetrate the attack and the context in which the attack occurs.

• The properties that are specific to signature attacks—attack context, attack direction, attack pattern,
and protocol-specific parameters (TCP, UDP, ICMP, or IP header fields).

Signatures can produce false positives, because certain normal network activity can be construed as
malicious. For example, some network applications or operating systems send out numerous ICMPmessages,
which a signature-based detection system might interpret as an attempt by an attacker to map out a
network segment. You canminimize false positives by editing your signature parameters (to fine-tune your
signatures).

You can create, filter, modify, or delete IPS signatures on the IPS Policy Signatures page in Security Director.
You can download and install the signature database to security devices. You can automate the download
and install process by scheduling the download and install tasks and configuring these tasks to recur at
specific time intervals. This ensures that your signature database is current.
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Creating IPS Signatures

Use the Create IPS Signature page to monitor and prevent intrusions. The intrusion prevention system
(IPS) compares traffic against signatures of known threats and blocks traffic when a threat is detected.

The signature database is one of the major components of IPS. It contains definitions of different objects,
such as attack objects, application signature objects, and service objects, which are used in defining IPS
policy rules. There are more than 8,500 signatures for identifying anomalies, attacks, spyware, and
applications.

To keep IPS policies organized and manageable, attack objects can be grouped. An attack object group
can contain one or more types of attack objects. Junos OS supports the following three types of attack
groups:

• IPS signature—Contains objects present in the signature database.
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• Dynamic—Contains attack objects based on certain matching criteria.

• Static—Contains customer-defined attack groups and can be configured through the CLI.

Before You Begin

• Read the “Understanding IPS Signatures” on page 675 topic

• Have a basic understanding of what attacks and patterns are.

• Review the IPS policy signaturesmain page for an understanding of your current data set. See “IPS Policy
Signatures Main Page Fields” on page 694 for field descriptions.

To configure an IPS signature:

1. Select Configure > IPS Policy > Signatures.

2. Click Create.

3. Select IPS Signature.

4. Complete the configuration according to the guidelines provided in the Table 220 on page 677.

5. Click OK.

A new IPS signature with the predefined configurations is created. You can use this signature in IPS policies.

Table 220: IPS Signatures Settings

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores. No
spaces are allowed and the maximum length is 63 characters.

Name

Enter a description for the IPS signature; maximum length is 1024 characters.Description

Enter a predefined or a new category. Use this category to group the attack objects. Within each
category, attack objects are grouped by severity. For example: FTP, TROJAN, SNMP.

Category
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Table 220: IPS Signatures Settings (continued)

GuidelinesSettings

Select an action you want IPS signature to take when the monitored traffic matches the attack
objects specified in the rules:

• None—No action is taken. Use this action to only generate logs for some traffic.

• Close Client & Server—Closes the connection and sends an RST packet to both the client and the
server.

• Close Client—Closes the connection and sends an RST packet to the client but not to the server.

• Close Server—Closes the connection and sends an RST packet to the server but not to the client.

• Ignore—Stops scanning traffic for the rest of the connection if an attack match is found. IPS
disables the rulebase for the specific connection.

• Drop—Drops all packets associated with the connection, preventing traffic for the connection
from reaching its destination. Use this action to drop connections for traffic that is not prone to
spoofing.

• Drop Packet—Drops a matching packet before it can reach its destination but does not close the
connection. Use this action to drop packets for attacks in traffic that is prone to spoofing, such
as UDP traffic. Dropping a connection for such traffic could result in a denial of service that
prevents you from receiving traffic from a legitimate source-IP address.

Action

Enter unique identifiers that can be used to search and sort log records. Keywords should related
to the attack and the attack object. For example, Amanda Amindexd Remote Overflow.

Keywords

Select a severity level for the attack that the signature will report:

• Critical—Contains attack objects matching exploits that attempt to evade detection, cause a
network device to crash, or gain system-level privileges.

• Info—Contains attack objects matching normal, harmless traffic containing URLs, DNS lookup
failures, SNMP public community strings, and peer-to-peer (P2P) parameters. You can use
informational attack objects to obtain information about your network.

• Major—Contains attack objects matching exploits that attempt to disrupt a service, gain user-level
access to a network device, or activate a Trojan horse previously loaded on a device.

• Minor—Contains attack objects matching exploits that detect reconnaissance efforts attempting
to access vital information through directory traversal or information leaks.

• Warning—Contains attack objects matching exploits that attempt to obtain noncritical information
or scan a network with a scanning tool.

The most dangerous level is critical, which attempts to crash your server or gain control of your
network. Informational is the least dangerous level and is used by network administrators to discover
holes in their security systems.

Severity

Signature Details
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Table 220: IPS Signatures Settings (continued)

GuidelinesSettings

Select an option to detect the service or protocol that the attack uses to enter your network:

• IP—Allows IPS to match the signature for a specified IP protocol type.

• ICMP—Allows IPS to match the signature for a specified ICMP ID.

• TCP—Allows IPS to match the signature for specified TCP port(s).

• UDP—Allows IPS to match the signature for specified UDP port(s).

• RPC—Allows IPS to match the signature for a specified remote procedure call (RPC) program
number. The RPC protocol is used by distributed processing applications to handle interaction
between processes remotely.

• Service—Allows IPS to match the signature for a specified service.

• IPv6 or ICMPv6—Specifies the header match information for the signature attack. You can specify
that IPS search a packet for a pattern match for IPv6 and ICMPv6 header information.

Binding

Enter the name of the network protocol. For example: IGMP, IP-IP.Protocol

Enter the type of IP protocol for the header that immediately follows the IPv6 header.

For example, if the device performs IPsec on exchanged packets, the Next Header value is probably
50 (ESP extension header) or 51 (AH extension header).

Next Header

Enter the port ranges for TCP and UDP protocol types.Port Range(s)

Enter the program ID for the RPC protocol.Program
Number

Specify the service that the attack uses to enter your network. You can select the specific service
used to perpetrate the attack as the service binding.

For example, suppose you select the DISCARD service. Discard protocol is an Application Layer
protocol where TCP/9, UDP/9 describes the process for discarding TCP or UDP data sent to port
9.

Service

Select the scope within which the count of an attack occurs:

• Source IP—Detect attacks from the source address for the specified number of times, regardless
of the destination address.

• Dest IP—Detect attacks sent to the destination address for the specified number of times, regardless
of the source address.

• Peer—Detect attacks between source and destination IP addresses of the sessions for the specified
number of times.

Time Scope
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Table 220: IPS Signatures Settings (continued)

GuidelinesSettings

Specify the number of times that the attack object must detect an attack within the specified scope
before the device considers the attack object to match the attack.

The range is from 0 through 4,294,967,295.

Time Count

Specify this filter to track attack objects based on the frequency that the attack produces a false
positive on your network.

Select an option:

• High—Provides information on the frequently tracked false positive occurrences.

• Medium—Provides information on the occasionally tracked false positive occurrences.

• Low—Provides information on the rarely tracked false positive occurrences.

Match
Assurance

Specify this filter to filter out slow-performing attack objects. You can use this filter to only select
the appropriate attacks based on performance impacts.

Select an option:

• High—Add a high performance impact attack object that is vulnerable to an attack. The performance
impact of signatures is high7 to high9, where the application identification is slow.

• Medium—Add a medium performance impact attack object that is vulnerable to an attack. The
performance impact of signatures is medium4 to medium6, where the application identification
is normal.

• Low—Add a low performance impact attack object that is vulnerable to an attack. The performance
impact of signatures is low1 to low3, where the application identification is faster.

• Unknown—Set all attack objects to unknown by default. As you fine-tune IPS to your network
traffic, you can change this setting to help you track performance impact. The performance impact
of signatures is 0 = unknown, where the application identification is also unknown.

Performance
Impact

Enter a Boolean expression of attack members used to identify the way attack members should be
matched.

For example: m01 AND m02, where m01, m02 are the attack members.

Expression

Specify if the attack is matched within a session or across transactions in a session:

• session—Allows multiple matches for the object within the same session.

• transaction—Matches the object across multiple transactions that occur within the same session.

Scope

Enable this option to generate a new log each time an attack is detected within the same session.
If this option is not selected, then the attack is logged only once per session.

Reset

680



Table 220: IPS Signatures Settings (continued)

GuidelinesSettings

Enable this option to create a compound attack object that must match each member signature or
protocol anomaly in the order you specify. If you do not specify an order, the compound attack
object still must match all members, but the pattern or protocol anomalies can appear in the attack
in any order.

A compound attack object detects attacks that use multiple methods to exploit a vulnerability.

Ordered

Add Signature

Select an option to define the location of the signature.

If you know the service and the specific service context, specify that service and then specify the
appropriate service contexts.

If you know the service, but are unsure of the specific service context, specify one of the general
contexts.

For example: line—Specify this context to detect a pattern match within a specific line within your
network traffic.

Context

Specify the connection direction of the attack:

• Client to Server—Detects the attack only in client-to-server traffic.

• Server to Client—Detects the attack only in server-to-client traffic.

• Any—Detects the attack in either direction.

Using a single direction (instead of Any) improves performance, reduces false positives, and increases
detection accuracy.

Direction

Enter a signature pattern of the attack youwant to detect. A signature is a pattern that always exists
within an attack; if the attack is present, so is the signature.

To create the attack pattern, youmust first analyze the attack to detect a pattern (such as a segment
of code, a URL, or a value in a packet header), and then create a syntactical expression that represents
that pattern.

For example: Use \[<character-set>\] for case-insensitive matches.

Pattern

Enter a regular expression to define rules tomatchmalicious or unwanted behavior over the network.

For example: For the syntax \[hello\], the expected pattern is hello, which is case sensitive.

The example matches can be: hElLo, HEllO, and heLLO.

Regex
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Table 220: IPS Signatures Settings (continued)

GuidelinesSettings

Select this option to exclude the specified pattern from being matched.

Negating a pattern means that the attack is considered matched if the pattern defined in the attack
does not match the specified pattern.

Negated

Add Anomaly

Select an option to detect abnormal or ambiguous messages within a connection according to the
set of rules for the particular protocol being used.

Protocol anomaly detectionworks by finding deviations from protocol standards, most often defined
by RFCs and common RFC extensions.

Anomaly

Specify the connection direction of the attack:

• Client to Server—Detects the attack only in client-to-server traffic.

• Server to Client—Detects the attack only in server-to-client traffic.

• Any—Detects the attack in either direction.

Using a single direction (instead of Any) improves performance, reduces false positives, and increases
detection accuracy.

Direction

Click the SupportedDetectors link to display a table that shows the device platforms and the version
number of the IPS protocol detector currently running on the device.

For example:

• Platform - SRX550

• Detector Version - 9.1.140080400

Supported
Detectors
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Creating IPS Signature Static Groups

Use the IPS Signature Static Group page to configure a specific, finite set of attack objects or groups.

Static groups require more maintenance than dynamic groups because you must manually add or remove
attack objects in a static group to change its members.

Use an IPS signature static group for the following tasks:

• Group your custom attack objects.

• Dynamic—Contains attack objects based on certain matching criteria.

• Static—Contains customer-defined attack groups and can be configured through the CLI.

Before You Begin

• Read the “Understanding IPS Signatures” on page 675 topic.

• Have a basic understanding of what attacks are.

• Read the Creating IPS Signatures topic. See “Creating IPS Signatures” on page 676.

• Review the IPS signatures main page for an understanding of your current data set. See “IPS Policy
Signatures Main Page Fields” on page 694 for field descriptions.

To configure an IPS signature static group:

1. Select Configure > IPS Policy > Signatures.

2. Click Create.

3. Select Static Group.

4. Complete the configuration according to the guidelines provided in the Table 221 on page 683.

5. Click OK.

A new IPS signature static group with the predefined configurations is created. You can use this signature
in IPS policies.

Table 221: IPS Signature Static Group Settings

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores.
No spaces are allowed and the maximum length is 63 characters.

Name
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Table 221: IPS Signature Static Group Settings (continued)

GuidelinesSettings

Add or delete group members of a static group.

Groupmembers include custom groupswhosemembers are predefined attacks, predefined
attack groups, custom attacks, or custom dynamic groups.

A custom group defines:

• A specific set of critical attack objects that you know your network is vulnerable against.

• A specific set of informational attack objects that you need to stay aware of events on
your network.

Group Members

Add IPS Signatures

Select one or more available IPS signatures to include in a static group.IPS Signatures

RELATED DOCUMENTATION

Understanding IPS Signatures | 675

Creating IPS Signatures | 676

Creating IPS Signature Dynamic Groups | 684
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Creating IPS Signature Dynamic Groups

Use the IPS Signature Dynamic Group page to configure attack objects based on a certain matching criteria.
Dynamic group members can be either predefined or custom attack objects. During a signature update,
the dynamic group membership is automatically updated based on the matching criteria for that group.
For example, you can dynamically group the attacks related to a specific application using the dynamic
attack group filters.

NOTE: A dynamic group cannot contain another group (predefined, static, or dynamic). However,
you can include a dynamic group as a member of a static group.
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You use dynamic groups so that an attack database update automatically populates the groupwith relevant
members. This eliminates the need to review each new signature to determine if you need to use it in your
existing security policy.

Before You Begin

• Read the “Understanding IPS Signatures” on page 675 topic.

• Have a basic understanding of what attacks and patterns are.

• Read the Creating IPS Signatures topic. See “Creating IPS Signatures” on page 676.

• Review the IPS signatures main page for an understanding of your current data set. See “IPS Policy
Signatures Main Page Fields” on page 694 for field descriptions.

To configure an IPS signature dynamic group:

1. Select Configure > IPS Policy > Signatures.

2. Click Create.

3. Select Dynamic Group.

4. Complete the configuration according to the guidelines provided in the Table 222 on page 685.

5. Click OK.

A new IPS signature dynamic groupwith the predefined configurations is created. You can use this signature
in IPS policies.

Table 222: IPS Signature Dynamic Group Settings

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores. No
spaces are allowed and the maximum length is 63 characters.

Name
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Table 222: IPS Signature Dynamic Group Settings (continued)

GuidelinesSettings

Specify a severity filter to add attack objects based on attack severity levels.

Select an option:

• Info—Provides information about activity on the network, such as applications that are running,
potential vulnerable software, and best practice violations. Generally, information attacks are not
malicious activity.

• Major—Provides information of attacks that try to gain user level access to a system to crash a
particular service or application.

• Critical—Provides information of attacks that try to gain root level access to a system to crash the
entire system.

• Minor—Provides information of attacks that try to perform information leakage techniques,
including those that exploit vulnerabilities to reveal information about the target.

• Warning—Issues a warning when attack matches. Warning attacks are attacks that are suspicious
in nature, such as scans and other reconnaissance attempts.

Severity

Select one or more available services to include in a dynamic group.Service

Select one or more available categories to include in a dynamic group.Category

Specify this filter to add recommended Juniper Networks predefined attack objects to the dynamic
group, or specify non-recommended attack objects to the dynamic attack group.

Specify an option:

• Yes—Adds predefined attacks recommended by Juniper Networks to the dynamic group.

• No—Specifies non-recommended attack objects in the dynamic attack group.

Recommended

Specify this filter to add predefined attacks to the dynamic group based on the direction specified
in the attacks.

Select an option:

• Any—Monitors traffic from client-to-server or server-to-client.

• CTS—Monitors traffic from client-to-server only. Most attacks occur over client-to-server
connections.

• STC—Monitors traffic from server-to-client only.

• Expression—Matches the expression with member name patterns using Boolean operators. A
member name is the name of an attack member in an IPS attack:

• AND—If both member name patterns match, the expression matches.

• OR—If either of the member name patterns match, the expression matches.
For SRX Series devices, expression and order cannot be configured together. Only one of them
can be specified. For example: m01 AND m02, where m01, m02 are the attack members.

Direction
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Table 222: IPS Signature Dynamic Group Settings (continued)

GuidelinesSettings

Specify this filter to filter out slow-performing attack objects. You can use this filter to only select
the appropriate attacks based on performance impacts.

Select an option:

• High—Add a high performance impact attack object that is vulnerable to an attack. The performance
impact of signatures is high7 to high9, where the application identification is slow.

• Medium—Add a medium performance impact attack object that is vulnerable to an attack. The
performance impact of signatures is medium4 to medium6, where the application identification
is normal.

• Low—Add a low performance impact attack object that is vulnerable to an attack. The performance
impact of signatures is low1 to low3, where the application identification is faster.

• Unknown—Set all attack objects to unknown by default. As you fine-tune IPS to your network
traffic, you can change this setting to help you track performance impact. The performance impact
of signatures is 0 = unknown, where the application identification is also unknown.

Performance
Impact

Specify this filter to track attack objects based on the frequency that the attack produces a false
positive on your network.

Select an option:

• High—Add a high performance impact attack object that is vulnerable to an attack. The performance
impact of signatures is high7 to high9, where the application identification is slow.

• Medium—Add a medium performance impact attack object that is vulnerable to an attack. The
performance impact of signatures is medium4 to medium6, where the application identification
is normal.

• Low—Add a low performance impact attack object that is vulnerable to an attack. The performance
impact of signatures is low1 to low3, where the application identification is faster.

• Unknown—Set all attack objects to unknown by default. As you fine-tune IPS to your network
traffic, you can change this setting to help you track performance impact. The performance impact
of signatures is 0 = unknown, where the application identification is also unknown.

False Positives
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Table 222: IPS Signature Dynamic Group Settings (continued)

GuidelinesSettings

Specify this filter to group attack objects by type (anomaly or signature).

Select an option:

• Protocol Anomaly—Detects unknown or sophisticated attacks that violate protocol specifications
(RFCs and common RFC extensions). You cannot create new protocol anomalies, but you can
configure a new attack object that controls how your device handles a predefined protocol anomaly
when detected.

• Signature—Detects known attacks using stateful attack signatures. A stateful attack signature is
a pattern that always exists within a specific section of the attack. Stateful signature attack objects
also include the protocol or service used to perpetrate the attack and the context in which the
attack occurs.

Object Type

Specify this filter to add attack objects based on the application that is vulnerable to the attack.

• Product Type—Specify this filter to include signatures belonging to the selected product type.

NOTE: Starting in Junos OS Release 18.2 onward, only the product type value All is supported.
Therefore, all vendor names are displayed in the drop-down.

For Junos OS Release 18.1 and earlier, you can select a value for the product type and
corresponding vendor name is displayed in the drop-down.

• Vendor Name—Select the name of the vendor for the dynamic signature. For example: Juniper
Networks.

• Title/Product Name—Specify this filter to include signatures belonging to the selected product
name. The product names are populated only when you select a product type and a vendor.

Vendor
Description
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Table 222: IPS Signature Dynamic Group Settings (continued)

GuidelinesSettings

Specify the Common Vulnerability Scoring System (CVSS) to be used as a filter criteria to include
IPS signatures as part of the dynamic group.

• Less-than—Select the Enable check box if the CVSS score of the attack must be less than the
value you specified.

Select the CVSS score as a filter criterion to include IPS signatures as a part of the dynamic group.
The range is 0 through 10.

• Greater-than—Select the Enable check box if the CVSS score of the attack must be greater than
the value you specified.

Select the CVSS score as a filter criterion to include IPS signatures as a part of the dynamic group.
The range is 0 through 10.

NOTE: CVSS-Score is supported on devices running Junos OS Release 18.2 onward. If you try to
publish IPS policy on devices running Junos OS Release 18.1 or earlier, then publish will fail.

The CVSS is an open framework, which is used to rate the severity and risk of computer system
security.

Scores range from 0 to 10, with 10 being the most severe. The CVSS assessment measures three
areas of concern:

• Base Metrics for qualities intrinsic to a vulnerability

• Temporal Metrics for characteristics that evolve over the lifetime of vulnerability

• Environmental Metrics for vulnerabilities that depend on a particular implementation or
environment

A numerical score is generated for each of these metric groups.

CVSS-Score

• Select the Enable check box if the age of attack (in years) in the signature must be less than the
value you specified.

Select the age of the attack as a filter criterion to include IPS signatures as a part of the dynamic
group. The range is 1 through 100.

• Select the Enable check box if the age of attack (in years) in the signature must be greater than
the value you specified.

Select the age of the attack as a filter criterion to include IPS signatures as part of the dynamic
group. The range is 1 through 100.

NOTE: Age of attack is supported on devices running Junos OS Release 18.2 onward. If you try to
publish IPS policy on devices running Junos OS Release 18.1 or earlier, then publish will fail.

Age of attack
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Table 222: IPS Signature Dynamic Group Settings (continued)

GuidelinesSettings

Select the file type of the attack as a filter criterion; for example, PDF.

NOTE: File Type is supported on devices running Junos OS Release 18.2 onward. If you try to
publish IPS policy on devices running Junos OS Release 18.1 or earlier, then publish will fail.

File Type

Select the vulnerability type of the attack as a filter criterion; for example, overflow.

NOTE: Vulnerability Type is supported on devices running Junos OS Release 18.2 onward. If you
try to publish IPS policy on devices running Junos OS Release 18.1 or earlier, then publish will fail.

Vulnerabilities are the intersection of three elements: a system susceptibility or flaw, attacker access
to the flaw, and attacker capability to exploit the flaw. Using vulnerability type, you can perform
vulnerability scanning. Vulnerability scanning is an inspection of the potential points of exploit on
a network to identify security issues. A vulnerability scan detects and classifies system weaknesses
in a networks and predicts the effectiveness of countermeasures.

Vulnerability
Type
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Edit and Clone Policies and Objects
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You can edit or clone policies and objects from the policies and shared objects main page.
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NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Edit Policies or Objects

To edit a policy or a shared objects:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to edit, and then click the pencil icon.

The Edit window appears, showing the same options as when creating a new policy or object.

3. Click OK to save your changes.

NOTE: After the published firewall policy rules are edited and saved, you see an icon next to
the check box for each saved policy rule on the Firewall Policies page. When you hover over the
icon, a message appears, indicating that the policy was edited and needs to be pushed to the
device. For updating the policy, see “Updating Policies on Devices” on page 478.

Clone Policies or Objects

To clone a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to clone, or select Clone from the More list.

The Clone window appears with editable fields.

3. Click OK to save your changes.

RELATED DOCUMENTATION

691



Creating IPS Signatures | 676

Delete and Replace Policies and Objects

IN THIS SECTION

Delete Policies and Objects | 692

Replace Policies and Objects | 692

You can delete or replace policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Delete Policies and Objects

To delete a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to delete, and then select the minus sign (-).

An alert message appears verifying that you want to delete your selection.

3. Click Yes to delete your selection.

Replace Policies and Objects

You can select one or more shared objects and replace them with other objects of the same type.

To replace one or more object:

1. Select Configure > Shared Objects > Addresses, Services, or Variables.

The addresses, services, or variables page appears.
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2. Right-click the shared object that you want to replace, or click Replace from the More list.

You can replace a single object or multiple objects. If the selected object is used in any policy, a warning
message appears before they are replaced.

3. Click Yes to continue the replacement operation.

RELATED DOCUMENTATION

Creating IPS Signatures | 676

Viewing Policy and Shared Object Details

On a policy or a shared object landing page, you can get a detailed view of the existing policies or objects.
The Detail View page lists all the configured parameters of a policy or an object. The Landing page of a
policy or shared object lists only some of the configured parameters and not all. The Detail View option
helps you to get a consolidated view of all the configured parameters.

NOTE: The detailed view is in read-only mode; you cannot edit any fields.

To see a detailed view of the policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to see the detailed view for, or selectDetail View
from the More list.

The Detail View page appears showing the configuration information, the user who created that
particular policy or shared object, and the last updated information.

You can also get a detailed view by hovering over the name and clicking the Detailed View icon before
the policy or shared object name.

RELATED DOCUMENTATION
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Creating IPS Policies | 640

Creating NAT Policies | 707

IPS Policy Signatures Main Page Fields

Use the IPS Policy Signatures main page to get an overall, high-level view of your IPS signature settings.
You can filter and sort this information to get a better understanding of what you want to configure.
Table 223 on page 694 describes the fields on this page.

Table 223: IPS Policy Signatures Main Page Fields

DescriptionField

Name of the IPS signature.Name

Age of the attack (in years) to be used as a filter criteria to include IPS signatures as
part of the dynamic group.

Age of attack

CommonVulnerability Scoring System (CVSS) to be used as a filter criteria to include
IPS signatures as part of the dynamic group.

CVSS-Score

File type of the attack to be used as a filter criteria; for example, flash.File Type

Vulnerability type of the attack to be used as a filter criteria; for example, overflow.Vulnerability Type

Severity level of the attack that the signature will report.Severity

Category of the attack objects.Category

Objects that are used in defining IDP policy rules.Object Type

Predefined attacks recommended by Juniper Networks to the dynamic group.Recommended

An IPS signature action takenwhen themonitored traffic matches the attack objects
specified in the rules.

Action

Detected known attack patterns and protocol anomalies within the network traffic.Pre-defined/Custom

Domain name of security device. This information is auto-populated once you select
the device. For example: global, system.

Domain
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CHAPTER 65

IPS Policy-Templates

IN THIS CHAPTER
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Delete and Replace Policies and Objects | 699

IPS Policy Templates Main Page Fields | 700

Understanding IPS Policy Templates

Juniper Networks provides predefined policy templates that you can use as a starting point for creating
your own policies. Each policy template contains rules that use the default actions associated with the
attack objects. You can customize these templates to work on your network by selecting your own source
and destination addresses and choosing intrusion prevention system (IPS) actions that reflect your security
needs. You can modify the template either by using the Advance option in the IPS Policy page or cloning
the template.

IPS policies are collections of rules and rulebases. An IPS policy supports two types of rulebases—IPS
rulebase and exempt rulebase. A rulebase is an ordered set of rules that use a specific detection method
to identify and prevent attacks. When a rule is matched, it means that an attack has been detected in the
network traffic, triggering the action for that rule. The IPS system performs the specified action and protects
your network from that attack. Each rulebase can have multiple rules—you determine the sequence in
which rules are applied to network traffic by placing them in the desired order. Each rulebase in the IPS
system uses specific detection methods to identify and prevent attacks. For more information on the IPS
policy rulebases, see “Understanding IPS Policies” on page 637.
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Creating IPS Policy Templates

Use the IPS Policy Templates page to configure intrusion prevention system (IPS) policy templates. Juniper
Networks provides predefined policy templates that you can use as a guideline for creating policies. Each
template is set of rules of a specific rulebase type. You canmodify the template either by using the Advance
option in the IPS Policy page or cloning the template. This approach allows you to make changes to the
policy and to avoid future issues due to changes in the policy templates.

Before You Begin

• Read the “Understanding IPS Policy Templates” on page 696 topic.

• Read the “Understanding IPS Policies” on page 637 topic.

• Configure network interfaces.

• Review the IPS policy template main page for an understanding of your current data set. See “IPS Policy
Templates Main Page Fields” on page 700 for field descriptions.

To configure an IPS policy template:

1. Select Configure > IPS Policy > Policy Template.

2. Click Create.

3. Complete the configuration according to the guidelines provided in the Table 224 on page 697.

4. Click OK.

A new IPS policy template with your configurations is created. After you create the policy template, add
rules in one or more rulebases to select that policy template as the active policy template on your policy.
See “Creating IPS Policy Rules” on page 642. You can use this policy template in IPS policies. To enable the
IPS policy, apply it to a domain; see “Assigning Policies and Profiles to Domains” on page 668.

Table 224: IPS Policy Template Settings

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons, periods, dashes, and
underscores. No spaces are allowed and the maximum length is 63 characters.

Name

Enter a description for the policy template; maximum length is 1024 characters.Description
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RELATED DOCUMENTATION

Understanding IPS Policy Templates | 696

Edit and Clone Policies and Objects

IN THIS SECTION

Edit Policies or Objects | 698

Clone Policies or Objects | 699

You can edit or clone policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Edit Policies or Objects

To edit a policy or a shared objects:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to edit, and then click the pencil icon.

The Edit window appears, showing the same options as when creating a new policy or object.

3. Click OK to save your changes.

NOTE: After the published firewall policy rules are edited and saved, you see an icon next to
the check box for each saved policy rule on the Firewall Policies page. When you hover over the
icon, a message appears, indicating that the policy was edited and needs to be pushed to the
device. For updating the policy, see “Updating Policies on Devices” on page 478.
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Clone Policies or Objects

To clone a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to clone, or select Clone from the More list.

The Clone window appears with editable fields.

3. Click OK to save your changes.

RELATED DOCUMENTATION

Creating IPS Policy Templates | 697

Delete and Replace Policies and Objects

IN THIS SECTION

Delete Policies and Objects | 699

Replace Policies and Objects | 700

You can delete or replace policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Delete Policies and Objects

To delete a policy or a shared object:

1. Select Configure > Policies or Shared Objects.
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The policies or shared objects page appears.

2. Select the policy or shared object that you want to delete, and then select the minus sign (-).

An alert message appears verifying that you want to delete your selection.

3. Click Yes to delete your selection.

Replace Policies and Objects

You can select one or more shared objects and replace them with other objects of the same type.

To replace one or more object:

1. Select Configure > Shared Objects > Addresses, Services, or Variables.

The addresses, services, or variables page appears.

2. Right-click the shared object that you want to replace, or click Replace from the More list.

You can replace a single object or multiple objects. If the selected object is used in any policy, a warning
message appears before they are replaced.

3. Click Yes to continue the replacement operation.

RELATED DOCUMENTATION

Creating IPS Policy Templates | 697

IPS Policy Templates Main Page Fields

Use the IPS Policy Templates main page to get an overall, high-level view of your policy template settings.
You can filter and sort this information to get a better understanding of what you want to configure.
Table 225 on page 700 describes the fields on this page.

Table 225: IPS Policy Templates Main Page Fields

DescriptionField

Name of the IPS policy template.Name

Total number of rules created for an IPS policy template.No. of Rules
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Table 225: IPS Policy Templates Main Page Fields (continued)

DescriptionField

Description of the IPS policy template.Description

Domain name of security device, which is autopopulated once you select the device.
For example: global, system.

Domain

RELATED DOCUMENTATION

Creating IPS Policy Templates | 697

Understanding IPS Policy Templates | 696
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NAT Policy-Policies
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NAT Overview

Network Address Translation (NAT) is a form of network masquerading where you can hide devices
between the zones or interfaces. A trust zone is a segment of the network where security measures are
applied. It is usually assigned to the internal LAN. An untrust zone is the Internet. NAT modifies the IP
addresses of the packets moving between the trust and untrust zones.

Whenever a packet arrives at the NAT device, the device performs a translation on the packet’s IP address
by rewriting it with an IP address that was specified for external use. After translation, the packet appears
to have originated from the gateway rather than from the original device within the network. This helps
you hide internal IP addresses from the other networks and keep your network secure.

Using NAT also allows you to usemore internal IP addresses. Because these IP addresses are hidden, there
is no risk of conflict with an IP address from a different network. This helps you conserve IP addresses.

Junos Space Security Director supports three types of NAT:

• Source NAT--Translates the source IP address of a packet leaving the trust zone (outbound traffic). It
translates the traffic originating from the device in the trust zone. Using source NAT, an internal device
can access the network by using the IP addresses specified in the NAT policy. The following use cases
are supported with IPv6 NAT:

• Translation from one IPv6 subnet to another IPv6 subnet without Port Address Translation (PAT)

• Translation from IPv4 addresses to IPv6 prefixes along with IPv4 address translation

• Translation from IPv6 host(s) to IPv6 host(s) with or without PAT

• Translation from IPv6 host(s) to IPv4 host(s) with or without PAT

• Translation from IPv4 host(s) to IPv6 host(s) with or without PAT

• Destination NAT--Translates the destination IP address of a packet entering the trust zone (inbound
traffic). It translates the traffic originating from a device outside the trust zone. Using destination NAT,
an external device can send packets to a hidden internal device. The following use cases are supported
with IPv6 NAT:

• Mapping of one IPv6 subnet to another IPv6 subnet

• Mapping between one IPv6 host and another IPv6 host

• Mapping of one IPv6 host (and optional port number) to another special IPv6 host (and optional port
number)

• Mapping of one IPv6 host (and optional port number) to another special IPv4 host (and optional port
number)

• Mapping of one IPv4 host (and optional port number) to another special IPv6 host (and optional port
number)
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• Static NAT-- Always translates a private IP address to the same public IP address. It translates traffic
from both sides of the network (both source and destination). For example, a webserver with a private
IP address can access the Internet using a static, one-to-one address translation. The following use cases
are supported with IPv6 NAT:

• Mapping of one IPv6 subnet to another IPv6 subnet

• Mapping between one IPv6 host and another IPv6 host

• Mapping between IPv4 address a.b.c.d and IPv6 address Prefix::a.b.c.d

• Mapping between IPv4 host(s) and IPv6 host(s)

• Mapping between IPv6 host(s) and IPv4 host(s)

Table 1 shows the persistent NAT support for different source NAT and destination NAT addresses.

Table 226: Persistent NAT Support

Persistent NAT

Destination NAT

AddressTranslated AddressSource NAT Address

NoIPv4IPv6IPv4

NoIPv6IPv6IPv4

YesIPv4IPv4IPv6

NoIPv6IPv6IPv6

Table 2 and Table 3 show the translated address pool selection for source NAT, destination NAT, and
static NAT addresses.

Table 227: Translated Address Pool Selection for Source NAT

Pool AddressDestination AddressSource NAT Address

IPv4IPv4IPv4

IPv6IPv6 - Subnet must be greater than 96IPv4

IPv4IPv4IPv6

IPv6IPv6IPv6
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Table 228: Translated Address Pool Selection for Destination NAT And Static NAT

Pool AddressDestination AddressSource NAT Address

IPv4 or IPv6IPv4IPv4

IPv4 or IPv6IPv6 - Subnet must be greater than 96IPv4

IPv4IPv4IPv6

IPv4 or IPv6IPv6IPv6

• For source NAT, the proxy NDP is available for NAT pool addresses. For destination NAT and static
NAT, the proxy NDP is available for destination NAT addresses.

• A NAT pool can have a single IPv6 subnet or multiple IPv6 hosts.

• You cannot configure the overflow pool if the address type is IPv6.

• NAT pools permit address entries of only one version type: IPv4 or IPv6.

Junos Space Security Director provides you with a workflowwhere you can create and apply NAT policies
on devices in a network.

Security Director views each logical system or tenant system as any other security device and takes
ownership of the security configuration of the logical system or tenant system. In Security Director, each
logical system or tenant system is managed as a unique security device.

NOTE: If the root logical system is discovered, all other user logical systems inside the device,
will also be discovered.

Because an SRX Series logical system device does not support interface NAT, Security Director also does
not allow interface NAT configuration of logical system. The logical system cannot participate in group
NAT in Security Director. For a device NAT policy, the interface based translation selection and pool with
Overflow Pool as interface are not supported in logical systems. The configuration is validated during the
publishing of the NAT policy to avoid commit failures in the device.

RELATED DOCUMENTATION

Creating NAT Policies | 707
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NAT Global Address Book Overview

IN THIS SECTION

Differences Between Global and Zone-Based Address Books | 706

In Junos OS Release 11.2 and later releases, the address book is moved from the zone level to the device
global level. This permits objects to be used across many zones and avoids inefficient use of resources.
This change also permits nested groups to be configured within the address book, removing redundancy
from repeating address objects.

The Security Director applicationmanages its address book at the global level, assigning objects to devices
that are required to create policies. If the device is capable of using a global address book, Security Director
pushes address objects used in the policies to the device global address book. Nested address group
capability is used in the publish and update feature of Security Director depending on the device capability.

Differences Between Global and Zone-Based Address Books

The global address book is supported in Junos OS Release 11.2 and later releases.

• An address book is not configured within a specific zone; therefore, one address book can be associated
with multiple zones.

• If a global address book is defined, you cannot create zone-based address books.

• By default, there is an address book called global associated with all zones.

• A zone can be attached to only one address book in addition to the global address book, which contains
all zones by default.

• Address name overlaps are possible between the global address book and zone address book. For
example, Security Director will attempt to match an address in the zone-based address book first, and,
if the address is not found, the global address book is checked. Youmust ensure that the correct address
objects are used in the policy.

• NAT rules can use address objects only from the global address book. They cannot use addresses from
user-defined address books.

NOTE: Beginning in JunosOS Release 12.1, zone-based address books are no longer supported.
Devices running Junos OS Release 12.1 or later must use the global address book.
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NOTE: Beginning in Junos OS Release 11.2, NAT rules can use address objects from the global
address book. However, Security Director will still continue to define the NAT address in the
rule itself rather than referring to the global address book.

RELATED DOCUMENTATION

NAT Overview | 703

Creating NAT Policies

Use the Network Address Translation (NAT) policy page to perform basic NAT configuration.

NAT is a form of network masquerading where you can hide devices between zones or interfaces. NAT
modifies the IP addresses of the packets moving between the trust and untrust zones. A trust zone is a
segment of the network where security measures are applied. It is usually assigned to the internal LAN.
An untrust zone is the Internet.

Whenever a packet arrives at a NAT device, the device performs a translation on the IP address of the
packet by rewriting it with an IP address that was specified for external use. After translation, the packet
appears to have originated from the gateway rather than from the original device within the network. This
process hides your internal IP addresses from the other networks and keeps your network secure.

Also, NAT permits you to use more internal IP addresses. Because these IP addresses are hidden, there is
no risk of conflict with an IP address from a different network. This feature helps you conserve IP addresses.

Before You Begin

• Read the “NAT Overview” on page 703 topic.

• Read the “NAT Global Address Book Overview” on page 706 topic.

• Review the NAT policies main page for an understanding of your current data set. See “NAT Policies
Main Page Fields” on page 735 descriptions.

To configure a NAT policy:

1. Select Configure > NAT Policy > Policies.

2. Click the plus sign (+) to create a new NAT policy.
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3. Complete the configuration according to the guidelines provided in Table 229 on page 708.

4. A new NAT policy is created. After you create a NAT policy, add rules in one or more rulebases to
select that policy to be the active policy on your device, see “Creating NAT Rules” on page 712. You can
also assign NAT policy to a domain; see “Assigning Policies and Profiles to Domains” on page 721.

Table 229: NAT Policy Settings

GuidelineSetting

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores.
No spaces are allowed and the maximum length is 255 characters.

Names

Enter a description for the NAT policy; maximum length is 255 characters.Description

Policy Options

Select this option to respond to incoming Address Resolution Protocol (ARP) requests.
ARP translates IPv4 addresses to MAC addresses.

Auto ARP Configuration

Select the type of NAT policy you want to create:

• Group policy

• Device policy

Type

Device Selection

Select the devices on which the group policy will be published. Select these devices from
the Available column and move them to the Selected column.

You can also search for the devices in the search field available in both Available and
Selected columns. You can search these devices by entering the device name, device IP
address, or device tag.

NOTE: During a device assignment for a group policy, only devices from the current and
child domains (with view parent enabled) are listed. Devices in the child domain with view
parent disabled are not listed.

Device Selection

Select the device onwhich the device policywill be published. During a device assignment
for a device policy, only devices from the current domain are listed.

Devices

Policy Sequence

Select an option to place the newly created global policy either before the existing device
policies or after the device policies. Once you select the policy placement for your global
policy, you can choose the sequence number.

Policy Placement
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Table 229: NAT Policy Settings (continued)

GuidelineSetting

Click Select to reorder your NAT policy among the existing device policies.Policy Sequence No.

RELATED DOCUMENTATION

NAT Overview | 703

NAT Global Address Book Overview | 706

Publishing Policies

When you publish rules, the process takes into account the priority and precedence values set on the
policy and the order of rules on the device. Rules are published in the order of their priority groups, with
prerules in the High priority group publishing first, before prerules in theMedium and Low priority groups.

If you change the priority or precedence of a published policy, the policy must be republished for the
changes to take effect. Sometimes, changing priority or precedence in one policy can affect other policies
in the same priority group. However, such policies do not need to be republished in order for their changes
in priority or precedence to take effect for the policies that are implicitly changed by the explicit changes
to the republished policy.

To publish a policy:

1. Select Configure > Policy-Name Policy > Policies.

2. Select the policy that you want to publish and click Publish. The Publish Policy page appears.

3. Select the check boxes next to the devices to which the policy changes will be published.

NOTE: You can search for a specific device on which the policy is published by entering the
search criteria in the search field. You can search the devices by their name and IP address.

4. Select Schedule at a later time if you want to schedule and publish the configuration later.
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5. Select Run now if you want to apply the configuration immediately.

6. Click Publish. The Affected Devices page displays the devices on which the policies will be published.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Creating IPS Policies | 640

Creating NAT Policies | 707

Updating Policies on Devices | 716

NAT Policy Rules Main Page Field

Use this page to get an overall, high-level view of your NAT policy rules settings. Details help you keep
track of the number and order of rules per policy. You can filter and sort this information to get a better
understanding of what you want to view. Table 230 on page 710 describes the fields on this page.

Table 230: NAT Policy Rules Main Page Field

DescriptionField

Unique name for the rule.Name

Type of the NAT rule such as source, destination, or static.NAT Type

Displays the source ingress type, For example: zone, interface, or routing
instance.

Source Ingress

Displays the source address of the NAT policy.Source Address

Displays the source port of the NAT policy.Source Port

Displays the protocol to permit or deny the traffic.Protocol

Displays the destination egress type. For example: zone, interface, or routing
interface.

Destination Egress

Displays the destination address of the policy.Destination Address

Displays the destination port of the policy.Destination Port
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Table 230: NAT Policy Rules Main Page Field (continued)

DescriptionField

Service to permit or deny for the source and destination type NAT rules. This
is supported for devices running Junos OS Release 12.1X47.

Service

Source address translated to an IP address for packet matching.Translated Packet Source

Destination address translated to an IP address for packet matching.Translated Packet Destination

Description of the NAT rule.Description

Starting in Junos Space Security Director Release 16.1, the address, service, and NAT pools objects can
be created, managed, dragged and dropped to the required rules from the NAT policy rules page. From
the Shared Objects list, select Show Addresses, Show Services, or Show Pools to see the required shared
objects. To create a new address, service, or NAT pool, click the plus sign (+). You can also modify, delete,
and manage these objects. You can search for any object by it’s name and IP address in the search field
available in the top right corner.

You can drag more than one object and drop on the respective columns in the policy tabular view. Security
Director ensure that objects are dropped in the supported columns and it does not permit to drop under
any other columns. The drag and drop of objects is supported on the Source Address, Destination Address,
and Service columns. You can drag source or destination NAT pool and drop into source or destination
NAT rule. A single or multiple addresses, services, and NAT pools can be dragged and dropped across
rules. To viewmultiple objects in an address, service, or NAT pool column, click the small horizontal triangle
to expand the columns.

You can drag and drop the shared objects such as addresses and services to the corresponding cells in the
rules grid. You can drag and drop data from source ingress to destination egress and vice versa, source
port to destination port and vice versa, and source address to destination address and vice versa. You can
also drag and drop the port, address, and protocols across the rules in the grid.

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.1, the address, service, and NAT pools
objects can be created, managed, dragged and dropped to the required rules from the NAT
policy rules page.

16.1

RELATED DOCUMENTATION

Creating NAT Rules | 712
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Creating NAT Rules

NAT processing centers on the evaluation of NAT rule sets and rules. A rule set determines the overall
direction of the traffic to be processed. Once a rule set that matches the traffic has been found, each rule
in the rule set is evaluated in order for a match. NAT rules can match on the following packet information:

• Source and destination address

• Source port (for source and static NAT only)

• Destination port

The first rule in the rule set that matches the traffic is used. If a packet matches a rule in a rule set during
session establishment, traffic is processed according to the action specified by that rule.

When you create a newNAT policy, click on theNAT policy name to configure the rules. You can configure
the following types of NAT rules:

• Source

• Static

• Destination

Depending on the type of rule you have chosen, some fields in the rule will not be applicable. In addition
to defining rules between zones and interfaces, you can define NAT rules with virtual routers defined on
the device. These rules can be successfully published and updated on the device.

Before You Begin

• Read the “NAT Overview” on page 703 topic.

• Read the “Creating NAT Policies” on page 707 topic.

To configure a NAT rule:

1. Select Configure > NAT Policies > Policies.

2. Click the NAT policy name.

The Rules page appears.

3. Add a rule by clicking Create. Select the type of rule you want to add (source, static, or destination).

4. Complete the configuration according to the guidelines provided in Table 231 on page 713.

5. Click Save.
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A new NAT rule is configured for a NAT policy.

Table 231: NAT Rules Settings

GuidelineSetting

Displays the sequence number assigned to the NAT rule.Seq.

Select the name of the NAT policy that you want to add a rule to.Name

Select the type of NAT rule:

• Source

• Static

• Destination

NAT Type

Click the Source Ingress field to configure the ingress type.

• Ingress Type—Select an ingress type: zone, interface, or routing instance.

• From the appropriate selector, select the zones, interfaces, or routing instance that you want
to associate the rule to, from the Available column.

For the Routing Instance option, you can select one or more of the available virtual routers on
the device. For the group NAT policy, you will see a consolidated list of all virtual routers on all
devices that the policy is assigned to.

• Click OK.

Source Ingress

Click the Source Address field to assign the source address for the policy, from the Available list.Source Address

Click the Source Port field to configure the source port for the policy.

• Enter a maximum of eight ports and port ranges separated by commas.

• Select the required port set from the Available list.

Create a source port inline by clicking Add New Source Port.

Source Port

Select the protocol from the Available list to permit or deny traffic.Protocol

Click the Destination Egress field to configure the egress type.

• Select an egress type: zone, interface, or routing instance.

• From the appropriate selector, select the zones, interfaces, or routing instance that you want
to associate the rule to, from the Available column.

• Click OK.

Destination
Egress

Click the Destination Address field to assign the destination address for the policy, from the
Available list. Create a destination address inline by clicking Add New Destination Address.

Destination
Address
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Table 231: NAT Rules Settings (continued)

GuidelineSetting

Click the Destination Port field to configure the destination port for the policy.

• Enter a maximum of eight ports and port ranges separated by commas. Devices running Junos
OS Release 12.1X47 and later support multiple ports and ranges, in the same way as Source
ports.

• Select the required port set from the Available list.

Create a destination port inline by clicking Add New Source Port.

Destination Port

Select the service to permit or deny for the source and destination typeNAT rules. This is supported
for devices running Junos OS Release 12.1X47.

Select one of the following options:

• Include Any Service

• Include Specific

Service
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Table 231: NAT Rules Settings (continued)

GuidelineSetting

Click Translated Packet Source.

Select the appropriate source address. This option is available only for the source NAT rule.

You can select the translation type as None, Interface, or Pool.

• None—No translation is required.

• Interface—Enable interface NAT with or without port overloading.

• Pool- IP addresses are used from the NAT pool.

If you select Pool, then select the source NAT pool from where the IP addresses are used for
translation.

If you enable proxy ARP, the switch captures and routes traffic to the intended destination.

Enable the Persistent check box to ensure that all requests from the same internal transport
address are mapped to the same reflexive transport address.

Configure the Persistent NAT type:

• Permit any remote host—All requests from a specific internal IP address and port are mapped
to the same reflexive transport address. (The reflexive transport address is the public IP address
and port created by the NAT device closest to the STUN server.) Any external host can send a
packet to the internal host by sending the packet to the reflexive transport address.

• Permit target host—All requests from a specific internal IP address and port are mapped to the
same reflexive transport address. An external host can send a packet to an internal host by
sending the packet to the reflexive transport address. The internal host must have previously
sent a packet to the external host’s IP address.

• Permit target host port—All requests from a specific internal IP address and port are mapped
to the same reflexive transport address. An external host can send a packet to an internal host
by sending the packet to the reflexive transport address. The internal host must have previously
sent a packet to the external host’s IP address and port.

Select Inactivity timeout. It is the amount of time, in seconds, that the persistent NAT binding
remains in the Juniper Networks device’s memory when all the sessions of the binding entry are
gone. When the configured timeout is reached, the binding is removed from memory. The range
is 60 through 7200 seconds.

Select theMaximum session number. It is themaximumnumber of sessions withwhich a persistent
NAT binding can be associated. For example, if the max-session-number of the persistent NAT
rule is 65,536, then a 65,537th session cannot be established if that session uses the persistent
NAT binding created from the persistent NAT rule. The range is 8 through 65,536. The default is
30 sessions.

Enable address mapping to allow requests from a specific internal IP address to be mapped to the
same reflexive IP address.

Translated
Packet Source
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Table 231: NAT Rules Settings (continued)

GuidelineSetting

Click Translated Packet Destination.

Select the appropriate destination address. This option is available only for the destination NAT
rule.

You can select the translation type as None or Pool.

• None—No translation is required.

• Pool- IP addresses are used from the NAT pool.

If you select Pool, then select the destination pool from where the IP addresses are used for
translation.

Translated
Packet
Destination

Enter a description for the NAT rule; maximum length is 4096 characters.Description

RELATED DOCUMENTATION

Creating NAT Policies | 707

NAT Overview | 703

Updating Policies on Devices

When you publish rules, the process takes into account the priority and precedence values set on the
policy and the order of rules on the device. Rules are published in the order of their priority groups, with
prerules in the High priority group publishing first, before prerules in theMedium and Low priority groups.

If you change the priority or precedence of a published policy, the policy must be republished for the
changes to take effect. Sometimes, changing priority or precedence in one policy can affect other policies
in the same priority group. However, such policies do not need to be republished in order for their changes
in priority or precedence to take effect for the policies that are implicitly changed by the explicit changes
to the republished policy.

To update a policy:

1. Select Configure >Policy-Name Policy > Policies.

2. Select the policy that you want to update and click Update. The Update Policy page appears.
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3. Select the check boxes next to the devices to which the policy changes will be published.

NOTE: You can search for a specific device on which the policy is published by entering the
search criteria in the search field. You can search the devices by their name and IP address.

4. Select Schedule at a later time if you want to schedule and publish the configuration later.

5. Select Run now if you want to apply the configuration immediately.

6. Click Publish. The Affected Devices page displays the devices on which the policies will be published.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Creating IPS Policies | 640

Creating NAT Policies | 707

Publishing Policies | 709

Edit and Clone Policies and Objects

IN THIS SECTION

Edit Policies or Objects | 718

Clone Policies or Objects | 718

You can edit or clone policies and objects from the policies and shared objects main page.
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NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Edit Policies or Objects

To edit a policy or a shared objects:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to edit, and then click the pencil icon.

The Edit window appears, showing the same options as when creating a new policy or object.

3. Click OK to save your changes.

NOTE: After the published firewall policy rules are edited and saved, you see an icon next to
the check box for each saved policy rule on the Firewall Policies page. When you hover over the
icon, a message appears, indicating that the policy was edited and needs to be pushed to the
device. For updating the policy, see “Updating Policies on Devices” on page 478.

Clone Policies or Objects

To clone a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to clone, or select Clone from the More list.

The Clone window appears with editable fields.

3. Click OK to save your changes.

RELATED DOCUMENTATION
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Creating NAT Policies | 707

Delete and Replace Policies and Objects

IN THIS SECTION

Delete Policies and Objects | 719

Replace Policies and Objects | 719

You can delete or replace policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Delete Policies and Objects

To delete a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to delete, and then select the minus sign (-).

An alert message appears verifying that you want to delete your selection.

3. Click Yes to delete your selection.

Replace Policies and Objects

You can select one or more shared objects and replace them with other objects of the same type.

To replace one or more object:

1. Select Configure > Shared Objects > Addresses, Services, or Variables.

The addresses, services, or variables page appears.
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2. Right-click the shared object that you want to replace, or click Replace from the More list.

You can replace a single object or multiple objects. If the selected object is used in any policy, a warning
message appears before they are replaced.

3. Click Yes to continue the replacement operation.

RELATED DOCUMENTATION

Creating NAT Policies | 707

Viewing Policy and Shared Object Details

On a policy or a shared object landing page, you can get a detailed view of the existing policies or objects.
The Detail View page lists all the configured parameters of a policy or an object. The Landing page of a
policy or shared object lists only some of the configured parameters and not all. The Detail View option
helps you to get a consolidated view of all the configured parameters.

NOTE: The detailed view is in read-only mode; you cannot edit any fields.

To see a detailed view of the policy or a shared object:

1. Select Configure >Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to see the detailed view for, or selectDetail View
from the More list.

The Detail View page appears showing the configuration information, the user who created that
particular policy or shared object, and the last updated information.

You can also get a detailed view by hovering over the name and clicking the Detailed View icon before
the policy or shared object name.

RELATED DOCUMENTATION

Creating Firewall Policies | 434
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Creating IPS Policies | 640

Creating NAT Policies | 707

Assigning Policies and Profiles to Domains

You can assign or reassign policies or profiles to different domainswhen it is first configured andwhenever
you want to implement a change. You can assign only one policy or profile at a time. Before assigning a
policy or profile to another domain, Security Director checks for the validity of the move. If the move is
not acceptable, a warning message appears.

To assign a policy or profile to a domain:

1. Select Configure and select the landing page for the type of policy or profile that you are assigning to
a domain.

2. From the landing page, right-click the policy or profile or click More.

A list of actions appears.

3. Select Assign <Policy or Profile> to Domain.

The Assign <Policy or Profile> to Domain page appears.

NOTE: <Policy or Profile> is the name of the policy or profile that you are assigning to a
domain.

4. Select the required items to assign to a domain.

5. Enable this option to ignore warning messages, if any.

6. Click Assign.

A policy or profile is assigned to a domain.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Creating NAT Policies | 707
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Creating IPS Policies | 640

Comparing Policies

Security Director enables you to compare two policies.

To compare any two policies:

1. Select Configure and select the landing page for the type of policy that you want to compare. For
example, Select Firewall Policies.

2. From the landing page, right-click the policy or clickMore.

A list of actions appears.

3. Select Compare Policy to compare with other policies.

The Compare Policy page appears.

4. Select the policy to compare with, and click OK.

The compare result of the two policies are displayed.

RELATED DOCUMENTATION
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Create and Manage Policy Versions

IN THIS SECTION

Create Policy Snapshots | 723

Manage Policy Versions | 724

Roll Back Policy Versions | 724
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Compare Policy Versions | 725

Delete Policy Versions | 725

You create a policy version by taking a snapshot of another policy. You can create versions for all types
of policies including All Devices, Group, Device, and Device exceptions.

The maximum number of versions maintained for any policy is 60. If the maximum limit is reached, you
must delete the unwanted versions before saving a new version. Versioning and rollback are independent
operations for each policy.

For example, if you take a snapshot of a group firewall policy, or roll back to a previous firewall policy
version, it does not change the version for all device policy rules; you must separately version each policy
rule.

Create Policy Snapshots

To create a policy version:

1. Select Configure > NAT Policy > Policies.

2. Select the check box next to the policy for which you are taking a snapshot, and then right-click the
policy or clickMore.

A list of actions appears.

3. SelectManage/Rollback Policy.

The Manage Version page appears.

4. Click Create Snapshot.

The Snapshot Policy page appears.

5. Enter your comments in the Comments field, and click Create to take a snapshot. The Snapshot Policy
window appears, showing the status of the version as it is created.

NOTE: During policy publish, Security Director takes an automatic snapshot of the policy.
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Manage Policy Versions

You can view or manage all available versions of a selected policy. You can perform the following tasks
on the snapshots:

• Roll back to a specific version.

• View the differences between any two versions (including the current version) of the policy

• Delete one or more versions from the system.

Roll Back Policy Versions

To roll back the selected version so it becomes the current version:

1. Select Configure > NAT Policy > Policies.

2. Select the check box next to the policy for which you are rolling back a version, and then right-click
the policy or clickMore.

A list of actions appears.

3. SelectManage/Rollback Policy.

The Manage Version page appears.

4. Select the version that you want to make as the current version, and click Rollback.

The rollback operation replaces all the rules and rule groups of the current version with rules and rule
groups from the selected version. For all the shared objects, Object Conflict Resolution (OCR) is done.
If there are any conflicts between the versioned data and the current objects in the system, the OCR
window is displayed.

5. After finishing any conflict resolution, click Next to view the OCR summary report.

6. Click Finish to replace the current policy with the versioned data. A summary of the snapshot policy is
shown by clicking Snapshot.
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Compare Policy Versions

To compare two different versions of a policy:

1. Select Configure > NAT Policy > Policies.

2. Select the check box next to the policy for which you want to compare versions, and then right-click
the policy or clickMore.

A list of actions appears

3. SelectManage/Rollback Policy.

The Manage Version page appears.

4. Select the versions to be compared, and click Compare. You can only compare two versions at a time.

The Compare Versions page appears.

5. Click Compare to view the results.

A Compare Versions results window appears showing the differences between the selected versions.

The Compare Versions results window has the following sections:

• Policy Property Changes—Shows policy changes for the modified rules.

• Rule Changes—Displays rules that are added, modified, or deleted.

• Column Changes—Shows the differences between the column content for modified rules.

Delete Policy Versions

To delete a policy version:

1. Select Configure > NAT Policy > Policies.

2. Right-click the policy or profile or clickMore.

A list of actions appears.

3. ClickManage/Rollback Policy.

The Manage Version page appears.

4. Select the policy version you want to delete and click Delete.
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A warning message is displayed.

5. Click Yes to confirm the deletion.

The selected policy version is deleted.

RELATED DOCUMENTATION
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Export Policies

IN THIS SECTION

Export a policy to PDF | 726

Export a policy to a ZIP file: | 726

Starting in Security Director Release 16.1, you can export any policies (firewall, IPS, or NAT) in a PDF or
ZIP file from their respective Policies landing page.

Export a policy to PDF

1. Select Configure > NAT Policy > Policies.

The NAT Policies page appears.

2. Right-click the policy you want to export or select Export Policy to PDF from the More menu.

The Export Policy to PDF page appears.

3. Click Export.

The selected policy details are exported into a PDF file.

Export a policy to a ZIP file:

1. Select Configure > NAT Policy > Policies.
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The NAT Policies page appears.

2. Right-click the policy you want to export or select Export Policy to Zip File from the More menu.

The Export Policy page appears.

3. Click Export.

The selected policy details are exported into a ZIP file.

Release History Table

DescriptionRelease

Starting in Security Director Release 16.1, you can export any policies (firewall, IPS, or NAT)
in a PDF or ZIP file from their respective Policies landing page.

16.1

RELATED DOCUMENTATION
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Assigning Devices to Policies

Once you create a group or device policy, you can assign devices to it.

To assign devices to a policy:

1. Select Configure >Policy-Name Policy > Policies.

The Policies landing page appears.

2. Right-click the policy to which you want to assign devices, or select Assign Devices from the More
menu.

The Assign Devices page appears. The Name field shows the name of the selected policy and is not
editable.

3. Select the Show only devices without policy assigned check box.

Only devices that are not assigned to any policy are displayed in the Device Selection section.

4. Select the devices you want to add to the policy from the Available column and click the right arrow
to move these devices to the Selected column.
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NOTE: There is an option to search for devices in the Selected column on the Assign Devices
page. By default, all selected devices are sorted in a list and you can search for devices again,
if required.

5. Click OK to assign the selected devices to the selected policy.

NOTE: If you do not have permission to certain devices, those devices are not visible while
assigning devices to a new or existing policy.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Creating IPS Policies | 640

Creating NAT Policies | 707

Unassigning Devices to Policies

Once you create a device policy, you can remove the assigned device from it. This allows you to add a
preferred device at any time to a device policy. This option is not available for a group policy.

To remove an assigned devices from a device policy:

1. Select Configure >Policy-Name >Policies.

The Policies landing page appears.

2. Select a device policy and then clickMore.

3. Click Unassign Devices

The Unassign Device page appears with a confirmation message.

You can also right-click a policy and select Unassign Devices.

4. Click Yes.

The assigned device is removed for the selected device policy.
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Creating IPS Policies | 640

Creating NAT Policies | 707

Creating Rule Name Template

Rule name template provides a mechanism to control the rule name generation based on the rule name
template. You can use the rule name templates for all types of rules in Firewall, NAT, and IPS policies.

To create a rule name template for policies:

1. Select Configure > Policies.

The Policies page appears.

2. Right-click the policy you want to take a snapshot, or select Rule Name Template Builder from the
More list.

3. The Rule Name Template Builder page appears.

Select the Enable check box to use the rule name template.

4. Select the compliance mode.

a. Strict Mode—Warns the user with an error message.

b. Weak Mode—Warns the user with a warning message.

5. Click the plus sign (+) to add a new template builder name.

You can define a template for a new or cloned rule with the following variables:

• Action

• Constant String

• Custom String

• Date (YYYYMMDD format)

• Date Short

• Egress

• Ingress

• Rule Type
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• Time (HHmmss format)

• Time (HHMM format)

• User ID

6. Click OK to create a new rule name template.

RELATED DOCUMENTATION
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Creating NAT Policies | 707

Viewing and Synchronizing Out-of-Band NAT Policy Changes Manually

IN THIS SECTION

Viewing Out-of-Band NAT Policy Changes | 731

Importing Out-of-Band NAT Policy Changes Manually | 732

Starting in Junos Space Security Director Release 20.1R1, when there is an out-of-bandNAT policy change
in the device, you can see an icon next to the corresponding policy in device-specific and group NAT
policies in Security Director. You can manually synchronize the out-of-band changes for a device-specific
policy, only when the automatic synchronization is disabled.

When you hover over the icon next to the policy, the tooltip indicates the out-of-band changes.

When a device is discovered in Security Director, the Managed Status is displayed as Managed in the
Security Devices page. For manual synchronization of out-of-band policy changes, the managed status of
the device must be SD Changed, Device Changed, or In Sync. You must update the device atleast once
from Security Director. In case of logical system (LSYS) or tenant system (TSYS), root device may show
the status as Device Changed if a policy is assigned to it. Update the root device so that the status is In
Sync.

After you synchronize the policy changes, the policy shows that you’ll need to republish the policy. A
dummy publish and update has to be performed in order to set the managed status as In sync.
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The custom rule group in a policy is not supported. If the policy has a custom rule group, then the custom
rule group is deleted after synchronizing the policy and all the rules are grouped inside device-specific or
predefined rule groups.

NOTE:
• Out-of-band changes are not supported if more than one policy is assigned to a device or if
rules are configured in All Devices Policy Pre/Post policies.

• The out-of-band changes does not support synchronization of duplicate rule-sets in a NAT
policy.

Viewing Out-of-Band NAT Policy Changes

To view out-of-band NAT policy changes:

1. Select Configure > NAT Policy > Policies.

The NAT Policies page appears. An icon is displayed for the policies indicating the out-of-band policy
changes.

2. Right-click the policy or select View Device Policy Changes from the More menu.

The Out of Band Changes page appears.

3. Click View to view the configuration changes for a device in CLI and XML format.

The view configuration page for the device is displayed.

After viewing the changes, you can choose to import or reject the out-of-band changes from the device.

4. Click OK.

NOTE: To reject all the out-of-band changes, select Reject all changes option. The icon next
to the policy will be cleared and the policy changes from the device will not be imported into
Security Director. During the subsequent update from Security Director, the out-of-band
changes will be overwritten in the device.

To import the out-of-band changes to Security Director, see “Importing Out-of-Band NAT
Policy Changes Manually” on page 732.
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Importing Out-of-Band NAT Policy Changes Manually

To import out-of-band NAT policy changes:

1. Select Configure > NAT Policy > Policies.

The NAT Policies page appears. An icon is displayed for the policies indicating the out-of-band policy
changes.

2. Right-click the policy or select View Device Policy Changes from the More menu.

The Out of Band Changes page appears.

3. Select Select Changes from Device to accept the out of band NAT policy changes from a device.

4. Select a device and click OK.

NOTE: In the case of group policy, you can view all the devices where the policy is associated,
but you can select only one device and import the changes. After selecting a device, click
Affected Devices to see all the devices where the policy is assigned.

In case of both, group policy and device specific policy, an icon is seen next to the device(s)
indicating the out-of-band changes.

The Import Device Configuration Changes page appears.

5. Select the NAT policy and click Next.

Objects with conflicts are displayed, if any.

6. Select objects and choose a conflict resolution type. Resolve any conflicts after you verify the
information, if needed.

7. Click Finish.

A summary of the configuration changes is displayed.

You can download the summary report as a ZIP file. The summaryreport.zip file contains the complete
rules report as a PDF.

8. Click OK to complete the import process.

The Job Details page is displayed with status of the import job.

9. Click OK.
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The policies page is displayed with an icon which indicates that the policy was edited and needs
publishing to the device.

10.Click Publish to publish the changes.

During the subsequent update from Security Director, the out-of-band changes will be overwritten in
the device(s).

RELATED DOCUMENTATION

Out-of-Band Changes Overview | 1384

About the Policy Sync Settings Page | 1382

Viewing the Details of a Job in Security Director | 181

Configuring NAT Rule Sets

A rule set determines the overall direction of the traffic to be processed. For example, a rule set can select
traffic from a particular interface or to a specific zone. A rule set can contain multiple rules. Once a rule
set is found that matches specific traffic, each rule in the rule set is evaluated for a match. Each rule in the
rule set further specifies the traffic to be matched and the action to be taken when traffic matches the
rule.

To configure a NAT rule set:

1. Select Configure > NAT Policy > Policies.

The NAT Policies page appears.

2. Right-click the NAT policy you want to take a snapshot, or select Configure Rule Sets from the More
list.

The Configure Rule Sets page appears.

3. Modify the rule set name in the Rule Set column and click OK to save the changes.

RELATED DOCUMENTATION
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Auto Grouping

In NAT policies, the rule group name is the same as the rule set name. The rule set name is a combination
of source ingress and destination egress values. If you modify the value of source ingress or destination
egress and save the changes, the policy rule set name changes and it is pushed to the device. However,
because the rule group is specific to Security Director, the rule group name does not change and the
modified rule is a part of the existing rule group. Starting in Security Director Release 18.3R1, if youmodify
the source ingress and destination egress values, you can rearrange the NAT policy rules, and themodified
policy rules are grouped based on the rule set name.

To group the rules automatically:

1. Select Configure>NAT Policies>Policies.

2. Click a policy.

The corresponding rules page is displayed.

3. Click the Source Ingress and Destination Egress fields and modify the corresponding values.

4. Click Save.

5. Right-click the rule that you want to group, or select Auto Group from the More list.

A message that the policy is modified is displayed.

6. Click OK

A rule group is created based on the corresponding rule set name and the modified rule is moved to
the created rule group.

If a rule group already exists with the new rule set name, new rule group will not be created, instead
modified rule is grouped under the existing rule group.

RELATED DOCUMENTATION
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NAT Policies Main Page Fields

UseNetwork Address Translation (NAT) for modifying or translating network address information in packet
headers. NAT can include the translation of port numbers as well as IP addresses. Table 232 on page 735
describes the fields on this page.

Table 232: NAT Policies Main Page Fields

DescriptionField

Name of the NAT policy.Name

Number of rules assigned to the NAT policy.Number of Rules

Number of devices on which the group or device policies are published.Number of Devices

Displays the publish state of the NAT policy configuration. You can verify your NAT
configurations before updating them to the device.

• Not Published—NAT policy is created but not published.

• Published—Configuration is published to all devices involved in the policy.

• Partially Published—Configuration is published to only fewer devices involved in the
NAT policy.

• Re-publish Required—Modifications are made to the NAT policy configuration after
it is published.

Publish Date

Last modified date and time of the NAT policy.Last Modified

User who modified the NAT policy.Modified By

RELATED DOCUMENTATION
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CHAPTER 67

NAT Policy-Devices

IN THIS CHAPTER

Devices with NAT Policies Main Page Fields | 736

Devices with NAT Policies Main Page Fields

Use the Devices with NAT Policies main page to get an overall, high-level view of your NAT policy device
settings. You can also use this page when you want to view the details of any number of rules and policies
assigned per device. This helps you to keep track of how many rules, and the order of the rules, of all the
policies that are assigned to a device. You can filter and sort this information to get a better understanding
of what you want to view. Table 233 on page 736 describes the fields on this page.

Table 233: Devices Main Page Fields

DescriptionField

Name of the device.Name

IP address of the device.IP Address

Total number of rules of all the policies assigned to the device. Click the link to
view the rules order that is deployed on the device.

Number of Rules

Total number of NAT policies assigned to the device.Number of Policies

Displays the supported device name. For example: SRX Series, vSRX.Platform

RELATED DOCUMENTATION
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CHAPTER 68

NAT Policy-Pools

IN THIS CHAPTER

Creating NAT Pools | 737

Edit and Clone Policies and Objects | 740

Delete and Replace Policies and Objects | 742

Show and Delete Unused Policies and Objects | 743

Showing Duplicate Policies and Objects | 744

Viewing Policy and Shared Object Details | 745

Assigning Policies and Profiles to Domains | 746

NAT Pools Main Page Fields | 747

Creating NAT Pools

A NAT pool is a set of IP addresses that you can define and use for translation. NAT policies perform
address translation by translating internal IP addresses to the addresses in these pools. Unlike static NAT,
where there is a one-to-one mapping that includes destination IP address translation in one direction and
source IP address translation in the reverse direction, with source NAT, you translate the original source
IP address to an IP address in the address pool.With destination NAT, you translate the original destination
address to an IP address in the address pool.

NOTE: Do not overlap NAT addresses for source NAT, destination NAT, and static NAT within
one routing instance.

Before You Begin

• Read the “NAT Overview” on page 703 topic

• Review the NAT pools main page for an understanding of your current data set. See “NAT Pools Main
Page Fields” on page 747 for field descriptions.
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To configure a NAT pool:

1. Select Configure > NAT Policy > Pools.

2. Click the plus sign (+) to create a new NAT pool.

3. Complete the configuration according to the guidelines provided in Table 234 on page 738.

4. Click OK.

A new NAT pool with your configurations is created. You can also assign NAT pools to a domain; see
“Assigning Policies and Profiles to Domains” on page 746.

Table 234: NAT Pool Settings

GuidelineSetting

General Information

Enter a unique string of alphanumeric characters, colons,
periods, slashes, dashes, and underscores; no spaces
allowed; 31-character maximum.

Name

Enter a description for the newNATpool; maximum length
is 255 characters.

Description

Select a NAT pool type to configure:

• Source

• Destination

Pool Type

Select a NAT pool address or click Create to create a new
NAT pool address.

Pool Address

Routing Instance

Select a device for a routing instance.Device

Select the required routing instance from the list of
available routing instances for the selected device.

Routing Instance

Enter the port number for the destination Nat pool type.Port

Advanced
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Table 234: NAT Pool Settings (continued)

GuidelineSetting

Specify the base address of the original source IP address
range. This is used for IP address shifting.

Host Address Base

Specify the following translation type for the incoming
traffic:

• NoTranslation—There is no translation required for the
incoming traffic.

• Port/Range—Set the global default single port range for
source NAT pools with port translation.

• Overload

Translation

Specify a NAT address pooling behavior:

• Paired—Use this option for applications that require all
sessions associated with one internal IP address to be
translated to the same external IP address for multiple
sessions.

• Non-Paired—Use this option for applications that can
be assigned IP addresses in a round-robin fashion.

Address Pooling

Specify that multiple internal IP addresses can bemapped
to the same external IP address. Use this option only when
the sourceNAT pool is configuredwith no port translation.
When a source NAT pool has only one or few external IP
addresses available, the address sharing option with a
many-to-one address mapping increases NAT resources
and improves traffic.

Address Sharing

Specify a source pool to use when the current address
pool is exhausted.

• Interface—Allow the interface pool to support overflow.

• Pool—Name of the source address pool.

• Overflow Pool—Once addresses from the original
source NAT pool are exhausted, IP addresses and
port numbers are allocated from the overflow pool.
A user-defined sourceNATpool or an egress interface
can be used as the overflow pool. (When the overflow
pool is used, the pool ID is returnedwith the address.)

Overflow Pool Type
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Table 234: NAT Pool Settings (continued)

GuidelineSetting

Specify the beginning port range for the sourceNAT pools,
if the Translation type is Port/Range. The starting and
ending port range is 1024 through 65535.

Start

Specify the end port range. The starting and ending port
range is 1024 through 65535.

End

Configure the port overloading-capacity for a source NAT
pool. If the factor is set to x, each translated IP address
has x times the maximum number of ports available. The
range is 2 through 32.

Port Overloading Factor

RELATED DOCUMENTATION
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Edit and Clone Policies and Objects

IN THIS SECTION

Edit Policies or Objects | 741

Clone Policies or Objects | 741

You can edit or clone policies and objects from the policies and shared objects main page.
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NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Edit Policies or Objects

To edit a policy or a shared objects:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to edit, and then click the pencil icon.

The Edit window appears, showing the same options as when creating a new policy or object.

3. Click OK to save your changes.

NOTE: After the published firewall policy rules are edited and saved, you see an icon next to
the check box for each saved policy rule on the Firewall Policies page. When you hover over the
icon, a message appears, indicating that the policy was edited and needs to be pushed to the
device. For updating the policy, see “Updating Policies on Devices” on page 478.

Clone Policies or Objects

To clone a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to clone, or select Clone from the More list.

The Clone window appears with editable fields.

3. Click OK to save your changes.

RELATED DOCUMENTATION
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Creating NAT Pools | 737

Delete and Replace Policies and Objects

IN THIS SECTION

Delete Policies and Objects | 742

Replace Policies and Objects | 742

You can delete or replace policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Delete Policies and Objects

To delete a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to delete, and then select the minus sign (-).

An alert message appears verifying that you want to delete your selection.

3. Click Yes to delete your selection.

Replace Policies and Objects

You can select one or more shared objects and replace them with other objects of the same type.

To replace one or more object:

1. Select Configure > Shared Objects > Addresses, Services, or Variables.

The addresses, services, or variables page appears.
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2. Right-click the shared object that you want to replace, or click Replace from the More list.

You can replace a single object or multiple objects. If the selected object is used in any policy, a warning
message appears before they are replaced.

3. Click Yes to continue the replacement operation.

RELATED DOCUMENTATION
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Show and Delete Unused Policies and Objects

IN THIS SECTION

Show Unused Policies and Objects | 743

Delete Unused Policies and Objects | 744

You can show or delete unused policies and objects in your network configurations.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Show Unused Policies and Objects

You can view all unwanted policies or objects that are not used anywhere in your network to take
appropriate action.

To show unused policies or objects:

1. Select Configure and select the landing page for type of policy or object you are showing.

2. From the landing page, clickMore.

A list of actions appears.
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3. Select Show Unused.

A list of unused objects (not referenced in any policy) and unused policies appear on the page.

Delete Unused Policies and Objects

You can clear all unwanted policies or objects that are not used anywhere in your network.

To delete unused policies or objects:

1. Select Configure and select the landing page for type of policy or object you are deleting.

2. Select the check boxes beside the items that you want to delete. Right-click on the policy or object or
click More from the landing page.

A list of actions appears.

3. Select Delete Unused Items.

A confirmation window appears before you can delete the unused policies or objects.

4. Click Yes to confirm the deletion.

All unused policies or objects are deleted.

NOTE: If you want to delete unused NAT pools from the device when the device is updated
from Security Director, go to Junos Space Network Management Platform, select
Administration > Application >Modify Application Settings > Update Device and select
Delete unused NAT pool check box.

RELATED DOCUMENTATION
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Showing Duplicate Policies and Objects

To display duplicate objects:

1. Select the check box beside the object(s).

744



2. Right-click the object(s) or select Show Duplicates from the More list.

The Show Duplicates page appears, which displays the duplicate objects.

3. Select the duplicate object(s), and perform any of the following actions:

• To merge policies or objects, select multiple policies, right-click or selectMerge from the More list.

The merge operation deletes or replaces the reference for only the custom services and not the
predefined services. If the selected duplicate objects are referenced in any other services (firewall
policy) and security objects (service groups), a warning message is provided before the objects are
merged.

Starting in Junos Space Security Director Release 18.4, you can view duplicate objects in Show
Duplicates page from parent domain and subdomains. You can merge shared objects from parent
domain to subdomain and vice versa.

NOTE: You can view the duplicate objects of subdomain only if the users of the subdomain
have read and execute privileges to parent domain objects.

• To locate the usage of the duplicate objects, select a policy or shared object, right-click or select Find
usage from More list.

.

• To delete the policies or shared objects, select the policies or shared objects, right-click and select
Delete or click delete icon. You can delete objects only from current domain. If you select multiple
objects from across the domains, then the delete option is disabled.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Creating NAT Policies | 707

Creating IPS Policies | 640

Viewing Policy and Shared Object Details

On a policy or a shared object landing page, you can get a detailed view of the existing policies or objects.
The Detail View page lists all the configured parameters of a policy or an object. The Landing page of a
policy or shared object lists only some of the configured parameters and not all. The Detail View option
helps you to get a consolidated view of all the configured parameters.
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NOTE: The detailed view is in read-only mode; you cannot edit any fields.

To see a detailed view of the policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears

2. Right-click the policy or shared object that you want to see the detailed view for, or selectDetail View
from the More list.

The Detail View page appears showing the configuration information, the user who created that
particular policy or shared object, and the last updated information.

You can also get a detailed view by hovering over the name and clicking the Detailed View icon before
the policy or shared object name.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Creating IPS Policies | 640

Creating NAT Policies | 707

Assigning Policies and Profiles to Domains

You can assign or reassign policies or profiles to different domainswhen it is first configured andwhenever
you want to implement a change. You can assign only one policy or profile at a time. Before assigning a
policy or profile to another domain, Security Director checks for the validity of the move. If the move is
not acceptable, a warning message appears.

To assign a policy or profile to a domain:

1. Select Configure and select the landing page for the type of policy or profile that you are assigning to
a domain.

2. From the landing page, right-click the policy or profile or clickMore.

A list of actions appears.

3. Select Assign<Policy or Profile> to Domain.
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The Assign <Policy or Profile> to Domain page appears.

NOTE: <Policy or Profile> is the name of the policy or profile that you are assigning to a
domain.

4. Select the required items to assign to a domain.

5. Enable this option to ignore warning messages, if any.

6. Click Assign.

A policy or profile is assigned to a domain.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Creating NAT Policies | 707

Creating IPS Policies | 640

NAT Pools Main Page Fields

NAT pool is a continuous range of IP addresses that you can use to create a NAT policy. NAT policies
perform address translation by translating internal IP addresses to the addresses in these pools.
Table 235 on page 747 describes the fields on this page.

Table 235: NAP Pools Main Page Fields

DescriptionField

Name of the NAT pool.Name

NAT pool address. It can be of type host, range, or network only.Pool Address

Description of the NAT pool.Description

Type of NAT pool; either source or destination.Pool Type

Display the user domain formapping objects andmanaging sections of a network.Domain
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CHAPTER 69

NAT Policy-Port Sets

IN THIS CHAPTER

Creating Port Sets | 749

Delete and Replace Policies and Objects | 750

Edit and Clone Policies and Objects | 752

Show and Delete Unused Policies and Objects | 753

Showing Duplicate Policies and Objects | 754

Viewing Policy and Shared Object Details | 756

Assigning Policies and Profiles to Domains | 757

Port Sets Main Page Fields | 758

Creating Port Sets

Use the Port Set page to group a set of ports or port ranges. These port sets are referenced using NAT
rules as source and destination ports of NAT policies.

Before You Begin

• Read the “NAT Overview” on page 703 topic.

• Review the port sets main page for an understanding of your current data set. See “Port Sets Main Page
Fields” on page 758 for field descriptions.

To configure a port set:

1. Select Configure > NAT Policy > Port Sets.

2. Click the plus sign (+) to create a new port set.

3. Complete the configuration according to the guidelines provided in Table 236 on page 750.

4. Click OK.
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A new port set with your configurations is created. You can also assign the profile to a domain; see
“Assigning Policies and Profiles to Domains” on page 757.

Table 236: Port Set Settings

DescriptionSetting

Enter a unique string of alphanumeric characters, colons, periods, slashes, dashes, and
underscores; no spaces allowed; 63-character maximum.

Name

Enter a description for the new port set; maximum length is 1024 characters.Description

Enter comma-separated ports, port ranges, or both; maximum number of ports and
port ranges for a single port is 8.

Ports or Port-Ranges

RELATED DOCUMENTATION

NAT Overview | 703

Delete and Replace Policies and Objects

IN THIS SECTION

Delete Policies and Objects | 751

Replace Policies and Objects | 751

You can delete or replace policies and objects from the policies and shared objects main page.

750



NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Delete Policies and Objects

To delete a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to delete, and then select the minus sign (-).

An alert message appears verifying that you want to delete your selection.

3. Click Yes to delete your selection.

Replace Policies and Objects

You can select one or more shared objects and replace them with other objects of the same type.

To replace one or more object:

1. Select Configure > Shared Objects > Addresses, Services, or Variables.

The addresses, services, or variables page appears.

2. Right-click the shared object that you want to replace, or click Replace from the More list.

You can replace a single object or multiple objects. If the selected object is used in any policy, a warning
message appears before they are replaced.

3. Click Yes to continue the replacement operation.

RELATED DOCUMENTATION

Creating Port Sets | 749
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Edit and Clone Policies and Objects

IN THIS SECTION

Edit Policies or Objects | 752

Clone Policies or Objects | 753

You can edit or clone policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Edit Policies or Objects

To edit a policy or a shared objects:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to edit, and then click the pencil icon.

The Edit window appears, showing the same options as when creating a new policy or object.

3. Click OK to save your changes.

NOTE: After the published firewall policy rules are edited and saved, you see an icon next to
the check box for each saved policy rule on the Firewall Policies page. When you hover over the
icon, a message appears, indicating that the policy was edited and needs to be pushed to the
device. For updating the policy, see “Updating Policies on Devices” on page 478.
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Clone Policies or Objects

To clone a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to clone, or select Clone from the More list.

The Clone window appears with editable fields.

3. Click OK to save your changes.

RELATED DOCUMENTATION

Creating Port Sets | 749

Show and Delete Unused Policies and Objects

IN THIS SECTION

Show Unused Policies and Objects | 753

Delete Unused Policies and Objects | 754

You can show or delete unused policies and objects in your network configurations.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Show Unused Policies and Objects

You can view all unwanted policies or objects that are not used anywhere in your network to take
appropriate action.
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To show unused policies or objects:

1. Select Configure and select the landing page for type of policy or object you are showing.

2. From the landing page, clickMore.

A list of actions appears.

3. Select Show Unused.

A list of unused objects (not referenced in any policy) and unused policies appear on the page.

Delete Unused Policies and Objects

You can clear all unwanted policies or objects that are not used anywhere in your network.

To delete unused policies or objects:

1. Select Configure and select the landing page for type of policy or object you are deleting.

2. Select the check boxes beside the items that you want to delete. Right-click on the policy or object or
click More from the landing page.

A list of actions appears.

3. Select Delete Unused.

A confirmation window appears before you can delete the unused policies or objects.

4. Click Yes to confirm the deletion.

All unused policies or objects are deleted.

RELATED DOCUMENTATION
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Showing Duplicate Policies and Objects

To display duplicate objects:

1. Select the check box beside the object(s).
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2. Right-click the object(s) or select Show Duplicates from the More list.

The Show Duplicates page appears, which displays the duplicate objects.

3. Select the duplicate object(s), and perform any of the following actions:

• To merge policies or objects, select multiple policies, right-click or selectMerge from the More list.

The merge operation deletes or replaces the reference for only the custom services and not the
predefined services. If the selected duplicate objects are referenced in any other services (firewall
policy) and security objects (service groups), a warning message is provided before the objects are
merged.

Starting in Junos Space Security Director Release 18.4, you can view duplicate objects in Show
Duplicates page from parent domain and subdomains. You can merge shared objects from parent
domain to subdomain and vice versa.

NOTE: You can view the duplicate objects of subdomain only if the users of the subdomain
have read and execute privileges to parent domain objects.

• To locate the usage of the duplicate objects, select a policy or shared object, right-click or select Find
usage from More list.

.

• To delete the policies or shared objects, select the policies or shared objects, right-click and select
Delete or click delete icon. You can delete objects only from current domain. If you select multiple
objects from across the domains, then the delete option is disabled.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Creating NAT Policies | 707

Creating IPS Policies | 640
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Viewing Policy and Shared Object Details

On a policy or a shared object landing page, you can get a detailed view of the existing policies or objects.
The Detail View page lists all the configured parameters of a policy or an object. The Landing page of a
policy or shared object lists only some of the configured parameters and not all. The Detail View option
helps you to get a consolidated view of all the configured parameters.

NOTE: The detailed view is in read-only mode; you cannot edit any fields.

To see a detailed view of the policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to see the detailed view for, or selectDetail View
from the More list.

The Detail View page appears showing the configuration information, the user who created that
particular policy or shared object, and the last updated information.

You can also get a detailed view by hovering over the name and clicking the Detailed View icon before
the policy or shared object name.

RELATED DOCUMENTATION
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Assigning Policies and Profiles to Domains

You can assign or reassign policies or profiles to different domainswhen it is first configured andwhenever
you want to implement a change. You can assign only one policy or profile at a time. Before assigning a
policy or profile to another domain, Security Director checks for the validity of the move. If the move is
not acceptable, a warning message appears.

To assign a policy or profile to a domain:

1. Select Configure and select the landing page for the type of policy or profile that you are assigning to
a domain.

2. From the landing page, right-click the policy or profile or clickMore.

A list of actions appears.

3. Select Assign <Policy or Profile> to Domain.

The Assign <Policy or Profile> to Domain page appears

NOTE: <Policy or Profile> is the name of the policy or profile that you are assigning to a
domain.

4. Select the required items to assign to a domain.

5. Enable this option to ignore warning messages, if any.

6. Click Assign.

A policy or profile is assigned to a domain.

RELATED DOCUMENTATION
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Port Sets Main Page Fields

Port set is a set of ports or port ranges. These port sets are referenced using NAT rules as source and
destination ports. Table 237 on page 758 describes the fields on this page.

Table 237: Port Sets Main Page Fields

DescriptionField

Name of the port set.Name

Description of the port set.Description

Display the user domain for mapping objects and managing sections of a
network.

Domain

User who created the port set.Created By

Number of ports or port ranges.Port/Port Range

RELATED DOCUMENTATION
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UTM Policy-Policies
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UTM Overview

IN THIS SECTION

UTM Licensing | 760

UTM Components | 761

Unified ThreatManagement (UTM) is a term used to describe the consolidation of several security features
into one device to protect against multiple threat types. The advantage of UTM is a streamlined installation
and management of multiple security capabilities.

The following security features are provided as part of the UTM solution:
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• Antispam—This feature examines transmitted messages to identify e-mail spam. E-mail spam consists
of unwanted messages usually sent by commercial, malicious, or fraudulent entities. When the device
detects an e-mail message deemed to be spam, it either drops the message or tags the message header
or subject field with a preprogrammed string. The antispam feature uses a constantly updated Spamhaus
Block List (SBL). Sophos updates and maintains the IP-based SBL.

• Full file-based antivirus—A virus is an executable code that infects or attaches itself to other executable
code to reproduce itself. Some malicious viruses erase files or lock up systems. Other viruses merely
infect files and overwhelm the target host or network with bogus data. The full file-based antivirus
feature provides file-based scanning on specific application layer traffic, checking for viruses against a
virus signature database. The antivirus feature collects the received data packets until it has reconstructed
the original application content, such as an e-mail file attachment, and then scans this content. Kaspersky
Lab provides the internal scan engine.

• Express antivirus—Express antivirus scanning is offered as a less CPU-intensive alternative to the full
file-based antivirus feature. The express antivirus feature is similar to the antivirus feature in that it scans
specific application layer traffic for viruses against a virus signature database. However, unlike full
antivirus, express antivirus does not reconstruct the original application content. Rather, it just sends
(streams) the received data packets, as is, to the scan engine. With express antivirus, the virus scanning
is executed by a hardware pattern-matching engine. This improves performance while scanning is
occurring, but the level of security provided is lessened. Juniper Networks provides the scan engine.

• Content filtering—Content filtering blocks or permits certain types of traffic based on the MIME type,
file extension, protocol command, and embedded object type.

• Web filtering—Web filtering lets you manage Internet usage by preventing access to inappropriateWeb
content. The following types of Web filtering solutions are available:

• Integrated Web filtering—Blocks or permits Web access after the device identifies the category for a
URL either from user-defined categories or from a category server (Websense provides the SurfControl
Content Portal Authority (CPA) server).

• Redirect Web filtering—Intercepts HTTP requests and forwards the server URL to an external URL
filtering server to determinewhether to block or permit the requestedWeb access.Websense provides
the URL filtering server.

• Juniper local Web filtering—Blocks or permits Web access after the device identifies the category for
a URL from user-defined categories stored on the device.

UTM Licensing

All UTM components require licenses with the exception of content filtering with custom URLs only. This
is because Juniper Networks leverages third-party technology that is constantly updated to provide the
most up-to-date inspection capabilities. Licenses can be purchased individually or as bundled licenses with
other features like AppSecure and IPS. The licenses are term based.
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UTM Components

UTM components include custom objects, feature profiles, and UTM policies that can be configured on
SRX Series devices. From a high-level, feature profiles specify how a feature is configured and then applied
to UTM policies, which then in turn is applied to firewall policies, as shown in Figure 1.

Figure 57: UTM Components

UTMprofiles do not have their own seven-tuple rulebase; in a sense they inherit the rules from the firewall
rule. The strength of the UTM feature comes from URL filtering, where you can have a separate
configuration for different users or user groups.

• CustomObject—Although SRX devices support predefined feature profiles that can handle most typical
use cases, there are some cases where you might need to define your own objects, specifically for URL
filtering, antivirus filtering, and content filtering.

• Feature Profiles—Feature profiles specify how components of each profile should function. You can
configure multiple feature profiles that can be applied through different UTM policies to firewall rules.

• UTM Policies—UTM policies perform as a logical container for individual feature profiles. UTM profiles
are then applied to specific traffic flows based on the classification of rules in the firewall policy. This
allows you to define separate UTMpolicies per firewall rule to differentiate the enforcement per firewall
rule. Essentially, the firewall rulebase acts as the match criteria, and the UTM policy is the action to be
applied.

• Firewall Policy—You can predefine feature profiles for the UTM policy that are then applied to the
firewall rules. This gives you the advantage of using the predefined UTM policy for that one UTM
technology (for example, antivirus or URL filtering), not both.

RELATED DOCUMENTATION
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Creating UTM Policies

Use the Unified Threat Management (UTM) policy page to configure UTM policies. UTM consolidates
several security features into one device to protect against multiple threat types. The UTM policy wizard
provides step-by-step procedures to create a UTMpolicy. You can configuremultiple profiles by launching
the respective wizards from the UTM policy wizard.

Before You Begin

• Read the UTM Overview topic.

• Review the UTM Policy main page for an understanding of your current data set. See “UTM Policies
Main Page Fields” on page 770 for field descriptions.

• Decide the filtering profile you want for the UTM policy: Web Filtering, Antispam, Antivirus, or Content
Filtering.

To configure UTM policies:

1. Select Configure > UTM Policy.

2. Click the + icon to create a new UTM policy.

3. Complete the configuration according to the guidelines provided in Table 238 on page 763.

4. Configure a filtering profile for your UTM policy:

• Antispam— Examine transmitted e-mail messages to identify e-mail spam over SMTP. For more
information, see “Creating Antispam Profiles” on page 789.

• Antivirus—Inspect files transmitted over several protocols (HTTP, FTP upload and download, IMAP,
SMTP, and POP3) to determine if the files exchanged are knownmalicious files, similar to how desktop
antivirus software scans files for the same purpose. For more information, see “Creating Antivirus
Profiles” on page 785.

• Content filtering—Block or permit certain types of traffic over several protocols (HTTP, FTP upload
and download, IMAP, SMTP, and POP3) based on theMIME type, file extension, protocol command,
and embedded object type. Formore information, see “CreatingContent Filtering Profiles” on page 793.

• Web Filtering-Manage Internet usage by preventing access to inappropriateWeb content over HTTP.
For more information, see “Creating Web Filtering Profiles” on page 772.

• Device—ConfigureUTMglobal options for a device. The device profile refers to the antispam, antivirus,
and Web filtering profiles. For more information, see “Creating Device Profiles” on page 798.

5. Click Finish. A new UTM policy is created.
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Table 238: UTM Policy Settings

GuidelineSetting

Enter a unique name for the UTM policy that is a string of alphanumeric characters, colons,
periods, dashes, and underscores. No spaces are allowed and the maximum length is 29
characters.

Name

Enter a description for the UTM policy; maximum length is 255 characters.Description

Specify traffic options for the UTM policy.

In an attempt to consume all available resources, a malicious user might generate a large amount
of traffic all at once. To prevent such activity from succeeding, you can impose traffic options:

• Connection limit per client—Specify the connection limit per client; default is 2000.

• Action when connection limit is reached—Specify the action that must be taken once the
connection limit is reached. The available actions are None, Log and Permit, and Block.

Traffic Options

RELATED DOCUMENTATION
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Comparing Policies

Security Director enables you to compare two policies.

To compare any two policies:

1. Select Configure and select the landing page for the type of policy that you want to compare. For
example, Select Firewall Policies.

2. From the landing page, right-click the policy or clickMore.

A list of actions appears.

3. Select Compare Policy to compare with other policies.

The Compare Policy page appears

4. Select the policy to compare with, and click OK.

The compare result of the two policies are displayed.
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RELATED DOCUMENTATION

Creating Firewall Policies | 434

Creating NAT Policies | 707

Creating IPS Policies | 640

Delete and Replace Policies and Objects

IN THIS SECTION

Delete Policies and Objects | 764

Replace Policies and Objects | 764

You can delete or replace policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Delete Policies and Objects

To delete a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to delete, and then select the minus sign (-).

An alert message appears verifying that you want to delete your selection.

3. Click Yes to delete your selection.

Replace Policies and Objects

You can select one or more shared objects and replace them with other objects of the same type.
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To replace one or more object:

1. Select Configure > Shared Objects > Addresses, Services, or Variables.

The addresses, services, or variables page appears.

2. Right-click the shared object that you want to replace, or click Replace from the More list.

You can replace a single object or multiple objects. If the selected object is used in any policy, a warning
message appears before they are replaced.

3. Click Yes to continue the replacement operation.

RELATED DOCUMENTATION
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Viewing Policy and Shared Object Details

On a policy or a shared object landing page, you can get a detailed view of the existing policies or objects.
The Detail View page lists all the configured parameters of a policy or an object. The Landing page of a
policy or shared object lists only some of the configured parameters and not all. The Detail View option
helps you to get a consolidated view of all the configured parameters.

NOTE: The detailed view is in read-only mode; you cannot edit any fields.

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears

2. Right-click the policy or shared object that you want to see the detailed view for, or selectDetail View
from the More list.

The Detail View page appears showing the configuration information, the user who created that
particular policy or shared object, and the last updated information.

You can also get a detailed view by hovering over the name and clicking the Detailed View icon before
the policy or shared object name.
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RELATED DOCUMENTATION

Creating Firewall Policies | 434

Creating IPS Policies | 640

Creating NAT Policies | 707

Assigning Policies and Profiles to Domains

You can assign or reassign policies or profiles to different domainswhen it is first configured andwhenever
you want to implement a change. You can assign only one policy or profile at a time. Before assigning a
policy or profile to another domain, Security Director checks for the validity of the move. If the move is
not acceptable, a warning message appears.

To assign a policy or profile to a domain:

1. Select Configure and select the landing page for the type of policy or profile that you are assigning to
a domain.

2. From the landing page, right-click the policy or profile or clickMore.

A list of actions appears.

3. Select Assign <Policy or Profile> to Domain.

The Assign <Policy or Profile> to Domain page appears.

NOTE: <Policy or Profile> is the name of the policy or profile that you are assigning to a
domain.

4. Select the required items to assign to a domain.

5. Enable this option to ignore warning messages, if any.

6. Click Assign.

A policy or profile is assigned to a domain.

RELATED DOCUMENTATION
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Creating Firewall Policies | 434

Creating NAT Policies | 707

Creating IPS Policies | 640

Showing Duplicate Policies and Objects

To display duplicate objects:

1. Select the check box beside the object(s).

2. Right click and select ShowDuplicates.

The Show Duplicates page appears.

3. Select the check box beside the duplicate object, click Delete and confirm to remove it.

RELATED DOCUMENTATION
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Creating IPS Policies | 640

Edit and Clone Policies and Objects

IN THIS SECTION

Edit Policies or Objects | 768

Clone Policies or Objects | 768

You can edit or clone policies and objects from the policies and shared objects main page.
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NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Edit Policies or Objects

To edit a policy or a shared objects:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to edit, and then click the pencil icon.

The Edit window appears, showing the same options as when creating a new policy or object.

3. Click OK to save your changes.

NOTE: After the published firewall policy rules are edited and saved, you see an icon next to
the check box for each saved policy rule on the Firewall Policies page. When you hover over the
icon, a message appears, indicating that the policy was edited and needs to be pushed to the
device. For updating the policy, see “Updating Policies on Devices” on page 478.

Clone Policies or Objects

To clone a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to clone, or select Clone from the More list.

The Clone window appears with editable fields.

3. Click OK to save your changes.

RELATED DOCUMENTATION

768



Creating UTM Policies | 762

Show and Delete Unused Policies and Objects

IN THIS SECTION

Show Unused Policies and Objects | 769

Delete Unused Policies and Objects | 769

You can show or delete unused policies and objects in your network configurations.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Show Unused Policies and Objects

You can view all unwanted policies or objects that are not used anywhere in your network to take
appropriate action.

To show unused policies or objects:

1. Select Configure and select the landing page for type of policy or object you are showing.

2. From the landing page, clickMore.

A list of actions appears.

3. Select Show Unused.

A list of unused objects (not referenced in any policy) and unused policies appear on the page.

Delete Unused Policies and Objects

You can clear all unwanted policies or objects that are not used anywhere in your network.
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To delete unused policies or objects:

1. Select Configure and select the landing page for type of policy or object you are deleting.

2. Select the check boxes beside the items that you want to delete. Right-click on the policy or object or
click More from the landing page.

A list of actions appears.

3. Select Delete Unused.

A confirmation window appears before you can delete the unused policies or objects.

4. Click Yes to confirm the deletion.

All unused policies or objects are deleted.

RELATED DOCUMENTATION
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UTM Policies Main Page Fields

Use the UTM policies main page to get an overall, high-level view of your UTM policies settings. You can
filter and sort this information to get a better understanding of what you want to configure. Table 1
describes the fields on this page.

Table 239: UTM Policy Main Page Fields

DescriptionField

Name of the UTM policy.Name

Domain name to which the UTM policy is assigned.Domain

Antispam filtering examines transmitted e-mail messages for spam.Antispam

Antivirus filtering scans specific application layer traffic and checks for viruses against
a virus signature database.

Antivirus

Content filtering blocks or permits types of traffic based on the MIME type, file
extension, protocol command, and embedded object type.

Content Filtering
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Table 239: UTM Policy Main Page Fields (continued)

DescriptionField

Web filtering manages Internet usage by preventing access to inappropriate Web
content.

Web Filtering

A brief description of the UTM policy.Description
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Creating Web Filtering Profiles

Use the Unified Threat Management (UTM) policy page to configure Web filtering profiles.

Web filtering lets you manage Internet usage by preventing access to inappropriate Web content. The
following Web filtering solutions are supported:

• Integrated Web Filtering—Blocks or permits Web access after the device identifies the category for a
URL, either from user-defined categories or from a category server (SurfControl Content Portal Authority
provided by Websense).

NOTE: Integrated Web filtering feature is a separately licensed subscription service.

• Redirect Web Filtering—Intercepts HTTP requests and forwards the server URL to an external URL
filtering server to determine whether to block or permit the requestedWeb access. Websense provides
the URL filtering server.

NOTE: Redirect Web filtering does not require a license.

• Juniper LocalWeb Filtering—Intercepts everyHTTP request in a TCP connection. In this case, the decision
making is done on the device after it looks up a URL to determine if it is in the allowlist or blocklist based
on its user-defined category.
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NOTE: Local Web filtering does not require a license or a remote category server.

Once you create a profile, you can assign it to UTM policies. Within the UTM policy, you can apply either
the same Web filtering profile or create one inline.

Before You Begin

• Read the UTM Overview topic.

• Decide the filtering profile you want for the UTM policy: Web Filtering, Antispam, Antivirus, or Content
Filtering.

• Review the Web Filtering Profile main page for an understanding of your current data set. See “Web
Filtering Profile Main Page Fields” on page 778 for field descriptions.

To create a Web filtering profile:

1. Select Configure > UTM Policy > Web Filtering.

2. Click the + icon to create a new Web filtering profile.

3. Complete the configuration according to the guidelines provided in Table 240 on page 773.

4. Click Finish. A new Web filtering profile is created that you can associate with an UTM policy.

Table 240: Web Filtering Profile Settings

GuidelineSetting

General Information

Enter a unique name for theWeb filtering profile that is a string of alphanumeric characters, colons,
periods, dashes, and underscores. No spaces are allowed and themaximum length is 29 characters.

Name

Enter a description for the Web filtering profile; maximum length is 255 characters.Description

Select the required engine type from the drop-down list:

• Juniper Enhanced— Configure UTM enhanced Web filtering.

• Surf Control—Configure a profile for the Web filtering surf-control integrated feature.

• Websense Redirect—Configure a redirect Web filtering profile.

Engine Type
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Table 240: Web Filtering Profile Settings (continued)

GuidelineSetting

Select the default action from the drop-down list.

NOTE: This option is available only for Juniper Enhanced and Surf Control engine types.

Default Action

Select a safe search solution to ensure that the embedded objects such as images on the URLs
received from the search engines are safe and that no undesirable content is returned to the client.

By default, the Safe Search check box is selected

NOTE: This option is available only for the Juniper Enhanced engine type. Save search redirect
supports HTTP only. You cannot extract theURL for HTTPS. Therefore, it is not possible to generate
a redirect response for HTTPS search URLs. Safe search redirects can be disabled by clearing the
Safe Search check box.

Safe Search

Specify a custom message to be sent when HTTP requests are blocked.

NOTE: If a message begins with http: or https:, the message is considered a block message URL.
Messages that begin with values other than http: or https: are considered custom block messages.

Custom Block
Message

Custom Quarantine Message Use UTM enhanced Web filtering to support block, log and permit,
and permit actions onHTTP/HTTPS requests. Additionally, it supports the quarantine action, which
allows or denies access to the blocked site based on the user’s response to the message.

The quarantine message contains the following information:

• URL name

• Quarantine name

• Category (if available)

• Site-reputation (if available)

Example: If you set the action for Enhanced_Search_Engines_and_Portals to quarantine, and you
try to access www.search.yahoo.com, the quarantine message is as follows:

***The requested webpage is blocked by your organization’s access policy***.

Custom
Quarantine
Message

When a URL category version is downloaded, a predefined base filter with default actions are also
downloaded. All categories have default actions in a base filter. The base filter can be attached to
user profile, which acts like a backup filter. The base filter takes action for the categories that are
not configured in a user profile.

Base Filter

URL Categories
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Table 240: Web Filtering Profile Settings (continued)

GuidelineSetting

A URL category is a list of URL patterns grouped under a single title so a single action that applies
to all URL patterns can be performed on the list.

Click the + icon to select one or more URL categories, an action, and a redirect profile. A redirect
profile is applicable only for block and quarantine actions. You can create a new redirect profile
by clicking Create New Redirect Profile. The created redirect profile is displayed in the Redirect
Profile drop-down list. The following actions are available:

• Log and Permit—Create a list of URL patterns that are logged, then permitted.

• Block—Create a list of URL patterns that are denied access.

• Quarantine—Create a list of URL patterns that are quarantined.

• Permit—Create a list of URL patterns that are permitted.

Edit the action or redirect profile by clicking Apply Actions and updating the action and redirect
profile.

Delete the URL category by selecting the URL category and clicking the X icon.

Fallback Options

The fallback options are used when the web filtering system experiences errors and must fallback
to one of the previously configured actions to either deny (block) or permit the object.

• Default Action— Select Log and Permit or Block from the drop-down list.

Global Reputation Actions
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Table 240: Web Filtering Profile Settings (continued)

GuidelineSetting

Select this check box if you want to apply global reputation actions.

Enhanced Web filtering intercepts HTTP and HTTPS requests and sends the HTTP URL or the
HTTPS source IP to the Websense ThreatSeeker Cloud (TSC). The TSC categorizes the URL into
one of the predefined categories and also provides site reputation information for the URL to the
device. The device determines if it can permit or block the request based on the information
provided by the TSC.

The URLs can be processed using their reputation score if there is no category available. Select
the action that you wish to take for the uncategorized URLs based on their reputation score:

• Very Safe—Permit, log and permit, block, or quarantine a request if a site reputation of 90 through
100 is returned. By default, Permit is selected.

• Moderately Safe—Permit, log and permit, block, or quarantine a request if a site reputation of
80 through 89 is returned. By default, Log and Permit is selected.

• Fairly Safe—Permit, log and permit, block or quarantine a request if a site-reputation of 70
through 79 is returned. By default, Log and Permit is selected.

• Suspicious—Permit, log and permit, block, or quarantine a request if a site reputation of 60
through 69 is returned. By default, Quarantine is selected.

• Harmful—Permit, log and permit, block, or quarantine a request if a site reputation of 1 through
59 is returned. By default, Block is selected.

NOTE: The Use global reputation check box is selected by default.

Uncategorized
URL Actions
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Selecting a Web Filtering Solution

There are three options for enabling Web filtering. Use Table 1 to help you decide which option is right.
The Web filtering solutions table gives you the pros and cons of each option.

Table 241: Web Filtering Solutions

ConsPros
Web Filtering
Option

Requires an Internet connection to be
able to contact the Threatseeker cloud.

Integrated Web filtering is also a
separately licensed subscription service.

Is the most powerful integrated method in terms of
detection.

It has a granular list of URL categories, support for
Google Safe Search, and a reputation engine.

This option can also redirect you to a custom URL
for block pages

Integrated Web
Filtering

Requires a separate Websense server.

Redirect Web filtering does not have as
much functionality as directing the entire
HTTP session through the Websense
server.

Does not require an Internet connection; all queries
are tracked locally.

This option has a slightly lower latency because the
server is onsite.

Redirect Web
Filtering

Is not ideal for broad URL filtering
support.

Does not require a license.

Juniper localWeb filtering is good for defining your
own blocklist or allowlist.

This option is good if you have only a handful of
URLs on which you want to enforce a policy.

Juniper Local Web
Filtering
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Web Filtering Profile Main Page Fields

Use the Web Filtering main page to get an overall, high-level view of your Web filtering settings. You can
filter and sort this information to get a better understanding of what you want to configure.
Table 242 on page 778 describes the fields on this page.

Table 242: Web Filtering Profile Main Page Fields

DescriptionField

Name of the Web filtering profile.Name

Domain name to which the Web filtering profile is assigned.Domain

Type of engine used for the profile: Juniper-enhanced, Surf-control, or Websense
redirect.

Profile Type

Default action for the connection limit.Default Action

Action takenwhen the connection limit is reached. Available actions are None, Log
and Permit, and Block.

Timeout

Description of the Web filtering profile.Description
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About the Category Update Page

To access this page, click Configure > UTM Policy > Category Update.

Use the Category Update page to download and install a URL category dynamically. You can download
the Websense Enhanced Web Filtering category version from the category download site at
https://update.juniper-updates.net and install it without upgrading SecurityDirector.Websense occasionally
releases new Enhanced Web Filtering categories. The category list is available in a file in JSON format. It
supports a predefined base filter and all categories have default actions in the base filter. The base filter
can be attached to a user profile, which acts like a backup filter. The base filter takes action for the categories
that are not configured in a user profile.

The category file is downloaded into Junos Space server in the following ways:

• Security Director automatically downloads the category file from the category download site for the
first time, if there is no category version available.

• You can download required version or latest version of category file.

• You can upload category file into Junos Space server. This is useful when you do not have internet
connection to the Junos Space server.
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NOTE:
• Maximum available Websense categories are 1000.

• Maximum available base filters are 16.

Tasks You Can Perform

You can perform the following tasks from this page:

• Configure URL settings. See “Configuring the Download URL Settings” on page 781.

• Download a category file and install it on SRX Series devices with an Enhanced Web Filtering license.
See “Downloading and Installing URL Categories” on page 782.

• Uploading and installing a category file to the Junos Space Server. See “Uploading and Installing URL
Categories” on page 783.

• Installing categories on newly added devices. See “Installing URL Categories on SRX Series Devices” on
page 784.

Field Descriptions

Table 243 on page 780 provides guidelines on using the fields on the Category Update page.

Table 243: Fields on the Category Update Page

DescriptionField

Specifies the downloaded category file version.File Version

Specifies the date when the Enhanced Web Category File was published in the
download site, that is, https://update.juniper-updates.net.

Publish Date

Specifies the Junos version on which the category file is supported.

NOTE: UTM category update is supported only from Junos 17.4 version.

Supported Junos

Select a predefined base filter, which has default actions for all categories, for Web
filtering.

Select Filter

Specifies the category name in the base filter.Name

Specifies the action for the categories in the base filter.Action

780



RELATED DOCUMENTATION

Configuring the Download URL Settings | 781

Downloading and Installing URL Categories | 782

Uploading and Installing URL Categories | 783

Installing URL Categories on SRX Series Devices | 784

Configuring the Download URL Settings

You can configure the download site URL from wherever the URL category package needs to be
downloaded. By default, https://update.juniper-updates.net is the download URL. Whenever a new
category is released from Websense, it will be available at the Juniper Networks download site at
https://update.juniper-updates.net.Websense occasionally releases newEnhancedWebFiltering categories.

To configure the download URL:

1. Select Configure > UTM Policy > Category Update.

The Category Update page is displayed.

2. Click Settings.

The Settings page is displayed.

3. Enter the URL from where the URL category package has to be downloaded. By default, the Juniper
Networks download site URL is displayed. For example, you see https://update.juniper-updates.net.

4. Browse and select a UTM server certificate file (*.crt or *.pem).

5. Enable the option to send the download configuration traffic through a proxy server.

6. Click OK.
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Downloading and Installing URL Categories

You can download the current URL category version or a specific version. Besides downloading the category
file, you can also choose to install it. You can also specify whether you want to run a job immediately or
schedule it for a later time.

Before You Begin

Configure the download URL settings. See “Configuring the Download URL Settings” on page 781.

To download and install a URL category:

1. Select Configure > UTM Policy > Category Update.

The Category Update page is displayed.

2. Click Download.

The Download and Install Settings page is displayed.

3. Select the latest version option or specify an available version number.

4. Select the Download and Install option if you want to install the categories after downloading them.

5. Specify whether you want to run a job immediately or schedule it for a later time.

6. Click OK.

If you have not selected the Download and Install option, the Job Detail:Download URL Categories
page with a summary of download status is displayed.

If you have selected the Download and Install option, the Job Status page is displayed with the status
of the URL category download, probing for devices with an EWF license or category version, and
installing URL categories on SRX Series devices with an EWF license.
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Uploading and Installing URL Categories

You can upload aURL category package file to a Junos Space server and choose to install the URL categories
after the upload.

Before You Begin

Download the EWF URL category file utm_category_package_1.tgz from
https://update.juniper-updates.net/EWF/ and save it in your local system.

To upload and install categories:

1. Select Configure > UTM Policy > Category Update.

The Category Update page is displayed.

2. Click Offline Upload.

The Upload page is displayed.

3. Browse and select the category file utm_category_package_1.tgz from your local system.

4. Select Upload and Install to install the URL categories on the SRX Series devices with an EWF license
after uploading it to the Junos Space server.

5. Click Upload.

If you did not select Upload and Install, then the URL categories are only uploaded to the Junos Space
server.

The Job Detail:Download URL Categories (Offline) page for downloading URL categories is displayed.
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Installing URL Categories on SRX Series Devices

You can install URL categories on SRX Series devices with an EWF license. All SRX Series devices with an
EWF license are listed in a table. If your device is not listed, then you can probe for SRX Series devices to
show up in the table.

To install URL categories on devices with an EWF license:

1. Select Configure > UTM Policy > Category Update.

The Category Update page is displayed.

2. Click Install.

The Install Category page is displayed. A category version is also displayed in the page title, depending
on the category version downloaded.

3. Select the devices with an EWF license.

If a device is not displayed, you can click Probe Devices to probe for devices.

4. Specify whether you want to run a job for installing the categories immediately or schedule it for a later
time.

5. Click OK.

The Job Details page is displayed with details, such as type, ID, user state, and so on.
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Creating Antivirus Profiles

Use the Unified Threat Management (UTM) policy page to configure antivirus profiles.

The antivirus profile defines the content to scan for anymalware and the action to be takenwhenmalware
is detected. Once you create a profile, you can assign it to UTM policies. Within the UTM policy, you can
apply either the same antivirus profile or create one inline to scan Web, file transfer, and e-mail traffic.

Before You Begin

• Read the UTM Overview topic.

• Decidewhat kind of filtering youwant for the UTMpolicy:Web Filtering, Antispam, Antivirus, or Content
Filtering.

• Review the Antivirus Profile main page for an understanding of your current data set. See “Antivirus
Profile Main Page Fields” on page 787 for field descriptions.

Configuring Antivirus Profile Settings

To create an antivirus profile:

• Select Configure > UTM Policy > Antivirus Profiles.

• Click the + icon to create a new antivirus profile.

• Complete the configuration according to the guidelines provided in Table 244 on page 786.

• Click Finish. An antivirus profile is created that can be associated with an UTM policy.
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Table 244: Antivirus Profile Settings

GuidelineSetting

General Information

Enter a unique name for the antivirus profile that is a string of alphanumeric characters, colons,
periods, dashes, and underscores. No spaces are allowed and the maximum length is 29 characters.

Name

Enter a description for the antivirus profile; maximum length is 255 characters.Description

Select the required engine type from the drop-down list:

• Kaspersky—Kaspersky Lab engine is responsible for scanning all the data it receives.

• Juniper Express—You configure a profile for the Juniper Express engine. Mostly used for express
antivirus scanning.

• Sophos—Sophos antivirus is an in-the-cloud antivirus solution. The virus and malware database is
located on external servers maintained by Sophos (Sophos Extensible List) servers, thus there is
no need to download and maintain large pattern databases on the Juniper Networks device.

NOTE: By default, Juniper Express is selected.

Engine Type

Fallback Options

The fallback options are used when the antivirus system experiences errors and must fall back to
one of the previously configured actions to either deny (block) or permit the object.

Use the fallback options to be configured when there is a failure, or select the default action if no
specific options are to be configured:

• Content Size—Select Block or Log and Permit. If the content size exceeds a set limit, the content
is either passed or blocked. The default action is Block.

• Content Size Limit—Enter the content size limit in kilobytes (KB). The limit range is 20 - 40,000
KB. The content size limit check occurs before the scan request is sent. The content size refers to
accumulated TCP payload size.

• Engine Error—Select Block or Log and Permit. The default action is Block. Note: Engine error
combines all errors, engine not ready, timeout, too many requests, and out of resources, into a
single fallback option.

• Default Action—Select Block or Log and Permit.

Notification Options
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Table 244: Antivirus Profile Settings (continued)

GuidelineSetting

Use the notification options to configure a method of notifying the user when a fallback occurs or
a virus is detected:

• Fallback Deny—Select this option to notify mail senders that their messages were blocked.

• Fallback Non-Deny—Select this option to warn mail recipients that they received unblocked
messages despite problems.

• Virus Detected—Select this option to notify mail recipients that their messages were blocked.
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Antivirus Profile Main Page Fields

Use the Antivirus main page to get an overall, high-level view of your antivirus settings. You can filter and
sort this information to get a better understanding of what you want to configure. Table 1 describes the
fields on this page.

Table 245: Antivirus Main Page Fields

DescriptionField

Name of the antivirus profile.Name

Domain name to which the antivirus profile is assigned.Domain

Type of engine used for the antivirus profile: Juniper express, Kaspersky, or
Sophos.

Profile Type

Content size limit, in kilobytes, refers to accumulated TCP payload size.Content Size Limit

Number of seconds to wait for a response from the server.Trickling Timeout
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Table 245: Antivirus Main Page Fields (continued)

DescriptionField

Description of the antivirus profile.Description
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Creating Antispam Profiles

Use the Unified Threat Management (UTM) policy page to configure antispam profiles.

E-mail spam consists of unwanted e-mail messages usually sent by commercial, malicious, or fraudulent
entities. When the device detects an e-mail message deemed to be spam, it either blocks the message or
tags the message header or subject field with a preprogrammed string. Antispam filtering allows you to
use both a third-party server-based spam block list (SBL) and to optionally create your own local allowlists
(benign) and blocklists (malicious) for filtering against e-mail messages.

NOTE: Sophos updates and maintains the IP-based SBL. Antispam is a separately licensed
subscription service.

Once you create a profile, you can assign it to UTM policies. Within the UTM policy, you can apply either
the same antispam profile or create one inline to scan e-mail traffic.

Before You Begin

• Read the UTM Overview topic

• Decide what kind of filtering you want for the UTM policy: Web filtering, antispam, antiviurs, or content
filtering.

• Review the Antispam Profile main page for an understanding of your current data set. See “Antispam
Profile Main Page Fields” on page 791 for field description.
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To create an antispam profile:

1. Select Configure > UTM Policy > Antispam Profiles.

2. Click the + icon to create a new antispam profile.

3. Complete the configuration according to the guidelines provided in Table 246 on page 790.

Table 246: Antispam Profile Settings

GuidelineSetting

General Information

Enter a unique name for the antispam profile that is a string of alphanumeric characters,
colons, periods, dashes, and underscores. No spaces are allowed and the maximum length
is 29 characters.

Name

Enter a description for the antispam profile; maximum length is 255 characters.Description

Select this check box to use server-based spam filtering. This check box is selected by default.
If the box is unchecked, local spam filtering is used. Server-based antispam filtering requires
Internet connectivity with the spam block list (SBL) server. Domain Name Service (DNS) is
required to access the SBL server. The firewall performs SBL lookups through the DNS
protocol.

NOTE: Server-based spam filtering supports only IP-based spam block list blocklist lookup.
Sophos updates and maintains the IP-based spam block list. Server-based antispam filtering
is a separately licensed subscription service.

Use Sophos Blocklist

Action

Select the antispam action that the device should take when it detects spam:

• Tag Email Subject Line

• Tag SMTP Header

• Block Email

• Note

Default Action

Enter a custom string for identifying a message as spam. By default, the device uses
***SPAM***.

Custom Tag
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Antispam Profile Main Page Fields

Use the Antispam main page to get an overall, high-level view of your antispam settings. You can filter
and sort this information to get a better understanding of what you want to configure. Table 1 describes
the fields on this page.

Table 247: Antispam Profile Main Page Fields

DescriptionField

Name of the antispam profile.Name

Domain name to which the antispam profile is assigned.Domain

Indicates whether server-based spam filtering, Sophos Blocklist, or local spam filtering
is used.

Blocklist

Action selected for the antispam profile: Tag Email Subject Line, Tag SMTP Header,
Block Email, or None.

Action

Custom-defined tag that identifies an e-mail message as spam.Custom Tag

Description of the antispam profile.Description
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Creating Content Filtering Profiles

Use the Unified Threat Management (UTM) policy page to configure content filtering profiles.

Content filtering blocks or permits certain types of traffic based on the MIME type, file extension, and
protocol command. The content filter controls file transfers across the device by checking traffic against
configured filter lists.

NOTE: The content filter profile evaluates traffic before all other UTM profiles, except Web
Filtering. Therefore, if traffic meets criteria configured in the content filter, the content filter
acts first upon this traffic.

You can configure the following types of content filters:

• MIME pattern filter—MIME patterns are used to identify the type of traffic in HTTP andMAIL protocols.
There are two lists of MIME patterns that are used by the content filter to determine the action to be
taken. The blockMIME list contains a list ofMIME type traffic that is to be blocked. TheMIME exception
list contains MIME patterns that are not to be blocked by the content filter and are generally subsets of
items on the block list.

NOTE: The exception list has a higher priority than the block list.

• Block Extension List—Because the name of a file is available during the transfers, using file extensions
is a highly practical way to block or allow file transfers. All protocols support the use of the block extension
list.
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• Protocol Command Block and Permit Lists—Different protocols use different commands to communicate
between servers and clients. By blocking or allowing certain commands, traffic can be controlled on the
protocol command level. The block or permit command lists are intended to be used in combination,
with the permit list acting as an exception list to the block list.

NOTE: If a protocol command appears on both the permit list and the block list, the command
is permitted.

Before You Begin

• Read the UTM Overview topic.

• Decidewhat kind of filtering youwant for the UTMpolicy:Web Filtering, Antispam, Antivirus, or Content
Filtering.

• Review the Content Filtering Profile main page for an understanding of your current data set. See
“Content Filtering Profile Main Page Fields” on page 796 for field descriptions.

To create a content filtering profile:

1. Select Configur > UTM Policy > Content Filtering Profiles.

2. Click the + icon to create a new content filtering profile.

3. Complete the configuration according to the guidelines provided in Table 248 on page 794.

4. Click Finish. A content filtering profile is created that can be associated with an UTM policy.

Table 248: Content Filtering Profile Settings

GuidelineSetting

General Information

Enter a unique name for the content filtering profile that is a string of alphanumeric characters,
colons, periods, dashes, and underscores. No spaces are allowed and the maximum length is 29
characters.

Name

Enter a description for the content filtering profile; maximum length is 255 characters.Description

Notification Options
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Table 248: Content Filtering Profile Settings (continued)

GuidelineSetting

Use the notification options to configure a method of notifying the user when a failure occurs or
a virus is detected:

• Notify Mail Sender—Select this check box if you want to notify the sender.

• Notification Type—Select the type of notification, Protocol or Message from the drop-down
list.

• Custom Notification Message—Enter a custom notification message.

Protocol Commands

Use content filtering to block specific commands forHTTP, FTP, SMTP, IMAP, and POP3 protocols.
Select the following options:

• Command Block List—Enter the protocol commands to be blocked. Use commas to separate
each command.

• Command Permit List—Enter the protocol commands to be permitted. Use commas to separate
each command.

Content Types

Use the content filter to block other types of harmful files that theMIME type or the file extension
cannot control.

Block Content Type—Select from the following types of content blocking (supported only for
HTTP):

• Active X

• Windows executables (.exe)

• HTTP cookie

• Java applet

• ZIP files

File Extensions

Use a file extension list to define a set of file extensions to block over HTTP, FTP, SMTP, IMAP,
and POP3.

• Extension Block List—Enter file extensions to block separated by commas. For example, exe,
pdf, js, and so forth.

MIME Types
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Table 248: Content Filtering Profile Settings (continued)

GuidelineSetting

Use content filtering to block or permit special MIME types over HTTP, FTP, SMTP, IMAP, and
POP3 connections. Specify the MIME(s) to be blocked or permitted:

• MIME Block List—Enter the MIME types you wish to block. Use commas to separate each
MIME type.

• MIME Permit List—Enter the MIME types you wish to permit. Use commas to separate each
MIME type.

RELATED DOCUMENTATION

Creating UTM Policies | 762

UTM Overview | 759

Creating Antispam Profiles | 789

Creating Antivirus Profiles | 785

Content Filtering Profile Main Page Fields

Use the Content Filtering Profile main page to get an overall, high-level view of your content filtering
settings. You can filter and sort this information to get a better understanding ofwhat youwant to configure.
Table 1 describes the fields on this page.

Table 249: Content Filtering Profile Main Page Fields

DescriptionField

Name of the content filtering profile.Name

Domain name to which the content filtering profile is assigned.Domain

List of protocol commands to be permitted. It allows you to control traffic at the
protocol-command level.

Permit Command List

List of protocol commands to be blocked. It allows you to control traffic at the
protocol-command level.

Block Command List

Type of notification that is sent when a fallback option of block is triggeredNotification Type
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Table 249: Content Filtering Profile Main Page Fields (continued)

DescriptionField

Description of the content filtering profile.Description

RELATED DOCUMENTATION

Creating Web Filtering Profiles | 772

UTM Overview | 759

Creating UTM Policies | 762
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CHAPTER 76

UTM Policy-Global Device Profiles

IN THIS CHAPTER

Creating Device Profiles | 798

Device Profiles Main Page Fields | 801

Creating Device Profiles

Use the Unified Threat Management (UTM) policy page to configure device profiles.

The device profile is used to configure UTM global options for a device. The device profile refers to the
antispam, antivirus, and Web filtering profiles.

Before You Begin

• Read the UTM Overview topic.

• Decide which kind of filtering you want for the UTM policy: Web filtering, antispam, antivirus, content
filtering, or device.

• Review the device profile main page for an understanding of your current data set. See “Device Profiles
Main Page Fields” on page 801 for field descriptions.

WARNING: When you configure the MIME allowlist feature, be aware that, because
header information in HTTP traffic can be spoofed, you cannot always trust HTTP
headers to be legitimate. When a Web browser is determining the appropriate action
for a given file type, it detects the file typewithout checking theMIME header contents.
However, the MIME allowlist feature does refer to the MIME encoding in the HTTP
header. For these reasons, it is possible in certain cases for a malicious website to
provide an invalid HTTP header. For example, a network administrator might
inadvertently add a malicious website to a MIME allowlist, and, because the site is in
the allowlist, it will not be blocked by Sophos even though Sophos has identified the
site as malicious in its database. Internal hosts would then be able to reach this site
and could become infected.
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To create a device profile:

1. Select Configure > UTM Policy > Device Profiles.

2. Click Create.

3. Complete the configuration according to the guidelines provided in Table 250 on page 799.

4. Click Finish.

Table 250: Device Profile Settings

GuidelineSetting

General Information

Enter a unique name for the device profile that is a string of alphanumeric characters, colons,
periods, dashes, and underscores. No spaces are allowed and the maximum length is 255
characters.

Name

Enter a description for the device profile; maximum length is 255 characters.Description

Assign a device or devices to a profile by selecting the device or devices in the Available column
and moving them to the Selected column.

NOTE: If a device is already assigned to a profile, it will not be listed in the Available column.

Devices

Antispam Profile

Select an address allowlist for local spam filtering. Allowlist include addresses that you want
to exclude from undergoing antispam processing. (These lists are configured as custom objects.)

NOTE: When both the allowlist and blocklist are in use, the allowlist is checked first. If there
is no match, then the blocklist is checked. A

Address Allowlist

Select an address blocklist for local spam filtering. Blocklists include addresses that you want
to exclude. (These lists are configured as custom objects.) Note: When both the allowlist and
blocklist are in use, the allowlist is checked first. If there is no match, then the blocklist is
checked.

Address Blocklist

Antivirus Profile
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Table 250: Device Profile Settings (continued)

GuidelineSetting

Enter MIME types to create MIME bypass lists and exception lists. The device uses MIME
types to decide which traffic may bypass antivirus scanning. The MIME allowlist defines a list
of MIME types and can contain one or many MIME entries. You can use your own custom
object lists, or you can use the default list that ships with the device called
junos-default-bypass-mime.

The following limitations apply:

• The maximum number of MIME items in a MIME list is 50.

• The maximum length of each MIME entry is restricted to 40 bytes.

• The maximum length of a MIME list name string is restricted to 40 bytes.

MIME Allowlist

EnterMIME types to create an exceptionMIME allowlist that excludes someMIME types from
the MIME allowlist. This list is a subset of MIME types found in the MIME allowlist.

For example, if the MIME allowlist includes the entry, video/ and the exception list includes
the entry video/x-shockwave-flash, by using these two lists, you can bypass objects with
“video/” MIME type but not bypass “video/x-shockwave-flash” MIME type.

Exception

MIME Allowlist

Enter URLs or IP addresses to create a list of websites that are always bypassed for scanning.

Because antivirus scanning is a CPU and memory intensive action, if there are URLs and IP
addresses that you are confident do not require scanning, youmight want to create this custom
list and add them to it.

URL Allowlist

Web Filtering Profile

Enter URLs to create a allowlist of websites that are always permitted.With localWeb filtering,
the firewall intercepts every HTTP request in a TCP connection and extracts the URL. The
decision is done on the device after it looks up a URL to determine if it is in the allowlist or
blocklist based on its user-defined category.

NOTE: AWeb filtering profile can contain one allowlist or one blocklist with multiple
user-defined categories each with a permit or block action.

URL Allowlist

Enter URLs to create a blocklist of websites that are always blocked.

NOTE: AWeb filtering profile can contain one allowlist or one blocklist with multiple
user-defined categories each with a permit or block action.

URL Blocklist

Choose a reputation level. An action will be taken based on the reputation level returned for
all types of URLs, whether categorized or uncategorized.

Site Reputation
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RELATED DOCUMENTATION

UTM Overview | 759

Creating UTM Policies | 762

Creating Antispam Profiles | 789

Creating Antivirus Profiles | 785

Creating Web Filtering Profiles | 772

Device Profiles Main Page Fields

Use the Device Profiles main page to get an overall, high-level view of your device profile settings. You
can filter and sort this information to get a better understanding of what you want to configure. Table 1
describes the fields on this page.

Table 251: Device Profiles Main Page Fields

DescriptionField

Name of the device profile.Name

Domain name to which the device profile is assigned.Domain

Antispam address allowlists (benign) consist of addresses or domain names
that you want excluded when scanning e-mail messages for antispam.

Antispam Address Allowlist

Antispam address blocklists (malicious) consist of addresses or domain names
that you want blocked when scanning e-mail messages for antispam.

Antispam Address Blocklist

Exception MIMEs and URL addresses that compose the allowlist. The list can
contain one or many MIME entries.

Antivirus URL Allowlist

URLs or IP addresses that are excluded from Web filtering.Web Filtering URL Allowlist

URLs or IP addresses that are blocked from Web access.Web Filtering URL Blocklist

Description of the device profile.Description

RELATED DOCUMENTATION

Creating Device Profiles | 798
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CHAPTER 77

UTM Policy-Default Configuration

IN THIS CHAPTER

About the Default Configuration Page | 803

Create a Default UTM Configuration | 804

Edit and Clone the Default Configuration | 818

View and Delete Unused Default Configuration | 820

About the Default Configuration Page

To access this page, click Configure > UTM Policy > Default Configuration.

You can configure the default UTM configuration for web filtering, antivirus, antispam, and content filtering
profiles on the selected device(s). You can assign the default configuration on the device(s) with Junos OS
Release 18.2 and later. You can configure only one default configuration on each device.

If any parameter in a specific UTM feature profile is not configured, then the corresponding parameter is
applied from the UTM default configuration. The UTM default configuration CLI is generated as part of
unified or standard firewall policy, where the corresponding device with default UTM configuration is
assigned.

Tasks You Can Perform

You can perform the following tasks from this page:

• Create a default UTM default configuration. See “Create a Default UTM Configuration” on page 804.

• Edit and clone a default UTMconfiguration. See “Edit and Clone theDefault Configuration” on page 818.

• View and delete unused default configurations. See “View and Delete Unused Default Configuration”
on page 820.

Field Descriptions

Table 252 on page 804 provides guidelines on using the fields on the Default Configuration page.
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Table 252: Fields on the Default Configuration Page

DescriptionField

Name of the default UTM configuration.Name

Provides description of the default UTM configuration.Description

Specifies the user domain.Domain

Specifies the Antispam type. Antispam examines transmitted messages to identify
any e-mail spam.

Antispam Type

Specifies the Antivirus type. Antivirus implements a file-based scanning process on
specific application layer traffic to check for viruses against a virus signature database.

Antivirus Type

Specifies the Content Filtering type. Content filtering specifies the kind of traffic to
block or permit based on the MIME type, file extension, and protocol commands.

Content Filtering Type

Specifies the Web Filtering type. Web filtering specifies the kind of traffic to block
or permit based on the MIME type, file extension, and protocol commands.

Web Filtering Type

The devices(s) on which you want to assign the default configuration.Devices

RELATED DOCUMENTATION

UTM Overview | 759

Create a Default UTM Configuration

You can define the default parameters for security features in unified threat management (UTM). You can
configure the parameters for the following:

• Web Filtering–Web filtering allows you to manage internet usage by preventing access to inappropriate
web content.

• Antivirus—The antivirus profile defines the content to scan for any malware and the action to be taken
when malware is detected.

• Antispam—Antispam examines transmitted messages to identify any e-mail spam.

• Content Filtering—Content filtering blocks or permits certain types of traffic based on the MIME type,
file extension, protocol command, and embedded object type.
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To create a default UTM configuration:

1. Select Configure > UTM Policy > Default Configuration.

2. Click + icon.

The Create Default Configuration page is displayed.

3. Complete the configuration according to the guidelines provided in Table 253 on page 805.

4. Click Finish.

The configuration summary is displayed.

5. Click OK.

The default UTM configuration is created and assigned to the selected device(s).

Table 253: Default UTM Configuration Settings

DescriptionField

General

General Information

Enter the name of the default configuration.Name

Enter a description for the default configuration. The maximum length is 255
characters.

Description

Select the devices(s) on which you want to assign default configuration. Devices with
Junos OS Release 18.2 onward are listed here.

Device

Web Filtering

Web Filtering Profiles by Traffic Protocol

Enable to configure the web-filtering engine type.HTTP Persist

Enable to specify a unique customized list of all URLs or IP addresses for a given
category that are bypassed for scanning.

HTTP Reassemble
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Table 253: Default UTM Configuration Settings (continued)

DescriptionField

Select a web-filtering engine type.

• Web-filter None—If you select this option for the first time, the type in the CLI
configuration is ignored. If you modify any other value to None, then existing CLI
configuration for type is deleted from the device.

• Juniper Enhanced—Select this option to enable enhanced Web filtering on the
device.

• Juniper Local—Select this option to enable Juniper Networks local URL filtering on
the device.

• Websense Redirect—Select this option to redirect the URL to theWebsense server.

Type

Select the URL blocklist category to block the URLs in that category. To create a new
URL blocklist category, click Create New URL Category.

A Web filtering profile can contain one allowlist or one blocklist with multiple
user-defined categories each with a permit or block action.

URL Blocklist

Select the URL allowlist category to bypass all the URLs in that category. To create a
newURL allowlist category, clickCreateNewURLCategory.With localWeb filtering,
the firewall intercepts every HTTP request in a TCP connection and extracts the URL.

A Web filtering profile can contain one allowlist or one blocklist with multiple
user-defined categories each with a permit or block action.

URL Allowlist

Global

This field is applicable only when the Web Filtering Profile type is Juniper Enhanced.

When a URL category version is downloaded, a predefined base filter with default
actions are also downloaded. All categories have default actions in a base filter. The
base filter can be attached to user profile, which acts like a backup filter. The base
filter takes action for the categories that are not configured in a user profile.

Select a predefined base filter, which has default actions for all categories, for Web
filtering.

Base Filter

This field is applicable only when theWeb Filtering Profile type isWebsense Redirect.

Enter the websense redirect account.

Account
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Table 253: Default UTM Configuration Settings (continued)

DescriptionField

Specify a custom message to be displayed when HTTP requests are blocked.

NOTE: If a message begins with http: or https:, the message is considered a block
messageURL.Messages that beginwith values other than http: or https: are considered
custom block messages.

Custom Block Message

This is applicable only when the Web Filtering Profile type is Juniper Enhanced or
Juniper Local.

Select a default action for the profile for requests that experience internal errors in
the web filtering module.

Select a default action.

• None—If you select this option for the first time, the default action in the CLI
configuration is ignored. If you modify any other value to None, then existing CLI
configuration for default action is deleted from the device.

• Permit—Permit the traffic.

• Log and Permit—Log the error and permit the traffic.

• Block—Log the error and deny the traffic.

• Quarantine—Quarantine the traffic.

Default Action

This option is applicable only when theWeb Filtering Profile type is Juniper Enhanced.

Select a safe search solution to ensure that the embedded objects such as images on
the URLs received from the search engines are safe and that no undesirable content
is returned to the client.

NOTE: Safe search redirect supports HTTP only. You cannot extract the URL for
HTTPS. Therefore, it is not possible to generate a redirect response for HTTPS search
URLs. Safe search redirects can be disabled by clearing the Safe Search check box.

Safe Search

Enter the quarantine custom message.Quarantine Custom Message

This is applicable only when the Web Filtering Profile type is Websense Redirect.

Enter the number of sockets used for communicating between the client and server.

The range is 1 to 32.

Sockets

Select a timeout interval from 1 to 1800 seconds.Timeout

Cache
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Table 253: Default UTM Configuration Settings (continued)

DescriptionField

This section is applicable only when the Web Filtering Profile type is Juniper Enhanced.

Specify a Juniper enhanced cache size. Select a cache size from 0 to 4096 Killobytes.Size

Specify Juniper enhanced cache timeout. Select a timeout interval from 1 to 1800
minutes.

Timeout

Block Message

Select the type of block message.

• None—If you select this option for the first time, the type in the CLI configuration
is ignored. If you modify any other value to None, then existing CLI configuration
for type is deleted from the device.

• Custom Redirect URL- Configure a URL that redirects unauthenticated hosts to a
central Web authentication (CWA) server.

Type

Enter URL of the block messages.URL

Fallback Settings

The fallback options are used when the web filtering system experiences errors and must fallback to one of the
previously configured actions to either deny (block) or permit the object.

If you select None for the first time, the field in the CLI configuration is ignored. If you modify any other value to
None, then existing CLI configuration for the fields is deleted from the device.

Specifies all errors other than the categorized settings. These could include either
unhandled system exceptions (internal errors) or other unknown errors. Select an
action: None, Block, or Log and permit.

Default

Specifies that the server connection is not established during certain processes. Select
an action: None, Block, or Log and permit.

Server Connectivity

Specifies that if the time taken to scan exceeds the timeout setting in theWeb filtering
profile, the processing is terminated and the content is passed or blocked without
completing filtering. Select an action: None, Block, or Log and permit.

Timeout

Specifies that if the total number of messages received concurrently exceeds the
device limits, the content is passed or blocked depending on the too-many-request
fallback option. Select an action: None, Block, or Log and permit.

Too-many-requests
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Table 253: Default UTM Configuration Settings (continued)

DescriptionField

URL Categories

Select an URL category.

A URL category is a list of URL patterns grouped under a single title so a single action
that applies to all URL patterns can be performed on the list.

Click the + icon to select one or more URL categories, an action, and a redirect profile.
A redirect profile is applicable only for block and quarantine actions. You can create
a new redirect profile by clicking Create New Redirect Profile. The created redirect
profile is displayed in the Redirect Profile drop-down list. The following actions are
available:

• Log and Permit—Create a list of URL patterns that are logged, then permitted

• Block—Create a list of URL patterns that are denied access.

• Quarantine—Create a list of URL patterns that are quarantined.

• Permit—Create a list of URL patterns that are permitted.

Edit the action or redirect profile by clicking Apply Actions and updating the action
and redirect profile.

Delete the URL category by selecting the URL category and clicking the X icon.

Quarantine Message

Select a type of quarantine message.

• None—If you select None for the first time, the type in the CLI configuration is
ignored. If you modify any other value to None, then existing CLI configuration for
type is deleted from the device.

• Custom Redirect URL—Configure a URL that redirects unauthenticated hosts to a
central Web authentication (CWA) server.

Type

Enter a valid URL.URL

Server

This section is applicable only when the Web Filtering Profile type is Juniper Enhanced or Websense Redirect.

Enter the address of the host server.Host

Enter the port number of the server.Port

Site Reputation Action
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Table 253: Default UTM Configuration Settings (continued)

DescriptionField

Specify the action to be taken depending on the site reputation returned for all types of URLs whether it is categorized
or uncategorized.

This section is applicable only when the Web Filtering Profile type is Juniper Enhanced.

If you select None for the first time, the field in the CLI configuration is ignored. If you modify any other value to
None, then existing CLI configuration for the field is deleted from the device.

Permit, log and permit, block, or quarantine a request if a site-reputation of 70 through
79 is returned.

Fairly Safe

Permit, log and permit, block, or quarantine a request if a site-reputation of zero
through 59 is returned.

Harmful

Permit, log and permit, block, or quarantine a request if a site-reputation of 80 through
89 is returned.

Moderately safe

Permit, log and permit, block, or quarantine a request if a site-reputation of 60 through
69 is returned.

Suspicious

Permit, log and permit, block, or quarantine a request if a site-reputation of 90 through
100 is returned.

Very Safe

Click Reset to position the slider to the recommended levels.Reset

Antivirus

Antivirus Profiles by Traffic Protocol

Select the anti-virus engine that will be used on the device. Select an engine type:

• Anti-Virus None—If you select None for the first time, the type in the CLI
configuration is ignored. If you modify any other value to None, then existing CLI
configuration for type is deleted from the device.

• Sophos Engine—Sophos antivirus is an in-the-cloud antivirus solution. The virus
andmalware database is located on external servers maintained by Sophos (Sophos
Extensible List) servers, thus there is no need to download andmaintain large pattern
databases on the Juniper Networks device.

• Avira Engine—This provides a full file-based virus scanning functionwhich is available
through a licensed subscription service.

Type
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Table 253: Default UTM Configuration Settings (continued)

DescriptionField

Select a unique customized list of all URLs for a given category that are bypassed for
scanning.

To create a URL category, see “Creating Custom URL Category Lists” on page 823.

URL Allowlist

MIME Allowlist

EnterMIME types to createMIME bypass lists and exception lists. The device usesMIME types to decide which traffic
may bypass antivirus scanning. The MIME allowlist defines a list of MIME types and can contain one or many MIME
entries.

Enter the special MIME types you want to block over HTTP, FTP, SMTP, and POP3
connections. Use commas to separate each MIME type.

MIME Block List

Enter the special MIME types you want to permit over HTTP, FTP, SMTP, and POP3
connections. Use commas to separate each MIME type.

MIME Permit List

Scan Options

Select the check-box to enable URI check. It specifies Uniform Resource Identifier
blocking: an effective measure for preventing malware from reaching the endpoint.
URI lookup is performed against an in-the-cloud malicious/infected URI database on
each URI requested via HTTP.

URI Check

Specifies the accumulated TCP payload size. Enter the content size limit value from
20 to 40,000 kilobytes.

Content Size Limit

Specifies the number of layers of nested compressed files and files with internal
extractable objects, such as archive files (tar), the internal antivirus scanner can
decompress before it executes the virus scan.

Select a value between 0 to 10.

Decompress Layer Limit

Specifies the time frame from when the scan request is generated to when the scan
result is returned by the scan engine.

Enter the time interval from 1 to 1800 seconds.

Timeout

Enable or disable the anti-virus pre-detection.Pre Detection

Sophos Engine

General Settings
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Table 253: Default UTM Configuration Settings (continued)

DescriptionField

Specify the antivirus engine timeout. Select a value from 1 to 5 seconds.Timeout

Specifies the number of times to retry the Sophos antivirus engine query. Select the
number of retry value from 0 to 5.

Retry

Server

Specify the DNS Server IP. Enter a valid DNS server IP address.Server IP

Pattern Update

Specifies the URL of the database server. Enter the URL for the pattern database.URL

Specifies the interval at which the database server is queried for a new version of the
database. Enter the time interval for automatically updating the pattern database. The
range is from 10 to 10080 seconds. The default interval is 60 seconds.

Interval

Specifies that the automatic download and update of the antivirus engine and signature
database are disabled.

No Auto Update

Email Notify

Enter a valid admin e-mail ID to notify about the pattern file update.Admin Email

Specify the custom message subject for notification. Enter the subject of the custom
message.

Custom Message Subject

Enter the custom message for notification.Custom Message

Proxy

Enter the IP address or hostname of the proxy server.Proxy Server

Select the proxy server port. Port range is from 0 to 65535Port

Enter the username of the proxy server.Username

Enter the password for proxy server. It consists of up to 32 characters.Password

Re-enter the password to verify the login password for the proxy server.Confirm password

Fallback Settings
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Table 253: Default UTM Configuration Settings (continued)

DescriptionField

Specifies all errors other than the categorized settings. This could include either
unhandled system exceptions (internal errors) or other unknown errors. Select None,
Block, Log and Permit, or Permit action.

Default

Specifies that if the content size exceeds a set limit, the content is passed or blocked
depending on the max-content-size fallback option. Select None, Block, Log and
Permit, or Permit action.

Content Size

Specifies that the scan engine is not ready during certain processes, for example, while
the signature database is loading. Select None, Block, Log and Permit, or Permit action.

Engine-not-ready

Specifies that if the time taken to scan exceeds the timeout setting in the antivirus
profile, the processing is terminated and the content is passed or blocked without
completing the virus checking. Select None, Block, Log and Permit, or Permit action.

Timeout

Specifies the resource constraints error received during virus scanning. This error can
be sent by the scan engine (as a scan-code) or scan manager. When the system is out
of resources occurs, scanning is terminated. Select None, Block, Log and Permit, or
Permit action.

Out-of-resources

Specifies that if the total number of messages received concurrently exceeds the
device limits, the content is passed or blocked depending on the too-many-request
fallback option. Select None, Block, Log and Permit, or Permit action.

Too-many-requests

Trickling

Specifies the mechanism used to prevent the HTTP client or server from timing-out
during a file transfer or during antivirus scanning.

Enter the trickling timeout interval from 0 to 600 seconds.

Trickling Timeout

Virus Detection

Specifies the type of notification to be sent when a virus is detected. Select Protocol
Only or Message options.

• None—If you select None for the first time, the type in the CLI configuration is
ignored. If you modify any other value to None, then existing CLI configuration for
type is deleted from the device.

• Message—Send a generic notification.

• Protocol-only—Send a protocol-specific notification.

Type
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Table 253: Default UTM Configuration Settings (continued)

DescriptionField

Specifies whether or not a notification is sent to the virus-detection notification e-mail
address when a virus is detected. Enable to send a notification and disable to not send
a notification.

Notify Mail Sender

Specifies the subject line text for your custom message for the virus detection
notification. Enter the subject line text for your custom message.

Custom Message Subject

Specifies the customized message text for the virus detection notification. Enter the
text for the custom notification message.

Custom Message

Fallback Block

Specifies the type of notification sent when a fallback option of block is triggered.
Select Protocol Only or Message options.

• Message-Send a generic notification.

• Protocol-only—Send a protocol-specific notification.

Type

Specifies that when a virus is detected and a fallback option of block is triggered, an
e-mail is sent to the administrator. Enable this option.

Notify Mail Sender

Specifies the subject line text for your custom message for the fallback block
notification. Enter the subject line text for your custom message.

Custom Message Subject

Specifies the customized message text for the fallback block notification. Enter the
text for this custom notification message.

Custom Message

Fallback Non Block

Specifies that the fallback nonblock notification is sent when a fallback e-mail option
without a blocking action is triggered. Enable the option.

Notify Mail Recipient

Specifies the subject line for your custom message for the fallback nonblock
notification. Enter the subject line text for your custom message.

Custom Message Subject

Specifies the customized message text for the fallback nonblock notification. Enter
the text for this custom notification message.

Custom Message

Avira Engine
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Table 253: Default UTM Configuration Settings (continued)

DescriptionField

The scan engine, Avira, scans the data by accessing the virus pattern database. It provides a full file-based anitvirus
scanning function that is available through a separately licensed subscription service. When your antivirus license key
expires, you can continue to use the locally stored antivirus signatures without any updates. If you delete the local
database, then antivirus scanning is also disabled.

You can download and install the antivirus scan engine on your SRX Series device either manually or by using the
Internet to connect to a Juniper Networks-hosted URL or a user-hosted URL. The virus pattern database is located
at https://update.juniper-updates.net/avira. By default, the pattern updates are downloaded through the SRX Series
devices.

After configuring Avira as the antivirus type, reboot the device for the new scan engine to take effect.

On Box AV Load Flavor

The on-device antivirus scan engine scans the data by accessing the virus pattern
database. Select the on-box Antivirus traffic load type.

Type

Pattern Update

Specifies the URL of the database server. Enter the URL for the pattern database.URL

Specifies the interval at which the database server is queried for a new version of the
database. Enter the time interval for automatically updating the pattern database. The
range is from 10 through 10080 seconds. The default interval is 60 seconds.

Interval

Specifies that the automatic download and update of the antivirus engine and signature
database are disabled.

No Auto Update

Specifies the time when the device automatically starts downloading the updated
signature database from the specified URL. Enter a value in the format:
YYYY-MM-DD.HH:MM:SS

Start Time

Email Notify

Enter a valid administrator e-mail ID for notifying about the pattern file update.Admin Email

Specify the custom message subject for notification. Enter the subject of the custom
message.

Custom Message Subject

Enter the custom message for notification.Custom Message

Antispam
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Table 253: Default UTM Configuration Settings (continued)

DescriptionField

Antispam Profiles by Traffic Protocol

Select an address allowlist for local spam filtering. Allowlist include addresses that
you want to exclude from undergoing antispam processing. These lists are configured
as custom objects. To create a list of URLs for allowlist, see “Creating URL Patterns”
on page 821.

NOTE: When both the allowlist and blocklist are in use, the allowlist is checked first.
If there is no match, then the blocklist is checked.

Address Allowlist

Specifies a list of MIME types to be excluded from the allowlist. These lists are
configured as custom objects. To create a list of URLs for blocklist, see “Creating URL
Patterns” on page 821.

NOTE: When both the allowlist and blocklist are in use, the allowlist is checked first.
If there is no match, then the blocklist is checked.

Address Blocklist

Specify the antispam type.

• Anti-spam None—If you select None for the first time, the type in the CLI
configuration is ignored. If you modify any other value to None, then existing CLI
configuration for type is deleted from the device.

• Anti-spam Sophos sbl—Select this option to use a third-party server-based spam
block list (SBL).

Type

Select this option to use server-based spam filtering. Un-select the check box to use,
local spam filtering.

Server-based antispam filtering requires Internet connectivity with the spam block
list (SBL) server. Domain Name Service (DNS) is required to access the SBL server.
The firewall performs SBL lookups through the DNS protocol.

NOTE: Server-based spam filtering supports only IP-based spam block list blocklist
lookup. Sophos updates and maintains the IP-based spam block list. Server-based
antispam filtering is a separately licensed subscription service.

Sophos Blocklist

Action
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Table 253: Default UTM Configuration Settings (continued)

DescriptionField

Select a default antispam action that the device should take when it detects spam.

• None—If you select None for the first time, the default action in the CLI configuration
is ignored. If you modify any other value to None, then existing CLI configuration
for default action is deleted from the device.

• Block e-mail—Block the spam e-mail.

• Tag header of e-mail—Add the custom string to the e-mail header.

• Tag subject of e-mail—Add the custom string at the beginning of the subject of an
e-mail.

Default Action

Enter a custom string for identifying a message as spam. Maximum length is 512
characters. By default, the device uses ***SPAM***.

Custom Tag

Content Filtering

Content Filtering Profiles by Traffic Protocol

Enter the protocol commands to be blocked. Use commas to separate each command.

Use content filtering to block specific commands for HTTP, FTP, SMTP, IMAP, and
POP3 protocols.

Command Block List

Enter the protocol commands to be permitted. Use commas to separate each command.

Use content filtering to block specific commands for HTTP, FTP, SMTP, IMAP, and
POP3 protocols.

Command Permit List

Select the content filtering type. The options are Content-Filtering None and Content
filtering local.

Type

Select types of harmful HTTP content you want to block that the MIME type or file
extension cannot control.

• Active X

• Windows executables (.exe)

• HTTP cookie

• Java applet

• ZIP files

Block Content Type

Enter the file extensions that you want to block over HTTP, FTP, SMTP, IMAP, and
POP3 connections. Use only commas to separate values and the maximum allowed
characters for each value is 29 characters. Do not use spaces to separate values. For
example: exe,pdf,js

Extension Block List
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Table 253: Default UTM Configuration Settings (continued)

DescriptionField

Enter the special MIME types you want to block over HTTP, FTP, SMTP, and POP3
connections. Use commas to separate each MIME type.

MIME Block List

Enter the special MIME types you wish to permit over HTTP, FTP, SMTP, and POP3
connections. Use commas to separate each MIME type.

MIME Permit List

Notification Options

Select the check box to notify sender when a content block is triggered.Notify Mail Sender

Specifies the type of notification sentwhen a content block is triggered. Select Protocol
or Message.

• Message—Send a generic notification.

• Protocol-only—Send a protocol-specific notification.

Notification Type

Specifies the customized message text for the content-block notification. Enter the
text for the custom notification message. Maximum length is 512 characters.

CustomNotificationMessage
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You can edit or clone the default configurations.

Edit the Default Configuration

To edit the default configuration:

1. Select Configure > UTM Policy > Default Configuration.

The Default Configuration page is displayed.

2. Select the policy and click pencil icon or right-click the policy and select Edit Policy.

TheModify Default Configuration page is displayed, showing the same options as when creating a new
configuration.

3. Click OK.

Clone the Default Configuration

To clone the default configuration:

1. Select Configure > UTM Policy > Default Configuration.

The Default Configuration page is displayed.

2. Right-click the policy or select Clone from the More list.

The Clone Default Configuration page is displayed.

3. Click OK.
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View and Delete Unused Default Configuration

IN THIS SECTION
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Deleting Unused Default Configuration | 820

You can view and delete the default configuration that are not used anywhere in the network.

View Unused Default Configuration

To view the unused default configuration:

1. Select Configure > UTM Policy > Default Configuration.

The Default Configuration page is displayed.

2. Right-click the policy or select Show Unused from More list.

A list of unused default configuration, which are not referenced in any policy, appear on the page.

Deleting Unused Default Configuration

To delete the unused default configuration:

1. Select Configure > UTM Policy > Default Configuration.

The Default Configuration page is displayed.

2. Right-click the policy or select Delete Unused Items from the More list.

A confirmation window appears before you delete the unused configuration.

3. Click Yes to confirm the deletion.

The selected unused items are deleted.
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CHAPTER 78

UTM Policy-URL Patterns
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Creating URL Patterns

Use the Create URL Patterns page to create customURL patterns. A URL pattern is a list of URLs organized
into a group. You can later assign this list to a URL category.

Before You Begin

• Read the “UTM Overview” on page 759 topic.

• Decide what kind of filtering you want for the UTM policy: Web filtering, antispam, antivirus, or content
filtering.

To create URL patterns:

1. Select Configure > UTM Policy > URL Patterns.

2. Click the + icon to create a new custom URL pattern list.

3. Complete the configuration according to the guidelines provided in Table 254 on page 821.

4. Click Finish. A new custom URL pattern list is created.

Table 254: URL Pattern Settings

GuidelinesSettings

General Information
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Table 254: URL Pattern Settings (continued)

GuidelinesSettings

Enter a unique name for the URL category that is a string of alphanumeric characters, colons,
periods, dashes, and underscores. No spaces are allowed and the maximum length is 29
characters.

Name

Enter a description for the URL pattern list; maximum length is 255 characters.Description

Enter URLs in the Add URLs box, and click Add. Separate multiple URLs with commas. The
URL List field supports the *, ., [, ], and ? wildcard characters. Precede all wildcard characters
with http://. You can only use * at the beginning of a URL followed by a period, and you
can only use ? at the end of a URL.

Add URLs
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CHAPTER 79

UTM Policy-Custom URL Categories
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Creating Custom URL Category Lists

Use the Create URL Category page to create custom URL category lists. A URL category is a list of URL
patterns grouped under a single title.

NOTE: This page will also list the predefined URL categories.

Before You Begin

• Read the “UTM Overview” on page 759 topic.

• Decide what kind of filtering you want for the UTM policy: Web filtering, antispam, antivirus, or content
filtering.

To create URL category lists:

1. Select Configure > UTM Policy > Custom URL Categories.

2. Click the + icon to create a new custom URL category list.

3. Complete the configuration according to the guidelines provided in Table 255 on page 824.

4. Click Finish. A new custom URL category list is created.
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Table 255: URL Category Lists Settings

GuidelinesSettings

General Information

Enter a unique name for the URL category that is a string of alphanumeric characters, colons,
periods, dashes, and underscores. No spaces are allowed and the maximum length is 29
characters.

Name

Enter a description for the URL category list; maximum length is 255 characters.Description

To add URLs to a list, select the URLs in the Available column and move them to the Selected
column.

Click Create a New Pattern to create a new URL pattern. Note: A URL pattern is a list of URLs
organized into a group. You can later assign this list to a URL category.

Separate multiple URLs with commas. The URL List field supports the *, ., [, ], and ? wildcard
characters. Precede all wildcard characters with http://. You can only use * at the beginning
of a URL followed by a period, and you can only use ? at the end of a URL.

URL Patterns
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Understanding Application-Based Routing

The relentless growth of voice, data, and video traffic and applications traversing the network requires
that networks recognize traffic types to effectively prioritize, segregate, and route traffic without
compromising performance or availability. SRX Series Services Gateways support advanced policy-based
routing (APBR), also known as application-based routing, to address these requirements.

APBR is a type of session-based, application-aware routing. This mechanism combines policy-based routing
with an application-aware traffic management solution. APBR implies classifying flows based on the
attributes of the applications and applying filters based on these attributes to redirect the traffic. The
flow-classifying mechanism is based on packets representing the application in use.

APBR implements:

• Deep packet inspection (DPI) and pattern-matching capabilities of application identification to identify
application traffic or a user session within an application

• Lookup in the application system cache (ASC) for application type and the corresponding destination IP
address, destination port, protocol type, and service for a matching rule
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If a matching rule is found, the traffic is directed to an appropriate route and the corresponding interface
or device.

APBR provides the following advantages:

• Enables you to define the routing behavior based on application attributes.

• Extends the scope of static routes by providing more flexible traffic-handling capabilities by offering
granular control for forwarding packets based on application attributes.

APBR involves the following workflow:

• Creating an APBR profile (also referred to as an application profile in this document) that will match the
type of traffic that you are going to direct to a different next hop. The profile includes multiple rules.
Each rule can contain multiple applications or application groups. If the application matches any of the
application or application groups of a rule in a profile, the application profile rule is considered as a match.

• Associating a routing instance with the application profile rule. When the traffic on the ingress zone and
interface matches an application profile, the associated static route and next hop defined in the routing
instance are used to route the traffic for the particular session.

• Associating the application profile to the ingress traffic. The application profile can be attached to a
security zone or it can be attached to a specific logical or physical interface associated with the security
zone. If the application profile is applied to a security zone, then all interfaces belonging to that zone
are attached to the application profile by default unless a specific configuration already exists for that
interface.

Figure 58 on page 827 shows the sequence in which APBR techniques are applied.
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Figure 58: APBR Flow Diagram

The following procedure explains the application-based routing:

1. APBR evaluates the packets based on incoming interface to determinewhether the session is a candidate
for application-based routing. If the traffic has not been flagged for application-based routing, it
undergoes normal processing (non-APBR route).

2. If the session needs application-based routing, APBR queries the application system cache (ASC)module
to get the application attributes details (IP address, destination port, protocol type, and service).

If the application is found, it is further processed for a matching rule in the APBR profile (see Step 3).

3. APBR uses the application details to look for a matching rule in the APBR profile (application profile).
If a matching rule is found, the traffic is redirected to the specified routing instance for route lookup.
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About the App Based Routing Page | 833

About the Application Routing Policies Page

To access this page, select Configure > App Routing Policies.

Use the Application Routing Policies page to configure advanced policy-based routing (APBR) profiles. In
advanced WAN routing space, the need for application-aware routing is gaining popularity. Enterprise
customers and cloud service providers are taking a software-definedWAN (SD-WAN) approach tominimize
the operating cost and to improve or optimize resource usage. The APBR profiles support such emerging
network deployments. APBR provides a capability to specify routes based on certain attributes of an end
user application. The APBR profile evaluates the application-aware traffic and permits or denies traffic
based on the applications and application groups.

Tasks You Can Perform

You can perform the following tasks from this page:

• Create an APBR policy. See “Configuring Advanced Policy-Based Routing Policy” on page 829

• Manage an APBR policy.

• Create andmanage APBR policy rules. See “Creating Advanced Policy-Based Routing Rules” on page 832

Field Descriptions

Table 256 on page 828 provides guidelines on using the fields on the Application Routing Policies page.

Table 256: Fields on the Application Routing Policies Page

DescriptionField

Specifies the name of the APBR policy.Policy Name

Specifies the number of rules created for the APBR policy.Rules

Specifies the number of devices associated with the APBR policy.Devices

Specifies the publish and update status of the APBR policy.Deployment Status

Specifies the last modified date and time of the APBR policy.Last Modified

Specifies the username of a user who created the APBR policy.Created By
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Table 256: Fields on the Application Routing Policies Page (continued)

DescriptionField

Specifies the description of the APBR policy, if any.Description

Specifies the domain name to which the APBR policy is associated.Domain
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Configuring Advanced Policy-Based Routing Policy

You can use the Add APBR Policy page to create an advanced policy-based routing (APBR) profile (also
known as an application profile) to match applications and application groups and redirect the packets that
match the profile to the specified routing instance for route lookup. The APBR profile evaluates the
application-aware traffic and permits or denies traffic based on attributes of the applications and application
groups. The context established in the first packet of a session must match the context contained in all
subsequent packets, if a session is to remain active.

The APBR profile is associated to the ingress traffic. The application profile can be attached to a security
zone or it can be attached to a specific logical or physical interface associated with the security zone.

To configure an APBR profile:

1. Select Configure > Application Routing Policies.

The Application Routing Policies page appears.

2. Click the create icon (+).

The Add APBR Policy page appears.

3. Complete the configuration by using the guidelines in Table 257 on page 830.

4. Click OK to complete the configuration.
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A new APBR profile is created. Click Add Rule or the policy name to configure policy rules. See “About
the Rules Page (Advanced Policy-Based Routing)” on page 830.

Click Cancel to discard the configuration.

Table 257: Fields on the Add APBR Policy Page

DescriptionField

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores.
No spaces are allowed; maximum length is 63 characters.

Name

Enter a description for the APBR profile; maximum length is 255 characters.Description

Select one or more devices to associate themwith a policy. However, a device can have only
one APBR policy associated, at a time.

Select a device in the Available column and move it to the Selected column.

Devices
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About the Rules Page (Advanced Policy-Based Routing)

To access this page, select Configure > App Routing Policies > Policy Name or Rules.

Use this page to create, edit, clone, or delete APBR policy rules. An APBR profile includes multiple rules.
Each rule can contain multiple applications or application groups. If an application profile matches any of
the application or application groups of a rule in a profile, the application profile rule is considered to be
a match. The traffic is then redirected to the defined routing instance for the route lookup.
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Tasks You Can Perform

You can perform the following tasks from this page:

• Create a new rule. See “Creating Advanced Policy-Based Routing Rules” on page 832.

• Edit, clone, or delete the rule. Hover over the rule name and click a specific icon to edit, clone, or delete
a rule.

Field Descriptions

Table 258 on page 831 provides guidelines on using the fields on the Rules page.

Table 258: Fields on the Rules Page

DescriptionField

Specifies the source zone (to-zone) that defines the context for the policy.Source

Specifies the application that is associated with the rule for matching.Application

Specifies a specific routing instance to which the device sends the matched
packets.

Routing Instance

Specifies the name of the rule.Rule Name
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Creating Advanced Policy-Based Routing Rules

Use this page to configure rules for an advanced policy-based routing (APBR) profile (also known as an
application profile). You can then associate the rules with one or more than one applications (example: for
HTTP) or application groups.

To create a rule:

1. Select Configure > Application Routing Policies.

The Application Routing Policies page appears.

2. Click the policy name or rules.

The Rules page appear.

3. Click the add icon (+).

4. Complete the configuration according to the guidelines provided in Table 259 on page 832.

5. Click Save.

The rules you configured are associated with the selected policy.

Table 259: Fields on the Rule Page

DescriptionFields

Click the add icon (+) to select a source zone from the list.

You can select one or more zones for the application profile.

Source

Click the add icon (+) to select the application from the list.

If the application matches any of the application or application groups of a rule in a profile, the
application profile rule is considered as a match.

You can select one or more applications.

Application

Click the + icon to select a routing instance from the list, that are configured on a device. The
device sends thematched packet to the specified routing instance. The routing instances specify
the routing table and the destination to which a packet is forwarded.

When traffic arrives at the specified zone, it is matched by the advanced application profile. The
application profile matches applications and application groups and if thematching rule is found,
the packets are routed to the routing instance that sends the traffic to a different interface as
specified in the next-hop IP address.

Routing Instance
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Table 259: Fields on the Rule Page (continued)

DescriptionFields

The rule name is automatically generated by Security Director. For example, Rule-incremental
value.

Rule Name

NOTE: AnAPBR policy designed in Security Director is equal to one or more policies on a device,
based on the unique security zones and rule set.
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About the App Based Routing Page

To access this page, selectMonitor > App Based Routing.

You can use the App Based Routing page to monitor the APBR profile data. You can view information on
the link utilization of an application for a selected duration, top ten applications using the app based routing,
list of devices, and a step graph showing how many times an application took an APBR path and a default
path.

Tasks You Can Perform

You can perform the following task from this page:

• Monitor the overall link usage, device level utilization of link usage, and step graph representation of
application routing information.

Field Descriptions

Table 260 on page 834 provides guidelines on using the widgets on the App Based Routing page.
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Table 260: Widgets on the App Based Routing Page

DescriptionWidget

Shows top ten applications with their throughput in Mbps.Top 10 Applications

Shows a graphical representation for how long an application took APBR path and default
path, for a selected duration. The data is shown for all devices.

By default, the result is shown for all applications. To view the result for any particular
application, select the application from the Apps list. You can also choose the time period.

Preferred vs Default Link
Usage

Shows list of devices assigned with the APBR profile. The list contains the root devices,
logical systems (LSYS), and tenant systems (TSYS).

Click on the device name to view more details on the link usage and other information
about APBR at the device level, as described in Table 261 on page 834.

Devices List

Table 261: Widgets for the Selected Device

DescriptionWidget

Shows a graphical representation of different interfaces of a device and
applications using those interfaces.

Links

Shows top 10 applications with the most sessions for the selected time period.Top 10 Applications

Select a required interface from the list and view the link utilization data by
different applications.

You can filter the data for a different time period.

Link Utilization

Shows a graphical representation for how long an application took APBR path
and default path, for a selected duration. This data is shown for the selected
device.

App Routing: Preferred vs Default
Link Usage

Shows an overall statistics of all applications taking the APBR path and default
path, for a selected duration. The data is shown for the selected device.

Preferred vs Default Link Usage
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Edit and Clone Policies and Objects
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You can edit or clone policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Edit Policies or Objects

To edit a policy or a shared objects:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to edit, and then click the pencil icon.

The Edit window appears, showing the same options as when creating a new policy or object.

3. Click OK to save your changes.

NOTE: After the published firewall policy rules are edited and saved, you see an icon next to
the check box for each saved policy rule on the Firewall Policies page. When you hover over the
icon, a message appears, indicating that the policy was edited and needs to be pushed to the
device. For updating the policy, see “Updating Policies on Devices” on page 478.
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Clone Policies or Objects

To clone a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to clone, or select Clone from the More list.

The Clone window appears with editable fields.

3. Click OK to save your changes.
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Assigning Devices to Policies

Once you create a group or device policy, you can assign devices to it.

To assign devices to a policy:

1. Select Configure >Policy-Name Policy> Policies.

The Policies landing page appears.

2. Right-click the policy to which you want to assign devices, or select Assign Devices from the More
menu.

The Assign Devices page appears. The Name field shows the name of the selected policy and is not
editable.

3. Select the Show only devices without policy assigned check box.

Only devices that are not assigned to any policy are displayed in the Device Selection section.

4. Select the devices you want to add to the policy from the Available column and click the right arrow
to move these devices to the Selected column.
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NOTE: There is an option to search for devices in the Selected column on the Assign Devices
page. By default, all selected devices are sorted in a list and you can search for devices again,
if required.

5. Click OK to assign the selected devices to the selected policy.

NOTE: If you do not have permission to certain devices, those devices are not visible while
assigning devices to a new or existing policy.

RELATED DOCUMENTATION
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Customizing Profile Names

You can customize the profile names, which are automatically generated by Security Director. Each
automatically created profile contains rules and these rules are associated to a zone. For example, you add
two rules to an application-based policy and assign the rules to zone 10 and add the third rule and assign
it to zone 11, then the first two rules are automatically created as one profile and the third rule is
automatically created as another profile.

To customize the profile names:

1. Select Configure > Application Policy Based Routing.

The Application Policy Based Routing page is displayed.

2. Right-click the policy name for which you want to customize the profile or select Configure profile
from theMore menu.

The Configure profile page is displayed. Its displays the zones configured on the rules and the profile
name.

3. Click the profile name and enter the customized profile name.

4. Click OK to customize the profile names.
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Publishing Policies

When you publish rules, the process takes into account the priority and precedence values set on the
policy and the order of rules on the device. Rules are published in the order of their priority groups, with
prerules in the High priority group publishing first, before prerules in theMedium and Low priority groups.

If you change the priority or precedence of a published policy, the policy must be republished for the
changes to take effect. Sometimes, changing priority or precedence in one policy can affect other policies
in the same priority group. However, such policies do not need to be republished in order for their changes
in priority or precedence to take effect for the policies that are implicitly changed by the explicit changes
to the republished policy.

To publish a policy:

1. Select Configure > Policy-Name Policy > Policies.

2. Select the policy that you want to publish and click Publish. The Publish Policy page appears.

3. Select the check boxes next to the devices to which the policy changes will be published.

NOTE: You can search for a specific device on which the policy is published by entering the
search criteria in the search field. You can search the devices by their name and IP address.

4. Select Schedule at a later time if you want to schedule and publish the configuration later.

5. Select Run now if you want to apply the configuration immediately.

6. Click Publish. The Affected Devices page displays the devices on which the policies will be published.
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Updating Policies on Devices

When you finish creating and verifying your security configurations, you can publish these configurations
and keep them ready to be pushed to the security devices. Security Director helps you push all the security
configurations to the devices all at once by providing a single interface that is intuitive.

The Publish workflow provides the ability to save and publish different services to be updated at a later
time to the appropriate firewalls (during the down time). This permits administrators to review their firewall,
VPN, and NAT policies before updating the device. This saves administrators troubleshooting time, avoid
errors, and saves costs associatedwith errors. Verify and tweak your security configurations before updating
them to the device by viewing the CLI and XML version of the configuration in the Publish workflow. This
approach helps you keep the configurations ready and update these configurations to the devices during
the maintenance window.

When you publish rules, the process takes into account the priority and precedence values set on the
policy and the order of rules on the device. Rules are published in the order of their priority groups, with
prerules in the High priority group publishing first, before prerules in theMedium and Low priority groups.

If you change the priority or precedence of a published policy, the policy must be republished for the
changes to take effect. Sometimes, changing priority or precedence in one policy can affect other policies
in the same priority group. However, such policies do not need to be republished in order for their changes
in priority or precedence to take effect for the policies that are implicitly changed by the explicit changes
to the republished policy.

To update a policy:

1. Select Configure > Policy-Name Policy > Policies. Select the policy that you want to update and click
Update. The Update Policy page appears.

2. Select the policy that you want to update and click Update. The Update Policy page appears.

3. Select the check boxes next to the devices to which the policy changes will be published.

NOTE: You can search for a specific device on which the policy is published by entering the
search criteria in the search field. You can search the devices by their name and IP address.

4. Select Schedule at a later time if you want to schedule and publish the configuration later.
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5. Select Run now if you want to apply the configuration immediately.

6. Click Publish. The Affected Devices page displays the devices on which the policies will be published.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Creating IPS Policies | 640

Creating NAT Policies | 707

Publishing Policies | 653

840



CHAPTER 81

Threat Prevention - Policies

IN THIS CHAPTER

Creating Threat Prevention Policies | 841

Threat Prevention Policy Overview | 848

Threat Policy Analysis Overview | 850

Implementing Threat Policy on VMWare NSX | 850

Creating Threat Prevention Policies

You can create threat prevention policies for various profiles from the Policies page.

NOTE: If you are creating policies for the first time, you are given the option of setting up Policy
Enforcer with ATP Cloud or configuring ATP Cloud alone. Clicking either button takes you to
quick setup for your selection. See “Comparing the Juniper Connected Security and non-Juniper
Connected Security Configuration Steps” on page 1120 for a configuration comparison.

Before You Begin

• Determine the type of profile you will use for this policy; command & control server, infected hosts,
malware. You can select one or more threat profiles in a policy. Note that you configure Geo IP policies
separately. See “Creating Geo IP Policies” on page 1018.

• Determine what action to take if a threat is found.

• Know what policy enforcement group you will add to this policy. To apply the policy, you must assign
one or more policy enforcement groups. See the instructions for assigning groups to policies at the
bottom of this page.

• Once policies are configured with one more groups assigned, you can save a policy in draft form or
update it. Policies changes do not go live until they have been updated.
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• If you are using Juniper ATP Cloud without Policy Enforcer, you must assign your threat prevention
policy to a firewall rule for it to take affect. See the instructions at the bottom of this page.

• If you delete a threat prevention policy that is assigned to a policy enforcement group, a status screen
appears displaying the progress of the deletion and the affected configuration items.

To create a threat prevention policy:

1. Select Configure>Threat Prevention > Policies.

2. Click the + icon.

The Create Threat Prevention Policy page appears.

3. Complete the configuration by using the guidelines in theTable 262 on page 842, Table 263 on page 843,
Table 264 on page 843, Table 265 on page 844, and Table 266 on page 846 below.

4. Click OK.

Table 262: Fields on the Threat Prevention Policy Page

DescriptionField

Enter a unique string that must begin with an alphanumeric character and can include
underscores; no spaces allowed; 63-character maximum.

Name

Enter a description;maximum length is 1024 characters. You shouldmake this description
as useful as possible for all administrators.

Description

Include the following profiles to your threat prevention policy. Youmust include at least
one profile. An error message is shown if you try to create the threat prevention policy
without selecting a profile.

• C&C profile—See Table 263 on page 843.

• Infected host profile—See Table 264 on page 843.

• Malware profile—See Table 265 on page 844.

• DDoS profile—See Table 266 on page 846.

Profiles

Select the log setting for the policy. You can log all traffic, log only blocked traffic, or
log no traffic.

Log Setting (Policy
setting for all profiles)

Table 263 on page 843 shows the management of command and control server threat in a policy.

842



Table 263: C&C Server Profile Management

DescriptionField

Select and choose settings for command and control servers. A C&C is a centralized computer
that issues commands to botnets (compromised networks of computers) and receives reports
back from them. Botnets can be used to gather sensitive information, such as account numbers
or credit card information, or to participate in a distributed denial-of-service (DDoS) attack.

CommandandControl
Server

Select the check box to include management for this threat type in the policy.Include C& C profile in
policy

Use the slider to change the action to be taken based on the threat score. Threat scores are
assigned using several criteria. Refer to themonitoring pages in the UI to investigate, located
underMonitor > Threat Management.

Threat Score

If the threat score is high enough to cause a connection to be blocked, you have following
configurable options:

• Drop connection silently (This is the default and recommended setting.)

• Close connection and do not send a message

• Close connection and redirect to URL—In the field provided, enter a URL to redirect
users to when connections are dropped.

• Send custom message—In the field provided, enter a message to be shown to users
when connections are dropped.

Actions

Table 264 on page 843 shows the management of infected host threat in a policy.

Table 264: Infected Host Profile Management

DescriptionField

Infected hosts are systems for which there is a high confidence that attackers have gained
unauthorized access. Infected hosts data feeds are listed with the IP address or IP subnet of
the host, along with a threat score.

Infected Host

Select the check box to include management for this threat type in the policy.

NOTE: If you want to enforce an infected host policy within the network, you must include a
switch in the site.

Include infected host
profile in policy
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Table 264: Infected Host Profile Management (continued)

DescriptionField

You have following options:

• Drop connection silently (This is the default and recommended setting.)

• Monitor—Choose this option to log all the traffic for certain infected hosts and monitor it.
You can then choose to perform any action on the monitored data.

NOTE: The PEG must contain only Space subnets or devices. The Monitor action for the
infected host profile is not applicable to any third party connector devices. An error message
is shown.

• Quarantine—In the field provided, enter a VLAN to which quarantined files are sent. (Note
that the fallback option is to block and drop the connection silently.)

Actions

Table 265 on page 844 shows the management of malware threat in a policy.

Table 265: Malware Threat Profile Management

DescriptionField

Malware is files that are downloaded by hosts or received as email attachments and found
to be suspicious based on known signatures, URLs. or other heuristics.

Malware (HTTP file
download, SMTP File
attachment, and IMAP
attachments)

Select the check box to include management for this threat type in the policy.Include malware profile in
policy

Turn this feature on to scan files downloaded over HTTP and then select a file scanning
device profile. The device profile is configured using Juniper ATP Cloud.

HTTP file download

Turn this feature to scan encrypted files downloaded over HTTPS.Scan HTTPS

Select ATP Cloud device profile. This is configured through ATP Cloud. ATP Cloud profiles
let you define which files to send to the cloud for inspection. You can group types of files
to be scanned together under a common name and create multiple profiles based on the
content you want scanned.

Device Profile
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Table 265: Malware Threat Profile Management (continued)

DescriptionField

If the threat score is high enough to cause a connection to be blocked, you have following
configurable options:

• Drop connection silently (This is the default and recommended setting.)

• Close connection and do not send a message

• Close connection and redirect to URL—In the field provided, enter a URL to redirect
users to when connections are dropped.

• Send custom message—In the field provided, enter a message to be shown to users
when connections are dropped.

Actions

Turn this feature on to inspect files received as email attachments (over SMTP only).SMTP File Attachments

Enable this option to configure reverse proxy for SMTP.

The reverse proxy does not prohibit server certificates. It forwards the actual server
certificate or chain as is to the client without modifying it.

Scan SMTPS

If you do not click the Change button to select a device profile for SMTP scanning, the
device profile selected for HTTP will be used by default.

Select Change to use a different device profile for SMTP.

Device profiles are configured through ATP Cloud and define which files to send to the
cloud for inspection.

Device Profile

Use the slider to change the action to be taken based on the threat score. Threat scores
are assigned using several criteria. This threat score applies to all malware, HTTP and
SMTP. (Note: There is no monitoring setting for malware.)

Threat Score

Actions for SMTP File Attachments include: Quarantine, Deliver malicious messages with
warning headers added, and Permit. This actions are set in ATP Cloud. Refer to the Juniper
ATP Cloud documentation for information.

Actions

Turn this feature on to select a a file scanning device profile and threat score ranges to
apply to IMAP e-mails.

IMAP Attachments

Enable this option to configure reverse proxy for IMAP e-mails.Scan IMAPS
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Table 265: Malware Threat Profile Management (continued)

DescriptionField

If you do not click the Change button to select a device profile for IMAP scanning, the
device profile selected for HTTP will be used by default.

Select Change to use a different device profile for IMAP.

Device profiles are configured through ATP Cloud and define which files to send to the
cloud for inspection.

Device Profile

Actions for IMAP Attachments include: Block, Deliver malicious messages with warning
headers added, and Permit. This actions are set in ATP Cloud. Refer to the Juniper ATP
Cloud documentation for information.

Actions

Use the slider to change the action to be taken based on the threat score. Threat scores
are assigned using several criteria. This threat score applies to all malware, HTTP, SMTP,
and IMAP. (Note: There is no monitoring setting for malware.)

Threat Score

Table 266 on page 846 shows the management of DDoS threat in a policy

Table 266: DDoS Threat Profile Management

DescriptionField

Enable this option to include themanagement of Distributed denial-of-service (DDoS) protection
that enables the MX router to quickly identify an attack and prevent a flood of malicious control
packets from exhausting system resources.

When you create a threat policy for the DDoS profile, it is not pushed to the device because the
policy is not yet assigned to any device. Assign the policy to the policy enforcement group.
Because the policy is created for the MX router, rule analysis is not initiated when a policy is
assigned to the policy enforcement group (PEG).

Include DDoS
Profile in Policy

Select the following actions from the list for the DDoS profile:

• Block—Use this option to block the DDoS attack.

• Rate Limit Value—Use this option to limit the bandwidth on the flow route. You can express
the rate limit value in Kbps, Mbps, or Gbps units. The rate limit range is 10Kbps to 100Gbps.

• Forward to—Use this option to configure the routing next hop to forward the packets for
scrubbing.

Actions

Specify a routing instance to which packets are forwarded in the as-number:community-value
format, where each value is a decimal number. For example, 65001:100.

Scrubbing Site
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Once you have a threat prevention policy, you assign one or more groups to it:

1. In the threat prevention policy main page (located under Configure>Threat Prevention > Policy), find
the appropriate policy.

2. In the Policy Enforcement Groups column, click theAssign toGroups link that appears herewhen there
are no policy enforcement groups assigned or click the group name that appears in this column to edit
the existing list of assigned groups. You can also select the check box beside a policy and click the
Assign toGroups button at the top of the page. See “Policy EnforcementGroupsOverview” on page 1024
.

For the infected host profiles created with Monitor action, you cannot assign a policy enforcement
group if it contains only the third-party connector devices or the combination of both Junos Space and
third-party connector devices. You must have only the Junos Space subnets in the policy enforcement
groups to assign them to the infected host profiles with Monitor action.

If you edit an existing infected host profile with either Drop Connection or Quarantine action toMonitor
action, you cannot assign any policy enforcement group having only third-party connector devices or
the combination of Junos Space and third-party connector devices.

3. In the Assign to Groups page, select the check box beside a group in the Available list and click the >
icon to move it to the Selected list. The groups in the Selected list will be assigned to the policy.

4. Click OK.

5. Once one or more policy enforcement groups have been assigned, a Ready to Update link appears in
the Status column. You must update to apply your new or edited policy configuration. Clicking the
Ready to Update link takes you the Threat Policy Analysis page. See “Threat Policy Analysis Overview”
on page 850. From there you can view your changes and choose to Update now, Update later, or Save
them in draft form without updating.

6. If you are using Juniper ATP Cloud without Policy Enforcer, you must assign your threat prevention
policy to a firewall rule for it to take affect. Navigate to Configure > Firewall Policy > Policies. In the
Advanced Security column, click an item to access the Edit Advanced Security page and select the
threat prevention policy from the Threat Prevention pulldown list.

RELATED DOCUMENTATION

Comparing the Juniper Connected Security and non-Juniper Connected Security Configuration
Steps | 1120

Creating Policy Enforcement Groups | 1022

Threat Policy Analysis Overview | 850
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Creating Geo IP Policies | 1018

Threat Prevention Policy Overview | 848

Policy Enforcer Overview | 1099

Benefits of Policy Enforcer | 1101

Policy Enforcer Components and Dependencies | 1106

Juniper ATP Cloud Overview | 1103

Threat Prevention Policy Overview

Threat prevention policies provide protection andmonitoring for selected threat profiles, including command
and control servers, infected hosts, andmalware. Using feeds from Juniper ATP Cloud and optional custom
feeds that you configure, ingress and egress traffic is monitored for suspicious content and behavior. Based
on a threat score, detected threats are evaluated and action may be taken once a verdict is reached.

Once policies are configured, the following fields are available on the Security Director main page to
provide an overview of each policy.

Table 267: Threat Prevention Policy Fields

DescriptionField

The user-created name for the policy.Name

Threat score settings overview if selected for the policy.
(Otherwise this field is empty.) For example:

Block: 8-10

Monitor: 5-7

Permit: 1-4

Profile: C&C Server

Threat score settings overview if selected for the policy.
(Otherwise this field is empty.)

Profile: Infected Host

Threat score settings overview if selected for the policy.
(Otherwise this is empty.)

Profile: Malware HTTP

Threat score settings overview if selected for the policy.
(Otherwise this field is empty.)

Profile: Malware SMTP
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Table 267: Threat Prevention Policy Fields (continued)

DescriptionField

This displays the status of the policy. This status is a
clickable link you can use to change the policy status.
When you first create a policy and assign it to a group,
this field readsViewAnalysis. Read “Threat Policy Analysis
Overview” on page 850 for more information on this field.

If the status is Update Failed, click Retry to perform the
rule analysis again. You can click the Update Failed status
to see the corresponding job details. The rule analysis retry
option is available only when the status is Update Failed.

NOTE: If the policy has been updated after it has already
been pushed to the endpoint, the status here is Update
with a warning icon to notify you the policy has been
changed but not pushed.

Status

This is the group to which the policy is assigned.Policy Enforcement Group

This field displays the log setting for the policy.Log

The user-created description for the policy.Description

Benefits of Threat Prevention Policy

• Enables you to define and enforce policies for controlling specific applications and embedded social
networking widgets.

• Reduces the need for manual updates and automatically applies policies and enforcement rules, driving
down the costs of managing network security.

• Leverages the network for multiple enforcement points across the infrastructure. Enables you to stop
threats closer to infection points and to prevent threats from spreading, which greatly improves the
efficacy of security operations.

RELATED DOCUMENTATION

Creating Threat Prevention Policies | 841

Policy Enforcement Groups Overview | 1024

Creating Geo IP Policies | 1018
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Policy Enforcer Overview | 1099

Benefits of Policy Enforcer | 1101

Policy Enforcer Components and Dependencies | 1106

Juniper ATP Cloud Overview | 1103

Threat Policy Analysis Overview

In the Threat Prevention Policies page, click theReady toUpdate link in the Status column to update policy
changes. Policies must be updated before they can go live.

NOTE: If the policy has been updated after it has already been pushed to the endpoint, the
status here is Update with a warning icon to notify you that the policy has been changed but
not pushed.

Use the threat policy analysis page to view your pending policy changes in chronological order. Click the
View Analysis link to view the changes. In the Action section, you can select to Update now, Update later,
or Save the changes without updating. If you select to update later, you can schedule a time to update.

By clicking on the policy links, you can update only the policies you select and choose not to update others.

RELATED DOCUMENTATION

Threat Prevention Policy Overview | 848

Creating Threat Prevention Policies | 841

Implementing Threat Policy on VMWare NSX

IN THIS SECTION

VMWare NSX Integration with Policy Enforcer and Juniper ATP Cloud Overview | 851

Before You Begin | 854

Configuring VMware NSX with Policy Enforcer | 857

Example: Creating a Firewall Rule in VMWare vCenter Server Using SDSN_BLOCK Tag | 859
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VMWare NSX Integration with Policy Enforcer and Juniper ATP Cloud Overview

Juniper Networks Advanced Threat Prevention Cloud (Juniper ATP Cloud) identifies the infected virtual
machines (VMs) running on VMWare NSX and tags these VMs as infected. This is based on a malware file
exchange from the infected VMs and/or based on the Command and Control communication with known
botnet sites on the internet.

Based on this identification of infected or compromised hosts, you can take one of the following actions:

• Enable additional security features such as Layer-7 Application Firewall and Intrusion Prevention (IPS)
leveraging vSRX

• Enforce Layer-2 to Layer-4 controls using NSX Distributed Firewall

• Leverage NSX integration with Host-Based security vendors
(https://www.vmware.com/products/nsx/technology-partners.html) to take host-based security actions
such as running antivirus or anti malware features on the infected VMs.

Policy Enforcer provides a set of Connector APIs for the third-party adaptors. TheNSXConnector integrates
with the Policy Enforcer using these APIs to enable enforcement of the infected hosts policy on Secure
Fabric. For NSX connectors, the NSX Manager , its associated vCenter, and an edge firewall form the
Secure Fabric.

The following topology shows how NSXManager and the edge firewall create a Secure Fabric to use with
Policy Enforcer.
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Figure 59: Topology of NSX Integration with Policy Enforcer
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Within the NSX Manager, the virtual machines (VM) connect to logical networks, shown as green and
yellow colour logical networks, as shown in Figure 59 on page 852. The logical switches connect to each
other using a Distributed Logical Router(DLR). To form the Secure Fabric, configure the edge service
gateway (ESG) to point to SRX Series devices or vSRX as the gateway for the networks hosted on NSX.
This is implemented by establishing IBGP session between ESG and vSRX or SRX Series device. This ensures
that all the north-south traffic passes through the vSRX edge firewall. The vSRX edge gateway is enrolled
with Juniper ATP Cloud for the traffic inspection.

If NAT services are required, it must be configured on the vSRX and not on the ESG. Configure NAT
services using the following CLI commands.

set security nat source rule-set trust-to-untrust from zone trust

set security nat source rule-set trust-to-untrust to zone untrust

set security nat source rule-set trust-to-untrust rule snat-rule match source-address 0.0.0.0/0

set security nat source rule-set trust-to-untrust rule snat-rule then source-nat interface

To establish a BGP session, use the following configuration commands:

set routing-options autonomous-system 10

set protocols bgp group nsx neighbor 5.0.0.2 peer-as 10
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You can view the BGP configuration in VMWare vCenter Server, as shown in Figure 60 on page 853.

Figure 60: VMWare vCenter BGP Configuration

NOTE: You can register the NSXManager with Security Director only when the Policy Enforcer
is configured. The NSXmicro service is bundled with the Policy Enforcer VM. However, the NSX
micro service is packaged as a standalone rpm, so that theNSXmicro service upgrade and patches
can be performed independent of the Policy Enforcer VM.

Implementation of Infected Hosts Policy Overview for VMware NSX

The vSRX or SRX Series devices running as an edge firewall is enrolled to send all the suspected traffic to
Juniper ATP Cloud.

The following steps explain the high-level workflow:

• If an infection is detected, Juniper ATP Cloud notifies the Policy Enforcer about the infected IP addresses

• If the infected IP address belongs to Secure Fabric associated with the NSX domain, Policy Enforcer
calls the NSX plugin APIs to notify the NSX Connector about the list of infected IP addresses

• NSX service will then retrieve the VM corresponding to the IP addresses sent and then calls the NSX
API to tag to an appropriate VM with a security tag, SDSN_BLOCK.

You can then create a policy to block the infected hosts using the SDSN_BLOCK tag by creating VMWare
Distributed Firewall (DFW) rules. The block policy consists of two rules for ingress block and egress block.
The ingress block rule applies to any traffic originating from a security group composed of VMs tagged
with a block tag to any destination. Similarly, the egress block rule applies to any traffic destined to security
group composed of VMs tagged with block tag from any source.
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The creation of security groups associatedwith the SDSN_BLOCK tag, creation of ingress and egress block
rules, and the action to take on the matching packets must be configured by the VMWare administrators.
The NSX Connector will simply apply the SDSN_BLOCK tag on the infected VM.

Registering NSXMicro Service as Policy Enforcer Connector Instance Overview

The integration of each NSX manager discovered in Security Director with Policy Enforcer is triggered
automatically.

The automatic registration of a connector instance involves the following steps:

1. Discovering the NSXManager in Security Director. This triggers an auto creation of the Policy Enforcer
connector instance.

2. Secure Fabric is created to manage the discovered NSX Manager.

3. Creation of threat prevention policy requires the knowledge of Juniper ATP Cloud realm and the edge
firewall device. These are taken as inputs from the user.

Before You Begin

IN THIS SECTION

Infected Hosts Workflow in VMware vCenter Server | 854

Before you begin to configure NSXwith Policy Enforcer, configure the infected hosts workflow in VMWare
vCenter Server.

Infected Hosts Workflow in VMware vCenter Server

To block the infected hosts:

1. Log in to the vSphere Web Client through the VMware vCenter Server.

2. From the vSphere Web Client, click Networking & Security and then click NSX Managers.

Under the Manage section, click Security Tags column head and create SDSN_BLOCK security tag for
NSX, as shown in Figure 61 on page 855.
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Figure 61: SDSN_BLOCK Security Tag

The feed for the infected hosts will be triggered by Juniper ATP Cloud down to Policy Enforcer. When
there is a trigger, the SDSN_BLOCK tag is attached to the VM. Click on the VM Count column to see
the VM details attached to the tag.

3. Select Networking & Security and then click Service Composer.

The Service Composer page appears. From the Service Composer, click the Security Groups tab. The
security administrator can create the security group based on the security tag.

4. Click the New Security Group icon to create a new security group.

5. Enter a name and description for the security group and then click Next.

6. On the Define dynamic membership page, define the criteria that an object must meet for it to be
added to the security group you are creating.

In the Criteria Details row, select Security Tag from the list and provide the SDSN_BLOCK tag name,
as shown in Figure 62 on page 856.
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Figure 62: Define Dynamic Membership Page

Click Next.

7. In the Ready to Complete page, verify the parameters and click Finish.

In the Service Composer page, under the Security Groups tab, you can see that the security group has
been created and the VM with the security tag is assigned to the security group.
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Configuring VMware NSX with Policy Enforcer

The following steps explain configuring VMWare NSX with Policy Enforcer:

1. Add the NSXManager to the Security Director database, as shown in Figure 63 on page 857. To know
more about adding a NSX Manager, see “Add the NSX Manager” on page 380.

Figure 63: Adding NSX Manager Page

2. After discovering the NSX Manager in Security Director, use the Guided Setup workflow to configure
the following parameters:

• Secure Fabric

• Policy Enforcement Group (PEG)

• Juniper ATP Cloud Realm

• Threat policies for the following threat types:

• Command and Control (C&C) Server

• Infected Hosts

• Malware

3. Select Configuration > Guided Setup > Threat Prevention.
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The Threat Prevention Policy Setup page appears.

4. Click Stat Setup.

The Threat Prevention Policy Setup page appears, as shown in Figure 64 on page 858. Some of the
resources are already configured as you discover the NSX Manager.

Figure 64: Guided Setup Page

5. In the Secure Fabric page, the site is already created. For that site, one enforcement point is also added.

To create a secure fabric site in Policy Enforcer for NSX based environment, you require two parts :
NSX Manager and edge firewall. In the Add Enforcement Points page, add vSRX, as shown in the
topology, as a edge firewall. Select the vSRX device listed under the Available column and move it to
the Selected column. You now have two enforcement points within the Secure Fabric.

Click Next.

6. In the Policy Enforcement Groups page, the policy enforcement group is already created based on the
Location Group Type. The location points to the Secure Fabric site created for NSX.

Click. Next.

7. In the ATP Cloud Realm page, associate the Secure Fabric with ATP Cloud realm.

If the ATP Cloud realm is already created, click Assign Sites in the Sites Assigned column and chose
the Secure Fabric site. The ATP Cloud realm and Secure Fabric are now associated.

Click. Next.

8. In the Policies page, create a threat prevention policy by choosing the profile types depending on the
type of threat prevention this policy provides (C&C Server, Infected Host, Malware) and an action for
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the profile. The DDoS profile is not supported by the NSX Connector. Once configured, you apply
policies to PEGs.

ClickAssign groups in the Policy Enforcement Group column to associate the policy enforcement group
with the policy.

SecurityDirector takes the snapshot of the firewall by performing the rule analysis and threat remediation
rules are pushed into the edge firewall.

Click Finish.

NOTE: The GeoIP feeds are not used with the NSX Connectors.

9. The last page is a summary of the items you have configured using quick setup. Click OK to be taken
to the Policies page under Configure > Threat Prevention > Policies and your policy is listed there.

Example: Creating a Firewall Rule in VMWare vCenter Server Using SDSN_BLOCK Tag

The following example shows the firewall rule creation using the SDSN_BLOCK security tag:

1. Log in to the vSphere Web Client through the VMware vCenter Server.

2. Select Networking & Security and then click Service Composer.

The Service Composer page appears.

3. Select Security Policies tab in the Service Composer page.

Create a security policy to block the traffic coming from the infected hosts.

4. Select the Create Security Policy icon.

The New Security Policy page appears.

5. Enter a name and description for the security policy, and click Next.

6. Select the Firewall Rules option from the left pane.

The Firewall Rules page appears.

7. Select the New Firewall Rule icon (+) to create a new firewall rule.

The New Firewall Rule page appears.
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8. Enter the name of the firewall rule.

9. In the Action field, select the Block option.

10. In the Source field, click Change and select the security group.

11. In the Destination field, click Change and select the security group to add as Any.

Click Ok. Figure 65 on page 860 shows a sample firewall rule configuration.

Figure 65: New Firewall Rule Page
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12.Click Finish.

A new policy is created. You can apply this policy to the security group.

13. In the Security Policies page, right-click on the policy name and select Apply Policy.

The Apply Policy to Security Groups page appears, as shown in Figure 66 on page 861.

Figure 66: Apply Policy to SG Page

14. Select the security group that you have created and assign to a policy.

Security administrator is now able to block the traffic coming from the infected hosts.
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CHAPTER 82

Threat Prevention - Feed Sources

IN THIS CHAPTER
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About the Feed Sources Page

To access this page, click Configure > Threat Prevention > Feed Sources.

Policy Enforcer uses threat feeds to provide actionable intelligence to policies about various types of
threats. These feeds can come from different sources, such as Juniper ATP Cloud, Juniper ATP, and from
lists that you can customize by adding IP addresses, domains, and URLs.
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You can add allowlist and blocklist in Juniper ATP Cloud and as well as in Custom feeds. When you add
an allowlist or blocklist in Custom feeds, a warning message shows that it will erase the existing allowlist
or a blocklist in Juniper ATPCloud, if any. You can only have one source for allowlist, blocklist, and infected
host feeds.

Tasks You Can Perform

You can perform the following tasks from the Juniper ATP Cloud page:

• Add ATP Cloud realm. See “Creating Juniper ATP Cloud Realms and Enrolling Devices or Associating
Sites” on page 876.

• Inspect and manage email attachments sent over SMTP. See “Juniper ATP Cloud Email Management:
SMTP Settings” on page 870.

• Configure email management for IMAP. See “Configure IMAP Settings” on page 873.

• Configure Allowlist and Blocklist. See “Creating Allowlist for Juniper ATP Cloud Email and Malware
Management” onpage883 and “CreatingBlocklists for JuniperATPCloudEmail andMalwareManagement”
on page 884.

• Configure file inspection profiles. See “Creating File Inspection Profiles” on page 880.

• Edit the ATP Cloud realm. See “Modifying Juniper ATP Cloud Realm” on page 879.

• Delete the ATP Cloud realm.

You can perform the following tasks from the JATP page:

• Add JATP server. See “Add JATP Server” on page 886.

• Edit the JATP server configuration. See “Edit or Delete a JATP Server” on page 888

• Delete the JATP server.

You can perform the following tasks from the Custom Feeds page:

• Create custom feeds for the dynamic address, allowlist, blocklist, infected hosts, DDoS, and C&C Server
feed types. See “Creating Custom Feeds” on page 890.

• Configure settings. See “Configuring Settings for Custom Feeds” on page 896.

• Edit the custom feed.

• Delete the custom feed.

Field Descriptions

Table 268 on page 864 provides guidelines on using the fields on the Feed Sources page.
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Table 268: Fields on the Feed Sources Page

DescriptionField

ATP Cloud

Name of the Juniper ATP Cloud realm.Realm

Name of the site associated to the realm.Sites

Name of the perimeter firewall devices that are enrolled to Juniper ATP Cloud.Devices

Region of the Juniper ATP Cloud realm.Location

Enrollment status of the realm.Enrollment Status

Expiry date and time of a token generated at the Juniper ATP Cloud side when a realm is
registered. The tokenwill be valid for one year. Once the token expires, the status is flipped
to Expired.

Thirty days prior to the expiry date, renew option is enabled to renew the token. Click
Renew to renew the token. Enter the realm credentials in the renew window and if the
realm credentials are valid, a new token is generated and assigned to the realm. The old
and the expired token is deleted.

NOTE: The username (e-mail address) that you provide as realm credentials must exactly
match with the username that is used while creating a realm in Juniper ATP Cloud. To
view the username in the Juniper ATP Cloud user interface, go to Administration>Users.

The e-mail address used as a username is case sensitive. If there is a mismatch in the
username, the validation of realm credentials fails and the token will not be renewed.

Token Expiry

The consolidated status of all the feeds of a selected Juniper ATP Cloud realm is shown
here.

If the status of any one of the feeds is FAILED, then the consolidated status is shown as
FAILED. Hover over the field to see the individual status of each feed. The status of IPv6
feeds are also listed along with other feed sources.

Feed Status

The date and time of the last time Policy Enforcer has requested the feeds from Juniper
ATP Cloud is shown here. Hover over the field to view a detailed list of date and time of
each feed download.

Last Downloaded

JATP

Name of the Juniper ATP zone.Zone Name
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Table 268: Fields on the Feed Sources Page (continued)

DescriptionField

Name of the site associated to the zone.Sites

The consolidated status of all the feeds of a selected Juniper ATP zone is shown here.
Hover over the field to see the individual status of each feed. The status of IPv6 feeds are
also listed along with other feed sources.

If the status of any one of the feeds is FAILED, then the consolidated status is shown as
FAILED.

Feed Status

The date and time of the last time Policy Enforcer has requested the feeds from Juniper
ATP is shown here. Hover over the field to view a detailed list of date and time of each
feed download.

Last Downloaded

Name of the perimeter firewall devices that are enrolled to Juniper ATP.Devices

Enrollment status of the zone.Enrollment Status

The IP address of the configured Juniper ATP appliance.Server IP Address

Custom Feeds

Name of the custom feed.Name

Type of the custom feed. For example, dynamic address, allowlist, blocklist, infected hosts,
DDoS, or C&C Server.

Feed Type

Date and time when the selected custom feed was last updated.Last Updated

Number of days within which the custom feed is going to expire or become inactive.Days to Become Inactive

View the status of downloading feeds from a remote file server to Policy Enforcer. This
field is blank for the locally created custom feeds.

The following statuses are shown under different scenarios:

• Pending—Status is shown as pending until Policy Enforcer downloads the new feeds
from the remote file server.

• Success—Status is shown as success when Policy Enforcer downloads the feeds
successfully.

• Failed—Status is shown as failed when downloading the feeds fails.

RemoteDownloadStatus

View the description of your custom feed.Description
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In the Custom Feeds page, you can search for any particular custom feed by its name and type of the
custom feed. Click the filter icon and the following fields can be searchable:

• Name—Enter the name of the custom feed to be searched.

• Feed Type—Select the feed type from the list.

RELATED DOCUMENTATION

Creating Juniper ATP Cloud Realms and Enrolling Devices or Associating Sites | 876

Juniper ATP Cloud Email Management: SMTP Settings | 870

Configure IMAP Settings | 873

Creating Allowlist for Juniper ATP Cloud Email and Malware Management | 883

Creating Blocklists for Juniper ATP Cloud Email and Malware Management | 884

Creating File Inspection Profiles | 880

Creating Custom Feeds | 890

Configuring Settings for Custom Feeds | 896

Add JATP Server | 886

Edit or Delete a JATP Server | 888

Juniper ATP Cloud Realm Overview

A security realm is a group identifier for an organization used to restrict access to Web applications. You
must create at least one security realm to login into Juniper ATP Cloud. Once you create a realm, you can
enroll SRX Series devices into the realm. You can also givemore users (administrators) permission to access
the realm.

If you have multiple security realms, note that each SRX Series device can only be bound to one realm,
and users cannot travel between realms.

RELATED DOCUMENTATION

About the Feed Sources Page | 862

Creating Juniper ATP Cloud Realms and Enrolling Devices or Associating Sites | 876

Using Guided Setup for Juniper ATP Cloud | 1230

Configuring Juniper ATPCloud (No Juniper Connected Security andNoGuided Setup) Overview | 1240
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Juniper ATP Cloud Malware Management Overview

Malware management includes profiles you can create to group file types together for scanning. It also
lets you configure customized allowlists and blocklists.

• File inspection profiles let you define which files to send to the cloud for inspection. By grouping similar
file types together to be scanned (such as .tar, .exe, and .java) under a common name, you can create
multiple profiles based on the content you want scanned. Then enter the profile names on eligible SRX
Series devices to apply them.

• Use the allowlist and blocklist pages to configure custom trusted and untrusted URLs and IPs. Content
downloaded from locations on the allowlist is trusted and does not have to be inspected for malware.
Hosts cannot download content from locations on the blocklist because those locations are untrusted.

RELATED DOCUMENTATION

Creating File Inspection Profiles | 880

Juniper ATP Cloud Email Management Overview

With Email Management, enrolled devices transparently submit potentially malicious email attachments
to the cloud for inspection. Once an attachment is evaluated, Juniper ATP Cloud assigns the file a threat
score between 0-10 with 10 being the most malicious.

NOTE: If an email contains no attachments, it is allowed to pass without any analysis.

Configure one of the following actions when an email attachment is determined to be malicious:

• Quarantine Malicious Messages—If you select to quarantine emails with attachments found to be
malicious, those emails are stored in the cloud in an encrypted form and a replacement email is sent to
the intended recipient. That replacement email informs the recipient of the quarantined message and
provides a link to the Juniper ATP Cloud quarantine portal where the email can be previewed. The
recipient can then choose to release the email by clicking a Release button (or request that the
administrator release it) or Delete the email.

• Deliver malicious messages with warning headers added—When you select this option, headers are
added to emails that most mail servers recognize and filter into Spam or Junk folders.

• Permit—You can select to permit the email and the recipient receives it intact.
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Figure 67: Email Management Overview

Quarantine Release

If the recipient selects to release a quarantined email, it is allowed to pass through the SRX series with a
header message that prevents it from being quarantined again, but the attachments are placed in a
password-protected ZIP file. The password required to open the ZIP file is also included as a separate
attachment. The administrator is notified when the recipient takes an action on the email (either to release
or delete it).

If you configure Juniper ATP Cloud to have the recipient send a request to the administrator to release
the email, the recipient previews the email in the Juniper ATP Cloud quarantine portal and can select to
Delete the email or Request to Release. The recipient receives a message when the administrator takes
action (either to release or delete the email.)

Blocklist and Allowlist

Emails are checked against administrator-configured blocklists and allowlists using information such as
Envelope From (MAIL FROM), Envelope To (RCPT TO), Body Sender, Body Receiver. If an email matches
the allowlist, that email is allowed through without any scanning. If an email matches the blocklist, it is
considered to be malicious and is handled the same way as an email with a malicious attachment.

RELATED DOCUMENTATION
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Juniper ATP Cloud Email Management: SMTP Settings | 870

File Inspection Profiles Overview

File Inspection profiles let you define which files to send to the cloud for inspection. You can group types
of files to be scanned together (such as .tar, .exe, and .java) under a common name and create multiple
profiles based on the content you want scanned. Then enter the profile names on eligible devices to apply
them.

Table 269: File Category Contents

DescriptionCategory

Archive filesArchive

Configuration filesConfiguration

All document types except PDFsDocument

Executable binariesExecutable

Java applications, archives, and librariesJava

Dynamic and static libraries and kernel modulesLibrary

Mobile formatsMobile

OS-specific update applicationsOS package

PDF, e-mail, and MBOX filesPDF

Installable Internet Applications such as Adobe Flash, JavaFX, Microsoft
Silverlight

Rich Application

Scripting filesScript

You can also define the maximum file size requirement per each category to send to the cloud. If a file
falls outside of the maximum file size limit the file is automatically downloaded to the client system.

NOTE: Once the profile is created, use the set services advanced-anti-malware policy CLI
command to associate it with the Juniper ATP Cloud profile.
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NOTE: If you are using the free model of Juniper ATP Cloud, you are limited to only the
executable file category.

RELATED DOCUMENTATION

Creating File Inspection Profiles | 880

Juniper ATP Cloud Malware Management Overview | 867

File Scanning Limits | 106

Juniper ATP Cloud Email Management: SMTP Settings

Use the SMTP Settings page to inspect and manage email attachments sent over SMTP.

Before You Begin

• Read the “Juniper ATP Cloud Email Management Overview” on page 867 topic.

• Decide how malicious emails are handled: quarantined, delivered with headers, or permitted.

To configure the email management settings for the Juniper ATP Cloud realm:

1. Select Configure > Threat Prevention > Feed Sources.

The Feed Sources page appears

2. Under the ATP Cloud tab, right-click ATP Cloud Realm or from the More list, select SMTP Settings.

3. Based on your selections, configuration options described in Table 270 on page 871,
Table 271 on page 872, and Table 272 on page 872.
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Table 270: Configure Quarantine Malicious Messages

GuidelineSetting

Quarantine malicious messages (the default)—When you select to
quarantinemalicious email messages, in place of the original email, intended
recipients receive a custom email you configure with information on the
quarantining. Both the original email and the attachment are stored in the
cloud in an encrypted format.

Action to take

• Recipients can release email—This option provides recipients with a link
to the Juniper ATP Cloud quarantine portal where they can preview the
email. From the portal, recipients can select to Release the email or
Delete it. Either action causes amessage to be sent to the administrator.

NOTE: If a quarantined email has multiple recipients, any individual
recipient can release the email from the portal and all recipients will
receive it. Similarly, if one recipient deletes the email from the portal, it
is deleted for all recipients.

• Recipients can request administrator to release email—This option also
provides recipients with a link to the Juniper ATP Cloud quarantine
portal where they can preview the email. From the portal, recipients
can select to Request to Release the email or Delete it. Either choice
causes amessage to be sent to the administrator.When the administrator
takes action on the email, a message is sent to the recipient.

NOTE: When a quarantined email is released, it is allowed to pass through
the SRX series with a header message that prevents it from being
quarantined again, but the attachment is placed inside a
password-protected zip file with a text file containing the password that
the recipient must use to open the file.

Release option

Email Notifications for End Users

If you have a corporate web site with further information for users, enter
that URL here. If you leave this field blank, this option will not appear to
the end user.

Learn More Link URL

When an email is quarantined, the recipient receives a custom message
informing them of their quarantined email. For this custommessage, enter
a subject indicating a suspicious email sent to them has been quarantined,
such as "Malware Detected."

Subject

Enter information to help email recipients understand what they should
do next.

Custom Message
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Table 270: Configure Quarantine Malicious Messages (continued)

GuidelineSetting

Enter custom text for the Juniper ATP Cloud quarantine portal link where
recipients can preview quarantined emails and take action on them.

Click Preview to view the custom message that will be sent to a recipient
when an email is quarantined.

Custom Link Text

Table 271: Configure Deliver with Warning Headers

GuidelineSetting

Delivermaliciousmessageswithwarning headers added—When you select
to deliver a suspicious email with warning headers, you can add headers
to emails that most mail servers will recognize and filter into spam or junk
folders.

Action to take

• X-Distribution (Bulk, Spam)—Use this header for messages that are sent
to a large distribution list and are most likely spam. You can also select
“Do not add this header.”

• X-Spam-Flag—This is a common header added to incoming emails that
are possibly spam and should be redirected into spam or junk folders.
You can also select “Do not add this header.”

• Subject Prefix—You can prepend headers with information for the
recipient, such as "Possible Spam."

SMTP Headers

Table 272: Permit

GuidelineSetting

Permit—You can select to permit themessage and no further configuration
is required.

Action to take

To send notifications to administrators when emails are quarantined or released from quarantine:

1. Click the + sign to add an administrator.

2. Enter the administrator's email address.

3. Select the Quarantine Notification check box to receive those notifications.
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4. Select the Release Notifications check box to receive those notifications.

5. Click OK.

RELATED DOCUMENTATION

Juniper ATP Cloud Email Management Overview | 867

Configure IMAP Settings

Use the IMAP Settings page to configure email management for IMAP.With email management for IMAP,
the enrolled SRX Series devices can transparently submit suspicious emails to Juniper ATP Cloud for
inspection and blocking.

Before You Begin

• Read the “Juniper ATP Cloud Email Management Overview” on page 867 topic.

• Decide how malicious emails are handled. For IMAP, the available options are to block or permit email.
Unlike SMTP, there is no quarantine option for IMAP and there is no option to preview a blocked email.

To configure the IMAP settings:

1. Select Configure > Threat Prevention > Feed Sources.

The Feed Sources page appears

2. Under the ATP Cloud tab, right-click ATP Cloud Realm or from the More list, select IMAP Settings.

3. Complete the configuration as per the guidelines given in Table 273 on page 874.

Based on your selections, configuration options will vary.
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Table 273: Configure Block Malicious Messages

GuidelineSetting

• Permit download of attachments—Allow email attachments, either from
all IMAP servers or specific IMAP servers, through to their destination.

NOTE: In Permitmode, blocklists and allowlists are not checked. Emails
from blocklisted addresses are not sent to the cloud for scanning. They
are allowed through to the client.

• Block download of attachments—Block email attachments, either from
all IMAP servers or specific IMAP servers, from reaching their destination.

NOTE: In Blockmode, blocklists and allowlists are checked. Emails from
blocklisted addresses are blocked. Emails from allowlisted addresses are
allowed through to the client.

Recipients can send a request to an administrator to release the email.
Enter the email address towhich recipients should send a release request.

NOTE: If a blocked email hasmultiple recipients, any individual recipient
can request to release the email and all recipients will receive it.

When you select to block email attachments, in place of the original email,
intended recipients receive a custom email you configure with information
on the block action. Both the original email and the attachment are stored
in the cloud in an encrypted format.

Action to take

• All IMAP Servers—The permitting or blocking of email attachments
applies to all IMAP servers.

• Specific IMAP Server—The permitting or blocking of email attachments
applies only to IMAP servers with hostnames that you add to a list. A
configuration section to add the IMAP server name appears when you
select this option.

When you add IMAP servers to the list, it is sent to the SRX Series device
to filter emails sent to Juniper ATP Cloud for scanning. For emails that are
sent for scanning, if the returned score is above the set policy threshold
on the SRX, then the email is blocked.

IMAP Server

Select the Specific IMAP Server option above and click the + sign to add
IMAP server hostnames to the list.

NOTE: You must use the IMAP server hostname and not the IP address.

IMAP Servers

Email Notifications for End Users
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Table 273: Configure Block Malicious Messages (continued)

GuidelineSetting

If you have a corporate web site with further information for users, enter
that URL here. If you leave this field blank, this option will not appear to
the end user.

Learn More Link URL

When an email is blocked, the recipient receives a custom message
informing them of their blocked email. For this custom message, enter a
subject indicating a suspicious email sent to them has been blocked, such
as "Malware Detected."

Subject

Enter information to help email recipients understand what they should
do next.

Custom Message

Enter custom text for the Juniper ATP Cloud quarantine portal link where
recipients can preview blocked emails and take action on them.

Click Preview to view the custom message that will be sent to a recipient
when an email is blocked.

Custom Link Text

To send notifications to administrators when emails are blocked or released from quarantine:

1. Click the + sign to add an administrator.

2. Enter the email address of the administrator and click OK.

3. Once the administrator is created, you can uncheck or check which notification types the administrator
will receive.

• Block Notifications—If you enable this option, a notification is sent when an email is blocked.

• Unblock Notifications—If you enable this option, a notification is sent when a user releases a blocked
email.

RELATED DOCUMENTATION

About the Feed Sources Page | 862
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Creating Juniper ATP Cloud Realms and Enrolling Devices or Associating
Sites

You can select a geographical location and enter your Juniper ATP Cloud credentials to create a realm and
associate sites or devices with the realm.

If you do not have Juniper ATPCloud account, select a geographical region and click here. You are redirected
to the Juniper ATP Cloud account page.

Before You Begin

• Understand which type of Juniper ATP Cloud license you have: free, basic, or premium. The license
controls which Juniper ATP Cloud features are available.

• To configure a Juniper ATP Cloud realm, you must already have Juniper ATP Cloud account with an
associated license.

• Ensure that the internet connectivity is available for Policy Enforcer. Without the internet connectivity,
you cannot create a realm.

• Decide which region will be covered by the realm you are creating. You must a select a region when you
configure a realm.

• Note that adding a device to a realm results in one or more commit operations occurring on the device
to apply the Juniper ATP Cloud or Policy Enforcer configuration.

To configure ATP Cloud Realm:

1. Select Configure>Threat Prevention>Feed Sources.

The Feed Sources page appears.

2. In the ATP Cloud tab, click the + icon to add a realm.

3. Complete the initial configuration by using the guidelines in Table 274 on page 876 below.

4. Click Finish.

Table 274: Fields on the Add ATP Cloud Realm Page

DescriptionField

ATP Cloud Realm Credentials
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Table 274: Fields on the Add ATP Cloud Realm Page (continued)

DescriptionField

Select a region of the world from the available choices.

The following options are available in the Location list:

• North America

• European Region

• Canada

• Asia Pacific

By default, the North America value appears in the list. To know more about the geographic
region, see here.

Location

Enter your e-mail address. Your username for Juniper ATP Cloud is your e-mail address.Username

Enter a unique string at least 8 characters long. Include both uppercase and lowercase letters,
at least one number, and at least one special character (~!@#$%^&*()_-+={}[]|:;<>,./?); no spaces
are allowed, and you cannot use the same sequence of characters that are in your username.

Password

Enter a name for the security realm. This should be a name that is meaningful to your organization.
A realm name can only contain alphanumeric characters and the dash symbol. Once created,
this name cannot be changed.

NOTE: When you create a custom feed with a realm, the feed is associated at the site level and
not at the realm level. If you modify this realm and associate new sites to it, a warning message
is shown that there are custom feeds are associatedwith this realm. Changing the site information
will change the custom feed information. You must go and edit the custom feed that was
associated with this realm and verify the realm association.

Realm

Site

Select one or more sites to enroll into the realm. If there are no sites associated with the realm,
click Create new site. To knowmore about creating a new site, see “Creating Secure Fabric and
Sites” on page 353.

NOTE:
• If you are using Juniper ATP Cloud without Policy Enforcer, you are not prompted to select
a site.

• Assigning a site to the realm will cause a change in the device configuration in the associated
devices.

• You must select the sites either with tenants or without tenants. You cannot select both at a
time.

Site
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Table 274: Fields on the Add ATP Cloud Realm Page (continued)

DescriptionField

Lists all devices from the realm that are not managed in Security Director. You must manually
discover them.

If you are using Juniper ATP Cloud with Policy Enforcer and you have no devices enrolled in
the realm, you are asked to select devices in the box on the left and move them to the right to
enroll them. All selected devices are automatically enrolled with Juniper ATP Cloud when you
finish the guided setup. To disenroll a device, you can edit a realm and move the device back to
the left side box.

NOTE: Adding a device to a realm results in one or more commit operations occurring on the
device to apply the Juniper ATP Cloud or Policy Enforcer configuration.

Unmanaged
Devices

Global Configuration

Enable this option to receive IPv6 feeds (C&C and Geo IP) from Policy Enforcer.IPv6 Feeds

Select a threshold level to block the infected hosts and to send an e-mail to the selected
administrators notifying about the infected host events.

Click the+ sign if you want to add new administrators to the list.

Threat Level
Threshold

Enable this option to log the Malware or the Host Status event or both the event types.Logging

Click the add icon (+) to enter the trusted IPv4 address of the proxy server, in the Server IP
column.

When there is a proxy server between users on the network and a firewall, the firewall might
see the proxy server IP address as the source of an HTTP or HTTPS request, instead of the
actual address of the user making the request.

With this in mind, X-Forwarded-For (XFF) is a standard header added to packets by a proxy
server that includes the real IP address of the client making the request. Therefore, if you add
trusted proxy servers IP addresses to the list in Juniper ATP Cloud, by matching this list with
the IP addresses in the HTTP header (X-Forwarded-For field) for requests sent from the SRX
Series devices, Juniper ATP Cloud can determines the originating IP address.

NOTE: XFF only applies to HTTP or HTTPS traffic, and only if the proxy server supports the
XFF header.

Proxy Servers
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NOTE: If you enrolled a device into a realm from within Security Director and you want to
disenroll it, you must do that from within Security Director. If you enrolled a device into a realm
fromwithin Juniper ATPCloud and youwant to disenroll it, youmust do that fromwithin Juniper
ATP Cloud. You cannot disenroll a device from within Security Directory that was enrolled from
within Juniper ATP Cloud.

RELATED DOCUMENTATION

About the Feed Sources Page | 862

Juniper ATP Cloud Realm Overview | 866

Using Guided Setup for Juniper ATP Cloud | 1230

Creating Secure Fabric and Sites | 353

Modifying Juniper ATP Cloud Realm

Use theModify ATPCloud Realm page tomodify the site information and global configuration information
of an existing ATPCloud realm. You can also view devices from the realm that are notmanaged by Security
Director.

To modify a Juniper ATP Cloud realm:

1. Select Configure>Threat Prevention> Feed Sources.

The Feed Sources page appears.

2. Select the realm and click the pencil icon to modify the configuration.

The Modify ATP Cloud Realm page appears.

3. Complete the configuration by using the guidelines in Table 275 on page 880.

4. Click Finish to complete the configuration or Cancel to discard the changes.

NOTE: Assigning a site to the realm will cause a change in the device configuration in the
associated devices.
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Table 275: Fields on the Modify ATP Cloud Realm page

DescriptionField

Site

Select a site to enroll into the realm. If there are no sites associated with the realm,
click Create new site.

Site

Lists all devices from the realm that are not managed in Security Director. You must
manually discover them.

Unmanaged Devices

Global Configuration

Enable this option to receive IPv6 feeds from Policy Enforcer.IPv6 Feeds

Select a threshold level to block the infected hosts and to send an e-mail to the
selected administrators notifying about the infected host events.

Threat Level Threshold

Enable or disable logging for the Malware or the Host Status event.Logging

Click the add icon (+) to enter the IPv4 address of the proxy server, in the Server IP
column.

You can also edit the existing IP address or delete them.

Proxy Servers

RELATED DOCUMENTATION

Creating Juniper ATP Cloud Realms and Enrolling Devices or Associating Sites | 876

About the Feed Sources Page | 862

Creating File Inspection Profiles

Use the ATP Cloud File Inspection Profiles page to create profiles to define which files to send to the cloud
for inspection.

Before you Begin

• Read the “File Inspection Profiles Overview” on page 869 topic.

• Read the “File Scanning Limits” on page 106 topic.
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• Note that if you are using the free version of Juniper ATP Cloud, only executable files are scanned.

To configure file inspection profiles:

1. Select Configure>Threat Prevention> Feed Sources.

The Feed Sources page appears.

2. Under the ATP Cloud tab, select ATP Cloud realm, right-click or from theMore list, select File Inspection
Profiles.

The ATP Cloud File Inspection Profiles page appears showing the existing file inspection profiles.

3. Click the + sign to create new profiles.

The Create Profile page appears.

4. Enter a name for the profile. (You can create multiple profiles for file inspection.)

5. In the File Categories section, select the file categories and the following actions from the list for each
file category:

• Do not scan—The file category will not be scanned.

• Scan file up to max size—The maximum files size (up to 32MB) to scan. If a file falls outside of the
maximum file size limit, the file is automatically downloaded to the client system.

• Hash lookup only—Hash lookups are not recommended because, they are compared with the files
that are already evaluated before.

See Table 276 on page 881 for the list of file types for each category.

6. Click OK.

Table 276: File Category Contents

DescriptionCategory

Archive filesArchive

Configuration filesConfiguration

All document types except PDFsDocument

Executable binariesExecutable

Java applications, archives, and librariesJava
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Table 276: File Category Contents (continued)

DescriptionCategory

Dynamic and static libraries and kernel modulesLibrary

Mobile formatsMobile

OS-specific update applicationsOS package

PDF, e-mail, and MBOX filesPDF

Scripting filesScript

Installable Internet Applications such as Adobe Flash, JavaFX, Microsoft
Silverlight

Rich Application

NOTE: Once the profile is created, use the set services advanced-anti-malware policy CLI
command to associate it with the Juniper ATP Cloud profile.

RELATED DOCUMENTATION

File Inspection Profiles Overview | 869

Juniper ATP Cloud Malware Management Overview | 867

File Scanning Limits | 106

About the Feed Sources Page | 862
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Creating Allowlist for Juniper ATP Cloud Email andMalware Management

Use the Modify Allowlist page to add email addresses, IP addresses, and URLs to the allowlist. An allowlist
contains known trusted IP addresses, URLs, and domains. Content downloaded from locations on the
allowlist does not have to be inspected for malware.

Before You Begin

• Read the “Juniper ATP Cloud Email Management Overview” on page 867 topic.

• Read the “Juniper ATP Cloud Malware Management Overview” on page 867 topic.

• Decide on the type of location you intend to define: URL or IP address.

• Review the current list of entries to ensure that the item you are adding does not already exist.

To configure the allowlists:

1. Select Configure>Threat Prevention> Feed Sources.

The Feed Sources page appears.

2. Under the ATP Cloud tab, right-click the ATP Cloud realm or from the More list, select Allowlist.

The Modify Allowlist page appears.

3. Click the + sign to add more entries to the allowlist.

4. Complete the configuration by using the guidelines in Table 277 on page 883.

5. Click OK.

Table 277: Fields on the Modify Allowlist Page

DescriptionField

Email List

The allowed email senders are listed here.

To add more email senders to the allowlist, click the + sign.

Enter the full address in the format name@domain.com or wildcard the name to permit all emails
from a specific domain. For example, *@domain.com.

Email Sender

Malware List
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Table 277: Fields on the Modify Allowlist Page (continued)

DescriptionField

Enter an IP address or a URL.

• IP—Enter an IPV4 address in standard four octet format. CIDR notation and IP address ranges
are also accepted. Any of the following formats are valid: 1.2.3.4, 1.2.3.4/30, or 1.2.3.4-1.2.3.6.

• URL—Enter the URL using the following format: juniper.net. Wildcards and protocols are not
valid entries. The system automatically adds a wildcard to the beginning and end of URLs.
Therefore juniper.net also matches a.juniper.net, a.b.juniper.net, and a.juniper.net/abc. If you
explicitly enter a.juniper.net, it matches b.a.juniper.net, but not c.juniper.net. You can enter a
specific path. If you enter juniper.net/abc, it matches x.juniper.net/abc, but not x.juniper.net/123.

IP and URL

To edit an existing allowlist entry, select the allowlist that you want to edit and click the pencil icon.

Juniper ATP Cloud periodically polls for new and updated content and automatically downloads it to your
SRX Series device. There is no need to manually push your allowlist files.

RELATED DOCUMENTATION
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Creating Blocklists for Juniper ATPCloud Email andMalwareManagement

Use the Modify Blocklist page to add email addresses, IP addresses, and URLs to the blocklist. A blocklist
contains known untrusted IP addresses, URLs, and domains. Access to locations on the blocklist is blocked,
and therefore no content can be downloaded from those sites.

Before You Begin

• Read the “Juniper ATP Cloud Email Management Overview” on page 867 topic.

• Read the “Juniper ATP Cloud Malware Management Overview” on page 867 topic.

• Compile a list of knownmalicious email addresses or domains to add to your blocklist. If an email matches
the blocklist, it is considered to be malicious and is handled the same way as an email with a malicious
attachment, blocked and a replacement email is sent. If an email matches the allowlist, that email is
allowed through without any scanning.
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• It is worth noting that attackers can easily fake the “From” email address of an email, making blocklists
a less effective way to stop malicious emails.

• Decide on the type of location you intend to define: URL or IP address.

• Review the current list of entries to ensure that the item you are adding does not already exist.

To configure the blocklists:

1. Select Configure>Threat Prevention> Feed Sources.

The Feed Sources page appears.

2. Under the ATP Cloud tab, right-click the ATP Cloud realm or from the More list, select Blocklist.

The Modify Blocklist page appears.

3. Click the + sign to add more entries to the blocklist.

4. Complete the configuration by using the guidelines in Table 278 on page 885.

5. Click OK.

Table 278: Fields on the Modify Blocklist Page

DescriptionField

Email List

The allowed email senders are listed here.

To add more email senders to the blocklist, click the + sign.

Enter the full address in the format name@domain.com or wildcard the name to permit all emails
from a specific domain. For example, *@domain.com.

Email Sender

Malware List

Enter an IP address or a URL.

• IP—Enter an IPV4 address in standard four octet format. CIDR notation and IP address ranges
are also accepted. Any of the following formats are valid: 1.2.3.4, 1.2.3.4/30, or 1.2.3.4-1.2.3.6.

• URL—Enter the URL using the following format: juniper.net. Wildcards and protocols are not
valid entries. The system automatically adds a wildcard to the beginning and end of URLs.
Therefore juniper.net also matches a.juniper.net, a.b.juniper.net, and a.juniper.net/abc. If you
explicitly enter a.juniper.net, it matches b.a.juniper.net, but not c.juniper.net. You can enter a
specific path. If you enter juniper.net/abc, it matches x.juniper.net/abc, but not x.juniper.net/123.

IP and URL
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To edit an existing blocklist entry, select the blocklist that you want to edit and click the pencil icon.

Juniper ATP Cloud periodically polls for new and updated content and automatically downloads it to your
SRX Series device. There is no need to manually push your blocklist files.

RELATED DOCUMENTATION
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Juniper ATP Cloud Malware Management Overview | 867
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Add JATP Server

Configure the Juniper ATP appliance in Policy Enforcer to receive threat feeds for threat mitigation.

Before You Begin

Before you add the Juniper ATP Appliance:

• Obtain the IP address of the Juniper ATP appliance.

• Generate the API Authorization key for the Juniper ATP admin user. This is required to provide authorized
programmatic access to the Juniper ATP Appliance REST API. The configured Authorization Key for that
user is then applied each time an API request is made by that user.

• In the Juniper ATP Appliance web UI, navigate to Config>System Profiles>Users and click on an
existing user account.

• In the Update User page, select the Generate New API Key option.

For more information, see Updating a User Account and Setting an API Authorization Key.

• Configure multi-tenancy Web Collector Zones for Managed Security Service Provider (MSSP) support.

• In the Juniper ATP Appliance web UI, navigate to Config>System Profiles>Zones.

For more information, see Configuring MSSP Multi-Tenancy Zones.

To add a Juniper ATP server:

1. Select Configure>Threat Prevention>Feed Sources.

The Feed Source page appears.

2. In the JATP page, click the + sign.
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The Add JATP Server page appears.

3. Complete the configuration according to the guidelines provided in Table 279 on page 887.

4. Click Finish.

The required Juniper ATP appliance is added to Policy Enforcer for threat monitoring.

Table 279: Fields on the Add JATP Server Page

DescriptionField

JATP Server Settings

Enter the IP address of the Juniper ATP appliance.JATP Server IP Address

Enter the API Authorization key of the Juniper ATP appliance user. The same API key is
used for general Juniper ATP RESTful API access and also to integrate with SRX Series
devices.

The API key is used only once to obtain the application token from the JATP server. The
obtained application token is provided to Policy Enforcer and this token never expires.

To know more about generating the API key, see Updating a User Account and Setting
an API Authorization Key.

API Key

Enter the configured zone name.

You can enroll Policy Enforcer with the Juniper ATP default zone or with a specific Juniper
ATP zone. This enrollment is authenticated with an API authorization key.

Zone Name

Site

Select the site to be enrolled to the zone from the list.

If there are no sites associated with the realm, click Add new Site.

Site

Lists all devices from the zone that are not managed in Security Director. You must
manually discover them.

Unmanaged Devices

Enable this option to receive IPv6 feeds (C&C and Geo IP) from Policy Enforcer.IPv6 Feeds

RELATED DOCUMENTATION

About the Feed Sources Page | 862
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Edit or Delete a JATP Server | 888

JATP Operator’s Guide

Edit or Delete a JATP Server

You can modify the site information of an existing Juniper ATP zone or delete a Juniper ATP server, from
the Feed Sources page.

To edit or delete a Juniper ATP server:

1. Select Configure>Threat Prevention>Feed Sources>JATP.

The Feed Sources page appears.

2. Select the zone you want to edit or delete and then right-click.

• Select Edit to modify site information. TheModify JATP Server page appears. Make the changes and
click Finish.

You can also click the pencil icon to modify the configuration.

• Select Delete to remove the Juniper ATP server. An alert message appears verifying that you want
to delete your selection. Click Yes to delete your selection.

You can also click the delete icon to delete the Juniper ATP server.

RELATED DOCUMENTATION

Add JATP Server | 886

About the Feed Sources Page | 862

Custom Feed Sources Overview

Policy Enforcer uses threat feeds to provide actionable intelligence to policies about various types of
threats. These feeds can come from different sources, such as Juniper ATP Cloud, and from lists that you
can customize by adding IP addresses, domains, and URLs.
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NOTE: Juniper ATP Cloud feeds and custom feeds are mutually exclusive. You can only have
one source for dynamic address, allowlist, blocklist, infected host feeds, and C&C Server.

NOTE: When dynamic address custom feeds are available, you cannot use office_365 feeds
from Juniper ATP Cloud.

The following types of custom threat feeds are available:

• A dynamic address is a group of IP addresses that can be imported from external sources. These IP
addresses are for specific domains or for entities that have a common attribute such as a particular
undesired location that poses a threat. You can then configure security policies to use the dynamic
addresses within a security policy.

• An allowlist contains known trusted IP addresses, URLs, and domains. Content downloaded from locations
on the allowlist does not have to be inspected for malware.

• A blocklist contains known untrusted IP addresses, URLs, and domains. Access to locations on the
blocklist is blocked, and therefore no content can be downloaded from those sites.

• Infected hosts are hosts known to be compromised. Enter host IP addresses manually or upload a text
file with the IP addresses of infected hosts.

• Using DDoS threat feed, policy Enforcer blocks source IP addresses in the feed, rate limit the traffic
from the source IP addresses, and takes BGP Flowspec action to apply null-route filtering or redirect
the traffic to scrubbing centers.

• Command and Control Server (C&C Server) is a centralized computer that issues commands to botnets
(compromised networks of computers) and receives reports back from them. Botnets can be used to
gather sensitive information, such as account numbers or credit card information, or to participate in a
distributed DDoS attack.

For threat management policies to use these feeds, you must enter configuration information for each
feed type.

Benefits of Custom Feed Sources

• Provides relevant and timely intelligence that you can use to create enforcement policies. Enables you
to customize threat feeds specific to your industry or organization.

• Provides flexible mechanisms to synchronize threat information to:

• Configure Policy Enforcer to poll from local file and remote file custom feeds.

• Push threat feeds to Policy Enforcer using the Threat Feed API .
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Creating Custom Feeds | 890

Example: Creating a Dynamic Address Custom Feed and Firewall Policy | 894

Creating Custom Feeds

Use the Create Custom Feed page to configure the Dynamic Address, Allowlist, Blocklist, Infected Hosts,
DDoS, and C&C Server custom feeds. These feeds provide relevant and timely intelligence that you can
use to create enforcement policies.

Before You Begin

• Knowwhat type of feed you are configuring and have all the necessary information on hand. Local feeds
are created on your local system and uploaded from there.

• Note that infected hosts are hosts known to be compromised. For an infected host custom feed, enter
host IP addresses manually or upload a text file with the IP addresses of infected hosts.

• If you create an allowlist, blocklist, or infected hosts feed, it will override the respective Juniper ATP
Cloud/JATP feed.

• Note that when ATP Cloud/JATP only mode is selected as the Threat Prevention Type, the infected
host and DDoS custom feeds are not available.

To create local file and remote file custom feeds:

1. Select Configure>Threat Prevention> Feed Sources.

The Feed Sources page appears. Youwill see only custom feeds available as the threat prevention type,
if you make no selection for ATP Cloud/JATP Configuration Type in the Policy Enforcer Settings page.

2. Click Create and select one of the following:

• Feeds with local files—Enter your data manually into the provided fields or upload from a text file on
your location machine.

• Feeds with remote file server—Configure communication with the remote server to fetch the data
feed from it.

3. Complete the configuration by using the guidelines in Table 280 on page 891 or Table 281 on page 893.

4. Click OK.
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NOTE:
• To use a custom feed of dynamic-address type, apply it to the source or destination address
in a firewall rule. In the firewall rule, you can filter addresses to show only the custom feeds.

If there is a firewall policy rule created using the dynamic address, you cannot delete the same
dynamic address from the Feed Sources page. You must first delete the firewall policy rule
and then , delete the dynamic address from the Feed Sources page.

• When you have no ATP Cloud/JATP Configuration Type selected (No selection), ATP
Cloud/JATP realms are disabled. Because site selection is usually done from the ATP
Cloud/JATP realm page, you must select sites from the Create Custom Feed page when in
“No selection” mode. The custom feeds are then downloaded to the devices in the chosen
sites. This is the only time site selection available in the Create Custom Feed page.

Table 280: Fields on the Create Custom Feed Page, Feeds with Local Files

DescriptionField

Enter a unique string that must begin with an alphanumeric character and can include only dashes
and underscores; no spaces allowed; 32-character maximum.

Name

Enter a description for your custom feed; maximum length is 64 characters. You should make this
description as useful as possible for all administrators.

Description

Select one of the following custom feeds as a threat prevention type:

• Dynamic Address

• Allowlist

• Blocklist

• Infected Hosts

• DDoS

• CC

Feed Type

Select the required sites from the list to associate them with the dynamic address or allowlists,
blocklists, or C&C Server feeds.

In the default mode (no ATP Cloud), only sites are listed because of no ATP Cloud. You can share
a site across the same feed type for dynamic address, allowlist, blocklist, and C&C Server. For
Infected hosts and DDoS, sites cannot be shared across the same feed type. However, you can
share a site across different feed types.

Sites
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Table 280: Fields on the Create Custom Feed Page, Feeds with Local Files (continued)

DescriptionField

Select the required realms from the list, if you are in Cloud feeds only, ATP Cloud/JATP, or ATP
Cloud/JATP with Juniper Connected Security mode.

Associate these realms with dynamic address or allowlists, blocklists, and C&C Server feeds. You
can share a realm across the same feed type for dynamic address, allowlist, blocklist, and CC. For
Infected hosts and DDoS, realms cannot be shared across the same feed type. However, you can
share a realm across different feed types.

The ATP Cloud/JATP realm without any assigned sites are not listed here. Only realms with sites
associated are listed here.

NOTE: If a site is associated with a tenant, the ATP Cloud/JATP realm displays the list in the
<realm-name>(Tenant:<tenant-name>) format.

Zones/Realms

Select one of the following input types for Allowlist and Blocklist:

• IP, Subnet and Range—Enter an IPV4 address in standard four octet format. CIDR notation and
IP address ranges are also accepted. Any of the following formats are valid: 1.2.3.4, 1.2.3.4/30,
or 1.2.3.4-1.2.3.6.

• URL and Domain—Enter the URL using the following format: http://yourfeed.com/abc and
Domain using the following format: http://yourfeed.com.

Wildcards and protocols are not valid entries.

User Input Type

(Available for
Allowlist and
Blocklist)

Do one of the following:

• Click Upload File to upload a text file with an IP address list. Click the Add button to include the
address list in your custom list.

For infected host andDDoS, the uploading file must have the string add at the beginning, followed
by the IP addresses. If you want to delete certain IP addresses, enter the string delete followed
by the IP addresses to delete.

Note that the file must contain only one item per line (no commas or semi colons). All items are
validated before being added to the custom list.

The file must not contain more than 500 entries. An error message is shown if you try to upload
a file containing more than 500 IP addresses. Use the Feeds with remote file server option to
upload a file containing more than 500 IP addresses.

• Manually enter your item and threshhold value in the space provided in the Custom List section.
To add more items, click + to add more spaces.

For syntax, enter an IPv4 address in standard four octet format. CIDR notation and IP address
ranges are also accepted. Any of the following formats are valid: 1.2.3.4, 1.2.3.4/30, or
1.2.3.4-1.2.3.6.

Custom List
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Table 281: Fields on the Create Custom Feed Page, Feeds with Remote File Server

DescriptionField

Enter a unique string that must begin with an alphanumeric character and can include
only dashes and underscores; no spaces allowed; 32-character maximum.

Name

Enter a description for your custom feed; maximum length is 64 characters. You should
make this description as useful as possible for all administrators.

Description

Select one of the following custom feeds as a threat prevention type:

• Dynamic Address

• Allowlist

• Blocklist

• Infected Hosts

• DDoS

• CC

Feed Type

Select one of the following:

• http

• https

Type of Server URL

Enter the URL for the remote file server.Server File URL

Click Browse and select the CA certificate to upload.

If you do not upload a certificate for https server URL, a warning message is shown
that a certificate is not uploaded and to whether proceed further or not. Click Yes to
proceed further without uploading a certificate or No to go back and upload the
certificate.

Certificate Upload

(If the URL type is HTTPS)

Enter the credentials for the remote file server.

This is not a mandatory field. You can still proceed to create a custom feed without
entering the username.

Username

Enter the credentials for the remote file server.

This is a mandatory field, if you have provided the username.

Password

Select how often updates are retrieved from the remote files server: Hourly, Daily,
Weekly, Monthly, Never

Update Interval

Select the required sites from the list to associate them with the custom feeds.Sites
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If you try to disenroll a site in an infected host, a warning message is shown to resolve all the current
infected hosts from the respective endpoints within a site. To resolve the infected hosts, log-in to ATP
Cloud UI, resolve the hosts, and then unassign sites from Policy Enforcer. Ensure that you always resolve
the infected hosts before unassigning sites. Once you unassign sites, you cannot resolve the hosts.

RELATED DOCUMENTATION
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Configuring Settings for Custom Feeds | 896

Example: Creating a Dynamic Address Custom Feed and Firewall Policy

As stated earlier, dynamic addresses provide dynamic IP address information to security policies. A dynamic
address entry (DAE) is a group of IP addresses, not just a single IP prefix, that can be entered manually or
imported from external sources. The DAE feature allows feed-based IP objects to be used in security
policies to either deny or allow traffic based on either source or destination IP criteria. For example, a DAE
may contain IP addresses for specific domains or for entities that have a common attribute such as a
particular undesired location that poses a threat. When the DAE is updated, the changes automatically
become part of the security policy. There is no need tomanually update the policy; no configuration commit
action is required.

This topic steps you through a simple example of creating a DAE and associating it with a policy. For
complete information in creating firewall policies in Security Director, see Creating Firewall Policies.

1. Click Configure>Threat Prevention>Feed Sources.

The Feed Sources page appears.

2. In the Custom Feeds tab, click Create > Feeds with local files.

3. Enter DAE_example1 as the name.

4. Select Dynamic Address from the Feed Type list.

5. Select the ATP Cloud realms from the Realms field.

6. In the Custom List field, click the plus sign (+) to add individual entries to the custom list.

7. Add the following IP addresses. See the online help for information on supported formats.
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• 192.0.2.0

• 192.0.2.1/10

• 198.51.100.0-198.51.100.5

8. Make sure all entries in the custom list are unchecked and click OK.

9. Click Configure > Firewall Policy > Policies.

NOTE: This is example uses simplistic rules to show how to associate a DAEwith an allowlist
firewall policy. When creating your own firewall policy, you will have to configure the rules
that meet your company’s requirements.

10.Click the plus sign (+) to create a new firewall policy.

11. Enter dynamic_address_test as the name.

12. Select All Logging Enabled from the Profile pull-down menu.

13. Select Device Policy as the Type and select a device from the Device pull-down menu.

14.Click OK.

After a few seconds, the dynamic_address_test policy appears in the list.

15.Click Add Rule next to the dynamic_address_test policy to start the rule wizard.

16. Enter dynamic_rule as the name and click Next.

17. In the Source window, select untrust from the Zone pulldown menu and click Select under the
Address(es) field.

18. In the Source Address window, select the Include Specific radio button.

19. SelectDAE_example1 in the left table and click the right arrow to move it to the right table. Then click
Next.

The Source window reappears and DAE_example1 appears in the address(es) field.

20. In the Destionation window, select trust from the Zone pulldown menu and click Next.
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21. In the Advanced Security window, select permit from the Rule Action pulldown menu and click Next.

22. In the Rule Options window, click Next to use the default settings.

23.Click Select in the Address(es) section and click the Include Specifics radio button.

24. In the Rule Analysis window, select theAnalyze the new rule to suggest a placement to avoid anomalies
checkbox and click Next.

After a few seconds, an analysis of your rule appears, including where it should be placed, etc.

25.Click Finish and then OK to exit the wizard.

26. In the resulting page, click Save (located near the top of the window.)

27.Check the checkbox for the dynamic_rule policy and click Publish.

When you publish rules, the process takes into account the priority and precedence values set on the
policy and the order of rules on the device.

Configuring Settings for Custom Feeds

Use the Settings page to specify the number of days for the custom feed to be active and expire once the
duration is crossed. Also, specify how often the feeds must be updated.

In the ATO Cloud with Juniper Connected Security, Clouds feed only, and No ATO Cloud modes, you can
configure the Time To Live (TTL) settings for dynamic address, allowlist, blocklist, infected host, DDoS,
and C&C Server feed types. In the ATO Cloud mode, you can configure TTL settings for only dynamic
address, allowlist, blocklist, and C&C Server feed types.

NOTE: When you configure a TTL setting for a particular feed type, the configuration is applicable
for all the custom feeds belonging to that particular feed type. For example, if you set TTL for
Allowlist feed type to 45 days, then all Allowlist feeds will have the same configuration.
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To configure Settings:

1. Select Configure>Threat Prevention>Feed Source.

The Feed Sources page appears.

2. In the Custom Feeds tab, select Settings.

The Settings page appears.

3. Complete the configuration by using the guidelines in Table 282 on page 897.

4. Click Update.

The settings are updated and a success message is shown that the Settings are updated successfully.

At the beginning of the Settings page, the last updated settings information is shown. This message is
refreshed whenever you update the setting.

Table 282: Fields on the Settings Page

DescriptionOption

Select one of the following options:

• Specify manually—Select this option to specify the number of days for the required custom
feed type to be active.

• Expires in (days)—Enter the number of days for the required custom feed to be active. Default
value is 30 days. The available range is 1 to 365 days.
The number of days that you configure in this field appears in the Days to Become Inactive
field on the Custom Feeds page. If you make any changes to this field, the same information
is refreshed in the Days to Become Inactive field and the timer is adjusted to the updated
value.

• Never Expire—Select this option if you do not want any custom feed type to be inactive or
expire.

Time to live

Specify how often each feed type must be updated.

By default, all feeds are updated every 5 minutes.

Valid range is 1 through 5 minutes.

Update Interval
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IPsec VPN-VPNs
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IPsec VPN Overview

IPsec VPN provides a means to securely communicate with remote computers across a public WAN such
as the Internet. A VPN connection can link two LANs (site-to-site VPN) or a remote dial-up user and a
LAN. The traffic that flows between these two points passes through shared resources such as routers,
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switches, and other network equipment that make up the public WAN. To secure VPN communication
that passes through the WAN, you’ll need to create an IPsec tunnel.

Security Director simplifies themanagement and deployment of IPsec VPNs. In general, VPN configurations
are tedious and repetitive when deploying over a large number of SRX Series devices and for full-meshed
VPN deployments. With Security Director, you can use VPN profiles to group common settings and apply
them to multiple VPN tunnel configurations across multiple SRX Series devices. You can mass deploy
site-to-site, hub-and-spoke, and fullymeshedVPNs. SecurityDirector determines the necessary deployment
scenarios and publishes the required configuration for all SRX Series devices.

Security Director supports policy-based and route-based IPsec VPNs on SRX Series devices. Policy-based
VPNs are supported only in the site-to-site deployments, where you configure two endpoints. If you have
two or more SRX Series devices, then route-based VPNs offer more flexibility and scalability. To allow
data to be securely transferred between a branch office and the corporate office, configure a policy-based
or route-based IPsec VPN. For an enterprise-class deployment, configure a hub-and-spoke IPsec VPN.

Use route-based tunnel mode if:

• Participating gateways are Juniper Networks products.

• Either source or destination NAT must occur when traffic traverses the VPN.

• Dynamic routing protocols must be used for VPN routing.

• Primary and backup VPNs are required in the setup.

Use policy-based tunnel mode if:

• The remote VPN gateway is a non-Juniper Networks device.

• Access to the VPN must be restricted for specific application traffic.

When you create a policy-based or route-based IPsec VPN, a topology is displayed for representation.
You’ll need to click on the icons to configure the remote gateway.

NOTE:
• Security Director views each logical system as any other security device and takes ownership
of the security configuration of the logical system. In Security Director, each logical system is
managed as a unique security device.

• Security Director ensures that the tunnel interfaces are exclusively assigned to the individual
logical systems of a device. No tunnel interface is assigned to more than one logical system
of the same device.

• Security Director does not support VPN over Point-to-Point Protocol over Ethernet (PPPoE).
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IPsec VPN Topologies

The following IPsec VPNs are supported:

• Site-to-Site VPNs—Connects two sites in an organization together and allows secure communications
between the sites.

• Hub-and-Spoke (establishment all peers)—Connects branch offices to the corporate office in an enterprise
network. You can also use this topology to connect spokes together by sending traffic through the hub.

• Hub-and-Spoke (establishment by spokes)—Auto-VPN supports an IPsec VPN aggregator (hub) that
serves as a single termination point for multiple tunnels to remote sites (spokes). Auto-VPN allows
network administrators to configure a hub for current and future spokes. No configuration changes are
required on the hub when spoke devices are added or deleted, thus allowing administrators flexibility
in managing large-scale network deployments.

• Hub-and-Spoke (Auto Discovery VPN)—Auto Discovery VPN (ADVPN) is a technology that allows the
central hub to dynamically inform spokes about a better path for traffic between two spokes. When
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both spokes acknowledge the information from the hub, they establish a shortcut tunnel and change
the routing topology for the host to reach the other side without sending traffic through the hub.

• FullMesh—Connects two ormore participating gateways and sets up a separate tunnel with every other
device in the group.

• Remote Access VPN (Juniper Secure Connect)—Juniper Secure Connect provides secure remote access
for the users to connect to the corporate networks and resources remotely using the Internet. Juniper
Secure Connect downloads the configuration from SRX Services devices and chooses themost effective
transport protocols during connection establishment.

• Remote Access VPN (NCP exclusive client)—Remote Access VPN allows users working at home or
traveling, to connect to the corporate office and its resource. The Network Control Protocol (NCP)
Exclusive Remote Access Client is part of the NCP Exclusive Remote Access solution for Juniper SRX
Series Gateways. The VPN client is only available with NCP Exclusive Remote AccessManagement. Use
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the NCP Exclusive Client to establish secure, IPsec-based data links from any location when connected
with SRX Series Gateways.
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Create a Site-to-Site VPN

A site-to-site VPN connects two sites in an organization and allows secure communications between the
sites.

Before You Begin

• Read the “IPsec VPN Overview” on page 899 topic.

• Review the IPsec VPN main page for an understanding of your current data set. See “IPsec VPN Main
Page Fields” on page 982 for field descriptions.

• Create addresses and address sets. See “Creating Addresses and Address Groups” on page 1026.
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• Create VPN profiles. See “Creating VPN Profiles” on page 988.

• Define extranet devices. See “Creating Extranet Devices” on page 984.

To configure a site-to-site VPN:

1. Select Configure > IPsec VPN > IPsec VPNs.

The IPsec VPNs page is displayed.

2. Click Create VPN > <Policy Based/Route Based> Site to Site.

The Create Site to Site VPN page is displayed.

3. Complete the VPN configuration parameters according to the guidelines provided in
Table 283 on page 905 through Table 286 on page 909.

NOTE: Click each device icon in the topology to configure the devices. ClickView IKE/IPSec
Settings to view or edit VPN profiles. If the VPN profile is default, you can edit the
configurations. If the profile is shared, you can only view the configurations.

The VPN connectivity will change from gray to blue line in the topology to show that the
configuration is complete.

4. Click Save to save the IPsec VPN configuration.

Figure 68: Create Site-to-Site VPN
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Table 283: IPsec VPN Configuration Parameters

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons,
periods, dashes, and underscores; spaces are not allowed;
maximum length is 62 characters.

Name

Enter a description for the VPN; maximum length is 255
characters.

Description

Select one of the following options:

• Traffic Selector (Auto Route Insertion)—A traffic selector
is an agreement between Internet Key Exchange (IKE)
peers to permit traffic through a tunnel if the traffic
matches a specified pair of local and remote addresses.

• Static routing—Generates static routing based on the
protected networks or zones per device.

• OSPF-DynamicRouting—GeneratesOSPFconfiguration.

• RIP-Dynamic Routing—Generates RIP configuration.

• eBGP-DynamicRouting—Generates eBGPconfiguration.

NOTE: Routing Topology is applicable only for
Route-based VPNs.

Routing Topology

Select a VPN profile from the drop-down list based on the
deployment scenario.

Default profile is applicable to a particular IPsec VPN only.
You can view and edit the details by clicking View
IKE/IPsec settings on the Create VPN page.

Shared profile can be used by one or more IPsec VPNs.
You can only view the details of the shared profiles by
clicking View IKE/IPsec settings.

If you select the VPN Profile value as Default, then while
saving the IPsec VPN, you can choose to save the new
profile as either VPN specific or shared. If you are saving
it as shared, then the profile will be listed on the VPN
Profiles page.

VPN Profile
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Table 283: IPsec VPN Configuration Parameters (continued)

GuidelinesSettings

Select an authentication method from the list that the
device uses to authenticate the source of Internet Key
Exchange (IKE) messages.

• Pre-shared based—Specifies that a pre-shared key,
which is a secret key shared between the two peers, is
used during authentication to identify the peers to each
other. The same key must be configured for each peer.

• RSA Signatures—Specifies that a public key algorithm,
which supports encryption and digital signatures is used.

• DSA Signatures—Specifies that the Digital Signature
Algorithm (DSA) is used.

• ECDSA Signatures 256—Specifies that the Elliptic Curve
DSA (ECDSA) using the 256-bit elliptic curve secp256r1,
as specified in the Federal Information Processing
Standard (FIPS) Digital Signature Standard (DSS) 186-3
is used.

• ECDSA Signatures 384—Specifies that the ECDSAusing
the 384-bit elliptic curve secp384r1, as specified in the
FIPS DSS 186-3 is used.

Authentication Method

Global Tunnel Settings

Establish a VPN connection using pre-shared keys, which
is essentially a password that is same for both parties.
Pre-shared keys are commonly deployed for site-to-site
IPsec VPNs, either within a single organization or between
different organizations.

Select the type of pre-shared key you want to use:

• Autogenerate—Select if you want to automatically
generate a unique key per tunnel. When selected, the
Generate Unique key per tunnel option is automatically
enabled. If you disable the Generate Unique key per
tunnel option, Security Director generates a single key
for all tunnels.

• Manual—Select to enter the key manually. By default,
the manual key is masked.

NOTE: This is applicable only if the authenticationmethod
is pre-shared based.

Pre-shared Key
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Table 283: IPsec VPN Configuration Parameters (continued)

GuidelinesSettings

Enter the IP address of the numbered tunnel interface.
This is the subnet address from where the IP address is
automatically assigned for tunnel interfaces.

Network IP

Select themaximum transmission unit (MTU) in bytes. This
defines the maximum size of an IP packet, including the
IPsec overhead. You can specify the MTU value for the
tunnel endpoint.

The valid range is 68 to 9192 bytes.

The default value is 1500 bytes.

Max Transmission Unit

Table 284: View or Select Devices

GuidelinesSettings

Select either Devices or Extranet devices as endpoints.

NOTE: To add extranet devices inline, click Add Extranet Devices.

Endpoint

View all devices from the current and child domains, with view parent enabled. Devices from
the child domain with view parent disabled are not shown.

You can select a device and add it as an endpoint.

The following filter criteria are applied for the device selection:

• SRX Series devices mapped to Junos OS Release 12.1X46 and later Junos-es schemas are not
listed.

• Logical systems and tenant systems are not listed.

• Routing option is not applicable.

Available

Table 285: Device Configuration Parameters

GuidelinesSettings

Select the outgoing interface for IKE security associations (SAs).External Interface

Select the tunnel zone. They are logical areas of address space that can support dynamic IP (DIP)
address pools for NAT applications to pre and post-encapsulated IPsec traffic.

Tunnel zones also provide great flexibility in combining tunnel interfaces with VPN tunnels.

NOTE: This is applicable for only route-based site-to-site VPN.

Tunnel Zone
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Table 285: Device Configuration Parameters (continued)

GuidelinesSettings

Select the required routing instance.

NOTE: This is applicable for only route-based site-to-site VPN.

Routing instance

Select an option:

• Initiator

• Recipient

NOTE: This is applicable when the VPN profile is Aggressive Mode profile.

Initiator/Recipient

Select a certificate to authenticate the virtual private network (VPN) initiator and recipient.

This is applicable in one of the following scenarios:

• The VPN profile is RSA profile or ADVPN profile.

• The authentication method is RSA-Signatures, DSA-Signatures, ECDSA-Signatures-256, or
ECDSA-Signatures-384.

Certificate

Select the certificate authority (CA) profile from the list to associate it with the local certificate.

This is applicable in one of the following scenarios:

• The VPN profile is RSA profile, ADVPN profile, or default profile with any signature type.

• The authentication method is RSA-Signatures, DSA-Signatures, ECDSA-Signatures-256, or
ECDSA-Signatures-384.

Trusted CA/Group

• Select the Static Routes check box to export static routes.

Security Director simplifies VPN address management by enabling the administrator to export
static routes to a remote site over a tunnel, allowing the static route networks to participate
in the VPN.

For eBGP Dynamic Routing, by default, the Static Routes check box is selected.

• Select the RIP Routes check box to export RIP routes.

NOTE: You can export RIP routes only when Routing Topology is OSPF Dynamic Routing.

• Select the OSPF Routes check box to export OSPF routes.

NOTE: You can export OSPF routes only when Routing Topology is RIP-Dynamic Routing.

If you select OSPF or RIP export, theOSPF or RIP routes outside the VPNnetwork is imported
into a VPN network through OSPF or RIP Dynamic routing protocols.

Export
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Table 285: Device Configuration Parameters (continued)

GuidelinesSettings

Select an OSPF area ID within the range of 0 to 4,294,967,295, where the tunnel interfaces of
this VPN need to be configured.

NOTE: This is applicable when the routing topology is OSPF-Dynamic Routing in route-based
site-to-site VPN.

OSPF Area

Select the retransmission timer to limit the number of times the RIP demand circuit re-sends
updatemessages to an unresponsive peer. If the configured retransmission threshold is reached,
routes from the next-hop router are marked as unreachable and the hold-down timer starts.
You must configure a pair of RIP demand circuits for this timer to take effect.

The retransmission range is from 5 through 180 seconds and the default value is 50 seconds.

NOTE: This is applicable only when routing topology is RIP-Dynamic Routing in route-based
site-to-site VPN.

Max
Retransmission
Time

Select a unique number to assign to the autonomous system (AS). The AS number identifies an
autonomous system and enables the system to exchange exterior routing informationwith other
neighboring autonomous systems. The valid range is from 0 through 4294967294.

NOTE: This is applicable only when routing topology is e-BGP Dynamic Routing in route-based
site-to-site VPN.

AS Number

Configure the addresses or interface type for the selected device to protect one area of the
network from the other.

When a dynamic routing protocol is selected, the interface option is displayed.

You can also create addresses by clicking Add New Address.

NOTE: This is applicable for only route-based site-to-site VPN.

Protected
Networks

Table 286: View or Edit IKE and IPsec Settings

GuidelinesSettings

IKE Settings

Select the required IKE version, either V1 or V2, that is used to negotiate dynamic security
associations (SAs) for IPsec. By default, IKE V2 is used.

IKE Version
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Table 286: View or Edit IKE and IPsec Settings (continued)

GuidelinesSettings

Select an IKE policy mode.

• Main—Uses six messages in three peer-to-peer exchanges to establish the IKE SA.
These three steps include the IKE SA negotiation, a Diffie-Hellman exchange, and
authentication of the peer. Also provides identity protection.

• Aggressive—Takes half the number of messages of main mode, has less negotiation
power, and does not provide identity protection.

NOTE: Mode is applicable when the IKE Version is V1.

Mode

Select the appropriate encryption mechanism.Encryption-algorithm

Select an algorithm. The device uses this algorithm to verify the authenticity and integrity
of a packet.

Authentication-algorithm

Select a group. Diffie-Hellman (DH) groups determine the strength of the key used in the
key exchange process.

Deffie Hellman group

Select a lifetime of an IKE security association (SA). The valid range is from 180 through
86,400 seconds.

Lifetime-seconds

Enable to permit the two gateways to determine if the peer gateway is up and responding
to the Dead Peer Detection (DPD) messages that are negotiated during IPsec
establishment.

Dead Peer Detection

Select a DPD Mode.

• Optimized: R-U-THERE messages are triggered if there is no incoming IKE or IPsec
traffic within a configured interval after the device sends outgoing packets to the peer.
This is the default mode.

• Probe Idle Tunnel: R-U-THEREmessages are triggered if there is no incoming or outgoing
IKE or IPsec traffic within a configured interval. R-U-THERE messages are sent
periodically to the peer until there is traffic activity.

• Always-send: R-U-THEREmessages are sent at configured intervals regardless of traffic
activity between the peers.

DPD Mode

Select an interval in seconds to send dead peer detection messages. The default interval
is 10 seconds, with a permissible range of 2 to 60 seconds.

DPD Interval

Select the failure DPD threshold value. This specifies the maximum number of times the
DPDmessagesmust be sent when there is no response from the peer. The default number
of transmissions is 5 times, with a permissible range of 1 to 5.

DPD Threshold
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Table 286: View or Edit IKE and IPsec Settings (continued)

GuidelinesSettings

Advance Configuration

Enable this option to accept peer IKE ID. This option is disabled by default. If General IKE
ID is enabled, the IKE ID option is disabled automatically.

General IKE ID

Select a reauthentication frequency. Reauthentication can be disabled by setting the
reauthentication frequency to 0.

Range is 0 to 100.

IKEv2 Re Authentication

IKEv2 fragmentation splits a large IKEv2 message into a set of smaller ones so that there
is no fragmentation at the IP level.

IKEv2 Re Fragmentation
Support

Select the size of the packet at which messages are fragmented. By default, the size is
576 bytes for IPv4.

Range is 570 to 1320.

IKEv2 Re-fragment Size

Select an option:

• None

• Distinguished name

• Hostname

• IPv4 address

• E-mail Address

IKE ID is applicable only when General IKE ID is disabled.

IKE ID

Enable Network Address Translation-Traversal (NAT-T) if the dynamic endpoint is behind
a NAT device.

NAT-T

Select a value. NAT Keepalives are required to maintain the NAT translation during the
connection between the VPN peers. Range is from 1 to 300 seconds.

Keep Alive

IPSec Settings

Select the required protocol to establish the VPN.

• ESP—The Encapsulating Security Payload (ESP) protocol provides both encryption and
authentication.

• AH—The Authentication Header (AH) protocol provides data integrity and data
authentication.

Protocol
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Table 286: View or Edit IKE and IPsec Settings (continued)

GuidelinesSettings

Select the necessary encryption method.

This is applicable if the Protocol is ESP.

Encryption Algorithm

Select an algorithm. The device uses these algorithms to verify the authenticity and
integrity of a packet.

Authentication Algorithm

Select Perfect Forward Secrecy (PFS) as the method that the device uses to generate the
encryption key. The PFS generates each new encryption key independently from the
previous key. The higher numbered groups provide more security but require more
processing time.

Perfect Forward Secrecy

Select an option to specify when IKE is activated.

• Immediately—IKE is activated immediately after VPN configuration changes are
committed.

• On-traffic—IKE is activated only when data traffic flows and must be negotiated with
the peer gateway. This is the default behavior.

Establish Tunnel

Advance Configuration

Enable this option to send Internet Control Message Protocol (ICMP) to determine if the
VPN is up.

VPN Monitor

When VPN monitoring optimization is enabled, the SRX Series device only sends ICMP
echo requests (pings) when there is outgoing traffic and no incoming traffic from the
configured peer, through the VPN tunnel. If there is incoming traffic through the VPN
tunnel, the SRX Series device considers the tunnel to be active and does not send pings
to the peer.

Optimized

By default, Anti-Replay detection is enabled. IPsec protects against a VPN attack by using
a sequence of numbers that are built into the IPsec packet—the system does not accept
a packet for which it has already seen the same sequence number. It checks the sequence
numbers and enforces the check, rather than just ignoring the sequence numbers. Disable
it if there is an error with the IPsec mechanism that results in out-of-order packets,
preventing proper functionality.

Anti Replay

Select themaximumnumber of seconds to allow for the installation of a re-keyed outbound
security association (SA) on the device.

Install interval

Select the appropriate idle time interval. The sessions and their corresponding translations
typically time out after a certain period if no traffic is received.

Idle Time
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Table 286: View or Edit IKE and IPsec Settings (continued)

GuidelinesSettings

Select an option to process the Don’t Fragment (DF) bit in IP messages.

• Clear—Disable the DF bit from the IP messages. This is the default.

• Copy—Copy the DF bit to the IP messages.

• Set—Enable the DF bit in the IP messages.

DF Bit

Enable copying of Differentiated Services Code Point (DSCP) field from the outer IP
header encrypted packet to the inner IP header plain text message on the decryption
path. The benefit in enabling this feature is that after IPsec decryption, clear text packets
can follow the inner class-of-service (CoS) rules.

Copy Outer DSCP

Select a lifetime of an IKE security association (SA). The valid range is from 180 through
86,400 seconds.

Lifetime Seconds

Select the lifetime (in kilobytes) of an IPsec security association (SA). The range is from
64 through 4294967294 kilobytes.

Lifetime kilobytes

RELATED DOCUMENTATION

IPsec VPN Overview | 899

Create a Hub-and-Spoke (Establishment All Peers) VPN

The hub-and-spoke (establishment all peers) VPN connects spokes together by sending traffic through
the hub.

Before You Begin

• Read the “IPsec VPN Overview” on page 899 topic.

• Review the IPsec VPN main page for an understanding of your current data set. See “IPsec VPN Main
Page Fields” on page 982 for field descriptions.

• Create addresses and address sets. See “Creating Addresses and Address Groups” on page 1026.

• Create VPN profiles. See “Creating VPN Profiles” on page 988.

• Define extranet devices. See “Creating Extranet Devices” on page 984.
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To configure hub-and-spoke (establishment all peers):

1. Select Configure > IPsec VPN > IPsec VPNs.

The IPsec VPNs page is displayed.

2. Click Create VPN > <Route Based>Hub and Spoke (Establishment All Peers).

The Create Hub-and-Spoke (Establishment All Peers) VPN page is displayed.

3. Complete the VPN configuration parameters according to the guidelines provided in
Table 283 on page 905 through Table 286 on page 909.

NOTE: Click each hub and spoke icon in the topology to configure the devices. Click View
IKE/IPSec Settings to view or edit VPN profiles. If the VPN profile is default, you can edit
the configurations. If the profile is shared, you can only view the configurations.

The VPN connectivity will change from gray to blue line in the topology to show that the
configuration is complete.

The topology displayed for hub-and-spoke is only a representation. You can configure any
number of hubs and spokes.

4. Click Save to save the IPsec VPN configuration.

Figure 69: Create Hub-and-Spoke (Establishment All Peers) VPN
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Table 287: IPsec VPN Configuration Parameters

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons,
periods, dashes, and underscores; spaces are not allowed;
maximum length is 62 characters.

Name

Enter a description for the VPN; maximum length is 255
characters.

Description

Select one of the following options:

• Traffic Selector (Auto Route Insertion)—A traffic selector
is an agreement between Internet Key Exchange (IKE)
peers to permit traffic through a tunnel if the traffic
matches a specified pair of local and remote addresses.

• Static routing—Generates static routing based on the
protected networks or zones per device.

• OSPF-DynamicRouting—GeneratesOSPFconfiguration.

• RIP-Dynamic Routing—Generates RIP configuration.

• eBGP-DynamicRouting—Generates eBGPconfiguration.

Routing Topology

Select a VPN profile from the drop-down list based on the
deployment scenario.

Default profile is applicable to a particular IPsec VPN only.
You can view and edit the details by clicking View
IKE/IPsec settings on the Create IPsec VPN page.

Shared profile can be used by one or more IPsec VPNs.
You can only view the details of the shared profiles by
clicking View IKE/IPsec settings on the Create IPsec VPN
page.

If you select the VPN Profile value as Default, then while
saving the IPsec VPN, you’ll need to save the new profile
as either VPN specific or shared. If you are saving it as
shared, then the profile will be listed on the VPN Profiles
page.

VPN Profile
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Table 287: IPsec VPN Configuration Parameters (continued)

GuidelinesSettings

Select an authentication method from the list that the
device uses to authenticate the source of Internet Key
Exchange (IKE) messages.

• Pre-shared based—Specifies that a pre-shared key,
which is a secret key shared between the two peers, is
used during authentication to identify the peers to each
other. The same key must be configured for each peer.

• RSA Signatures—Specifies that a public key algorithm,
which supports encryption and digital signatures is used.

• DSA Signatures—Specifies that the Digital Signature
Algorithm (DSA) is used.

• ECDSA-Signatures-256—Specifies that the Elliptic Curve
DSA (ECDSA) using the 256-bit elliptic curve secp256r1,
as specified in the Federal Information Processing
Standard (FIPS) Digital Signature Standard (DSS) 186-3
is used.

• ECDSA-Signatures-384—Specifies that the ECDSAusing
the 384-bit elliptic curve secp384r1, as specified in the
FIPS DSS 186-3 is used.

Authentication Method

Global Tunnel Settings

Establish a VPN connection using pre-shared keys, which
is essentially a password that is same for both parties.

Select the type of pre-shared key you want to use:

• Autogenerate—Select if you want to automatically
generate a unique key per tunnel. When selected, the
Generate Unique key per tunnel option is automatically
enabled. If you disable Generate Unique key per tunnel
option, Security Director generates a single key for all
tunnels.

• Manual—Select to enter the key manually. By default,
the manual key is masked.

NOTE: This is applicable only if the authenticationmethod
is Preshared based.

Pre-shared Key

Enter the IP address of the numbered interface. This is
the subnet address from where the IP address is
automatically assigned for tunnel interfaces.

Network IP
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Table 287: IPsec VPN Configuration Parameters (continued)

GuidelinesSettings

Select All or specify the number of spoke devices to share
one tunnel interface on hub.

Number of Spoke Devices Per Tunnel Interface

Select themaximum transmission unit (MTU) in bytes. This
defines the maximum size of an IP packet, including the
IPsec overhead. You can specify the MTU value for the
tunnel endpoint. The valid range is 68 to 9192 bytes. The
default value is 1500 bytes.

Max Transmission Unit

Table 288: View or Select Devices

GuidelinesSettings

Select either Devices or Extranet devices as hubs.

NOTE: To add extranet devices, click Add Extranet Devices.

Hub

Select either Devices or Extranet devices as spokes.

NOTE: To add extranet devices, click Add Extranet Devices.

Spoke

View all devices from the current and child domains, with view parent enabled. Devices from the
child domain with view parent disabled are not shown.

Select hub and spoke devices.

The following filter criteria are applied for the device selection:

• SRX Series devices mapped to Junos OS Release 12.1X46 and later Junos-es schemas are not
listed.

• Logical systems and tenant systems are not listed.

• Routing option is not applicable.

Available

Table 289: Device Configuration Parameters

GuidelinesSettings

Select the outgoing interface for IKE security associations (SAs). This interface is associated with
a zone that acts as its carrier, providing firewall security for it.

External Interface

Select the tunnel zone. They are logical areas of address space that can support dynamic IP (DIP)
address pools for NAT applications to pre- and post-encapsulated IPsec traffic.

Tunnel zones also provide great flexibility in combining tunnel interfaces with VPN tunnels.

Tunnel Zone
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Table 289: Device Configuration Parameters (continued)

GuidelinesSettings

Specify the cost for an access route for the next hop.Metric

Select the required routing instance.Routing instance

Select a certificate to authenticate the virtual private network (VPN) initiator and recipient.

This is applicable in one of the following scenarios:

• The VPN profile is RSA profile or ADVPN profile.

• The authentication method is RSA-Signatures, DSA-Signatures, ECDSA-Signatures-256, or
ECDSA-Signatures-384.

Certificate

Select the certificate authority (CA) profile from the list to associate it with the local certificate.

This is applicable in one of the following scenarios:

• The VPN profile is RSA profile or ADVPN profile.

• The authentication method is RSA-Signatures, DSA-Signatures, ECDSA-Signatures-256, or
ECDSA-Signatures-384.

Trusted CA/Group

• Select the Static Routes check box to export static routes.

Security Director simplifies VPN addressmanagement by enabling the administrator to export
static routes to a remote site over a tunnel, allowing the static route networks to participate
in the VPN. However, only devices on the hub side can export static default routes to the
device side. Devices at the spoke side cannot export static default routes over a tunnel.

NOTE: For eBGP Dynamic Routing, by default, the Static Routes check box is selected.

• Select the RIP Routes check box to export RIP routes.

NOTE: You can export RIP routes only when Routing Topology is OSPF Dynamic Routing.

• Select the OSPF Routes check box to export OSPF routes.

NOTE: You can export OSPF routes only when Routing Topology is RIP-Dynamic Routing.

If you select OSPF or RIP export, theOSPF or RIP routes outside the VPN network is imported
into a VPN network through OSPF or RIP Dynamic routing protocols.

Export

Select an OSPF area ID within the range of 0 to 4,294,967,295, where the tunnel interfaces of
this VPN need to be configured.

This is applicable when the Routing Topology is OSPF-Dynamic Routing.

OSPF Area
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Table 289: Device Configuration Parameters (continued)

GuidelinesSettings

Select the retransmission timer to limit the number of times the RIP demand circuit re-sends
updatemessages to an unresponsive peer. If the configured retransmission threshold is reached,
routes from the next-hop router are marked as unreachable and the hold-down timer starts. You
must configure a pair of RIP demand circuits for this timer to take effect.

The retransmission range is from 5 through 180 seconds and the default value is 50 seconds.

NOTE: This is applicable only when Routing Topology is RIP-Dynamic Routing.

Max
Retransmission
Time

Select a unique number to assign to the autonomous system (AS). The AS number identifies an
autonomous system and enables the system to exchange exterior routing informationwith other
neighboring autonomous systems. The valid range is from 0 through 4294967295.

NOTE: This is applicable only when Routing Topology is e-BGP Dynamic Routing.

AS Number

Configure the addresses or interface type for the selected device to protect one area of the
network from the other.

When a dynamic routing protocol is selected, the interface option is displayed.

NOTE: You can also create addresses by clicking Add New Address.

Protected
Networks

Table 290: View or Edit IKE or IPsec Settings

GuidelinesSettings

IKE Settings

Select the required IKE version, either V1 or V2, that is used to negotiate dynamic security
associations (SAs) for IPsec. By default, IKE V2 is used.

IKE Version

Select an IKE policy mode.

• Main—Uses six messages in three peer-to-peer exchanges to establish the IKE SA.
These three steps include the IKE SA negotiation, a Diffie-Hellman exchange, and
authentication of the peer. Also provides identity protection.

• Aggressive—Takes half the number of messages of main mode, has less negotiation
power, and does not provide identity protection.

NOTE: Mode is applicable when the IKE Version is V1.

Mode

Select the appropriate encryption mechanism.Encryption-algorithm
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Table 290: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Select an algorithm. The device uses this algorithm to verify the authenticity and integrity
of a packet.

Authentication-algorithm

Select a group. Diffie-Hellman (DH) groups determine the strength of the key used in the
key exchange process.

Deffie Hellman group

Select a lifetime of an IKE security association (SA). The valid range is from 180 through
86,400 seconds.

Lifetime-seconds

Enable to permit the two gateways to determine if the peer gateway is up and responding
to the Dead Peer Detection (DPD) messages that are negotiated during IPsec
establishment.

Dead Peer Detection

Select a DPD Mode.

• Optimized: R-U-THERE messages are triggered if there is no incoming IKE or IPsec
traffic within a configured interval after the device sends outgoing packets to the peer.
This is the default mode.

• Probe Idle Tunnel: R-U-THEREmessages are triggered if there is no incoming or outgoing
IKE or IPsec traffic within a configured interval. R-U-THERE messages are sent
periodically to the peer until there is traffic activity.

• Always-send: R-U-THEREmessages are sent at configured intervals regardless of traffic
activity between the peers.

DPD Mode

Select an interval in seconds to send dead peer detection messages. The default interval
is 10 seconds, with a permissible range of 2 to 60 seconds.

DPD Interval

Select the failure DPD threshold value. This specifies the maximum number of times the
DPDmessagesmust be sent when there is no response from the peer. The default number
of transmissions is 5 times, with a permissible range of 1 to 5.

DPD Threshold

Advance Configuration

Enable this option to accept peer IKE ID. This option is disabled by default. If General IKE
ID is enabled, the IKE ID option is disabled automatically.

General IKE ID

Select a reauthentication frequency. Reauthentication can be disabled by setting the
reauthentication frequency to 0.

Range is 0 to 100.

IKEv2 Re Authentication
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Table 290: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

IKEv2 fragmentation splits a large IKEv2 message into a set of smaller ones so that there
is no fragmentation at the IP level.

IKEv2 Re Fragmentation
Support

Select the size of the packet at which messages are fragmented. By default, the size is
576 bytes for IPv4.

Range is 570 to 1320.

IKEv2 Re-fragment Size

Select an option:

• None

• Distinguished name

• Hostname

• IPv4 address

• E-mail Address

IKE ID is applicable only when General IKE ID is disabled.

IKE ID

Enable Network Address Translation-Traversal (NAT-T) if the dynamic endpoint is behind
a NAT device.

NAT-T

Select a value. NAT Keepalives are required to maintain the NAT translation during the
connection between the VPN peers. Range is from 1 to 300 seconds.

Keep Alive

IPSec Settings

Select the required protocol to establish the VPN.

• ESP—The Encapsulating Security Payload (ESP) protocol provides both encryption and
authentication.

• AH—The Authentication Header (AH) protocol provides data integrity and data
authentication.

Protocol

Select the necessary encryption method.

This is applicable if the Protocol is ESP.

Encryption Algorithm

Select an algorithm. The device uses these algorithms to verify the authenticity and
integrity of a packet.

Authentication Algorithm
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Table 290: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Select Perfect Forward Secrecy (PFS) as the method that the device uses to generate the
encryption key. The PFS generates each new encryption key independently from the
previous key. The higher numbered groups provide more security but require more
processing time.

Perfect Forward Secrecy

Select an option to specify when IKE is activated.

• Immediately—IKE is activated immediately after VPN configuration changes are
committed.

• On-traffic—IKE is activated only when data traffic flows and must be negotiated with
the peer gateway. This is the default behavior.

Establish Tunnel

Advance Configuration

Enable this option to send Internet Control Message Protocol (ICMP) to determine if the
VPN is up.

VPN Monitor

When VPN monitoring optimization is enabled, the SRX Series device only sends ICMP
echo requests (pings) when there is outgoing traffic and no incoming traffic from the
configured peer, through the VPN tunnel. If there is incoming traffic through the VPN
tunnel, the SRX Series device considers the tunnel to be active and does not send pings
to the peer.

Optimized

By default, Anti-Replay detection is enabled. IPsec protects against a VPN attack by using
a sequence of numbers that are built into the IPsec packet—the system does not accept
a packet for which it has already seen the same sequence number. It checks the sequence
numbers and enforces the check, rather than just ignoring the sequence numbers. Disable
it if there is an error with the IPsec mechanism that results in out-of-order packets,
preventing proper functionality.

Anti Replay

Select themaximumnumber of seconds to allow for the installation of a re-keyed outbound
security association (SA) on the device.

Install interval

Select the appropriate idle time interval. The sessions and their corresponding translations
typically time out after a certain period if no traffic is received.

Idle Time

Select an option to process the Don’t Fragment (DF) bit in IP messages.

• Clear—Disable the DF bit from the IP messages. This is the default.

• Copy—Copy the DF bit to the IP messages.

• Set—Enable the DF bit in the IP messages.

DF Bit
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Table 290: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Enable copying of Differentiated Services Code Point (DSCP) field from the outer IP
header encrypted packet to the inner IP header plain text message on the decryption
path. The benefit in enabling this feature is that after IPsec decryption, clear text packets
can follow the inner class-of-service (CoS) rules.

Copy Outer DSCP

Select a lifetime of an IKE security association (SA). The valid range is from 180 through
86,400 seconds.

Lifetime Seconds

Select the lifetime (in kilobytes) of an IPsec security association (SA). The range is from
64 through 4294967294 kilobytes.

Lifetime kilobytes

RELATED DOCUMENTATION

IPsec VPN Overview | 899

Create a Hub-and-Spoke (Establishment by Spokes) VPN

Auto-VPN allows you to configure a hub for current and future spokes. No configuration changes are
required on the hub when spoke devices are added or deleted, thus allowing administrators flexibility in
managing large-scale network deployments.

Before You Begin

• Read the “IPsec VPN Overview” on page 899 topic.

• Review the IPsec VPN main page for an understanding of your current data set. See “IPsec VPN Main
Page Fields” on page 982 for field descriptions.

• Create addresses and address sets. See “Creating Addresses and Address Groups” on page 1026.

• Create VPN profiles. See “Creating VPN Profiles” on page 988.

To configure hub-and-spoke (establishment by spokes):

1. Select Configure > IPsec VPN > IPsec VPNs.

The IPsec VPNs page is displayed.

2. Click Create VPN > <Route Based>Hub and Spoke (Establishment by Spokes).

923



The Create Hub-and-Spoke (Establishment by Spokes) VPN page is displayed.

3. Complete the VPN configuration parameters according to the guidelines provided in
Table 283 on page 905 through Table 286 on page 909.

NOTE: Click each hub and spoke icon in the topology to configure the devices. Click View
IKE/IPSec Settings to view or edit VPN profiles. If the VPN profile is default, you can edit
the configurations. If the profile is shared, you can only view the configurations.

The VPN connectivity will change from gray to blue line in the topology to show that the
configuration is complete.

The topology displayed for hub-and-spoke is only a representation. You can configure any
number of hubs and spokes.

4. Click Save to save the IPsec VPN configuration.

Figure 70: Create Hub-and-Spoke (Establishment by Spokes) VPN
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Table 291: IPsec VPN Configuration Parameters

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons,
periods, dashes, and underscores; spaces are not allowed;
maximum length is 62 characters.

Name

Enter a description for the VPN; maximum length is 255
characters.

Description

Select one of the following options:

• Traffic Selector (Auto Route Insertion)—A traffic selector
is an agreement between Internet Key Exchange (IKE)
peers to permit traffic through a tunnel if the traffic
matches a specified pair of local and remote addresses.

• Static routing—Generates static routing based on the
protected networks or zones per device.

• OSPF-DynamicRouting—GeneratesOSPFconfiguration.

• RIP-Dynamic Routing—Generates RIP configuration.

• eBGP-DynamicRouting—Generates eBGPconfiguration.

Routing Topology

Select a VPN profile from the drop-down list based on the
deployment scenario.

Default profile is applicable to a particular IPsec VPN only.
You can view and edit the details by clicking View
IKE/IPsec settings on the Create IPsec VPN page.

Shared profile can be used by one or more IPsec VPNs.
You can only view the details of the shared profiles by
clicking View IKE/IPsec settings on the Create IPsec VPN
page.

If you select the VPN Profile value as Default, then while
saving the IPsec VPN, you’ll need to save the new profile
as either VPN specific or shared. If you are saving it as
shared, then the profile will be listed on the VPN Profiles
page.

VPN Profile
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Table 291: IPsec VPN Configuration Parameters (continued)

GuidelinesSettings

Select an authentication method from the list that the
device uses to authenticate the source of Internet Key
Exchange (IKE) messages.

• Pre-shared based—Specifies that a pre-shared key,
which is a secret key shared between the two peers, is
used during authentication to identify the peers to each
other. The same key must be configured for each peer.

• RSA Signatures—Specifies that a public key algorithm,
which supports encryption and digital signatures, is
used.

• DSA Signatures—Specifies that the Digital Signature
Algorithm (DSA) is used.

• ECDSA-Signatures-256—Specifies that the Elliptic Curve
DSA (ECDSA) using the 256-bit elliptic curve secp256r1,
as specified in the Federal Information Processing
Standard (FIPS) Digital Signature Standard (DSS) 186-3
is used.

• ECDSA-Signatures-384—Specifies that the ECDSAusing
the 384-bit elliptic curve secp384r1, as specified in the
FIPS DSS 186-3 is used.

Authentication Method

Global Tunnel Settings

Establish a VPN connection using pre-shared keys, which
is essentially a password that is same for both parties.

Select the type of pre-shared key you want to use:

• Autogenerate—Select if you want to automatically
generate a unique key per tunnel. When selected, the
Generate Unique key per tunnel option is automatically
enabled. If you disable Generate Unique key per tunnel
option, Security Director generates a single key for all
tunnels.

• Manual—Select to enter the key manually. By default,
the manual key is masked.

NOTE: This is applicable only if the authenticationmethod
is Pre-shared based.

Pre-shared Key
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Table 291: IPsec VPN Configuration Parameters (continued)

GuidelinesSettings

Enter the IP address of the numbered interface. This is
the subnet address from where the IP address is
automatically assigned for tunnel interfaces.

Network IP

Select themaximum transmission unit (MTU) in bytes. This
defines the maximum size of an IP packet, including the
IPsec overhead. You can specify the MTU value for the
tunnel endpoint. The valid range is 68 to 9192 bytes. The
default value is 1500 bytes.

Max Transmission Unit

Table 292: View or Select Devices

GuidelinesSettings

Select Devices as hubs.Hub

Select Devices as spokes.Spoke

View all devices from the current and child domains, with view parent enabled. Devices from
the child domain with view parent disabled are not shown.

Select hub and spoke devices.

The following filter criteria are applied for the device selection:

• SRX Series devices mapped to Junos OS Release 12.1X46 and later Junos-es schemas are
not listed.

• Logical systems and tenant systems are not listed.

• Routing option is not applicable.

Available

Table 293: Device Configuration Parameters

GuidelinesSettings

Select the outgoing interface for IKE security associations (SAs). This interface is associated with
a zone that acts as its carrier, providing firewall security for it.

External Interface

Select the tunnel zone. They are logical areas of address space that can support dynamic IP (DIP)
address pools for NAT applications to pre- and post-encapsulated IPsec traffic.

Tunnel zones also provide great flexibility in combining tunnel interfaces with VPN tunnels.

Tunnel Zone

Specify the cost for an access route for the next hop.Metric
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Table 293: Device Configuration Parameters (continued)

GuidelinesSettings

Select the required routing instance.Routing instance

Select a certificate to authenticate the virtual private network (VPN) initiator and recipient.

This is applicable in one of the following scenarios:

• The VPN profile is RSA profile or ADVPN profile.

• The authentication method is RSA-Signatures, DSA-Signatures, ECDSA-Signatures-256, or
ECDSA-Signatures-384.

Certificate

Select the certificate authority (CA) profile from the list to associate it with the local certificate.

This is applicable in one of the following scenarios:

• The VPN profile is RSA profile or ADVPN profile.

• The authentication method is RSA-Signatures, DSA-Signatures, ECDSA-Signatures-256, or
ECDSA-Signatures-384.

Trusted CA/Group

• Select the Static Routes check box to export static routes.

Security Director simplifies VPN addressmanagement by enabling the administrator to export
static routes to a remote site over a tunnel, allowing the static route networks to participate
in the VPN. However, only devices on the hub side can export static default routes to the
device side. Devices at the spoke side cannot export static default routes over a tunnel.

NOTE: For eBGP Dynamic Routing, by default, the Static Routes check box is selected.

• Select the RIP Routes check box to export RIP routes.

NOTE: You can export RIP routes only when Routing Topology is OSPF Dynamic Routing.

• Select the OSPF Routes check box to export OSPF routes.

NOTE: You can export OSPF routes only when Routing Topology is RIP-Dynamic Routing.

If you select OSPF or RIP export, theOSPF or RIP routes outside the VPN network is imported
into a VPN network through OSPF or RIP Dynamic routing protocols.

Export

Select an OSPF area ID within the range of 0 to 4,294,967,295, where the tunnel interfaces of
this VPN need to be configured.

This is applicable when the Routing Topology is OSPF-Dynamic Routing.

OSPF Area
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Table 293: Device Configuration Parameters (continued)

GuidelinesSettings

Select the retransmission timer to limit the number of times the RIP demand circuit re-sends
updatemessages to an unresponsive peer. If the configured retransmission threshold is reached,
routes from the next-hop router are marked as unreachable and the hold-down timer starts. You
must configure a pair of RIP demand circuits for this timer to take effect.

The retransmission range is from 5 through 180 seconds and the default value is 50 seconds.

NOTE: This is applicable only when Routing Topology is RIP-Dynamic Routing.

Max
Retransmission
Time

Select a unique number to assign to the autonomous system (AS). The AS number identifies an
autonomous system and enables the system to exchange exterior routing informationwith other
neighboring autonomous systems. The valid range is from 0 through 4294967295.

NOTE: This is applicable only when Routing Topology is e-BGP Dynamic Routing.

AS Number

Configure the addresses or interface type for the selected device to protect one area of the
network from the other.

When a dynamic routing protocol is selected, the interface option is displayed.

NOTE: You can also create addresses by clicking Add New Address.

Protected
Networks

Table 294: View or Edit IKE or IPsec Settings

GuidelinesSettings

IKE Settings

Select the required IKE version, either V1 or V2, that is used to negotiate dynamic security
associations (SAs) for IPsec. By default, IKE V2 is used.

IKE Version

Select an IKE policy mode.

• Main—Uses six messages in three peer-to-peer exchanges to establish the IKE SA.
These three steps include the IKE SA negotiation, a Diffie-Hellman exchange, and
authentication of the peer. Also provides identity protection.

• Aggressive—Takes half the number of messages of main mode, has less negotiation
power, and does not provide identity protection.

NOTE: Mode is applicable when the IKE Version is V1.

Mode

Select the appropriate encryption mechanism.Encryption-algorithm
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Table 294: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Select an algorithm. The device uses this algorithm to verify the authenticity and integrity
of a packet.

Authentication-algorithm

Select a group. Diffie-Hellman (DH) groups determine the strength of the key used in the
key exchange process.

Deffie Hellman group

Select a lifetime of an IKE security association (SA). The valid range is from 180 through
86,400 seconds.

Lifetime-seconds

Enable to permit the two gateways to determine if the peer gateway is up and responding
to the Dead Peer Detection (DPD) messages that are negotiated during IPsec
establishment.

Dead Peer Detection

Select a DPD Mode.

• Optimized: R-U-THERE messages are triggered if there is no incoming IKE or IPsec
traffic within a configured interval after the device sends outgoing packets to the peer.
This is the default mode.

• Probe Idle Tunnel: R-U-THEREmessages are triggered if there is no incoming or outgoing
IKE or IPsec traffic within a configured interval. R-U-THERE messages are sent
periodically to the peer until there is traffic activity.

• Always-send: R-U-THEREmessages are sent at configured intervals regardless of traffic
activity between the peers.

DPD Mode

Select an interval in seconds to send dead peer detection messages. The default interval
is 10 seconds, with a permissible range of 2 to 60 seconds.

DPD Interval

Select the failure DPD threshold value. This specifies the maximum number of times the
DPDmessagesmust be sent when there is no response from the peer. The default number
of transmissions is 5 times, with a permissible range of 1 to 5.

DPD Threshold

Advance Configuration

Enable this option to accept peer IKE ID. This option is disabled by default. If General IKE
ID is enabled, the IKE ID option is disabled automatically.

General IKE ID

Select a reauthentication frequency. Reauthentication can be disabled by setting the
reauthentication frequency to 0.

Range is 0 to 100.

IKEv2 Re Authentication
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Table 294: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

IKEv2 fragmentation splits a large IKEv2 message into a set of smaller ones so that there
is no fragmentation at the IP level.

IKEv2 Re Fragmentation
Support

Select the size of the packet at which messages are fragmented. By default, the size is
576 bytes for IPv4.

Range is 570 to 1320.

IKEv2 Re-fragment Size

Select an option:

• None

• Distinguished name

• Hostname

• IPv4 address

• E-mail Address

IKE ID is applicable only when General IKE ID is disabled.

IKE ID

Enable Network Address Translation-Traversal (NAT-T) if the dynamic endpoint is behind
a NAT device.

NAT-T

Select a value. NAT Keepalives are required to maintain the NAT translation during the
connection between the VPN peers. Range is from 1 to 300 seconds.

Keep Alive

IPSec Settings

Select the required protocol to establish the VPN.

• ESP—The Encapsulating Security Payload (ESP) protocol provides both encryption and
authentication.

• AH—The Authentication Header (AH) protocol provides data integrity and data
authentication.

Protocol

Select the necessary encryption method.

This is applicable if the Protocol is ESP.

Encryption Algorithm

Select an algorithm. The device uses these algorithms to verify the authenticity and
integrity of a packet.

Authentication Algorithm
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Table 294: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Select Perfect Forward Secrecy (PFS) as the method that the device uses to generate the
encryption key. The PFS generates each new encryption key independently from the
previous key. The higher numbered groups provide more security but require more
processing time.

Perfect Forward Secrecy

Select an option to specify when IKE is activated.

• Immediately—IKE is activated immediately after VPN configuration changes are
committed.

• On-traffic—IKE is activated only when data traffic flows and must be negotiated with
the peer gateway. This is the default behavior.

Establish Tunnel

Advance Configuration

Enable this option to send Internet Control Message Protocol (ICMP) to determine if the
VPN is up.

VPN Monitor

When VPN monitoring optimization is enabled, the SRX Series device only sends ICMP
echo requests (pings) when there is outgoing traffic and no incoming traffic from the
configured peer, through the VPN tunnel. If there is incoming traffic through the VPN
tunnel, the SRX Series device considers the tunnel to be active and does not send pings
to the peer.

Optimized

By default, Anti-Replay detection is enabled. IPsec protects against a VPN attack by using
a sequence of numbers that are built into the IPsec packet—the system does not accept
a packet for which it has already seen the same sequence number. It checks the sequence
numbers and enforces the check, rather than just ignoring the sequence numbers. Disable
it if there is an error with the IPsec mechanism that results in out-of-order packets,
preventing proper functionality.

Anti Replay

Select themaximumnumber of seconds to allow for the installation of a re-keyed outbound
security association (SA) on the device.

Install interval

Select the appropriate idle time interval. The sessions and their corresponding translations
typically time out after a certain period if no traffic is received.

Idle Time

Select an option to process the Don’t Fragment (DF) bit in IP messages.

• Clear—Disable the DF bit from the IP messages. This is the default.

• Copy—Copy the DF bit to the IP messages.

• Set—Enable the DF bit in the IP messages.

DF Bit
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Table 294: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Enable copying of Differentiated Services Code Point (DSCP) field from the outer IP
header encrypted packet to the inner IP header plain text message on the decryption
path. The benefit in enabling this feature is that after IPsec decryption, clear text packets
can follow the inner class-of-service (CoS) rules.

Copy Outer DSCP

Select a lifetime of an IKE security association (SA). The valid range is from 180 through
86,400 seconds.

Lifetime Seconds

Select the lifetime (in kilobytes) of an IPsec security association (SA). The range is from
64 through 4294967294 kilobytes.

Lifetime kilobytes

RELATED DOCUMENTATION

IPsec VPN Overview | 899

Create a Hub-and-Spoke Auto Discovery VPN

The Auto-Discovery VPN (ADVPN) dynamically establishes VPN tunnels between spokes to avoid routing
traffic through the hub.

Before You Begin

• Read the “IPsec VPN Overview” on page 899 topic.

• Review the IPsec VPN main page for an understanding of your current data set. See “IPsec VPN Main
Page Fields” on page 982 for field descriptions.

• Create addresses and address sets. See “Creating Addresses and Address Groups” on page 1026.

• Create VPN profiles. See “Creating VPN Profiles” on page 988.

To configure Hub and Spoke ADVPN:

1. Select Configure > IPsec VPN > IPsec VPNs.

The IPsec VPNs page is displayed.

2. Click Create VPN > <Route Based>Hub and Spoke (ADVPN - Auto Discovery VPN).

The Create Hub-and-Spoke (ADVPN - Auto Discovery VPN) page is displayed.
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3. Complete the VPN configuration parameters according to the guidelines provided in
Table 283 on page 905 through Table 286 on page 909.

NOTE: Click each hub and spoke icon in the topology to configure the devices. Click View
IKE/IPSec Settings to view or edit VPN profiles. If the VPN profile is default, you can edit
the configurations. If the profile is shared, you can only view the configurations.

The VPN connectivity will change from gray to blue line in the topology to show that the
configuration is complete.

The topology displayed for hub-and-spoke is only a representation. You can configure any
number of hubs and spokes.

4. Click Save to save the IPsec VPN configuration.

Figure 71: Create Hub-and-Spoke Auto Discovery VPN

Table 295: IPsec VPN Configuration Parameters

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons,
periods, dashes, and underscores; spaces are not allowed;
maximum length is 62 characters.

Name

934



Table 295: IPsec VPN Configuration Parameters (continued)

GuidelinesSettings

Enter a description for the VPN; maximum length is 255
characters.

Description

Select one of the following options:

• OSPF-DynamicRouting—GeneratesOSPFconfiguration.

• RIP-Dynamic Routing—Generates RIP configuration.

• eBGP-DynamicRouting—Generates eBGPconfiguration.

Routing Topology

Select a VPN profile from the drop-down list based on the
deployment scenario.

Default profile is applicable to a particular IPsec VPN only.
You can view and edit the details by clicking View
IKE/IPsec settings on the Create IPsec VPN page.

Shared profile can be used by one or more IPsec VPNs.
You can only view the details of the shared profiles by
clicking View IKE/IPsec settings on the Create IPsec VPN
page.

If you select the VPN Profile value as Default, then while
saving the IPsec VPN, you’ll need to save the new profile
as either VPN specific or shared. If you are saving it as
shared, then the profile will be listed on the VPN Profiles
page.

VPN Profile

Select an authentication method from the list that the
device uses to authenticate the source of Internet Key
Exchange (IKE) messages.

• RSA Signatures—Specifies that a public key algorithm,
which supports encryption and digital signatures is used.

• DSA Signatures—Specifies that the Digital Signature
Algorithm (DSA) is used.

• ECDSA-Signatures-256—Specifies that the Elliptic Curve
DSA (ECDSA) using the 256-bit elliptic curve secp256r1,
as specified in the Federal Information Processing
Standard (FIPS) Digital Signature Standard (DSS) 186-3
is used.

• ECDSA-Signatures-384—Specifies that the ECDSAusing
the 384-bit elliptic curve secp384r1, as specified in the
FIPS DSS 186-3 is used.

Authentication Method
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Table 295: IPsec VPN Configuration Parameters (continued)

GuidelinesSettings

Select the maximum number of shortcut tunnels that can
be created with different shortcut partners using a
particular gateway. The maximum number, which is also
the default, is platform-dependent.

Shortcut Connection Limit

Select the rate, in packets per second, below which the
shortcut is brought down.

Range: 3 through 5,000 packets per second.

Idle Threshold

Select the duration, in seconds, after which the shortcut
is deleted if the traffic remains below the idle-threshold
value.

Range: 60 seconds through 86,400 seconds.

Idle Time

Global Tunnel Settings

Enter the IP address of the numbered interface. This is
the subnet address from where the IP address is
automatically assigned for tunnel interfaces.

Network IP

Select themaximum transmission unit (MTU) in bytes. This
defines the maximum size of an IP packet, including the
IPsec overhead. You can specify the MTU value for the
tunnel endpoint. The valid range is 68 to 9192 bytes. The
default value is 1500 bytes.

Max Transmission Unit

Table 296: View or Select Devices

GuidelinesSettings

Select Devices as hubs.Hub

Select Devices as spokes.Endpoint
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Table 296: View or Select Devices (continued)

GuidelinesSettings

View all devices from the current and child domains, with view parent enabled. Devices from
the child domain with view parent disabled are not shown.

Select hub and spoke devices.

The following filter criteria are applied for the device selection:

• SRX Series devices mapped to Junos OS Release 12.1X46 and later Junos-es schemas are
not listed.

• Logical systems and tenant systems are not listed.

• Routing option is not applicable.

Available

Table 297: Device Configuration Parameters

GuidelinesSettings

Select the outgoing interface for IKE security associations (SAs). This interface is associated with
a zone that acts as its carrier, providing firewall security for it.

External Interface

Select the tunnel zone. They are logical areas of address space that can support dynamic IP (DIP)
address pools for NAT applications to pre- and post-encapsulated IPsec traffic.

Tunnel zones also provide great flexibility in combining tunnel interfaces with VPN tunnels.

Tunnel Zone

Specify the cost for an access route for the next hop.Metric

Select the required routing instance.Routing instance

Select a certificate to authenticate the virtual private network (VPN) initiator and recipient.

This is applicable in one of the following scenarios:

• The VPN profile is RSA profile or ADVPN profile.

• The authentication method is RSA-Signatures, DSA-Signatures, ECDSA-Signatures-256, or
ECDSA-Signatures-384.

Certificate

Select the certificate authority (CA) profile from the list to associate it with the local certificate.

This is applicable in one of the following scenarios:

• The VPN profile is RSA profile or ADVPN profile.

• The authentication method is RSA-Signatures, DSA-Signatures, ECDSA-Signatures-256, or
ECDSA-Signatures-384.

TrustedCA/Group
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Table 297: Device Configuration Parameters (continued)

GuidelinesSettings

The hub authenticates the spoke’s IKE ID if the subject fields of the spoke’s certificate exactly
match the values configured on the hub. Multiple entries can be specified for each subject field.
The order of values in the fields must match.

Container

The hub authenticates the spoke’s IKE ID if the subject fields of the spoke’s certificate match
the values configured on the hub. The wildcard match supports only one value per field. The
order of the fields is inconsequential

Wildcard

• Select the Static Routes check box to export static routes.

Security Director simplifies VPN address management by enabling the administrator to export
static routes to a remote site over a tunnel, allowing the static route networks to participate
in the VPN. However, only devices on the hub side can export static default routes to the
device side. Devices at the spoke side cannot export static default routes over a tunnel.

NOTE: For eBGP Dynamic Routing, by default, the Static Routes check box is selected.

• Select the RIP Routes check box to export RIP routes.

NOTE: You can export RIP routes only when Routing Topology is OSPF Dynamic Routing.

• Select the OSPF Routes check box to export OSPF routes.

NOTE: You can export OSPF routes only when Routing Topology is RIP-Dynamic Routing.

If you select OSPF or RIP export, the OSPF or RIP routes outside the VPN network is imported
into a VPN network through OSPF or RIP Dynamic routing protocols.

Export

Select an OSPF area ID within the range of 0 to 4,294,967,295, where the tunnel interfaces of
this VPN need to be configured.

This is applicable when the Routing Topology is OSPF-Dynamic Routing.

OSPF Area

Select the retransmission timer to limit the number of times the RIP demand circuit re-sends
update messages to an unresponsive peer. If the configured retransmission threshold is reached,
routes from the next-hop router are marked as unreachable and the hold-down timer starts. You
must configure a pair of RIP demand circuits for this timer to take effect.

The retransmission range is from 5 through 180 seconds and the default value is 50 seconds.

NOTE: This is applicable only when Routing Topology is RIP-Dynamic Routing.

Max
Retransmission
Time

Select a unique number to assign to the autonomous system (AS). The AS number identifies an
autonomous system and enables the system to exchange exterior routing informationwith other
neighboring autonomous systems. The valid range is from 0 through 4294967295.

NOTE: This is applicable only when Routing Topology is e-BGP Dynamic Routing.

AS Number
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Table 297: Device Configuration Parameters (continued)

GuidelinesSettings

Configure the addresses or interface type for the selected device to protect one area of the
network from the other.

When a dynamic routing protocol is selected, the interface option is displayed.

NOTE: You can also create addresses by clicking Add New Address.

Protected
Networks

Table 298: View or Edit IKE or IPsec Settings

GuidelinesSettings

IKE Settings

Select the required IKE version, either V1 or V2, that is used to negotiate dynamic security
associations (SAs) for IPsec. By default, IKE V2 is used.

IKE Version

Select an IKE policy mode.

• Main—Uses six messages in three peer-to-peer exchanges to establish the IKE SA.
These three steps include the IKE SA negotiation, a Diffie-Hellman exchange, and
authentication of the peer. Also provides identity protection.

• Aggressive—Takes half the number of messages of main mode, has less negotiation
power, and does not provide identity protection.

NOTE: Mode is applicable when the IKE Version is V1.

Mode

Select the appropriate encryption mechanism.Encryption-algorithm

Select an algorithm. The device uses this algorithm to verify the authenticity and integrity
of a packet.

Authentication-algorithm

Select a group. Diffie-Hellman (DH) groups determine the strength of the key used in the
key exchange process.

Deffie Hellman group

Select a lifetime of an IKE security association (SA). The valid range is from 180 through
86,400 seconds.

Lifetime-seconds

Enable to permit the two gateways to determine if the peer gateway is up and responding
to the Dead Peer Detection (DPD) messages that are negotiated during IPsec
establishment.

Dead Peer Detection
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Table 298: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Select a DPD Mode.

• Optimized: R-U-THERE messages are triggered if there is no incoming IKE or IPsec
traffic within a configured interval after the device sends outgoing packets to the peer.
This is the default mode.

• Probe Idle Tunnel: R-U-THEREmessages are triggered if there is no incoming or outgoing
IKE or IPsec traffic within a configured interval. R-U-THERE messages are sent
periodically to the peer until there is traffic activity.

• Always-send: R-U-THEREmessages are sent at configured intervals regardless of traffic
activity between the peers.

DPD Mode

Select an interval in seconds to send dead peer detection messages. The default interval
is 10 seconds, with a permissible range of 2 to 60 seconds.

DPD Interval

Select the failure DPD threshold value. This specifies the maximum number of times the
DPDmessagesmust be sent when there is no response from the peer. The default number
of transmissions is 5 times, with a permissible range of 1 to 5.

DPD Threshold

Advance Configuration

Enable this option to accept peer IKE ID. This option is disabled by default. If General IKE
ID is enabled, the IKE ID option is disabled automatically.

General IKE ID

Select a reauthentication frequency. Reauthentication can be disabled by setting the
reauthentication frequency to 0.

Range is 0 to 100.

IKEv2 Re Authentication

IKEv2 fragmentation splits a large IKEv2 message into a set of smaller ones so that there
is no fragmentation at the IP level.

IKEv2 Re Fragmentation
Support

Select the size of the packet at which messages are fragmented. By default, the size is
576 bytes for IPv4.

Range is 570 to 1320.

IKEv2 Re-fragment Size
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Table 298: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Select an option:

• None

• Distinguished name

• Hostname

• IPv4 address

• E-mail Address

IKE ID is applicable only when General IKE ID is disabled.

IKE ID

Enable Network Address Translation-Traversal (NAT-T) if the dynamic endpoint is behind
a NAT device.

NAT-T

Select a value. NAT Keepalives are required to maintain the NAT translation during the
connection between the VPN peers. Range is from 1 to 300 seconds.

Keep Alive

IPSec Settings

Select the required protocol to establish the VPN.

• ESP—The Encapsulating Security Payload (ESP) protocol provides both encryption and
authentication.

• AH—The Authentication Header (AH) protocol provides data integrity and data
authentication.

Protocol

Select the necessary encryption method.

This is applicable if the Protocol is ESP.

Encryption Algorithm

Select an algorithm. The device uses these algorithms to verify the authenticity and
integrity of a packet.

Authentication Algorithm

Select Perfect Forward Secrecy (PFS) as the method that the device uses to generate the
encryption key. The PFS generates each new encryption key independently from the
previous key. The higher numbered groups provide more security but require more
processing time.

Perfect Forward Secrecy

Select an option to specify when IKE is activated.

• Immediately—IKE is activated immediately after VPN configuration changes are
committed.

• On-traffic—IKE is activated only when data traffic flows and must be negotiated with
the peer gateway. This is the default behavior.

Establish Tunnel
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Table 298: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Advance Configuration

Enable this option to send Internet Control Message Protocol (ICMP) to determine if the
VPN is up.

VPN Monitor

When VPN monitoring optimization is enabled, the SRX Series device only sends ICMP
echo requests (pings) when there is outgoing traffic and no incoming traffic from the
configured peer, through the VPN tunnel. If there is incoming traffic through the VPN
tunnel, the SRX Series device considers the tunnel to be active and does not send pings
to the peer.

Optimized

By default, Anti-Replay detection is enabled. IPsec protects against a VPN attack by using
a sequence of numbers that are built into the IPsec packet—the system does not accept
a packet for which it has already seen the same sequence number. It checks the sequence
numbers and enforces the check, rather than just ignoring the sequence numbers. Disable
it if there is an error with the IPsec mechanism that results in out-of-order packets,
preventing proper functionality.

Anti Replay

Select themaximumnumber of seconds to allow for the installation of a re-keyed outbound
security association (SA) on the device.

Install interval

Select the appropriate idle time interval. The sessions and their corresponding translations
typically time out after a certain period if no traffic is received.

Idle Time

Select an option to process the Don’t Fragment (DF) bit in IP messages.

• Clear—Disable the DF bit from the IP messages. This is the default.

• Copy—Copy the DF bit to the IP messages.

• Set—Enable the DF bit in the IP messages.

DF Bit

Enable copying of Differentiated Services Code Point (DSCP) field from the outer IP
header encrypted packet to the inner IP header plain text message on the decryption
path. The benefit in enabling this feature is that after IPsec decryption, clear text packets
can follow the inner class-of-service (CoS) rules.

Copy Outer DSCP

Select a lifetime of an IKE security association (SA). The valid range is from 180 through
86,400 seconds.

Lifetime Seconds

Select the lifetime (in kilobytes) of an IPsec security association (SA). The range is from
64 through 4294967294 kilobytes.

Lifetime kilobytes
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Create a Full Mesh VPN

A full mesh VPN connects two or more participating gateways and sets up a separate tunnel with every
other device in the group.

Before You Begin

• Read the “IPsec VPN Overview” on page 899 topic.

• Review the IPsec VPN main page for an understanding of your current data set. See “IPsec VPN Main
Page Fields” on page 982 for field descriptions.

• Create addresses and address sets. See “Creating Addresses and Address Groups” on page 1026.

• Create VPN profiles. See “Creating VPN Profiles” on page 988.

• Define extranet devices. See “Creating Extranet Devices” on page 984.

To configure a full mesh VPN:

1. Select Configure > IPsec VPN > IPsec VPNs.

The IPsec VPNs page is displayed.

2. Click Create VPN > <Route Based>Full Mesh VPN.

The Create Full Mesh VPN page is displayed.

3. Complete the VPN configuration parameters according to the guidelines provided in
Table 283 on page 905 through Table 286 on page 909.
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NOTE: Click a node in the topology to configure the devices. Click View IKE/IPSec Settings
to view or edit VPN profiles. If the VPN profile is default, you can edit the configurations. If
the profile is shared, you can only view the configurations.

The VPN connectivity will change from gray to blue line in the topology to show that the
configuration is complete.

The topology displayed for full mesh is only a representation. Maximum of six nodes are
displayed in the topology. You can configure any number of nodes.

4. Click Save to save the IPsec VPN configuration.

Figure 72: Create Full Mesh VPN

Table 299: IPsec VPN Configuration Parameters

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons,
periods, dashes, and underscores; spaces are not allowed;
maximum length is 62 characters.

Name

Enter a description for the VPN; maximum length is 255
characters.

Description
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Table 299: IPsec VPN Configuration Parameters (continued)

GuidelinesSettings

Select one of the following options:

• Traffic Selector (Auto Route Insertion)—A traffic selector
is an agreement between Internet Key Exchange (IKE)
peers to permit traffic through a tunnel if the traffic
matches a specified pair of local and remote addresses.

• Static routing—Generates static routing based on the
protected networks or zones per device.

• OSPF-DynamicRouting—GeneratesOSPFconfiguration.

• RIP-Dynamic Routing—Generates RIP configuration.

Routing Topology

Select a VPN profile from the drop-down list based on the
deployment scenario.

Default profile is applicable to a particular IPsec VPN only.
You can view and edit the details by clicking View
IKE/IPsec settings on the Create IPsec VPN page.

Shared profile can be used by one or more IPsec VPNs.
You can only view the details of the shared profiles by
clicking View IKE/IPsec settings on the Create IPsec VPN
page.

If you select the VPN Profile value as Default, then while
saving the IPsec VPN, you’ll need to save the new profile
as either VPN specific or shared. If you are saving it as
shared, then the profile will be listed on the VPN Profiles
page.

VPN Profile
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Table 299: IPsec VPN Configuration Parameters (continued)

GuidelinesSettings

Select an authentication method from the list that the
device uses to authenticate the source of Internet Key
Exchange (IKE) messages.

• Pre-shared based—Specifies that a pre-shared key,
which is a secret key shared between the two peers, is
used during authentication to identify the peers to each
other. The same key must be configured for each peer.

• RSA Signatures—Specifies that a public key algorithm,
which supports encryption and digital signatures is used.

• DSA Signatures—Specifies that the Digital Signature
Algorithm (DSA) is used.

• ECDSA-Signatures-256—Specifies that the Elliptic Curve
DSA (ECDSA) using the 256-bit elliptic curve secp256r1,
as specified in the Federal Information Processing
Standard (FIPS) Digital Signature Standard (DSS) 186-3
is used.

• ECDSA-Signatures-384—Specifies that the ECDSAusing
the 384-bit elliptic curve secp384r1, as specified in the
FIPS DSS 186-3 is used.

Authentication Method

Global Tunnel Settings

Establish a VPN connection using pre-shared keys, which
is essentially a password that is same for both parties.

Select the type of pre-shared key you want to use:

• Autogenerate—Select if you want to automatically
generate a unique key per tunnel. When selected, the
Generate Unique key per tunnel is automatically
enabled. If you disable Generate Unique key per tunnel,
Security Director generates a single key for all tunnels.

• Manual—Select to enter the key manually. By default,
the manual key is masked.

NOTE: This is applicable only if the authenticationmethod
is Pre-shared based.

Pre-shared Key

Enter the IP address of the numbered interface. This is
the subnet address from where the IP address is
automatically assigned for tunnel interfaces.

Network IP
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Table 299: IPsec VPN Configuration Parameters (continued)

GuidelinesSettings

Select themaximum transmission unit (MTU) in bytes. This
defines the maximum size of an IP packet, including the
IPsec overhead. You can specify the MTU value for the
tunnel endpoint. The valid range is 68 to 9192 bytes. The
default value is 1500 bytes.

Max Transmission Unit

Table 300: View or Select Devices

GuidelinesSettings

Select either Devices or Extranet devices as endpoints.

NOTE: To add extranet devices inline, click Add Extranet Devices.

Endpoint

View all devices from the current and child domains, with view parent enabled. Devices from
the child domain with view parent disabled are not shown.

Select devices to add as endpoints.

The following filter criteria are applied for the device selection:

• SRX Series devices mapped to Junos OS Release 12.1X46 and later Junos-es schemas are not
listed.

• Logical systems and tenant systems are not listed.

• Routing option is not applicable.

Available

Table 301: Device Configuration Parameters

GuidelinesSettings

Select the outgoing interface for IKE security associations (SAs). This interface is associated with
a zone that acts as its carrier, providing firewall security for it.

External Interface

Select the tunnel zone. They are logical areas of address space that can support dynamic IP (DIP)
address pools for NAT applications to pre- and post-encapsulated IPsec traffic.

Tunnel zones also provide great flexibility in combining tunnel interfaces with VPN tunnels.

Tunnel Zone

Specify the cost for an access route for the next hop.Metric

Select the required routing instance.Routing instance
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Table 301: Device Configuration Parameters (continued)

GuidelinesSettings

Select a certificate to authenticate the virtual private network (VPN) initiator and recipient.

This is applicable in one of the following scenarios:

• The VPN profile is RSA profile or ADVPN profile.

• The authentication method is RSA-Signatures, DSA-Signatures, ECDSA-Signatures-256, or
ECDSA-Signatures-384.

Certificate

Select the certificate authority (CA) profile from the list to associate it with the local certificate.

This is applicable in one of the following scenarios:

• The VPN profile is RSA profile or ADVPN profile.

• The authentication method is RSA-Signatures, DSA-Signatures, ECDSA-Signatures-256, or
ECDSA-Signatures-384.

Trusted CA/Group

• Select the Static Routes check box to export static routes.

Security Director simplifies VPN address management by enabling the administrator to export
static routes to a remote site over a tunnel, allowing the static route networks to participate
in the VPN. However, only devices on the hub side can export static default routes to the
device side. Devices at the spoke side cannot export static default routes over a tunnel.

NOTE: For eBGP Dynamic Routing, by default, the Static Routes check box is selected.

• Select the RIP Routes check box to export RIP routes.

NOTE: You can export RIP routes only when Routing Topology is OSPF Dynamic Routing.

• Select the OSPF Routes check box to export OSPF routes.

NOTE: You can export OSPF routes only when Routing Topology is RIP-Dynamic Routing.

If you selectOSPF or RIP export, theOSPF or RIP routes outside the VPNnetwork is imported
into a VPN network through OSPF or RIP Dynamic routing protocols.

Export

Select an OSPF area ID within the range of 0 to 4,294,967,295, where the tunnel interfaces of
this VPN need to be configured.

This is applicable when the Routing Topology is OSPF-Dynamic Routing.

OSPF Area

Select the retransmission timer to limit the number of times the RIP demand circuit re-sends
updatemessages to an unresponsive peer. If the configured retransmission threshold is reached,
routes from the next-hop router are marked as unreachable and the hold-down timer starts.
You must configure a pair of RIP demand circuits for this timer to take effect.

The retransmission range is from 5 through 180 seconds and the default value is 50 seconds.

NOTE: This is applicable only when Routing Topology is RIP-Dynamic Routing.

Max
Retransmission
Time
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Table 301: Device Configuration Parameters (continued)

GuidelinesSettings

Configure the addresses or interface type for the selected device to protect one area of the
network from the other.

When a dynamic routing protocol is selected, the interface option is displayed.

NOTE: You can also create addresses by clicking Add New Address.

Protected
Networks

Table 302: View or Edit IKE or IPsec Settings

GuidelinesSettings

IKE Settings

Select the required IKE version, either V1 or V2, that is used to negotiate dynamic security
associations (SAs) for IPsec. By default, IKE V2 is used.

IKE Version

Select an IKE policy mode.

• Main—Uses six messages in three peer-to-peer exchanges to establish the IKE SA.
These three steps include the IKE SA negotiation, a Diffie-Hellman exchange, and
authentication of the peer. Also provides identity protection.

• Aggressive—Takes half the number of messages of main mode, has less negotiation
power, and does not provide identity protection.

NOTE: Mode is applicable when the IKE Version is V1.

Mode

Select the appropriate encryption mechanism.Encryption-algorithm

Select an algorithm. The device uses this algorithm to verify the authenticity and integrity
of a packet.

Authentication-algorithm

Select a group. Diffie-Hellman (DH) groups determine the strength of the key used in the
key exchange process.

Deffie Hellman group

Select a lifetime of an IKE security association (SA). The valid range is from 180 through
86,400 seconds.

Lifetime-seconds

Enable to permit the two gateways to determine if the peer gateway is up and responding
to the Dead Peer Detection (DPD) messages that are negotiated during IPsec
establishment.

Dead Peer Detection
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Table 302: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Select a DPD Mode.

• Optimized: R-U-THERE messages are triggered if there is no incoming IKE or IPsec
traffic within a configured interval after the device sends outgoing packets to the peer.
This is the default mode.

• Probe Idle Tunnel: R-U-THEREmessages are triggered if there is no incoming or outgoing
IKE or IPsec traffic within a configured interval. R-U-THERE messages are sent
periodically to the peer until there is traffic activity.

• Always-send: R-U-THEREmessages are sent at configured intervals regardless of traffic
activity between the peers.

DPD Mode

Select an interval in seconds to send dead peer detection messages. The default interval
is 10 seconds, with a permissible range of 2 to 60 seconds.

DPD Interval

Select the failure DPD threshold value. This specifies the maximum number of times the
DPDmessagesmust be sent when there is no response from the peer. The default number
of transmissions is 5 times, with a permissible range of 1 to 5.

DPD Threshold

Advance Configuration

Enable this option to accept peer IKE ID. This option is disabled by default. If General IKE
ID is enabled, the IKE ID option is disabled automatically.

General IKE ID

Select a reauthentication frequency. Reauthentication can be disabled by setting the
reauthentication frequency to 0.

Range is 0 to 100.

IKEv2 Re Authentication

IKEv2 fragmentation splits a large IKEv2 message into a set of smaller ones so that there
is no fragmentation at the IP level.

IKEv2 Re Fragmentation
Support

Select the size of the packet at which messages are fragmented. By default, the size is
576 bytes for IPv4.

Range is 570 to 1320.

IKEv2 Re-fragment Size

950



Table 302: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Select an option:

• None

• Distinguished name

• Hostname

• IPv4 address

• E-mail Address

IKE ID is applicable only when General IKE ID is disabled.

IKE ID

Enable Network Address Translation-Traversal (NAT-T) if the dynamic endpoint is behind
a NAT device.

NAT-T

Select a value. NAT Keepalives are required to maintain the NAT translation during the
connection between the VPN peers. Range is from 1 to 300 seconds.

Keep Alive

IPSec Settings

Select the required protocol to establish the VPN.

• ESP—The Encapsulating Security Payload (ESP) protocol provides both encryption and
authentication.

• AH—The Authentication Header (AH) protocol provides data integrity and data
authentication.

Protocol

Select the necessary encryption method.

This is applicable if the Protocol is ESP.

Encryption Algorithm

Select an algorithm. The device uses these algorithms to verify the authenticity and
integrity of a packet.

Authentication Algorithm

Select Perfect Forward Secrecy (PFS) as the method that the device uses to generate the
encryption key. The PFS generates each new encryption key independently from the
previous key. The higher numbered groups provide more security but require more
processing time.

Perfect Forward Secrecy

Select an option to specify when IKE is activated.

• Immediately—IKE is activated immediately after VPN configuration changes are
committed.

• On-traffic—IKE is activated only when data traffic flows and must be negotiated with
the peer gateway. This is the default behavior.

Establish Tunnel
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Table 302: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Advance Configuration

Enable this option to send Internet Control Message Protocol (ICMP) to determine if the
VPN is up.

VPN Monitor

When VPN monitoring optimization is enabled, the SRX Series device only sends ICMP
echo requests (pings) when there is outgoing traffic and no incoming traffic from the
configured peer, through the VPN tunnel. If there is incoming traffic through the VPN
tunnel, the SRX Series device considers the tunnel to be active and does not send pings
to the peer.

Optimized

By default, Anti-Replay detection is enabled. IPsec protects against a VPN attack by using
a sequence of numbers that are built into the IPsec packet—the system does not accept
a packet for which it has already seen the same sequence number. It checks the sequence
numbers and enforces the check, rather than just ignoring the sequence numbers. Disable
it if there is an error with the IPsec mechanism that results in out-of-order packets,
preventing proper functionality.

Anti Replay

Select themaximumnumber of seconds to allow for the installation of a re-keyed outbound
security association (SA) on the device.

Install interval

Select the appropriate idle time interval. The sessions and their corresponding translations
typically time out after a certain period if no traffic is received.

Idle Time

Select an option to process the Don’t Fragment (DF) bit in IP messages.

• Clear—Disable the DF bit from the IP messages. This is the default.

• Copy—Copy the DF bit to the IP messages.

• Set—Enable the DF bit in the IP messages.

DF Bit

Enable copying of Differentiated Services Code Point (DSCP) field from the outer IP
header encrypted packet to the inner IP header plain text message on the decryption
path. The benefit in enabling this feature is that after IPsec decryption, clear text packets
can follow the inner class-of-service (CoS) rules.

Copy Outer DSCP

Select a lifetime of an IKE security association (SA). The valid range is from 180 through
86,400 seconds.

Lifetime Seconds

Select the lifetime (in kilobytes) of an IPsec security association (SA). The range is from
64 through 4294967294 kilobytes.

Lifetime kilobytes
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Create a Remote Access VPN—Juniper Secure Connect

Juniper Secure Connect is Juniper’s client-based SSL-VPN solution that offers secure remote access for
your network resources. Juniper Secure Connect downloads the configuration from SRX Services devices
and chooses the most effective transport protocols during connection establishment.

Before You Begin

• Read the “IPsec VPN Overview” on page 899 topic.

• Review the IPsec VPN main page for an understanding of your current data set. See “IPsec VPN Main
Page Fields” on page 982 for field descriptions.

• Create addresses and address sets. See “Creating Addresses and Address Groups” on page 1026.

• Create VPN profiles. See “Creating VPN Profiles” on page 988.

• Define extranet devices. See “Creating Extranet Devices” on page 984.

To configure a remote access Juniper secure connect:

1. Select Configure > IPsec VPN > IPsec VPNs.

The IPsec VPNs page is displayed.

2. Click Create VPN > <Route Based> Remote Access Juniper Secure Connect.

The Create Remote Access (Juniper Secure Connect) page is displayed.

3. Complete the IPsec VPN configuration parameters according to the guidelines provided in
Table 283 on page 905 through Table 286 on page 909.

953



NOTE: Click the remote user and local gateway icons to configure remote user and local
gateway. Click View IKE/IPSec Settings to view or edit VPN profiles. If the VPN profile is
default, you can edit the configurations. If the profile is shared, you can only view the
configurations.

The VPN connectivity will change from gray to blue line in the topology to show that the
configuration is complete.

The topology displayed is only for representation.

4. Click Save to save the IPsec configuration.

Figure 73: Create Remote Access Juniper Secure Connect

Table 303: IPsec VPN Configuration Parameters

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons,
periods, dashes, and underscores; spaces are not allowed;
maximum length is 62 characters.

Name

Enter a description for the VPN; maximum length is 255
characters.

Description
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Table 303: IPsec VPN Configuration Parameters (continued)

GuidelinesSettings

Traffic Selector (Auto Route Insertion)—A traffic selector
is an agreement between Internet Key Exchange (IKE)
peers to permit traffic through a tunnel if the traffic
matches a specified pair of local and remote addresses.

Routing Topology

Select a VPN profile from the drop-down list based on the
deployment scenario.

Default profile is applicable to a particular IPsec VPN only.
You can view and edit the details by clicking View
IKE/IPsec settings on the Create IPsec VPN page.

Shared profile can be used by one or more IPsec VPNs.
You can only view the details of the shared profiles by
clicking View IKE/IPsec settings on the Create IPsec VPN
page.

If you select the VPN Profile value as Default, then while
saving the IPsec VPN, you’ll need to save the new profile
as either VPN specific or shared. If you are saving it as
shared, then the profile will be listed on the VPN Profiles
page.

VPN Profile

Select an authentication method from the list that the
device uses to authenticate the source of Internet Key
Exchange (IKE) messages.

• Pre-shared based—Specifies that a pre-shared key,
which is a secret key shared between the two peers, is
used during authentication to identify the peers to each
other. The same key must be configured for each peer.

• RSA Signatures—Specifies that a public key algorithm,
which supports encryption and digital signatures is used.

Authentication Method

Global Tunnel Settings
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Table 303: IPsec VPN Configuration Parameters (continued)

GuidelinesSettings

Establish a VPN connection using pre-shared keys, which
is essentially a password that is same for both parties.

Select the type of pre-shared key you want to use:

• Autogenerate—Select if you want to automatically
generate a unique key per tunnel. When selected, the
Generate Unique key per tunnel option is automatically
enabled. If you disable the Generate Unique key per
tunnel option, Security Director generates a single key
for all tunnels.

• Manual—Select to enter the key manually. By default,
the manual key is masked.

NOTE: This is applicable only if the authenticationmethod
is pre-shared-based.

Pre-shared Key

Select themaximum transmission unit (MTU) in bytes. This
defines the maximum size of an IP packet, including the
IPsec overhead. You can specify the MTU value for the
tunnel endpoint. The valid range is 68 to 9192 bytes. The
default value is 1500 bytes.

Max Transmission Unit

Table 304: View or Select Devices

GuidelinesSettings

Select a device to add it as an endpoint.Endpoint

View all devices from the current and child domains, with view parent enabled. Devices from
the child domain with view parent disabled are not shown.

Select a device and add it as an endpoint.

The following filter criteria are applied for the device selection:

• SRX Series devices mapped to Junos OS Release 12.1X46 and later Junos-es schemas are
not listed.

• Logical systems and tenant systems are not listed.

• Routing option is not applicable.

Available
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Table 305: Remote User Settings

GuidelinesSettings

Enable this option to use the configured VPN name as remote access default profile.

NOTE:
• This option is not available if the default profile is configured.

• You must enable the default profile. If not enabled, configure the default profile under VPN
> IPsec VPN > Global Settings > Remote Access VPN.

Default Profile

Select one of the following options from the list to establish the Juniper Secure Connect client
connection:

• Manual—You need to manually connect to the VPN tunnel every time you log in.

• Always—You are automatically connected to the VPN tunnel every time you log in.

The default connection mode is Manual.

Connection Mode

Enable this option to establish SSL VPN connection from the Juniper Secure Connect Client to
the SRX Series device.

By default this option is enabled.

NOTE: This is a fallback option when IPsec ports are not reachable.

SSL VPN

Enable this option to authenticate the client system using unique configured methods.

An authentication prompt is displayed when you connect in the client system. The VPN
connection will only be initiated after successful authentication through the method configured
for Windows Hello (fingerprint recognition, face recognition, PIN entry, and so on).

Windows Hello must be preconfigured on the client system if the Biometric authentication
option is enabled.

Biometric
Authentication

Enable this option to allow the Juniper Secure Connect client to detect if the SRX Series device
is reachable.

Disable this option to allow the Juniper Secure Connect client to detect till the SRX Series device
connection reachability is restored.

This option is enabled by default.

DPD Interval—Select an interval in seconds to send dead peer detection messages. The default
interval is 10 seconds, with a permissible range of 2 to 60 seconds.

DPD Threshold—Select the failure DPD threshold value. This specifies the maximum number
of times the DPD messages must be sent when there is no response from the peer. The default
number of transmissions is 5 times, with a permissible range of 1 to 5.

Dead Peer
Detection
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Table 305: Remote User Settings (continued)

GuidelinesSettings

Enable this option to provide users to securely log on to the Windows domain before logging
on to theWindows system. The client supports domain logon using a credential service provider
after establishing a VPN connection to the company network.

Window logon

Table 306: Local Gateway Configuration Parameters

GuidelinesSettings

Select the outgoing interface for IKE security associations (SAs). This interface is associated
with a zone that acts as its carrier, providing firewall security for it.

External Interface

Select the tunnel zone. They are logical areas of address space that can support dynamic IP
(DIP) address pools for NAT applications to pre- and post-encapsulated IPsec traffic.

Tunnel zones also provide great flexibility in combining tunnel interfaces with VPN tunnels.

Tunnel Zone

Select the authentication profile from the list thatwill be used to authenticate a user accessing
the remote access VPN.

Click Add to create a new access profile. For more information on creating a new access
profile, see “Creating Access Profiles” on page 605.

NOTE: LDAP authentication is not supported in a remote VPN.

User Authentication

Select a SSL VPN profile from the list to terminate the remote access connection.

To create a new SSL VPN profile:

1. Click Add.

The Add SSL VPN Profile page is displayed.

2. Enter the SSL VPN profile name.

3. Enable Logging option to log for SSL VPN.

4. Enter a SSL termination profile name.

5. Select a server certificate.

6. Click OK.

SSL VPN Profile
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Table 306: Local Gateway Configuration Parameters (continued)

GuidelinesSettings

Enable this option so that all traffic from the Juniper Secure Connect client is NATed to the
selected interface by default.

If disabled, you must ensure that you have a route from your network pointing to the SRX
Series devices for handling the return traffic correctly.

NAT Traffic

Select a certificate to authenticate the virtual private network (VPN) initiator and recipient.Certificate

Select the certificate authority (CA) profile from the list to associate it with the local
certificate.

This is applicable when authentication method is RSA-Signatures.

Trusted CA/Group

Configure the addresses type for the selected device to protect one area of the network
from the other.

NOTE: You can also create addresses by clicking Add New Address.

Protected Networks

Table 307: View or Edit IKE or IPsec Settings

GuidelinesSettings

IKE Settings

Select the appropriate encryption mechanism.Encryption-algorithm

Select an algorithm. The device uses this algorithm to verify the authenticity and integrity
of a packet.

Authentication-algorithm

Select a group. Diffie-Hellman (DH) groups determine the strength of the key used in
the key exchange process.

Deffie Hellman group

Select a lifetime of an IKE security association (SA). The valid range is from 180 through
86,400 seconds.

Lifetime-seconds

Enable to permit the two gateways to determine if the peer gateway is up and responding
to the Dead Peer Detection (DPD) messages that are negotiated during IPsec
establishment.

Dead Peer Detection
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Table 307: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Select a DPD Mode.

• Optimized: R-U-THERE messages are triggered if there is no incoming IKE or IPsec
traffic within a configured interval after the device sends outgoing packets to the peer.
This is the default mode.

• Probe Idle Tunnel: R-U-THERE messages are triggered if there is no incoming or
outgoing IKE or IPsec traffic within a configured interval. R-U-THERE messages are
sent periodically to the peer until there is traffic activity.

• Always-send: R-U-THEREmessages are sent at configured intervals regardless of traffic
activity between the peers.

DPD Mode

Select an interval in seconds to send dead peer detection messages. The default interval
is 10 seconds, with a permissible range of 2 to 60 seconds.

DPD Interval

Select the failure DPD threshold value. This specifies the maximum number of times the
DPDmessagesmust be sentwhen there is no response from the peer. The default number
of transmissions is 5 times, with a permissible range of 1 to 5.

DPD Threshold

Advance Configuration

This option is enabled, by default. IKEv2 fragmentation splits a large IKEv2 message into
a set of smaller ones so that there is no fragmentation at the IP level.

IKEv2 Re-Fragmentation
Support

Select the size of the packet at which messages are fragmented. By default, the size is
576 bytes for IPv4.

Range is 570 to 1320.

IKEv2 Re-fragment Size

Enable Network Address Translation-Traversal (NAT-T) if the dynamic endpoint is behind
a NAT device.

NAT-T

Select a value. NAT Keepalives are required to maintain the NAT translation during the
connection between the VPN peers. Range is from 1 to 300 seconds.

Keep Alive

Select the number of concurrent connections that the VPN profile supports. When the
maximum number of connections is reached, no more Remote Access User (VPN)
endpoints attempting to access an IPsec VPN can begin Internet Key Exchange (IKE)
negotiations.

IKE Connection Limit

IPSec Settings
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Table 307: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Select the necessary encryption method.

This is applicable if the Protocol is ESP.

Encryption Algorithm

Select an algorithm. The device uses these algorithms to verify the authenticity and
integrity of a packet.

Authentication Algorithm

Select Perfect Forward Secrecy (PFS) as the method that the device uses to generate the
encryption key. The PFS generates each new encryption key independently from the
previous key. The higher numbered groups provide more security but require more
processing time.

Perfect Forward Secrecy

Advance Configuration

Enable this option to send Internet Control Message Protocol (ICMP) to determine if the
VPN is up.

VPN Monitor

When VPN monitoring optimization is enabled, the SRX Series device only sends ICMP
echo requests (pings) when there is outgoing traffic and no incoming traffic from the
configured peer, through the VPN tunnel. If there is incoming traffic through the VPN
tunnel, the SRX Series device considers the tunnel to be active and does not send pings
to the peer.

Optimized

By default, Anti-Replay detection is enabled. IPsec protects against a VPN attack by using
a sequence of numbers that are built into the IPsec packet—the system does not accept
a packet for which it has already seen the same sequence number. It checks the sequence
numbers and enforces the check, rather than just ignoring the sequence numbers. Disable
it if there is an error with the IPsec mechanism that results in out-of-order packets,
preventing proper functionality.

Anti Replay

Select the maximum number of seconds to allow for the installation of a re-keyed
outbound security association (SA) on the device.

Install interval

Select the appropriate idle time interval. The sessions and their corresponding translations
typically time out after a certain period if no traffic is received.

Idle Time

Select an option to process the Don’t Fragment (DF) bit in IP messages.

• Clear—Disable the DF bit from the IP messages. This is the default.

• Copy—Copy the DF bit to the IP messages.

• Set—Enable the DF bit in the IP messages.

DF Bit
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Table 307: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Enable copying of Differentiated Services Code Point (DSCP) field from the outer IP
header encrypted packet to the inner IP header plain text message on the decryption
path. The benefit in enabling this feature is that after IPsec decryption, clear text packets
can follow the inner class-of-service (CoS) rules.

Copy Outer DSCP

Select a lifetime of an IKE security association (SA). The valid range is from 180 through
86,400 seconds.

Lifetime Seconds

Select the lifetime (in kilobytes) of an IPsec security association (SA). The range is from
64 through 4294967294 kilobytes.

Lifetime kilobytes

RELATED DOCUMENTATION

IPsec VPN Overview | 899

IPsec VPN Global Settings | 970

Create a Remote Access VPN—NCP Exclusive Client

The Network Control Protocol (NCP) Exclusive Remote Access Client is part of the NCP Exclusive Remote
Access solution for Juniper SRX Series Gateways. The VPN client is only available with NCP Exclusive
Remote Access Management. Use the NCP Exclusive Client to establish secure, IPsec-based data links
from any location when connected with SRX Series Gateways.

Before You Begin

• Read the “IPsec VPN Overview” on page 899 topic.

• Review the IPsec VPN main page for an understanding of your current data set. See “IPsec VPN Main
Page Fields” on page 982 for field descriptions.

• Create addresses and address sets. See “Creating Addresses and Address Groups” on page 1026.

• Create VPN profiles. See “Creating VPN Profiles” on page 988.

• Define extranet devices. See “Creating Extranet Devices” on page 984.
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To configure a remote access NCP exclusive client:

1. Select Configure > IPsec VPN > IPsec VPNs.

The IPsec VPNs page is displayed.

2. Click Create VPN > <Route Based> Remote Access NCP Exclusive Client.

The Create Remote Access (NCP Exclusive Client) page is displayed.

3. Complete the IPsec VPN configuration parameters according to the guidelines provided in
Table 283 on page 905 through Table 286 on page 909.

NOTE: Click Local Gateway icon in the topology to configure a local gateway. Click View
IKE/IPSec Settings to view or edit VPN profiles. If the VPN profile is default, you can edit
the configurations. If the profile is shared, you can only view the configurations.

The VPN connectivity will change from gray to blue line in the topology to show that the
configuration is complete.

The topology displayed is only for representation.

4. Click Save to save the IPsec configuration.

Figure 74: Create Remote Access NCP Exclusive Client
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Table 308: IPsec VPN Configuration Parameters

GuidelinesSettings

Enter a unique string of alphanumeric characters, colons,
periods, dashes, and underscores; spaces are not allowed;
maximum length is 62 characters.

Name

Enter a description for the VPN; maximum length is 255
characters.

Description

Traffic Selector (Auto Route Insertion)—A traffic selector
is an agreement between Internet Key Exchange (IKE)
peers to permit traffic through a tunnel if the traffic
matches a specified pair of local and remote addresses.

Routing Topology

Select a VPN profile from the drop-down list based on the
deployment scenario.

Default profile is applicable to a particular IPsec VPN only.
You can view and edit the details by clicking View
IKE/IPsec settings on the Create IPsec VPN page.

Shared profile can be used by one or more IPsec VPNs.
You can only view the details of the shared profiles by
clicking View IKE/IPsec settings on the Create IPsec VPN
page.

If you select the VPN Profile value as Default, then while
saving the IPsec VPN, you’ll need to save the new profile
as either VPN specific or shared. If you are saving it as
shared, then the profile will be listed on the VPN Profiles
page.

VPN Profile

Select an authentication method from the list that the
device uses to authenticate the source of Internet Key
Exchange (IKE) messages.

• Pre-shared based—Specifies that a pre-shared key,
which is a secret key shared between the two peers, is
used during authentication to identify the peers to each
other. The same key must be configured for each peer.

• RSA Signatures—Specifies that a public key algorithm,
which supports encryption and digital signatures is used.

Authentication Method

Global Tunnel Settings
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Table 308: IPsec VPN Configuration Parameters (continued)

GuidelinesSettings

Establish a VPN connection using preshared keys, which
is essentially a password that is same for both parties.

Select the type of pre-shared key you want to use:

• Autogenerate—Select if you want to automatically
generate a unique key per tunnel. When selected, the
Generate Unique key per tunnel option is automatically
enabled. If you disable the Generate Unique key per
tunnel option, Security Director generates a single key
for all tunnels.

• Manual—Select to enter the key manually. By default,
the manual key is masked.

NOTE: This is applicable only if the authenticationmethod
is pre-shared-based.

Pre-shared Key

Select themaximum transmission unit (MTU) in bytes. This
defines the maximum size of an IP packet, including the
IPsec overhead. You can specify the MTU value for the
tunnel endpoint. The valid range is 68 to 9192 bytes. The
default value is 1500 bytes.

Max Transmission Unit

Table 309: View or Select Devices

GuidelinesSettings

Select a device to add it as an endpoint.Endpoint

View all devices from the current and child domains, with view parent enabled. Devices from
the child domain with view parent disabled are not shown.

Select a device and add it as an endpoint.

The following filter criteria are applied for the device selection:

• SRX Series devices mapped to Junos OS Release 12.1X46 and later Junos-es schemas are
not listed.

• Logical systems and tenant systems are not listed.

• Routing option is not applicable.

Available
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Table 310: Local Gateway Configuration Parameters

GuidelinesSettings

Select the outgoing interface for IKE security associations (SAs). This interface is associated
with a zone that acts as its carrier, providing firewall security for it.

External Interface

Select the tunnel zone. They are logical areas of address space that can support dynamic IP
(DIP) address pools for NAT applications to pre and post-encapsulated IPsec traffic.

Tunnel zones also provide great flexibility in combining tunnel interfaces with VPN tunnels.

Tunnel Zone

Select the authentication profile from the list thatwill be used to authenticate a user accessing
the remote access VPN.

Click Add to create a new access profile. For more information on creating a new access
profile, see “Creating Access Profiles” on page 605.

NOTE: LDAP authentication is not supported in a remote VPN.

User Authentication

Select a SSL VPN profile from the list to terminate the remote access connection.

To create a new SSL VPN profile:

1. Click Add.

The Add SSL VPN Profile page is displayed.

2. Enter the SSL VPN profile name.

3. Enable Logging option to log for SSL VPN.

4. Enter a SSL termination profile name.

5. Select a server certificate.

6. Click OK.

SSL VPN Profile

Enable this option so that all traffic from the Juniper Secure Connect client is NATed to the
selected interface by default.

If disabled, you must ensure that you have a route from your network pointing to the SRX
Series devices for handling the return traffic correctly.

NAT Traffic

Select a certificate to authenticate the virtual private network (VPN) initiator and recipient.Certificate
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Table 310: Local Gateway Configuration Parameters (continued)

GuidelinesSettings

Select the certificate authority (CA) profile from the list to associate it with the local
certificate.

This is applicable when authentication method is RSA-Signatures.

Trusted CA/Group

Configure the addresses type for the selected device to protect one area of the network
from the other.

NOTE: You can also create addresses by clicking Add New Address.

Protected Networks

Table 311: View or Edit IKE or IPsec Settings

GuidelinesSettings

IKE Settings

Select the required IKE version, either V1 or V2, that is used to negotiate dynamic security
associations (SAs) for IPsec. By default, IKE V2 is used.

IKE Version

Select an IKE policy mode.

• Main—Uses six messages in three peer-to-peer exchanges to establish the IKE SA.
These three steps include the IKE SA negotiation, a Diffie-Hellman exchange, and
authentication of the peer. Also provides identity protection.

• Aggressive—Takes half the number of messages of main mode, has less negotiation
power, and does not provide identity protection.

NOTE: Mode is applicable when the IKE Version is V1.

Mode

Select the appropriate encryption mechanism.Encryption-algorithm

Select an algorithm. The device uses this algorithm to verify the authenticity and integrity
of a packet.

Authentication-algorithm

Select a group. Diffie-Hellman (DH) groups determine the strength of the key used in the
key exchange process.

Deffie Hellman group

Select a lifetime of an IKE security association (SA). The valid range is from 180 through
86,400 seconds.

Lifetime-seconds

Enable to permit the two gateways to determine if the peer gateway is up and responding
to the Dead Peer Detection (DPD) messages that are negotiated during IPsec
establishment.

Dead Peer Detection
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Table 311: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Select a DPD Mode.

• Optimized: R-U-THERE messages are triggered if there is no incoming IKE or IPsec
traffic within a configured interval after the device sends outgoing packets to the peer.
This is the default mode.

• Probe Idle Tunnel: R-U-THEREmessages are triggered if there is no incoming or outgoing
IKE or IPsec traffic within a configured interval. R-U-THERE messages are sent
periodically to the peer until there is traffic activity.

• Always-send: R-U-THEREmessages are sent at configured intervals regardless of traffic
activity between the peers.

DPD Mode

Select an interval in seconds to send dead peer detection messages. The default interval
is 10 seconds, with a permissible range of 2 to 60 seconds.

DPD Interval

Select the failure DPD threshold value. This specifies the maximum number of times the
DPDmessagesmust be sent when there is no response from the peer. The default number
of transmissions is 5 times, with a permissible range of 1 to 5.

DPD Threshold

Advance Configuration

IKEv2 fragmentation splits a large IKEv2 message into a set of smaller ones so that there
is no fragmentation at the IP level.

IKEv2 Re Fragmentation
Support

Select the size of the packet at which messages are fragmented. By default, the size is
576 bytes for IPv4.

Range is 570 to 1320.

IKEv2 Re-fragment Size

Enable Network Address Translation-Traversal (NAT-T) if the dynamic endpoint is behind
a NAT device.

NAT-T

Select a value. NAT keepalives are required to maintain the NAT translation during the
connection between the VPN peers. Range is from 1 to 300 seconds.

Keep Alive

Select the number of concurrent connections that the VPN profile supports. When the
maximumnumber of connections is reached, nomore RemoteAccessUser (VPN) endpoints
attempting to access an IPsec VPN can begin Internet Key Exchange (IKE) negotiations.

IKE Connection Limit

IPSec Settings

Select the necessary encryption method.

This is applicable if the Protocol is ESP.

Encryption Algorithm
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Table 311: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Select Perfect Forward Secrecy (PFS) as the method that the device uses to generate the
encryption key. The PFS generates each new encryption key independently from the
previous key. The higher numbered groups provide more security but require more
processing time.

Perfect Forward Secrecy

Advance Configuration

Enable this option to send Internet Control Message Protocol (ICMP) to determine if the
VPN is up.

VPN Monitor

When VPN monitoring optimization is enabled, the SRX Series device only sends ICMP
echo requests (pings) when there is outgoing traffic and no incoming traffic from the
configured peer, through the VPN tunnel. If there is incoming traffic through the VPN
tunnel, the SRX Series device considers the tunnel to be active and does not send pings
to the peer.

Optimized

By default, Anti-Replay detection is enabled. IPsec protects against a VPN attack by using
a sequence of numbers that are built into the IPsec packet—the system does not accept
a packet for which it has already seen the same sequence number. It checks the sequence
numbers and enforces the check, rather than just ignoring the sequence numbers. Disable
it if there is an error with the IPsec mechanism that results in out-of-order packets,
preventing proper functionality.

Anti Replay

Select themaximumnumber of seconds to allow for the installation of a re-keyed outbound
security association (SA) on the device.

Install interval

Select the appropriate idle time interval. The sessions and their corresponding translations
typically time out after a certain period if no traffic is received.

Idle Time

Select an option to process the Don’t Fragment (DF) bit in IP messages.

• Clear—Disable the DF bit from the IP messages. This is the default.

• Copy—Copy the DF bit to the IP messages.

• Set—Enable the DF bit in the IP messages.

DF Bit

Enable copying of Differentiated Services Code Point (DSCP) field from the outer IP
header encrypted packet to the inner IP header plain text message on the decryption
path. The benefit in enabling this feature is that after IPsec decryption, clear text packets
can follow the inner class-of-service (CoS) rules.

Copy Outer DSCP

Select a lifetime of an IKE security association (SA). The valid range is from 180 through
86,400 seconds.

Lifetime Seconds
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Table 311: View or Edit IKE or IPsec Settings (continued)

GuidelinesSettings

Select the lifetime (in kilobytes) of an IPsec security association (SA). The range is from
64 through 4294967294 kilobytes.

Lifetime kilobytes

RELATED DOCUMENTATION

IPsec VPN Overview | 899

IPsec VPN Global Settings | 970

IPsec VPN Global Settings

The Global Settings page displays the default settings that apply to the devices in your remote access VPN
topology. You can view or modify the VPN global configuration details.

1. Select Configure > IPsec VPN> VPN.

The IPsec VPN page is displayed.

2. Click Global Settings.

The Global Settings page is displayed.

3. Click the pencil icon to modify the global settings.

The Modify Global Settings page is displayed.

Table 312: Global Settings

DescriptionField

Select a default profile name from the list.

NOTE: This option is available when at least one Juniper Secure Connect VPN is created.

Default Profile Name

Enable this option to track Encapsulated Security Payload (ESP) tunnels.SSL VPNTunnel tracking
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Table 312: Global Settings (continued)

DescriptionField

Lists the SSL VPN profiles.

NOTE: This option displays associated IPsec VPNs when at least one remote access VPN
is created.

To create a new SSL VPN profile:

1. Click Add.

The Add SSL VPN Profile page is displayed.

2. Enter the name for a SSL VPN profile.

3. Enable Logging option to log for SSL VPN.

4. Enter a SSL termination profile name.

5. Select a server certificate from the list.

6. Click OK.

To edit a SSL VPN profile, select the profile you want to edit and click on the pencil icon.

To delete a SSL VPN profile, select the profile you want to delete and click on the delete
icon.

SSL VPN Profiles

RELATED DOCUMENTATION

IPsec VPN Overview | 899

Understanding IPsec VPNModes

The following two modes determine how traffic is exchanged in the VPN:

• Tunnel Mode—This mode encapsulates the original IP packet within another packet in the VPN tunnel.
This is most commonly used when hosts within separate private networks want to communicate over
a public network. Both VPN gateways establish the VPN tunnel to each other, and all traffic between
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the two gateways appears to be from the two gateways, with the original packet embedded within the
exterior IPsec packet.

• Transport Mode—This mode does not encapsulate the original packet in a new packet, as tunnel mode
does; rather, transport mode sends the packet directly between the two hosts that have established the
IPsec tunnel.

Tunnel mode is the most common VPN mode on the Internet because it easily allows entire networks
(particularly those with private address space) to communicate over public IP networks. Transport mode
is primarily used when encrypting traffic between two hosts to secure communication where IP address
overlap is not an issue (for example, between a host and a server on a private network).

RELATED DOCUMENTATION

IPsec VPN Overview | 899

Understanding IPsec VPN Routing | 974

Understanding IKE Authentication | 974

Comparison of Policy-Based VPNs and Route-Based VPNs | 972

Comparison of Policy-Based VPNs and Route-Based VPNs

Security Director supports configuring two types of VPNs for SRX Series devices – policy-based and
route-based VPNs. The underlying IPsec functionality is essentially the same in terms of traffic being
encrypted.

Table 1 summarizes the differences between policy-based VPNs and route-based VPNs.

Table 313: Differences between Policy-Based and Route-Based VPNs

Route-Based VPNsPolicy-Based VPNs

A policy does not specifically reference a VPN tunnel.A tunnel is treated as an object that, together with
source, destination, application, and action,
constitutes a tunnel policy permitting VPN traffic.

A route determines which traffic is sent through the tunnel
based on a destination IP address.

A tunnel policy specifically references a VPN tunnel
by name.

The number of route-based VPN tunnels that you can create
is limited by the number of st0 interfaces (for point-to-point
VPNs) or the number of tunnels that the device supports,
whichever is lower.

The number of policy-based VPN tunnels that you
can create is limited by the number of tunnels that
the device supports.
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Table 313: Differences between Policy-Based and Route-Based VPNs (continued)

Route-Based VPNsPolicy-Based VPNs

Because the route, not the policy, determines which traffic
goes through the tunnel, multiple policies can be supported
with a single SA or VPN.

Although you can create numerous tunnel policies
referencing the sameVPN tunnel, each tunnel policy
pair creates an individual IPsec security association
(SA) with the remote peer. Each SA counts as an
individual VPN tunnel.

The regulation of traffic is not coupled to the means of its
delivery.

The actionmust be permit andmust include a tunnel.

Route-based VPNs support the exchange of dynamic routing
information through VPN tunnels. You can enable an instance
of a dynamic routing protocol, such as OSPF, on a st0 interface
that is bound to a VPN tunnel.

The exchange of dynamic routing information is not
supported.

Route-based VPNs use routes to specify the traffic sent to a
tunnel; a policy does not specifically reference a VPN tunnel.

If you needmore granularity than a route can provide
to specify the traffic sent to a tunnel, using a
policy-based VPN with security policies is the best
choice.

When the security device does a route lookup to find the
interface throughwhich it must send traffic to reach an address,
it finds a route through a secure tunnel (st0) interface. With a
route-based VPN tunnel, you can consider a tunnel as a means
for delivering traffic, and you can consider the policy as a
method for either permitting or denying the delivery of that
traffic.

You can consider a tunnel as an element in the
construction of a policy.

Proxy ID is supported for both route-based and policy-based VPNs. However, the multi-proxy ID is
supported for only route-based VPNs. Themulti-proxy ID is also known as traffic selector. A traffic selector
is an agreement between IKE peers to permit traffic through a tunnel, if the traffic matches a specified
pair of local and remote addresses. You define a traffic selector within a specific route-based VPN, which
can result in multiple Phase 2 IPsec SAs. Only traffic that conforms to a traffic selector is permitted through
an SA. The traffic selector is commonly required when remote gateway devices are non-Juniper Networks
devices.

RELATED DOCUMENTATION

IPsec VPN Overview | 899

Understanding IPsec VPN Routing | 974
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Understanding IPsec VPN Modes | 971

Understanding IKE Authentication | 974

Understanding IPsec VPN Routing

SRX Series devices must know how to reach destination networks. This can be done through the use of
static routing or dynamic routing. In Security Director, route-based VPNs support OSPF, RIP, and eBGP
routing along with static routing. Static routing requires that administrators specify the list of host or
network addresses at each site as part of the VPN. For example, in a retail scenario, where thousands of
spokes can be part of a VPN, the static routing approach generates a huge configuration at each device.
Static routing requires administrator tomanually configure each route. Problems occur as the infrastructure
changes or when the administrator does not have access to the addresses for the protected network.
Keeping routes up-to-date manually creates tremendous overhead.

RELATED DOCUMENTATION

IPsec VPN Overview | 899

Understanding IKE Authentication | 974

Understanding IPsec VPN Modes | 971

Comparison of Policy-Based VPNs and Route-Based VPNs | 972

Understanding IKE Authentication

The IKE negotiations only provide the ability to establish a secure channel over which two parties can
communicate. You still need to define how they authenticate each other. This is where IKE authentication
is used to ensure that the other party is authorized to establish the VPN.

The following IKE authentications are available:

• Preshared key authentication—Themost commonway to establish a VPN connection is to use preshared
keys, which is essentially a password that is the same for both parties. This passwordmust be exchanged
in advance in an out-of-bandmechanism, such as over the phone, through a verbal exchange, or through
less securemechanisms, even e-mail. The parties then authenticate each other by encrypting the preshared
key with the peer’s public key, which is obtained in the Diffie-Hellman exchange.

Preshared keys are commonly deployed for site-to-site IPsec VPNs, either within a single organization
or between different organizations. To ensure that preshared keys are used in the most secure fashion,
a preshared key must consist of at least 8 characters (12 or more is recommended) using a combination
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of letters, numbers, and nonalphanumeric characters, along with different cases for the letters (the
preshared key should not use a dictionary word).

• Certificate authentication—Certificate-based authentication is considered more secure than preshared
key authentication because the certificate key cannot be compromised easily. Certificates are also far
more ideal in larger scale environments with numerous peer sites that should not all share a preshared
key. Certificates are composed of a public and private key, and can be signed by a primary certificate
known as a certificate authority (CA). In this way, certificates can be checked to see if they are signed
with a CA that is trusted.

RELATED DOCUMENTATION
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Publishing IPsec VPNs

To publish an IPsec VPN:

1. Select Configure > IPSec VPN > IPSec VPNs.

2. Select the VPN that you want to publish and click Publish. The Publish Policy page appears.

3. Select the check boxes next to the devices to which the policy changes will be published.

NOTE: You can search for a specific device on which the VPN is published by entering the
search criteria in the search field in the top-right corner of the Services page. You can search
the devices by their name, IP address, or the device OS version.

NOTE: If the VPN is to be published on a large number of devices, the devices are displayed
across multiple pages. You can use the pagination and display options available on the lower
ribbon, just below the list of devices, to view all devices on which the VPN is published.
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4. Select Schedule at a later time if you want to schedule and publish the configuration later.

5. Select Run now if you want to apply the configuration immediately.

6. Click Publish. The Affected Devices page displays the devices on which the VPN will be published.

RELATED DOCUMENTATION

Updating IPSec VPN | 976

Updating IPSec VPN

To update a VPN:

1. Select the VPN policy that you want to update and click Update. The Update VPN page appears.

2. Select the check boxes next to the devices to which the VPN changes will be published.

NOTE: You can search for a specific device on which the VPN is published by entering the
search criteria in the search field. You can search the devices by their name and IP address.

3. Select Schedule at a later time if you want to schedule and publish the configuration later.

4. Select Run now if you want to apply the configuration immediately.

5. Click Publish and Update. The Affected Devices page displays the devices on which the policies will
be published.

RELATED DOCUMENTATION

IPsec VPN Overview | 899
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Modify IPsec VPN Settings

IN THIS SECTION

Modify Device Selection | 977

To modify the IPsec VPN settings:

1. Select Configure > IPsec VPN > IPsec VPNs.

The IPsec VPNs page is displayed.

2. Right-click the IPsec VPN that you want to modify and selectModify VPN or select the IPsec VPN and
click the pencil icon.

Based on the VPN topology the corresponding edit IPsec VPN page appears.

3. Edit the required fields and click OK.

Follow the applicable configuration guidelines used while creating the IPsec VPN.

You can also edit the tunnel settings on the device configuration page by clicking View/Edit Tunnels.

Modify Device Selection

To view or edit the devices:

1. Select Configure > IPsec VPN > VPNs.

The IPsec VPNs page is displayed.

2. Select an IPsec VPN and click the pencil icon.

The Modify IPsec VPN page is displayed.

3. Click View/Select Devices.

4. Edit the device selection.

5. Click OK.
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RELATED DOCUMENTATION

IPsec VPN Overview | 899

Viewing Tunnels

You can view all the tunnels configured for your VPN using this option.

To view the tunnel information of a VPN:

1. Select Configure > IPsec VPN > IPsec VPNs.

The IPsec VPN page appears.

2. Right-click the VPN and select View Tunnels, or select View Tunnels from the More list.

The Tunnels page appears showing the summary of tunnel configurations for device associated with
the selected VPN.

3. Click OK.

RELATED DOCUMENTATION

IPsec VPN Overview | 899

Importing IPsec VPNs

Junos Space Security Director lets you import your existing large and complex VPN configurations into
Security Director. You do not have to recreate the same VPN environment to allow Security Director to
manage it. During the VPN import, all VPN-related objects are also imported along with the VPN.

To import a VPN:

1. Select IPSec VPN > IPSec VPNs.

The existing VPNs are listed on the right pane.

2. Select Import VPN from the More option.

The Import VPN page appears.
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3. Click Next.

The Select Devices page appears. You can select one ormore devices fromwhich the VPN configuration
must be imported. The filter option enables you to perform the free text search on the device name,
IP address, and device platform.

4. Select the security device to import its VPN settings. Click Next.

A progress bar appears showing the analysis of the device configurations.

5. After analyzing the VPN configuration, Security Director performs the configuration parsing and the
endpoint correlation. During the endpoint correlation if any conflicting configurations are found, you
can either proceed to ignore the conflicts during the import and log this detail as a job or cancel the
operation. Click Yes to ignore the conflicts and import the remaining configuration or No to terminate
the import and proceed to the next step to select devices.

The conflict occurs when the combination of IKE and IPsec parameters are same between the endpoints.
The following points explain the scenarios underwhich the conflicts occur for different VPN configuration
types:

• Preshared key and Main Mode

• Preshared key

• Local IKE ID of local endpoint and remote IKE ID of remote endpoint

• Remote IKE ID of local endpoint and local IKE ID of remote endpoint

• Preshared key and Aggressive Mode

• Preshared key

• Local IKE ID of local endpoint and remote IKE ID of remote endpoint

OR

• Remote IKE ID of local endpoint and local IKE ID of remote endpoint

• Certificate, Main Mode, and DN type IKE ID

• Remote IKE ID of local endpoint and DN of the certificate of remote endpoint

• DN of the certificate of the local endpoint and remote IKE ID of remote endpoint

• Certificate, Main Mode and other IKE ID type

• Local IKE ID of the local endpoint and remote IKE ID of the remote endpoint

• Remote IKE ID of local endpoint and local IKE ID of remote endpoint

• Certificate, Aggressive Mode, and DN type IKE ID

• Remote IKE ID of local endpoint and DN of the certificate of remote endpoint
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• DN of the certificate of the local endpoint and remote IKE ID of remote endpoint

• Certificate, Aggressive Mode, and other IKE ID type

• Local IKE ID of local endpoint and remote IKE ID of remote endpoint

OR

• Remote IKE ID of local endpoint and local IKE ID of remote endpoint

If there are no conflicts, you can directly proceed to Step 6.

6. The Select EndPoints page appears showing the VPN settings.

All the imported VPNs will have autogenerated names, which you have the option to modify. Click the
VPN name and enter the name. There is a predefined quick filter available to list all the errors and
warnings. Click the drop-down list to select the required filter parameter.

The Select EndPoints page lists the VPNs discovered from the configuration and allows you to explore
the devices, or endpoints for each of the discovered VPNs. You can also perform a free text search on
the VPN name, device name, and endpoint names.

Table 1 shows the description of each column.

Table 314: Settings Guidelines

GuidelinesSettings

DescriptionColumn Name

Lists all the discovered VPNs and their associated devices and endpoints
in a tree structure.

VPNs & Local Endpoints

Shows matching endpoint details.Remote Endpoints

Displays any information, error, and warning messages detected during
the import.

Warning

7. The Summary page appears. All the VPNs listed on this page are saved in the Security Director database
for further management.

Click Finish. A progress bar appears showing the progress of the import. Once the import is successful,
you can manage the VPNs from the VPN landing page.

8. The final summary page appears showing the number of VPNs, devices, and endpoints imported. To
view the complete job details, click full log details. The Job Details page appears.

9. Click Close. All the imported VPN configurations appear on the VPN landing page.
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NOTE: At any point of the import workflow, you can choose to exit. All your settings and
progress are discarded.

Note:

• The schema version of the device must be mapped to the Junos version to import all the VPN settings.

• You must republish the imported VPNs before modifying them further.

• VPN imported without IKE IDs configured on devices is not available for any modifications, unless you
modify any VPN settings. On modifying these imported VPNs generate local or remote IKE IDs.

• Single-ProxyID, Multi-ProxyID, and the preshared key settings are imported at the tunnel level.

• By default, for the imported VPNs, the preshared key type is shown as Auto-generate. However, a new
key is not generated for the already imported tunnels. If a new device is added to the VPN, only for that
device, a new key is autogenerated.

RELATED DOCUMENTATION

IPsec VPN Overview | 899

Deleting IPSec VPN

To delete one or more IPSec VPNs:

1. Select Configure > IPSec VPN > IPSec VPNs.

2. Select one or more IPSec VPNs.

3. Click X to delete the IPSec VPNs.

A message is displayed to confirm the delete operation.

4. Click Yes to delete the selected IPSec VPNs.

The IPSec VPNs are deleted from the IPSec VPNs page.

A warning is displayed for confirmation on deleting these IPSec VPNs from the device.
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5. Click Redirect to navigate to the Security Devices page.

6. Select the device, right-click and selectPreviewChanges to run the PreviewChanges job. Post validation,
select the device, right-click and select Update Changes to proceed with the Update Changes job to
delete the IPSec VPNs from the device.

RELATED DOCUMENTATION

IPsec VPN Overview | 899

IPsec VPNMain Page Fields

Use IPsec VPN to secure your network traffic with encryption and authentication. The VPN tunnels are
central components of networks and secure the data between different sites and remote users. Table 1
describes the fields on this page.

Table 315: IPsec VPNMain Page Fields

DescriptionField

Name of the IPsec VPN.Name

Description of the IPsec VPN.Description

There are different types of topology deployments for IPsec VPN: site-to-site, full-mesh,
hub-and-spoke.

Type

The profile type, that is, Inline Profile or Shared Profile.Profile Type

Name of the VPN profile. The security parameters are defined in this profile to establish
VPN connection between two sites.

Profile Name

The tunnel mode, that is, Route Based or Policy Based.Tunnel Mode

The configuration state of the IPsec VPN.Configuration State
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Table 315: IPsec VPNMain Page Fields (continued)

DescriptionField

Display the publish state of the VPN configuration. You can verify your VPN
configurations before updating them to the device.

Published - Configuration is published to all devices involved in the VPN.

Partially Published - Configuration is published to only fewer devices involved in the
VPN.

Unpublished - VPN is created but not published.

Republish Required - Modifications are made to the VPN configuration after it is
published.

Publish State

Display the user domain for mapping objects and managing sections of a network.Domain Name

RELATED DOCUMENTATION

IPsec VPN Overview | 899
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CHAPTER 84

IPsec VPN-Extranet Devices

IN THIS CHAPTER

Creating Extranet Devices | 984

Find Usage for Extranet Devices | 985

Extranet Devices Main Page Fields | 986

Creating Extranet Devices

Use the Extranet devices page tomanage the third-party devices that Junos Space does not directly control
or manage. Extranet devices can be ScreenOS devices or other vendor VPN-capable firewall devices that
cannot be managed by Security Director. Extranet devices in the Security Director help users design and
manageVPNs residing between SRX Series devices and third-party deviceswithout actually being connected
to them.

Before you begin

• Review the Extranet Devices main page for an understanding of your current data set. See “Extranet
Devices Main Page Fields” on page 986 for field descriptions

• To avoid duplicate IP address while creating extranet devices, enable Prevent extranet device with
duplicate content option for shared objects in Junos SpaceNetworkManagement Platform. SeeModifying
Settings of Junos Space Applications.

When you create an extranet device in Security Director with duplicate IP address, an error message is
displayed.

To configure extranet devices:

1. Select Configure> IPSec VPN > Extranet Devices.

2. Click the plus sign (+) to create a new extranet device.

Complete the configuration according to the guidelines provided in Table 316 on page 985.

3. Click OK to save.
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Your changes are saved. A new extranet device is added to Security Director.

Table 316: Extranet Device Settings

GuidelineSetting

Enter a name that begins with an alphanumeric character
and can include colons, periods, slashes, and underscores,
for a maximum length of 63 characters.

Name

Enter a description for the extranet device; maximum
length is 255 characters.

Description

Enter the IPv4/IPv6 address for the extranet device.IP Address

Enter aDNS resolvable name for the extranet device. This
hostname is used to generate an IKE ID. The hostname
can include alphanumeric characters, dashes, and
underscores, for a maximum length of 255 characters.

Hostname

Displays the name of the user who created the extranet
device.

Created

Displays the user domain for mapping objects and
managing sections of a network.

Domain Name

RELATED DOCUMENTATION

Extranet Devices Main Page Fields | 986

Find Usage for Extranet Devices

Starting in Junos Space Security Director Release 20.3, you can find the usage of extranet devices in IPsec
VPNs.

To find an extranet device usage:

1. Select Configure > IPsec VPN > Extranet Devices.

The Extranet Devices page is displayed.

2. Right-click an extranet device and select Find Usage.
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The Search Results page is displayed with the IPsec VPN names where the extranet device is used. If
the extranet device is not used by any VPN, the search result will not display any IPsec VPNs.

RELATED DOCUMENTATION

Creating Extranet Devices | 984

Extranet Devices Main Page Fields

Use extranet device objects to reference third-party devices that you do not have login or other device
controls over. Extranet devices are firewalls that Junos Space does not directly control and manage.

Table 317: Extranet Devices Main Page Fields

DescriptionField

Name of the extranet device.Name

Description of the extranet device.Description

DNS resolvable name of the extranet device. This hostname is used to generate
IKE ID.

Hostname

IPv4 address of the device.IP Address

User who created the extranet device.Created By

User domain for mapping objects and managing sections of a network.Domain Name

RELATED DOCUMENTATION

Creating Extranet Devices | 984
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CHAPTER 85

IPsec VPN-Profiles

IN THIS CHAPTER

VPN Profiles Overview | 987

Creating VPN Profiles | 988

Edit and Clone IPsec VPN profiles | 994

Assigning Policies and Profiles to Domains | 995

VPN Profiles Main Page Fields | 996

VPN Profiles Overview

You can use the VPN Profile page to create an object that specifies the parameters used in a IPsec VPN.
You can configure the Internet Key Exchange (IKE) and IPsec settings in VPN profile.

When a VPN profile is created, Junos Space creates an object in the Junos Space database to represent
the VPN profile. You can use this object to create a route-based or policy-based IPsec VPN.

SRX Series devices support the following authentication methods in IKE negotiations for IPsec VPN:

• Pre-shared key

• RSA signature

• DSA signature

• ECDSA signature 256

• ECDSA signature 384

The predefined VPN profile is available for both RSA and DSA certificates-based authentication. The PKI
certificate list from the device is automatically retrieved during the device discovery.

SRX Series devices support pre-shared key and PKI certificate-based authentication methods in IKE
negotiation for IPsec VPNs. The RSA certificate and DSA certicate-based authentication are supported
for IKE negotiation. The predefined VPN profile is available with both RSA and DSA certificates-based
authentication. The PKI certificate list from the device is automatically retrieved during the device discovery
and update-based syslog notifications.
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RELATED DOCUMENTATION

Creating VPN Profiles | 988

Creating VPN Profiles

Use the VPN Profiles page to configure VPN profiles that define security parameters when establishing a
VPN connection. You can reuse the same profile to create more VPN tunnels. When a VPN profile is
created, Junos Space creates an object in the Security Director database to represent the VPN profile.
You can use this object to create either route-based or policy-based IPsec VPNs.

NOTE: You cannot modify or delete Juniper Networks Predefined VPN profiles. You can only
clone them and create new profiles.

Starting in Junos Space Security Director Release 20.3, you can create a VPN profile based on a VPN
topology. You can create:

• Site-to-site VPN profile

• Hub-and-spoke (establishment all peers) VPN profile

• Hub-and-spoke (establishment by spokes) VPN profile

• Hub-and-spoke Auto Discovery VPN profile

• Full mesh VPN profile

• Remote access (Juniper Secure Connect) profile

• Remote access (NCP Exclusive Client) profile

Before You Begin

Review the VPN profiles main page for an understanding of your current data set. See “VPN Profiles Main
Page Fields” on page 996 for field descriptions.

To configure a VPN profile:

1. Select Configure > IPsec VPN > Profiles.

The VPN Profiles page is displayed.

2. Click Create VPN Profile and select a VPN topology based on which you want to create a VPN profile.

The corresponding create VPN profile page is displayed.
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3. Complete the configuration according to the guidelines provided in Table 318 on page 989 .

4. Click Save.

A new VPN profile is created. You can use this object to create IPsec VPNs.

Table 318: VPN Profile Settings

GuidelinesSettings

Enter a unique string of alphanumeric characters, dashes and underscores; no spaces
allowed; 62-character maximum.

Name

Enter a description for the VPN profile; maximum length is 255 characters.Description

IKE Settings

Select the required authentication method:

• Pre-shared based

• RSA-Signatures

• DSA-Signatures

• ECDSA-Signatures-256

• ECDSA-Signatures-384

NOTE: For Remote VPN, only Pre-shared based and RSA-Signatures are supported.

Authentication Method

Select the required IKE version, either V1 or V2, that is used to negotiate dynamic security
associations (SAs) for IPsec. By default, IKE V2 is used.

NOTE: This is not applicable for remote access VPN profiles.

IKE Version

Select an IKE policy mode.

• Main—Uses six messages in three peer-to-peer exchanges to establish the IKE SA.
These three steps include the IKE SA negotiation, a Diffie-Hellman exchange, and
authentication of the peer. Also provides identity protection.

• Aggressive—Takes half the number of messages of main mode, has less negotiation
power, and does not provide identity protection.

NOTE: Mode is applicable when the IKE Version is V1.

Mode is not applicable for remote access VPN profiles.

Mode

Select the appropriate encryption mechanism.Encryption-algorithm
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Table 318: VPN Profile Settings (continued)

GuidelinesSettings

Select an algorithm. The device uses these algorithms to verify the authenticity and
integrity of a packet.

Authentication-algorithm

Select a group. Diffie-Hellman (DH) groups determine the strength of the key used in the
key exchange process.

Deffie Hellman group

Select a lifetime of an IKE security association (SA). The valid range is from 180 through
86,400 seconds.

Lifetime-seconds

Enable to permit the two gateways to determine if the peer gateway is up and responding
to the Dead Peer Detection (DPD) messages that are negotiated during IPsec
establishment.

Dead Peer Detection

Select a DPD Mode.

• Optimized: R-U-THERE messages are triggered if there is no incoming IKE or IPsec
traffic within a configured interval after the device sends outgoing packets to the peer.
This is the default mode.

• Probe Idle Tunnel: R-U-THEREmessages are triggered if there is no incoming or outgoing
IKE or IPsec traffic within a configured interval. R-U-THERE messages are sent
periodically to the peer until there is traffic activity.

• Always-send: R-U-THEREmessages are sent at configured intervals regardless of traffic
activity between the peers.

DPD Mode

Select an interval in seconds to send dead peer detection messages. The default interval
is 10 seconds, with a permissible range of 2 to 60 seconds.

DPD Interval

Select the failure DPD threshold value. This specifies the maximum number of times the
DPDmessagesmust be sent when there is no response from the peer. The default number
of transmissions is 5 times, with a permissible range of 1 to 5.

DPD Threshold

Advance Configuration

Enable this option to accept peer IKE ID. This option is disabled by default. If General IKE
ID is enabled, the IKE ID option is disabled automatically.

NOTE: This is not applicable for remote access VPN profiles.

General IKE ID
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Table 318: VPN Profile Settings (continued)

GuidelinesSettings

Select a reauthentication frequency. Reauthentication can be disabled by setting the
reauthentication frequency to 0.

Range is 0 to 100.

NOTE: This is not applicable for remote access VPN profiles.

IKEv2 Re Authentication

IKEv2 fragmentation splits a large IKEv2 message into a set of smaller ones so that there
is no fragmentation at the IP level.

This is applicable when authentication method is RSA-Signatures.

IKEv2 Re Fragmentation
Support

Select the size of the packet at which messages are fragmented. By default, the size is
576 bytes for IPv4.

Range is 570 to 1320.

This is applicable when authentication method is RSA-Signatures.

IKEv2 Re-fragment Size

Select an option:

• None

• Distinguished name

• Hostname

• IPv4 address

• E-mail Address

IKE ID is applicable only when General IKE ID is disabled.

NOTE: Only E-mail ID is applicable for remote access VPN profiles.

IKE ID

Enable Network Address Translation-Traversal (NAT-T) if the dynamic endpoint is behind
a NAT device.

NAT-T

Select a value. NAT Keepalives are required to maintain the NAT translation during the
connection between the VPN peers. Range is from 1 to 300 seconds.

Keep Alive

Configure the number of concurrent connections that the VPN profile supports. When
the maximum number of connections is reached, no more Remote Access User (VPN)
endpoints attempting to access an IPsec VPN can begin Internet Key Exchange (IKE)
negotiations.

NOTE: This is applicable only for remote access VPN profiles.

IKE Connection Limit

991



Table 318: VPN Profile Settings (continued)

GuidelinesSettings

IPsec Settings

Select the required protocol to establish the VPN.

• ESP—The Encapsulating Security Payload (ESP) protocol provides both encryption and
authentication.

• AH—The Authentication Header (AH) protocol provides data integrity and data
authentication.

NOTE: This is not applicable for remote access VPN profiles.

Protocol

Select the necessary encryption method.

This is applicable if the Protocol is ESP.

Encryption Algorithm

Select an algorithm. The device uses these algorithms to verify the authenticity and
integrity of a packet.

Authentication Algorithm

Select Perfect Forward Secrecy (PFS) as the method that the device uses to generate the
encryption key. The PFS generates each new encryption key independently from the
previous key. The higher numbered groups provide more security but require more
processing time.

Perfect Forward Secrecy

Select the lifetime of an IKE security association (SA). The valid range is from 180 through
86,400 seconds.

Lifetime Seconds

Select the lifetime (in kilobytes) of an IPsec security association (SA). The range is from
64 through 4294967294 kilobytes.

Lifetime kilobytes

Select an option to specify when IKE is activated.

• Immediately—IKE is activated immediately after VPN configuration changes are
committed.

• On-traffic—IKE is activated only when data traffic flows and must be negotiated with
the peer gateway. This is the default behavior.

NOTE: This is not applicable for remote access VPN profiles.

Establish Tunnel

Advance Configuration

Enable this option to send Internet Control Message Protocol (ICMP) to determine if the
VPN is up.

VPN Monitor
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Table 318: VPN Profile Settings (continued)

GuidelinesSettings

Enable the Optimized option. When VPN monitoring optimization is enabled, the SRX
Series device only sends ICMP echo requests (pings) when there is outgoing traffic and
no incoming traffic from the configured peer through the VPN tunnel. If there is incoming
traffic through the VPN tunnel, the SRX Series device considers the tunnel to be active
and does not send pings to the peer.

Optimized

By default, Anti-Replay detection is enabled. IPsec protects against the VPN attack by
using a sequence of numbers that are built into the IPsec packet—the system does not
accept a packet for which it has already seen the same sequence number. It checks the
sequence numbers and enforces the check, rather than just ignoring the sequence numbers.
Disable it if there is an error with the IPsecmechanism that results in out-of-order packets,
preventing proper functionality.

Anti Replay

Select themaximumnumber of seconds to allow for the installation of a re-keyed outbound
security association (SA) on the device.

Install interval

Select the appropriate idle time interval. The sessions and their corresponding translations
typically time out after a certain period if no traffic is received.

Idle Time

Select an option to process the Don’t Fragment (DF) bit in IP messages.

• Clear—Disable the DF bit from the IP messages. This is the default.

• Copy—Copy the DF bit to the IP messages.

• Set—Enable the DF bit in the IP messages.

DF Bit

Enable copying of Differentiated Services Code Point (DSCP) field from the outer IP
header encrypted packet to the inner IP header plain text message on the decryption
path. The benefit in enabling this feature is that after IPsec decryption, clear text packets
can follow the inner class-of-service (CoS) rules.

Copy Outer DSCP

RELATED DOCUMENTATION

VPN Profiles Main Page Fields | 996

VPN Profiles Overview | 987
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Edit and Clone IPsec VPN profiles

IN THIS SECTION

Edit a VPN Profile | 994

Clone IPsec VPN Profile | 994

You can edit or clone a custom IPsec VPN profile. Starting in Junos Space Security Director Release 20.3,
when you edit or clone a VPN profile migrated from an earlier release, you need to select a VPN topology
for the VPN profile.

NOTE: You cannot modify or delete Juniper Networks Predefined VPN profiles. You can only
clone them and create new profiles.

Edit a VPN Profile

1. Select Configure > IPsec VPN > Profiles.

The VPN Profiles page is displayed.

2. Select the IPsec VPN that you want to edit, and then click the pencil icon.

The edit window appears, showing the same options as when creating a new VPN profile.

NOTE: Starting in Junos Space Security Director Release 20.3, you’ll need to select a VPN
topology while creating an IPsec VPN.When you edit a VPN profile migrated from an earlier
release, you’ll need to select a VPN topology for the VPN profile.

3. Click Save to save your changes.

Clone IPsec VPN Profile

1. Select Configure > IPsec VPN > Profiles.

The VPN Profiles page is displayed.
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2. Right-click the VPN Profile that you want to clone and select Clone. You can also select Clone from
the More list.

The Clone window appears with editable fields.

NOTE: Starting in Junos Space Security Director Release 20.3, you’ll need to select a VPN
topologywhile creating an IPsec VPN.When you clone a VPN profile migrated from an earlier
release, you’ll need to select a VPN topology for the VPN profile.

3. Click OK to save your changes.

RELATED DOCUMENTATION

Creating VPN Profiles | 988

Assigning Policies and Profiles to Domains

You can assign or reassign policies or profiles to different domainswhen it is first configured andwhenever
you want to implement a change. You can assign only one policy or profile at a time. Before assigning a
policy or profile to another domain, Security Director checks for the validity of the move. If the move is
not acceptable, a warning message appears.

To assign a policy or profile to a domain:

1. Select Configure and select the landing page for the type of policy or profile that you are assigning to
a domain.

2. From the landing page, right-click the policy or profile or clickMore.

A list of actions appears.

3. Select Assign <Policy or Profile> to Domain.

The Assign <Policy or Profile> to Domain page appears.

NOTE: <Policy or Profile> is the name of the policy or profile that you are assigning to a
domain.
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4. Select the required items to assign to a domain.

5. Enable this option to ignore warning messages, if any.

6. Click Assign.

A policy or profile is assigned to a domain.

RELATED DOCUMENTATION

Creating Firewall Policies | 434

Creating NAT Policies | 707

Creating IPS Policies | 640

VPN Profiles Main Page Fields

Use the VPN profiles main page to get an overall, high-level view of your VPN settings. You can filter and
sort this information to get a better understanding of what you want to configure. Table 319 on page 996
describes the fields on this page.

Table 319: VPN Profiles Main Page Fields

DescriptionField

Name of the VPN profile.Name

A VPN profile type can be predefined or custom. You can use these predefined sets
or create your own.

Type

Description of the VPN profile.Description

IKE negotiation mode (main or aggressive) is used to determine the type and number
of message exchanges that occur in a phase. Only one mode is used for negotiation,
and the same mode must be configured on both sides of the tunnel.

Mode

The VPN topology of the profile.VPN Topology

User who created the VPN profile.Created By

User domain for mapping objects and managing sections of a network.Domain Name
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Table 319: VPN Profiles Main Page Fields (continued)

DescriptionField

Specifies the list of IPSec VPNs to which the profile is associated.IPsec VPN

RELATED DOCUMENTATION

Creating VPN Profiles | 988

VPN Profiles Overview | 987
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CHAPTER 86

Insights

IN THIS CHAPTER

About the Log Parsers Page | 998

Create a New Log Parser | 1000

Edit and Delete a Log Parser | 1004

About the Log Sources Page | 1005

Add a Log Source | 1006

Edit and Delete a Log Source | 1007

View Log Statistics | 1008

About the Event Scoring Rules Page | 1009

Create an Event Scoring Rule | 1010

Edit and Delete Event Scoring Rules | 1012

About the Incident Scoring Rules Page | 1013

Create an Incident Scoring Rule | 1015

Edit and Delete Incident Scoring Rules | 1016

About the Log Parsers Page

To access this page, click Configure > Insights > Log Parsers.

Use the flexible log parser to define how the system log data must be parsed. The flexible parser enables
you to provide a sample of your logs to create a new parser, parse the logs, normalize the fields, filter logs
based on your configured criteria, and assign severity and semantics to various fields. You can create
multiple parsers for different log sources. You can also import the parsers from a file or export the parsers
to a standard file that can be saved and shared.

Security Director Insights includes prepackaged parsers for SRX Series device logs. You can export a
prepackaged parser to a file and save a copy of that parser. This is a sample parser. You can add any logs
to it, change the filter criteria, or modify the conditions for severity settings according to your environment
and Security Operation Center (SOC) process. Before modifying a prepackaged log parser, it’s good to
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export it to a file and save a copy of the default parser. You can always import it back to the SRX Series
device if you need it later.

Tasks You Can Perform

You can perform the following tasks from the Log Parsers page:

• Create a new log parser. See “Create a New Log Parser” on page 1000.

• Import and export log parsers. See Import and Export Log Parsers.

• Edit and delete a log parser. See “Edit and Delete a Log Parser” on page 1004.

Field Descriptions

Table 320 on page 999 provides guidelines to configure the Log Parsers.

Table 320: Fields on the Log Parsers Page

DescriptionField

Specifies the name of the log parser that you have created.Name

Specifies the corresponding description provided for the log parser.Description

RELATED DOCUMENTATION

Create a New Log Parser | 1000

Edit and Delete a Log Parser | 1004

Import and Export Log Parsers
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Create a New Log Parser

Use the New Log Parser page to create your own log parser by using sample logs. You can build your own
parser by mapping fields in your sample logs to Security Director Insights event fields, indicating which
types of events will generate an incident.

To create a new log parser:

1. Select Configure > Insights > Log Parsers.

The Log Parsers page appears.

2. Select the plus icon (+).

The New Log Parser page appears.

3. Complete the configuration according to the guidelines provided in Table 321 on page 1000.

4. Click Finish, and you are presented with the results of your flexible log parser as they are applied to
the sample logs provided.

Review the results carefully to determine whether your mapping, filtering, and assignment conditions
are as expected.

Table 321: Add New Log Parser

GuidelineSetting

Create/Edit Parser

Enter a unique and descriptive name for the log parser.Name

Enter a description for the log parser.Description

Parse Log File

Upload the raw log file by browsing to it, or paste the log data in a separate field provided below
the Browse button.

Ensure the log file contains an RFC-compliant syslog header.

Raw Log
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Table 321: Add New Log Parser (continued)

GuidelineSetting

Specify the format of the sample log file. The available options are:

• XML

• JSON

• CSV

• Others

Log File Format

If your log file is in CSV format, you may provide a comma-delimited list of field names in this
field. If the CSV headers are not provided, the fields will be named as csvN, where N is the field
position.

CSV Headers

(if the log file format
is CSV)

If you select the Others option for the log file format, you must supply a grok pattern for the
log file. A grok pattern may consist of one or more lines. The grok pattern line beginning with
LOGPATTERN is the pattern that will be applied to the logs. A grok pattern must include a
pattern named LOGPATTERN, otherwise the parser will not have any pattern to use.

Grok Pattern

(if the log file format
is others)

Field Mapping

In the Unmapped Field section, select a field in the Parsed Fields column and then select a value
in the Insights Fields column to map. After selecting both the fields, clickMap. The mapped
fields now appear in the Mapped Fields section, which lists all fields that have been mapped to
each other.

You can perform the following actions from the Field Mapping page:

• Click a circular arrow icon in the Mapped Fields section to undo a mapping.

• Click the filter icon in the Unmapped Fields section to enter text for searching.

• In the Unmapped Fields section, you can select multiple fields from the Parsed Fields column
and map them to one field from the Insights Fields column. When you do this, a sort icon
appears in the Mapped Fields section. Use the Sort capability to select the order in which
multiple fields are applied based on whether those fields contain a valid value or not. Higher
in the order takes priority.

• Select the Counter check box to count the number of times a field appears.

NOTE: Fields marked with * are mandatory.

Mapped Fields and
Unmapped Fields

Date Format
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Table 321: Add New Log Parser (continued)

GuidelineSetting

This is an optional configuration. You can leave this field blank, if your log file is using a standard
time as dictated by RFC 3164 or RFC 5424. Those headers are automatically parsed. If the
timestamp cannot be parsed, use the Ruby strftime to provide a format string so that Security
Director Insights can interpret the date and time in your log file as the event start time.

For more information about the Ruby strftime format, see
https://ruby-doc.org/core-2.3.0/Time.html#method-i-strftime.

Field Mapping:
Format Date and
Time

Log Filtering

You can create filters to notify Security Director Insights aboutmalicious and unmalicious events
as you decide what logs are to be kept and which ones can be ignored. Log filtering removes
logs that are “noisy” and not of particular interest and retains logs that are related to malicious
events.

With these filters, you can select exact match or contains filter for the string you enter.

Click Add and configure filtering conditions as follows:

• Select a log file field from the list.

• Select a suitable filter condition from the list such as Matches, Contains, Does not Contain,
and so on. If you select Matches, your provided string must match the selected field exactly.
If you select Contains, your provided string must appear as a substring within the selected
field.

• In the edit field, enter a string to filter log files, and then click Add.

ClickOK and your condition is added to the filter. You can addmultiple filters. An “or” condition
is applied to the list of filters; therefore, the order of filters is not relevant.

NOTE: Select the check box for a filter and click Delete to remove that filter.

Log Filtering

Conditions Assignment
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Table 321: Add New Log Parser (continued)

GuidelineSetting

You can assign different conditions to an event, based on the filtering parameters you configure.

• Event Severity—Assign conditions to define the severity of an event.

Click Add and set conditions as follows:

• Select a severity level. The options are Benign, Low, Medium, High, and Critical.

• Select a field from the list to set the severity level for that field.

• Select a condition. For example, If you selectMatches, your stringmust match the selected
field exactly. If you select Contains, your string must appear as a substring within the
selected field.

• In the edit field, enter a string to filter log files and click Add.

• Progression—Assign conditions to define the progression of an event.

Click Add and set conditions as follows:

• Select a progression level. The options are Phishing, Exploit, Download, Infection, and
Execution.

• Select a field from the list to set the progression level for that field.

• Select a condition. For example, If you selectMatches, your stringmust match the selected
field exactly. If you select Contains, your string must appear as a substring within the
selected field.

• In the edit field, enter a string to filter log files and click Add.

• Blocked—Assign conditions to define the event is blocked or not.

Click Add and set conditions as follows:

• Select a blocked level. The options are True and False.

• Select a field from the list to set the block level for that field.

• Select a condition. For example, If you selectMatches, your stringmust match the selected
field exactly. If you select Contains, your string must appear as a substring within the
selected field.

• In the edit field, enter a string to filter log files and click Add.

Assign Conditions

RELATED DOCUMENTATION

About the Log Parsers Page | 998

Edit and Delete a Log Parser | 1004

Import and Export Log Parsers
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Edit and Delete a Log Parser

IN THIS SECTION

Edit a Log Parser | 1004

Delete a Log Parser | 1004

You can edit and delete a log parser from the Log Parsers page.

Edit a Log Parser

To edit a log parser:

1. Select Configure > Insights > Log Parsers.

The Log Parsers page appears.

2. Select the log parser that you want to edit, and click the pencil icon.

The Edit Log Parser page appears, displaying the same fields that were presented when you added new
log parsers.

3. Modify the log parser fields.

4. Click Finish to save your changes.

You are taken to the Log Parsers page. A confirmation message appears, indicating the status of the
edit operation.

Delete a Log Parser

To delete a log parser:

1. Select Configure > Insights > Log Parsers.

The Log Parsers page appears.

2. Select a log parser that you want to delete and click the delete icon.

An alert message appears, asking you to confirm the delete operation.
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3. Click Yes to delete the log parser.

A confirmation message appears, indicating the status of the delete operation.

RELATED DOCUMENTATION

About the Log Parsers Page | 998

Create a New Log Parser | 1000

Import and Export Log Parsers

About the Log Sources Page

To access this page, select Configure > Insights > Log Sources.

Security products such as Juniper Secure Analytics (JSA) can act as a log source. You can create multiple
log parsers for different log sources. The log source name is the hostname portion of the syslog message
that Security Director Insights uses to identify the log source, and how Security Director Insights will parse
its logged events.

Tasks You Can Perform

You can perform the following tasks from the Log Sources page:

• Add log sources. See “Add a Log Source” on page 1006.

• Edit and delete log sources. See “Edit and Delete a Log Source” on page 1007.

• View log statistics. See “View Log Statistics” on page 1008.

Field Descriptions

Table 322 on page 1005 provides guidelines on using the fields on the Log Sources page.

Table 322: Fields on the Log Sources Page

DescriptionField

Specifies the unique string that needs to be looked for.Log Source Identifier

Specifies the name of the log parser assigned to that particular log source.Parser

Specifies the severity of the log parser.Severity
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Table 322: Fields on the Log Sources Page (continued)

DescriptionField

Specifies different actions that you can take for a log source.Actions

RELATED DOCUMENTATION

Add a Log Source | 1006

Edit and Delete a Log Source | 1007

View Log Statistics | 1008

Add a Log Source

Use the Add Log Source page to create a log source and assign the log parser with a severity level.

To add a log source:

1. Select Configure > Insights > Log Sources.

The Log Sources page appears.

2. Click Create.

The Add Log Source page appears.

3. Complete the configuration according to the guidelines provided in Table 323 on page 1006.

4. Click Save.

A new log source is created and listed on the Log Sources page.

Table 323: Fields on the Add Log Source Page

GuidelineSetting

Enter a unique name for the log source.Log Source Identifier

Select a required log parser from the list.Parser

You can enable or disable SSL.SSL
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Table 323: Fields on the Add Log Source Page (continued)

GuidelineSetting

Assign a default severity level from the list.Default Severity

RELATED DOCUMENTATION

About the Log Sources Page | 1005

Edit and Delete a Log Source | 1007

View Log Statistics | 1008

Edit and Delete a Log Source

IN THIS SECTION

Edit a Log Source | 1007

Delete a Log Source | 1008

You can edit and delete log sources from the Log Sources page.

Edit a Log Source

To edit a log source:

1. Select Configure>Insights>Log Sources.

The Log Sources page appears.

2. Select the log source that you want to edit, click the pencil icon.

The Update Log Sources page appears, displaying the same fields that were presentedwhen you added
new log sources.
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3. Modify the log source fields.

4. Click Save to save your changes.

You are taken to the Log Sources page. A confirmation message appears, indicating the status of the
edit operation.

Delete a Log Source

To delete a log source:

1. Select Configure>Insights>Log Sources.

The Log Sources page appears.

2. Select the log source that you want to delete, click the delete icon.

An alert message appears, asking you to confirm the delete operation.

3. Click Yes to delete the log source.

A confirmation message appears, indicating the status of the delete operation.

RELATED DOCUMENTATION

About the Log Sources Page | 1005

Add a Log Source | 1006

View Log Statistics | 1008

View Log Statistics

The counter for each log source shows the number of logs collected over five minutes, one hour, one day,
one week intervals, and a total count, broken down by the fields you chose when creating the custom log
parser.

To view logs statistics:

1. Select Configure>Insights>Log Sources.

The Log Sources page appears.

2. Click Counters.
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The All Logs page appears.

The logs statistics may include the following information:

• All Incoming Logs: Aggregate (lifetime), Last five minutes, Last one hour, Last twenty four hours, and
Last seven days

• All Created Events: Aggregate(lifetime), Last five minutes, Last one hour, Last twenty four hours, and
Last seven days

3. Click Reset to reset the counter or Close to close the page.

RELATED DOCUMENTATION

About the Log Sources Page | 1005

Add a Log Source | 1006

Edit and Delete a Log Source | 1007

About the Event Scoring Rules Page

To access this page, select Configure > Insights > Event Scoring Rules.

You can use the event scoring rules to customize the log event to match your security operation center
(SOC) processes. Rules comprise the following elements:

• Condition—The rules engine supports several match operations for different field types. For example,
the matching operations include conditions such as Matches, Contains, Greater Than, and Less Than.
You can combinemultiple matching criteria in an ANY (OR) configuration or an ALL (AND) configuration.
To apply a condition, select a normalized field from the event and match the criteria that trigger the rule.

• Action—An action is a response to an event. You can configure, increase, or lower the severity or look
up a threat intelligence source.

Tasks You Can Perform

You can perform the following tasks from the Event Scoring Rules page:

• Create an event scoring rule. See “Create an Event Scoring Rule” on page 1010.

• Edit and delete an event scoring rule. See “Edit and Delete Event Scoring Rules” on page 1012.

• Enable or disable an event scoring rule.
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Field Descriptions

Table 324 on page 1010 provides guidelines on using the fields on the Event Scoring Rules page.

Table 324: Fields on the Event Scoring Rules Page

DescriptionField

Specifies the name of the rule.Rule Name

Specifies the condition applied for the rule.Rule Description

Specifies the matching criteria set for the rule.Match Any/All Rules

Specifies the action to be taken when the condition of a rule is met.Actions

Specifies the status of the rule, whether enabled or disabled.Status

Click Enable or Disable to either enable the event scoring rule or disable it.

RELATED DOCUMENTATION

Create an Event Scoring Rule | 1010

Edit and Delete Event Scoring Rules | 1012

Create an Event Scoring Rule

You can create rules for the log events by defining the matching condition and corresponding actions to
take when a condition is met.

To create a rule for scoring log events:

1. Select Configure > Insights > Event Scoring Rules.

The Event Scoring Rules page appears.

2. Click the plus icon (+).

A page appears, on which you can define the rule’s condition and actions.

3. In the text box that appears at the top of the page, enter a unique name for the rule.
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4. In the Condition section:

• Select a matching condition from the list:Match Any orMatch All.

• Select the type of event from the list. You can select from options such as:

• Detection Method

• Endpoint IP

• Endpoint User Name

• Event Name

• Event Severity

• File Hash

• File Name

• File Path

• HTTP Content-Type

• HTTP Referer

• HTTP Status

• Log Severity

• Progression

• Signature ID

• Threat Source Host Name

• Threat Source IP

• Threat Source User Name

• URL

• URL Hostname

• URL Path

• URL Query

• URL Scheme

• Vendor Response

• For the selected event, select a condition from the list.

• For the selected condition, provide necessary additional data.

• If you are defining more than one condition, click Add.

5. In the Action(s) section:
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a. Select a required action from the list, such as Raise or Lower Severity (by 0.25, 0.50, 0.75, or 1.0),
Set Severity (value), Check feed, and Skip remaining rules.

b. For the selected action, assign the additional actions from the list.

c. If you are defining more than one action, click Add.

6. Click Confirm.

A new rule is created and listed on the Event Scoring Rules page.

RELATED DOCUMENTATION

About the Event Scoring Rules Page | 1009

Edit and Delete Event Scoring Rules | 1012

Edit and Delete Event Scoring Rules

IN THIS SECTION

Edit an Event Scoring Rule | 1012

Delete an Event Scoring Rule | 1013

You can edit and delete event rules from the Event Scoring Rules page.

Edit an Event Scoring Rule

To edit an event scoring rule:

1. Select Configure > Insights > Event Scoring Rules.

The Event Scoring Rules page appears.

2. Select the rule that you want to edit, and click the pencil icon.

An edit page appears, displaying the same fields that were presented when you created a new rule.
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3. Modify the rule.

4. Click Confirm to save your changes.

You are taken to the Event Scoring Rules page. A confirmation message appears, indicating the status
of the edit operation.

Delete an Event Scoring Rule

To delete an event scoring rule:

1. Select Configure > Insights > Event Scoring.

The Event Scoring Rules page appears.

2. Select the rule that you want to delete, and click the delete icon.

An alert message appears, asking you to confirm the delete operation.

3. Click Yes to delete the rule.

A confirmation message appears, indicating the status of the delete operation.

RELATED DOCUMENTATION

About the Event Scoring Rules Page | 1009

Create an Event Scoring Rule | 1010

About the Incident Scoring Rules Page

To access this page, select Configure > Insights > Incident Scoring Rules.

Use incident scoring rules to score the risk of an incident by verifying that the indicators of compromise
are already blocked from execution or mitigated by other events that contributed toward this incident.
Rules comprise the following elements:

• Condition—The only matching condition available for any field type is mitigated by another event.

• Action—An action is a response to an incident. You can raise or lower the severity, set the severity value,
or skip the remaining rules.
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Tasks You Can Perform

You can perform the following tasks from the Incident Scoring Rules page:

• Create an incident scoring rule. See “Create an Incident Scoring Rule” on page 1015.

• Edit and delete an incident scoring rule. See “Edit and Delete Incident Scoring Rules” on page 1016.

• Enable or disable an incident scoring rule.

Field Descriptions

Table 325 on page 1014 provides guidelines on using the fields on the Incident Scoring Rules page.

Table 325: Fields on the Incident Scoring Rules Page

DescriptionField

Specifies the name of the rule.Rule Name

Specifies the condition applied for the rule.Rule Description

Specifies the match criteria set for the rule.Match Any/All Rules

Specifies the action to be taken when the condition of a rule is met.Actions

Specifies the status of the rule, whether enabled or disabled.Status

RELATED DOCUMENTATION

Create an Incident Scoring Rule | 1015

Edit and Delete Incident Scoring Rules | 1016
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Create an Incident Scoring Rule

You can create rules for incidents by defining the matching condition and corresponding actions to take
when a condition is met.

To create a rule for scoring incidents:

1. Select Configure > Insights > Incident Scoring Rules.

The Incident Scoring Rules page appears.

2. Click the plus icon (+).

A page appears, on which you can define the rule’s condition and actions.

3. In the Rule Description field, enter a unique name for the rule.

4. In the Condition section:

a. Select a matching condition from the list:Match Any orMatch All.

b. Select the type of incident from the list: File Hash, Threat Source IP, or URL.

c. For the selected incident, select mitigated by another event as the condition.

NOTE: To add multiple conditions, click Add.

5. In the Action(s) section:

a. Select a required action from the list, such as Raise or Lower Severity (%), Set Severity (value), or
Skip remaining rules.

b. Based on the action you have selected, provide additional data.

NOTE: To add multiple actions, click Add.

6. Click Confirm.

A new rule is created and listed in the Incident Scoring Rules page.

Click Enable or Disable to either enable the incident scoring rule or disable it.
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RELATED DOCUMENTATION

About the Incident Scoring Rules Page | 1013

Edit and Delete Incident Scoring Rules | 1016

Edit and Delete Incident Scoring Rules

IN THIS SECTION

Edit an Incident Scoring Rule | 1016

Delete an Incident Scoring Rule | 1016

You can edit and delete an incident scoring rule from the Incident Scoring Rules page.

Edit an Incident Scoring Rule

To edit an incident scoring rule:

1. Select Configure > Insights > Incident Scoring Rules.

The Incident Scoring Rules page appears.

2. Select the rule that you want to edit, and click the pencil icon.

An edit page appears, displaying the same fields that were presented when you created a new rule.

3. Modify the rule.

4. Click Confirm to save your changes.

You are taken to the Incident Scoring Rules page. A confirmationmessage appears, indicating the status
of the edit operation.

Delete an Incident Scoring Rule

To delete an incident scoring rule:

1. Select Configure > Insights > Incident Scoring Rules.
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The Incident Scoring Rules page appears.

2. Select the rule that you want to delete, and click the delete icon.

An alert message appears, asking you to confirm the delete operation.

3. Click Yes to delete the rule.

A confirmation message appears, indicating the status of the delete operation.

RELATED DOCUMENTATION

About the Incident Scoring Rules Page | 1013

Create an Incident Scoring Rule | 1015
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CHAPTER 87

Shared Objects-Geo IP

IN THIS CHAPTER

Creating Geo IP Policies | 1018

Geo IP Overview | 1020

Delete and Replace Policies and Objects | 1020

Creating Geo IP Policies

You can create Geo IP policies from the Geo IP policies page.

Before You Begin

• Youmust have Juniper ATPCloud account to receiveGeo IP feeds.Make sure you configure the necessary
steps for Juniper ATP Cloud before creating a Geo IP policy.

• Geo IP filtering is a useful tool when you are experiencing certain types of attacks, such as DDOS from
specific geographical locations.

• If you are using Juniper ATP Cloud without Policy Enforcer, you must select your Geo IP policy as the
source and/or destination of a firewall rule to apply it.

To create a Geo IP policy:

1. Select Configure>Shared Objects>Geo IP.

2. Click the + icon.

3. Complete the configuration by using the guidelines in Table 326 on page 1019 below.

4. Click OK.
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Table 326: Fields on the Geo IP Policy Page

Enter a unique string that must begin with an alphanumeric character and can include
underscores; no spaces allowed; 63-character maximum.

Name

Enter a description; maximum length is 1024 characters. You should make this description
as useful as possible for all administrators.

Description

Select the check box beside the countries in the Available list and click the > icon to move
them to the Selected list. The countries in the Selected list will be included in the policy and
action will be taken according to their threat level.

Countries

Choose what traffic to block from the selected countries. Incoming traffic, Outgoing traffic,
or Incoming and Outgoing traffic. (Policy Enforcer only)

Block Traffic

Choose to log all traffic or only blocked traffic. (Policy Enforcer only)Log Setting

Once you have a Geo IP policy, you assign it to one more groups (Policy Enforcer only):

To assign a Geo IP policy to a group or groups:

1. In the Group column, click the Assign to Groups link that appears here when there are no groups
assigned or click the group name that appears in this column to edit the existing list of assigned groups.

2. In the Assign to Groups page, select the check box beside a group in the Available list and click the >
icon to move it to the Selected list. The groups in the Selected list will be assigned to the policy.

3. Click OK.

4. Once one or more groups have been assigned, a Ready to Update link appears in the Status column.
You must update to apply your new or edited policy configuration. Clicking the Ready to Update link
takes you the Threat Policy Analysis page. See “Threat Policy Analysis Overview” on page 850. From
there you can view your changes and choose to Update now, Update later, or Save them in draft form
without updating.

5. If you are using Juniper ATP Cloud without Policy Enforcer, you must select your Geo IP policy as the
source and/or destination of a firewall rule. Navigate to Configure > Firewall Policy > Policies.

RELATED DOCUMENTATION

Creating Policy Enforcement Groups | 1022

Creating Threat Prevention Policies | 841
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Threat Policy Analysis Overview | 850

Geo IP Overview | 1020

Configuring Cloud Feeds Only | 1246

Geo IP Overview

Geo IP refers to the method of locating a computer terminal's geographic location by identifying that
terminal's IP address. A Geo IP feed is an up-to-date mapping of IP addresses to geographical regions. By
mapping IP address to the sources of attack traffic, geographic regions of origin can be determined, giving
you the ability to filter traffic to and from specific locations in the world.

RELATED DOCUMENTATION

Creating Geo IP Policies | 1018

Threat Prevention Policy Overview | 848

Juniper ATP Cloud Realm Overview | 866

Delete and Replace Policies and Objects

IN THIS SECTION

Delete Policies and Objects | 1021

Replace Policies and Objects | 1021

You can delete or replace policies and objects from the policies and shared objects main page.
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NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Delete Policies and Objects

To delete a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to delete, and then select the minus sign (-).

An alert message appears verifying that you want to delete your selection.

3. Click Yes to delete your selection.

Replace Policies and Objects

You can select one or more shared objects and replace them with other objects of the same type.

To replace one or more object:

1. Select Configure > Shared Objects > Addresses, Services, or Variables.

The addresses, services, or variables page appears.

2. Right-click the shared object that you want to replace, or click Replace from the More list.

You can replace a single object or multiple objects. If the selected object is used in any policy, a warning
message appears before they are replaced.

3. Click Yes to continue the replacement operation.

RELATED DOCUMENTATION

Creating Geo IP Policies | 1018
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CHAPTER 88

Shared Objects-Policy Enforcement Groups

IN THIS CHAPTER

Creating Policy Enforcement Groups | 1022

Policy Enforcement Groups Overview | 1024

Creating Policy Enforcement Groups

You can create policy enforcement groups from the policy enforcement groups page.

Before You Begin

• Know what type of endpoints you are including in your policy enforcement group: IP address/subnet,
or location.

• Determine what endpoints you will add to the group based on how you will configure threat prevention
according to location, users and applications, or threat risk.

• Keep in mind that endpoints cannot belong to multiple policy enforcement groups.

To create a policy enforcement group:

1. Select Configure>Shared Objects>Policy Enforcement Groups.

2. Click the + icon.

3. Complete the configuration by using the guidelines in the Table 327 on page 1022 below.

4. Click OK.

Table 327: Fields on the Policy Enforcement Group Page

DescriptionField

Enter a unique string that must begin with an alphanumeric character and can include only dashes
and underscores; no spaces allowed; 32-character maximum.

Name
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Table 327: Fields on the Policy Enforcement Group Page (continued)

DescriptionField

Enter a description; maximum length is 64 characters. You should make this description as useful as
possible for all administrators.

Description

Select a group type from the available choices. IP Address/Subnet or Location.Group Type

This field is available only if the Group Type field is IP Address/Subnet

The subnets of all connectors added in the Connector page are dynamically listed in the Available
column. If the Group Type is IP Address/Subnet, the subnets within the connector instances that
have the threat remediation enabled are only listed.

When using Junos Space, Policy Enforcer is able to dynamically discover subnets configured on
Juniper switches. Policy Enforcer does not have the same insight with third-party devices. Therefore
you can add subnets to your connector configuration and select them here. This allows you to
selectively apply policies to those subnets.

If you have not configured a connector, you will see only Junos Space subnets discovered by Policy
Enforcer. If you have a connector configured, you can see the subnets of a connector in the Available
column. Hover over subnets to view the description for these subnets entered during the connector
creation. You will not see any description if it is not entered during creating a connector. The
description will show “No description available” for subnets that come from Junos Space.

The Available and Selected columns have filters listed with connectors or Space. You can choose a
connector and filter only the subnets belonging to that particular connector. The result shows the
name of a device to which the subnet belongs and also the type of the device.

You can also use the search bar to search and filter the result based on subnet, name of the device,
or type of the device.

Click Refresh Available IPs to refresh the available IP addresses or subnets. If you edit any selected
items in the Selected column, the list is refreshed to the initial selected list after the refresh. A
progress bar is shown with the refresh progress in percentage.

In a scenario where there are no IP addresses or subnets, the refreshwill still be successful. Amessage
is displayed showing that the refresh was successful but there are no IP addresses or subnets found.

Connector
IPs

This field is available only if the Group Type field is IP Address/Subnet

Enter an IP address and select the connector type from the list to add to PEG. The IP address must
be within the subnet range of the selected connector. Click Add to add the additional IP address to
the Selected column of the Connector IPs field.

A validation is performed to check if the additional IP address is within the subnet range of the
selected connector. If not, an error message is shown to enter the IP address within the subnet range.

Additional
IP
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Table 327: Fields on the Policy Enforcement Group Page (continued)

DescriptionField

Sites with the threat remediation enabled instances are only listed, if the Group Type is Location.
Select the check box beside the sites in the Available list and click the > icon to move them to the
Selected list.

The endpoints in the Selected list will be included in the policy enforcement group.

Sites

You can create a policy enforcement group with subnets from different connectors based on how they
have grouped their network segments. For example, If you have Junos Space EX switch with subnets HR:
1.1.1.1/24 and Finance: 2.2.2.2/24, ClearPass connector with subnets HR: 1.1.1.1/24 and Marketing:
2.2.2.2/24, Cisco ISE with subnets HR: 1.1.1.1/24 and Finance: 2.2.2.2/24. You can create a single policy
enforcement group and name it as HR by choosing the following subnets: Junos Space EX HR: 1.1.1.1/24,
ClearPass connector subnet HR: 1.1.1.1/24, and Cisco ISE connector subnet HR: 1.1.1.1/24.

RELATED DOCUMENTATION

Policy Enforcement Groups Overview | 1024

Using Guided Setup for Juniper ATP Cloud with Juniper Connected Security | 1224

Policy Enforcement Groups Overview

A policy enforcement group is a grouping of endpoints to which threat prevention policies are applied.
Create a policy enforcement group by adding endpoints (firewalls, switches, subnets, set of end users)
under one common group name and later applying a threat prevention policy to that group.

RELATED DOCUMENTATION

Creating Policy Enforcement Groups | 1022

Threat Prevention Policy Overview | 848
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CHAPTER 89

Shared Objects-Addresses
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Addresses and Address Groups Overview | 1025

Creating Addresses and Address Groups | 1026

Import and Export CSV Files | 1031
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Addresses Main Page Fields | 1038

Addresses and Address Groups Overview

Addresses specify an IP address or a hostname. You can create addresses that can be used across all
devices managed by Security Director. Addresses are used in firewall, NAT, IPS, and VPN services and
apply to corresponding SRX Series devices. If you only know the hostname, you enter it into the Hostname
field and use the address resolution option to resolve it to an IP address. You can also resolve an IP address
to the corresponding hostname.

Once you create an address, you can combine it with other addresses to form an address group. Address
groups are useful when you want to apply the same policy to multiple addresses.

Security Director manages its address book at the global level, assigning objects to devices that are required
to create policies. An address book is a collection of addresses and address groups that are available in a
security zone. If the device is capable of using a global address book, Security Director pushes address
objects used in the policies to the device global address book.
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NOTE: Starting in Junos Space Security Director Release 21.1, you can import a valid source or
destination inline address for an IPS Policy from an SRX Series device to Security Director. In
the case of an inline address, the address object can be assigned in the device without creating
the address object in the address-book. After import of inline address, you can edit the inline
address in shared object. You can edit the name and IP address listed on the Addresses page.
This is applicable for devices with Junos OS release 18.1 or later.

RELATED DOCUMENTATION

Creating Addresses and Address Groups | 1026

Finding Usages for Policies and Objects | 1065

Assigning Policies and Profiles to Domains | 521

Viewing Policy and Shared Object Details | 522

Creating Addresses and Address Groups

Use the Addresses page to create addresses that can be used across all devices managed by Security
Director. Addresses are used in firewall, NAT, IPS, and VPN services and apply to corresponding SRX Series
devices.

Once you create an address, you can combine it with other addresses to form an address group. Address
groups are useful when you want to apply the same policy to multiple devices.

Before You Begin

• Read the topic.

• Decide on the type of address object to define: Host, Range, Network, Wildcard, or DNS Host.

• Review the addresses main page for an understanding of your current data set. See “Addresses Main
Page Fields” on page 1038 for field descriptions.

To create an address object:

1. Select Configure > Shared Objects > Addresses.

2. Click Create.
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3. Complete the configuration according to the guidelines provided in Table 328 on page 1027 and
Table 329 on page 1030.

4. Click OK.

A new address or address group with your configurations is created. You can use this object in policies.
You can also assign it to a domain; see Assigning Policies and Profiles to Domains.

Table 328: Fields on the Create Addresses Page

GuidelineSetting

Select Address or Address Group. If you select Address Group, then the screen changes so you can
select the addresses youwant to include in your address group. Table 329 on page 1030 describes address
group configuration parameters.

Object
Type

Enter a unique name for the address. It must begin with an alphanumeric character and cannot exceed
63 characters. Dashes and underscores are allowed.

Name

Enter a description for your address; maximum length is 1,024 characters. You should make this
description as useful as possible for all administrators.

Description
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Table 328: Fields on the Create Addresses Page (continued)

GuidelineSetting

Type
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Table 328: Fields on the Create Addresses Page (continued)

GuidelineSetting

Select a type of address and fill in the corresponding fields. Available types are:

• Host

• Host IP—Enter the IPv4 or IPv6 host IP address. For example: 1.2.3.4 or 0:0:0:0:0:FFFF:0102:0304.
If you do not know the IP address, you can enter the hostname and click Look up hostname.

• Hostname—Enter the hostname. It must begin with an alphanumeric character and cannot exceed
63 characters. Dashes and underscores are allowed. If you do not know the host name, you can
enter the IP address and click Look up IP address. For example, enter www.company.com and click
Look up IP address. Hostname lookup is supported for IPv4 and IPv6 addresses.

• Range

• Start Address—Enter a starting IPv4 or IPv6 address for the address range. For example: 10.0.0.0
or 0:0:0:0:0:FFFF:A00:0.

• End Address—Enter an ending IPv4 or IPv6 address for the address range. The range is validated
once you enter the address.

NOTE: An address range is configured onmanaged device(s) as address-setwith one ormore network
address objects covering the specified address range. Security Director supports range address objects
in 'mem*' format.

• Network

• Network—Enter the network IP address. For example: 10.0.0.0. IPv6 is also supported. For example:
4001:334:244:2255:24a2:244::

• Subnet Mask—Enter the subnet mask for the network range. For example, IPv4 netmask:
10.0.0.0/24. The subnet mask is validated as you enter it. You should enter the correct subnet
mask in accordance with the network value. For example, IPv6 netmask:
4001:334:244:2255:24a2:244:: / 126.

• Wildcard

• Network—Enter the network IPv4 or IPv6 address. For example: 1.2.3.4 or 2001:4860:800f::68

• Wildcard Mask—Enter the wildcard mask for the network range. For example: 0.0.0.255.

• DNS Host

• DNSName—Enter theDNS name. For example:www.example.com. Only alphanumeric characters,
dashes, and periods are accepted. This name cannot exceed 69 characters and must end with an
alphanumeric character.

• DNS Type—Select the DNS type as IPv4-only or IPv6-only.

Starting in Security Director Release 18.3R1, while creating an address object, if you enter a duplicate
host IP address, address range, network IP address, wildcard mask, or DNS name, then the creation of
addresses with duplicate content is based on the shared objects settings in Junos Space Network
Management Platform.

By default, you can create duplicate address. If you do not want to allow creation of duplicate addresses
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Table 328: Fields on the Create Addresses Page (continued)

GuidelineSetting

in Security Director, go to Network Management Platform and select
Administration>Application>Modify Application Settings>Shared Objects. Select the check box to
prevent creation of addresses with duplicate content.When any duplicate content is selected in Security
Director, an error message is displayed.

Select the required metadata from the list to assign to an address object.

Only host and range address types are supported.

When associating the address (host or range) with metadata, you can use only AND operator.

For example: Location = Bangalore AND Location = Chennai AND Zone = East.

Assign
Metadata

Table 329: Address Group Settings

GuidelineSetting

Select Address Group. When you select Address Group, then the screen changes so you can select
the addresses you want to include in your address group.

Object Type

Enter a unique name for the address group. It must begin with an alphanumeric character and
cannot exceed 63 characters. Dashes and underscores are allowed.

Name

Enter a description for your address group. You should make this description as useful as possible
for all administrators.

Description

Select the check box beside each address you want to include in the address group. Click the arrow
tomove the selected address or addresses from the Available column to the Selected column. Note
that you can use the fields at the top of each column to search for addresses.

While address groups are being created, if the selected address groups are already available, then
the creation of address groups with duplicate content is based on the shared objects settings in
Junos Space Network Management Platform.

By default, you can create duplicate address groups. If you do not want to allow creation of duplicate
addresses in Security Director, go to Network Management Platform and select Administration>
Application>ModifyApplication Settings>SharedObjects. Select the check box to prevent creation
of address groups with duplicate content. When any duplicate content is selected in Security
Director, an error message is displayed.

Addresses

RELATED DOCUMENTATION
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Addresses and Address Groups Overview | 1025

Finding Usages for Policies and Objects | 1065

Showing Duplicate Policies and Objects | 1067

Assigning Policies and Profiles to Domains | 521

Viewing Policy and Shared Object Details | 522

Import and Export CSV Files

IN THIS SECTION

Import from a CSV file | 1032

Export to a CSV File | 1034

You can export all the columns on the Addresses page to a comma-separated value (.csv) file. You can also
import information from a CSV file.

Starting in Junos Space Security Director Release 20.3, while importing an address object, you can resolve
object conflicts, if any. Junos Space Security Director uses object name as the unique identifier for the
object (per domain). During import, all the Security Director objects and device objects are compared by
name.

• If the object name does not exist in Security Director, the object is added to Security Director.

• If the object name exists in Security Director with the same content, the existing object in Security
Director is used.

• If the object name exists in Security Director with different content, the object conflict resolution screen
is displayed.
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NOTE: Objects that are not linked to a policy are imported into Security Director and then
removed from the device configuration as part of device update.

Import from a CSV file

To import configurations from a CSV file:

1. Select Configure > Shared Objects > Addresses.

The Addresses page is displayed.

2. Right-click an address object and select Import from CSV. You can also select Import from CSV from
the More list.

The Addresses Import CSV Wizard page is displayed.

3. Click Browse to locate the CSV file that you want to import and then click Upload to upload the file
to the Security Director database.

NOTE: To view a sample CSV file, click View sample CSV file.

4. Click Next.

5. Resolve object conflicts, if any.

An object conflict occurs when the name of the object to be imported matches an existing object, but
the definition of the object does not match. You can take the following actions for the conflicting
objects:

• Rename Object—Provide a new name to the conflicting object. "_1" is added by default to the name,
or users can specify a new unique name. Device Preview or Update deletes the original object and
adds the object with the new name.

• Overwrite with Imported Value—Overwrite the existing object with the new object. The object is
replaced in Security Director with the new object. The change appears in the next preview/update
for all other devices that use this object.

• Keep Existing Object—Keep the existing object and ignore the new object. The object in Security
Director is used instead of the device object.

6. Click Finish.
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A summary of configuration changes is displayed.

7. Click OK to import the CSV file.

Example: During import, when object conflict occurs between the device and Security Director you must
choose a conflict resolution as in Table 330 on page 1033.

Table 330: OCRWhile Importing Addresses to Security Director

New Object
NameConflict ResolutionImported ValueValueObject TypeObject Name

Address1_1Keep Existing Object203.0.113.10198.51.100.10AddressAddress1

Address2_1Overwrite with
Imported value

203.0.113.20198.51.100.20AddressAddress2

Address3_1Rename Object203.0.113.30198.51.100.30AddressAddress3

The object values and the result after resolving conflicts are listed in Table Table 331 on page 1033.

Table 331: After Importing Addresses to Security Director

ResultDiscoveredValue in SecurityDirector
DiscoveredObjectName in Security
Director

No change198.51.100.10Address1

Value changed203.0.113.20Address2

No change198.51.100.30Address3

Address3_1 created203.0.113.30Address3_1

NOTE: Once the initial conflict is resolved, the object conflict resolution checks for further
conflicts with the new name and definition until resolution is complete. If Security Director finds
further conflicts, the Conflict Resolution page is refreshed to display the new conflicts.

1033



Export to a CSV File

To export configurations to a CSV file:

1. Select Configure > Shared Objects > Addresses.

The Addresses page is displayed.

2. Right-click the address object that you want to export and select Export to CSV. You can also select
Export to CSV from the More list.

The Export Addresses pop-up is displayed.

3. Click Export All or Export Selected.

The Addresses Export CSV Status page is displayed with the status of download percentage.

When the CSV file is available, you can open or save the file.

RELATED DOCUMENTATION

Creating Addresses and Address Groups | 1026

Addresses Main Page Fields | 1038

Assigning Addresses and Address Groups to Domains

You can assign or reassign addresses to different domain. You can assign only one address at a time;
multiple selections are not allowed. Before assigning an address to other domains, Security Director checks
for the validity of the move. For example, you cannot move an address in the Global domain to a child
domain, if it is used by a policy in the Global domain. A warning message is shown for such scenarios.

To assign an address to a domain:

1. Select Configure and Provision > Shared Objects > Addresses.

The Address page appears.

2. Select the address or address group, right click and select Assign Address to Domain.

The Assign Address to Domain page appears.
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3. Select the domain assignment.

4. Click Assign.

The selected domain is assigned to the address.

Showing Duplicate Policies and Objects

To display duplicate objects:

1. Select the check box beside the object(s).

2. Right-click the object(s) or select Show Duplicates from the More list.

The Show Duplicates page appears, which displays the duplicate objects.

3. Select the duplicate object(s), and perform any of the following actions:

• To merge policies or objects, select multiple policies, right-click or selectMerge from the More list.

The merge operation deletes or replaces the reference for only the custom services and not the
predefined services. If the selected duplicate objects are referenced in any other services (firewall
policy) and security objects (service groups), a warning message is provided before the objects are
merged.

Starting in Junos Space Security Director Release 18.4, you can view duplicate objects in Show
Duplicates page from parent domain and subdomains. You can merge shared objects from parent
domain to subdomain and vice versa.

NOTE: You can view the duplicate objects of subdomain only if the users of the subdomain
have read and execute privileges to parent domain objects.

• To locate the usage of the duplicate objects, select a policy or shared object, right-click or select Find
usage from More list.

.

• To delete the policies or shared objects, select the policies or shared objects, right-click and select
Delete or click delete icon. You can delete objects only from current domain. If you select multiple
objects from across the domains, then the delete option is disabled.
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RELATED DOCUMENTATION

Creating Firewall Policies | 434

Creating NAT Policies | 707

Creating IPS Policies | 640

Delete and Replace Policies and Objects

IN THIS SECTION

Delete Policies and Objects | 1036

Replace Policies and Objects | 1037

Delete Unused Policies and Objects | 1037

You can delete or replace policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Delete Policies and Objects

To delete a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to delete, and then select the minus sign (-).

An alert message appears verifying that you want to delete your selection.

3. Click Yes to delete your selection.
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Replace Policies and Objects

You can select one or more shared objects and replace them with other objects of the same type.

To replace one or more object:

1. Select Configure > Shared Objects > Addresses, Services, or Variables.

The addresses, services, or variables page appears.

2. Right-click the shared object that you want to replace, or click Replace from the More list.

You can replace a single object or multiple objects. If the selected object is used in any policy, a warning
message appears before they are replaced.

3. Click Yes to continue the replacement operation.

Delete Unused Policies and Objects

You can clear all unwanted policies or objects that are not used anywhere in your network.

To delete unused policies or objects:

1. Select Configure and select the landing page for type of policy or object you are deleting.

2. Select the check boxes beside the items that you want to delete. Right-click on the policy or object or
click More from the landing page.

A list of actions appears.

3. Select Delete Unused Items.

A confirmation window appears before you can delete the unused policies or objects.

4. Click Yes to confirm the deletion.

All unused policies or objects are deleted.

NOTE: If you want to delete unused address and address groups from the device when the
device is updated from Security Director, go to Junos Space NetworkManagement Platform,
select Administration > Application >Modify Application Settings > Update Device and
select Delete unused addresses and address groups check box.
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Creating Addresses and Address Groups | 1026

Addresses Main Page Fields

Use address and address groups to define policies across devices. Addresses are a combination of IP
addresses, hostnames, and domains and once created, can be combined to form address groups.

Table 332: Addresses Main Page Fields

DescriptionField

Name of the address or address group.Name

Type determines how the address is defined: host, range, network, wildcard, DNS
host, or address group.

Type

Name of the host for the selected type.Hostname

IP address of the host for the selected type or members of the address group.IP Address

Description of your address or address group.Description

Domain or child domain of the address or address group.Domain

RELATED DOCUMENTATION

Addresses and Address Groups Overview | 1025

Creating Addresses and Address Groups | 1026
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CHAPTER 90

Shared Objects-Services

IN THIS CHAPTER

Services and Service Groups Overview | 1039

Creating Services and Service Groups | 1040

Import and Export CSV Files | 1046

Delete and Replace Policies and Objects | 1049

Showing Duplicate Policies and Objects | 1051

Services and Service Groups Overview

A service in Security Directory refers to an application on a device. For example, Domain Name Service
(DNS). Services are based on protocols and ports used by an application, and when added to a policy, a
configured service can be applied across all devices managed by Security Director. The protocols used to
create a service include: TCP, UDP,MS-RPC, SUN-RPC, ICMP, and ICMPv6. Security Director also includes
predefined, commonly used services, and you cannot modify or delete them.

Once you create a service, you can combine it with other services to form a service group. Service groups
are useful when you want to apply the same policy to multiple services. This lets you create fewer policies.

Note that Security Director manages services in the same way it manages addresses, by always deleting
the unused services (those services that are not referenced by any policy on the device) from the device
during publish or update. If the option is disabled, Security Director will never try to delete a service from
the device, even if that service is unused.

RELATED DOCUMENTATION

Creating Services and Service Groups | 1040

Finding Usages for Policies and Objects | 1065

Showing Duplicate Policies and Objects | 1067

Assigning Policies and Profiles to Domains | 521

Viewing Policy and Shared Object Details | 522
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Creating Services and Service Groups

A service in Security Director refers to an application on a device, such as Domain Name Service (DNS).
Services are based on protocols and ports used by an application, andwhen added to a policy, a configured
service can be applied across all devices managed by Security Director. Once you create a service, you
can combine it with other services to form a service group. Service groups are useful when you want to
apply the same policy to multiple services.

The protocols available to create a service include: TCP, UDP, SUN-RPC, MS-RPC, ICMP, ICMPv6, and
Other.

During a device update, you can delete all unused services and service groups by selecting an option
available under Update Device in Junos Space. By default, this option is enabled when you perform a fresh
install of Security Director or upgrade from the previous release.

NOTE: There are Juniper Networks defined service objects for commonly used services, but
you cannot modify or delete them. These services appear when you install a fresh version of
Security Director.

Before You Begin

• Read the topic.

• Gather all the information for the protocols you are using to create the service, including source and
destination ports and protocol type such as TCP or UDP.

• Check to see if cloning an existing service might be more efficient than creating a new one.

• Review the services main page for an understanding of your current data set. See for field descriptions.

To configure a service:

1. Select Configure > Shared Objects > Services.

2. Click Create.

3. Complete the configuration according to the guidelines in Table 333 on page 1041 through
Table 335 on page 1045.

4. Click OK.
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A new service or service group with your configurations is created. You can use this object in policies. You
can also assign it to a domain; see “Assigning Policies and Profiles to Domains” on page 521.

Table 333: Service Settings

GuidelineSetting

General Information

Select Service or Service Group. If you select Service Group, then the screen changes so
you can select the services you want to include in your service group.

Object Type

Required. Enter a unique name for the service. It must beginwith an alphanumeric character
and cannot exceed 63 characters. Dashes and underscores are allowed.

Name

Enter a description for your service. You shouldmake this description as useful as possible
for all administrators.

Description

Create Protocol

Enter a unique name for the protocol. It must begin with an alphanumeric character and
cannot exceed 63 characters. Dashes and underscores are allowed.

Name

Enter a description for your protocol. It cannot exceed 1,024 characters.Description

Select a type of protocol and fill in the corresponding fields. Available types are: TCP,
UDP, ICMP, SUN-RPC,MS-RPC, ICMPv6, andOther. If you select TCP, continuewith this
table. See Table 2 for the other protocol types.

Type

Enter a destination port number for TCP. This is a value or value range from 0 through
65,535.

If you do not provide any value in the destination port field, a message is displayed that
the default value will be Any. “Any” represents null or empty. Click Cancel and enter the
destination port or click OK to continue with the default value.

Destination Port

Advanced Settings

Selected by default. Enter a timeout value for this protocol in seconds or minutes. The
maximum values are 129,600 seconds and 2,160 minutes.

Enable Inactivity Timeout

Select an ALG (Application Layer Gateway) service option if applicable.ALG
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Table 333: Service Settings (continued)

GuidelineSetting

Enter the source port or port range for the protocol.

If you do not provide any value in the source port field, a message is displayed that the
default valuewill be Any. “Any” represents null or empty. ClickCancel and enter the source
port or click OK to continue with the default value.

Source Ports and Port
Ranges

NOTE: Starting in Security Director Release 18.3R1, you cannot create a service object with
duplicate protocol details such as name, destination port, timeout duration, and source port or
port ranges. The creation of services with duplicate content is based on the shared objects
settings in Junos Space Network Management Platform.

By default, you can create duplicate service objects. If you do not want to allow creation of
duplicate services in Security Director, go to Network Management Platform and select
Administration>Application>Modify Application Settings>SharedObjects. Select the check box
to prevent creation of services with duplicate content. When any duplicate content is selected
in Security Director, an error message is displayed.

Table 334 on page 1042 includes the settings and guidelines for the various protocol types.

Table 334: Create Protocol Type Settings

GuidelineSetting

UDP

Enter a destination port number for UDP. This is a value or value range from 0 through
65,535.

If you do not provide any value in the destination port field, a message is displayed
that the default value will be Any. “Any” represents null or empty. ClickCancel to enter
the destination port or click OK to continue with the default value.

Destination Port

Advanced Settings

Selected by default. Enter a timeout value for this protocol in seconds or minutes. The
maximum values are 129,600 seconds and 2,160 minutes.

Enable Inactivity Timeout

Select an ALG (Application Layer Gateway) service option if applicable.ALG
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Table 334: Create Protocol Type Settings (continued)

GuidelineSetting

Enter a source port or port range for UDP. This is a value or value range from 0 through
65,535.

If you do not provide any value in the source port field, a message is displayed that the
default value will be Any. “Any” represents null or empty. Click Cancel to enter the
source port or click OK to continue with the default value.

Source Ports and Port
Ranges

ICMP

Selected by default. Enter a timeout value for this protocol in seconds or minutes. The
maximum values are 129,600 seconds and 2,160 minutes.

Enable Inactivity Timeout

Enter a value from 0 through 225 for the ICMP message type. For example, enter 1
for host unreachable. You can find these values in RFC 792.

ICMP Type

Enter a value from 0 through 225 for the ICMP code. For example, enter 0 for echo
reply. You can find these values in RFC 792.

ICMP Code

SUN-RPC

Enter a destination port for SUN-RPC. This is a value or value range from 0 through
65,535.

If you do not provide any value in the destination port field, a message is displayed
that the default value will be Any. “Any” represents null or empty. ClickCancel to enter
the destination port or click OK to continue with the default value.

Destination Port (available if
Enable ALG is selected)

Selected by default. Enter a timeout value for this protocol in seconds or minutes. The
maximum values are 129,600 seconds and 2,160 minutes.

Enable Inactivity Timeout

Not selected by default. If you enable ALG for this protocol, youmust enter a destination
port in the field that becomes available.

Enable ALG

Enter a value or value range for the RPC (remote procedure call) service. For example,
enter 100,017 for remote execution. You can find these values in RFC 5531.

RPC Program Number

Select TCP or UDP for the protocol type.Protocol Type

MS-RPC
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Table 334: Create Protocol Type Settings (continued)

GuidelineSetting

Enter a destination port for MS-RPC. This is a value or value range from 0 through
65,535.

If you do not provide any value in the destination port field, a message is displayed
that the default value will be Any. “Any” represents null or empty. ClickCancel to enter
the destination port and click OK to continue with the default value.

Destination Port (available if
Enable ALG is selected)

Selected by default. Enter a timeout value for this protocol in seconds or minutes. The
maximum values are 129,600 seconds and 2,160 minutes.

Enable Inactivity Timeout

Not selected by default. If you enable ALG for this protocol, youmust enter a destination
port number in the field that becomes available.

Enable ALG

Enter the corresponding UUID value for the MS-RPC service. For predefined values,
refer to MS-RPC UUID Mappings.

UUID

Select TCP or UDP for the protocol type.Protocol Type

ICMPv6

Selected by default. Enter a timeout value for this protocol in seconds or minutes. The
maximum values are 129,600 seconds and 2,160 minutes.

Enable Inactivity Timeout

Enter a value from 0 through 225 for the ICMPv6 message type. You can find these
values in RFC 4443.

ICMP Type

Enter a value from 0 through 225 for the ICMPv6 code. You can find these values in
RFC 4443.

ICMP Code

Use other to create protocols that do not match the provided type categories. Enter
a destination port for the other protocol. This is a value or value range from 0 through
65,535.

If you do not provide any value in the destination port field, a message is displayed
that the default value will be Any. “Any” represents null or empty. ClickCancel to enter
the destination port and click OK to continue with the default value.

Destination Port

Advanced Settings

Selected by default. Enter a timeout value for this protocol in seconds or minutes. The
maximum values are 129,600 seconds and 2,160 minutes.

Enable Inactivity Timeout
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Table 334: Create Protocol Type Settings (continued)

GuidelineSetting

Select an ALG (Application Layer Gateway) service option if applicable.ALG

Enter the source port or port range for the other protocol.

If you do not provide any value in the source port field, a message is displayed that the
default value will be Any. “Any” represents null or empty. Click Cancel to enter the
source port or click OK to continue with the default value.

Source Ports and Port
Ranges

Enter a protocol number for the protocol type. RFC 791 contains a list of protocols
and their corresponding numbers. This number identifies the service in the next higher
level in the protocol stack to which data is passed.

Protocol Number

Table 335 on page 1045 includes the settings and guidelines for service groups.

Table 335: Service Group Settings

GuidelineSetting

General Information

Select Service Group. When you select Service Group, then the screen changes so you can select
the services you want to include in your service group.

Object Type

Enter a unique name for the service group. It must begin with an alphanumeric character and
cannot exceed 63 characters. Dashes and underscores are allowed.

Name

Enter a description for your service group. You should make this description as useful as possible
for all administrators.

Description

Select the check box beside each service you want to include in the service group. Click the arrow
to move the selected service or services from the Available column to the Selected column. Note
that you can use the fields at the top of each column to search for listed services.

If the selected service groups are already available, the creation of service groups with duplicate
content is based on the shared objects settings in Junos Space Network Management Platform.

By default, you can create duplicate service groups. If you do notwant to allow creation of duplicate
service groups in Security Director, go to Network Management Platform and select
Administration>Application>Modify Application Settings>Shared Objects. Select the check box
to prevent creation of service groups with duplicate content. When any duplicate content is
selected in Security Director, an error message is displayed.

Services
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Services and Service Groups Overview | 1039

Finding Usages for Policies and Objects | 1065

Showing Duplicate Policies and Objects | 1067

Assigning Policies and Profiles to Domains | 521

Viewing Policy and Shared Object Details | 522

Import and Export CSV Files

IN THIS SECTION

Import from a CSV file | 1047

Export to a CSV File | 1049

You can export all the columns on the Services page to a comma-separated value (.csv) file. You can also
import information from a CSV file.

Starting in Junos Space Security Director Release 20.3, you can import service objects from a CSV file.
While importing a service object, you can resolve object conflicts, if any. Junos Space Security Director
uses object name as the unique identifier for the object (per domain). During import, all the Security Director
objects and device objects are compared by name.

• If the object name does not exist in Security Director, the object is added to Security Director.

• If the object name exists in Security Director with the same content, the existing object in Security
Director is used.

• If the object name exists in Security Director with different content, the object conflict resolution screen
is displayed.
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NOTE: Objects that are not linked to a policy are imported into Security Director and then
removed from the device configuration as part of device update.

Import from a CSV file

To import configurations from a CSV file:

1. Select Configure > Shared Objects > Services.

The Services page is displayed.

2. Right-click a service object and select Import from CSV. You can also select Import from CSV from the
More list.

The Services Import CSV Wizard page is displayed.

3. Click Browse to locate the CSV file that you want to import and then click Upload to upload the file
to the Security Director database.

NOTE: To view a sample CSV file, click View sample CSV file.

4. Click Next.

5. Resolve object conflicts, if any.

An object conflict occurs when the name of the object to be imported matches an existing object, but
the definition of the object does not match. You can take the following actions for the conflicting
objects:

• Rename Object—Provide a new name to the conflicting object. "_1" is added by default to the name,
or users can specify a new unique name. Device Preview or Update deletes the original object and
adds the object with the new name.

• Overwrite with Imported Value—Overwrite the existing object with the new object. The object is
replaced in Security Director with the new object. The change appears in the next preview/update
for all other devices that use this object.

• Keep Existing Object—Keep the existing object and ignore the new object. The object in Security
Director is used instead of the device object.

6. Click Finish.
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A summary of configuration changes is displayed.

7. Click OK to import the CSV file.

Example: During import, when object conflict occurs between the device and Security Director you must
choose a conflict resolution as in Table 330 on page 1033.

Table 336: OCRWhile Importing Services to Security Director

New Object
Name

Conflict
ResolutionImported ValueValue

Object
Type

Object
Name

Service1_1Rename ObjectService_1, Protocol:TCP,
Destination Port:26

Service_1,
Protocol:TCP,
Destination Port:25

ServiceService1

Service2_1Overwrite with
Imported value

Service_2, Protocol:TCP,
Destination Port:31

Service_2,
Protocol:TCP,
Destination Port:30

ServiceService2

Service3_1Keep Existing
Object

Service_3, Protocol:TCP,
Destination Port:41

Service_3,
Protocol:TCP,
Destination Port:40

ServiceService3

The object values and the result after resolving conflicts are listed in Table Table 331 on page 1033.

Table 337: After Importing Services to Security Director

ResultDiscovered Value in Security Director
Discovered Object Name in
Security Director

No changeService_1, Protocol:TCP, Destination Port:25Service1

Value changedService_2, Protocol:TCP, Destination Port:31Service2

No changeService_3, Protocol:TCP, Destination Port:40Service3

Service1_1 createdService_1, Protocol:TCP, Destination Port:26Service1_1

NOTE: Once the initial conflict is resolved, the object conflict resolution checks for further
conflicts with the new name and definition until resolution is complete. If Security Director finds
further conflicts, the Conflict Resolution page is refreshed to display the new conflicts.
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Export to a CSV File

To export configurations to a CSV file:

1. Select Configure > Shared Objects > Services.

The Services page is displayed.

2. Right-click the service object that you want to export and select Export to CSV. You can also select
Export to CSV from the More list.

The Export Services pop-up is displayed.

3. Click Export All or Export Selected.

The Services Export CSV Status page is displayed with the status of download percentage.

When the CSV file is available, you can open or save the file.

RELATED DOCUMENTATION

Creating Services and Service Groups | 1040

Delete and Replace Policies and Objects

IN THIS SECTION

Delete Policies and Objects | 1050

Replace Policies and Objects | 1050

You can delete or replace policies and objects from the policies and shared objects main page.
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NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Delete Policies and Objects

To delete a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to delete, and then select the minus sign (-).

An alert message appears verifying that you want to delete your selection.

3. Click Yes to delete your selection.

Replace Policies and Objects

You can select one or more shared objects and replace them with other objects of the same type.

To replace one or more object:

1. Select Configure > Shared Objects > Addresses, Services, or Variables.

The addresses, services, or variables page appears.

2. Right-click the shared object that you want to replace, or click Replace from the More list.

You can replace a single object or multiple objects. If the selected object is used in any policy, a warning
message appears before they are replaced.

3. Click Yes to continue the replacement operation.

RELATED DOCUMENTATION
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Showing Duplicate Policies and Objects

To display duplicate objects:

1. Select the check box beside the object(s).

2. Right-click the object(s) or select Show Duplicates from the More list.

The Show Duplicates page appears, which displays the duplicate objects.

3. Select the duplicate object(s), and perform any of the following actions:

• To merge policies or objects, select multiple policies, right-click or selectMerge from the More list.

The merge operation deletes or replaces the reference for only the custom services and not the
predefined services. If the selected duplicate objects are referenced in any other services (firewall
policy) and security objects (service groups), a warning message is provided before the objects are
merged.

Starting in Junos Space Security Director Release 18.4, you can view duplicate objects in Show
Duplicates page from parent domain and subdomains. You can merge shared objects from parent
domain to subdomain and vice versa.

NOTE: You can view the duplicate objects of subdomain only if the users of the subdomain
have read and execute privileges to parent domain objects.

• To locate the usage of the duplicate objects, select a policy or shared object, right-click or select Find
usage from More list.

.

• To delete the policies or shared objects, select the policies or shared objects, right-click and select
Delete or click delete icon. You can delete objects only from current domain. If you select multiple
objects from across the domains, then the delete option is disabled.

RELATED DOCUMENTATION
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CHAPTER 91

Shared Objects-Variables
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Variables Overview

A variable is useful when similar rules can be applied across devices where only the zone or address might
differ. Using variables instead of static values allows you to create fewer rules and use them more widely.
You can achieve this by creating a variable address or a variable zone that you configure for all devices to
which you are applying a group policy.

For example:

• Group firewall policy FW-G1 has two devices, Dev-1 andDev-2. Each device has its own unique address.
Dev-1 has address A1. Dev-2 has address A2.

• You want to apply the same rule to both devices, but you do not want to configure two rules with all
the same criteria except for the address. It is more efficient to configure one rule with a variable default
address and apply it to both devices.

• You can achieve this by creating an address variable with a default address, A3, and making A3 common
to Dev-1 and Dev-2 in your rule. When you configure default address A3, you map it to the real address
of each device, A1 for Dev-1 and A2 for Dev-2.

• When group firewall policy FW-G1 is applied, these mappings are used to replace the default address
with the real address for each device.

Variables are only used in group policies. They are not applicable to device policies.
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Figure 75: Variable Address Usage

RELATED DOCUMENTATION

Creating Variables | 1053

Assigning Policies and Profiles to Domains | 521

Viewing Policy and Shared Object Details | 522

Creating Variables

Use variables to dynamically obtain addresses and zones in group firewall policies that are applied to
multiple devices. A variable is useful when similar rules can be used across devices where only the zone
or address might differ. Using variables instead of static values allows you to create fewer rules and use
them more widely.

When you configure variables, youmap specific devices to configured values and default values are replaced
by these mapping when policies are applied. Note that variables are only used in group policies. They are
not applicable to device policies.

Before You Begin

• Read the topic.

• Decide on the type of variable to define, either address or zone.
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• Check to see if cloning an existing variable might be more efficient than creating a new one.

• Review the Variables main page for an understanding of your current data set. See for field descriptions.

To create a variable object:

1. Select Configure > Shared Objects > Variables.

2. Click Create.

3. Complete the configuration according to the guidelines provided in Table 338 on page 1054 to
Table 340 on page 1055.

4. Click OK.

A new variable with your configurations is created. You can use this object in policies. You can also assign
it to a domain; see Assigning Policies and Profiles to Domains.

Table 338: Variable Profile Settings

GuidelineSetting

Enter a unique name for this variable. It must begin with an alphanumeric character and cannot
exceed 63 characters. Dashes and underscores are allowed.

Name

Enter a description for your variable; maximum length is 1,024 characters. You should make
this description as useful as possible for all administrators.

Description

Select a type of variable and fill in the corresponding fields. Available types are: Address or
Zone. When you select a type, the required fields for that type are shown. See
Table 339 on page 1054 for address types. See Table 340 on page 1055 for zone types.

Type

Table 339: Create Variable Address Profile Setting

GuidelineSetting

Select a predefined address by clicking anywhere within this field and choosing an address from
the Select Address window or click Add to create a new default address. This default address
is replaced with the mapped device-specific address when applied to the group firewall policy.

Default Address

Select the check box beside each device to which you want to map this variable address. Click
the arrow to move the selected device or devices from the Available column to the Selected
column. Only devices from the current and child domain are listed. Note that you can use the
fields at the top of each column to search for listed devices.

Context Value
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Table 339: Create Variable Address Profile Setting (continued)

GuidelineSetting

Select a predefined address by clicking anywhere within this field and choosing an address from
the Select Address window. The default address is replaced by this device-specific address
when applied to a policy that includes the selected device or devices.

Address

Table 340: Create Zone Profile Settings

GuidelineSetting

Enter a zone. This default zone is replaced with the mapped zone when applied to the group
firewall policy. The default value is trust.

Default Zone

Select the check box beside each device to which you want to map this variable zone. Click the
arrow tomove the selected device or devices from the Available column to the Selected column.
Note that you can use the fields at the top of each column to search for listed devices.

Context Value

For SRX Series devices, select a zone from the list. The default zone is replaced by this
device-specific zone when applied to a policy that includes the selected device or devices.

Starting in Junos Space Security Director Release 16.2, if you select an MX Series router, the
Zone field lists all the AMS interfaces that are assigned to the service set. If you select both SRX
Series devices and MX Series routers, both zones and AMS values are listed.

Zone

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.2, if you select an MX Series router, the
Zone field lists all the AMS interfaces that are assigned to the service set. If you select both SRX
Series devices and MX Series routers, both zones and AMS values are listed.

16.2
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Editing Variables

To edit a variable:

1. Select Configure and Provision > Shared Objects > Variables.

The Variables page appears.

2. Select the address or zone variable you want to edit and click Edit.

The Edit Variable page appears.

3. Edit the variable as needed, including the name, description, default address, context value, and (mapped)
address for an address variable. For a zone variable, you can edit the name, description, default zone,
context value, and (mapped) zone.

4. Click OK to save the changes.

Import and Export CSV Files

IN THIS SECTION

Import from a CSV file | 1056

Export to a CSV File | 1057

You can export all the columns on the Security Director Devices page to a comma-separated value (.csv)
file. You can also import information from a CSV file.

Import from a CSV file

To import configurations from a CSV file:

1. Select Configure > Shared Objects > Variables.

2. From the landing page, clickMore.

A list of actions appears.
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3. Select Import from CSV

The Select CSV File window appears.

4. Click Browse to locate the CSV file you are importing.

5. Click Import.

Export to a CSV File

To export configurations to a CSV file:

1. Select Configure > Shared Objects > Variables.

2. Select the check box(es) beside the item(s) you want to export. ClickMore or right click on the page.
A list of actions appears.

3. Select Export to CSV

The Select CSV File window appears.

4. Click Export All or Export Selected.

The Export CSV Job Status page appears.

5. When the export file is ready, click the provided link in the CSV Job Status page to download the file.
You can also access the download link in the job manager.

RELATED DOCUMENTATION

Creating Variables | 1053

Showing Duplicate Policies and Objects

To display duplicate objects:

1. Select the check box beside the object(s).

2. Right click and select Show Duplicates.

The Show Duplicates page appears.
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3. Select the check box beside the duplicate object, click Delete and confirm to remove it.
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CHAPTER 92

Shared Objects-Zone Sets
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Understanding Zone Sets

Security zones are the building blocks for policies; they are logical entities to which one or more interfaces
are bound. Security zones provide a means of distinguishing groups of hosts (user systems and servers)
and their resources from one another to apply different security measures to them.

A zone set is a grouping of two or more zones in a network to regulate and secure the traffic through the
security platform running Junos OS. With zone-based security, you can define multiple security zones,
group similar interfaces, and apply the same policies to all zones. Zone sets are referenced in the global
firewall group to avoid creating multiple policies across every possible interface.

NOTE: In Security Director, a zone set is a group of multiple zones and not a device-level object.

Figure 76 on page 1060 shows a zone set with three zones, Zone 1, Zone 2, and Zone 3. Zone 1 provides
access from hosts H1 and H3 to the data residing on server S1. Zone 2 provides access from host H3 to
the data residing on server S2. Zone 3 provides access from host H2 to the data residing on server S2.
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Figure 76: Hierarchy of Zone Set, Zones, and Zone Members

Interfaces act as a doorway through which traffic enters and exits a Juniper Networks device. Many
interfaces can share exactly the same security requirements; however, different interfaces can also have
different security requirements for inbound and outbound data packets. Interfaces with identical security
requirements can be grouped together into a single security zone. See Figure 77 on page 1060, which shows
a basic zone topology that includes a router connected to three interfaces.

Figure 77: Basic Zone Topology

Figure 77 on page 1060 shows a basic zone topologywith three zones, private LAN,DMZ, and public Internet.
A router within the zone to three interfaces:

• One interface connected to the public Internet

• One interface connected to a private LAN that must not be accessible from the public Internet
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• One interface connected to an Internet service demilitarized zone (DMZ), where a webserver, Domain
Name System (DNS) server, and e-mail server must be accessible to the public Internet

Each interface in this network is assigned to its own zone, although you might want to allow varied access
from the public Internet to specific hosts in the DMZ and varied application use policies for hosts in the
protected LAN.

In this network, there are three main policies:

• Private zone connectivity to the Internet

• Private zone connectivity to DMZ hosts

• Internet zone connectivity to DMZ hosts

If an additional interface is added to the private zone, the hosts connected to the new interface in the
zone can pass traffic to all hosts on the existing interface in the same zone. Also, the traffic from the hosts
to hosts in other zones is similarly affected by existing policies.

RELATED DOCUMENTATION
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Creating Zone Sets

Use zone sets page to group one or more zones and reference them in the global firewall group.

A zone set is a grouping of one or more zones in a network to regulate and secure traffic through the
security platform running Junos OS.With the zone-based security, you can define multiple security zones,
group similar interfaces, and apply the same policies to the zones to avoid creating multiple policies across
every possible interface.

Zone sets are referenced in the global firewall group to provide you with the flexibility to perform actions
on traffic without the restrictions of zone specifications.

Before You Begin

• Read the “Understanding Zone Sets” on page 1059 topic.

• Define a security zone.
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• Add logical interfaces to the zone.

• Review the zone sets main page for an understanding of your current data set. See “Zone Sets Main
Page Fields” on page 1069 for field descriptions.

To configure a zone set:

1. Select Configure > Shared Objects > Zone Sets.

2. Click the + icon.

3. Complete the configuration according to the guidelines provided in the Table 341 on page 1062.

4. Click OK.

A new zone set with the predefined configurations is created. You can use this zone set in firewall policy.

Table 341: Zone Set Settings

GuidelinesSettings

Enter a unique name for the zone set that begins with alphanumeric characters. Colons,
periods, slashes, dashes, and underscores are allowed. The maximum length is 63 characters.

Name

Enter a description for the zone set; maximum length is 1024 characters.Description

Select one or more predefined or unique zones from the Available column for inclusion in the
zone set. For example: DMZ, junos-host.

The unique zones and predefined zones on your firewall depend on the device managed by
Security Director.

Zones
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Edit and Clone Policies and Objects

IN THIS SECTION

Edit Policies or Objects | 1063

Clone Policies or Objects | 1064

You can edit or clone policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Edit Policies or Objects

To edit a policy or a shared objects:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Select the policy or shared object that you want to edit, and then click the pencil icon.

The Edit window appears, showing the same options as when creating a new policy or object.

3. Click OK to save your changes.

NOTE: After the published firewall policy rules are edited and saved, you see an icon next to
the check box for each saved policy rule on the Firewall Policies page. When you hover over the
icon, a message appears, indicating that the policy was edited and needs to be pushed to the
device. For updating the policy, see “Updating Policies on Devices” on page 478.
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Clone Policies or Objects

To clone a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to clone, or select Clone from the More list.

The Clone window appears with editable fields.

3. Click OK to save your changes.

RELATED DOCUMENTATION
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Delete and Replace Policies and Objects

IN THIS SECTION

Delete Policies and Objects | 1064

Replace Policies and Objects | 1065

You can delete or replace policies and objects from the policies and shared objects main page.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Delete Policies and Objects

To delete a policy or a shared object:

1. Select Configure > Policies or Shared Objects.

1064



The policies or shared objects page appears.

2. Select the policy or shared object that you want to delete, and then select the minus sign (-).

An alert message appears verifying that you want to delete your selection.

3. Click Yes to delete your selection.

Replace Policies and Objects

You can select one or more shared objects and replace them with other objects of the same type.

To replace one or more object:

1. Select Configure > Shared Objects > Addresses, Services, or Variables.

The addresses, services, or variables page appears.

2. Right-click the shared object that you want to replace, or click Replace from the More list.

You can replace a single object or multiple objects. If the selected object is used in any policy, a warning
message appears before they are replaced.

3. Click Yes to continue the replacement operation.

RELATED DOCUMENTATION
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Finding Usages for Policies and Objects

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

You can find usages for policies or objects and take appropriate action.
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To find policies or objects usages:

1. Select Configure > and select the landing page for the policy or object for which you want to find
usages.

The policies or shared objects page appears

2. Right-click the policy or object or clickMore.

3. Select Find Usage. The usage window appears, showing the usage of the selected policy or object.

RELATED DOCUMENTATION
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Show and Delete Unused Policies and Objects

IN THIS SECTION

Show Unused Policies and Objects | 1066

Delete Unused Policies and Objects | 1067

You can show or delete unused policies and objects in your network configurations.

NOTE: Some tasks in this topic might not apply to your feature. Refer to the tasks relevant to
you.

Show Unused Policies and Objects

You can view all unwanted policies or objects that are not used anywhere in your network to take
appropriate action.
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To show unused policies or objects:

1. Select Configure and select the landing page for type of policy or object you are showing.

2. From the landing page, clickMore.

A list of actions appears.

3. Select Show Unused.

A list of unused objects (not referenced in any policy) and unused policies appear on the page.

Delete Unused Policies and Objects

You can clear all unwanted policies or objects that are not used anywhere in your network.

To delete unused policies or objects:

1. Select Configure and select the landing page for type of policy or object you are deleting.

2. Select the check boxes beside the items that you want to delete. Right-click on the policy or object or
click More from the landing page.

A list of actions appears.

3. Select Delete Unused.

A confirmation window appears before you can delete the unused policies or objects.

4. Click Yes to confirm the deletion.

All unused policies or objects are deleted.

RELATED DOCUMENTATION
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Showing Duplicate Policies and Objects

To display duplicate objects:

1. Select the check box beside the object(s).
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2. Right-click the object(s) or select Show Duplicates from the More list.

The Show Duplicates page appears, which displays the duplicate objects.

3. Select the duplicate object(s), and perform any of the following actions:

• To merge policies or objects, select multiple policies, right-click or selectMerge from the More list.

The merge operation deletes or replaces the reference for only the custom services and not the
predefined services. If the selected duplicate objects are referenced in any other services (firewall
policy) and security objects (service groups), a warning message is provided before the objects are
merged.

Starting in Junos Space Security Director Release 18.4, you can view duplicate objects in Show
Duplicates page from parent domain and subdomains. You can merge shared objects from parent
domain to subdomain and vice versa.

NOTE: You can view the duplicate objects of subdomain only if the users of the subdomain
have read and execute privileges to parent domain objects.

• To locate the usage of the duplicate objects, select a policy or shared object, right-click or select Find
usage from More list.

.

• To delete the policies or shared objects, select the policies or shared objects, right-click and select
Delete or click delete icon. You can delete objects only from current domain. If you select multiple
objects from across the domains, then the delete option is disabled.
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Viewing Policy and Shared Object Details

On a policy or a shared object landing page, you can get a detailed view of the existing policies or objects.
The Detail View page lists all the configured parameters of a policy or an object. The Landing page of a
policy or shared object lists only some of the configured parameters and not all. The Detail View option
helps you to get a consolidated view of all the configured parameters.
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NOTE: The detailed view is in read-only mode; you cannot edit any fields.

To see a detailed view of the policy or a shared object:

1. Select Configure >Policies or Shared Objects.

The policies or shared objects page appears.

2. Right-click the policy or shared object that you want to see the detailed view for, or selectDetail View
from the More list.

The Detail View page appears showing the configuration information, the user who created that
particular policy or shared object, and the last updated information.

You can also get a detailed view by hovering over the name and clicking the Detailed View icon before
the policy or shared object name.

RELATED DOCUMENTATION
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Zone Sets Main Page Fields

Use the zone sets main page to get an overall, high-level view of your zone sets settings. You can filter
and sort this information to get a better understanding ofwhat youwant to configure. Table 342onpage 1069
describes the fields on this page.

Table 342: Zone Sets Main Page Fields

DescriptionField

Name of the zone set.Name

Description of the zone set.Description

Domain name of the zone set for securing and managing the zone settings of your
network. For example: global, system.

Domain
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Table 342: Zone Sets Main Page Fields (continued)

DescriptionField

Unique zones defined by the user or predefined zones to include in the zone sets. For
example: DMZ, junos-host.

Zones
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CHAPTER 93

Shared Objects-Metadata
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Creating a Metadata | 1073

Metadata-Based Policy Enforcement Overview

Traditionally, firewall policies are created using source and destination address objects. These objects are
usually addresses or address groups. To create a firewall policy, you must know the IP address or range
of IP addresses you want to target.

The introduction ofmetadata enables you to appropriately tag these addresses. You can use thesemetadata
tags when you create the firewall policy.

The metadata-based policy enforcement involves the following steps:

1. Metadata definition—Define the metadata key values you want to use. For example, Location =
Bangalore; Sunnyvale, OS = Windows, Mac, Linux; Role = Database, application, Web.

2. Metadata association—Associate the defined metadata with the addresses of type host or range.

3. Metadata expressions evaluation—When you create a rule for a firewall policy, you choose the source
and destination addresses based on metadata expressions, instead of IP addresses, address groups, or
network ranges.

Benefits of Metadata-Based Policies

• The use of metadata tags facilitates a wide range of security automation operations and significantly
reduces the number of rules required to implement a solution.

• Metadata-based policies ensure that the defined security policy is instantiated on the firewalls even
before the applications and application components are created.When the new application components
are instantiated, the relevant firewall policies are automatically updated with the metadata for the
application components, thereby enabling automatic policy enforcement at the time of instantiation of
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the application components. The security administrators do not need tomanually commit changes related
to the metadata of addresses unless the rules are changed.

• Whether you deploy the application components inside a data center or in different public cloud locations,
you can leverage the same metadata-based policy and deploy it to different SRX Series devices or vSRX
instances in different locations and achieve a consistent security posture.

• Security administrators can see amore holistic picture about each network entity based on themetadata
assignments. The administrators are no longer limited to knowing the network entity based on only the
IP address of the entity.

RELATED DOCUMENTATION
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About the Metadata Page

To access this page, select Configure > Shared Objects > Object Metadata.

Use the Metadata page to view the user defined metadata.

Tasks You Can Perform

You can perform the following tasks from this page:

• Create metadata. See “Creating a Metadata” on page 1073.

• Edit, clone, or delete the metadata.

Field Descriptions

Table 343 on page 1072 provides guidelines on using the fields on the Metadata page.

Table 343: Fields on the Metadata Page

DescriptionField

Specifies the name of the metadata.Name

Specifies the possible values of a metadata.Possible Values
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Table 343: Fields on the Metadata Page (continued)

DescriptionField

Specifies the provider information of the metadata. For example, Security Director or
any external provider.

By default, the system generated provider is shown. You cannot modify or use this
provider in any configuration.

Provider

RELATED DOCUMENTATION
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Creating a Metadata

Use the CreateMetadata page to define newmetadata of your choice. Themetadata is assigned to address
objects and used in the firewall policy rules.

NOTE: Metadata cannot be assigned to address groups.

To create a new metadata:

1. Select Configure > Shared Objects > Object Metadata.

The Metadata page appears.

2. Click the add icon (+).

The Create Metadata page appears.

3. Complete the configuration according to the guidelines provided in Table 344 on page 1074.

4. Click Ok.

A new metadata is created. Associate the new metadata to an address. See “Creating Addresses and
Address Groups” on page 1026.

Click Cancel to discard the changes.
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Table 344: Fields on the Create Metadata Page

DescriptionField

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores.
No spaces are allowed; maximum length is 63 characters.

For example: Location

Name

Define the possible metadata values. You can use only alphabetical characters. Values must
be comma separated.

For example, Bangalore, Sunnyvale, and so on.

Possible Value
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Change Management-Change Requests
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Change Control Workflow Overview
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Benefits of the Change Control Workflow | 1077

Setting Up the Change Control Workflow | 1077

The change control workflow allows you to request an approval for changes to a firewall or a NAT policy.
Traditionally, when a policy is published and/or updated, all the changes to the policy are published. You
cannot select a subset of changes to publish. For example, suppose two rules, R1 and R2, are added to a
policy. When the policy is published, both the rules are published. R1 and R2 rule additions cannot be
published separately.

The change control workflow represents a set of changes made to a policy to achieve a logical goal (usually
a request in an IT ticketing system). For example, a new finance user in a company requests access to the
server that hosts the payroll management system. The user files a ticket requesting access. At this point,
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the requester creates a change request. The approver can either approve or deny the change request,
individually or as part of a batch. The Change Management workspace allows the requester (in this case,
the firewall administrator) to create and update change requests and the approver to approve or deny
change requests.

Table 345 on page 1076 describes the roles for the change control workflow.

Table 345: Predefined Roles in the Change Control Workflow

DescriptionRole

A user with access permission needed to make changes to designated policies;
submit them for approval; and, once approved, update them to the network.

For example, an administrator can provide the required information about the
change to the firewall or NAT policy.

Security Director Change
Control Requester

A user with access permission needed to approve change requests from a requester.
For example, a senior administrator or manager can act as an approver, after which
a firewall administrator, acting as the requester, can update the changes to the
appropriate firewall or NAT policy.

Security Director Change
Control Approver

At a high level, the following change control workflow tasks, and who performs them, are described:

1. The administrator opens a new session to modify the security or network environment, or both, by
using Security Director.

2. The administrator configures the security policy and application settings in Security Director.

3. The administrator submits the completed session for approval.

4. The manager reviews the proposedmodifications and either approves or denies the request, or returns
it to the administrator with a request to make the proposed changes.

5. The administrator makes the requested changes and resubmits the session for approval, if the manager
initially denied the request and requested modifications.

6. The manager approves the request.

7. The administrator installs the policy for all approved sessions.

1076



NOTE:
• Before you can install a policy, all sessions must be approved,

• If a user publishes a policy, all change requests created for that policy are deleted and all current
changes on the policy are pushed to the device.

The following sections provide more information about the change control workflow:

Benefits of the Change Control Workflow

• The request resembles a request in an IT ticketing system. The approver can either approve changes to
a firewall or NAT policy or deny the change request, individually or as part of batch.

• The policies that are modified within an activity (or configuration session) are locked and thereby
prevented from being modified within other activities. This prevents conflicting changes from being
made.

Setting Up the Change Control Workflow

To set up the change control workflow:

1. Select Network Management Platform > Administration > Applications.

A page appears listing the available Network Management Platform applications.

2. Right-click Security Director and selectModify Application Settings.

3. ClickChange-Control-Workflow and provide the information, as described in Table 346 on page 1077.

Table 346: Fields on the Change Control Workflow Setting Page

DescriptionOption

Approve all firewall and NAT policy changes before updateing the policy
changes. All Security Director users will be logged out after this option is
selected.

Enable Change Control Workflow

Number of days within which the request must be approved or denied. The
default number of days is 7.

Default approval days

Ticket field name for creating the change request. The default field name is
Ticket Number.

Default ticket field name
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Table 346: Fields on the Change Control Workflow Setting Page (continued)

DescriptionOption

Receive e-mail notifications when the change request is created, approved, or
denied. The notification is sent to both the requester and the approver.

Enable e-mail notifications

Maximumnumber of outstanding change requests per policy. The default value
is 10.

Maximum requests per policy

NOTE: If you disable the change control workflow, all the change requests created for firewall
and NAT policies are deleted.
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Creating a Firewall or NAT Policy Change Request

Use the Create Change Request page to create change requests for a firewall or NAT policy.

To create a change request:

1. Select Configure > <Policy-Name> >Policies.

The Policies page appears.

2. Select the policy that you want to request a change, and click Request Change.
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The Create Change Request page appears.

3. Complete the configuration by using the guidelines in Table 347 on page 1079.

4. Click OK to complete the configuration or Cancel to discard the configuration.

Table 347: Fields on the Create Change Request Page

DescriptionField

Enter a unique string of alphanumeric characters, colons, periods, dashes, and underscores.
No spaces are allowed; maximum length is 63 characters.

Request Name

Enter a description for the change request; maximum length is 255 characters.Description

Enter the ticket number of the change request; maximum length is 255 characters.

This is an identifier to a ticket in the customer’s ticketing system. This helps in correlating the
change request to an item in the customer’s ticketing system. More than one change request
can bemapped to a ticket. Because a change request is for a single policy, a ticket could involve
changes to multiple policies.

Different customers use different terminologies to represent the ticketing system. Therefore,
the name of this field is configurable. For example, you can name this field as ticket number,
work-flow, tracking ID, or any other name.

Ticket Number

Select the priority from the list for your change request. The change requests are processed
according to the priority.

The available options are:

• Low

• Medium

• High

• Critical

This field indicates the criticality of the change request and helps the approver to prioritize
the review of their outstanding tickets. Apart from prioritizing the reviews, this does not affect
the change request workflow in any other way.

Request Priority

Select a due date for approval.

If you do not select a date, a default duration of 5 days from the current date is set as a due
date for approval.

Approval Due Date

Click View to view the unsubmitted changes of a policy.Changes
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About the Changes Submitted Page

To access this page, click Configure > Change Management > Change Requests.

Use the Changes Submitted page to take appropriate actions on the changes submitted such as approve,
deny, update, edit, and delete.

Tasks You Can Perform

You can perform the following tasks from this page:

• Approve the request. See “Approving and Updating Changes Submitted” on page 1082.

• update the approved changes. “Approving and Updating Changes Submitted” on page 1082.

• Deny the request. See “Editing, Denying, and Deleting Change Requests” on page 1091.

• Edit or delete the change request. See “Editing, Denying, and Deleting Change Requests” on page 1091.

Field Descriptions

Table 348 on page 1081 provides guidelines on using the fields on the Changes Submitted page.
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Table 348: Fields on the Changes Submitted Page

DescriptionField

Name of the change submit request.

Click the request name to view the following information:

• Summary of changes

• Delta of changes

• Compare the changes between change requests

• List of affected devices

Request Name

Specifies the status of the change request such as, pending, approved, denied, updated, in
progress, and update failed.

Status

Specifies the priority of the change request and helps approvers prioritize reviews of their
outstanding tickets.

Priority

Specifies if the policy has any dependencies with other policies. If a change request depends
on other change requests, this column contains a link to view the dependencies. For example,
a rule is added in CR1. The same rule is thenmodified in a subsequent change request, CR2.
CR2 is now dependent on CR1 (CR1 is a dependency of CR2).

Dependencies

Specifies the date by which the requestor is asking the approver to complete the review
of the change request.

Approval Due Date

Specifies the name of the policy for which the change request has been created.Policy Name

Specifies the service type of the policy. For example: Firewall, NATService Type

Specifies the ticket number. This information helps in correlating the change request to an
item in the customer’s ticketing system. Note that more than one change request could
map to a ticket and could involve changes to multiple policies.

Ticket Number

Specifies the description of the change request. This field is autopopulated from the
comments the user enters while saving changes to the policy. If user performs multiple
saves, this field is populated with a concatenated list of all saved comments.

Description

Specifies the name of the requester.Created By
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Approving and Updating Changes Submitted

To approve the change requests and update the policy changes:

1. Select Configure > Change Management > Change Requests.

The Changes Submitted page appears.

2. Select the change request and click Approve.

3. The submitted change request is displayed in the approvers workspace.

4. The approver reviews the change request and checks for any dependencies. Dependencies can be
viewed by clicking the View link.

5. If there are no dependencies, the approver enters the comments in the Approve Request window and
then clicks Yes. A pop-up message shows the status as approval successful.

6. The change request workspace of the firewall administrator shows all the change requests that were
approved or rejected.

7. The administrator then selects an approved change request and schedules it to publish and update.

8. The administrator selects Update to update immediately or schedule to update later. If the selected
change request has dependencies, then the user is notified that update of dependency change requests
will also be scheduled (if they have not been already) or advanced (if they have been scheduled for a
later time) to the same time as that of the selected change request. The list of dependency change
requests that are also updated will be displayed. A new snapshot of the policy is created. This snapshot
is used as the source for publish and update. This new snapshot is essentially the previously updated
snapshot of the policy along with the changes from the selected change request. This snapshot is visible
in the Manage Snapshots list.

Updating a change request is same as publishing and updating together. If either of publish or update
jobs fail, the change request is moved to the Update Failed state. You can reupdate the failed change
requests.

9. The administrator views and verifies the job status.
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NOTE:
• You must approve all the parent change requests before approving a child change request, if
there is a dependency.

• You must deny all child change requests before denying a parent change request, if there is a
dependency.
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Creating and Updating a Firewall Policy Using Change Control Workflow

IN THIS SECTION
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To create, approve, and update a firewall policy using the Change Control Workflow, perform these tasks:

Creating a Change Request

The following procedure explains the steps policy administrators need to take to submit change requests.

To create a change request:

1. Configure the Change Control Workflow:
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a. Select Network Management Platform > Administration > Applications.

The Applications page appears.

b. Right-click Security Director and clickModify Application Settings.

The Modify Security Director Settings page appears.

c. Click Change-Control-Workflow.

The Change ControlWorkflow page appears in the right pane, as shown in Figure 78 on page 1084.

Figure 78: Change Control Workflow Configuration

d. Select the Enable Change Control Workflow option to enable the Change Control Workflow for all
the firewall and NAT policies.

By default, the Change Control Workflow option is disabled. When you enable this option, you are
logged out of Security Director.

e. In the Default approval days field, enter the default number of days for reviewers to approve or
deny the change request. The default value is five days.

f. In the Default ticket field name field, enter the ticket name.

The ticket name that you enter here appears on the Create Change Request page as a separate field
where you can enter the ticket number. The default name is Ticket Number.

g. Enable the e-mail notification option for approvers and requesters when a change request is created,
approved, or denied. By default, this option is disabled.

h. In the Maximum number of requests per policy field, enter the maximum number of outstanding
change requests that can exist in an undeployed state for a policy. The default value is 10 requests.

i. ClickModify.
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A confirmation page appears to enable the Change Control Workflow, as shown in
Figure 79 on page 1085.

Figure 79: Confirm Change Control Workflow

j. Click Confirm.

2. Request approval for a change request.

a. In the Firewall Policies page, select the policy, and click Request Change.

The Create Change Request page appears, as shown in Figure 80 on page 1085. You can also edit a
policy rule and create a change request from the Policy Rules page.

Figure 80: Create Change Request Page

b. In the Request Name field, enter the name of your change request. You can enter a maximum of
63 characters.

c. In the Description field, enter the description for your change request. You can use a maximum of
255 characters.
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d. In the Ticket Number field, enter the ticket number for your change request. The maximum length
is 255 characters.

This number is an identifier to a ticket in your ticketing system. You can map more than one change
request to a ticket.

e. From the Request Priority list, select the priority for your change request to let the approver know
the criticality of your change request.

The default priority is High.

f. In the Approval Due Date field, select a due date for approval.

By default, the number of days that you configured in Step 1 are set for approval.

g. In the Changes field, click View to view the unsubmitted changes before creating a change request.

h. Click Ok.

A change request for your policy is created for approval. Any changes to the shared objects or rules
of the policy are also submitted for change request approval. This change request appears in the
workspace of the approver to take appropriate action.

Approving a Change Request

The following steps explain the procedure for approvers to take necessary action on the submitted change
requests:

1. Review the submitted change requests by the policy administrators.

a. Click Security Director > Configure > Change Management > Change Requests.

Approver can see the changes submitted information, as shown in Figure 81 on page 1087.
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Figure 81: Change Requests Page

b. Under the Changes Submitted section, review the change request in the pending state and check
for any dependencies. In the Dependencies column, click View to view dependencies.

2. Approve or deny the change request.

a. After reviewing the change request, click Approve or Deny.

A confirmation window appears to approve or deny the change request. A comment in the
confirmation window for the Deny action is mandatory, as shown in Figure 82 on page 1088 and
Figure 83 on page 1088.
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Figure 82: Approve Request Page

Figure 83: Deny Request Page
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NOTE:
• Ensure that the change request does not have any dependencies before the approval.
If there is a dependency, you must approve all the parent change requests before
approving a child change request.

• Before denying a change request, you must ensure that all the change requests that are
dependent on the selected change request for denial are already in the denied state. A
warning message is displayed if the dependent change requests are not in the denied
state.

b. Click Yes to approve or deny the request.

The change request workspace of the policy administrator shows all the change requests that were
approved or rejected. An e-mail is sent to the requester and other approvers about the approval or
denial of the corresponding change request.

Publishing and Updating the Approved Change Request

The change request workspace of the policy administrator shows the change requests that are approved
or rejected. The policy administrators can update only the approved change requests. Updating a change
request is the same as publishing and updating in succession. You can either update the change request
immediately or schedule to update later.

To update a change request:

1. Click Security Director > Configure > Change Management > Change Requests.

You see the information on changes submitted.

2. In the Changes Submitted area, select the approved change request and click Update.

The Update Change Request page appears, as shown in Figure 84 on page 1090.
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Figure 84: Update Change Request Page

3. Select the Run now option to update the changes immediately or the Schedule at a later time option
to schedule the update later.

If the selected change request has dependencies, then the user is notified that the deployment of
dependency change requests will also be scheduled (if they have not been already) or advanced (if they
have been scheduled for a later time) to the same time as that of the selected change request.

A new snapshot of the policy is created. This snapshot is used as the source to publish and update.
This new snapshot is essentially the previously deployed snapshot of the policy along with the changes
from the selected change request. This snapshot is visible in the Manage Snapshots list.

4. Click Update Request.

If either the publish job or update job fails, then the change request is moved to the Deployment Failed
state. You can redeploy the failed change requests.

5. Review and verify the publish and update job status.

The review, verification, and update is performed by the policy administrators.
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Editing, Denying, and Deleting Change Requests

IN THIS SECTION

Editing Changes Submitted | 1091

Denying Changes Submitted | 1091

Deleting Changes Submitted | 1092

You can edit, deny, and delete the change requests from the Changes Submitted page. You can deny the
approved change request to remove the changes.

Editing Changes Submitted

To edit a change request:

1. Select Configure > Change Management > Change Requests.

The Changes Submitted page appears.

2. Select the submitted change request that you want to edit, and click the pencil icon.

The Edit Change Request page appears, showing the same fields that are displayed when you create
a new change request.

3. Edit the change request fields as needed.

4. Click OK to save changes.

The changes are saved and you are returned to the Changes Submitted page.

Denying Changes Submitted

To deny a change request:

1. Select Configure > Change Management > Change Requests.

The Changes Submitted page appears.

2. Select a changed request that you want to deny, and click Deny.
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The Deny Request page appears to confirm the deny action. You can select multiple change requests
for denial.

3. Enter your comment for the denial.

This is a mandatory field. You must ensure that all the change requests that are dependent on the
selected change request for denial are already in the denied state. A warning message is displayed, if
the dependent change requests are not in the denied state.

4. Click Yes to deny the request.

A confirmmessage shows the denial as successful and the status is changed from Approved to Denied,
on the Changes Submitted landing page. An e-mail is sent to the requester of the change request and
other approvers about the denial of the change request.

Deleting Changes Submitted

To delete a change request:

1. Select Configure > Change Management > Change Requests.

The Changes Submitted page appears.

2. Select the change request that you want to delete and click the X icon.

A warning dialog box appears asking you to confirm the deletion.

3. Click Yes to delete the selected change request.

The change request is deleted and you are returned to the Changes Submitted page.

NOTE: You cannot select more than one change request for deletion.
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About the Changes Not Submitted Page

To access this page, click Configuration > Change Management > Change Requests.

Use the Changes Not Submitted page to view all policy changes that are not submitted. You can also
perform the required actions such as initiating the change request, editing the policy, and discarding the
policy changes.

A policy can be submitted for change request, if one or more of the following conditions match:

• If the policy is explicitly locked and being modified by the current user.

• If the policy is implicitly modified because of a change in a referred shared object (except if the policy
is locked by another user).

NOTE: Changes to a shared object can bemade by any user with the appropriate permissions.

• The policy is newly created, imported, or migrated from NSM.

A policy cannot be submitted for change request for the following reasons:

• If a policy is not assigned to any device.

• If a policy is locked by some other user.

Tasks You Can Perform

You can perform the following tasks from this page:

• Initiate the change request. See “Creating a Firewall or NAT Policy Change Request” on page 1078.

• Edit the policy details.

• Discard the policy changes. See “Discarding Policy Changes” on page 1094.

Field Descriptions

Table 349 on page 1093 provides guidelines on using the fields on the Changes Not Submitted page.

Table 349: Fields on the Changes Not Submitted Page

DescriptionField

Specifies the name of the policy. Click the Policy Name link to view the
summary of changes to the policy.

Policy Name
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Table 349: Fields on the Changes Not Submitted Page (continued)

DescriptionField

Click View to view detailed information about the unsubmitted changes.Unsubmitted Changes

Specifies the type of policy (firewall or NAT).Service Type

Specifies date and time at which the policy was modified.Last Modified

Specifies the name of the user who saved the changes.Change Saved By
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Discarding Policy Changes

At any time, you can undo all changes made during the current session. This action removes the changes
and the policy reverts to its previous state.

To discard all the changes made during the current session:

1. Select Configuration > Change Management > Change Request.

2. In the ChangesNot Submitted section, select the unsubmitted policy, and clickDiscard Policy Changes.

A warning dialog box appears asking you to confirm the discard operation.

3. Click Yes.

This operation also includes discarding changes to the referred shared objects. The Object Conflict
Resolution (OCR) is performed to check for any conflicts while rolling back the changes. If there are
any conflicts between the versioned data and the current changes in the system, the OCR window is
displayed. After resolving all conflicts, click Next to view the OCR summary report.

4. Click Finish to discard the changes.
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Viewing Submitted and Unsubmitted Policy Changes

Using the Submitted Changes and Unsubmitted Changes page, you can view the details of the policy
changes.

To see a detailed view of submitted or unsubmitted policy changes:

1. Select Configure > Change Management > Change Requests.

2. To view the details, click the request name under the Changes Submitted section or click View in the
Unsubmitted Changes column under the Changes Not Submitted section.

The Submitted Changes or Unsubmitted Changes page appears. Table 350 on page 1095 explains details
available on this page.

Table 350: Detailed View of Changes

DescriptionName

Displays the general summary of a policy or a change request with the following
information:

• Name of the policy or a change request

• Status of the change request, if changes are submitted

• Modified date of a policy or a change request

• Change summary information

Summary of Changes

Displays the differences between the configurations. Click on the device name to see
the delta configurations. You can view the delta in a CLI configuration or an XML
configuration window.

Delta Configuration

Displays a detailed report of current changes from the last created change request.Compare Changes
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Table 350: Detailed View of Changes (continued)

DescriptionName

Displays the total number of devices that are associated with the policy. The following
device details are displayed:

• Device name

• IP address of a device

• Connection status of a device

• Platform details of a device

• Configuration status of a device

Affected Devices
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CHAPTER 95

Change Management-Change Request History
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About the Change Request History Page

To access this page, click Configure > Change Management > Change Request History.

Use the Change Request History page to view the history of all the updated change requests. You click
on the request name to view more details about the changes.

Tasks You Can Perform

You can perform the following tasks from this page:

• Click the request name to view the details of the changes.

• Click the update Job ID to view job details of each change request.

Field Descriptions

Table 351 on page 1097 provides guidelines on using the fields on the Change Request History page.

Table 351: Fields on the Change Request History Page

DescriptionField

Name of the change submit request.

Click the request name to view the following information:

• Summary of changes

• Delta of changes

• Compare the changes between change requests

• List of affected devices

Request Name
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Table 351: Fields on the Change Request History Page (continued)

DescriptionField

Specifies if the policy has any dependencies with other policies

For all the successfully updated change requests, this field is shown as None.

Dependencies

Specifies the name of the policy for which the change request has been created.Policy Name

Specifies the service type of the policy. For example: Firewall, NATService Type

Specifies the ticket number of a change request.Ticket Number

Specifies the description of the change request. This field is autopopulated from the
comments the user enters while saving changes to the policy. If user performsmultiple
saves, this field is populated with a concatenated list of all saved comments.

Description

Specifies the name of the requester.Created By

Specifies the change request created date and time.Request Created

Specifies the priority of the change request.Priority

Specifies the comments entered by the approver while approving the change request.Comments

Specifies the name of the approver who has approved the change request.Approved By

Specifies the name of user who has updated the approved change request.Updated By

Specifies the job ID of the update. Click the job ID to view the complete job details.Update Job ID

Specifies the date and time of the change request update.Update Date
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CHAPTER 96

Overview of Policy Enforcer and Juniper ATP Cloud
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Policy Enforcer Overview

Policy Enforcer, a component of the Junos Space Security Director user interface, integrates with Juniper
ATP Cloud to provide centralized threat management and monitoring to your Juniper connected security
network, giving you the ability to combine threat intelligence from different solutions and act on that
intelligence from one management point.

It also automates the enforcement of security policies across the network and quarantines infected
endpoints to prevent threats across firewalls and switches. Working with Juniper ATP Cloud, it protects
perimeter-oriented threats as well as threats within the network. For example, if a user downloads a file
from the Internet and that file passes through an SRX Series firewall, the file can be sent to the Juniper
ATP Cloud cloud for malware inspection. If the file is determined to be malware, Policy Enforcer identifies
the IP address andMAC address of the host that downloaded the file. Based on a user-defined policy, that
host can be put into a quarantine VLAN or blocked from accessing the Internet.

Figure 85 on page 1100 illustrates the flow diagram of Policy Enforcer over a traditional SRX Series
configuration.
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Figure 85: Comparing Traditional SRX Customers to Policy Enforcer Customers

Supported Topologies

Policy Enforcer supports the following topologies:

• Client to Layer 2 switch to Layer 3 SRX (IRB)

• Client to Layer 2 switch to Layer 3 switch (IRB)

• Client to Layer 2/Layer 3 switch (IRB)

RELATED DOCUMENTATION

1100



Juniper Networks Connected Security Overview | 15

Policy Enforcer Components and Dependencies | 1106

Policy Enforcer Configuration Concepts | 1112

Juniper ATP Cloud Overview | 1103

Policy Enforcer Installation Overview | 1122

Using Guided Setup for Juniper ATP Cloud with Juniper Connected Security | 1224

Using Guided Setup for Juniper ATP Cloud | 1230

Benefits of Policy Enforcer

Most enterprise computer security revolves around creating awall around the perimeter of an organization.
See Figure 86 on page 1101.

Figure 86: Perimeter-Defined Security Model

With this perimeter oriented security, networks are built with an inherently trusted model where the
applications or users connecting to a network (for example, VLAN) can fundamentally talk to each other
and network security solutions like firewalls and Intrusion Prevention Systems (IPS) are deployed in the
perimeter to provide security. Firewalls are often configured with all possible rules in an effort to prevent
unknown malware, application and network attacks from penetrating the enterprise. This architecture is
based on amodel where it is assumed that “Everything already inside the network is fundamentally trusted”
and “Everything outside the network is untrusted” so the perimeter is the location where all security
controls are deployed.
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This architecture is consistent across data centers, and campus and branch configurations. Unfortunately,
there are flaws to this security architecture. They don’t help in protecting against internal threats. Despite
the popularity of firewalls, the sophistication of applications and malware in recent years has found a way
to circumvent perimeter defenses. Once inside the enterprise, these threats can easily spread; where
someone’s infected laptop or desktop couldmake Enterprise networks a botnet army and become a source
of internal and external attacks. Enterprises can protect against internal threats by deploying multiple
layers of firewalls, but that requires careful planning since it is difficult to take all internal traffic through
a separate layer of firewalls.

The security framework become a highly fragmented approach due tomultiple administrators, management
systems and reliance on a lot of manual coordination among different administrators and systems:

• There is a network security team that manages security policies on perimeter firewalls primarily to
manage external threats.

• There is a network operations team, that typically manages security policies by using network and
application isolation to protect against internal attacks and unauthorized access.

• Then there is third team, an IT team, that manages end-points such as laptops, desktops and application
servers to make sure that they have the correct security posture.

In contrast, Policy Enforcer and Juniper Connected Security, see Figure 87 on page 1102, simplifies network
security by providing protection based on logical policies and not security devices. Policy Enforcer does
provide perimeter security, but it’s no longer just protecting the inside from the outside. The fact that
somebody is connected to the internal network does not mean that they can get unrestricted access to
the network. This model is fundamentally more secure because even if one application on the network is
compromised, companies can limit the spread of that infection/threat to other potentially more critical
assets inside the network.

Figure 87: Policy Enforcer and Juniper Connected Security
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Policy Enforcer is a model where the information security is controlled and managed by security software.
New devices are automatically covered by security policies, instead of having to identify it’s IP address as
with other models. Because it’s software-defined, environments can be moved without affecting security
policies and controls already in place. Other advantages include:

• Better and more detailed security—By providing better visibility into network activity, you can respond
faster to cyber threats and other security incidents. Threats can be detected faster by leveraging threat
intelligence from multiple sources (including third-party feeds) and the cloud. A central control lets you
analyze security challenges without interfering with standard network activity and to distribute security
policies throughout your organization. For example, you can selectively block malicious traffic while
allowing normal traffic flow.

• Scalability and cost savings—A software-based model allows you to quickly and easily scale security up
or down based on your immediate needs all without having to add or subtract hardware that is expensive
to buy and maintain.

• Simpler solution—Hardware security architectures can be complex due to the servers and specialized
physical devices that are required. In a software model, security is based on policies. Information can be
protected anywhere it resides without depending on its physical location.
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Juniper ATP Cloud Overview

Juniper ATP Cloud is a cloud-based solution that integrates with Policy Enforcer. Cloud environments are
flexible and scalable, and a shared environment ensures that everyone benefits from new threat intelligence
in near real-time. Your sensitive data is secured even though it is in a cloud shared environment. Security
administrators can update their defenses when new attack techniques are discovered and distribute the
threat intelligence with very little delay.
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Juniper ATP Cloud offers the following features:

• Communicates with firewalls and switches to simplify threat prevention policy deployment and enhance
the anti-threat capabilities across the network.

• Delivers protection against “zero-day” threats using a combination of tools to provide robust coverage
against sophisticated, evasive threats.

• Checks inbound and outbound traffic with policy enhancements that allow users to stop malware,
quarantine infected systems, prevent data exfiltration, and disrupt lateral movement.

• Provides deep inspection, actionable reporting, and inline malware blocking.

• Provides feeds for GeoIP, C&C, allowlist and blocklist, infection hosts, custom configured feeds and file
submission.

Figure 88 on page 1104 lists the Juniper ATP Cloud components.

Figure 88: Juniper ATP Cloud Components

Table 352 on page 1105 briefly describes each Juniper ATP Cloud component’s operation.
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Table 352: Juniper ATP Cloud Components

OperationComponent

C&C feeds are essentially a list of servers that are known command and control
for botnets. The list also includes servers that are known sources for malware
downloads. See “Command and Control Servers Overview” on page 90.

Command and control (C&C) cloud
feeds

GeoIP feeds is an up-to-date mapping of IP addresses to geographical regions.
This gives you the ability to filter traffic to and from specific geographies in
the world.

GeoIP cloud feeds

Infected hosts indicate local devices that are potentially compromised because
they appear to be part of a C&C network or other exhibit other symptoms.
See “Infected Hosts Overview” on page 87.

Infected host cloud feeds

Lists you customize by adding IP addresses, domains, and URLs to your own
lists. See “Custom Feed Sources Overview” on page 888.

Custom Feeds

An allowlist is simply a list of known IP addresses that you trust and a blocklist
is a list that you do not trust.

Allowlist and blocklists

Performs malware analysis and threat detection.Malware inspection pipeline

Inspects files, metadata, and other information.Internal compromise detection

RELATED DOCUMENTATION

Juniper ATP Cloud Realm Overview | 866

Using Guided Setup for Juniper ATP Cloud | 1230

Configuring Juniper ATPCloud (No Juniper Connected Security andNoGuided Setup) Overview | 1240
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CHAPTER 97

Concepts and Configuration Types to Understand
Before You Begin (Policy Enforcer and Juniper ATP
Cloud)

IN THIS CHAPTER

Policy Enforcer Components and Dependencies | 1106

Policy Enforcer Configuration Concepts | 1112

Juniper ATP Cloud Configuration Type Overview | 1113

Features By Juniper ATP Cloud Configuration Type | 1116

Available UI Pages by Juniper ATP Cloud Configuration Type | 1118

Comparing the Juniper Connected Security and non-Juniper Connected Security Configuration Steps | 1120

Policy Enforcer Components and Dependencies

The Policy Enforcer management interface is a component of Junos Space Security Director and requires
the following to be configured and deployed:

• Junos Space Platform—Junos Space is a comprehensive network management solution that simplifies
and automates management of Juniper Networks switching, routing, and security devices. Junos Space
Virtual Appliance includes the complete Junos Space software package as well as the JunosOS operating
system. It requires users to create a virtual machine (VM) in order to deploy the appliance.

• Security Director—Junos Space Security Director provides centralized and orchestrated security policy
management through aweb-based interface. Security administrators can use Security Director tomanage
all phases of the security policy life cycle for every SRX Series physical and virtual device.

• Policy Enforcer—Policy Enforcer itself is installed on a VM and uses RESTful APIs to communicate with
both Security Director and Juniper Networks Advanced Threat Prevention Cloud (Juniper ATP Cloud).
Policy Enforcer contains two components:

• Policy Controller—Defines the logical grouping of the network into secure fabric, automates the
enrollment of SRX Series devices with Juniper ATP Cloud, and configures the SRX firewall policies.
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• Feed Connector—Aggregates the cloud and customer feeds and is the server for SRX Series devices
to download feeds.

• Juniper ATP Cloud—Juniper ATP Cloud employs a pipeline of technologies in the cloud to identify varying
levels of risk, and provides a higher degree of accuracy in threat protection. It integrates with SRX Series
gateways to deliver deep inspection, inline malware blocking, and actionable reporting.

Juniper ATP Cloud’s identification technology uses a variety of techniques to quickly identify a threat
and prevent an impending attack, including:

• Rapid cache lookups to identify known files.

• Dynamic analysis that involves unique deception techniques applied in a sandbox to trick malware
into activating and self-identifying.

• Machine-learning algorithms to adapt to and identify new malware.

• SRX Series device—SRX Series gateways provide security enforcement and deep inspection across all
network layers and applications. Users can be permitted or prohibited from accessing specific business
applications andWeb applications, regardless of the network ports and protocols that are used to transmit
the applications.

Figure 89 on page 1108 illustrates how the components in the Policy Enforcer DeploymentModel interact.
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Figure 89: Components of the Policy Enforcer Deployment Model

Figure 90 on page 1109 shows an example infected endpoint scenario to illustrate how some of the
components work together.
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Figure 90: Blocking an Infected Endpoint

ActionStep

A user downloads a file from the Internet.1

Based on user-defined policies, the file is sent to the Juniper ATPCloud cloud formalware inspection.2

The inspection determines this file is malware and informs Policy Enforcer of the results.3

The enforcement policy is automatically deployed to the SRX Series device and switches.4

The infected endpoint is quarantined.5

Policy Enforcer can track the infected endpoint and automatically quarantine it or block it from accessing
the Internet if the user moves from one campus location to another. See Figure 91 on page 1110.
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Figure 91: Tracking Infected Endpoint Movement

In this example, Juniper ATP Cloud identifies the endpoint as having an IP address of 192.168.10.1 and
resides in SVL-A. The EX Series switch quarantines it because it has been labeled as an infected host by
Juniper ATP Cloud. Suppose the infected host physically moves from location SVL-A to location SVL-B.
The EX Series switch (in SVL-B) microservice tracks the MAC address to the new IP address and
automatically quarantines it. Policy Enforcer then informs Juniper ATPCloud of the newMAC address-to-IP
address binding.

Policy Enforcer can also quarantine infected hosts even if those hosts are connected to third-party switches,
as shown in Figure 92 on page 1111.

For Policy Enforcer to provide threat remediation to endpoints connecting through third-party devices, it
must be able to authenticate those devices and determine their state. It does this using a tracking and
accounting threat remediation plug-in to gather information from a RADIUS server and enforce policies
such as terminate session and quarantine. For more information, see “Policy Enforcer Connector Overview”
on page 1153
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Figure 92: Third-Party Switch Support

ActionStep

An end-user authenticates to the network through IEEE 802.1X or throughMAC-based authentication.1

Juniper ATP Cloud detects the end point is infected with malware and adds it to the infected host feed.2

Policy Enforcer downloads the infected host feed.3

Policy Enforcer enforces the infected host policy using the Connector. See “Policy Enforcer Connector
Overview” on page 1153.

4

The Connector queries the RADIUS server for the infected host endpoint details and initiates a Change
of Authorization (CoA) for the infected host.

5

The CoA can be either block or quarantine the infected host.6

The enforcement occurs on the NAC device the infected host is authenticated with.7

Policy Enforcer communicates the infected host details back to Juniper ATP Cloud.8

RELATED DOCUMENTATION
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Policy Enforcer Configuration Concepts | 1112

Juniper ATP Cloud Overview | 1103

Policy Enforcer Installation Overview | 1122

Using Guided Setup for Juniper ATP Cloud with Juniper Connected Security | 1224

Using Guided Setup for Juniper ATP Cloud | 1230

Configuring JuniperATPCloudwith JuniperConnected Security (WithoutGuided Setup)Overview | 1238

Policy Enforcer Configuration Concepts

You have some options for how you can approach the initial setup of Juniper ATPCloud and Policy Enforcer.
There is a “Guided Setup” approach which walks you through the necessary steps for getting the product
up and running. This is the recommended approach. If you prefer, you can manually configure each part
of the product.

Either way, before you begin the configuration, you need to understand the concepts behind the
configuration items required to successfully deploy threat management policies across your network.
These items include security realms for Juniper ATP Cloud, secure fabric for sites, and policy groups for
endpoints. These are explained in this section.

• Security Realm—When configuring Juniper ATP Cloud or Policy Enforcer with Juniper ATP Cloud, there
are Realm selection fields at the top of several pages. A security realm is a group identifier for an
organization used to restrict access to Web applications. You must create at least one security realm to
login into Juniper ATP Cloud. Once you create a realm, you can enroll SRX Series devices into the realm.
You can also give more users (administrators) permission to access the realm.

If you have multiple security realms, note that each SRX Series device can only be bound to one realm,
and users cannot travel between realms.

• Policy Enforcement Groups—A policy enforcement group is a grouping of endpoints to which threat
prevention policies are applied. Create a policy enforcement group by adding endpoints (firewalls,
switches, subnets, set of end users) under one common group name and later applying a threat prevention
policy to that group.

Some information to know about enforcement groups is as follows: Determine what endpoints you will
add to the group based on how you will configure threat prevention, either according to location, users
and applications, or threat risk. Endpoints cannot belong to multiple policy enforcement groups.

• Threat Prevention Policies—Once you have a Threat Prevention Policy, you assign one or more Policy
Enforcement Groups to it. Threat prevention policies provide protection and monitoring for selected
threat profiles, including command & control servers, GeoIP, infected hosts, and malware. Using feeds
from Juniper ATP Cloud and custom feeds you configure, ingress and egress traffic is monitored for
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suspicious content and behavior. Based on a threat score, detected threats are evaluated and action
may be taken once a verdict is reached.

• Secure Fabric—For your configuration you must create one or more sites for your secure fabric. Secure
fabric is a collection of sites which contain network devices (switches, routers, firewalls, and other
security devices), used in policy enforcement groups. When threat prevention policies are applied to
policy enforcement groups, the system automatically discovers to which sites those groups belong. This
is how threat prevention is aggregated across your secure fabric.

Some information to know about sites is as follows: When you create a site, you must identify the
perimeter firewalls so you can enroll them with Juniper ATP Cloud. If you want to enforce an infected
host policy within the network, you must assign a switch to the site. Devices cannot belong to multiple
sites.

RELATED DOCUMENTATION

Juniper ATP Cloud Configuration Type Overview | 1113

Using Guided Setup for Juniper ATP Cloud with Juniper Connected Security | 1224

Using Guided Setup for Juniper ATP Cloud | 1230

Policy Enforcer Overview | 1099

Juniper ATP Cloud Overview | 1103

Juniper ATP Cloud Configuration Type Overview

Juniper ATP Cloud or JATP with Policy Enforcer can be used in four different configuration types, which
will be explained here.

NOTE: The license you purchase determines if you can use the available configurations and
feature sets for your selected ATP Cloud Configuration Type.

Configuration Type is set here in the UI: Administration > Policy Enforcer > Settings.

The following Juniper ATPCloudConfiguration Types and correspondingworkflows are available.Workflows
are the items you configure for each selection.

ATP Cloud or JATP with Juniper Connected Security—This is the full version of the product. All Policy
Enforcer features and threat prevention types are available.
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Here is the Juniper ATP Cloud with Juniper Connected Security workflow:

• Secure Fabric

• Policy Enforcement Group

• Juniper ATP Cloud Realm

• Threat Prevention Policies for the following threat types:

• C&C Server

• Infected Hosts

• Malware

• Geo IP

Here is the JATP with Juniper Connected Security workflow:

• Secure Fabric

• Policy Enforcement Group

• Threat Prevention Policies for the following threat types:

• C&C Server

• Infected Hosts

• Malware

• Geo IP

ATP Cloud or JATP—This includes all threat prevention types, but does not include the benefits of Secure
Fabric, Policy Enforcement Groups, and Threat Prevention policies provided by Policy Enforcer. All
enforcement is done through SRX Series Device policies.

Here is the Juniper ATP Cloud workflow:

• Juniper ATP Cloud Realm

• Threat Prevention Policies for the following threat types:

• C&C Server

• Infected Hosts

• Malware

• Geo IP

Here is the JATP workflow:

• Threat Prevention Policies for the following threat types:
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• C&C Server

• Infected Hosts

• Malware

• Geo IP

Cloud feeds only—The prevention types available are command and control server, infections hosts, and
Geo IP feeds. Policy Enforcer Secure Fabric, Policy Enforcement Groups, and Threat Prevention policies
are also available. All enforcement is done through SRX Series Device policies.

Here is the Cloud feeds only workflow:

• Secure Fabric

• Policy Enforcement Group

• Juniper ATP Cloud Realm

• Threat Prevention Policies for the following threat types:

• C&C Server

• Infected Hosts

• Geo IP

No ATP Cloud (no selection)—You would make no Juniper ATP Cloud selection to configure Juniper
Connected Security using custom feeds. Custom feeds are available for dynamic address, allowlist, blocklist,
infected hosts, and C&C Server. With this setting, there are no feeds available from Juniper ATP Cloud,
but the benefits of Secure Fabric, Policy Enforcement Groups, and Threat Prevention policies provided
by Policy Enforcer are available. Infected hosts is the only prevention type available.

Here is the No selection workflow:

• Secure Fabric

• Policy Enforcement Group

• Custom Feeds

• Threat Prevention Policies for the following threat type:

1115



• Infected Hosts

NOTE: Moving between configuration types is not supported in all cases. You can only move
from one Juniper ATP Cloud Configuration Type to a “higher” configuration type. You cannot
move to a lower type. Please note the following hierarchy:

• Juniper ATP Cloud or JATP with Juniper Connected Security (highest)

• Juniper ATP Cloud or JATP

• Cloud feeds only

• No Juniper ATP Cloud or JATP- No selection (lowest)

For each configuration type, certain features and UI pages are available. Please see the links below for
details.

• Features By Juniper ATP Cloud Configuration Type on page 1116

• Available UI Pages by Juniper ATP Cloud Configuration Type on page 1118

RELATED DOCUMENTATION

Policy Enforcer Overview | 1099

Policy Enforcer Components and Dependencies | 1106

Benefits of Policy Enforcer | 1101

Policy Enforcer Configuration Concepts | 1112

Features By Juniper ATP Cloud Configuration Type

For each configuration type, certain features and UI pages are available.

Refer to the following table for the features available for each configuration type.
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Table 353: List of features by Juniper ATP Cloud Configuration Type

No ATP
Cloud/JATP (no
selection)Cloud feeds onlyATP Cloud/JATP

ATP Cloud/JATP
with Juniper
ConnectedSecurityFeature

Not AvailableNot AvailableYES

Support with existing
SRX Series policies.
(No Secure Fabric,
Policy Enforcement
Group or Third-party
switch support)

YES

Support with Policy
Enforcement Groups
across the entire
Secure Fabric
(including Third-party
switch support)

Full Threat
Prevention Support

Not AvailableNot AvailableYESYESSRX Series Device
Malware Scanning

Not AvailableNot AvailableYESYESSRX Series Device
Infected Host
Blockingwith Juniper
ATP Cloud or JATP

Not AvailableYESYESYESCloud Feeds for
Command and
Control Servers and
GeoIP with Juniper
ATP Cloud or JATP

YESYESYESYESInfected Hosts
Custom Feeds

YESYESYESYESDynamic Address
Custom Feeds

YESYESYESYESCustomAllowlist and
Blocklists

RELATED DOCUMENTATION

Available UI Pages by Juniper ATP Cloud Configuration Type | 1118

Juniper ATP Cloud Configuration Type Overview | 1113
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Available UI Pages by Juniper ATP Cloud Configuration Type

For each configuration type, certain features and UI pages are available.

Refer to the following table for the UI pages available for each configuration type.

Table 354: List of available UI pages by ATP Cloud Configuration Type

No ATP
Cloud/JATP (no
selection)Cloud feeds onlyATPCloud/JATP

ATPCloud/JATP
with Juniper
Connected
SecurityUI Page

Monitor Pages: Threat Prevention

Not AvailableNot AvailableYESYESHosts

Not AvailableNot AvailableYESYESCC

Not AvailableNot AvailableYESYESHTTP File Download

Not AvailableNot AvailableYESYESSMTP Quarantine

Not AvailableNot AvailableYESYESEmail Attachments

Not AvailableNot AvailableYESYESManual Upload

YESYESYESYESAll Hosts Status

YESYESNot AvailableYESDDoS Feeds Status

Devices Page

YESYESNot AvailableYESSecure Fabric

Configure Pages: Threat Prevention

YESYESYESYESPolicies

YESYESYESYESCustom Feeds

(Dynamic Address, Allowlist,
Blocklist, CC)
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Table 354: List of available UI pages by ATP Cloud Configuration Type (continued)

No ATP
Cloud/JATP (no
selection)Cloud feeds onlyATPCloud/JATP

ATPCloud/JATP
with Juniper
Connected
SecurityUI Page

YESYESNot AvailableYESCustom Feeds

(Infected Host, DDoS)

Not AvailableYESYES

(Only for ATP
Cloud)

YES

(Only for ATP
Cloud)

ATP Cloud Realms

Not AvailableNot AvailableYESYESEmail Management

Not AvailableNot AvailableYESYESMalware Management

Shared Objects

YESYESNot AvailableYESPolicy Enforcement Groups

Not AvailableYESYESYESGeo IP

Administration: Policy Enforcer

YESYESYESYESSettings

YESYESNot AvailableYESConnectors

NOTE: SMTP Quarantine is available only for Juniper ATP Cloud. It is not available for JATP.

RELATED DOCUMENTATION

For each configuration type, certain features and UI pages are available. Please see the links below.

Features By Juniper ATP Cloud Configuration Type | 1116

Juniper ATP Cloud Configuration Type Overview | 1113
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Comparing the Juniper Connected Security and non-Juniper Connected
Security Configuration Steps

The remainder of this guide describes how to configure Security Director for either Policy Enforcer with
Juniper ATP Cloud (Juniper Connected Security) or Juniper ATP Cloudwith no Policy Enforcer (non-Juniper
Connected Security). An optional quick setup configuration is available to step you through the configuration
tasks. Or you can use Security Director windows to configure each step manually.

Table 355 on page 1120 compares the basic steps for both.

Table 355: Comparing the Juniper Connected Security Configuration Steps to the non-Juniper Connected
Security Configuration Steps

Non-Juniper Connected Security
Configuration StepsJuniper Connected Security Configuration Steps

Register one or more Juniper ATP Cloud
accounts.

Create your secure fabric.

A secure fabric is a collection of sites which contain network devices
such as switches, routers, firewalls, and other security devices.

Select your SRX Series devices to register.
Only SRX Series devicesmanaged by Security
Director are supported.

Create your policy enforcement groups.

You can create policy enforcement groups based on, for example,
location or IP subnets. Policy enforcement groups are basically
endpoints.

Create the Juniper ATP Cloud profiles and
policies. You can create C&C (threat score and
actions to take), malware and infected host
policies.

Register one or more Juniper ATP Cloud accounts.

Add the Juniper ATP Cloud policy as a rule in
your firewall policy.

Create threat prevention policies.

Threat prevention policies provide protection and monitoring for
selected threat profiles, including command& control servers, infected
hosts, and malware.

Apply your threat prevention policies to policy enforcement groups.

When threat prevention policies are applied to policy enforcement
groups, the system automatically discovers towhich sites those groups
belong. When you dynamically add sites, the policy enforcement
groups and threat prevention policies are updated automatically.
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CHAPTER 98

Installing Policy Enforcer

IN THIS CHAPTER
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Policy Enforcer Installation Overview

Table 356 on page 1122 lists the general steps to install and configure Policy Enforcer.

Table 356: Overview of Steps to Install and Configure Policy Enforcer

SeeDescriptionStep

Junos Space Network Management Platform
software download

Junos Space Security Director software download

Install and configure Junos Space and Security
Director 16.1 or later.

NOTE: After installing Junos Space and Security
Director, you must update to the latest Junos
Space device schema. See your Junos Space
Security Director documentation for more
information on upgrading your schema.

1
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Table 356: Overview of Steps to Install and Configure Policy Enforcer (continued)

SeeDescriptionStep

Juniper Tech LibraryInstall and configure your SRX Series devices, EX
Series switches or QFX Series switches. Switches
are “discoverable” through Junos Space.

For information on discovering switches, see
“Using Guided Setup for Juniper ATP Cloud with
Juniper Connected Security” on page 1224.

2

“Deploying and Configuring the Policy Enforcer
with OVA files” on page 1124

“Installing Policy Enforcerwith KVM” on page 1130

Download, deploy and configure the Policy
Enforcer virtual machine.

You install Policy Enforcer on an industry-standard
x86 server running a hypervisor, either the
kernel-based virtual machine (KVM) hypervisor or
the VMware ESXi hypervisor.

3

“Identifying the Policy Enforcer Virtual Machine
In Security Director” on page 1141

Use the Policy Enforcer Settings screen in Security
Director (Administration > Policy Enforcer
Settings) to identify the Policy Enforcer virtual
machine to communicate with.

4

“Obtaining a Juniper ATP Cloud License” on
page 1142

“Creating a Juniper ATP Cloud Web Portal Login
Account” on page 1143

Obtain a Juniper ATP Cloud license and create a
Juniper ATP Cloud portal account.

5

“Loading a Root CA” on page 1144Install the root CA on your Juniper ATP
Cloud-supported SRX Series devices.

6

“ClearPass Configuration for Third-Party Plug-in”
on page 1184

“Cisco ISE Configuration for Third-Party Plug-in”
on page 1191

Configure ClearPass or Cisco ISE as a connector
for third-party products (non-Juniper Networks)
to unify policy enforcement across all network
elements.

7
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Table 356: Overview of Steps to Install and Configure Policy Enforcer (continued)

SeeDescriptionStep

“Using Guided Setup for Juniper ATP Cloud with
Juniper Connected Security” on page 1224

“Using Guided Setup for Juniper ATP Cloud” on
page 1230

Use the Guided Setup screens in Security Director
to configure Threat Prevention policies and deploy
to devices. Optionally, you can configure policies
without guided setup.

8
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Deploying and Configuring the Policy Enforcer with OVA files

As with other Juniper Networks virtual appliances, Policy Enforcer requires either a VMware ESX server
version 4.0 or later or a VMware ESXi server version 4.0 or later that can support a virtual machine with
the following configuration:

• 2 CPU

• 8-GB RAM (16-GB recommended)

• 120-GB disk space

If you are not familiar with using VMware ESX or EXSi servers, see VMware Documentation and select
the appropriate VMware vSphere version.
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To deploy and configure the Policy Enforcer with OVA files, perform the following tasks:

1. Download the Policy Enforcer virtualmachineOVA image from the JuniperNetworks software download
page.

NOTE: Do not change the name of the Policy Enforcer virtual machine image file that you
download from the Juniper Networks support site. If you change the name of the image file,
the creation of the Policy Enforcer virtual machine can fail.

2. Launch the vSphere Client that is connected to the ESX server where the Policy Enforcer virtual machine
is to be deployed.

3. Select File > Deploy OVF Template from the menu bar.

4. Click Browse to locate the OVA file you downloaded in Step 1.

5. Click Next and follow the instructions in the installation wizard.

It may take a few minutes to deploy your virtual machine. Once deployed, its name appears in the left
side of the vSphere Client.

6. Right-click the virtual machine name in the left side of the vSphere Client and select Open Console to
start configuring your network settings.

7. Log in to your virtual machine using root and abc123 as the username and password, respectively. You
will be required to change the password at a later step.

The welcome page appears.

8. Click OK.

The End User License Agreement (EULA) window appears.

9. Click Accept to acknowledge the EULA. If you do not agree with the EULA, click Cancel. Your
configuration will stop and you will return to the main vSphere Client page.

The Network configuration page appears. See Figure 93 on page 1126.
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Figure 93: Defining the Basic Network Configuration Settings

10. Enter the following configuration information.

DescriptionOption

Enter the hostname for the Policy Enforcer virtual machine; for example,
pe.juniper.net.

Hostname

Enter the IP address for the Policy Enforcer virtual machine.

NOTE: Make note of this IP address as you’ll need it in a later step.

IP address

Enter the netmask for the Policy Enforcer virtual machine.Network mask

Enter the IP address of the default gateway that connects your internal network
to external networks.

Default gateway

Enter the IP address of your primary system registered to join theDomainName
System (DNS).

Primary DNS server

Enter the IP address of a secondary DNS server. Policy Enforcer uses this
address only when the primary DNS server is unavailable.

Secondary DNS server

Select this check box if you do not want to check basic network settings. By
default, the system will ping the gateway to ensure it receives a response
indicating your settings are correct.

Skip DNS servers check

11.Click Apply Changes.

Your network settings are applied. A progress window indicates the status.
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When the system is finished updating your network settings, an NTP server window appears and
prompts you to configure the NTP server list. See Figure 94 on page 1127.

Figure 94: Prompt for Configuring the NTP Servers

12.Click Yes to customize the NTP server list. Click No to use the default list of 0, 1, 2 and
3.centos.pool.ntp.org.

13. (Optional) Specify the NTP servers to use. See Figure 95 on page 1127. Click Apply Changes to accept
your edits, Clear All to clear all fields in this window, or Cancel to discard any edits and continue to the
next step.

Figure 95: Configuring the NTP Servers

14.The Root password change page appears. See Figure 96 on page 1128.
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Figure 96: Changing the Root Password

15. Enter and re-enter a new administrator password for the Policy Enforcer virtual machine.

Password restrictions are listed in the screen.

NOTE: Make note of this password as you’ll need it in a later step.

If you forget your password, see CentOS root password reset instructions.

16.Click OK.

The Juniper Networks Policy Enforcer page appears. See Figure 97 on page 1128.

Figure 97: Reviewing and Changing Your Configuration Settings
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17. Select one of the options and press Enter.

DescriptionOption

Lets you review the configuration settings you defined one last time before
applying them to the Policy Enforcer virtual machine.

We recommend that you do not change your configuration settings after
Policy Enforcer is set up within Security Director.

Review configuration and finish
setup

Select a setting to update its value.Change...

Lets you ping the default gateway and custom IP address and lets you perform
a DNS lookup to verify that your settings are correct.

Troubleshooting menu

The Review configuration page appears. See Figure 98 on page 1129.

Figure 98: Reviewing Your Configuration Settings

18.Review your configuration settings and click Finish setup. To change any of the settings, click Change
configuration.

When you click Finish setup, the configuration settings are applied to the Policy Enforcer virtual machine.
A status page indicates the progress.

When done, the Setup Complete page appears.
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19.Click Finish to return to the main vSphere Client page.

NOTE: Each time you log in to the Policy Enforcer virtual machine, you are given the option
to review or change any of these settings.
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The Policy Enforcer Virtual Appliance Release 17.1R2 and later can be deployed on qemu-kvm (KVM)
Release 1.5.3-105.el7 or later which is on CentOS Release 6.8 or later.

NOTE: Juniper Networks does not provide any support for installing and configuring the KVM
server. You must install the virtual appliance image and configure it as per the recommended
specifications for the virtual appliance. Juniper Networks will provide support only after the
Policy Enforcer Virtual Appliance has booted successfully.

The prerequisites to deploy a Policy Enforcer Virtual Appliance on a KVM server are as follows:

• Knowledge about configuring and installing a KVM server.

• The KVM server and supported packages must be installed on a CentOS machine with the required
kernels and packages. For information about installing a KVM server and supported packages on CentOS,
refer to http://wiki.centos.org/HowTos/KVM.

• The Virtual Machine Manager (VMM) client must be installed on your local system.

• You use virt-manager or virt-install to install Policy Enforcer VMs. See your host OS documentation for
complete details on these packages.

The following are the minimum requirements for installing the Policy Enforcer VM.

• 2 CPU

• 8-GB RAM (16 GB recommended)

• 120-GB disk space

This topic includes:

Installing Policy Enforcer with virt-manager

You can install and launch Policy Enforcer with the KVM virt-manager GUI package.

Ensure that sure you have already installed KVM, qemu, virt-manager, and libvirt on your host OS.

To install Policy Enforcer with virt-manager:

1. Download the Policy Enforcer KVM image from the Juniper software download site.

2. On your host OS, type virt-manager. The Virtual Machine Manager appears.

NOTE: You must have admin rights on the host OS to use virt-manager.
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3. Click Create a new virtual machine. The New VM wizard appears .

4. Enter a name for the virtual machine, select Import existing disk image, and click Forward.

5. Browse to the location of the downloaded Policy Enforcer image and select it.

6. Select Linux from the OS type list and select Show all OS options from the Version list.

7. Select Red Hat Enterprise Linux 6 or later from the expanded Version list and click Forward.

8. Set the RAM to 8192 MB and set CPUs to 1. Click Forward.

9. Under AdvancedOptions, select Specify shared device name and enter the name of the bridge (typically
br0) into the text box.

10.Click Finish. The VM manager creates the virtual machine and launches the Policy Enforcer console.

Installing Policy Enforcer with virt-install

The virt-install and virsh tools are CLI alternatives to installing and managing Policy Enforcer VMs on a
Linux host.

Ensure that sure you have already installed KVM, qemu, virt-install, and libvirt on your host OS.

NOTE: You must have root access on the host OS to use the virt-install command.

To install Policy Enforcer with virt-install:

1. Download the Policy Enforcer KVM image from the Juniper software download site.

2. On your host OS, use the virt-install command with the mandatory options listed in
Table 357 on page 1133.

NOTE: See the official virt-install documentation for a complete description of available
options.
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Table 357: virt-install Options

DescriptionCommand Option

Name the Policy Enforcer VM.--name name

Allocate RAM for the VM, in megabytes.--ram megabytes

Enable the vmx feature for optimal throughput. You can also enable aes
for improved cryptographic throughput.

NOTE: CPU flag support depends on your host OS and CPU.

Use virsh capabilities to list the virtualization capabilities of your host OS
and CPU.

--cpu cpu-model, cpu-flags

Allocate the number of vCPUs for the Policy Enforcer VM.--vcpus number

Specify disk storage media and size for the VM. Include the following
options:

• size=gigabytes

• device=disk

• bus=ide

• format=qcow2

--disk path

Configure the guest OS type and variant.--os-type os-type

--os-variant os-type

Create and boot the Policy Enforcer VM from an existing image.--import

The following example creates a Policy Enforcer VM with 8192 MB RAM, 1 vCPUs, and disk storage
up to 120 GB:

hostOS# virt-install --name vPEM --ram 8192 --cpu SandyBridge,+vmx,-invtsc --vcpus=1
--arch=x86_64 --disk path=/mnt/pe.qcow2,size=120,device=disk,bus=ide,format=qcow2 --os-type
linux --os-variant rhel6 --import

Configuring Policy Enforcer Settings

By default, when you create the Policy Enforcer VM through virt-manager or virt-install, the console
window appears for you to set up and configure the Policy Enforcer settings. You can open the console
at any time after the initial configuration to review or edit your settings.
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To configure Policy Enforcer settings:

1. Log in to your virtual machine using root and abc123 as the username and password, respectively. You
will be required to change the password at a later step.

The welcome page appears.

2. Click OK.

The End User License Agreement (EULA) window appears.

3. Click Accept to acknowledge the EULA. If you do not agree with the EULA, click Cancel. Your
configuration will stop and you will return to the main vSphere Client page.

The Network configuration page appears. See Figure 99 on page 1134.

Figure 99: Defining the Basic Network Configuration Settings

4. Enter the following configuration information.

DescriptionOption

Enter the hostname for the Policy Enforcer virtual machine; for example,
pe.juniper.net.

Hostname

Enter the IP address for the Policy Enforcer virtual machine.

NOTE: Make note of this IP address as you’ll need it in a later step.

IP address

Enter the netmask for the Policy Enforcer virtual machine.Network mask
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DescriptionOption

Enter the IP address of the default gateway that connects your internal network
to external networks.

Default gateway

Enter the IP address of your primary system registered to join theDomainName
System (DNS).

Primary DNS server

Enter the IP address of a secondary DNS server. Policy Enforcer uses this
address only when the primary DNS server is unavailable.

Secondary DNS server

Select this check box if you do not want to check basic network settings. By
default, the system will ping the gateway to ensure it receives a response
indicating your settings are correct.

Skip DNS servers check

5. Click Apply Changes.

Your network settings are applied. A progress window indicates the status.

When the system is finished updating your network settings, an NTP server window appears and
prompts you to configure the NTP server list. See Figure 100 on page 1135.

Figure 100: Prompt for Configuring the NTP Servers

6. Click Yes to customize the NTP server list. Click No to use the default list of 0, 1, 2 and
3.centos.pool.ntp.org.

7. (Optional) Specify theNTP servers to use. See Figure 101 on page 1136. ClickApply Changes to accept
your edits, Clear All to clear all fields in this window, or Cancel to discard any edits and continue to the
next step.
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Figure 101: Configuring the NTP Servers

8. The Root password change page appears. See Figure 102 on page 1136.

Figure 102: Changing the Root Password

9. Enter and re-enter a new administrator password for the Policy Enforcer virtual machine.

Password restrictions are listed in the screen.

NOTE: Make note of this password as you’ll need it in a later step.

If you forget your password, see CentOS root password reset instructions.
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10.Click OK.

The Juniper Networks Policy Enforcer page appears. See Figure 103 on page 1137.

Figure 103: Reviewing and Changing Your Configuration Settings

11. Select one of the options and press Enter.

DescriptionOption

Lets you review the configuration settings you defined one last time before
applying them to the Policy Enforcer virtual machine.

We recommend that you do not change your configuration settings after
Policy Enforcer is set up within Security Director.

Review configuration and finish
setup

Select a setting to update its value.Change...

Lets you ping the default gateway and custom IP address and lets you perform
a DNS lookup to verify that your settings are correct.

Troubleshooting menu

The Review configuration page appears. See Figure 104 on page 1138.

1137



Figure 104: Reviewing Your Configuration Settings

12.Review your configuration settings and click Finish setup. To change any of the settings, click Change
configuration.

When you click Finish setup, the configuration settings are applied to the Policy Enforcer virtual machine.
A status page indicates the progress.

When done, the Setup Complete page appears.

13.Click Finish to return to the main vSphere Client page.
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NOTE: Each time you log in to the Policy Enforcer virtual machine, you are given the option
to review or change any of these settings.

Connecting to the KVMManagement Console

By default, when you create the Policy Enforcer VM the console window appears for you to set up and
configure the Policy Enforcer settings. You can open the console at any time after the initial configuration
to review or edit your settings. To do this, you must have the virt-manager package or virsh installed on
your host OS.

To connect to the Policy Enforcer console using virt-manager:

1. Launch virt-manager.

2. Highlight the Policy Enforcer VM you want to connect to from the list of VMs displayed.

3. Click Open.

4. Select View>Text Consoles>Serial 1. The Policy Enforcer console appears.

To connect to the Policy Enforcer console with virsh:

1. Use the virsh console command on the Linux host OS. For example:

user@host# virsh console PE-kvm-2
Connected to domain PE-kvm-2

2. The Policy Enforcer console appears.
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Policy Enforcer Ports

You will need to open ports for Policy Enforcer to communicate with other products and devices.
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Table 358 on page 1140 lists the ports that Policy Enforcer uses to communicate with Security Director.

Table 358: Policy Enforcer Ports to Communicate with Security Director

OutInPortProtocolService

X8080TCPHTTPS

X443TCPHTTPS

Table 359 on page 1140 lists the ports that Policy Enforcer uses to communicate with SRX Series Devices.

Table 359: Policy Enforcer Ports to Communicate with SRX Series Devices

OutInPortProtocolService

X443TCPHTTPS

Table 360 on page 1140 lists the ports that Policy Enforcer uses to communicatewith the Juniper ATPCloud
server to download feeds.

NOTE: Connectivity between Juniper ATP Cloud and Policy Enforcer is certificate-based. Once
the trust is established, every request is within a context of valid token.

Table 360: Policy Enforcer Ports to Communicate with cloudfeeds.sky.junipersecurity.net

OutInPortProtocolService

X443TCPHTTPS

Table 361 on page 1140 lists the remaining Policy Enforcer services.

Table 361: Policy Enforcer Services

CommentsService

Used for basic network connection.DNS

Used to synchronize system clocks with the Network Time Protocol (NTP).NTP

If you are using NSX with Policy Enforcer (or Security Director), the following ports must be opened on
NSX.
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Table 362: NSX Ports

CommentsOutInPort

Used for communication between NSX and Security Director.X443

Used for outbound SSH based auto discovery of devices.X7804

Used for host management and image upload over sftp.X22
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Identifying the Policy Enforcer Virtual Machine In Security Director

You must identify the Policy Enforcer virtual machine in Security Director so that they can communicate
with each other. To do so, follow these steps:

1. Log in to Security Director and select Administration > PE Settings.

2. Enter the IP address of the Policy Enforcer virtual machine and the root password and click OK.

3. Select a Threat Prevention Type:

• ATPCloudwith PE—All Juniper Connected Security features and threat prevention types are available.

NOTE: If you upgrade from cloud feeds or ATPCloud, you cannot roll back again. Upgrading
resets all devices previously participating in threat prevention. Use the setup wizard to
expedite the process configuring threat prevention policies.

• ATP Cloud—All threat prevention types are available: Command and control server, Geo IP, and
Infected hosts.
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NOTE: If you upgrade from cloud feeds only to ATP Cloud, you cannot roll back again.
Upgrading resets all devices previously participating in threat prevention, and you must
re-enroll them with ATP Cloud. Use the setup wizard to expedite the process configuring
threat prevention policies.

• Cloud Feeds only—Command and control server and Geo IP are the only threat prevention types
available.

For more information on these threat prevention types, see “Policy Enforcer Settings” on page 1149.

If you change the Policy Enforcer VM password (see Deploying and Configuring the Policy Enforcer
Virtual Machine), the Policy Enforcer VM still communicates with Security Director even if you do not
update the Policy Enforcer password in the Administration > PE Settingswindow in Security Director.
You can, however, update the information in the PE Settings page with the new password to keep your
credentials consistent.
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Obtaining a Juniper ATP Cloud License

Contact your local sales office or a Juniper Networks partner to place an order for a Juniper ATP Cloud
premium license. Once the order is complete, an authorization code is e-mailed to you. You will use this
code in conjunction with your SRX Series device serial number to generate a premium license entitlement.
(Use the show chassis hardware CLI command to find the serial number of the SRX Series device.)

To obtain a Juniper ATP Cloud premium or basic license, follow these steps:

1. Go to https://www.juniper.net/generate_license/ and log in with your Juniper Networks Customer
Support Center (CSC) credentials.

2. In the Generate Licenses list, select J Series Service Routers and SRX Series Devices.
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3. Using your authorization code and SRX Series serial number, follow the instructions to generate your
license key. (Note that you do not enter this license key anywhere.)

Once generated, your license key is automatically transferred to the cloud server. It can take up to 24
hours for your activation to be updated in the Juniper ATP Cloud cloud server

The free version does not require you to generate a license. The SRX Series device only needs to be enrolled
to the cloud, and it will automatically be entitled to the free version.

Unlike with physical SRX Series devices, you must install Juniper ATP Cloud premium licenses onto your
vSRX instances. Installing the Juniper ATP Cloud license follows the same procedure as withmost standard
vSRX licenses. For more information on installing the Juniper ATP Cloud license onto your vSRX instance,
see the LicenseManagement and vSRXDeployments sectionwithinManaging theAdvanced Threat Prevention
Cloud License.
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Creating a Juniper ATP Cloud Web Portal Login Account

To create a Juniper ATP Cloud account, youmust first have a Customer Support Center (CSC) user account.
For more information, see Creating a User Account. If you forget to do this step, you will be reminded
during the quick setup.

1. Go to https://sky.junipersecurity.net and select your region. On the next screen, clickCreate a security
realm.

2. Enter the following required information and continue to click Next until you are finished:

• Your single sign-on or Juniper Networks CSC credentials.

• A security realm name — for example, Juniper-Mktg-Sunnyvale. Realm names can only contain
alphanumeric characters and the dash (“-”) symbol.

• Your contact information.

• An e-mail address and password. This will be your login information to access the Juniper ATP Cloud
management interface.

1143

http://www.juniper.net/documentation/en_US/release-independent/sky-atp/topics/topic-map/sky-atp-license-mgmt.html
http://www.juniper.net/documentation/en_US/release-independent/sky-atp/topics/topic-map/sky-atp-license-mgmt.html
https://www.juniper.net/support/Set_Up_Account_Overview.pdf
https://sky.junipersecurity.net


3. When you click Finish, you are automatically logged in and taken to the Juniper ATP Cloud Web UI
dashboard.

RELATED DOCUMENTATION

Loading a Root CA | 1144

Using Guided Setup for Juniper ATP Cloud with Juniper Connected Security | 1224

Using Guided Setup for Juniper ATP Cloud | 1230

Loading a Root CA

After the Policy Enforcer virtual machine is configured and created and before creating any ATP policy,
you must set up certificates on any Juniper ATP Cloud-supported SRX Series device. For a list of Juniper
ATP Cloud- supported devices, see Juniper ATP Cloud Supported Platforms Guide.

NOTE: The following is simply an example. You will need to modify the group name, profile and
policy name to match your configuration.

To set up certificates for Policy Enforcer:

1. Create the CA profile using the following CLI command. A CA profile configuration contains information
specific to a CA.

root@host# request security pki generate-key-pair certificate-id ssl-inspect-ca size 2048 type rsa
root@host# request security pki local-certificate generate-self-signed certificate-id ssl-inspect-ca
domain-name www.juniper.net subject "CN=www.juniper.net,OU=IT,O=Juniper
Networks,L=Sunnyvale,ST=CA,C=US" email security-admin@juniper.net

2. Configure the CA profile.

NOTE: The CA profile name must be policyEnforcer.

root@host# set security pki policyEnforcer ssl-inspect-ca ca-identity ssl-inspect-ca
root@host# set security pki ca-profile policyEnforcer ca-identity ssl-profile-ca
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3. Load the default trusted CA.

root@host# request security pki ca-certificate ca-profile-group load ca-group-nameAll-Trusted-CA-Def
filename default

4. Enable HTTPS on the threat prevention policy.

When creating your threat prevention policy (in Security Director, selectConfigure>Threat Prevention
> Policy), enable the Scan HTTPS option to scan files downloaded over HTTPS. For more information
on creating threat prevention policies, see the Security Director online help.

When you enable HTTPS on the threat prevention policy, Policy Enforcer sends the following
configuration to the devices:

##Security Firewall Policy : trust - untrust##

set security policies from-zone trust to-zone untrust policy 

PolicyEnforcer-Rule1-1 then permit application-services ssl-proxy profile-name

 policyEnforcer

##Security Firewall Policy : global ##

set security policies global policy PolicyEnforcer-Rule1-1 then permit 

application-services ssl-proxy profile-name policyEnforcer

##SSL Forward proxy Profile Configurations##

set services ssl proxy profile policyEnforcer trusted-ca all

set services ssl proxy profile policyEnforcer root-ca ssl-inspect-ca

5. Export the locally generated certificate from the SRX Series device and install it on clients as a trusted
CA to avoid some of the certificate errors that may occur.

Each website or browser behaves slightly different. Some require exceptions to be added to your
browser to display the content while others may not work because the local certificate is weak.

root@host# request security pki local-certificate export certificate-id 

ssl-inspect-ca type pem filename ssl-inspect-ca.pem

6. (Optional) You can limit some certificate warning messages using the following CLI command:

root@host# set services ssl proxy profile policyEnforcer actions 

ignore-server-auth-failure
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Upgrading Your Policy Enforcer Software

To upgrade to the latest release of Policy Enforcer, download and run the rpm file available from Juniper
Network’s software download page. You must have a version of Policy Enforcer already installed to run
the upgrade script. If you do not, download the latest software version from the Policy Enforcer software
download page and follow the Policy Enforcer Installation Overview instructions.

NOTE: You can upgrade only from the previous release. For example, you can upgrade from
16.1R1 to 16.1R2 or from 16.1R2 to 17.1. You cannot skip a release. For example, upgrading
from 16.1R1 to 17.1R1 is not supported.

To upgrade your Policy Enforcer software to the latest release:

1. Access the Policy Enforcer software download page

https://www.juniper.net/support/downloads/?p=sdpe

2. Select the Software tab.

3. From the Version drop-down menu, select the version you want to install.

4. From under the Application Package heading, download the Policy Enforcer RPM to your Policy Enforcer
virtual appliance.

5. On your Policy Enforcer virtual appliance, change directory to where you downloaded the RPM bundle
and install it using the following command:

[root@hostname~]# rpm -Uvh filename.rpm

For example:
[root@hostname~]# rpm -Uvh Policy_Enforcer-21.2R1-XXXX-PE-Upgrade.rpm

It may take a few minutes to install the RPM bundle. Once installed, the Policy Enforcer screens within
Security Director and any schema changes are updated. The configuration settings you used when you
deployed the Policy Enforcer VM are retained.

To verify your upgrade:

• In Security Director, select Administration > PE settings. This page shows the current installed Policy
Enforcer version number.

• Check the log file for any errors.
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• (Upgrading from16.1R1 to 16.2R1) Check the /var/log/pe_upgrade.log file for any errors. The following
is an example output of the pe_upgrade.log file for a successful upgrade.

Location: /var/log/pe_upgrade.log

Update text:

Preparing...                ########################################### [100%]

   1:Policy_Enforcer        ########################################### [100%]

Upgrading..

root

Stopping services

Service: feed_scheduler

Stopping service…

Service stopped

Service: feed_server

Stopping service…

Service stopped

Service: config_server

Stopping service…

Service stopped

Extracting spotlight-connector package

Extracting security-common-lib package

Executing sql table

Copying spotlight-connector package

Copying security-common-lib package

Starting services

Service: config_server

Starting service…

Service started

Service: feed_server

Starting service…

Service started

Service: feed_scheduler

Starting service…

Service started

root

Done.

• (Upgrading from 17.1R1 to 17.2R1) Check the following log files for errors:

• /var/log/pe_upgrade_17_2.log

• /var/log/pe_upgade_17_2_3rd_party_adapter.log

• /var/log/pe_upgrade_nsx.log
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NSXMigration Instructions from Policy Enforcer Release 17.1R1 to 17.2R1

After successfully upgrading to Policy Enforcer Release 17.2R1 and when all the Policy Enforcer services
and NSX micro service are up and running, the administrator must run the nsxmicro_sdsn_migrate script
manually. After the successful installation of the script, the Juniper Connected Security resources such as
Connector instance, Secure Fabric, and Policy Enforcement Groups (PEG) are created for theNSXManagers
that are already discovered in Security Director.

If the Juniper Connected Security resources are already present in the upgraded version of the software,
a message is displayed showing that the NSX Manager with Juniper Connected Security resources are
already present in the NSX database.
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Policy Enforcer Installation Overview | 1122

1148



CHAPTER 99

Configuring Policy Enforcer Settings and Connectors
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Policy Enforcer Settings

To configure your Policy Enforcer, perform the following actions.

Before You Begin

• Policy Enforcer Release version and Security Director Release version must be compatible. The Settings
page shows the current release version of Policy Enforcer. If there is an incompatibility, an errormessage
is shown that there is a mismatch between Security Director and Policy Enforcer release versions. To
know more about the supported software versions, see Policy Enforcer Release Notes.

You cannot proceed further if the Policy Enforcer and Security Director Release versions are incompatible.

• A valid Policy Enforcer VMpassword is required to have a fully functional Policy Enforcer. If the password
is valid, a message is shown at the top of the Settings page that the Policy Enforcer Space user (pe_user)
password is currently valid and the date by when the password expires. The pe_user has the same
capabilities as the super user.
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If the password is invalid, an error message is shown at the top of the Settings page. To fix this issue,
login to the Policy Enforcer VM, change the root password, and then enter the new root password in
the Settings page.

• Policy Enforcer with Security Director can be used in four different configuration types. For each
configuration type, certain features are available. Read the following topic: “Juniper ATP Cloud
Configuration TypeOverview” on page 1113 before youmake a Juniper ATPCloud or Juniper Advanced
Threat Prevention (JATP) Configuration Type selection on the Policy Enforcer Settings page.

• If you are using Juniper ATP Cloud or JATP without Juniper Connected Security or Cloud Feeds only,
you must still download Policy Enforcer and create a policy enforcer virtual machine.

• Juniper ATP Cloud license and account are needed for three of the configuration types (Juniper ATP
Cloud or JATP with Juniper Connected Security, Juniper ATP Cloud or JATP, and Cloud Feeds only), but
not for the default mode (No Selection). If you do not have a Juniper ATP Cloud license, contact your
local sales office or Juniper Networks partner to place an order for a Juniper ATPCloud premium license.
If you do not have a Juniper ATP Cloud account, when you configure Juniper ATP Cloud, you are
redirected to the Juniper ATPCloud server to create one. Please obtain a license before you try to create
a Juniper ATPCloud account. Refer to “Policy Enforcer InstallationOverview” on page 1122 for instructions
on obtaining a Juniper ATP Cloud premium license.

To set up ATP Cloud or JATP Configuration Type, you must do the following:

1. Select Security Director>Administration>Policy enforcer>Settings.

2. Enter the IP address for the policy enforcer virtual machine. (This is the IP address you configured
during the PE VM installation. You can locate this IP address in the vSphere Center portal.)

3. Enter the password for the policy enforcer virtual machine. (This is the same password you use to login
to the VM with your root credentials. Note that the username defaults to root )

NOTE: Refer to “Deploying and Configuring the Policy Enforcer withOVA files” on page 1124
for instructions on downloading Policy Enforcer and creating your policy enforcer virtual
machine.

4. To operate in certificate-based authentication mode, enable the Certificate Based Authentication
option. You must browse and upload x509 certificate file and x509 certificate key file. The Certificate
Based Authentication field is useful for seamless operation when Junos Space Network Management
Platform user switches to certificate-based authentication mode.

When you configure Policy Enforcer, pe_user is automatically created with a username and password.
However, by default, certificate-based authentication is disabled. If youwant to log in to Policy Enforcer
seamlessly when Junos Space Network Management Platform user switches to certificate based
authentication mode, then you must enable the Certificate Based authentication field.
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When Junos Space NetworkManagement Platform user changes from password based authentication
mode to certificate based authentication mode, and if you have not enabled the certificate based
authentication on the Settings page, an error message is displayed while logging in to Policy Enforcer.
The pe_user can no longer operate using password-based authentication.

After uploading the certificates on the Settings Page, navigate to Junos Space Network Management
Platform User>Role Based Access control>User Accounts. Right Click the pe_user and selectModify
User. You can view the certificate uploaded for the pe_user.

For more information about certificate-based authentication or certificate parameter–based
authentication in Junos SpaceNetworkManagement Platform, see CertificateManagementOverview.

5. Select ATPCloud Configuration Type. If you do not select a type, Policy Enforcer works in defaultmode.
(See “Juniper ATP Cloud Configuration Type Overview” on page 1113 for more information.)

Refer Table 363 on page 1151 to understand the supported threat prevention types for different Policy
Enforcer modes:

Table 363: Supported Threat Prevention Types for Different PE Modes

ATP Cloud or JATP
with Juniper
Connected Security

ATP Cloud or
JATP

Cloud Feeds
Only

No Selection
(Default)Threat Prevention Type

YesYesYesYesCustom feeds

YesYesYesYesCommand and Control (C&C) feeds

YesYesYes-Infected Host feed

YesYes--Malware inspection

Yes---Enforcement on EX Series and QFX
Series switches or using 3rd party
Connectors

You cannot change or modify a higher configuration to a basic mode. For example, you cannot change:

• Juniper ATP Cloud or JATP ->Cloud feeds only

• Juniper ATP Cloud or JATP with Juniper Connected Security ->Cloud feeds only

• Juniper ATP Cloud or JATP ->No Selection (Default)

WARNING: If you change to a lower mode, you must reinstall Security Director
and Policy Enforcer.
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However, you can change or modify your configuration to a higher mode. For example you can change:

• Cloud feeds only-> Juniper ATP Cloud or JATP

• Cloud feeds only ->Juniper ATP Cloud with Juniper Connected Security

• Juniper ATP Cloud or JATP -> Juniper ATP Cloud with Juniper Connected Security

6. Polling timers affect how often the system polls to discover endpoints. There are two polling timers,
one that polls network wide and one that polls site wide. They each have default settings, but you can
change those defaults to poll more or less often.

• Network wide polling interval (value in hours): The default is 24 hours. You can set this range from
between 1 to 48 hours. This timer polls all endpoints added to the secure fabric.

• Site wide polling interval (value in minutes): The default is 5 minutes. You can set this range from 1
minute to 60 minutes. This timer polls infected endpoints moving within the sites that are a part of
Secure fabric.

7. Click Enable Feeds Purge to enable the purge option. You can purge the feeds that are older than a
specified number of days.

8. The Purge History determines the number of days you can preserve the history of the feeds in Policy
Enforcer. You can set a range between 300 to 600 days. The default is 365 days.

The purge job runs every day at 12:00 PM and makes sure that the data set on the purge history is
maintained.

9. Click the Download button to view or save Policy Enforcer data logs to your local system. These logs
are in a compressed file format.

RELATED DOCUMENTATION

Comparing the Juniper Connected Security and non-Juniper Connected Security Configuration
Steps | 1120

Using Guided Setup for Juniper ATP Cloud with Juniper Connected Security | 1224

Using Guided Setup for Juniper ATP Cloud | 1230

Configuring Cloud Feeds Only | 1246

Using Guided Setup for No Juniper ATP Cloud (No Selection) | 1234
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Policy Enforcer Connector Overview

Configure a connector for third-party products (non-Juniper Networks) to unify policy enforcement across
all network elements. This protects endpoints, wired and wireless, connecting to third-party devices as
well as Juniper devices.

For Policy Enforcer to provide threat remediation to endpoints connecting through third-party devices, it
must be able to authenticate those devices and determine their state. It does this using a tracking and
accounting threat remediation plug-in to gather information from a RADIUS server and enforce policies
such as terminate session and quarantine.

NOTE: All third-party switches being usedwith Policy Enforcer must support AAA/RADIUS and
Dynamic Authorization Extensions to RADIUS protocol (RFC 3579 and RFC 5176).

NOTE: All Cisco Systems switchmodels that adhere to Radius IETF attributes and support Radius
Change of Authorization from Aruba ClearPass are supported by Policy Enforcer for threat
remediation.

Once configured, the connector uses an API to gather endpointMAC address information from the RADIUS
server. If a host is found to be suspicious, the RADIUS server sends a CoA to disconnect the active session
and quarantine the host. Once the threat has beenmitigated, the interface can return to the network again,
but must be authorized to do so by Policy Enforcer using the plug-in and information gathered from the
RADIUS server.

Once you have a connector configured, the following information is provided on the Connectors main
page.

Table 364: Connectors Information- Main Page

DescriptionField

The name you entered for the connector.Name

This field always reads Third Party Switch at this time.Type
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Table 364: Connectors Information- Main Page (continued)

DescriptionField

The current status of the connector. (Active or Inactive.)

Hover over the status to see more details of connector instances and their respective status.

The following statuses are shown:

• Active status with green icon—All connector instances inside a connector are active

• Inactive status with red icon—All connector instances inside a connector are inactive

• Active status with red icon—One of the connectors is inactive and other connectors are
active.

• In progress status with green icon—All connectors are still in progress.

• Pending (not in progress) status with green icon—All connectors are still pending.

Status

Specifies the description of a connector.Description

Specifies the IP address of the product management server.Identity Server

The IP address of the ClearPass RADIUS server.IP Address

Benefits of Policy Enforcer Connector

• Custom threat feed and automation - Automates the threat remediation workflows for third-party
products.

• RESTful APIs - Provides a network vendor agnostic mechanism for threat remediation. Enables you to
automate configuration and management of physical, logical, or virtual devices.

RELATED DOCUMENTATION

ClearPass Configuration for Third-Party Plug-in | 1184

Cisco ISE Configuration for Third-Party Plug-in | 1191

Creating a Policy Enforcer Connector for Third-Party Switches | 1165

Creating a Policy Enforcer Connector for Public and Private Clouds

Perform the following actions to configure connectors for the public and private clouds.
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Before You Begin

• For Amazon Web Services (AWS) connector:

• Create access key and password for your AWS account. This will be a unique username and password
for your Amazon account required to create a connector. See Managing Access Keys for Your AWS
Account.

• Create Virtual Private Clouds(VPC) for the required region. See Getting Started With Amazon VPC.

• Instantiate the vSRX instance in the required VPC and set the tag identifier, for example
AWS_SDSN_VSRX. This tag identifier must match with the vSRX instance tag key in AWS.

• Create a Security Group in AWS required to create a threat prevention policy for the AWS connector.

• Deploy workloads in the required VPC and set the resource tags to the workloads.

• For Microsoft Azure connector:

• Get started with Microsoft Azure. See Getting Started With Microsoft Azure.

• Create tenant ID for you Azure account. SeeManaging Access Keys for YourMicrosoft Azure Account.

To configure threat remediation for a public or private cloud, you must install and register the threat
remediation plug-in with Policy Enforcer as follows:

1. Select Administration > Policy Enforcer > Connectors.

The Connectors page appears.

2. Click the create icon (+).

The Create Connector page appears.

3. Complete the configuration using the information in Table 365 on page 1155.

4. Click OK.

NOTE: Once configured, you select the connector name as an Enforcement Point in your
Secure Fabric.

Table 365: Fields on the Create Connector Page for AWS and Contrail

DescriptionField

General
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Table 365: Fields on the Create Connector Page for AWS and Contrail (continued)

DescriptionField

Enter a unique string thatmust beginwith an alphanumeric
character and can include underscores; no spaces allowed;
63 characters maximum.

Name

Enter a description; maximum length is 1024 characters.
You should make this description as useful as possible for
all administrators.

Description

Select AmazonWeb Services, Contrail, orMicrosoft Azure
from the list to connect to your secure fabric and create
policies for this network.

Connector Type

Enter the IP (IPv4 or IPv6) address or URL of AWS,
Contrail, or Microsoft Azure.

For AWS, this field is set to www.aws.amazon.com, by
default. This is where all VPCs are located. You cannot
edit this field.

For Microsoft Azure, this field is set to
management.azure.com, by default. This is where all virtual
networks are located. You cannot edit this field.

IP Address/URL

For AWS and Microsoft Azure connectors, the port is set
to 443 by default and you cannot edit this field.

For Contrail connector, provide the port number as 8081.

Port

Enter the username of the server for the selected
connector type.

For AWS, enter the generated access key for your Amazon
account. This is not same as your Amazon account
username.

Username

Enter the password for the selected connector type.

For AWS, enter your secret password generated along
with your access key. This is not same password as your
amazon account.

Password

Enter the Azure subscription ID available per tenant basis.Subscription ID

(only for Microsoft Azure connector)
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Table 365: Fields on the Create Connector Page for AWS and Contrail (continued)

DescriptionField

Enter the Microsoft Azure tenant ID.Tenant ID

(only for Microsoft Azure connector)

Network Details

One ormore virtual networks under the AWS account are
discovered. They are called virtual private cloud (VPC).
Only VPCs having vSRX instances deployed aremanaged.
The VPCs are region specific. Select a region from the
Region list and the corresponding VPCs are listed. By
default, the VPCs for the first available region are listed.

Security Director suggests a default Secure Fabric site
name for the VPC, in the <connector name>_<vpc
name>_site format. Click the Secure Fabric site name to
edit it.When you edit the name, youwill also see the other
Secure Fabric sites that do not have any switches or
connectors assigned to them. You can also assign these
Secure Fabric sites to the connectors. If the edited site
name is already existing with a connector or a switch, an
alert message is shown and the Secure Fabric site name
is reverted to its previous name.

You must enable either Threat Remediation or Next
Generation Firewall options or both. You cannot create a
connector instance without enabling at least one option.
If you navigate to the next page without enabling these
options, an error message is shown insisting the user to
enable either Threat Remediation or Next Generation
Firewall to proceed further.

You can get a detailed view of the VPC by hovering over
the name and clicking theDetailed View icon. See “Viewing
VPC or Projects Details” on page 1172.

NOTE: You can perform search on VPCs. Search is not
supported for the site names.

Connector Type: AWS

Virtual Private Clouds

1157



Table 365: Fields on the Create Connector Page for AWS and Contrail (continued)

DescriptionField

One or more virtual networks under the Microsoft Azure
account are discovered. These virtual networks are based
on the Azure subscription per tenant basis. A tenant can
havemore than one subscription and a single subscription
can contain one or more virtual networks.

Security Director suggests a default site name for the
project, in the <connector name>_<virtual network
name>_site format. Click the site name to edit it. When
you edit the site name, you will also see the other sites
that do not have any switches or connectors assigned to
them. You can also assign these sites to the connectors.
If the edited site name is already existing with a connector
or a switch, an alert message is shown and the site name
is reverted to its previous name.

You must enable either Threat Remediation or Next
Generation Firewall options or both. You cannot create a
connector instance without enabling at least one of the
two options. If you navigate to the next page without
enabling these options, an errormessage is shown insisting
the user to enable either Threat Remediation or Next
Generation Firewall to proceed further.

You can get a detailed view of the virtual network by
hovering over the name and clicking the Detailed View
icon.

Connector Type: Microsoft Azure

Virtual Networks
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Table 365: Fields on the Create Connector Page for AWS and Contrail (continued)

DescriptionField

Tenant information determined from the Contrail
connector is listed.

Security Director suggests a default site name for the
project, in the <connector name>_<project name>_site
format. Click the site name to edit it. When you edit the
site name, you will also see the other sites that do not
have any switches or connectors assigned to them. You
can also assign these sites to the connectors. If the edited
site name is already existing with a connector or a switch,
an alert message is shown and the site name is reverted
to its previous name.

You must enable either Threat Remediation or Next
Generation Firewall options or both. You cannot create a
connector instance without enabling at least one of the
two options. If you navigate to the next page without
enabling these options, an errormessage is shown insisting
the user to enable either Threat Remediation or Next
Generation Firewall to proceed further.

You can get a detailed view of the project by hovering
over the name and clicking the Detailed View icon. See
“Viewing VPC or Projects Details” on page 1172.

NOTE: You can perform search on Project names. Search
is not supported for the site names.

Connector Type: Contrail

Project

The subnet information for Contrail, Microsoft Azure, and
AWS is determined from the respective systems. For AWS
and Microsoft Azure, subnets are the availability zones
and for Contrail, subnets are virtual networks. You can
create Policy Enforcement Groups for one or more of the
subnets, if threat remediation is selected.

Subnets for AWS, Microsoft Azure, and Contrail are
allocated to bewithin the tenant IP AddressManagement
(IPAM) scheme.

Subnets

Configuration
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Table 365: Fields on the Create Connector Page for AWS and Contrail (continued)

DescriptionField

Configuration
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Table 365: Fields on the Create Connector Page for AWS and Contrail (continued)

DescriptionField

Metadata

Specifies the resource tag information and the resource
tag values that you have determined from the projects or
VPC. The tag information appears only if the Next
Generation Firewall option is enabled.

For AWS and Microsoft Azure connector, the resource
tag values are fetched fromAWS andMicrosoft Azure for
all the endpoints and then mapped them to the Security
Director generated metadata names.

Based on the resource tag name, Security Director checks
if a metadata with the same resource tag name is already
available. If available, it automatically maps the resource
tag name to its metadata. If there is no match found,
Security Director suggests a new metadata name for the
corresponding tag. The suggestedmetadata name is same
as the resource tag name. You can also edit the suggested
metadata name and customize the resource tag name.

However, in the GeneratedMetaData Name column, you
cannot use the following predefined metadata names:

• Tenant

• Provider

• Controller

If you provide these names, an appropriate error message
is shown to choose a different name.

Select the Map option to map the resource tag to the
generated Security Director Metadata while creating the
connector instance. If the Map option is not selected, the
connector instance is created for a project or VPCwithout
any resource tags. For example, if you have multiple
resource tags for a project, you can choose one or more
resource tags to map to the corresponding generated
metadata, by selecting the Import option. The project or
VPCwith the selected resource tags are createdwhen the
connector instance is created.

Mapping of Contrail, Microsoft Azure, andAWS connector
resource tags to Security Director metadata enables you
to create the next generation firewall policy definitions
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Table 365: Fields on the Create Connector Page for AWS and Contrail (continued)

DescriptionField

for the source and destination rules, based on the
metadata expressions. Policy Enforcer dynamically
determines thematching VM instances in AWS,Microsoft
Azure, or Contrail connector to the metadata expressions
and pushes the IP address content as dynamic address
groups to the enforcement points in the tenant specific
vSRX firewall instance.

In the Configuration Value column, provide any additional
information required for this particular connector
connection. For example, if the connector type is
ForeScout CounterACT, you are required to provide the
WebAPI username and password. Similarly for other
connectors if the additional configuration parameters are
required, they are listed in this column.

After the successful completion, the subnet you have
created is mapped to that particular connector instance.

For AWS and Microsoft Azure, provide the following
configuration parameters:

• SRX username—Specify the username of the vSRX
device that you have instantiated for a VPC or a virtual
network.

• SRX identifier tag—Specify the tag name of the vSRX
device, if the recommended vSRX name was not used.
If you do not specify any value for this field, Policy
Enforcer uses vSRX as a default tag name to identify the
device.

This enables discovery of this particular vSRX device in
Junos Space. This vSRX device is also added to a specific
secure fabric site.

• Infected Host Security Group—Specify the security
group name that you would want to tag an infected
workload for threat remediation.

• SRX authentication key—Specify the authentication key
file to access the vSRX device. Editing this in the grid
prompts you to either upload the authentication key
file or view an already existing uploaded authentication
key.
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Table 365: Fields on the Create Connector Page for AWS and Contrail (continued)

DescriptionField

For Contrail, provide the following configuration
parameters:

• SRX username

• SRX password

• Infected host security group

NOTE:
• For AWS, Microsoft Azure, and Contrail connectors, the site association is achieved in the
Connectors page itself.

• When a connector is added to the site, Policy Enforcer discovers the vSRX Series associated
with the connector and assigns it to the site. Hover over the connector name to view the
corresponding vSRX with its IP address as a tool tip.

• If the mode in PE Setting page is Juniper Connected Security with ATP Cloud, then you must
create ATP Cloud realm and assign the sites associated with the VPC or Project to the realm.
Otherwise the vSRX instances in the VPC or Project does not download the dynamic address
group objects, that is the list of workloads in the VPC or Project that match a policy metadata
expression.

Threat Remediation Workflow

Once you create an AWS, Microsoft Azure, or a Contrail connector with Threat Remediation option, a site
is created in the Secure Fabric page.

Perform the following actions for threat remediation:

1. Select Configure > Threat Prevention > ATP Cloud Realms.

Select the associated Secure Fabric sites to the respective VPC, virtual networks, or Project that is
successfully added. Add the secure fabric site to a Juniper ATP Cloud realm and enrol the vSRX devices
to the Juniper ATP Cloud. Enroll devices by clicking Add Devices in the list view once the realm is
created.

2. Select Configure > Shared Objects > Policy Enforcement Groups.

Click the add icon to create a new policy enforcement group. You will see a list of all subnets that you
have created in a VPC or virtual network. Select the required subnets for this VPC or a virtual network
and create a policy enforcement group. Associate this policy enforcement group to threat remediation
policy.
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3. Select Configure > Threat Prevention > Policies.

Click the add icon to create a new threat prevention policy. Add the threat prevention policy, including
profiles for one or more threat types. The security group that you had selected during connector
configuration is used when the host gets infected within a corresponding VPC or a virtual network.

Next Generation Firewall Workflow

When you create an AWS, Microsoft Azure, or a contrail connector with Next Generation Firewall option,
it means that for a particular VPC or a virtual network, Layer 7 firewall policy is enabled. Perform the
following actions to enable next generation firewall:

1. Select Configure > Firewall Policy.

2. Select the policy for which you want to define rules and click Add Rule.

The Create Rules page appears.

3. In the General tab, enter the name of the rule and description of the rule

4. In the Source tab, click Select for the Address(es) field to select the source address.

The Source Address page appears.

• In the Address Selection field, click By Metadata Filter option.

• In the Metadata Provider field, select PE as a provider from the list.

• In theMetadata Filter field, all the generatedmetadatas during the connector configuration are listed.
Using these metadatas, create a required metadata expression. For example, Application =Web and
Tier = App.

• In the Matched Addresses field, addresses matching the selected metadata are listed. This address
is used as a source address. For every metadata expression, a unique dynamic address group (DAG)
is created.

• Click Ok and complete configuring other parameters for the rule.

• Publish and update the configuration immediately or schedule it later.

RELATED DOCUMENTATION

Policy Enforcer Connector Overview | 1153

Editing and Deleting a Connector | 1169

Viewing VPC or Projects Details | 1172
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Creating a Policy Enforcer Connector for Third-Party Switches

Perform the following actions to create connectors for the third-party switches.

Before You Begin

• Have your ClearPass, Cisco ISE, ForeScout, Pulse Secure server information available.

• To obtain an evaluation copy of ForeScout CounterACT to use with Policy Enforcer, click here.

• Once configure, you select the Connector as an Enforcement Point in your Secure Fabric.

• Review the “Policy Enforcer Connector Overview” on page 1153 topic.

• To create a connector for a public or a private cloud, see “Creating a Policy Enforcer Connector for Public
and Private Clouds” on page 1154.

To configure threat remediation for third-party devices, youmust install and register the threat remediation
plug-in with Policy Enforcer as follows:

1. Select Administration > Policy Enforcer > Connectors.

The Connectors page appears.

2. Click the create icon (+).

The Create Connector page appears.

3. Complete the configuration using the information in Table 366 on page 1165.

4. Click OK.

NOTE: Once configured, you select the connector name as an Enforcement Point in your
Secure Fabric.

Table 366: Fields on the Create Connector Page

DescriptionField

General

Enter a unique string thatmust beginwith an alphanumeric
character and can include underscores; no spaces allowed;
63 characters maximum.

Name
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Table 366: Fields on the Create Connector Page (continued)

DescriptionField

Enter a description; maximum length is 1024 characters.
You should make this description as useful as possible for
all administrators.

Description

Select the required third-party network of devices to
connect to your secure fabric and create policies for this
network. The available connectors are Cisco ISE, HP
ClearPass, Pulse Secure, and ForeScout CounterACT.

Connector Type

Enter the IP (IPv4 or IPv6) address of the product
management server.

IP Address/URL

Select the port to be used from the list. When this is left
blank, port 443 is used as the default.

Port

Enter the username of the server for the selected
connector type.

• ClearPass—Enter the Client ID created while setting up
the ClearPass API client. See “ClearPass Configuration
for Third-Party Plug-in” on page 1184 for details.

• Cisco ISE—Enter the username you used when you
created the API Client in the Cisco ISE UI. See “Cisco
ISE Configuration for Third-Party Plug-in” on page 1191.

• ForeScout—Enter the username of your DEX plugin.
See “Integrating ForeScout CounterACT with Juniper
Networks Connected Security” on page 1174.

Username
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Table 366: Fields on the Create Connector Page (continued)

DescriptionField

Enter the password of the server for the selected
connector type.

• ClearPass—Enter the Client Secret string created while
setting up the ClearPass API client. See “ClearPass
Configuration for Third-Party Plug-in” on page 1184 for
details.

WARNING: When the Access Token Lifetime expires,
youmust generate a newClient Secret in ClearPass and
update it here too.

• Cisco ISE—Enter the password you used when you
created the API Client in the Cisco ISE UI. See “Cisco
ISE Configuration for Third-Party Plug-in” on page 1191
.

• ForeScout—Enter the password of your DEX plugin. See
“Integrating ForeScout CounterACT with Juniper
Networks Connected Security” on page 1174.

Password

Enter the Data Exchange (DEX) user role information to
authenticate and connect to the ForeScout connector.
See “Integrating ForeScout CounterACT with Juniper
Networks Connected Security” on page 1174.

DEX User Role

(For ForeScout connector type only)

Network Details
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Table 366: Fields on the Create Connector Page (continued)

DescriptionField

Connector Type:ClearPass, ForeScoutCounterACT, Pulse
Secure, and Cisco ISE

Add subnet information to the connector configuration
so you can include those subnets in groups and then apply
policies to the groups. When using Junos Space, Policy
Enforcer is able to dynamically discover subnets configured
on Juniper switches. Policy Enforcer does not have the
same insight with third-party devices.

When you add subnets as part of the connector
configuration, those subnets become selectable in Policy
Enforcement Groups.

To add subnet information, do one of the following:

• ClickUpload File to upload a text file with an IP address
list.

Note that the file you upload must contain only one
item per line (no commas or semi colons). All items are
validated before being added to the list.

OR

• Manually enter the IP addresses. For example:
192.168.0.1/24.

Click the add icon (+) to add more IP addresses.

NOTE: It is mandatory to add at least one IP subnet to a
connector. You cannot proceed to next step without
adding a subnet.

Subnets

Configuration

Provide any additional information required for this
particular connector connection. After the successful
completion, the subnet you have created is mapped to
that particular connector instance.

NOTE: For ClearPass and Cisco ISE connectors no
additional configuration information are required.

Configuration
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NOTE:
• You can associate ClearPass, Cisco ISE, Pulse Secure, or Forescout connector to a site only in
your Secure Fabric.

• When a connector is added to the site, Policy Enforcer discovers the vSRX Series associated
with the connector and assigns it to the site. Hover over the connector name to view the
corresponding vSRX with its IP address as a tool tip.

WARNING: Ensure that the correct credentials are provided for the ClearPass, Cisco
ISE, Pulse Secure, and ForeScout identity servers. If the initial connection fails, an error
message is shown only at that time. Once that message disappears, the status of
connectivity to the identity server is not shown in Policy Enforcer. Note that the identity
servers are only queried on-demand.

RELATED DOCUMENTATION

Policy Enforcer Connector Overview | 1153

ClearPass Configuration for Third-Party Plug-in | 1184

Cisco ISE Configuration for Third-Party Plug-in | 1191

Editing and Deleting a Connector | 1169

Viewing VPC or Projects Details | 1172

Editing and Deleting a Connector

IN THIS SECTION

Editing a Connector | 1170

Deleting a Connector | 1171

You can edit or delete a connector from the Connector page.
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Editing a Connector

To edit a connector:

1. Select Administration > Policy Enforcer > Connectors.

The Connectors page appears.

2. Select the connector you want to edit , and then click the pencil icon.

The Edit Connector page appears displaying the same options that were used to create a new connector.
Note that you cannot edit the Name and IP Address/URL fields.

For the AWS connector, when you select a new region, you must enter the configuration parameters
for the VPCs in that region. This enables you to maintain different vSRX authentication keys across
different regions.

For AWS and Contrail connectors, you can enable or disable the threat remediation and next generation
firewall features. If you disable the next generation firewall feature from a project or VPC, that particular
project or VPC connector instance will be deleted. The VPCs are deleted from the corresponding
regions.

A warning message is shown if you edit the existing generated metadata name. If you edit the existing
metadata name, duplicate metadata objects are created that are associated to a firewall policy. To edit
the metadata name, select Configure > Shared Objects > Object Metadata and edit the required
metadata name. Also if the firewall policies are associatedwith this metadata, selectConfigure > Firewall
Policy > Policies and edit the corresponding metadata expression.

To delete the mapping of the tag name with the generated metadata, disable the Map option for the
corresponding project or VPC. A warning message is shown that there could be a firewall policy
associated with this metadata. Select Configure > Firewall Policy > Policies and edit the corresponding
metadata expression. The mapping is deleted at the end of the edit workflow. You can also enable the
Import option for the tags thatwere notmapped to the generatedmetadatawhile creating the connector.

3. Modify the required field values and click Save to save your changes.

If you discover a new connector instance, you can enable the threat remediation or next generation firewall
option. A new site is created when you enable one of these options. You must add these new sites to a
realm to perform the threat remediation. At the end of the edit connector workflow, a reminder message
is shown to add the sites to a realm.
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NOTE:
• During the AWS connector editing, if you change the region, changes that you have made in
the current session are discarded. An alert message is shown when you change the region.

• During the ClearPass or Cisco ISE connector editing, you cannot delete subnets that are already
assigned to a policy enforcement group. However, you can add of any new subnets and edit
their descriptions.

Deleting a Connector

To delete a connector:

1. Select Administration > Policy Enforcer > Connectors.

The Connectors page appears.

2. Select the connector that you want to delete, and select the delete icon (X).

Deleting a connector deletes the connector instances and its references as well. A warning message is
shown listing all the connector instances that will be deleted, before deleting the connector.

3. Click Delete to delete your selection.

If the connector instances that you want to delete has PEG assigned, a warning message is shown to
unassign the subnets from PEG first and then delete the connector, as shown in Figure 105 on page 1171.

Figure 105: Deletion Failed Warning

For AWS and Contrail connectors, if there are connector instanceswith PEG assigned, only those connector
instances are not deleted. However, other connector instances without PEG assigned are deleted.
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NOTE:
• You cannot delete the ClearPass or Cisco ISE connector if its subnets are assigned to a policy
enforcement group. Youmust unassign those subnets from that particular policy enforcement
group and then delete the connector.

• You cannot delete a connector if it is assigned as an enforcement point to a site. Before deleting
a connector, you must unassign it from the site on Secure Fabric.

RELATED DOCUMENTATION

Policy Enforcer Connector Overview | 1153

Creating a Policy Enforcer Connector for Third-Party Switches | 1165

Viewing VPC or Projects Details

To view the complete details of a VPC or a project:

1. Select Administration > Policy Enforcer > Connectors.

The Connectors page appears.

2. Select the connector you want to edit , and then click the pencil icon.

The Edit Connector page appears displaying the same options that were used to create a new connector.

3. In the Network Details section, get a detailed view by hovering over the VPC or project name and click
the Detailed View icon before the VPC or project name.

The Detailed View page appears, as shown in Figure 106 on page 1173.
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Figure 106: Detailed View Page

Table 367 on page 1173 explains fields on the Detailed View page.

Table 367: Fields on the Detailed View Page

DescriptionField

Specifies name of a VPC or project.Name

Specifies the site to which the VPC or project s allocated.Secure Fabric

Specifies the connector type. For example, virtual network for Contrails and
AvailabilityZone for AWS.

Type/Zone

Specifies the IP Address Management (IPAM) subnets allocated to the respective VPC or
project.

IPAM Subnet

Specifies the group of subnets allocated to the VPC or project.

For Contrail, you will see a key value of Tier. For example, the group is called web and
assigned subnet is x.x.x.x/xx. For AWS, you will see only the group of subnets.

For Contrail, they are still group of subnets. However, each of the subnets are allocated
to a tag, for example, database, tier, application, and so on.

Group Subnets

RELATED DOCUMENTATION
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Integrating ForeScout CounterACT with Juniper Networks Connected
Security

IN THIS SECTION

Configuring the DEX Plug-in | 1174

Configuring the Web API Plug-in | 1178

Creating ForeScout CounterACT Connector in Security Director | 1180

This topic provides instructions on how to integrate the third-party device ForeScout CounterACT with
Juniper Networks Connected Security solution to remediate threats from infected hosts for enterprises.
ForeScout CounterACT is an agentless security appliance that dynamically identifies and evaluates network
endpoints and applications the instant they connect to your network. CounterACT applies an agentless
approach and integrates with Juniper Connected Security to block or quarantine infected hosts on Juniper
Networks’ devices, third-party switches, and wireless access controllers with or without 802.1x protocol
integration.

To integrate ForeScout CounterACT with Juniper Connected Security, you must create a connector in
Policy Enforcer that enables CounterACT to connect to your secure fabric and create policies for
CounterACT. Before you configure the ForeScout CounterACT connector, youmust ensure that ForeScout
CounterACT is installed and runningwith theOpen IntegrationModule (OIM). The ForeScout OIM consists
of two plug-ins: Data Exchange (DEX) and Web API. Install both the plug-ins and ensure that they are
running. You must configure these plug-ins before you create a connector in Policy Enforcer.

If you do not have ForeScout CounterACT installed in your network, obtain an evaluation copy from here.

This topic includes the following sections:

Configuring the DEX Plug-in

TheDEX plug-in receives API information about infected hosts from the ForeScout CounterACT connector.
Messages from infected hosts are either blocked or quarantined.
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When you configure the DEX plug-in, you also configure a new property, Test, for DEX.When configured,
this property ensures that Web services are available for Policy Enforcer, monitors the network status,
and validates usernames and passwords.

To configure the DEX plug-in:

1. Select Tools > Options > Data Exchange (DEX) in the CounterACT UI.

The Data Exchange configuration page appears.

2. On the Data Exchange (DEX) page, select the CounterACTWeb Services > Accounts tab, as shown in
Figure 107 on page 1175.

The DEX Accounts page appears.

Figure 107: DEX Accounts Page

3. Select Add.

The Add page appears.

4. In the Name field, enter the name for the CounterACT Web service account.

Enter this name in the DEX User Role field (see Step 3) while configuring the ForeScout connector in
Security Director.

5. In the Description field, enter a brief description of the purpose of the Web service account.
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6. In the Username field, enter the username that will be used to authorize CounterACT to access the
Web service account.

7. In the Password field, enter the password that will be used to authorize CounterACT to access this
Web service account.

8. Click OK.

9. In the Properties tab, click Add.

The General pane of the Add Property from CounterACT Web Service wizard opens, as shown in
Figure 108 on page 1176.

Figure 108: Add Property-General Pane Page

10.Add properties such as block, quarantine, and Test, as shown in Figure 109 on page 1177.
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Youmust include the Test property. Otherwise, you cannot add CounterACT as a third-party connector
to Policy Enforcer successfully.

Figure 109: DEX Properties Page

11. In the Security Settings tab, click Add and add the IP address range from where communication is
expected, as shown in Figure 110 on page 1177.

Figure 110: Add IP Range Page

Click OK. The IP address appears in the IP Address Range list, as shown in Figure 111 on page 1178.
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Figure 111: DEX Security Settings Page

12.On the Data Exchange (DEX) page, click Apply.

The configuration is saved and the configuration settings are applied.

Configuring the Web API Plug-in

The Web API plug-in enables external entities to communicate with CounterACT by using simple, yet
powerful Web service requests based on HTTP interaction. You configure the Web API plug-in to create
an account for Policy Enforcer integration.

To configure the Web API plug-in:

1. Select Tools > Options >Web API in the CounterACT UI.

The Web API page appears.

2. In the User Settings tab, select Add.

The Add Credentials page appears.

3. Use the same username and password that you created for the DEX configuration (see Step 6 and Step
7) and click OK, as shown in Figure 112 on page 1179.
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Figure 112: Web API User Settings Page

4. Select the Client IPs tab and click Add.

Add the Policy Enforcer IP address into the access list.

5. Click OK.

The IP address appears in the IP Address Range list, as shown in Figure 113 on page 1180.
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Figure 113: Web API Client IPs Page

6. Click Apply to save and apply your configuration.

Creating ForeScout CounterACT Connector in Security Director

After you configure the DEX and Web API plug-ins, you need to create a connector for ForeScout
CounterACT in Policy Enforcer.

To create a ForeScout CounterACT connector in Junos Space Security Director:

1. Select Security Director > Administration > Policy Enforcer > Connectors.

The Connectors page appears.

2. Click the create icon (+).

The Create Connector page appears.

3. In the General tab, select ForeScout CounterACT as the connector type and provide the username,
DEX user role, and password, as shown in Figure 114 on page 1181. ( The DEX user role is the one that
you created in Step 4).

Specify 443 as the port number for communication.
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Figure 114: Edit Connector Page

4. In the Network Details tab, configure the IP subnets, as shown in Figure 115 on page 1181.

CounterACT treats the IP subnets as endpoints and takes action.

Figure 115: Edit Connector - Network Details Page
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5. In the Configuration tab, specify the Web API username and password, as shown in
Figure 116 on page 1182.

Figure 116: ForeScout Connector - Configuration Tab

6. Click Finish.

A new ForeScout CounterACT connector is created.

7. Verify that the communication between Policy Enforcer and CounterACT is working.

After installing ForeScout CounterACT and configuring a connector, in the CounterACT UI, create policies
for CounterACT to take the necessary action on the infected hosts. The Hosts page lists compromised
hosts and their associated threat levels, as shown in Figure 117 on page 1183.
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Figure 117: Host Information

Table 368 on page 1183 shows the recommended actions performed by CounterACT on the infected hosts
that are blocked or quarantined.

Table 368: Recommended Action to Be Performed on the Infected Hosts

Action Performed by CounterACTConnection State
Infected Host Policy
Enforcer Action

Apply access control list (ACL) to block inbound and outbound
traffic for a specific MAC address.

WiredBlocked

Apply WLAN block on the endpoint, which will block the traffic
based on the wireless MAC address.

Wireless

Apply CoA.Dot1x

Apply VLAN. This action is specified by Policy Enforcer.WiredQuarantined

Apply VLAN. This action is specified by Policy Enforcer.Wireless

RELATED DOCUMENTATION
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ClearPass Configuration for Third-Party Plug-in

Policy Enforcer's ClearPass Connector communicateswith the Clearpass Radius server using the Clearpass
API. As part of threat remediation, Policy Enforcer's Clearpass Connector uses enforcement profiles. This
section provides information for configuring Clearpass so that Policy Enforcer can invoke the appropriate
enforcement profiles.

As part of the configuration, on ClearPass you will create two enforcement profiles, one for quarantine
and one for terminate. Then you will use them in the ClearPass enforcement policy. Once ClearPass is
configured, you will configure a ClearPass Connector on Policy Enforcer.

NOTE:
• Always use a third-party switch that supports 802.1x, Radius CoA, Radius Accounting, and
DHCP snooping features. Enabling DHCP snooping is important which configures the Radius
attribute, Framed-IP-Address. Only after configuring Framed-IP-Address, Policy Enforcer can
detect the session related to the infected-host IP addresses and terminate the session.

• The stale sessions in ClearPass cannot be terminated and therefore, the actual East-West
traffic block will not be active until you reauthenticate the session. You must ensure to clear
the stale sessions in ClearPass frequently.

On ClearPass you will configure the following:

• API Client

• Custom Attribute

• Enforcement Profiles

• Enforcement Policy

To configure the API Client:

1. In ClearPass, navigate to Administration > API Services > API Clients and create a client with the
following attributes:

NOTE: You must login as ClearPass Guest to see the API services menu.

• Client ID: sdsnclient

• Enabled: Select the check box for Enable API client
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• Operator Profile: Create a profile from Administrator > Operator Logins > Profiles for the API client
with minimum access privileges as shown in Figure 118 on page 1185.

Figure 118: ClearPass API Client Operator Profile Minimum Privileges

• Grant Type: Select Client credentials (grant_type = client_credentials)

• Client Secret: Copy and save this. It will not be shown again.

• Access Token Lifetime: Enter 5 minutes as a time-frame.
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Figure 119: ClearPass Edit API Client

2. Click Save Changes.

To configure a Custom Attribute:

1. Select ClearPass Policy Manager and navigate to Administration > Dictionaries > Attributes to create
a custom attribute. Then add it into the Dictionary: sdsnEpStatus. Enter the following:

• Entity Type: Endpoint

• Name: sdsnEpStatus (Note that you must use this name - sdsnEpStatus)

• Data Type: List

• Is Mandatory: Yes

• Allowed Values: healthy, blocked, quarantine

• Default Value: healthy
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Figure 120: ClearPass Edit Attribute

2. Click Save.

To configure Enforcement Profiles:

1. In ClearPass, navigate to Configuration > Enforcement > Profiles and create two enforcement profiles.

2. Profile 1: Create the following profile to quarantine infected endpoints:

• Name: Name of the enforcement profile

• Description: Quarantine profile for Juniper Connected Security

• Type: RADIUS

• Action: Accept
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Figure 121: ClearPass Enforcement Profile: Quarantine

NOTE: The data displayed at the bottomof the screen is for example and not for configuration
purposes. Note that the 4th attribute can be set for the accounting packets to be sent by the
NAS device to the Clearpass Radius server.

3. Profile 2: Create the following profile to block infected endpoints:

NOTE: To configure this profile, copy the default system profile Juniper Terminate Session
and edit the profile name and attributes.

• Name: JNPR SDSN Terminate Session

• Description: Block profile for SDSN

• Type: RADIUS_CoA

• Action: Disconnect
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NOTE: If there are any vendor-specific additional attributes required for the Terminate COA,
those needs to be added here. For example, in the case of Juniper Networks TrapezeWireless
Clients, the JNPR SDSN Terminate Session profile requires two additional attributes:
NAS-IP-Address and User-Name.

Figure 122: ClearPass Enforcement Profile: Terminate

Configure an Enforcement Policy:

In ClearPass, navigate toConfiguration > Enforcement > Policies. Both profiles you createdmust be added
to all the enforcement policies for endpoints addressed by Policy Enforcer.

1189



Figure 123: ClearPass Enforcement Policy

NOTE: Rules Evaluation should be set to "First applicable."

NOTE: Make sure the default termination enforcement profile for each of the supported vendors
is not superseded by any of its enforcement profile copies. Also make sure that all the attributes
required for termination are set in the profile. (As in the previous Juniper Networks Trapeze
Wireless Clients example.)

Enable Insight:

1. In ClearPass, navigate to Administration > Server Manager > Server Configuration for the server in
use.

2. Enable Insight in the System tab.

Set the Log accounting Interim-update Packets as TRUE:

1. In ClearPass, navigate to Administration > Server Manager > Server Configuration for the server in
use.

2. Select the Service Parameters tab.
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3. In the Select Service drop down list, select Radius Server and set the Log accounting Interim-update
Packets as TRUE.

4. Proceed to “Creating a Policy Enforcer Connector for Third-Party Switches” on page 1165 to finish the
configuration with Policy Enforcer.
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Cisco ISE Configuration for Third-Party Plug-in

Policy Enforcer's Cisco ISE Connector communicates with the Cisco Identity Services Engine server using
the Cisco ISE API. As part of threat remediation, Policy Enforcer's Connector uses enforcement profiles.
This section provides information for configuring Cisco ISE so that Policy Enforcer can invoke the appropriate
enforcement profiles.

As part of the configuration, on Cisco ISE you will create two enforcement profiles, one for quarantine
and one for terminate. Then you will use them in the Cisco ISE enforcement policy. Once Cisco ISE is
configured, you will configure a Cisco ISE Connector on Policy Enforcer.

On Cisco ISE you will configure the following:

• Change policy modes

• Create an API client

• Configure network profiles

• Add a custom attribute

• Configure authorization profiles

• Set an authorization policy
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On Cisco ISE, the Simple Mode policy model is selected by default. For creating an API client, Policy Sets
should be enabled.

• Navigate to Administration > System > Settings > Policy Sets and Enable Policy Setsmode.

You are prompted to login again after changing the mode.

Figure 124: Cisco ISE: Enable Policy Sets Mode

Create an API Client:

1. Using the Cisco ISE web UI, create an Admin User by navigating to Administration > System > Admin
Access > Administrator > Admin User.

2. Create an Admin User and assign it to the following Admin Groups: ERS Admin,MnT Admin.

Make note of the username and password. You will need them when you configure the connector
portion in Policy Enforcer later on.

Figure 125: Cisco ISE: Create Admin User and Assign to Admin Groups

Enable the External RESTful Services API (ERS) for the Administration Node:

1. Navigate to Administration > System > Settings >ERS Settings and select Enable ERS for Read/Write.
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2. Click Save.

Figure 126: Cisco ISE: Enable ERS

Configure network profiles:

Devices managed by ISE must support RADIUS CoA and have the proper network profiles assigned to
handle the CoA commands sent by the ISE server:

1. Navigate to Administration > Network Resources > Network Device Profiles and verify the existing
network device profile list.

If you are creating a new profile, proceed to the next step for information.
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Figure 127: Cisco ISE: Network Device Profiles List

2. If you are configuring a new profile, you must minimally set the following:

• Enable RADIUS and add a corresponding dictionary in the supported protocol list.

Figure 128: Cisco ISE: Network Device Profile, Enable RADIUS

• Enable and configure the Change of Authorization (CoA) according to the figure below.
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Figure 129: Cisco ISE: Configure Change of Authorization (CoA)

• Configure the Disconnection and Re-authenticate operation with the proper RADIUS attributes and
vendor specific VSA to handle the standard disconnect and reauthenticate operations. Below is the
sample configuration for Juniper’s EX devices.

Figure 130: Sample Configuration for Juniper EX
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Configure a custom attribute.

1. Navigate to Administration > Identity Management > Settings > Endpoint Custom Attribute and add
attribute sdsnEpStatus with type string.

Figure 131: Cisco ISE: Add Attribute sdsnEpStatus

2. Verify the attribute under Policy > Policy Elements > Dictionaries > System > Endpoints.
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Figure 132: Cisco ISE: Verify Attribute

3. Navigate to Policy > Policy Elements > Conditions > Authorization > Simple Conditions. Add there
authorization simple conditions using the sdsnEpStatus attribute you created.

In the screen below,, there are three conditions created using sdsnEpStatus attribute. The condition
names do not need to be the same as in the screen here, but the expressions must be matched. These
conditions will be used in Policy Sets to handle the threat remediation for managed endpoints as
described later in the Policy Sets setting section. Only the sdsnEpStatus-blocked and
sdsnEpStatus-quarantine conditions will be used there. sdsnEpStatus-healthy is created for fulfillment
purpose and can be ignored for now.

1197



Figure 133: Cisco ISE: Configure Simple Conditions, Match Expression

Figure 134: Cisco ISE: Configure Simple Conditions, Match Expression
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Configure permission/authorization profiles.

You can create the authorization profiles corresponding to “block” and “quarantine” actions as fits your
needs. In the sample configuration provided here, the block action will result as total denial access to the
network, and the quarantine profile will move the endpoint to another designated VLAN.
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1. Navigate to From Policy > Policy Elements > Results > Authorization > Authorization Profiles.

Refer to the figures below for sample configurations.

Figure 135: Cisco ISE: Configure Authorization Profiles

Figure 136: Cisco ISE: Configure Authorization Profiles
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NOTE: For blocking a host, the default ‘DenyAccess’ profile is used.

Set the authorization policy:

1. Create two rules as Local Exceptions, applying the conditions and authorization/permission profiles
we created in the previous step. Names may be different, but these two rules must be at the top of
the Exception list.

Refer to the figure below for a sample configuration.
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Figure 137: Cisco ISE: Local Exception Rules, Example

NOTE: Find this under Policy > Policy Sets > Authorization Policy.

2. Proceed to “Creating a Policy Enforcer Connector for Third-Party Switches” on page 1165 to finish the
configuration with Policy Enforcer.
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Overview

This topic provides instructions on how to integrate the third-party device Pulse Policy Secure (PPS) with
Juniper Networks Connected Security solution to remediate threats from infected hosts for enterprises.
The Juniper Connected Security solution provides end-to-end network visibility that enables enterprises
to secure their entire physical and virtual networks. PPS provides visibility into the network by detecting
and continuously monitoring the network. Using the threat detection and policy enforcement, the PPS
and Juniper Connected Security solution automates the network security and supports centralised
management, in a multi-vendor environment.

PPS integrates with Juniper Networks Connected Security solution through RESTful APIs and takes
appropriate action based on the admission control policies. The PPS integration with Juniper Connected
Security solution detects and enforces threat prevention policies and provides a collaborative and
comprehensive approach towards complete network security. It enables users to leverage the existing
trusted threat feed sources to provide a consistent and automated defense across diverse environments.

Benefits of the Pulse Policy Secure Integration with Juniper Connected Security

• PPS has more visibility of endpoints connected to the network.

• Based on the threat alerts received from Juniper Connected Security, PPS enhances the security by
isolating or acting at the endpoint level.

Deployment of Pulse Policy Secure with Juniper Connected Security

The following high level workflow describes the deployment of PPS with Juniper Connected Security. PPS
receives the threat alert information from Juniper Connected Security solution and takes an action on the
endpoint based on the admission control policies.

1. User successfully authenticates with the PPS server.

2. User downloads a file from the Internet. The perimeter firewall (SRX Series device) scans the file and
based on the user-defined policies, sends the scanned file to Juniper ATP Cloud for analysis.

3. Juniper ATP Cloud detects that the file contains malware, identifies the endpoint as an infected host,
and notifies the SRX Series device and Policy Enforcer.
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4. Policy Enforcer downloads the infected host feed and sends a threat action to PPS.

5. The PPS server quarantines or blocks the endpoint.

PPS tracks the infected host and does not allow the infected host to acquire full access until the endpoint
is disinfected. When the host is disinfected and cleared from Juniper ATP Cloud or Policy Enforcer,
PPS receives a clear event from the Policy Enforcer connector. After receiving the clear event, PPS
removes the infected host. The host is now authenticated and an appropriate role is assigned to it.

Configuring Pulse Policy Secure with Juniper Connected Security

IN THIS SECTION

Admission Control Template | 1208

Admission Control Policies | 1209

Admission Control Client | 1211

The network security devices are configured with PPS for admission access control.

A high-level overview of the configuration steps required to set up and run the integration is described
below:

1. The administrator configures the basic PPS configurations such as creating an authentication server,
authenticating realm, user roles, and role mapping rules. To know more about configuring your PPS,
see Pulse Policy Secure Administration Guide.

2. Configure Policy Enforcer as a client in PPS. PPS acts as a RESTful API server for Policy Enforcer.

The RESTful API access for the admin user must be enabled by accessing the serial console or
alternatively from the PPS admin user interface (UI). Select Authentication>Auth
Server>Administrators>Users. Click Admin and enable the Allow access to REST APIs option.

3. Configure PPS to block or quarantine the endpoint based on the threat prevention policy.

You must configure the admission control client to obtain the Policy Enforcer IP address that sends
events to PPS and admission control policy to understand the PPS event types such as,
events-block-endpoint, quarantine-endpoint, clear-blocked-endpoint, and clear-quarantine-endpoint.

4. Configure the Switches or WLC as RADIUS Client in PPS by selecting Endpoint Policy>Network
Access>Radius Clients>New Radius Client. The switch is configured with PPS as a RADIUS server.
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5. Configure RADIUS return attribute policies, to define the action upon receiving the quarantine event.

• Quarantine using VLANs:

The PPS determines which quarantine VLAN to send to RADIUS Client when a quarantine-endpoint
event is received, as shown in Figure 138 on page 1205.

Figure 138: RADIUS Return Attributes for Quarantine-Host

• Quarantine using ACLs:
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For environments that has flat VLAN, the PPS provides the ability to quarantine users by applying a
preconfigured firewall filter. Also, this is a preferredmethod in environments that use static IP address
assignment for end devices.

The following example shows the firewall filter configuration on the switch. The firewall filter name
is then passed on as RADIUS return attribute, as shown in Figure 139 on page 1207.

Configure the PERMIT-PULSE-ONLY and PERMIT-ALL firewall filters on the switch using the following
commands:

set firewall family ethernet-switching filter PERMIT-PULSE-ONLY termpps fromdestination-address
10.92.81.113/32

set firewall family ethernet-switching filter PERMIT-PULSE-ONLY term pps then accept

set firewall family ethernet-switching filter PERMIT-PULSE-ONLY term dhcp_allow from
destination-port 67

set firewall family ethernet-switching filter PERMIT-PULSE-ONLY term dhcp_allow then accept

set firewall family ethernet-switching filter PERMIT-PULSE-ONLY term pps-discard then discard

deactivate firewall family ethernet-switching filter PERMIT-PULSE-ONLY

set firewall family ethernet-switching filter PERMIT-ALL termALLOW-ALL fromdestination-address
0.0.0.0/0

set firewall family ethernet-switching filter PERMIT-ALL term ALLOW-ALL then accept

deactivate firewall family ethernet-switching filter PERMIT-ALL

To assign these filters in PPS, select Endpoint Policy>Network Access>Radius Attributes>Return
Attributes.
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Figure 139: RADIUS Return Attributes for Clear-Quarantine

1207



NOTE:
• Ensure that PPS has the endpoint IP address for the enforcement to work correctly.

• Since the endpoint IP address is mandatory, deployments where the user is behind a NAT
might not work as expected. This is because PPSmight have the actual IP address, and Juniper
Connected Security might send the NATed IP address.

• To receive the endpoint IP address (accounting information) by PPS, you must use the Pulse
Secure client on endpoints when they are connected to EX4300 Series switches.

Admission Control Template

The admission control template provides a list of possible events that can be received from the network
security device alongwith the regular expression to parse themessage. The template also provides possible
actions that can be taken for an event.

PPS is loadedwith default templates for Policy Enforcer. The administrators can create templates for other
security devices and upload those templates.

To view the admission control templates, select Endpoint Policy>Admission Control>Templates, as shown
in Figure 140 on page 1208. You can view the list of configured integration templateswith the list of network
security devices and the supported protocol types.

Figure 140: Pulse Secure Templates Page
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Admission Control Policies

The admission control policies define the list of actions to be performed on PPS for the user sessions. The
actions are based on the event and the severity of the information received from the network security
device.

To view and add the new integration policy:

1. Select Endpoint Policy>Admission Control>Policies.

2. Click New Policy.

The New Policy page appears, as shown in Figure 141 on page 1209.

Figure 141: Pulse Secure - New Policy Page

3. Enter the policy name.

4. Select Juniper Networks Policy Enforcer as a template.

5. In the Rule on receiving section, select one of the following event types and the severity level. The
event types and the severity level are based on the selected template.

1209



The following event types are supported on sessions:

• Block-endpoint—Blocks the hostMACAddress on the PPS permanently. If the administrator chooses
to clear the blocked endpoint, it can be cleared either by using the Junos Space Security Director
application or by using the PPS Administration UI.

• Quarantine-endpoint (Change user roles)—Changes the roles assigned to the user on PPS so that
restrictions or privileges for the user can be changed. The administrator can choose to apply these
roles permanently or temporarily. If it is permanent, system is directly quarantined regardless of
which network it connects to.

• Clear Blocked Endpoint—Clears a previously blocked MAC Address.

• Clear Quarantined Endpoint—Clears a previously quarantined MAC Address.

6. In the then perform this action section, select the following desired action:

• Select a role and assign it to the endpoint to put that endpoint into a quarantine network.

• In the Make this role assignment option, specify the following actions:

• Permanent—To apply the role assignment permanently. This is the recommended option. Choose
this option for the action to persist.

• For this session only—To apply the role assignment only for the current session.

7. In the Roles section, specify the following options:

• Policy applies to ALL roles—To apply the policy to all users.

• Policy applies to SELECTED roles—To apply this policy only to users who are mapped to roles in the
Selected roles list. You must add roles to this list from the Available roles list.

• Policy applies to all roles OTHER THAN those selected below—To apply this policy to all users except
for those who are mapped to the roles in the Selected roles list. You must add roles to this list from
the Available roles list.

NOTE: These options are applicable to both quarantine and block actions.

8. Click Save changes.

Once the policy is created, you can see the summary page. Figure 142 on page 1211 shows the different
policies created for different events with different user roles.
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Figure 142: Pulse Secure - Policies Configure Page

Admission Control Client

The admission control clients are the network security devices on which the syslog forwarding is enabled.
The messages are received by the syslog server module running on PPS.

To add a client:

1. Select Endpoint Policy>Admission Control>Clients.

2. Click New Client.

The New Client page appears, as shown in Figure 143 on page 1212.
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Figure 143: Pulse Secure - New Client Page

3. Enter the name of the Juniper Networks Policy Enforcer. This is added as a client in the PPS.

4. Enter the description.

5. Enter the IP address of the client.

6. Select the template used by the client: JuniperNerworks-Policy Enforcer-HTTP-JSON.

7. Click Save Changes.

Policy Enforcer is added a new client in the PPS.

Creating Pulse Policy Secure Connector in Security Director

Once you add Policy Enforcer as a client in PPS, create a connector for PPS to configure the Juniper
Connected Security to send the event information.

To create a connector for PPS and configure Juniper Connected Security using Security Director:

1. Select Security Director>Administration>Policy Enforcer>Connectors.

The Connectors page appears.

2. Click the create icon (+).
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The Create Connector page appears, as shown in Figure 144 on page 1213.

Figure 144: Create Connector Page

3. In the General tab, select Pulse Policy Secure in the ConnectorType list.

4. In the IP Address/URL field, enter the IP address of PPS.

5. Retain the default port number as 443.

6. Enter the username and password of PPS.

Note that you must have enabled the REST API access on PPS (Authentication > Auth Server >
Administrators > Users > click “admin”, enable Allow access to REST APIs).

7. Click Next.

8. In the Network Details section, configure the IP subnets, as shown in Figure 145 on page 1214.
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Figure 145: Create Connector Network Details Page

9. In the Configuration tab, provide any additional information required for this specific connector
connection.

10.Click Finish.

Once the configuration is successful the following page is displayed, as shown in Figure 146 on page 1214.

Figure 146: Connectors Page

11.Verify that the communication between Policy Enforcer and PPS is working.

After installing PPS and configuring a connector, in the PPS UI, create policies for PPS to take the
necessary action on the infected hosts.
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Troubleshooting

The following troubleshooting logs are available:

• To verify the event logs on PPS, select System>Log/Monitoring>Events.

You can verify that the event logs are generated every time when an event is received from Policy
Enforcer, as shown in Figure 147 on page 1215.

Figure 147: Pulse Secure Events Page

• To verify the user login related logs such as realm, roles, username, and IP address, select System>Logs
& Monitoring>User Access.

• To verify the reports, select System>Reports>Infected Hosts.

You can verify whether the quarantined or blocked host is listed in the Infected Devices report. This
report lists the MAC address, IP address, and the device status, as shown in Figure 148 on page 1216.
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Figure 148: Infected Hosts Reports Page

• To enable the debug logs for troubleshooting, selectMaintenance>Troubleshooting>Monitoring>Debug
Log, as shown in Figure 149 on page 1216.

Figure 149: Debug Log Monitoring Page

• To troubleshoot any issues on the Policy Enforcer, download and verify the Policy Enforcer logs from
Security Director>Administration>Policy Enforcer>Settings page, as shown in Figure 150 on page 1217.
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Figure 150: Policy Enforcer Settings Page

• The administrators can also verify the Hosts table from Juniper ATP Cloud to check the status of the
host, as shown in Figure 151 on page 1217.

You can clear the host entry if the State Of Investigation field value is Resolved-Fixed.

Figure 151: Juniper ATP Cloud Hosts Page
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Policy Enforcer Backup and Restore

IN THIS SECTION

Backing-Up Policy Enforcer | 1220

Restoring Policy Enforcer from a Backup File | 1222

Policy Enforcer provides the option of backing-up all Policy Enforcer configuration and storing it as a .tar
file. In the event of any unforeseen circumstances such as a malicious attack or system failure you can use
the backup file to restore Policy Enforcer to a previously saved configuration. You can also take a backup
before you change some configuration in Policy Enforcer, and revert to the backed up configuration, if
needed. You can take multiple backups and choose to restore the Policy Enforcer configuration from any
of these backup files.

Policy Enforcer backup includes Policy Enforcer configurations such as .yml files, databases or sequences,
and device configurations. Policy Enforcer also communicates with multiple components to obtain
information, as shown in Figure 152 on page 1219.
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Figure 152: Policy Enforcer Communication with Multiple Components

Policy Enforcer communicates with:

• Juniper ATP Cloud/ JATP for feeds

• Security Director for profiles and configurations

• Junos Space Network Management Platform and Security Director to discover network connectivity
like endhosts

• Connectors to connect to AWS, Azure, ClearPass, Contrail, PulseSecure, and Forescout

Policy Enforcer backup includes the backup of all these configurations and dependencies. When you
backup Policy Enforcer, both Policy Enforcer and Security Director configurations are backed up.

NOTE: Policy Enforcer backup does not include feed data.
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Backing-Up Policy Enforcer

Before You Begin

You must be aware of the following before you initiate a Policy Enforcer backup:

• When you initiate a backup/restore, Policy Enforcer goes intomaintenancemode andwill be unresponsive
until the backup/restore process is complete. Ensure that you complete all the tasks with Policy Enforcer
before you start the backup/restore process.

• If you are saving the backup .tar file on a remote server, ensure that there is enough space for the file
on that server.

• Ensure that Policy Enforcer and Security Director backups are taken and restored at the same time to
prevent unexpected application behavior.

• Ensure Policy Enforcer and connected Junos Space Security Director database backups are taken at the
same time and no changes are made when backups are happening.

To take a backup of Policy Enforcer:

1. Select Administration > Policy Enforcer > Backup and Restore.

The Backup and Restore page appears.

2. Click Backup on the top-right corner of the page.

The Backup page appears.

3. Complete the configuration using the information in Table 369 on page 1221.

4. Click OK.

A job is created to execute the backup process. To see the progress of the backup, go to the Job
Management page.

NOTE: Policy Enforcerwill be inmaintenancemode andwill be unavailable till the backup process
is complete.

After the backup process is complete, the backup .tar file is listed on the Backup and Restore page.
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Table 369: Fields on the Backup Page

DescriptionField

Select whether you want to save the backup .tar file to a
local server or to a remote server.

• Local—Saves the backup .tar file locally in the
/opt/policyEnforcer/feeder/backup folder.

• Remote—Saves the backup .tar file in the device that
you specify in the IP Address field.

Server Type

Enter a description; maximum length is 1024 characters.
Make this description as useful as possible for everyone.

Description

Enter the username of the remote server where youwant
to save the backup .tar file.

Username

Enter the password for the selected remote server.Password

Enter the IPv4 or IPv6 address of the remote server where
you want to save the backup .tar file.

IP Address

Enter the filepath and folder name on the remote server
where you want to save the backup .tar file.

Directory

To select a schedule for the backup:

1. Click Add Schedule.

The Backup Schedule page opens.

In the Type field:

• Select Run now to start the backup immediately.

• Select Schedule at a later time and select the date
and time of the backup.

2. Click OK.

The Backup page appears with the schedule details.

You can also edit or delete the backup schedule by clicking
Edit or Delete, respectively.

Schedule Backup

1221



Restoring Policy Enforcer from a Backup File

Before You Begin

You must be aware of the following before you restore Policy Enforcer from a backup file:

• When you initiate a backup/restore, Policy Enforcer goes intomaintenancemode andwill be unresponsive
until the backup/restore process is complete. Ensure that you complete all the tasks with Policy Enforcer
before you start the backup/restore process.

• Ensure that Policy Enforcer and Security Director backups are taken and restored at the same time to
prevent unexpected application behavior.

• When you restore Policy Enforcer from a backup file, ensure the matching Security Director backup is
also restored at the same time. Do not make any changes to managed devices in Security Director or
devices connected to Policy Enforcer as the system does not check for this.

To restore Policy Enforcer from a backup file:

1. Select Administration > Policy Enforcer > Backup and Restore.

The Backup and Restore page appears.

2. Select the backup file from which you want to restore Policy Enforcer configurations and click Restore
on the top-right corner of the page.

A pop-up page appears asking for confirmation to restore Policy Enforcer from the backup file.

3. Click Restore to start the restore process.

RELATED DOCUMENTATION

Policy Enforcer Settings | 1149

Policy Enforcer Connector Overview | 1153
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CHAPTER 100

Guided Setup-ATP Cloud with SDSN

IN THIS CHAPTER

Using Guided Setup for Juniper ATP Cloud with Juniper Connected Security | 1224
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UsingGuided Setup for Juniper ATPCloudwith Juniper Connected Security

Guided Setup is the most efficient way to complete your Juniper ATP Cloud with Juniper Security
configuration. To locate Guided Setup, navigate to Configure > Guided Setup > Threat Prevention in the
Junos Space Security Director Portal.

Before You Begin

• The ATPCloud Configuration type you select on the Policy Enforcer Settings page determines the guided
setup process. Guided setup provides all the configuration items you need for your chosen type. See
“Juniper ATP Cloud Configuration Type Overview” on page 1113 for details on each configuration type.

• Before you begin the guided setup process, you must enter the IP address and login credentials for the
policy enforcer virtual machine on the Policy Enforcer Settings page. If you haven’t yet done that, go to
Administration > Policy Enforcer > Settings and enter the necessary information. See “Policy Enforcer
Settings” on page 1149 for more information.

• Ensure that all the devices that you want to set up threat prevention for are already discovered and
available on Junos Space. See “Overview of Device Discovery in Security Director” on page 343.

• Ensure that you install the proper Schema that is suitable with the OS Version of the device.

• Ensure that device version should not be less than 15.x.

• Juniper ATP Cloud license and account are needed for all Juniper ATP Cloud Configuration Types.
(Juniper ATP Cloud with Juniper Connected Security, Juniper ATP Cloud, and Cloud Feeds only). If you
do not have a Juniper ATP Cloud license, contact your local sales office or Juniper Networks partner to
place an order for a Juniper ATP Cloud premium or basic license. If you do not have a Juniper ATP Cloud
account, when you configure Juniper ATP Cloud, you are redirected to the Juniper ATP Cloud server to
create one. Please obtain a license before you try to create a Juniper ATP Cloud account. Refer to
“Obtaining a Juniper ATP Cloud License” on page 1142 for instructions on obtaining a Juniper ATP Cloud
license.

• There are some concepts you should understand before you begin the configuration. We recommend
that you read about them here in advance. “Policy Enforcer Configuration Concepts” on page 1112.

This video provides a complete overview of how you can set up use Policy Enforcer threat prevention to
blockmalicious servers and domains. You can refer to the procedure below for more elaborate instructions.

Video: Using Guided Setup for Set Up Threat Prevention
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The Guided Setup process offers the following steps for configuring Juniper ATP Cloud with Juniper
Connected Security threat prevention.

1. Navigate to theGuided Setup page from theConfiguration >Guided Setup > Threat Preventionmenu.

The Threat Prevention Policy Setup page appears as shown in Figure 153 on page 1225.

Figure 153: Threat Presentation Guided Setup

2. Click Start Setup to begin the guided setup.

The guided setup takes you through the various configuration, the first being Tenants, as shown in
Figure 154 on page 1226.

3.
NOTE: This step is not applicable for SRX Series devices. Tenants are only applicable for MX
Series devices.

Create a tenant representing an enterprise by clicking + on the top-right corner of the page. The Create
Tenant page appears.

Use the instructions provided in section “Create Secure Fabric Tenants” on page 364 to create a tenant.

NOTE: When a tenant is created, a VRF instance is assigned to the tenant. When a site is
associated with this tenant, only those devices that have the VRF instance associated with
the tenant can be added to the site.
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Click OK to move on to the next step.

The Secure Fabric page appears.

NOTE: In Policy Enforcer Release 20.1R1, only MX series devices support LSYS and VRF.
Also, only root-logical system is supported. All the sites of a realm are either with tenants or
without tenants.

Figure 154: Threat Prevention Configuration

4. A Secure Fabric is a collection of network devices (switches, routers, firewalls, and other security
devices), used by users or user groups, to which policies for aggregated threat prevention are applied.
Create a Secure Fabric by clicking + on the top-right corner of the page. The Create Site page appears.

Use the instructions provided in section “Creating Secure Fabric and Sites” on page 353 to create a site.

After you create a site, youmust add the devices for which youwant to apply a common security policy,
to the site. To do so, click Add Enforcement Points in the Enforcement Points column of a device or,
alternately select a device and click Add Enforcement Points on the top-right corner of the page. Use
the instructions provided in section “Adding Enforcement Points” on page 357 to add endpoints to the
site.

NOTE:
• A device can belong to only one site and you must remove it from any other site where it
is used.

• Firewall devices are automatically enrolled with ATP Cloud as part of this step. No manual
enrollment is required.

You can find the newly created Secure Fabric on the Devices page.

Click OK to move on to the next step.
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The Policy Enforcement Group page appears.

5. A policy enforcement group is a grouping of endpoints ready to receive advance threat prevention
policies. Create a policy enforcement group by clicking + on the top-right corner of the page. The Policy
Enforcement Group page appears.

Use the instructions provided in section “Creating Policy Enforcement Groups” on page 1022 to create
a policy enforcement group.

You can find the newly created policy enforcement group on the Configure > Shared Objects page.

Click OK to move on to the next step.

The ATP Cloud Realm page appears.

6. A security realm is a group identifier for an organization used to restrict access to Web applications.
You can create one or multiple realms. If you have not created a realm from within your ATP Cloud
account, you can create and register it here by clicking the + sign on the top-right corner of the page.

Use the instructions provided in section “Creating Juniper ATP Cloud Realms and Enrolling Devices or
Associating Sites” on page 876 to create and register a realm, and then enroll SRX Series devices into
the realm.

If a realm is already created with a site assigned, all devices in a site are listed under the Devices in
Site(s) column that includes EX Series, SRX Series, all enforcement points, and devices that are originally
from a realm. Devices that are marked as perimeter firewall devices are listed under the Perimeter
Firewall column.

Click OK to move on to the next step.

The Threat Prevention Policy page appears.

7. Create a threat prevention policy by clicking + on the top-right corner of the page. The Create Threat
Prevention Policy page appears.

Use the instructions provided in section “Creating Threat Prevention Policies” on page 841 to create a
threat prevention policy.

The newly created threat prevention policy is available on page Configure > Threat Prevention >
Policies.

Click OK to move on to the next step.

The Geo IP page appears.

8. (Optional) Geo IP refers to the method of locating a computer terminal's geographic location by
identifying that terminal's IP address. A Geo IP feed is an up-to-date mapping of IP addresses to
geographical regions. By mapping IP address to the sources of attack traffic, the geographic regions of
origin can be determined, giving you the ability to filter traffic to and from specific locations in the
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world. Create a Geo IP by clicking + on the top-right corner of the page. The Create Geo IP page appears
as shown in Figure 155 on page 1228.

Use the instructions provided in section “Creating Geo IP Policies” on page 1018 to create a Geo IP.

Click Finish to move on to the Summary page.

The Geo IP page appears.

Figure 155: Create Geo IP

9. The last page is a summary of the parameters you have configured using quick setup. ClickOK to create
the threat prevention policy. The Policies page appears with the newly created policy listed.

10.You must apply your new or edited policy configuration to Policy Enforcer in order for the policy
configuration to go live. In order to do that, click the Ready to Update link in the Status column. The
Threat Policy Analysis page appears.

Use the Threat Policy Analysis page to view your pending policy changes in chronological order. Click
the View Analysis link to view the changes.

In the Action section, you can choose to: Update now to , Update later, or Save the changes without
updating.

• Update now—Apply the policy configuration immediately.

• Update later—Apply the policy configuration at a scheduled date and time of your choice.

• Save the changeswithout updating—Save the policy changeswithout applying them to Policy Enforcer.
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CHAPTER 101

Guided Setup-ATP Cloud
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Using Guided Setup for Juniper ATP Cloud

Guided Setup is the most efficient way to complete your initial configuration. Locate Guided Setup from
the Configuration > Guided Setup > Threat Prevention menu.

• The ATPCloud Configuration type you select on the Policy Enforcer Settings page determines the guided
setup process. Guided setup provides all the configuration items you need for your chosen type. See
“Juniper ATP Cloud Configuration Type Overview” on page 1113 for details on each configuration type.

• Before you begin the guided setup process, you must enter the IP address and login credentials for the
policy enforcer virtual machine on the Policy Enforcer Settings page. If you haven’t yet done that, go to
Administration > Policy Enforcer > Settings and enter the necessary information. See “Policy Enforcer
Settings” on page 1149 for more information.

• Juniper ATP Cloud license and account are needed for all Juniper ATP Cloud Configuration Types.
(Juniper ATP Cloud with Juniper Connected Security, Juniper ATP Cloud, and Cloud Feeds only). If you
do not have a Juniper ATP Cloud license, contact your local sales office or Juniper Networks partner to
place an order for a Juniper ATP Cloud premium or basic license. If you do not have a Juniper ATP Cloud
account, when you configure Juniper ATP Cloud, you are redirected to the Juniper ATP Cloud server to
create one. Please obtain a license before you try to create a Juniper ATP Cloud account. Refer to
“Obtaining a Juniper ATP Cloud License” on page 1142 for instructions on obtaining a Juniper ATP Cloud
license.

• There are some concepts you should understand before you begin the configuration. Read “Juniper ATP
Cloud Overview” on page 1103 for further information.

Click Start Setup from Configuration > Guided Setup > Threat Prevention to begin.
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1. Add ATP Cloud Realm—If you have not created a realm from within your Juniper ATP Cloud account,
you can create it here by clicking the + sign. Once you add a realm, you can enroll SRX Series devices
into the realm. A security realm is a group identifier for an organization used to restrict access to Web
applications. You can create one or multiple realms. See “Juniper ATP Cloud Realm Overview” on
page 866 for information. A realm has the following configuration fields

• Username and Password—These are credentials you must provide, obtained through your Juniper
ATP Cloud account.

• Realm—This is the name of the realm you are creating.

2. Click Add devices to enroll them in threat prevention before proceeding to the next step. Devices
designated as perimeter firewalls are automatically enrolled with Juniper ATP Cloud.

3. Create a Policy—You create a name for the policy, choose one or more profile types depending on the
type of threat prevention this policy provides (C&C Server, Infected Host, Malware), and select a log
setting.

• Once configured, threat prevention policies are located under Configure > Threat Prevention >
Policies. A policy has the following fields:

• Name and Description.

• Profiles—The type of threat this policy manages:

• C&C Server (Command and Control Server)—A C&C server is a centralized computer that issues
commands to botnets (compromised networks of computers) and receives reports back from
them. A C&C profile provides information on C&C servers that have attempted to contact and
compromise hosts on your network. Information such as IP address, threat level, and country of
origin are gathered.

• Infected Host—An infected host profile provides information on compromised hosts and their
associated threat levels. Host information includes IP address, threat level, blocked status, when
the threat was seen, command and control hits, and malware detections.

• Malware—A malware profile provides information on files downloaded by hosts and found to
be suspicious based on known signatures or URLs. The filename, file type, signature, date and
time of download, download host, URL, and file verdict are gathered.

• Logging—All traffic is logged by default. Use the pulldown to narrow the types of traffic to be
logged.

4. Geo IP—Geo IP refers to themethod of locating a computer terminal's geographic location by identifying
that terminal's IP address. A Geo IP feed is an up-to-date mapping of IP addresses to geographical
regions. By mapping IP address to the sources of attack traffic, geographic regions of origin can be
determined, giving you the ability to filter traffic to and from specific locations in the world. For Geo
IP, you configure the following:

• Name and Description
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• Countries—Select the check box beside the countries in the Available list and click the > icon tomove
them to the Selected list. The countries in the Selected list will be included in the policy and action
will be taken according to their threat level.

• Block Traffic—Choose what traffic to block from the selected countries. Incoming traffic, Outgoing
traffic, or Incoming and Outgoing traffic.

5. The last page is a summary of the items you have configured. ClickOK to be taken to the Policies page
under Configure > Threat Prevention, and your policy is listed there.

NOTE: When you are using Juniper ATP Cloud without Policy Enforcer, you must assign the
policy to a firewall rule before it can take affect. Navigate to Configure > Firewall Policy >
Policies. In the Advanced Security column, click an existing item to access the Edit Advanced
Security page and select the Threat Prevention Policy from the Threat Prevention pulldown list.

RELATED DOCUMENTATION

Juniper ATP Cloud Overview | 1103

Juniper ATP Cloud Realm Overview | 866

Configuring Juniper ATPCloud (No Juniper Connected Security andNoGuided Setup) Overview | 1240

Creating Geo IP Policies | 1018
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Using Guided Setup for No Juniper ATP Cloud (No Selection)

Guided Setup is the most efficient way to complete your initial configuration. Locate Guided Setup from
the Configuration > Guided Setup > Threat Prevention menu.

Youwouldmake no ATP Cloud selection to configure Juniper Connected Security using only custom feeds.
Custom feeds are the only threat prevention type available if you make no selection for ATP Cloud
Configuration Type in the Policy Enforcer Settings page.

• Before you begin the guided setup process, you must enter the IP address and login credentials for the
policy enforcer virtual machine on the Policy Enforcer Settings page. If you haven’t yet done that, go to
Administration > Policy Enforcer > Settings and enter the necessary information. See “Policy Enforcer
Settings” on page 1149 for more information.

• There are some concepts you should understand before you begin the configuration. It is recommended
you read about them here in advance. “Policy Enforcer Configuration Concepts” on page 1112.

The Guided Setup process offers the following steps for configuring threat prevention with custom feeds
(No ATP Cloud selection). Click Start Setup to begin.

1. Tenants—You can create a tenant representing an Enterprise. When a tenant is created, a VRF is
assigned to the tenant. When a site is associated with this tenant, only those devices that have the
VRF associated with the tenant can be added to the site.

NOTE: In Policy Enforcer Release 20.1R1, only MX series devices support LSYS and VRF.
Also, only root-logical system is supported. All the sites of a realm are either with tenants or
without tenants.

2. Secure Fabric—Secure Fabric is a collection of network devices (switches, routers, firewalls, and other
security devices), used by users or user groups, to which policies for aggregated threat prevention are
applied. Once created, secure fabric is located under Devices. For secure fabric, the following is
configured:

• Sites—A site is a collection of network devices participating in threat prevention. Using quick setup,
you can create your own site, but note that a device can only belong to one site and youmust remove
it from the any other site where it is used to use it elsewhere.

Click Add Devices in the Device Name column or in the IP address column to add devices to a site.
Using the check boxes in the device list, you should indicate which devices are firewalls or switches.

3. Policy Enforcement Group—A policy enforcement group is a grouping of endpoints ready to receive
advance threat prevention policies. Create a policy enforcement group by adding endpoints (firewalls
and switches) under one common group name and later applying a security policy to that group. For
policy enforcement group, the following is configured:
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• Once configured, policy enforcement groups are located under Configure > SharedObjects. A policy
enforcement groups has the following fields:

• Name and Description.

• Group Type—IP Address, Subnet, or Location

• Endpoint—IP addresses included in the group

4. Custom Feeds— Policy Enforcer uses threat feeds to provide actionable intelligence to policies about
various types of threats. These feeds can come from different sources. In this case, the feeds are
customized by adding IP addresses, domains, and URLs to your own lists.

The following types of custom threat feeds are available:

• Dynamic Address—A dynamic address is a group of IP addresses that can be imported from external
sources. These IP addresses are for specific domains or for entities that have a common attribute
such as a particular undesired location that poses a threat. You can then configure security policies
to use the dynamic addresses within a security policy.

• Allowlist—An allowlist contains known trusted IP addresses, URLs, and domains. Content downloaded
from locations on the allowlist does not have to be inspected for malware.

• Blocklist—A blocklist contains known untrusted IP addresses, URLs, and domains. Access to locations
on the blocklist is blocked, and therefore no content can be downloaded from those sites.

• Infected Host—Infected hosts are hosts known to be compromised.

NOTE: The Juniper ATP Cloud advanced anti-malware detection of the infected host is
not supported in SRX Series 300 and SRX Series 320 devices, if these devices are running
Junos OS release prior to 18.3R1.

• DDoS—Using DDoS threat feed, policy Enforcer blocks source IP addresses in the feed, rate limit the
traffic from the source IP addresses, and takes BGP Flowspec action to apply null-route filtering or
redirect the traffic to scrubbing centers.

• Command andControl Server (C&C)—C&C is a centralized computer that issues commands to botnets
(compromised networks of computers) and receives reports back from them. Botnets can be used
to gather sensitive information, such as account numbers or credit card information, or to participate
in a distributed DDoS attack.

5. Threat Prevention Policy—A threat prevention policy requires you to create a name for the policy,
choose one or more profile types depending on the type of threat prevention this policy provides
(infected hosts), and select a log setting. Once configured, you apply policies to policy enforcement
groups.

• Once configured, threat prevention policies are located under Configure > Threat Prevention >
Policies. A policy has the following fields:
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• Name and Description.

• Profiles—The type of threat this policy manages:

• Infected Hosts—An infected host profile would provide information on compromised hosts and
their associated threat levels. Host information includes IP address, threat level, blocked status,
when the threat was seen, command and control hits, and malware detections.

• Logging—All traffic is logged by default. Use the pulldown to narrow the types of traffic to be
logged.

• Group—Once your policy is created, it is applied to the policy enforcement group.

6. The last page is a summary of the items you have configured using quick setup. Click OK to be taken
to the Policies page under Configure > Threat Prevention > Policies and your policy is listed there.

7. You must update to apply your new or edited policy configuration. Clicking the Ready to Update link
takes you the Threat Policy Analysis page. See “Threat Policy Analysis Overview” on page 850. From
there you can view your changes and choose to Update now, Update later, or Save them in draft form
without updating.

RELATED DOCUMENTATION
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Configuring Juniper ATP Cloud with Juniper Connected Security (Without
Guided Setup) Overview

This is an outline of the tasks required to configure ATP Cloud with Juniper Connected Security.

NOTE: If you prefer to use quick setup, which automatically takes you through the steps listed
below, it is located under Configure>Guided Setup >ATP Cloud with PE.

Before You Begin

• Juniper ATP Cloud license and account are needed for all threat prevention types (Juniper ATP Cloud
with PE, Juniper ATP Cloud, and Cloud Feeds only). If you do not have Juniper ATP Cloud license, contact
your local sales office or Juniper Networks partner to place an order for Juniper ATP Cloud premium or
basic license. If you do not have Juniper ATP Cloud account, when you configure Juniper ATP Cloud,
you are redirected to the Juniper ATP Cloud server to create one. Please obtain a license before you try
to create Juniper ATP Cloud account. Refer to “Obtaining a Juniper ATP Cloud License” on page 1142 for
instructions on obtaining Juniper ATP Cloud license.

• Before you configure Policy Enforcer, you must enter the IP address and login credentials for the policy
enforcer virtual machine. Go to Administration > Policy Enforcer > Settings. Once this information is
entered, you can begin the setup process. See “Policy Enforcer Settings” on page 1149. (Refer to “Policy
Enforcer InstallationOverview” on page 1122 for instructions on downloading Policy Enforcer and creating
your policy enforcer virtual machine.)

To configure Juniper ATP Cloud with Juniper Connected Security:

1. Create one or more ATP Cloud realms and enroll SRX Series devices in the appropriate realm. (Enroll
devices by clicking Add Devices in the list view once the realm is created.)

In the UI, navigate to Configure>Threat Prevention>ATP Cloud Realms. Click the + icon to add a new
ATP Cloud realm.

See “Creating Juniper ATP Cloud Realms and Enrolling Devices or Associating Sites” on page 876 for
details.

2. Create sites and add devices to those sites.

In the UI, navigate to Devices >Secure Fabric. Click the + icon to create a new site.

See “Creating Secure Fabric and Sites” on page 353 for details.

3. Create a policy enforcement group.
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In the UI, navigate toConfigure>SharedObjects>Policy EnforcementGroups. Click the + icon to create
a new policy enforcement group.

See “Creating Policy Enforcement Groups” on page 1022 for details.

4. Add the threat prevention policy, including profiles for one or more threat types: C&C server, infected
host, malware.

In the UI, navigate to Configure> Threat Prevention > Policies. Click the + icon to create a new threat
prevention policy.

See “Creating Threat Prevention Policies” on page 841 for details.

RELATED DOCUMENTATION
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Configuring Juniper ATP Cloud (No Juniper Connected Security and No
Guided Setup) Overview

This is an outline of the configuration tasks you must complete to configure Juniper ATP Cloud mode
without Juniper Connected Security mode.

NOTE: Configuring Policy Enforcer (Juniper Connected Security mode) is required if you want
to work on the Juniper Connected Security architecture from within Security Director.

If you prefer to use guided setup, which automatically takes you through the steps listed below, it is located
under Configure>Guided Setup >ATP Cloud.

• Juniper ATP Cloud license and account are needed for all threat prevention types (Juniper ATP Cloud
with PE, Juniper ATP Cloud, and Cloud Feeds only). If you do not have a Juniper ATP Cloud license,
contact your local sales office or Juniper Networks partner to place an order for a Juniper ATP Cloud
premium license. If you do not have a Juniper ATP Cloud account, when you configure Juniper ATP
Cloud, you are redirected to the Juniper ATP Cloud server to create one. Please obtain a license before
you try to create a Juniper ATP Cloud account. Refer to “Obtaining a Juniper ATP Cloud License” on
page 1142 for instructions on obtaining a Juniper ATP Cloud premium license.

• Before you configure Juniper ATP Cloud you must enter the IP address and login credentials for the
policy enforcer virtual machine. Go toAdministration > Policy Enforcer > Settings. Once this information
is entered, you can begin the setup process. See “Policy Enforcer Settings” on page 1149. (Refer to “Policy
Enforcer InstallationOverview” on page 1122 for instructions on downloading Policy Enforcer and creating
your policy enforcer virtual machine.)
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1. Create one or more Juniper ATP Cloud realms and enroll SRX Series devices in the appropriate realm.
(Enroll devices by clicking Add Devices in the list view once the realm is created.)

In the UI, navigate to Configure>Threat Prevention>ATP Cloud Realms. Click the + icon to add a new
ATP Cloud realm.

See “Creating Juniper ATP Cloud Realms and Enrolling Devices or Associating Sites” on page 876 for
details.

2. Create a threat prevention policy, including profiles for one or more threat types: C&C server, infected
host, or malware.

In the UI, navigate to Configure>Threat Prevention >Policy. Click the + icon to create a new threat
prevention policy.

See “Creating Threat Prevention Policies” on page 841 for details.

3. You must assign a threat prevention policy to a firewall rule before it can take affect.

In the UI, navigate to Configure > Firewall Policy > Policies. In the Advanced Security column, click an
item to access the Edit Advanced Security page and select the threat prevention policy from the Threat
Prevention pulldown list.

RELATED DOCUMENTATION

Creating Juniper ATP Cloud Realms and Enrolling Devices or Associating Sites | 876

Creating Threat Prevention Policies | 841

Creating Geo IP Policies | 1018
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Creating Juniper ATP Cloud Realms and Enrolling Devices or Associating
Sites

You can select a geographical location and enter your Juniper ATP Cloud credentials to create a realm and
associate sites or devices with the realm.

If you do not have Juniper ATPCloud account, select a geographical region and click here. You are redirected
to the Juniper ATP Cloud account page.

Before You Begin

• Understand which type of Juniper ATP Cloud license you have: free, basic, or premium. The license
controls which Juniper ATP Cloud features are available.

• To configure a Juniper ATP Cloud realm, you must already have Juniper ATP Cloud account with an
associated license.

• Ensure that the internet connectivity is available for Policy Enforcer. Without the internet connectivity,
you cannot create a realm.

• Decide which region will be covered by the realm you are creating. You must a select a region when you
configure a realm.

• Note that adding a device to a realm results in one or more commit operations occurring on the device
to apply the Juniper ATP Cloud or Policy Enforcer configuration.

To configure ATP Cloud Realm:

1. Select Configure>Threat Prevention>Feed Sources.

The Feed Sources page appears.

2. In the ATP Cloud tab, click the + icon to add a realm.

3. Complete the initial configuration by using the guidelines in Table 274 on page 876 below.

4. Click Finish.

Table 370: Fields on the Add ATP Cloud Realm Page

DescriptionField

ATP Cloud Realm Credentials
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Table 370: Fields on the Add ATP Cloud Realm Page (continued)

DescriptionField

Select a region of the world from the available choices.

The following options are available in the Location list:

• North America

• European Region

• Canada

• Asia Pacific

By default, the North America value appears in the list. To know more about the geographic
region, see here.

Location

Enter your e-mail address. Your username for Juniper ATP Cloud is your e-mail address.Username

Enter a unique string at least 8 characters long. Include both uppercase and lowercase letters,
at least one number, and at least one special character (~!@#$%^&*()_-+={}[]|:;<>,./?); no spaces
are allowed, and you cannot use the same sequence of characters that are in your username.

Password

Enter a name for the security realm. This should be a name that is meaningful to your organization.
A realm name can only contain alphanumeric characters and the dash symbol. Once created,
this name cannot be changed.

NOTE: When you create a custom feed with a realm, the feed is associated at the site level and
not at the realm level. If you modify this realm and associate new sites to it, a warning message
is shown that there are custom feeds are associatedwith this realm. Changing the site information
will change the custom feed information. You must go and edit the custom feed that was
associated with this realm and verify the realm association.

Realm

Site

Select one or more sites to enroll into the realm. If there are no sites associated with the realm,
click Create new site. To knowmore about creating a new site, see “Creating Secure Fabric and
Sites” on page 353.

NOTE:
• If you are using Juniper ATP Cloud without Policy Enforcer, you are not prompted to select
a site.

• Assigning a site to the realm will cause a change in the device configuration in the associated
devices.

• You must select the sites either with tenants or without tenants. You cannot select both at a
time.

Site

1243

https://sky.junipersecurity.net/


Table 370: Fields on the Add ATP Cloud Realm Page (continued)

DescriptionField

Lists all devices from the realm that are not managed in Security Director. You must manually
discover them.

If you are using Juniper ATP Cloud with Policy Enforcer and you have no devices enrolled in
the realm, you are asked to select devices in the box on the left and move them to the right to
enroll them. All selected devices are automatically enrolled with Juniper ATP Cloud when you
finish the guided setup. To disenroll a device, you can edit a realm and move the device back to
the left side box.

NOTE: Adding a device to a realm results in one or more commit operations occurring on the
device to apply the Juniper ATP Cloud or Policy Enforcer configuration.

Unmanaged
Devices

Global Configuration

Enable this option to receive IPv6 feeds (C&C and Geo IP) from Policy Enforcer.IPv6 Feeds

Select a threshold level to block the infected hosts and to send an e-mail to the selected
administrators notifying about the infected host events.

Click the+ sign if you want to add new administrators to the list.

Threat Level
Threshold

Enable this option to log the Malware or the Host Status event or both the event types.Logging

Click the add icon (+) to enter the trusted IPv4 address of the proxy server, in the Server IP
column.

When there is a proxy server between users on the network and a firewall, the firewall might
see the proxy server IP address as the source of an HTTP or HTTPS request, instead of the
actual address of the user making the request.

With this in mind, X-Forwarded-For (XFF) is a standard header added to packets by a proxy
server that includes the real IP address of the client making the request. Therefore, if you add
trusted proxy servers IP addresses to the list in Juniper ATP Cloud, by matching this list with
the IP addresses in the HTTP header (X-Forwarded-For field) for requests sent from the SRX
Series devices, Juniper ATP Cloud can determines the originating IP address.

NOTE: XFF only applies to HTTP or HTTPS traffic, and only if the proxy server supports the
XFF header.

Proxy Servers
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NOTE: If you enrolled a device into a realm from within Security Director and you want to
disenroll it, you must do that from within Security Director. If you enrolled a device into a realm
fromwithin Juniper ATPCloud and youwant to disenroll it, youmust do that fromwithin Juniper
ATP Cloud. You cannot disenroll a device from within Security Directory that was enrolled from
within Juniper ATP Cloud.

RELATED DOCUMENTATION

About the Feed Sources Page | 862

Juniper ATP Cloud Realm Overview | 866

Using Guided Setup for Juniper ATP Cloud | 1230

Creating Secure Fabric and Sites | 353
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CHAPTER 105

Cloud Feeds Only Threat Prevention

IN THIS CHAPTER

Configuring Cloud Feeds Only | 1246

Configuring Cloud Feeds Only

This in an outline of the configuration tasks you must complete to configure Cloud feeds only threat
prevention.

NOTE: Since devices are not enrolled to ATP Cloud in Cloud feed only mode, there is no
information to display under Monitor > Threat Prevention, and therefore those screens are
unavailable.

• Juniper ATP Cloud license and account are needed for the following (Juniper ATP Cloud with Juniper
Connected Security, Juniper ATP Cloud, and Cloud feeds only). If you do not have a Juniper ATP Cloud
license, contact your local sales office or Juniper Networks partner to place an order for a Juniper ATP
Cloud premium license. If you do not have a Juniper ATP Cloud account, when you configure Juniper
ATP Cloud, you are redirected to the Juniper ATP Cloud server to create one. Please obtain a license
before you try to create a Juniper ATP Cloud account. Refer to “Obtaining a Juniper ATP Cloud License”
on page 1142 for instructions on obtaining a Juniper ATP Cloud premium license.

• Before you configure Cloud Feeds you must enter the IP address and login credentials for the policy
enforcer virtual machine. Go to Administration > Policy Enforcer > Settings. Once this information is
entered, you can begin the setup process. See “Policy Enforcer Settings” on page 1149. (Refer to “Deploying
and Configuring the Policy Enforcer withOVA files” on page 1124 for instructions on downloading Policy
Enforcer and creating your policy enforcer virtual machine.)
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To configure Security Director for Cloud feed only threat prevention, do the following:

NOTE: Cloud feed only configuration is similar to ATPCloud (without Juniper Connected Security)
configuration. The only differences being that devices do not have to be enrolled to Juniper ATP
Cloud and the only threat prevention types available are command and control server and Geo
IP.

1. Create a tenant representing an Enterprise. When a tenant is created, a VRF is assigned to the tenant.

In the UI, navigate to Devices >Secure Fabric > Tenants. Click the + icon to create a new tenant.

See “Create Secure Fabric Tenants” on page 364 for details.

NOTE: In Policy Enforcer Release 20.1R1, only MX series devices support LSYS and VRF.
Also, only root-logical system is supported. All the sites of a realm are either with tenants or
without tenants.

2. Create one or more Juniper ATP Cloud realms and add devices to the realm. (Note that devices do not
have to be enrolled to Juniper ATP Cloud for Cloud Feed only mode.)

In the UI, navigate to Configure>Threat Prevention>ATP Cloud Realms. Click the + icon to add a new
ATP Cloud realm.

See “Creating Juniper ATP Cloud Realms and Enrolling Devices or Associating Sites” on page 876 for
details.

3. Create sites and add devices to those sites.

In the UI, navigate to Devices >Secure Fabric. Click the + icon to create a new site.

See “Creating Secure Fabric and Sites” on page 353 for details.

4. Create a policy enforcement group.

In the UI, navigate toConfigure>SharedObjects>Policy EnforcementGroups. Click the + icon to create
a new policy enforcement group.

See “Creating Policy Enforcement Groups” on page 1022 for details.

5. Create a threat prevention policy for Command and Control server, Geo IP, or Infected hosts.

In the UI, navigate to Configure>Threat Prevention >Policy. Click the + icon to create a new threat
prevention policy.
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See “Creating Threat Prevention Policies” on page 841 for details.

6. Configure Geo IP settings for inclusion in a firewall policy. See “Creating Geo IP Policies” on page 1018.

You must select your Geo IP policy as the source and/or destination of a firewall rule before it can take
effect. Navigate to Configure > Firewall Policy > Policies.

RELATED DOCUMENTATION

Creating Juniper ATP Cloud Realms and Enrolling Devices or Associating Sites | 876

Creating Geo IP Policies | 1018

Creating Threat Prevention Policies | 841

Policy Enforcer Settings | 1149
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CHAPTER 106

Configuring No ATP Cloud (No Selection) (without
Guided Setup)

IN THIS CHAPTER

Configuring No ATP Cloud (No Selection) (without Guided Setup) Overview | 1249

ConfiguringNoATPCloud (No Selection) (withoutGuided Setup)Overview

Youwouldmake no ATP Cloud selection to configure Juniper Connected Security using only custom feeds.
Custom feeds are the only threat prevention type available if you make no selection for ATP Cloud
Configuration Type in the Policy Enforcer Settings page.

• Before you configure Policy Enforcer, you must enter the IP address and login credentials for the policy
enforcer virtual machine. Go to Administration > Policy Enforcer > Settings. Once this information is
entered, you can begin the setup process. See “Policy Enforcer Settings” on page 1149. (Refer to “Policy
Enforcer InstallationOverview” on page 1122 for instructions on downloading Policy Enforcer and creating
your policy enforcer virtual machine.)

• There are some concepts you should understand before you begin the configuration. It is recommended
you read about them here in advance.“Policy Enforcer Configuration Concepts” on page 1112.

To configure Policy Enforcer with no ATP Cloud selection and without the guided setup:

1. In the Secure Fabric page, create sites and add devices to those sites.

In the UI, navigate to Devices >Secure Fabric. Click the + icon to create a new site.

See “Creating Secure Fabric and Sites” on page 353 for details.

2. Create a policy enforcement group.

In the UI, navigate toConfigure>SharedObjects>Policy EnforcementGroups. Click the + icon to create
a new policy enforcement group.

See “Creating Policy Enforcement Groups” on page 1022 for details.

3. Create a custom feed and select one of the following custom feeds as a threat prevention types:
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• Dynamic Address

• Allowlist

• Blocklist

• Infected Hosts

• DDoS

In the UI, navigate to Configure>Threat Prevention> Feed Sources. Click Create to create a custom
feed.

See “Creating Custom Feeds” on page 890 for details.

4. Add the threat prevention policy, including profiles for one or more threat types: C&C server, infected
host, malware.

In the UI, navigate to Configure> Threat Prevention > Policies. Click the + icon to create a new threat
prevention policy.

See “Creating Threat Prevention Policies” on page 841 for details.

RELATED DOCUMENTATION

Secure Fabric Overview | 355

Creating Secure Fabric and Sites | 353

Creating Policy Enforcement Groups | 1022

Creating Custom Feeds | 890

Threat Prevention Policy Overview | 848

Creating Threat Prevention Policies | 841
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Migration Instructions for Spotlight SecureCustomers
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Moving From Spotlight Secure to Policy Enforcer
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Spotlight Secure and Policy Enforcer Deployment Comparison | 1252

License Requirements | 1252

Juniper ATP Cloud and Spotlight Secure Comparison Table | 1252

Migrating Spotlight Secure to a Policy Enforcer Configuration Overview | 1254

Installing Policy Enforcer | 1255

Configuring Advanced Threat Prevention Features: Spotlight Secure/Policy Enforcer Comparison | 1261

The Spotlight Secure Threat Intelligence Platform aggregates threat feeds frommultiple sources to deliver
open, consolidated, actionable intelligence to SRX Series Devices across an organization. This product is
now superseded by the Juniper Connected Security Policy Enforcer. The Juniper Connected Security
framework delivers enhanced security from external as well as internal attacks by leveraging both security
as well as network devices as a coherent security system.

Policy Enforcer is an orchestration solution that orchestrates user intent policy enforcement for threat
remediation as well as micro-segmentation across the entire network. This document talks about the
logistics of migrating from Spotlight Secure to Policy Enforcer.

Spotlight Secure and Policy Enforcer with Juniper ATP Cloud are two different platforms and therefore a
direct migration of threat policies from Spotlight Secure to Policy Enforcer is not supported. Instead it is
recommended that you remove Spotlight Connector from your Space Fabric and remove threat related
configurations on Security Director before you install Policy Enforcer. Then you will need to reconfigure
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your data and threat feeds. The following sections provide an overview of the transition process from
Spotlight Secure to Policy Enforcer with Juniper ATP Cloud.

Spotlight Secure and Policy Enforcer Deployment Comparison

The function of Spotlight Secure connector, to bring together all the available threat intelligence andmake
it available to security policies, is now done via Policy Enforcer with Juniper ATP Cloud. In addition, Policy
enforcer is a key part of the Juniper Connected Security Solution.

Spotlight Secure was installed to a separate virtual machine and then added as a specialized node to the
Junos Space Fabric on Junos Space until version 15.1. Policy Enforcer is shipped as a virtual machine that
is deployed independently. Instead of adding the new VM as a Junos Space node, the configuration has
been simplified with a workflow using the Security Director user interface.

NOTE: Spotlight Secure supported a HA deployment. The current version of Policy Enforcer is
supported only as a single stand-alone deployment.

License Requirements

For existing Spotlight Secure customers, no new additional license is needed. If you have a Spot-CC license,
it can be used with Policy Enforcer and Juniper ATP Cloud as well. A Policy Enforcer license would only
be needed if you want to use the complete set of Juniper Connected Security features with Juniper ATP
Cloud. Juniper Connected Security/Policy Enforcer features includes all threat prevention types: C&C,
infected hosts, malware, GeoIP, and policy management and deployment features such as secure fabric
and threat prevention policies. See “Features By Juniper ATP Cloud Configuration Type” on page 1116 for
more details.

Juniper ATP Cloud and Spotlight Secure Comparison Table

The following table provides a product comparison:
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Table 371: Juniper ATP Cloud and Spotlight support Quick Summary

Workflow using Juniper ATP Cloud,
SecurityDirector and Policy Enforcer

Support with Policy
Enforcer and Juniper
ATP Cloud

Support in Spotlight
SecureFeature

• Create a Realm in Juniper ATP Cloud
if you do not already have one

• Configure Policy Enforcer in Cloud
feed only or Juniper ATP Cloud or
Juniper ATP Cloud with Juniper
Connected Securitymodes to connect
to the realm

• Configure a Threat Prevention Profile
using Command and Control options

• Use this Threat Prevention Profile in
Firewall Policy

Fully SupportedFully SupportedCommand andControl
Feed

• Create a Realm in Juniper ATP Cloud
if you do not already have one

• Configure Policy Enforcer Setting in
Juniper ATP Cloud mode

• Create a Custom Feed using Blocklist,
Allowlist or Dynamic address options
selecting static IP or file options

Blocklist, Allowlist,
Infected Host, and
Dynamic Address
features are fully
supported

Blocklist, Allowlist and
Dynamic Address
features are fully
supported.

Custom Feeds

Juniper ATP Cloud supports an Infected
Host feed, natively integratedwith Policy
Enforcer and Security Director.

Juniper ATP Cloud
supports an Infected
Host feed, natively
integrated with Policy
Enforcer and Security
Director.

Not directly
supported by
Spotlight. You must
create custom feeds

Infected Host
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Table 371: Juniper ATP Cloud and Spotlight support Quick Summary (continued)

Workflow using Juniper ATP Cloud,
SecurityDirector and Policy Enforcer

Support with Policy
Enforcer and Juniper
ATP Cloud

Support in Spotlight
SecureFeature

Juniper ATP Cloud supports an Infected
Host feed which is natively integrated
with Policy Enforcer. Policy Enforcer can
take block/quarantine actions at the
switch port level.

Juniper ATP Cloud
supports an Infected
Host feed which is
natively integrated with
Policy Enforcer. Policy
Enforcer can take
block/quarantine
actions at the access
network level.

NOTE: This requires a
Policy Enforcer license
and does not comewith
a SPOT_CC license.

Not supported using
Spotlight and Security
Director

Infected Host
Remediation at the
Access Network level

Migrating Spotlight Secure to a Policy Enforcer Configuration Overview

In this section, there is a side by side comparison of feature configuration for Spotlight Secure on Security
Director 15.1 and Policy Enforcer on Security Director 16.1 and higher to aid in re-configuring your threat
policies.

This is an overview of the tasks needed to migrate:

1. Document the current data and feed configuration from current version of Security Director.

2. Remove Spotlight Connector from your Junos Space Fabric and remove the threat prevention
configuration.

3. Upgrade to the latest versions of Junos Space and Security Director.

NOTE: Since the underlying operation system is upgraded to Centos6.8 on Junos Space
version 16.1, first upgrade Junos Space and applications to 15.2R2 and then follow the
documentation to restore the database before deploying 16.1 or higher. Please refer to the
Junos Space 16.1 release notes for details.

4. Deploy the Policy Enforcer virtual machine. See instructions in the following section.
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5. Deploy Security Director and install Policy Enforcer to Security Director.

6. Configure a Juniper ATP Cloud realm and enroll SRX Series devices into the realm. For all deployment
models, it is necessary to configure ATP Cloud Realm and enroll firewalls.

7. Configure feeds and threat policies.

Installing Policy Enforcer

Policy Enforcer provides centralized, integrated management of all your security devices (both physical
and virtual), allowing you to combine threat intelligence from different solutions and act on that intelligence
from one management point. Using Policy Enforcer and the intelligence feeds it offers through Juniper
ATP Cloud, you can create threat prevention policies that provide monitoring and actionable intelligence
for threat types such as known malware, command and control servers, infected hosts, and Geo IP-based
server data.
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Policy enforcer is shipped as a OVA file that should be deployed over VMware ESX.
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1. Download the Policy Enforcer virtualmachineOVA image from the JuniperNetworks software download
page. It is recommended to deploy Policy Enforcer on the same ESX server as Junos Space.
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NOTE: Do not change the name of the Policy Enforcer virtual machine image file that you
download from the Juniper Networks support site. If you change the name of the image file,
the creation of the Policy Enforcer virtual machine can fail.

Figure 156: Deploy Policy Enforcer OVF File 1

Figure 157: Deploy Policy Enforcer OVF File 2
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NOTE: See “Deploying and Configuring the Policy Enforcer withOVA files” on page 1124 for
the complete Policy Enforcer installation documentation.

2. Initial configuration is done through the console. In addition to network and host configuration, you
must set a customer ID and reset the root password. The default login to Policy Enforcer is Username:
root,Password: abc123
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Figure 158: Policy Enforcer Configuration Summary

3. Once Policy Enforcer is deployed, it must be added to Security Director via Security Director User
Interface. From the Security Director UI, navigate to Administration > Policy Enforcer > Settings.

NOTE: Unlike Spotlight Secure, Policy Enforcer does not need to be added to Junos Space
Fabric. The addition is done only through the Security Director UI.

4. On the Settings page, there three ATP Cloud Configuration Types to choose from.

• ATPCloudwith Juniper Connected Security—All Policy Enforcer features and threat prevention types
are available

• ATP Cloud—All threat prevention types are available: Command and control server, Geo IP, and
Infected hosts.

• Cloud feeds only—Command and control server and Geo IP are the only threat prevention types
available.

• No selection (No ATP Cloud)—You can choose to make no selection. When you make no selection,
there are no feeds available from Juniper ATP Cloud, but the benefits of Secure Fabric, Policy
Enforcement Groups, and Threat Prevention policies provided by Policy Enforcer are available.
Infected hosts is the only prevention type available
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NOTE: You can switch fromCloud feeds only to ATP Cloud, or ATP Cloud to ATP Cloudwith
Juniper Connected Security, but the reverse is not supported.

NOTE: If you upgrade from Cloud feeds only to ATP Cloud, you cannot roll back again.
Upgrading resets all devices previously participating in threat prevention, and you must
re-enroll them with ATP Cloud. This is true for upgrading from ATP Cloud to ATP Cloud with
Juniper Connected Security. “ATP Cloud with Juniper Connected Security” is for the Juniper
Connected Security solution and not covered in this section.

NOTE: See “Juniper ATP Cloud Configuration Type Overview” on page 1113 for the Policy
Enforcer documentation on this topic.

NOTE: Policy Enforcerwith ATPCloud does not support aworkflow for removing Policy Enforcer.
To switch to a different Policy Enforcer, replace the IP and login information in the Policy Enforcer
settings page.

ConfiguringAdvancedThreat Prevention Features: Spotlight Secure/Policy EnforcerComparison

The following section is a side by side comparison of how advanced threat prevention features were
configured on Spotlight Secure compared to how they are configured with Policy Enforcer.

Configuring Command and Control and Infected Host
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Spotlight Secure: C&C and Infected Host

This is how C&C and infected host feeds were configured on Security Director 15.1 with Spotlight Secure:

1. Under Security intelligence > Information Source, click + to add a new information source. Select
Spotlight Secure Cloud as source.

Figure 159: Spotlight Secure: Add Information Source

2. Create a Security Intelligence profile from Security intelligence > Profiles . Choose Command and
Control as the feed category and set the Blocking threshold. Configure Block Options and Logging.
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Figure 160: Spotlight Secure: Create Security Intelligence Profile

3. Complete the workflow to create a profile.

Figure 161: Spotlight Secure: Create Profile

4. Create a security intelligence policy.
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Figure 162: Spotlight Secure: Create Security Intelligence Policy

5. Apply the security intelligence policy to a firewall policy.

Figure 163: Spotlight Secure: Apply Security Intelligence Policy to Firewall Policy
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Policy Enforcer with ATP Cloud: C&C and Infected Host

This is how C&C and infected host feeds are configured on Security Director 16.1 and higher with Policy
Enforcer:

NOTE: Policy Enforcer can be configured with Juniper ATP Cloud or Cloud feeds only to enable
Command and Control feeds. The following instructions are for Cloud feeds only.

NOTE: In addition to the instructions provided here, Threat Prevention Guided Setup under
Configuration >Guided Setup >Threat Prevention can be leveraged for awizard drivenworkflow.

1. Configure a Juniper ATP Cloud Realm by navigating to Configure > Threat Prevention > ATP Cloud
Realms. Click + to create a realm.

(Youmust have a Juniper ATP Cloud account to configure a realm. If you do not have an account please
click on the link provided in the Juniper ATP Cloud Realm window to create one at the Juniper ATP
Cloud account page. See “Creating Juniper ATP Cloud Realms and Enrolling Devices or Associating
Sites” on page 876 for details).

NOTE: You do not need a Juniper ATP Cloud premium license to create an account or realm.

2. Once the ATP Cloud realm is created, add a policy by navigating to Configure > Threat Prevention >
Policies. Click + to create a policy. Enable the check box to Include C&C profile in policy and set threat
score thresholds, actions, and logging.
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Figure 164: Policy Enforcer: Create Threat Prevention Policy

Figure 165: Policy Enforcer: Create Threat Prevention Policy, Select Threat Score and Logging

3. Apply the threat prevention policy to a firewall policy.
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Figure 166: Policy Enforcer: Apply Threat Prevention Policy to Firewall Policy

4. Publish, verify the configuration and update to the firewall.

Figure 167: Policy Enforcer: Update Firewall Policy
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NOTE: If ATP Cloud is chosen as the ATP Cloud Configuration Type under Administration
> Policy Enforcer > Settings, the workflow remains the same, but additional parameters
become available for configuring anti-malware.

Configuring Custom Feeds

Spotlight Secure: Custom Feeds

This is how custom feeds were configured on Security Director 15.1 with Spotlight Secure:

1. Create an information source by navigating to Security Intelligence > Information Source . Click + to
add a source. (Note that WebApp Secure is no longer supported.)

Figure 168: Spotlight Secure: Add Information Source

2. Upload from a custom file. Select Source as Custom File Upload and point to a local file.
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Figure 169: Spotlight Secure: Configure Custom File Upload

3. Configure a periodic upload from a remote file server. Provide the full URL to the plain text file you
want to poll and enter server login information, Username and Password.

Figure 170: Spotlight Secure: Enter Server Login for Custom File Upload
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4. Create a dynamic object by navigating to Security Intelligence > Dynamic Address Group. Configure
the feed as the custom feed that was created in the previous step.

Figure 171: Spotlight Secure: Select Custom Feed in Dynamic Address Group

5. Use the dynamic object in a security policy.
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Figure 172: Spotlight Secure: Select Dynamic Address in Security Policy

6. Configure a custom feed as an allowlist or blocklist by navigating to Security Intelligence > Profiles.
Edit Global Allow List or Global Back List to add a custom feed created in the previous steps.

Policy Enforcer with ATP Cloud: Custom Feeds

This is how custom feeds are configured on Security Director 16.1 and higher with Policy Enforcer:

NOTE: In addition to the instructions provided here, Threat Prevention Guided Setup under
Configuration >Guided Setup >Threat Prevention can be leveraged for awizard drivenworkflow.

Policy Enforcer supports manually adding or uploading custom feed information from a file server. The
custom feed can be a dynamic object, infected hosts list, allowlist or blocklist which can then be used
within the match criteria of a firewall rule.

1. Create Custom Feeds by navigating to Configure > Threat Prevention > Custom Feeds. Click + to
create a new feed.

2. Provide a Name and Description for the custom feed and choose the tab for the type of feed:Dynamic
Address, Blocklist, Allowlist or Infected Host.

3. Manually configure the IP list or upload it from a local file. The IP list can be defined as individual IP
addresses, IP address ranges, or subnets. See “Creating Custom Feeds” on page 890 for complete details.
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NOTE: Dynamic objects can be used within a firewall policy to match criteria as a source or
destination address object.

NOTE: Policy Enforcer supports only cloud based C&C feeds and not custom C&C feeds.
Policy Enforcer APIs can be used to extend this functionality.

4. Upload a local file. Select the Upload file option in the right corner of the page.

5. If you have configured an allowlist, downloads from those IP addresses are considered trusted. For
blocklists, all downloads from those IP addresses are blocked. Dynamic objects can be used within a
firewall policy match criteria as a source or destination address object.

Figure 173: Policy Enforcer: Use Dynamic Addresses in Firewall Policy

Configuring Geo IP
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Spotlight Secure: Geo IP

This is how Geo IP feeds were configured on Security Director 15.1 with Spotlight Secure:

1. Create a GeoIP object under dynamic object by navigating to Security Intelligence >Dynamic Address
Group. Select the feed as GeoIP and pick the countries from the drop down list.

Figure 174: Spotlight Secure: Create Geo IP with Dynamic Address Group

2. Use the Geo IP object in a firewall policy.
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Figure 175: Spotlight Secure: Use Geo IP in Firewall Policy

Policy Enforcer with ATP Cloud: Geo IP

This is how Geo IP feeds are configured on Security Director 16.1 and higher with Policy Enforcer:

1. Define GeoIP objects that can then be used within the match criteria of a firewall policy by navigating
to Configure > Shared Objects > Geo IP. Create a Geo IP feed and choose countries to include from
the list.(This feature requires a SecIntel or Juniper ATP Cloud license.)
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Figure 176: Policy Enforcer: Create Geo IP

2. Use the Geo IP feed you created as the source or destination address in a firewall policy.

Figure 177: Policy Enforcer: Use Geo IP in the Firewall Policy
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Creating Log Report Definitions

Use this page to create log report definitions. Log-based reports help you to schedule reports based on
default reports and default filters defined. You can also generate reports with different data criteria,
including filters, aggregation criteria, and time range.

Before You Begin

• Read the “Reports Overview” on page 1285 topic.

• Review the Reports main page for an understanding of your current data set. See “Managing Report”
on page 1290 for field descriptions.

To configure a log report definition:

1. Select Report > Report Definitions.

2. Click Create and then select Log Report Definition.

1277



3. Complete the configuration according to the guidelines provided in the Table 372 on page 1278.

4. Click Preview as PDF to review the configuration.

5. Click OK to save the report definition.

6. Click Send Report Now to send the report through e-mail to the recipient immediately.

A new log report definition with the defined configurations is created. You can use the created policy
definition to identify the issues with the firewall rules.

Table 372: Log Report Definition Settings

GuidelinesSettings

General Information

Enter a unique name for the report definition that is a string of alphanumeric characters, colons,
periods, dashes, and underscores. No spaces are allowed and themaximum length is 29 characters

Report Name

Enter a description for the report definition; maximum length is 1024 characters.Description

Content

Click Use Data Criteria from Filters.

Select the data criteria from the list of default and user-created filters that are saved from the
Events and Logs page.

The details of the filters displayed are:

• Filter Name—Name of the filter.

• Filter Description—Description of the filter.

• Group By—Select group by option.

• Time Span (Last)—Select a period in Minutes/Hours/Days/Weeks/Months or select a time
range to generate reports.

• Filter By—Specify the filter criteria based on which the report must be generated.

Example: If you want to generate a report with event category as antivirus and event name
as AV_VIRUS_Detected_MT, then the value must be: Event Category = antivirus AND Event
Name = AV_VIRUS_DETECTED_MT.

• Chart—Select the chart type for the report.

• Show Top—Select the number of top records to be displayed in the generated report. Valid
range is 1 to 1000.

NOTE: The default time stamp value is last 3 hours.

Use Data Criteria
from Filters
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Table 372: Log Report Definition Settings (continued)

GuidelinesSettings

Schedule

Click Add Schedule.

Select the type of report schedule that you want to use:

• Run now—Select this option to schedule and publish the configuration at the current time.

• Schedule at a later time—Select this option if youwant to schedule and publish the configuration
at a later time.

Select the recurring schedule for report generation. The available options are:

• Repeat—Select this option to generate the report on an hourly, daily, weekly, monthly, or
yearly basis.

• Every—Select the number of days, weeks, or months for which the recurring report will be
generated.

• Ends—Select the end date and end time for the report.

Add Schedule

Email

Click Add Email Recipients

• Recipients—Enter or select the e-mail addresses of the recipients. By default, you can search
by first name and select registered users. You can also type in external email addresses.

• Subject—Enter the subject for the e-mail notification.

• Comment—Enter the comments for the e-mail notification.

NOTE: The reports are not sent if a specified recipient does not have permission for a device
or domain included in the report configuration when the report is generated.

Email Recipients
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Creating Policy Analysis Report Definitions

Use the Reports page to create policy analysis report definitions. Policy analysis reports help you to analyze
the firewall rule base for policies managed by Security Director. These reports also identify the firewall
rules that contain issues.

Before You Begin

• Read the “Reports Overview” on page 1285 topic.

• Review the Reports main page for an understanding of your current data set. See “Report Definition
Main Page Fields” on page 1293 for field descriptions.

Configuring Policy Analysis Report Definitions

To configure a policy analysis report definition:

1. Select Reports > Report Definitions.

2. Click Create and then select Policy Analysis Report Definition.

3. Complete the configuration according to the guidelines provided in the Table 373 on page 1280.

4. Click OK to save the report definition.

5. Click Preview as PDF to review the configuration.

6. Click Send Report Now to send the report through e-mail to the recipient immediately.

A new policy analysis report definition with the defined configurations is created. You can use the created
policy definition to identify the issues with the firewall rules.

Table 373: Policy Analysis Report Definition Settings

GuidelinesSettings

General Information

Enter a unique name for the report definition that is a string of alphanumeric characters, colons,
periods, dashes, and underscores. No spaces are allowed and the maximum length is 29
characters.

Report Name

Enter a description for the report definition; maximum length is 1024 characters.Description
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Table 373: Policy Analysis Report Definition Settings (continued)

GuidelinesSettings

Content

Select the anomaly type that you want to include in the report:

• Shadowed—Select this option to identify any shadowed rules. A rule is shadowed when all
the packets of a previous rule match with the current rule. By selecting this option, the
shadowed rules are not evaluated.

• Redundant—Select this option to identify redundant or duplicate rules. A redundant rule
performs the same action on the same packets as another rule. The security policy is not
affected by removing the redundant rules.

• Expired Scheduler—Select this option to identify rules with an expired schedule.

• Logging Disabled—Select this option to identify rules that have predefined policy profile with
all the logging functionality disabled.

• Unused Rules—Select this option to identify any unused rules.

NOTE: By default the report is generated for all types of anomalies.

Anomalies

Select time period for which you want to generate the report for unused rules. Default value is
Last day.

NOTE: This field is displayed only when you select Unused Rules option for Anomalies.

TimeSpan for
unused rules

Select a firewall policy type based onwhich youwant to create a policy analysis report definition:

• Standard—The policy analysis report definitions are created based on standard firewall policies.

• Unified—The policy analysis report definitions are created based on unified firewall policies.

Policy Type

Select the firewall policy filter to be added by selecting the policy name from the list.Firewall Policy

Schedule
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Table 373: Policy Analysis Report Definition Settings (continued)

GuidelinesSettings

Click Add Schedule.

Select the type of report schedule that you want to use:

• Run now—Select this option to schedule and publish the configuration at the current time.

• Schedule at a later time–Select this option if you want to schedule and publish the
configuration at a later time.

Select the recurring schedule for report generation. The available options are:

• Repeat—Select this option to generate the report on an hourly, daily, weekly, monthly, or
yearly basis.

• Every—Select the number of days, weeks, or months for which the recurring report will be
generated.

• Ends—Select the end date and end time for the report.

Add Schedule

Email

Click Add Email Recipients

• Recipients—Enter or select the e-mail addresses of the recipients. By default, you can search
by first name and select registered users. You can also type in external email addresses.

• Subject—Enter the subject for the e-mail notification.

• Comment—Enter the comments for the e-mail notification.

NOTE: The reports are not sent if a specified recipient does not have permission for a device
or domain included in the report configuration when the report is generated.

Email Recipients
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Creating Bandwidth Report Definitions

Use the Reports page to create bandwidth analysis report definitions. Bandwidth reports helps in analyzing
the bandwidth usage of an application or an user. It gives you important information on bandwidth usage
and helps you in identifying top applications and top users consuming more bandwidth.

Before You Begin

• Read the“Reports Overview” on page 1285 topic.

• Review the Reports main page for an understanding of your current data set. See “Report Definition
Main Page Fields” on page 1293 for field descriptions.

Configuring Bandwidth Report Definitions

To configure a bandwidth analysis report definition:

1. Select Reports> Report Definitions.

2. Click Create and then select Bandwidth Report Definition.

3. Complete the configuration according to the guidelines provided in the Table 374 on page 1283.

4. Click Preview as PDF to review the configuration.

5. Click OK to save the report definition.

6. Click Send Report Now to send the report through e-mail to the recipient immediately.

A new bandwidth analysis report definition with the defined configurations is created. You can use the
created policy definition to identify the issues with the bandwidth usage.

Table 374: Bandwidth Report Definition Settings

GuidelinesSettings

General Information

Enter a unique name for the report definition that is a string of alphanumeric characters, colons,
periods, dashes, and underscores. No spaces are allowed and the maximum length is 29
characters.

Report Name

Enter a description for the report definition; maximum length is 1024 characters.Description
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Table 374: Bandwidth Report Definition Settings (continued)

GuidelinesSettings

Content

Select the number of top records to be displayed in the generated report. Valid range is 1 to
1000.

Show Top

Select a period in Minutes/Hours/Days/Weeks/Months or select a time range to generate
reports.

Last

Choose the type of bandwidth report that you want to generate:

• Application andUser Usage—Select this option to generate a report on the bandwidth usage
statistics by application and user.

• Top Talkers—Select this option to generate a report on the source IPs, with the highest
bandwidth usage or maximum sessions, over a specified period.

Type of Bandwidth

Schedule

Click Add Schedule.

Select the type of report schedule that you want to use:

• Run now—Select this option to schedule and publish the configuration at the current time.

• Schedule at a later time—Select this option if you want to schedule and publish the
configuration at a later time.

Select the recurring schedule for report generation. The available options are:

• Repeat—Select this option to generate the report on an hourly, daily, weekly, monthly, or
yearly basis.

• Every—Select the number of days, weeks, or months for which the recurring report will be
generated.

• Ends—Select the end date and end time for the report.

Add Schedule

Email

Click Add Email Recipients

• Recipients- Enter or select the e-mail addresses of the recipients. By default, you can search
by first name and select registered users. You can also type in external email addresses.

• Subject- Enter the subject for the e-mail notification.

• Comment- Enter the comments for the e-mail notification.

NOTE: The reports are not sent if a specified recipient does not have permission for a device
or domain included in the report configuration when the report is generated.

Email Recipients
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Reports Overview

Reports are generated based on a summary of network activity and overall network status. These generated
reports can help you to perform a trend analysis of your network's activities to study changes in traffic
patterns. You can use the predefined reports as is, or you can build custom reports that meet specific
needs.

NOTE: Starting in Junos Space Security Director Release 21.2, Tenant Systems (TSYS) devices
are also supported.

Using reports, you can:

• Schedule reports based on the defined filters.

• Schedule reports based on the available default reports.

• Generate daily, weekly, and monthly reports, and send e-mail notifications to defined recipients.

• Generate reports with multiple sections, each section having its own criterion.

For example, if you are an administrator, you can schedule reports on a daily, weekly, or monthly basis,
and configure them to includemultiple criteria. You can also personalize the reports by adding your company
logo, cover page, header, footer, and so on.

A Juniper Networks branded cover page is the default cover sheet of the reports. It contains the report
title, name, and date of report creation. You can provide your company logo on the cover page along with
the Juniper Networks logo. You can also provide the text for the footer and the logo for the header. If you
do not provide the header and footer, the Juniper Networks branded header and footer are used. The
generated report includes Table of Contents (TOC) with links to each section of the report. When the
system generates a report, you and other designated recipients receive the report in PDF format through
e-mail.
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Using Reports

Reports are generated based on a summary of network activity and overall network status. These generated
reports can help you to perform a trend analysis of your network's activities to study changes in traffic
patterns. You can use the predefined reports as is, or you can build custom reports that meet specific
needs.

Using reports, you can:

• Schedule reports based on the defined filters.

• Schedule reports based on the available default reports.

• Generate daily, weekly, and monthly reports, and send e-mail notifications to defined recipients.

• Generate reports with multiple sections, each section having its own criterion.

For example, If you are an administrator, you can schedule reports on a daily, weekly, or monthly basis,
and configure them to includemultiple criteria. You can also personalize the reports by adding your company
logo, cover page, header, footer, and so on.

A Juniper Networks branded cover page is the default cover sheet reports. It contains the report title,
name, and date of report creation. You can provide your company logo on the cover page along with the
Juniper Networks logo. You can also provide the text for the footer and the logo for the header. If you do
not provide the header and footer, the JuniperNetworks branded header and footer are used. The generated
report includes Table of Contents (TOC)with links to each section of the report.When the system generates
a report, you and other designated recipients receive the report in PDF format through e-mail.

Logging

Logs, also called event logs, provide vital information for managing network security incident investigation
and response. Logging provides the following features:

• Receives events from SRX Series devices and application logs.

• Stores events for a defined period of time or a set volume of data.

• Parses and indexes logs to help speed up searching.

• Provides queries and helps in data analysis and historical events investigation.
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Using Report Definitions

You can use the Report Definitions page to view a summary of network activity and overall network status.
You can use the predefined reports as is, or you can build custom reports.

To use report definitions:

1. Select Reports > Report Definitions.

The Report Definitions page is displayed.

2. Click a column header. The available options are:

• Sort Ascending—Sorts reports in ascending order; for example, A to Z or 1 to 10.

• Sort Descending—Sorts reports in descending order; for example Z to A or 10 to 1.

• Show or Hide Columns—Provides a list of columns with check boxes to add or remove columns from
the report definitions table. Table 375 on page 1287 lists the columns that you can add to the table or
remove from the table.

• Check boxes—Each row has a check box. Select the check box to perform operations like, run now,
preview as PDF, send report, edit recipients, edit schedule, clone, edit the report definitions, and
delete the report definitions.

By default, some predefined reports are available.

Table 375: Report Definitions Columns

DescriptionField

Name of the report (user-created or predefined).Name

Description of the report definition.Description

Type of report definition used such as log reports, bandwidth report, or policy
analysis reports.

Type
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Table 375: Report Definitions Columns (continued)

DescriptionField

Details of the sections in the report such as Top Applications, Top Applications
Blocked, Top Roles, and so on.

Report Content

Report generation schedule such as daily, weekly, or monthly.Schedule

Recipients of the generated reports.Recipients

Time when the last report was generated, along with the status.Last Generated

Job ID of the report.Job ID
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Editing Report Definitions

To edit a report definition:

1. Select Reports > Report Definitions.

The Report Definitions page appears.

2. Select a report definition by clicking the appropriate check box.

3. On the upper right side of the Report Definitions page, click the Edit button.

The edit report definition page is displayed. The options available on the create report definition page
are available for editing.

4. Click OK to save your changes.
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Deleting Report Definitions

You can clear all unwanted report definitions that are not used anywhere in your network.

To delete a report definition:

1. Select Reports > Report Definitions.

The report definitions page appears.

2. Select the report definition that you want to delete, and then select the (-) minus sign. An alert message
appears verifying that you want to delete your selection.

3. Click Yes to delete your selection.

The delete report notification is displayed.

4. Click OK.

NOTE: An error message appears if the report definition is used by any object.
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Managing Report

Before You Begin

You can perform various actions using reports, such as run a report immediately, edit a schedule, edit
e-mail recipients, preview a report in pdf format, send reports, clone reports, and view report definition
details.

To perform these actions:

1. Select Reports > Report Definitions.

2. Select the report definition and then right-click the report definition or click theMore drop-down list.

3. Select the appropriate action from the drop-down list:

Run Now—Starting in Junos Space Security Director Release 16.1, you can select the Run Now option
that runs the report immediately and provides a link to view the report in pdf format. You can view the
archived reports by clicking the Generated Reports link on the left navigation pane. This option is also
available as the Run Now button on the Report Definitions page.

a. Configure according to the guidelines provided in the Table 376 on page 1292.

b. Click OK. The report is generated and a link is displayed to download the report in pdf format.

Preview as PDF—You can preview the generated report in pdf format. You can generate the report as
needed.

a. Configure according to the guidelines provided in the Table 376 on page 1292.

b. Click OK. The report is generated and a link is displayed to download the report in pdf format.

Send Report—Sends the report through e-mail to the recipient. The user receives a notification once
the report is sent. The user can also use the job ID to see more details of the job. You can generate the
report as needed.

a. Configure according to the guidelines provided in the Table 376 on page 1292.

b. Click OK.

The Edit Recipients page is displayed.
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c. Modify or add the recipients, subject line, or any comments for the e-mail notifications.

d. Click OK to send the report to the recipients.

A success message is displayed.

Edit Recipients—Allows user to edit or add the recipients, e-mail address, subject, and comments.

a. Modify or add recipients, subject, and comments in the e-mail.

b. Click OK.

Edit Schedule—Allows user to edit the schedule such as adding a recurrence, start date, end date, and
time.

a. Select an option:

• Run Now—To schedule the job immediately.

• Schedule at a later time—Select a date and time to schedule the job at a later period of time.

b. Select Recurrence to add details, such as the interval at which job should run and when the job
should end.

Clone— Allows the user to clone an existing report definition.

a. Edit the details of the report.
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b. Click OK.

Detailed View—Starting in Junos Space Security Director Release 16.2, you can view the report name,
description, report content type, report definition type, and its contents in Report Definition Details
page.

You can also click the icon next to Name in the Report Definitions page to view the Report Definitions
Details page.

Table 376: Run Now Settings

DescriptionFields

Choose an option from the following types:

• Run Now—To generate the report immediately, for the default time duration.

• Custom Time Range Selection—To generate the report immediately, for a selected time
range.

NOTE: If you select the type as Custom Time Range Selection, then Show Top and Time Span
(Last) fields are displayed.

Types

Select the number of top records to be displayed in the generated report. Valid range is 1 to
1000.

Show Top

Select a period in Minutes/Hours/Days/Weeks/Months or select Custom to choose the time
range to generate reports.

Time Span (Last)

Select all devices or specific devices. By default, data is displayed for all the devices in the
network.

Choose the Selective option to select specific devices.

Select devices from the Available column and click the right arrow to move these devices to
the Selected column.

Devices

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.2, you can view the report name, description,
report content type, report definition type, and its contents in Report Definition Details page.

16.2

Run Now—Starting in Junos Space Security Director Release 16.1, you can select the Run Now
option that runs the report immediately and provides a link to view the report in pdf format. You
can view the archived reports by clicking the Generated Reports link on the left navigation pane.

16.1
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Report Definition Main Page Fields

Use this page to get an overall, high-level view of your report definition settings. You can filter and sort
this information to get a better understanding of what you want to configure. Table 377 on page 1293
describes the fields on the Report Definitions page and Table 378 on page 1294 describes the predefined
report definitions.

Table 377: Report Definition Main Page Fields

DescriptionField

Name of the report (user-created or predefined).Name

Description of the report definition.Description

Predefined report or Custom report.Definition Type

Type of report definition used such as log reports, bandwidth report, or
policy analysis reports.

Type

Details of the sections in the report such as Top Applications, Top
Applications Blocked, Top Roles, and so on.

Report Content

Report generation schedule such as daily, weekly, or monthly.Schedule

Recipients of the generated reports.Recipients

Time when the last report was generated, along with the status.Last Generated

Job ID of the report.Job ID
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NOTE:
• Starting in Junos Space Security Director Release 17.1, Antivirus, URL Report, Application and
User Usage, IPS Threat Environment, and Threat Report predefined report definitions are
added.

• Starting in Junos Space Security Director Release 16.2, IPS Report predefined report definition
is added, which displays consolidated report of all IPS events.

• Starting in Junos Space Security Director Release 16.1, Top Destination Countries and Top
Source Countries predefined report definitions are added.

• Starting in Junos Space Security Director Release 15.2, Top Firewall Rules and Top Encrypted
Applications predefined report definitions are added.

Table 378: Predefined Report Definitions

DescriptionName

Displays report on top firewall service deny.Top Firewall Service Deny

Displays report on top services detected in system by firewall.Top Services Detected

Displays reports on top applications blocked.Top Applications Blocked

Displays report on top firewall generating logs.Top Firewall Rules

Displays report on top source IP addresses by count.Top Source IPs

Displays report on top source IP addresses by countries.Top Source Countries

Displays reports on top roles by count.Top Roles

Displays report on top destinations IP addresses by countries.Top Destination Countries

Displays report on top URLs detected.Top URLs Detected

Displays report on top firewall deny sources IP addresses.Top Firewall Deny Sources

Displays report on top security intelligence and AAMW events.Top SECINTEL and AAMW events

Displays report on top destination IP addresses by count.Top Destination IPs

Displays report on top applications that are using encryption.Top Encrypted Applications
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Table 378: Predefined Report Definitions (continued)

DescriptionName

Displays reports on top Web applications by count.Top Web Apps

Displays report on top firewall events by count.Top Firewall Events

Displays report on top antispam detected.Top Anti Spam Detected

Displays report on top firewall deny destinations IP addresses.Top Firewall Deny Destinations

Displays a consolidated report on all IPS events statistics.IPS Report

Displays a consolidated report on all antivirus events statistics.Antivirus

Displays a consolidated report on all URL events statistics.URL Report

Displays a report on the bandwidth usage statistics by application and user.Application and User Usage

Displays a report on the source IPs, with the highest bandwidth usage or
maximum sessions, over a specified period.

Top Talkers

Displays a consolidated report on all IPS threat events.IPS Threat Environment

Displays the statistics related to top threats identified through IDP, Antivirus,
Antispam, Screen, and Device Authentication failure events.

Threat Report

Displays the statistics of threats and risks like top high risk applications,
Threats and Malware, Top Bandwidth Usage by Apps and Top Malware
Source Countries and so on for application risk assessment, threat and
malware assessment, and user and web access assessment.

Threat Application Risk Assessment

Displays statistics related to a specific user. You can generate the report
using run now option, preview as PDF or send it over an email. You can
choose to have a complete record or top ten records for a user.

The report displays various statistics for users such as top URLs by session,
top high risk URLs visited, total bandwidth used by high risk URL categories,
breakdown of URL categories visited, total session used on risky URLs, and
so on.

URLs visited per User
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Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 17.1, Antivirus, URL Report, Application and
User Usage, IPS Threat Environment, and Threat Report predefined report definitions are added.

17.1

Starting in Junos Space Security Director Release 16.2, IPS Report predefined report definition
is added, which displays consolidated report of all IPS events.

16.2

Starting in Junos Space Security Director Release 16.1, TopDestination Countries and Top Source
Countries predefined report definitions are added.

16.1

Starting in Junos Space Security Director Release 15.2, Top Firewall Rules and Top Encrypted
Applications predefined report definitions are added.

15.2
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CHAPTER 109

My Profile
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Modifying Your User Profile in Security Director

Use the My Profile page to modify some details of your user profile.

User accounts are created by the administrator and the My Profile page lets you modify some details of
your user profile.

Before You Begin

• Read the “Overview of Users in Security Director” on page 1302 topic.

To modify the user profile:

1. SelectAdministration >MyProfile or, in the Utility bar, click the arrow next to the username and select
My Profile.

The My Profile page appears.

2. Modify your user profile according to the guidelines provided in Table 379 on page 1299.

3. Click OK.

Your modifications are saved and a confirmation message is displayed.

Table 379: My Profile Settings

DescriptionSetting

Basic Information

Displays your username; this field cannot be modified.Username
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Table 379: My Profile Settings (continued)

DescriptionSetting

Click Change Password to change your password.

The Change Password page appears. Modify the fields according to the guidelines
provided in Table 380 on page 1300.

Change Password

Modify your first name, which can be a string of alphanumeric characters and some
special characters (- _ . @). The maximum length is 32 characters.

First Name

Modify your last name, which can be a string of alphanumeric characters and some
special characters (- _ . @). The maximum length is 32 characters.

Last Name

Modify the e-mail address, which must be in the user@domain format.E-Mail Address

X.509 Certificate

Displays the details of the certificate parameters, if a certificate was previously
uploaded for the user.

Click Clear to clear the certificate subject name and the X.509 certificate file.

Certificate Subject Name

Upload an X.509 certificate file (.cer, .crt, or .pem extension), which is used to
authenticate the user instead of the username and password.

X.509 Certificate File

Object Visibility

Select this check box to view and manage objects from all domains to which you
are assigned.

Manage objects from all assigned
domains

Table 380: Change Password Settings

DescriptionSetting

Enter your existing password.Old Password
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Table 380: Change Password Settings (continued)

DescriptionSetting

Enter a password for the user.

The password must be at least six characters long, contain at least one lowercase letter,
contain at least one number that is not in the last position, must not contain the username
or the username in reverse, and must not have three characters repeated in succession.

The password strength indicator displays the efficiency of the password that you entered.

NOTE: You cannot proceed to the next step if the password strength indicator shows that
the password is weak.

Password

Reenter the password for confirmation.

Click OK. The password is changed and you are taken to the My Profile page.

Confirm Password
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Overview of Users in Security Director

Junos Space Security Director supports the authentication and authorization of users. A Junos Space Super
Administrator or User Administrator creates users and assigns roles to the users so that they can access
and manage users, devices, services, and so on. To access and manage Junos Space Security Director, a
user must be assigned one or more roles, which are validated during authorization.

Users receive permission to perform tasks only through the roles that they are assigned. In most cases, a
single role assignment enables a user to view and to perform tasks on the objects within a workspace. For
example, a user assigned the Device Manager role can discover devices, resynchronize devices, view the
physical inventory and interfaces for devices, and delete managed devices. A user that is assigned the User
Administrator role can create, modify, and delete other users in Junos Space, and perform actions, like
creating, modifying, deleting, and so on, specific to roles, domains, and remote profiles.

Junos Space is shippedwith the superuser account (username super) that has Super Administrator privileges,
which provides full access to Junos Space. When you first log in to Junos Space as the default Super
Administrator, you can perform all tasks and access all Junos Space system resources. Super administrators
can create new users and assign roles and domains to those users to specifywhich tasks users can perform.
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Creating Users in Security Director

Use the Users page to create new users and assign one or more roles and domains to the users. You assign
roles and domains to users based on the network management tasks that they perform. You need to have
the privileges of a super administrator or user administrator to create users.

Before You Begin

• Read the “Overview of Users in Security Director” on page 1302 topic.

• Review the Users main page to view the existing users. See “Users Main Page Fields” on page 1314 for
field descriptions.

To configure a user:

1. Select Administration > Users & Roles > Users.

The Users page appears.

2. Click Create.

The Create User page appears.

3. Complete the configuration according to the guidelines provided in Table 381 on page 1304.

NOTE: Fields marked with * are mandatory

4. Click OK.

A new user is created and you are returned to the Users page.
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Table 381: User Settings

DescriptionSetting

General

Enter a unique string of alphanumeric characters and some special characters (- _ . @).
No spaces are allowed and the maximum length is 128 characters.

Username

Select this option to generate a temporary password for the user. The user can log in
with the temporary password and change the password using the My Profile page.

Temporary Password

Specify the duration after which the temporary password expires. The user must log in
within this duration and change the temporary password; after the expiry of the password,
the user is not allowed to log in. The default is 24 hours and the range is 1 through 10,000
hours.

NOTE: This field is visible only if the Temporary Password check box is selected.

Temporary password will
expire after

Displays the system-generated temporary password. Click the Generate button to
generate another password

NOTE: This field is visible only if the Temporary Password check box is selected.

Temporary Password

Select this check box to send the generated temporary password to the e-mail address
specified for the user.

This check box is enabled only when the SMTP server is configured for Junos Space. If
the e-mail does not reach the user or the password is lost, the administratormust generate
a new temporary password. There is no option to resend the old temporary password.

NOTE: This field is visible only if the Temporary Password check box is selected.

E-mail password to user

Enter a password for the user.

The password must be at least six characters long, contain at least one lowercase letter,
contain at least one number that is not in the last position, must not contain the username
or the username in reverse, and must not have three characters repeated in succession.

The password strength indicator displays the efficiency of the password that you entered.

NOTE: You cannot proceed to the next step if the password strength indicator shows
that the password is weak.

Password

Reenter the password for confirmation.Confirm Password

Enter a string of alphanumeric characters and some special characters (- _ . @). The
maximum length is 32 characters.

First Name
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Table 381: User Settings (continued)

DescriptionSetting

Enter a string of alphanumeric characters and some special characters (- _ . @). The
maximum length is 32 characters.

Last Name

Enter a valid e-mail address in the user@domain format.E-Mail Address

Select the global setting or specify the maximum number of concurrent UI sessions
allowed. The range is 0 through 999; 0 indicates unlimited concurrent UI sessions.

Maximum Concurrent UI
Sessions

Upload an X.509 certificate file (.cer, .crt, or .pem extension), which is used to authenticate
the user instead of the username and password.

Click Next to continue.

X.509 Certificate File

Role Assignment

Specify the username of an existing user whose roles you want to assign to the new
user.

The roles for the user that you selected are displayed in the Selected column of the Role
field.

Use Same Roles Assigned
to

Select one or more roles in the Available column and click the forward arrow to confirm
your selection.

The selected roles are displayed in the Selected column.

NOTE: You must select at least one role.

Role

Select whether the user can view only the jobs triggered by that user (the default) or all
jobs.

Click Back to return to the previous section or Next to continue.

Job Management View

Domain Assignment

Specify the username of an existing user whose domains you want to assign to the new
user.

Use Same Domains
Assigned to
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Table 381: User Settings (continued)

DescriptionSetting

Select one ormore domains to assign to the user. If you select a domainwith subdomains,
the subdomains are also included. You must select at least one domain.

If you do not assign a domain to the user, the Global domain is assigned to the user by
default.

Click Back to return to the previous section or Finish to go to a summary page.

Available Domains

RELATED DOCUMENTATION
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Viewing and Terminating Active User Sessions in Security Director | 1307

Editing and Deleting Users in Security Director

You can edit and delete users from the Users page. If the tasks performed by a user, or the user is no
longer needed, then the administrator can delete the user.

Editing Users

To edit a user:

1. Select Administration > Users & Roles > Users.

The Users page appears.

2. Select the user that youwant to edit, and click the pencil icon. Alternatively, right-click a user and select
Edit User.

The Edit User page appears, showing the same fields that are presented when you create a user.

3. Edit the user fields as needed.
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NOTE: Some fields cannot be edited.

4. The Edit User page appears, showing the same fields that are presented when you create a user.

5. Click OK to save the changes.

The changes are saved and you are returned to the Users page.

Deleting Users

To delete a user:

1. Select Administration > Users & Roles > Users.

The Users page appears.

2. Select the user that you want to delete, and click the X icon.

The Delete Users page appears, displaying the list of users selected for deletion.

3. (Optional) Delete users who have jobs that are in progress or scheduled to run later, by clearing the
Exclude users who have scheduled or in-progress jobs check box..

4. Click OK to delete the selected users.

The users are deleted and you are returned to the Users page.

RELATED DOCUMENTATION

Overview of Users in Security Director | 1302

Creating Users in Security Director | 1303

Viewing and Terminating Active User Sessions in Security Director

As a Junos Space user administrator, you can view and terminate user sessions before starting amaintenance
cycle. You can view the list of users who are logged in along with details of their IP addresses, including
where they logged in and the duration of their sessions. You can view and terminate user sessions from
the Users page.
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Viewing Active User Sessions

To view active user sessions:

1. Select Administration > Users & Roles > Users.

The Users page appears.

2. Click the Active Sessions button.

The Active Sessions page appears, displaying the list of active user sessions. Table 382 on page 1308
describes the fields on this page.

3. Click Close to close the page.

You are returned to the Users page.

Table 382: Active Sessions Fields

DescriptionField

Username of the user.Username

Current domain to which the user belongs.Current Domain

IP address of the client from which the user has logged in.IP Address

Name of the node in the Junos Space fabric that is currently serving the
user session.

Fabric Node Name

Date and time at which the user session was initiated.Session Start Time

Duration of the user session.Session Duration
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Terminating Active User Sessions

To terminate one or more active user sessions:

NOTE: You cannot terminate sessions of a user with the username super

1. Select Administration > Users & Roles > Users.

The Users page appears.

2. Click the Active Sessions button.

The Active Sessions page appears, displaying the list of active user sessions.

3. Select the sessions that you want to terminate, and click End Session.

The End User Sessions page appears displaying the sessions selected for termination.

4. Specify whether you want to terminate the sessions immediately or later. If you specify that you want
to terminate the sessions later, you must enter a date and time (in MM/DD/YYYY and HH:MM:SS
AM/PM/24-hour formats).

5. Click OK.

The Job Detail: Terminate User Session page appears displaying the details of the session termination
job.

6. Click OK to close the Job Detail page.

You are returned to the Users page.

RELATED DOCUMENTATION

Overview of Users in Security Director | 1302

Creating Users in Security Director | 1303
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Viewing the User Details in Security Director

You can view the details of users, which allows you to view information about a user at a quick glance on
one page, from the Users page.

To view the details of a user:

1. Select Administration > Users & Roles> Users.

The Users page appears.

2. Double-click the user for which you want to view the details. Alternatively, select a user and, from the
More menu, click View User Details.

The User Details page appears. Table 383 on page 1310 describes the fields on this page.

3. Click Close.

You are returned to the Users page.

Table 383: Users Details Page Fields

DescriptionField

Username of the user.Username

Name of the user.Name

E-mail address of the user.E-mail

Indicates whether the user was created manually (local) or added automatically by
Junos Space through remote login (remote).

User Type

Indicates whether the user is enabled or disabled. Users are enabled by default. A
user whose account is disabled cannot log in to Junos Space.

Status

Indicateswhether the global settingsmust be used to determine themaximumnumber
of concurrent UI sessions permitted for the user.

Use Global Settings

Maximum number of concurrent UI sessions permitted for the user. If this field is set,
then this value overrides the global settings.

Maximum concurrent UI
sessions

Indicates whether a user is locked out or not. Users who are locked out cannot log
in to Junos Space and must request an administrator to unlock their user accounts.

Locked Out

Indicates whether the user’s password is active, expired, or temporary.Password Status
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Table 383: Users Details Page Fields (continued)

DescriptionField

Indicates whether the user can view only the jobs triggered by that user or all jobs.View Jobs

Roles to which the user is assigned. For the selected role, the Role Summary field on
the right side of the page displays the tasks associated with that role.

Assigned Roles

Domains to which the user is assigned. Users can access only those objects within
the domain to which they are assigned.

Assigned Domains

RELATED DOCUMENTATION
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Clearing Local Passwords for Users in Security Director

The Clear Local Passwords feature lets you remove the local password that you assign to users when
remote or remote-local authentication is enabled.

NOTE: This feature is enabled in Security Director only if you have configured remote
authentication or remote-local authentication in Junos Space Network Management Platform.

A local password is an emergency password that allows remote users to log in to Junos Space using local
authentication (username and password) in the following cases:

• If the authentication server goes down (in remote mode)

• If remote authentication fails (in remote-local mode)

To remove local users passwords, you must have the permission to perform the Clear Local Passwords
action. However, if you are logged in to Security Director, you cannot perform this action for the user
account that you used for logging in.

To clear local passwords for one or more users:

1. Select Administration > Users & Roles > Users.

The Users page appears.
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2. Select the users for whom you want to clear the local passwords. From the More or right-click menu,
select Clear Local Passwords.

The Clear Local Passwords page appears, displaying the list of users for whom you want to remove the
local passwords.

3. Click Clear Local Passwords to confirm that you want to clear the local passwords for the selected
users.

The local passwords for the selected users are cleared and you are returned to the Users page.

RELATED DOCUMENTATION

Overview of Users in Security Director | 1302

Creating Users in Security Director | 1303

Disabling and Enabling Users in Security Director

You can disable and enable disabled users from the Users page. The Status column on the Users page
displays the status of the users.

Administrators can disable users to prevent them from logging into Security Director and performing any
actions. By default, all users are enabled.

NOTE: You cannot disable your own user account or the super user account (username super).

When a user is disabled and tries to log in, a message indicating that the account is disabled is displayed.
If the user is logged in at the time when the user is disabled, the system logs off the user and displays a
message indicating that the user account is disabled.

Disabling Users

To disable one or more users:

1. Select Administration > Users & Roles > Users.

The Users page appears.
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2. Select the users that you want to disable. From either the More or right-click menu, select Disable
Users.

The Disable Users page appears, displaying the list of users selected for disabling.

3. Click Yes to confirm the disable operation.

The users are disabled and you are returned to the Users page.

Enabling Users

To enable one or more users:

1. Select Administration > Users & Roles > Users.

The Users page appears.

2. Select the disabled users that you want to disable. From either the More or right-click menu, select
Enable Users.

The Enable Users page appears, displaying the list of users selected for enabling.

3. Click Yes to confirm the enable operation.

The users are enabled and you are returned to the Users page.

RELATED DOCUMENTATION

Creating Users in Security Director | 1303
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Unlocking Users in Security Director

Junos Space Security Director locks out users who enter more than the permitted number of incorrect
passwords. If your user account is locked out, then an error message is displayed when you try to log in
to Security Director. You can try logging in from another client or request the administrator to unlock your
account.

By default, a user is locked out after four unsuccessful login attempts. Administrators can configure the
number of unsuccessful login attempts after which a user should be logged out in the Administration
workspace of Junos Space Network Management Platform.
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To unlock one or more users:

1. Select Administration > Users & Roles > Users.

The Users page appears.

2. Select the locked users that you want to unlock. From the More or right-click menu, select Unlock
Users.

The Unlock Users page appears, displaying the list of users selected for unlocking.

3. Click Yes to confirm that you want to unlock the users.

The users are unlocked and you are returned to the Users page.

RELATED DOCUMENTATION
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Users Main Page Fields

Use the Users page to view, create, modify, and delete users. You can also disable and enable users, unlock
users, clear local passwords, and view active sessions. Every user must be assigned at least one role and
belong to at least one domain. You can filter and sort the users displayed, and view details of each user.
Table 384 on page 1314 describes the fields on this page.

Table 384: Users Main Page Fields

DescriptionField

Username of the user.Username

First name of the user.First Name

Last name of the user.Last Name

E-mail address of the user.E-mail

Domains to which the user is assigned. Users can access only those objects within
the domain to which they are assigned.

Assigned Domain
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Table 384: Users Main Page Fields (continued)

DescriptionField

Indicates whether the user was created manually (local) or automatically by Junos
Space through remote login (remote).

User Type

Indicates whether the user is enabled or disabled. Users are enabled by default. A
user whose account is disabled cannot log in to Junos Space.

Status

Indicates whether the user’s password is active, expired, or temporary.Password Status

Indicates whether a user is locked out or not. Users who are locked out cannot log
in to Junos Space and must request an administrator to unlock their user accounts.

Locked Out

RELATED DOCUMENTATION
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Domain RBAC Overview

A domain is a sphere or a boundary around which you can interact with a system. A Junos Space Network
Management Platform domain encompasses all Junos Space objects; it enforces access, controls visibility,
and provides for management of network objects. By creating a domain, you create a container for
interacting with the system. Devices are the key elements in a domain. You use domains and the devices
within those domains to configure a device-management partitioning scheme allowing for role-based
access control (RBAC).

Domains allow you to control and partition a network from the management point of view. You can create
a network based on certain criteria while providing users with management access to their devices. At the
same time, domains allow sharing of objects and certain configuration enforcements. Objects in the Global
domain can only be accessed in read-only mode by the child domains, if view parent is enabled. Access
across peer domains is not allowed. This kind of network partitioning is required for bothmanaged security
service providers (MSSP) and enterprise customers. The Network Management Platform enables users to
manage objects from all the allowed domains in the aggregated view. However, Security Director does
not support this functionality. Starting in Security Director 15.2, RBAC is available on the Administration
tab, under the Users & Roles section on the left navigation pane.

The following sections explain the impact of domain RBAC on Security Director objects and services.
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About Domains

By default, Junos Space and, therefore, Security Director comeswith only the Global domain defined. New
domains can be created as child domains of the Global domain. When you create a domain, you work with
roles and users. Figure 178 on page 1317 shows a simple domain scheme that will be used as a reference
throughout this document. Formore information about creating domains, see “CreatingDomains in Security
Director” on page 1331.

Figure 178: Security Director Domains

Working with Roles

Roles are used to group access permissions for easier assignment to users. For example, the Super
Administrator role assigns read and write access to all aspects of Junos Space, Security Director, and the
functionswithin. On the other hand, theDomain Administrator has read andwrite access to some functions,
read-only access to other functions, and no access to some other functions. Security Director comes with
several predefined roles that cannot be changed, including the Super Administrator and the Domain
Administrator. User-defined roles can be created by cloning and then editing the predefined roles or by
creating new roles from scratch. Users are assigned to roles during the creation of their accounts or by
editing the user accounts after creation.

Users can be assigned to multiple roles. If a user is assigned to multiple roles that have conflicting
permissions, the least restrictive permissions are applied to that user account. For example, suppose the
Administrative Auditor role restricts users to only viewing report definitions and the Report Definition
Administrator role allows users to modify report definitions. If a user is assigned to both roles, that user
will be able to modify report definitions. Figure 179 on page 1318 illustrates this principle.
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Figure 179: Security Director Roles

Working with Users

User accounts can be thought of as the recipients of RBAC policies. In Security Director, users are assigned
to specific domains and to specific roles. Access to domains defines which devices and objects users can
work with and assignment of users to roles defines what functions users can perform on the objects to
which they have access. For more information about working with users, see “Creating Users in Security
Director” on page 1303.

Figure 180 on page 1318 shows the Global domain view of the Junos Space users list. Note the Assigned
Domain column outlined in green.

Figure 180: Security Director Users
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About Objects or Services

Prior to domain RBAC, you only needed write permission for a domain to create an object or service in it.
Now with domain RBAC, you also need access to a domain to create an object or service in that domain.
For example, suppose you have domains D1, D2, and Global. To create an object in D1, you must switch
to the D1 domain before you can create an object in that domain.

NOTE: You cannot create an object or service in one domainwhile you are in a different domain.

In Security Director Release 13.2 and later, the REST API cannot be used to create objects in child domains,
even if the user account usedwith the API has write access to the child domain. All objects created through
the REST API are created in the Global domain.

All the objects that are created internally as part of an operation are part of the domain in which the
operation is triggered. For example, all audit logs for an operation are created in the domain in which the
operation is triggered.

Reading or Viewing Objects or Services

You can view all objects in a domain to which you have access. In Security Director, you must switch the
view to the D1 domain to view objects in that domain. If you have read access to both the D1 and D2
domains, you cannot see D2 domain objects from the D1 domain view, and vice versa. You can see objects
in the Global domain from theD1 domain, provided theD1 domain has view parent permission. You cannot
see D1 or D2 objects from the Global domain.

The ability to read or write objects in any given domain is dependent on switching your view to that specific
domain from the Domains menu. However, Security Director also allows you to view objects in the parent
domain as read-only if the view parent setting is enabled. For example, given the domain structure shown
in Figure 178 on page 1317, the resulting views of the shared address objects in domains D1 and D2 are
shown in Figure 181 on page 1320 and Figure 182 on page 1320 and respectively.
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Figure 181: D1 Domain Addresses

In the D1 Domain view, address objects from the System, Global, and D1 Domains are visible. These
address objects can be used with devices and policies in the D1 Domain.

Figure 182: D2 Domain Addresses

Because the view parent setting is disabled in D2, the only visible addresses in the D2 domain are the ones
that exist in the SystemDomain. Any address created later in the D2Domain would also show in this view.

Updating or Modifying Objects or Services

To modify a domain object through Security Director, you must switch to that domain. You cannot switch
to a domain for which you do not have access. You cannot modify an object in one domain if you are in a
different domain.

Modifying objects through REST is ID based. To modify an object in a domain, you must have write access
to that domain and your user role must includemodify permissions for the object type in question. Objects
in the System domain are in read-only mode so you cannot modify them.
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Deleting Objects or Services

To delete a domain object through Security Director, you must switch to that domain. You cannot delete
an object in one domain if you are in a different domain.

Deleting objects through REST is ID based. To delete an object in a domain, you must have write access
to that domain and your user role must include delete permissions for the object type in question. Objects
in the System domain are in read-only mode so you cannot delete them.

Referencing Objects

An object can always reference another object in the same domain, with no restrictions. An object in the
D1 domain can reference other objects in the D1 domain. The rules are more complex for referencing
objects in a different domain. For example, a D1 domain object can reference objects in the D1 domain
or in its parent domain, the Global domain. However, D1 objects cannot reference D2 objects. Objects in
the Global domain cannot reference objects in child domains, D1 and D2. See Figure 183 on page 1321.

Figure 183: Security Director Domain References

There is an exception to this rule when it comes to referencing devices. Objects in the D1 domain can
reference devices in the same domain or they can reference devices in the D2 domain. But this is not true
in reverse; that is, objects in the D1 domain cannot reference devices in the Global domain.

NOTE: Services cannot reference other services even within the same domain.
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Moving Objects Across Domains

You can move objects from one domain to another, in general. For example, you can move an object from
the D1 domain to the Global domain and from the Global domain back to the D1 domain. A validation is
performed to check that the move was valid. Invalid moves are not allowed. Moving an object becomes
complex if the object is referenced by another object. An object in the D1 domain can be moved up to the
Global domain if it is referenced by another object that is either in the D1 domain or in the Global domain.
However, moving an object from the Global domain to the D1 domain is not allowed if the object is
referenced by another object in the Global domain.

The rules are different for moving device objects between domains. You canmove a device from the Global
domain to theD1 domain if the device is used by an object in either the Global or theD1 domain. However,
moving a device from the D1 domain to the Global domain is not allowed if an object in the D1 domain is
using that device.

To move a device that is part of a cluster, you must move both members of the cluster. You cannot move
only the primary or only the secondary device. You can move an object from the D1 domain to the Global
domain only if you have write access to the Global domain and view parent access enabled in the D1
domain.

Naming Objects in a Domain

The name of an object must be unique within a domain hierarchy. Objects with the same name cannot be
created in both the D1 and Global domains. The domain hierarchy includes the current domain, its parent,
and its child domains.

All the name validations consider domains as one of the constraints.

The object name must be a string beginning with a number or letter and consisting of alphanumeric
characters, colons, periods, slashes, dashes, and underscores. The object name must not contain special
characters such as &, <, >, and \n.

About Predefined Objects

All Security Director predefined objects are in the System domain. The predefined services, addresses,
signatures, and so on are visible from all the domains in read-only mode.

All device-specific predefined objects are also in the System domain. When a new predefined object is
discovered during the device discovery process, that object is also placed in the System domain. The All
Device policy is placed in the Global domain and you can modify that policy.

RELATED DOCUMENTATION
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Junos Space Security Director Overview | 2

Creating Customized Roles in Security Director

Use the Roles page to create customized (user-defined) roles.

After you create roles, you can assign the roles to various user accounts that you created in Junos Space
or to remote profiles for remote authorization. Roles allow you to segregate users based on the functionality
that they are allowed to access.

When a user logs in to Junos Space, the workspaces that the user can access and the tasks that they can
perform are determined by the roles that have been assigned to that particular user account.

Before You Begin

• Read the “Understanding Roles in Security Director” on page 1324 topic.

• Review the Roles main page to view the existing users. See “Roles Main Page Fields” on page 1329 for
field descriptions.

To configure a role:

1. Select Administration > Users & Roles > Roles.

The Roles page appears.

2. Click Create.

The Create Role page appears.

3. Complete the configuration according to the guidelines provided in Table 385 on page 1323.

4. Click OK.

A new role is created and you are returned to the Roles page.

Table 385: Role Settings

DescriptionSetting

Enter a unique title for the role that is a string containing alphanumeric characters, spaces,
and some special characters (- . _). The title must not start with a space and the maximum
length is 32 characters.

Title
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Table 385: Role Settings (continued)

DescriptionSetting

Enter a description unique string containing alphanumeric characters, spaces, and some
special characters (- . _). The maximum length is 256 characters.

Description

Select one or more tasks to assign to the custom (user-defined) Role. You must associate at
least one task with a role.

Privileges

RELATED DOCUMENTATION
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Understanding Roles in Security Director

Roles define the functionality or tasks that a user can perform in Junos Space, and they enable you to
segregate users based on the functionality that they are allowed to access. You do this by assigning a
different set of roles to various user accounts (in the case of local user accounts created in Junos Space)
or to remote profiles to be used for remote authorization. When a user logs in to Junos Space, the tasks
that they can perform are determined by the roles that have been assigned to that particular user account.

There are two types of roles: predefined roles, which are created by Junos Space, and user-defined
(customized) roles, which must be created manually. The list of predefined user roles that Junos Space
Security Director supports is available on the Roles page (select Administration > Users & Roles > Roles).

Roles can only be created by users who are assigned the User Administrator or Super Administrator or by
a user with the Create Role permission.
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Editing, Cloning, and Deleting Roles in Security Director

You can edit, clone, and delete roles from the Roles page.

Editing Roles

To edit a role:

NOTE: Predefined roles cannot be edited.

1. Select Administration> Users & Roles > Roles.

The Roles page appears.

2. Select the role that you want to edit, and click the pencil icon or select Edit Role from the right-click
menu.

The Edit Role page appears, showing the same fields that are presented when you create a role.

3. Edit the role fields as needed.

NOTE: The role title cannot be edited.

4. Click OK to save the changes.

The changes are saved and you are returned to the Roles page.

Cloning Roles

To clone a role:

1. Select Administration> Users & Roles > Roles.

The Roles page appears.

2. Select the role that you want to clone. From the More or the right-click menu, select Clone Role .

The Clone Role page appears, showing the same fields that are presented when you create a role.

1325



3. Modify the role fields as needed.

4. Click OK to save the changes.

The cloned role is created and you are returned to the Roles page.

Deleting Roles

To delete one or more roles:

NOTE: Predefined roles cannot be deleted.

1. Select Administration> Users & Roles > Roles.

The Roles page appears.

2. Select the roles that you want to delete and click the X icon. Alternatively, select the roles and from
the More menu, select Delete Roles.

The Confirm Delete page appears.

3. Click Yes to delete the selected roles.

The changes are saved and you are returned to the Roles page.

RELATED DOCUMENTATION

Creating Customized Roles in Security Director | 1323

Understanding Roles in Security Director | 1324

Viewing the Details of a Role in Security Director

You can view the details of roles from the Roles page.

To view the details of a role:

1. Select Administration> Users & Roles > Roles.

The Roles page appears.
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2. Double-click the role for which you want to view the details. Alternatively, select a role and from the
More or right-click menu, click View Role Details.

The Roles Details page appears. Table 386 on page 1327 describes the fields on this page.

3. Click Close.

You are returned to the Roles page.

Table 386: Roles Details Page Fields

DescriptionField

Title of the role.Title

Describes the custom role.Description

Junos Space workspaces and tasks associated with the role.Workspaces and Tasks

RELATED DOCUMENTATION

Creating Users in Security Director | 1303

Roles Main Page Fields | 1329

Importing and Exporting Roles in Security Director

You can import and export roles from the Roles page. You import roles from an XML file to add new roles
to Junos Space Security Director. If you are importing roles for the first time, we recommend that you
view the sample XML file first. You export user-defined (customized) roles from the Junos Space database
to access details about the roles and download the file to your local computer.

Importing Roles

To import one or more roles:

1. Select Administration > Users & Roles > Roles.

The Roles page appears.

2. Click Import.

The Import Roles page appears.
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3. Use the Browse button to select the file that you want to import.

NOTE: Click the View Sample XML File link to view or download the sample XML file.

4. Click Import Roles to import the selected roles.

The Job Details page appears displaying details of the job.

5. Click OK to close the Job Details page.

You are returned to the Roles page.

Exporting Roles

To export one or more roles:

NOTE: Predefined roles cannot be exported.

1. Select Administration > Users & Roles > Roles.

The Roles page appears.

2. Select the roles that you want to export. From the More or right-click menu, select Export Roles.

The Export Roles page appears.

3. Click Yes to confirm the export operation.

The JobDetails: Export Roles page appears displaying the details of the job. Use the link in theDownload
field to download the exported roles.

4. Click OK to close the Job Details page.

You are returned to the Roles page.

RELATED DOCUMENTATION
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Understanding Roles in Security Director | 1324
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Roles Main Page Fields

Use the Roles main page to view, create, edit, clone, and delete customized (user-defined) roles. You can
also import roles from, and export roles to, a comma-separated values (CSV) file. You can filter and sort
the roles displayed, and view details of each role. Table 387 on page 1329 describes the fields on this page.

Table 387: Roles Main Page Fields

DescriptionField

Title of the role.Role Title

Indicates whether the role is predefined (system-defined) or a custom
(user-defined) role.

Type

Describes the custom role.Description

RELATED DOCUMENTATION
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CHAPTER 112

Users and Roles-Domains
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Overview of Domains in Security Director

A domain is a logical mapping of objects, such as devices, to users who access and manage the network
by using these objects. Junos Space allows a hierarchal structure for domains. The top-level domain is
called the Global domain. You can create a hierarchy of up to five levels of subdomains under the Global
domain. You can use these subdomains to create easily manageable sections of your network. When you
assign objects and users to these subdomains, users can manage these objects partially or completely
based on the roles assigned to them.

You can assign or unassign users and remote profiles to domains, and assign devices to domains.

Switching Between Domains

If you have access to more than one domain, you can switch between domains without having to log out
and in to Security Director. To switch between domains, click theDomain Switcher in the Security Director
banner, which is displayed at the top of every Security Director page, and then select the domain to which
you want to switch.
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Domain RBAC Overview | 1316

Creating Domains in Security Director

Use the Add Domain page to create new domains and assign users or devices to the domains.

You add a domain when you want to create a logical grouping of objects and users. The top-level domain
is called the Global domain and is created by the system. You can add up to five levels of subdomains
under the Global domain.

Before You Begin

• Read the “Overview of Domains in Security Director” on page 1330 topic.

• Review the Domains main page for an understanding of your existing domains. See “DomainsMain Page
Fields” on page 1341 for field descriptions.

To configure a domain:

1. Select Administration > Users & Roles > Domains.

The Domains page appears.

2. Click Create.

The Add Domain page appears.

3. Complete the configuration according to the guidelines provided in Table 388 on page 1332.

NOTE: Fields marked with * are mandatory

4. Click OK.

A new domain is created and you are returned to the Domains page.
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Table 388: Domain Settings

DescriptionSetting

Domain Information

Enter a unique string containing only alphanumeric characters and some special
characters (_ .). No spaces are allowed and the maximum length is 254 characters.

Domain Name

Select the check box to allow users of this domain to have read and execute access
to the objects in the parent domain.

Allow users of this domain to
have read and execute access
to parent domain objects

Enter a string containing alphanumeric characters and some special characters (_ .
@). The maximum length is 255 characters.

Click Next to continue.

Description

User Assignment

Select the users that you want to assign to the domain by clicking the check box
corresponding to the users.

WARNING: Userswill lose someprivilegeswhen they aremoved to the child-domain

Click Back to return to the previous section or Next to continue.

Device Assignment

Select the devices that you want to assign to the domain by clicking the check box
corresponding to the devices.

Click Back to return to the previous section or Finish to go to a summary page.

RELATED DOCUMENTATION
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Edit and Delete Domains in Security Director

IN THIS SECTION

Edit Domains | 1333

Delete Domains | 1334

You can edit and delete domains from the Domains page.

NOTE: Before deleting a domain, you must ensure that all jobs and audit logs associated with
the domain are purged.

Edit Domains

To edit a domain:

1. Select Administration > Users & Roles > Domains.

The Domains page appears.

2. Select the domain that you want to edit, and click the pencil icon.

The Edit Domain page appears, showing the same fields that are presented when you create a domain.

3. Edit the domain fields as needed.

4. Click OK.

The changes are saved and you are returned to the Domains page, where a confirmation message is
displayed at the top of the page.
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Delete Domains

To delete a domain:

1. Select Administration > Users & Roles > Domains.

The Domains page appears.

2. Select the domain that you want to delete, and click the X icon.

The Confirm Delete page appears, asking you to confirm your selection.

3. Click Yes to delete the selected domain.

The Job Detail: Delete Domain page appears listing the details of the job. If the deletion is successful,
the Job State displays SUCCESS; if the deletion is unsuccessful, the Job State displays FAILURE.

4. Click OK to close the Job Details page.

You are returned to the Domains page.

RELATED DOCUMENTATION
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Creating Domains in Security Director | 1331

Exporting Domains in Security Director

You export domains from the Junos Space database to access details of the domains. When you export a
domain, the details of the domain are saved in a comma-separated values (CSV) file. You export domains
if you want to view the domain information in an external application or e-mail the information.

To export a domain:

1. Select Administration > Users & Roles > Domains.

The Domains page appears.

2. Select the domain that you want to export, and click the Export button.

The Export Domain page appears, asking you to confirm your selection.

3. Click Yes.

1334



The Job Details: Export Domain page appears displaying the details of the job. Use the Download link
to download file containing the exported domains.

4. Click OK to close the Job Details page.

You are returned to the Domains page.

RELATED DOCUMENTATION
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Creating Domains in Security Director | 1331

Viewing Users, Devices, and Remote Profiles Assigned to a Domain in
Security Director

You can view the users, devices, and remote profiles assigned to a domain from the Domains page. This
enables you to view the users, devices, and remote profiles assigned to a particular domain at a quick
glance on one page.

To view the details of a domain:

1. Select Administration > Users & Roles > Domains.

The Domains page appears.

2. Click the domain name link to view the users, devices, and remote profiles assigned to the domain.

TheDomain-Name page appearswith theAssignedUsers tab selected by default. Table 389 on page 1336
describes the fields on this page.

3. Click the Assigned Devices tab to view the devices assigned to the domain.

TheDomain-Namepage appearswith theAssignedDevices tab selected. Table 390onpage1336describes
the fields on this page.

4. Click the Assigned Remote Profiles tab to view the devices assigned to the domain.

TheDomain-Name page appearswith thewith theAssigned Remote Profiles tab. Table 391 on page 1336
describes the fields on this page.

5. Click Domains in the left-hand menu to return to the Domains page.
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You are returned to the Domains page

Table 389: Assigned Users Tab Fields

DescriptionField

Username of the user assigned to the domain.Username

First name of the user assigned to the domain.First Name

Last name of the user assigned to the domain.Last Name

E-mail address of the user assigned to the domain.E-Mail Address

Indicates whether the user is enabled or disabled.Status

Domains to which the user is assigned.Assigned Domains

Table 390: Assigned Devices Tab Fields

DescriptionField

Name of the device assigned to the domain.Device Name

IP address of the device assigned to the domainIP Address

Name of the device assigned to the domain.Platform

Table 391: Assigned Remote Profiles Tab Fields

DescriptionField

Name of the remote profile assigned to the domain.Profile Name

Description of the remote profile assigned to the domain.Description

Domains to which the remote profile is assigned.Assigned Domains
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Assigning and Unassigning Remote Profiles to Domains in Security Director | 1338

Assigning Devices to Domains in Security Director | 1337

Assigning Devices to Domains in Security Director

You can assign devices to domains using the Domains page. You assign devices to domains if you want to
logically group devices in domains. If you switch from one domain to another, then only the devices
belonging to that domain are accessible.

To assign devices to a domain:

1. Select Administration > Users & Roles > Domains.

The Domains page appears.

2. From the Number of Devices column, click the numbered link corresponding to the domain to which
you want to assign devices.

You are taken to the Domain-Name page with the Assigned Devices tab selected.

3. Click the + icon.

The Assign Devices to Domain Domain-Name page appears displaying a list of devices that can be
assigned. You can click the ViewAudit Log link to view the details of the audit log entry for the domain
assignment. You are taken to the Audit Logs page in Junos Space Network Management Platform.

4. Select one or more devices by clicking the check boxes corresponding to the remote profiles.

5. Click OK.

The Assign Objects to Domain Status page appears displaying the status of the domain assignment.
Click the View Audit Log link to view the audit log entry in the Audit Logs page.

6. Click OK.

You are taken to the Domain-Name page.

RELATED DOCUMENTATION
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Assigning and Unassigning Remote Profiles to Domains in Security Director | 1338

Overview of Domains in Security Director | 1330

Creating Domains in Security Director | 1331

Assigning andUnassigning Remote Profiles toDomains in SecurityDirector

IN THIS SECTION

Assigning Remote Profiles to Domains | 1338

Unassigning Remote Profiles from Domains | 1339

You can assign remote profiles to domains or unassign remote profiles from domains using the Domains
page. You assign a remote profile to a domain if you want to restrict the objects only to that domain to
which users associated with the remote profile have access. You unassign a remote profile from a domain
if you no longer want to provide users associated with the remote profile access to that domain.

Assigning Remote Profiles to Domains

To assign remote profiles to a domain:

1. Select Administration > Users & Roles > Domains.

The Domains page appears.

2. From the Number of Remote Profiles column, click the numbered link corresponding to the domain to
which you want to assign remote profiles.

You are taken to the Domain-Name page with the Assigned Remote Profiles tab selected.

3. Click the + icon.

The Assign Remote Profiles to Domain Domain-Name page appears displaying a list of remote profiles
that can be assigned.

4. Select one or more remote profiles by clicking the check boxes corresponding to the remote profiles.

5. Click OK.

The remote profiles are assigned to the domain and you are returned to the Domain-Name page.
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Unassigning Remote Profiles from Domains

To unassign remote profiles from a domain:

1. Select Administration > Users & Roles > Domains.

The Domains page appears.

2. From the Number of Remote Profiles column, click the numbered link corresponding to the domain
from which you want to unassign remote profiles.

You are taken to the Domain-Name page with the Assigned Remote Profiles tab selected.

3. Select the remote profiles that you want to unassign.

4. Click the X icon.

The selected remote profiles are unassigned from the domain and you are returned to theDomain-Name
page.

SEE ALSO
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You can assign users to domains or unassign users from domains using the Domains page. You assign users
to a domain if you want to restrict the objects to which the users have access only to that domain. You
unassign users from a domain if you no longer want to provide users access to that domain.

Assigning Users to Domains

To assign users to a domain:

1. Select Administration > Users & Roles > Domains.

The Domains page appears.

2. From the Number of Users column, click the numbered link corresponding to the domain to which you
want to assign users.

You are taken to the Domain-Name page with the Assigned Users tab selected.

3. Click the Assign User icon.

The Assign Users to Domain Domain-Name page appears displaying a list of users that can be assigned.

4. Select one or more users by clicking the check boxes corresponding to the users.

5. Click OK.

The users are assigned to the domain and you are returned to the Domain-Name page.

Unassigning Users from Domains

To unassign users from a domain:

1. Select Administration > Users & Roles > Domains.

The Domains page appears.

2. From the Number of Users column, click the numbered link corresponding to the domain from which
you want to unassign users.

You are taken to the Domain-Name page with the Assigned Users tab selected.

3. Select the users that you want to unassign.

4. Click the Unassign User icon.

The users are unassigned from the domain and you are returned to the Domain-Name page
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SEE ALSO
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Creating Domains in Security Director | 1331

Domains Main Page Fields

Use theDomainsmain page to create, modify, delete, and export domains. You can also assign and unassign
users and remote profiles to domains as well as assign devices to domains. You can filter and sort the
domains displayed, and view details of each domain. Table 392 on page 1341 describes the fields on this
page.

Table 392: Domains Main Page Fields

DescriptionField

Name of the domain. Click a domain name link to view the users, devices, and remote
profiles assigned to the domain. See “Viewing Users, Devices, and Remote Profiles
Assigned to a Domain in Security Director” on page 1335.

Domain

Number of users assigned to the domain. Click a number-of-users link to view the users
assigned to the domain. See “Viewing Users, Devices, and Remote Profiles Assigned
to a Domain in Security Director” on page 1335.

Number of Users

Number of devices assigned to the domain. Click a number-of-devices link to view the
devices assigned to the domain. See “Viewing Users, Devices, and Remote Profiles
Assigned to a Domain in Security Director” on page 1335.

Number of Devices

Number of remote profiles assigned to the domain. Click a number-of-remote-profiles
link to view the remote profiles assigned to the domain. See “Viewing Users, Devices,
and Remote Profiles Assigned to a Domain in Security Director” on page 1335.

Number of Remote Profiles

Date and time at which the domain was created.Date and Time Created

Indicates whether users assigned to the domain have read and execute access to the
objects in the parent domain or not. This field is not applicable to global domains.

Read and Execute for parent
domain objects

Description of the domain.Description
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Creating Remote Profiles in Security Director

Use the Create Remote Profile page to create a new remote profile and assign one or more roles and
domains to the remote profile. You must associate at least one role and one domain with a remote profile.
Remote profiles are used to authenticate users remotely.

Before You Begin

• Read the “Overview of Remote Profiles in Security Director” on page 1345 topic.

• Review the Remote Profiles main page for an understanding the existing remote profiles. See “Remote
Profiles Main Page Fields” on page 1348 for field descriptions.

To configure a remote profile:

1. Select Administration > Users & Roles > Remote Profiles.

The Remote Profiles page appears.

2. Click Create.

The Create Remote Profile page appears.

3. Complete the configuration according to the guidelines provided in Table 393 on page 1344.
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NOTE: Fields marked with * are mandatory

4. Click OK.

A new remote profile is created and you are returned to the Remote Profiles page.

Table 393: Remote Profile Settings

DescriptionSetting

Role assignment

Enter a unique string containing alphanumeric characters and some special characters (- .
_). No spaces are allowed and the maximum length is 32 characters.

Name

Enter a unique string containing alphanumeric characters and some special characters (- .
_). The maximum length is 256 characters.

Description

Select whether the user assigned to the remote profile can view only the jobs triggered
by that remote profile or all jobs.

Job Management View

Select one or more roles in the Available column and click the forward arrow to confirm
your selection.

The selected roles are displayed in the Selected column.

NOTE: You must select at least one role.

Click Next to continue.

Role

Domain Assignment

Select one or more domains to assign to the remote profile. If you select a domain with
subdomains, the subdomains are also included. You must select at least one domain.

If you do not assign a domain to the user, the Global domain is assigned to the user by
default.

Click Back to return to the previous section or Finish to go to a summary page.

Available Domains

RELATED DOCUMENTATION
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Viewing the Details of a Remote Profile in Security Director | 1347

Overview of Remote Profiles in Security Director

Remote profiles are used to assign a specific set of roles to users when remote authentication and
authorization are enabled in Junos Space. A remote profile is a collection of roles defining the set of
functions that a user is allowed to perform.

Junos Space does not create remote profiles by default, and if you want to use remote authentication and
authorization, you must create one or more remote profiles. When you create a remote profile, you must
specify one or more roles and domains to associate with the remote profile. You can then configure the
name of the remote profile for one or more user accounts in the remote authentication servers (RADIUS
or TACACS+) that you are using for authentication and authorization. Remote profile names can be
configured as a vendor-specific attribute (VSA) in RADIUS servers and as an attribute-value pair (AVP) in
TACACS+ servers.

When a remote authentication server successfully authenticates a user session, the server includes the
configured remote profile name for that user in the response message that is sent to Junos Space. Junos
Space looks up the remote profile based on this name and determines the set of roles for the user. Junos
Space then uses this information to control the set of workspaces the user can access and the tasks the
user is allowed to perform.
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Edit and Delete Remote Profiles in Security Director
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You can edit and delete remote profiles from the Remote Profiles page.

Edit Remote Profiles

To edit a remote profile:

1. Select Administration > Users & Roles > Remote Profiles.

The Remote Profiles page appears.

2. Select the remote profile that you want to edit, and click the pencil icon.

The Edit Remote Profile page appears, showing the same fields that are presented when you create a
remote profile.

3. Edit the remote profile fields as needed.

NOTE: Some fields cannot be edited.

4. Click OK to save the changes.

The changes are saved and you are returned to the Remote Profiles page.

Delete Remote Profiles

To delete remote profiles:

1. Select Administration > Users & Roles > Remote Profiles.

The Remote Profiles page appears.

2. Select the remote profiles that you want to delete, and click the X icon.

The Delete Remote Profiles page appears, displaying the list of remote profiles selected for deletion.

3. Click Yes to delete the selected remote profiles.

The remote profiles are deleted and you are returned to the Remote Profiles page.

RELATED DOCUMENTATION
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Remote Profiles Main Page Fields | 1348

Viewing the Details of a Remote Profile in Security Director

You can view the details of remote profiles, which allows you to view information about the remote profile
at a quick glance on one page, from the Remote Profiles page.

To view the details of a remote profile:

1. Select Administration > Users & Roles > Remote Profiles.

The Remote Profiles page appears.

2. Double-click the remote profile for which you want to view the details. (Alternatively, select a remote
profile and selectViewRemote Profile Details from the shortcut menu, or click the Detailed View icon,
which appears when you mouse over a remote profile entry, to view the details.)

The Remote Profiles Details page appears. Table 394 on page 1347 describes the fields on this page.

Table 394: Remote Profiles Details Page Fields

DescriptionField

Name of the remote profile.Name

Description of the remote profile.Description

Indicates whether the user assigned to the remote profile can view only the jobs
triggered by that user or all jobs.

View Jobs

Indicates the roles that are associated with the remote profile.Assigned Roles

Indicates the domains that are associated with the remote profile.Available Domains

Displays the hierarchy of tasks that are assigned to the role selected in the
Assigned Role field.

Role Summary

RELATED DOCUMENTATION
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Remote Profiles Main Page Fields | 1348

Remote Profiles Main Page Fields

Use the Remote Profiles page to create, modify, and delete remote profiles. Remote profiles are used to
authenticate users remotely. You can filter and sort the remote profiles displayed, and view details of each
remote profile. Table 395 on page 1348 describes the fields on this page.

Table 395: Remote Profiles Main Page Fields

DescriptionField

Name of the remote profile.Profile Name

Description of the remote profile.Description
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CHAPTER 114

Logging Management

IN THIS CHAPTER

Logging and Reporting Overview | 1349

Logging and Reporting Overview

The Junos Space Security Director Logging and Reporting module enables log collection across multiple
SRX Series devices and enables log visualization.

You can use either Security Director Log Collector or Juniper Secure Analytics (JSA) as a log collector. For
details on deploying and configuring JSA, see Juniper Secure Analytics documentation.

The Logging and Reporting module provides:

• Device health and events monitoring.

• Visualization of security events resulting from complex and dynamic firewall policies using dashboard
and event viewer.

• Device health monitoring of CPU and memory.

• Alert notification about specific events or upon attaining threshold limits.

• Scalable virtual machine (VM) based log collection and log collector management.

NOTE: For details on installing Security Director and setting up Log Collector, see Security
Director Installation and Upgrade Guide.

Logs, also called event logs, provide vital information for managing network security, incident investigation,
and response. Logging provides the following features:

• Receives events from SRX Series devices and application logs.

• Stores events for a defined period of time or a set volume of data.
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• Parses and indexes logs to help speed up searching.

• Provides queries and helps in data analysis and historical events investigation.

You must configure Security Director and SRX series devices to receive logs. Select Security Director >
Devices > Device Management to configure syslog to receive SRX Series device logs.
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Enabling Logging on Branch SRX Series Devices

Enabling Logging on High-End SRX Series Devices
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CHAPTER 115

Logging Management-Logging Nodes

IN THIS CHAPTER

Adding Logging Nodes | 1351

Enabling Log Forwarding | 1354
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Adding Logging Nodes

Use this page to configure logging nodes. Youmust deploy either Security Director Log Collector or Juniper
Secure Analytics (JSA) as a log collector and then add it to Security Director to view the log data in the
Dashboard, Events and Logs, Reports, and Alerts pages.

Before You Begin

• Read the “Logging and Reporting Overview” on page 1349 topic.

• Configure system log and security logging configuration from Devices > Security Devices >Modify
Configuration. See “Modifying the Configuration of Security Devices” on page 234.

• Review the LoggingManagement main page for an understanding of your current data set. See “Logging
Nodes Main Page Fields” on page 1355 for field descriptions.

• While adding SRX firewall as a log source in JSA or QRadar, set the log source type to Juniper Junos
Platform and not Juniper SRX Series Services Gateway.

• You must have the recent version of Juniper Junos Device Support Module (DSM) installed on JSA or
QRadar.

• For information on JSA, see Juniper Secure Analytics documentation.

To add Log Collector to Security Director:

1. Select Administration > Logging Management > Logging Nodes.

2. Click the + icon to add logging nodes. The Add Logging Node page appears.
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3. Choose the Log Collector type as Security Director Log Collector or Juniper Secure Analytics.

NOTE: Starting in Junos Space Security Director Release 16.2, the Log Collector type Juniper
Secure Analytics is added.

4. Click Next.

5. Complete the configuration for Add Collector/JSA Node according to the guidelines provided in
Table 396 on page 1352.

NOTE: From Junos Space Security Director Release 17.2, for distributed Log Collector
deployment, you must add only Log Receiver node.

6. Click Next.

The certificate details are displayed.

7. Click Finish.

8. Review the summary of configuration changes from the summary page and click Edit to modify the
details, if required.

9. Click OK to add the node.

A new logging node with your configurations is added. To verify if the node is configured correctly, click
Logging Management > Logging Nodes to check the status of the node.

NOTE: In Junos Space Security Director Release 16.2, the JSA node is added only via Security
Director, so the JSA node is not displayed in Space > Administration > Fabric.

Table 396: Logging Node Settings

GuidelinesSettings

Enter a unique name for the node that is a string of alphanumeric characters, colons, periods,
dashes, and underscores. No spaces are allowed and the maximum length is 29 characters.

Node Name
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Table 396: Logging Node Settings (continued)

GuidelinesSettings

Enter an IPv4 or IPv6 address for the node.

Starting in Junos Space Security Director Release 18.2R1, IPv6 address is supported while
adding JSA node.

IP Address

For Security Director Log Collector, provide the default credentials: Username is admin and
Password is juniper123. Youmust change the default password using the Log Collector CLI
configureNode.sh command as shown in Figure 184 on page 1353.

Figure 184: Change Password

For JSA, provide the admin credentials that is used to log in to the JSA console.

User Name and
Password

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.2, the Log Collector type Juniper Secure
Analytics is added.

16.2

In Junos Space Security Director Release 16.2, the JSA node is added only via Security Director,
so the JSA node is not displayed in Space > Administration > Fabric.

16.2

RELATED DOCUMENTATION

Logging and Reporting Overview | 1349

Logging Devices Main Page Fields | 1359
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Using the Log Statistics and Troubleshooting | 1357

Modifying the Configuration of Security Devices | 234

Enabling Log Forwarding

To enable log forwarding:

1. Select Administration> Logging Management > Logging Nodes.

2. On the upper right side of the page, click the Log Forwarding button.

3. Complete the configuration.

Table 397: Log Forwarding

GuidelinesSettings

Enable this option to forward the logs to a syslog server.Syslog Forwarding

Specifies the IP address to which the syslog is forwarded.Destination IP

Specifies the port number to which the syslog is forwarded.Port Number

Specifies the protocol to which the syslog is forwarded. The available protocols
are TCP and UDP.

Protocol

NOTE: Starting in Junos Space Security Director Release 16.2 onward, log forwarding is not
supported on JSA.

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.2 onward, log forwarding is not
supported on JSA.

16.2

RELATED DOCUMENTATION
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Logging and Reporting Overview | 1349

Logging Devices Main Page Fields | 1359

Using the Log Statistics and Troubleshooting | 1357

Adding Logging Nodes | 1351

Logging Nodes Main Page Fields

Use this page to manage and configure Log Collector. You can add, remove, log forward, or change the
database password for the logging nodes. You can also view log information such as node name, type of
node, node IP address, status, version, and the last boot time of the logging node.

Table 398 on page 1355 describes the fields on this page.

Table 398: Logging Management Main Page Fields

DescriptionField

Name of the Log Collector node.Node Name

Type of Log Collector used for logging.Node Type

IPv4 address of the Log Collector.Node IPv4

IPv6 address of the Log Collector.Node IPv6

Current network status of the Log Collector, that is, UP or DOWN.Status

Displays the status of the Log Collector.

• GREEN—Log Collector is healthy and is receiving logs.

• YELLOW—Log Collector is not functioning as expected. For example, Log
Collector services might be down.

• RED—Log Collector is down.

Application

Version of the Log Collector.Version

Last system reboot time.Last Boot Time
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NOTE: Starting in Junos Space Security Director Release 16.2 onward, the Status, Application,
Version, and Last Boot Time are not displayed for the JSA node. The Log Forwarding and Change
Log Password options are not available for JSA node.

RELATED DOCUMENTATION

Logging and Reporting Overview | 1349

Logging Devices Main Page Fields | 1359

Using the Log Statistics and Troubleshooting | 1357

Adding Logging Nodes | 1351
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CHAPTER 116

Logging Management-Statistics & Troubleshooting

IN THIS CHAPTER

Using the Log Statistics and Troubleshooting | 1357

Using the Log Statistics and Troubleshooting

Use this page to view the statistical information for each node. The log statistics is displayed as a time
series chart, which shows the average event rate per day. You can view the event pattern for up to 90
days.

You can also view the complete statistic details such as node name, node type, events per second rate,
time when the last log was received, total disk space, free space, health status, CPU usage, memory usage,
and disk I/O wait period. You can use this information to troubleshoot issues with your node.

Before You Begin

• Read the Logging and Reporting Overview topic.

• Review the LoggingManagement main page for an understanding of your current data set. See “Logging
Devices Main Page Fields” on page 1359 for field descriptions.

To use the Log Statistics and Troubleshooting Page:

1. Select Administration > Logging Management > Statistics & Troubleshooting.

The Node Statistics page appears.

2. Use the guidelines provided in Table 399 on page 1357 to learn about the page.

Table 399: Node Statistics

GuidelineAction

Refreshes the node statistics information.Refresh
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NOTE: Starting in Junos Space Security Director Release 16.2, information is not displayed for
the JSA node.

RELATED DOCUMENTATION

Logging and Reporting Overview | 1349

Logging Devices Main Page Fields | 1359

Adding Logging Nodes | 1351
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CHAPTER 117

Logging Management-Logging Devices

IN THIS CHAPTER

Logging Devices Main Page Fields | 1359

Creating Security Logs | 1360

Logging Devices Main Page Fields

Use the Logging Devices section to view the details about your log receiver nodes. These nodes receive
logs from devices, you can view details such as name, IP address, and the average events per second
received on each node.

To use the Logging Device page:

1. Select Administration > Logging Management > Logging Devices. The Logging Devices page appears.

2. Read the descriptions provided in Table 400 on page 1359 to learn about the page.

Table 400: Logging Devices Main Page Fields

DescriptionField

Name of the Security Director Log Collector or Juniper Secure Analytics.Node Name

IP address of the node.Node IP

Average events per second (eps) on an hourly basis.Average EPS

Device Configuration

Use the Device Configuration section to view the configured log collector details for your device such as
its IP address, average events per second rate, and the last updated timestamp. See Table 401 on page 1360
to learn about the page.
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Table 401: Device Configuration Main Page Fields

DescriptionField

Name of the device.Device Name

IP address of the device.Device IP

IP address of the receiving node.Sending Logs To (Receiver Node)

Average events per second (eps) on an hourly basis.Average EPS (Hourly)

Last updated timestamp.Last Updated

RELATED DOCUMENTATION

Logging and Reporting Overview | 1349

Adding Logging Nodes | 1351

Using the Log Statistics and Troubleshooting | 1357

Creating Security Logs

To configure security logging:

1. Select Security Director > Devices > Device Management.

The Device Management page appears.

2. Right-click a device and select Device Configuration > Modify Configuration.

The View/Edit Configuration page appears.

3. Under the Security section, click Security Logging.

The Create Security Logging page appears.

4. Under the General Settings section, configure the following parameters:

• From the Mode list, select the mode of logging as stream or event.

• To specify a source IP address or the IP address used when exporting security logs, enter the IP
address in the Source Address field.
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• From the Format list, select the logging format as syslog, sd-syslog, or binary.

• To limit the rate per second at which data plane logs are generated, enter the rate value in the
Rate-Cap field.

• To disable security logging for a device, select the Disable Logging check box.

• To use Coordinated Universal Time (UTC) for security log timestamps, select the UTC-Timestamp
check box.

• To limit the rate per second at which logs are streamed, enter the event rate in the Event-rate field.

5. Under the Stream section, configure the following parameters:

To create a new stream configuration:

• Click the plus sign (+).

The Stream Configuration page appears.

• In the Stream Name field, enter the name of the new stream configuration.

• In the Host field, enter the IPv4 or IPv6 address.

• In the Port field, enter the port number.

• In the Severity list, select one of the following available required severity types:

• Emergency

• Alert

• Critical

• Error

• Warning

• Notice

• Info

• Debug

• In the Category list, select the type of category as all or content-security.

• In the Format list, select the type of format as syslog, sd-syslog, welf, or binary.

• To create a new stream, click Ok.

You can modify or delete the existing streams. To modify or edit a stream, select the stream and click
the pencil icon. To delete a stream, select the stream and click the minus sign (-).

6. Expand the File section and configure the following parameters:

• In the File Name field, enter a filename for the log data file.

• In the File Path field, enter the path where the log file is saved.
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• In the File Size field, enter the maximum size of the log file in megabytes.

• In the Max No. Of files field, enter the maximum number of log files to create for each session.

7. Expand the Cache section, and configure the following parameters:

• In the Limit field, enter themaximum number of log entries to store in the cachememory. The default
value is 10,000 entries.

8. To restrict the device from logging certain configurations, you can create different exclude configurations.

To create a new exclude configuration:

• Under the Exclude section, click the plus sign (+).

The Exclude Configuration page appears.

• In the Name field, enter the name of a new exclude configuration.

• Under the Destination section, in the IP Address field, enter the destination IP address in IPv4 or
IPv6 address format. The audit log does not include security alarms from the specified destination
IP address.

In the Port field, enter the destination IP address port.

• Under the Source section, in the IP Address field, enter the source IP address in IPv4 or IPv6 address
format. The audit log does not include security alarms from the specified source IP address.

In the Port field, enter the source IP address port.

• Under the Other Filters section, configure the following parameters:

• In the Event Id field, enter the event ID of the security event. The audit log does not include security
alarms for this event ID.

• To restrict the logging of failed events, select the Failure check box.

• In the Interface field, enter the name of the interface. The audit log does not include security alarms
from the specified interface.

• In the Policy Name field, enter the policy name.

• In the Process field, specify the name of the process that is generating the events.

• In the Protocol field, enter the protocol name.

• To restrict the logging of successful events, select the Success check box.

• In the User Name field, enter the name of the authenticated user. All security events that are
enabled by this user are not generated in the audit log.

• To create a new exclude configuration, click Ok.

9. To create a new security log, click Ok.
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NOTE: Security logging is not supported for the logical systems devices.
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CHAPTER 118

Monitor Settings

IN THIS CHAPTER

About the Monitor Settings Page | 1364

Monitor Settings Overview | 1365

About the Monitor Settings Page

To access this page, click Administration >Monitor Settings.

You can use the Monitor Settings page to enable and disable polling of data from devices. Polling allows
Security Director to pull data specific to traffic, resource usage, and sessions across user-specified time
intervals.

Tasks You Can Perform

You can perform the following task from this page:

• Configure monitor settings. To change the status of a device, select a device, click Enable or Disable
and follow the guidelines in Table 402 on page 1364.

Field Descriptions

Table 402 on page 1364 provides guidelines on using the fields on the Monitor Settings page.

Table 402: Fields on the Monitor Settings Page

DescriptionField

Enable or disable device monitoring. By default, device monitoring is enabled.Device Monitoring

Enable or disable traffic polling. The allowed range is 1 to 60 minutes. By default,
traffic polling is enabled every 15 minutes.

Traffic Polling
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Table 402: Fields on the Monitor Settings Page (continued)

DescriptionField

Enable or disable resource usage polling. The allowed range is 1 to 60 minutes. By
default, resource usage polling is enabled every 10 minutes.

Resource Usage Polling

Enable or disable session polling. The allowed range is 1 to 60 minutes. By default,
session polling is disabled. Session polling can be enabled every 30 minutes, by
default.

Session Polling

Name of a device. Example, device1.Device Name

IP address of a device. Example, 10.0.0.0.IP Address

The SRX series device platform. Example, SRX1500.Platform

The status of a device. The options are:

• Enable – Enables device polling.

• Disable – Disables device polling.

Status

RELATED DOCUMENTATION

Monitor Settings Overview | 1365

Monitor Settings Overview

Device monitoring allows Security Director to poll devices for health and system data. The collected data
is shown in the widgets on the dashboard.

You can enable and disable polling of data from devices. Polling allows Security Director to pull data specific
to traffic, resource usage, and sessions across user-specified time intervals.

To change the status of a device, select a device and click Enable or Disable.

You can enable or disable polling when you need information on the devices that are managed by Security
Director. If polling is enabled, then data is displayed in the widgets in the dashboard. If polling is disabled,
then data is not displayed in the widgets. The following device widgets in the dashboard are dependent
on the configured monitor settings:
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• Devices Most CPU Usage

• Devices Most Memory Usage

• Devices Most Sessions

• Devices Most Bandwidth by Bytes

• Zones Most Bandwidth by Bytes

• Devices Most Dropped Packets

• Zones Most Dropped Packets

• Devices Most Bandwidth by Packets

• Zones Most Bandwidth by Packets

• Devices Most Storage

RELATED DOCUMENTATION

About the Monitor Settings Page | 1364

Dashboard Overview | 20
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CHAPTER 119

Signature Database

IN THIS CHAPTER

Using the Signature Database | 1367
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Signature Database Main Page Fields | 1369

Installing the Signature Database Configuration | 1370

Downloading the Signature Database Configuration | 1372

Uploading the Signature Database Configuration from a File System | 1373

Using the Signature Database

Use the Signature Database page to download and install the intrusion prevention system (IPS) signature
database and application firewall signature database to security devices. This database includes signature
definitions of attacks and applications that can be used to identify applications for tracking firewall policies,
quality of service prioritization, and IPS.

Before You Begin

• Read the “Understanding Signature Databases” on page 1368 topic.

• Ensure that your device has a connection to the Internet to download security package updates.

• Review the signature database main page for an understanding of your current data set. See “Signature
Database Main Page Fields” on page 1369 for field descriptions.

To download and install the signature database configuration:

If signature database is not downloaded, navigate to Administration > Signature Database to download
the latest signatures.

1. To download the signature database configuration, perform the steps provided in “Downloading the
Signature Database Configuration” on page 1372.
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2. To upload the signature database configuration, perform the steps provided in “Uploading the Signature
Database Configuration from a File System” on page 1373.

3. To install the signature database configuration, perform the steps provided in “Installing the Signature
Database Configuration” on page 1370 .

Once you download and install the signatures, you can use them to configure application services.

RELATED DOCUMENTATION

Understanding Signature Databases | 1368

Signature Database Main Page Fields | 1369

Understanding Signature Databases

The signature database is one of the major components of the intrusion prevention system (IPS). This
database includes signature definitions of attacks and applications that can be used to identify applications
for tracking firewall policies, quality of service prioritization, and IPS.

The IPS signature database is stored on an IPS enabled device and contains definitions of predefined attack
objects and groups. These attack objects and groups are designed to detect known attack patterns and
protocol anomalies within the network traffic. You can configure attack objects and groups as match
conditions in IPS policy rules.

The following download options are available in the signature database for the signature download:

• Delta Download–Downloads only the updates from the previously downloaded version.

• Full Download—Downloads the complete signature database; the downloadmight take a longer amount
of time.

All of the downloaded signatures are created in the system domain in read-only mode. The configurations
that are downloaded are also saved in the system domain.

Security Director sends the full signature database update if any one of the following scenarios is true:

• You install an older version of the signature files.

• The corresponding diff files do not exist.

• A signature file is added using the offline update.

You can perform an offline update of the signature database files by downloading the latest signature
version from https://services.netscreen.com/space/2/latest/latest-space-update.zip and storing it locally.
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You can configure the signature database settings to install the latest signature on to the device. Once
the latest signatures are available, you can use them to configure application services.

RELATED DOCUMENTATION

Using the Signature Database | 1367

Downloading the Signature Database Configuration | 1372

Uploading the Signature Database Configuration from a File System | 1373

Installing the Signature Database Configuration | 1370

Signature Database Main Page Fields

Use the signature databasemain page to get an overall, high-level view of your signature database settings.
You can filter and sort this information to get a better understanding of what you want to configure.
Table 403 on page 1369 describes the fields on this page.

Table 403: Signature Database Main Page Fields

DescriptionField

Active Database on Space

Version of signature database.Database Version

Date when the signature database was published.Publish Date

Job ID that you can use to update job details in the Job Management page.Update Job

Number of devices installed.Installed Device Count

Version number of the IPS protocol detector currently running on the device.Detectors

Install signature database configuration.Action

Displays the time set to download the signature database settings.Scheduled Download

Latest List of Signatures

Version of latest signature database.Database Version

Date when the signature database was published.Publish Date
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Table 403: Signature Database Main Page Fields (continued)

DescriptionField

Display list of updated signature details for the selected database.Update Summary

Version number of the IPS protocol detector currently running on the device.Detectors

• DeltaDownload–Download only the updates from the previously downloaded
signature database version.

• Full Download–Download the complete signature database; the download
might take a while to complete.

Action

Download History

Name of the user who downloaded the signature database.User Name

IP address of the user host where the download was done.User IP

Name of the task. For example, Download IPS/Application Signatures.Task Name

Time details when the signature database was downloaded.Timestamp

Successful or failed status of the signature database download.Result

Description of the download task.Description

RELATED DOCUMENTATION

Understanding Signature Databases | 1368

Using the Signature Database | 1367

Installing the Signature Database Configuration

Once the signature database is downloaded, you can install the active database.

Security Director sends the full signature database update if any one of the following scenarios is true:

• You install an older version of the signature files.

• The corresponding diff files do not exist.

• A signature file is added using the offline update.
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When you do not have an Internet connection to download the package, you can perform an offline update
of the signature database files by downloading the latest signature version from
https://services.netscreen.com/space/2/latest/latest-space-update.zip and storing it locally.

To install the signature database:

1. Select Administration > Signature Database.

2. Click Install Signatures.

The Install Configuration page appears.

3. You can view the summary of active signature databse version, which will be installed on your device.

4. Click the check box next to the devices on which you want to install the signature database.

You can select Full Probe or Delta Probe from Probe Devices or by right-clicking the selected device
to validate the intrusion prevention system (IPS) and application firewall licenses.

5. Enable Incremental Update to perform an incremental update or a full update of the signature database
for the selected device.

6. Select Run nowto set the signature database to automatically install immediately.

7. Select Schedule at a later time to set the signature database to automatically install at the specified
time and to take the following actions:

a. Choose a date by clicking the date picker icon.

b. Enter the time.

c. Select the time format from the drop-down menu.

8. Select the Recurrence check box to enable the schedule to recur in a given time interval.

9. Click OK.

The signature database configuration installation is complete.

RELATED DOCUMENTATION
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Downloading the Signature Database Configuration | 1372
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Uploading the Signature Database Configuration from a File System | 1373

Downloading the Signature Database Configuration

The following download options are available for the signature database configuration download:

• Delta Download–Downloads only the updates from the previously downloaded version.

• Full Download–Downloads the complete signature database; the download might take a longer amount
of time.

To download the signature database configuration:

1. Select Administration > Signature Database.

2. Click Download Configuration .

The Download Configuration page appears.

3. Enter the destination URL where you want to download the IPS and AppFw signature database in the
Download URL field. For example, https://services.netscreen.com.

4. Enable the Proxy Server field to send the download configuration traffic.

5. Select Run now to automatically download the signature database immediately.

6. Select Schedule at a later time to set the signature database to automatically download at the specified
time and to take the following actions:

a. Choose a date by clicking the date picker icon.

b. Enter the time.

c. Select the time format from the drop-down menu.

7. Select the Recurrence check box to enable the schedule to recur in a given time interval.

8. Click OK.

All the downloaded signatures are created in the System domain in read-only mode. The configuration
that are downloaded are also saved in the System domain.

RELATED DOCUMENTATION
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Uploading the Signature Database Configuration from a File System

You can upload the signature database if you do not have a latest version of the database updates. You
can get the lastest version of the database file at:
https://services.netscreen.com/space/2/latest/latest-space-update.zip.

To upload the signature database:

1. Select Administration> Signature Database.

2. Click Upload From File System.

3. Browse and select the attack bundle, which consists of the latest signature versions available at the
time.

4. Click Upload to upload the signature to Security Director.

Once the upload is completed, you can install the latest signature file version on to a device.

RELATED DOCUMENTATION
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Using the Signature Database | 1367

Downloading the Signature Database Configuration | 1372

Installing the Signature Database Configuration | 1370
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CHAPTER 120

License Management

IN THIS CHAPTER

About the License Notification Settings Page | 1374

Notification Settings | 1375

About the License Notification Settings Page

To access this page, click Administration > License Management > Notification Settings.

You can configure the polling schedule to poll the devices for license details. If youwant to send notification
regarding licenses that are about to expire, you can enable the license notification settings and add the
e-mail recipients. An e-mail will be sent to the configured recipient with license expiry details.

Tasks You Can Perform

You can perform the following tasks from this page:

• Schedule license polling. See “Notification Settings” on page 1375.

• Enable e-mail notification, create, edit, and delete e-mail setting. See “Notification Settings” on page 1375.

Field Descriptions

Table 404 on page 1374 provides guidelines on using the fields on the License Notification Settings page.

Table 404: Fields on the License Settings Page

DescriptionField

Polling Schedule

Specifies the schedule ID for polling the devices.Schedule ID

Specifies an option to poll devices for license details, that is daily, weekly, or
monthly.

Recurrence
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Table 404: Fields on the License Settings Page (continued)

DescriptionField

Specifies the polling interval.Schedule Day

Specifies the date and time of the polling.Start Time

Mail Notification

Specifies the e-mail ID of the recipient.Mail Recipient

Specifies the number of days before the license expiry when the notification
should be sent to the configured recipient.

Days left for expiry

RELATED DOCUMENTATION

License Management Overview | 421

Notification Settings | 1375

Notification Settings

IN THIS SECTION

Schedule License Polling | 1376

Enable License Notification Settings | 1376

Create E-mail Settings | 1377

You can configure a license polling schedule with daily, weekly, or monthly polling options to set how
frequently should the system check for the license expiration and send e-mail. By default, polling occurs
weekly once. Configure the e-mail IDs of the recipients to send e-mail notification. Youmust enable e-mail
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notification to notify the users. If the validity of the license is less than 30 days, an alert is generated with
the license expiry details on the Generated Alerts page inMonitor > Alerts & Alarms > Alerts.

Schedule License Polling

You can configure the schedule for polling devices for license details.

To schedule polling:

1. Select Administration > License Management > Notification Settings.

The License Settings page is displayed.

2. Click Schedule Poll.

The License Schedule Polling page is displayed.

3. Select whether you want to repeat the polling monthly or weekly.

4. Select the polling interval Daily, Weekly, or Monthly.

For weekly polling, select the day in the week. For monthly polling, select the day of the month when
the polling should occur.

5. Specify whether you want to run job immediately or schedule it for a later time.

Select Run now to run the job immediately or select Schedule at a later time and provide a suitable
date and time for the job to run.

6. Click Submit.

A job is created and you can view job status in the JobManagement page. If you cancel the jobmanually,
configured schedule for License Settings page remains the same. To trigger the job again, select Schedule
Poll and click Submit.

By default, a job is triggered with default configurations when Security Director is installed. Whenever
you modify the schedule, existing job is updated.

Enable License Notification Settings

To enable the license notification setting:

1. Select Administration > License Management > Notification Settings.

2. Enable the Mail Notification option.

A confirmation message is displayed for enabling the notification.
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You can view the list of e-mail recipients and notification interval. By default, the E-mail notification is
disabled.

Create E-mail Settings

To add the recipients to send e-mail notifications regarding the license expiry:

1. Select Administration > License Management > Notification Settings.

The License Settings page is displayed.

2. Click + icon.

The Create Mail Settings Page is displayed.

3. Enter the e-mail ID of the recipient and number of days before license expiry to send the e-mail
notification.

4. Click Submit.

You can see the added e-mail recipient in the License Settings page. You canmodify the existing details
of the e-mail recipient or delete it.

RELATED DOCUMENTATION

License Management Overview | 421
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CHAPTER 121

Migrating Content from NSM to Security Director

IN THIS CHAPTER

NSMMigration | 1378

NSMMigration

Starting in Junos Space Security Director Release 16.2, you can migrate firewall and NAT policies from
Network and Security Manager (NSM) to Security Director for a set of devices. All objects supported by
Security Director (addresses, services, address groups, service groups, and schedulers) can be imported
with the policy, with the exception of polymorphic objects. Rules referring to unsupported objects are
disabled after the migration. For example, if a firewall policy rule is configured with the VPN tunnel or if
a NAT pool is configured with a routing instance, such rules are disabled after the migration.

At any time, only a single migration from the NSM workflow can be triggered on Security Director.
Figure 185 on page 1379 shows the device import workflow.
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Figure 185: High-Level Device Import Workflow
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You can migrate policies from the NSM database (for the NSM Release 2010.3 to Release 2012.2) into
Security Director.

The following NSM features are supported during the migration:

• Firewall policies with global rules (including support for the global address book)

• NAT policies with support for the global address book

• Nested address group support (Junos OS Release 11.2 and later)

• Negate address group support in firewall rules

• Service offload support in firewall rules

• Source address or source port option in static NAT

• Source port option in source NAT
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NOTE: NSM to Security Director migration is not supported for ScreenOS devices.

Before You Begin

Migrating policies from NSM requires the NSM database to be exported in .xdiff format. You must copy
this file to your local machine and provide its path to migrate policies from NSM to Security Director.

To import policies from NSM:

1. Select Administration > NSMMigration.

The Migration From NSM page appears.

2. Click Launch.

The NSM Migration page appears.

3. Browse to the path where the .xdiff file is stored, and select the appropriate .xdiff file generated from
NSM. Click OK to import the .xdiff file to the Security Director server.

The Devices page appears showing the name of the available devices, the IP address of each device,
the Junos OS version of each device, the platform, the device family, and the domain.

4. Select the devices for which you want to import the policies, and click Next.

The Managed Services summary page appears. This page provides the following information.

• Policy name and type (firewall or NAT)

• Number of rules with errors or warnings

• Summary that includes:

• Number of IP addresses, services, or NAT pool objects

• Rules with unsupported objects

5. Select the policy that you want to import, and click Next.

The Conflict Resolution page appears showing a list of conflicts, if any. An object conflict occurs when
the name of the object to be imported matches an existing object, but the definition of the object does
not match.

Conflicting objects can be IP addresses, services, or NAT pool objects. You can take the following
actions for the conflicting objects:

• Rename object—Give the conflicting object a new name.
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• Overwrite with imported value—Overwrite the existing object with the new object.

• Keep existing object—Keep the existing object, and ignore the new object.

Once the initial naming conflict has been resolved, the object conflict resolution checks for further
conflicts with the new name and definition until resolution is complete.

NOTE: If Security Director finds further conflicts, the Conflict Resolution page is refreshed
to display the new conflicts.

6. After all object conflicts are resolved, click Finish.

After the import is complete, a comprehensive report for each policy imported is available. You can
download the summary report from your browser to your local machine. The summary report is saved
as SummaryReport.zip.

7. Go to the Firewall Policy or NAT Policy workspace to view the imported policies. Security Director
creates a group policy without associating any devices with it. You can continue to import policy objects
for all other devices. All imported device policies will show up as group policies in Security Director.
You can perform all normal firewall or NAT policy functions on these imported policies.

NOTE:
• If a group has more than 300 rules, Security Director automatically breaks the group into
multiple rule groups, each containing 400 rules. The only exception is that these groups are
placed last in the list of groups. The size of the last group is calculated by the upper threshold
of 300 rules and lower threshold of 100 rules.

• _DE is affixed to the device specific policies name by Security Director. You cannot directly
assign device specific policies to a group policy. Assign devices to the device specific policies
first, and then assign those devices to the group policies.

• _PRE is affixed to the group policy names that are added before the device specific policies
and _POST is affixed to the group policy names that are added after the device specific policies.

Release History Table

DescriptionRelease

Starting in Junos Space Security Director Release 16.2, you can migrate firewall and NAT
policies from Network and Security Manager (NSM) to Security Director for a set of devices.

16.2
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CHAPTER 122

Policy Sync Settings

IN THIS CHAPTER

About the Policy Sync Settings Page | 1382

Out-of-Band Changes Overview | 1384

About the Policy Sync Settings Page

To access this page, click Administration > Policy Sync Settings.

Starting in Junos Space Security Director Release 19.2R1, use the Policy Sync Settings page to automatically
synchronize out-of-band firewall policy changes from a device to Security Director. The device must be
discovered by Security Director. The out-of-band configuration changes are changes youmake to a device
configuration through any method other than deploying the configuration change from Security Director.
By default, the automatic synchronization is disabled.

This page is displayed only in the global domain and applicable for only device-specific firewall policies.
Out-of-band firewall policy changes are applicable for both standard firewall and unified firewall policies.

Starting in Junos Space Security Director Release 19.4R1, you can import or reject out-of-band changes
for an IPS policy from a device to Security Director manually or automatically. For devices running Junos
OS Release 18.2 and later, you can synchronize the changes from standard or unified firewall policies page.
For devices with Junos OS Release 18.1 and earlier, you can synchronize the IPS policy changes from the
IPS Policies page.

Starting in Junos Space Security Director Release 20.1R1, you can import or reject out-of-band changes
for a NAT policy from a device to Security Director manually or automatically.

When a device is discovered in Security Director, the Managed Status is displayed as Managed in the
Security Devices page. For automatic synchronization of out-of-band policy changes, the managed status
of the device must be SD Changed, Device Changed, or In Sync. You must update the device atleast once
from Security Director. In case of logical systems (LSYS) or tenant systems (TSYS), root device may show
the status as Device Changed if a policy is assigned to it. Update the root device so that the status is In
Sync.
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NOTE:
• The out-of-band changes are not supported if more than one policy is assigned to a device or
if rules are configured in All Devices Policy Pre/Post policies.

• The out-of-band changes does not support synchronization of duplicate rule-sets in a NAT
policy.

Tasks You Can Perform

You can perform the following tasks from this page:

• Enable automatic synchronization of out-of-band firewall, IPS, and NAT policy changes in the device.

• Choose an option to automatically accept or reject the out-of-band firewall, IPS, andNAT policy changes.

Field Descriptions

“Policy Sync Settings” on page 1382 provides guidelines on using the fields on the Policy Sync Settings page.

Table 405: Fields on the Policy Sync Settings Page

DescriptionField

By default, the automatic synchronization of out-of-band
firewall, IPS, and NAT policy changes is disabled. Enable
this option to automatically synchronize out-of-band
firewall and IPS policy changes from a device to Security
Director.

When automatic synchronization of out-of-band policy
changes is disabled, you can import the out-of-band
changes from a device manually.

After you synchronize the policy changes, the policy shows
that you’ll need to republish the policy. A dummy publish
and update has to be performed in order to set the
managed status as In sync.

The custom rule group in a policy is not supported. If the
policy has a custom rule group, then the custom rule group
is deleted after synchronizing the policy and all the rules
are grouped inside device-specific or predefined rule
groups.

Auto Sync Policy Changes
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Table 405: Fields on the Policy Sync Settings Page (continued)

DescriptionField

The policy “source of truth” is where the device is
synchronized to Security Director. All device side out of
sync changes are rejected to match Security Director.

• Select Security Director to automatically reject all
out-of-band firewall, IPS, and NAT policy changes from
a device to Security Director.

• Select Device to automatically synchronize all
out-of-band firewall, IPS, and NAT policy changes from
a device to Security Director. Select Firewall Policy, IPS
Policy, or NAT policy.

This triggers Auto Policy Sync job in the Job
Management page. After the job is successful, the
out-of-band changes are synchronized from the device
to Security Director.

Before synchronizing the out-of-band changes
automatically, Security Director automatically takes
snapshot of the policy so that you can revert/rollback
to older version of the policy. To roll back a policy
version, see “Create and Manage Policy Versions” on
page 454.

Policy Source of Truth

RELATED DOCUMENTATION

Out-of-Band Changes Overview | 1384

Viewing and Synchronizing Out-of-Band Firewall Policy Changes Manually | 468

Viewing and Synchronizing Out-of-Band IPS Policy Changes Manually | 662

Viewing and Synchronizing Out-of-Band NAT Policy Changes Manually | 730

Viewing the Details of a Job in Security Director | 181

Out-of-Band Changes Overview

Out-of-band configuration changes are the changes you make to a device configuration through any
method other than deploying the configuration change from Security Director.

Out-of-band changes include configuration changes made by:
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• Using the device CLI

• Using the device Web-based management interface (J-Web interface)

When you make out-of-band changes, Security Director detects the configuration changes on the device.
It sets the device configuration state to Out of Sync because the device configuration does not match with
the build mode configuration for the device. You cannot deploy configuration on devices that are in the
Out of Sync state. To return the device configuration state to In Sync, click Resynchronize with Network.
This task resynchronizes the device’s configuration stored in Security Director to match the device
configuration.

After the configuration status of the device is In Sync, you can see an icon next to policy for which out of
band policy changes have been made in the device. You can automatically or manually synchronize the
out-of-band firewall, IPS, and NAT policy changes from a device. Automatic synchronization is applicable
for only device-specific policies and manual synchronization is applicable for both device-specific and
group policies.

Starting in Junos Space Security Director Release 19.4R1, you can import or reject out-of-band changes
for an IPS policy from a device to Security Director manually or automatically. For devices running Junos
OS Release 18.2 and later, you can synchronize the IPS policy changes from standard firewall policies or
unified firewall policies page. For devices running Junos OS Release 18.1 and earlier, you can synchronize
the IPS policy changes from the IPS Policies page.

Starting in Junos Space Security Director Release 20.1R1, you can import or reject out-of-band changes
for a NAT policy from a device to Security Director manually or automatically.

NOTE: If Space as System of Record (SSOR) is enabled, then the device out-of-band changes
should be resolved from the Junos Space UI for Security Director out-of-band changes to work.

Benefits

• Device and Security Director always synchronized—You can use our new Auto Sync Policy Changes
setting in Administration > Policy Sync Settings page to automatically synchronize the out-of-band
device-specific firewall and IPS policy changes made on the device with Security Director. You can also
manually synchronize the out-of-band changes.

• Better control over configuration changes—You can now view a list of all out-of-band changes made on
amanaged device. You can accept or reject the changes to synchronize the device with Security Director.

RELATED DOCUMENTATION
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About the Policy Sync Settings Page | 1382

Viewing and Synchronizing Out-of-Band Firewall Policy Changes Manually | 468

Viewing and Synchronizing Out-of-Band IPS Policy Changes Manually | 662

Viewing and Synchronizing Out-of-Band NAT Policy Changes Manually | 730

Resynchronizing Managed Devices with the Network in Security Director | 219
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CHAPTER 123

Insights Management

IN THIS CHAPTER

Add Insights Nodes | 1387

About the Alerts Settings Page | 1390

Create a New Alert Setting | 1392

Configure System Settings | 1394

About the Identity Settings Page | 1395

Add JIMS Configuration | 1396

Edit and Delete an Identity Setting | 1397

Configure Mitigation Settings | 1399

About the Threat Intelligence Page | 1400

Configure Threat Intelligence Source | 1402

Edit and Delete Threat Intelligence Source | 1403

About the ServiceNow Configuration Page | 1404

About the Backup & Restore Page | 1405

Create a Backup File and Restore the Configuration | 1406

Download and Delete a Backup File | 1407

Add Insights Nodes

Use Security Director Insights to automate security operations and take effective actions on security
events logged by Juniper Networks Security products. It connects disparate security tools for seamless
security operations and incident response. It ingests logs from SRX Series devices and other security
vendors to correlate and provide automated enrichment to identify the threats.

Security Director Insights is a single virtual appliance (Service VM) that runs on the VMware vSphere
infrastructure. You must configure Security Director Insights as nodes for Security Director to discover
the Security Director Insights virtual machine (VM).

You can deploy Security Director Insights as a single node or two nodes (primary and secondary) with high
availability (HA).
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To configure a standalone or primary (active) node:

1. Select Security Director > Administration >Insights Management > Insights Nodes.

The Insights Nodes page appears.

2. Complete the configuration according to the guidelines provided in Table 406 on page 1388.

3. Click Save.

If the details provided are valid, the Security Director Insights node is added successfully. Click Reset
to remove the node.

Table 406: Add Insights Nodes

GuidelinesSetting

Enter the IP address of the Security Director Insights VM. (This is the IP address you
configured during the Security Director Insights VM installation).

IP Address

The username to access the VM is always admin. You cannot modify this field.Username

Enter the password to access the SecurityDirector Insights VM. (This is the same password
you use to log in to the VM CLI with your admin credentials).

Password

To configure the secondary (standby) node details:

1. Select the Enable HA option.

The HA Setup page appears.

2. Complete the configuration according to the guidelines provided in Table 407 on page 1389.

3. Click Save & Enable.

The Insights Nodes page appears. It shows the status of the secondary node activation.

4. Click Refresh Data to check the status of the secondary node configuration.

After the configuration is successful, you see the respective IP addresses appearing in the
Data/Management Virtual IP and Monitoring Virtual IP columns.

NOTE: Keep clicking the Refresh Data option until you see that the secondary node is
configured successfully and all the other errors disappear, if any.
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Table 407: Configure HA Setup

GuidelinesSetting

Secondary Node Details

Enter the IP address of the secondary (standby) node.Secondary system IP

The username to access the virtual machine is always ‘admin’. You cannot
modify this field.

Username

Enter your SSH password to access the secondary node. (This is the same
password you use to log in to the VM CLI with your admin credentials.)

Password

HA Settings

Enter the virtual IP address for data traffic between primary (active) and
secondary (standby) nodes.

Data Virtual IP/Netmask

Enter the virtual IP address for HA monitoring traffic between active and
standby nodes.

HA monitor Virtual IP/Netmask

(Optional) Enter a list of IP addresses for ping tests.Ping IPs

NOTE: To enable HA, the IP addresses on Security Director Insights must be static.

In the Node Status section, you can see the complete configuration details of the primary (active) and
secondary (standby) nodes.

You can take the following actions:

• Stop standby—In the Standby section, click Stop to temporarily stop HA service on a standby node to
perform maintenance tasks.

• Start standby—In the Standby section, click Start to restart the HA service, if it is stopped.

• Rebuild standby—To rebuild out-of-sync data on the standby node, click Rebuild.

• Failover—To manually shut down the HA service on the active node, so that the standby node becomes
the active node, click Failover in the Active section. The virtual IP address will be reassigned to the new
active node. You can use the Failover option to perform any maintenance tasks on the active node. You
must click Start to restart the HA services.

Table 408 on page 1390 shows more details of each Security Director Insights node in the Insights Node
page.
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Table 408: Insights Node Details

DescriptionField Name

Specifies the hostname of the node.Hostname

Specifies the data traffic IP address of the node.Data Traffic IP

Specifies the HA monitoring IP address of the node.HA Monitor IP

Specifies the CPU usage of the node.CPU Usage

Specifies the memory usage of the node.Memory Usage

Specifies whether the node is online or offline.Online

Specifies whether the node is primary (active) or secondary (standby).Role

Specifies the health of the node.Status

RELATED DOCUMENTATION

Security Director Insights Overview | 17

About the Alerts Settings Page

To access this page, select Security Director > Administration > Insights Management > Alert Settings.

The configurations we do from the Alert Settings page are for system-audit and system-health checks. On
this page, you can configure alert settings, so that when the system state reaches a certain threshold, an
alert is generated and you are notified.

Tasks You Can Perform

You can perform the following tasks from this page:

• Create new alert settings. See “Create a New Alert Setting” on page 1392.

• Display, delete, or edit an existing alert configuration.
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Field Descriptions

Table 409 on page 1391 describes the fields on the Alert Settings page.

Table 409: Fields on the Alert Settings Page

DescriptionField

Provides details about the alert settings, such as alert type, event type, report format,
and date range.

Description

Specifies whether an alert is generated based on a trigger or by schedule.Delivery

For each generated alert, you can take different actions such as, display the alert, edit
the alert setting, or delete the alert.

Actions

Display, Delete, or Edit an Existing Alert

To display, delete, or edit an existing alert configuration:

• Select Display to view the details of an alert in HTML or PDF format. You can configure the format.

• Select Edit and then Save to modify the alert configuration. You can, for example, change details of the
system audit and system health alert settings.

• Select Delete and then Save to delete the current settings of an alert.

RELATED DOCUMENTATION

Create a New Alert Setting | 1392
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Create a New Alert Setting

You can configure alert settings to generate alerts based on system health or data in the system audit
records. You can configure event types to include in the alert notification, date range, whether to notify
all users or only the current user, alerts related to the overall health of the system, when there was a data
retention, and so on. You can generate an alert immediately or schedule the alert generation for a later
day and time. The generated report is sent to the recipient’s e-mail ID in HTML or PDF format.

To create an alert setting:

1. Select Administration > Insights Management > Alert Settings.

The Alerts Settings page appears.

2. Click Create.

The Create New Alert Setting page appears.

3. Complete the configuration according to the guidelines provided in Table 410 on page 1392.

4. Click Save.

A new alert setting is created and displayed on the Alerts Settings page.

Table 410: Create New Alert Setting

GuidelineSetting

Select the type of alert notification to be configured: System Audit or System Health.Type

System Audit Alert Settings

Select the event types to include in the alert notification:

• Login/Logout—Generate an alert when a user logs in to or logs out of the system.

• Add/Update Users—Generate an alert when a new user is added or an existing user’s
details are updated.

• System Settings—Generate alerts when there are changes to the system settings.

• Restarts—Generate an alert when the system is restarted.

• Remote Support—Generate an alert when a user has sought remote support to address
any issues.

Event Type

Select whether to send the alert notification to all users or only to the current user.Users

To filter the report notification by time period, select one of the following options: Last
Day, Last Week, Last Month, Last Year

Date Range
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Table 410: Create New Alert Setting (continued)

GuidelineSetting

Enter the number of rows of results to include in the alert notification (default is 25).Max Num Results

Select HTML or PDF as the notification output format.Format

Select Trigger to generate an alert immediately.

Select By Schedule to schedule the alert generation on a specified day and time. For time,
use the format 00:00 am or pm.

Generate On

Enter a valid e-mail address of the recipient. You can enter more than one e-mail ID.
Separate e-mail IDs with commas.

Recipient’s Email

System Health Alert Settings

For system health alerts, select eitherOverall Healthmetrics,Data Retention, orHAAlerts.

For data retention, youwill receive alerts when the device reaches 80% capacity. Youmust
delete old data to store the incoming data.

Health

Select HTML or PDF as the notification output format.Format

Select Trigger to generate an alert immediately.

Select By Schedule to schedule the alert generation on a specified day and time. For time,
use the format 00:00 am or pm.

NOTE: For HA alerts, you can only trigger an alert. You cannot schedule the alert
generation.

Generate On

Enter a valid e-mail address of the recipient. You can enter more than one e-mail ID.
Separate e-mail IDs with commas.

Recipient’s Email

RELATED DOCUMENTATION

About the Alerts Settings Page | 1390

Add Insights Nodes | 1387
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Configure System Settings

Use the System Settings page to configure or revise outgoing e-mail notification settings. You can also
test the current outgoingmail configuration. E-mail notifications are generated for alert settings configured
on the Alert Settings page. Ensure that the Security Director Insights node connectivity is working fine.
E-mail messages are sent from the Security Director Insights VM.

To configure outgoing e-mail settings:

1. Select Administration> Insights Management> System Settings.

The System Settings page appears.

2. In theOutgoing Email Settings section, complete the configuration according to the guidelines provided
in Table 411 on page 1394.

Table 411: Configure Outgoing E-mail Settings

GuidelineSetting

Enter the IP address of the enterprise mail host.SMTP Host

Enter the SMTP port number (default is 587).

You can add Gmail. Most of the other e-mail providers use port 465 for SSL.

SMTP Port

This option is enabled by default. You can use Secure Sockets Layer (SSL) for further
protection.

Deselect the option to disable the use of SSL.

Use SSL

Enter the username that you want to use for authentication.SMTP Login

Enter an SMTP password for the login account.SMTP Password

Enter the e-mail address of the sender; the default is noreply@juniper.net.From Address

On the Administration > InsightsManagement > System Settings page, in the Test Outgoing Email Settings
section, you can test the current outgoing mail configuration.

To test an outgoing e-mail setting:

1. Enter an e-mail address (or series of e-mail addresses, separated by commas) to which the test e-mail
will be sent by Security Director Insights.
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2. Click Test to test your e-mail notification configuration. An e-mail will be sent by Security Director
Insights to the e-mail address(es) entered, based on the configuration settings.

The format of the test e-mail is This e-mail is a confirmation that your Insights Central Manager ( VM
name) is correctly configured. This email was sent on Fri, 09 Oct 2020 at 22:02:02 +0000 to
abc@xxx.com. For further information, please visit https://support.juniper.net.

NOTE: This test verifies the ability to send an e-mail. It does not test the validity of the e-mail
address.

RELATED DOCUMENTATION

Add Insights Nodes | 1387

About the Identity Settings Page

To access this page, select Administration > Insights Management > Identity Settings.

Security Director Insights interfaces with Juniper Identity Management Service (JIMS) to map endpoint
IP addresses in events and logs to usernames and hostnames. You can configure JIMS to provide access
information to Security Director Insights.

Tasks You Can Perform

You can perform the following tasks from the Identity Settings page:

• Add a JIMS configuration. See “Add JIMS Configuration” on page 1396.

• Delete or edit an existing JIMS configuration. See “Edit and Delete an Identity Setting” on page 1397.

• Select Test to test the JIMS configuration. You can verify the configuration and check whether the
Security Director Insights VM can communicate with JIMS successfully.

Field Descriptions

Table 412 on page 1396 provides guidelines to use the fields on the Identity Settings page.
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Table 412: Fields on the Identity Settings Page

DescriptionField

Specifies details about the JIMS configuration.Details

For each JIMS configuration, you can take different actions such as editing or deleting
the JIMS configuration.

Actions

RELATED DOCUMENTATION

Add JIMS Configuration | 1396

Edit and Delete an Identity Setting | 1397

Add JIMS Configuration

Use the Add JIMS Configuration page to configure a JIMS profile to obtain user identities. Ensure that you
have added the IP address of Security Director Insights in the JIMS server.

To add a JIMS configuration:

1. Select Administration> Insights Management> Identity Settings.

The Identity Settings page appears.

2. Click Create.

The Add JIMS Configuration page appears.

3. Complete the configuration according to the guidelines provided in Table 413 on page 1396.

4. Click Save.

A new JIMS configuration is added to Security Director Insights and listed on the Identity Settings page.

Table 413: Add JIMS Configuration

GuidelineSetting

Enter a valid IPv4 or IPv6 address or the hostname of the JIMS server.JIMSEndpointHostname/IP

Select the connection port of the JIMS server from the list. The range is 1 to 65,535.JIMS Port Number
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Table 413: Add JIMS Configuration (continued)

GuidelineSetting

Select an SSL setting: Enabled or Disabled.SSL

Select an identity source to collect data from: Active Directory, Syslog, or both.Identity Sources

Reverse DNS lookup converts an IP address to hostname to identify the domain name
of the source. Choose to enable or disable the Use Reverse DNS setting. This option
is enabled by default.

Use Reverse DNS

You can disallow identity mapping for certain hosts. Enter the hostnames separated
by commas. Identity mappings for these hosts are ignored and not included in event
handling and displays.

Exclude hostnames

Enter the Open Authorization (OAuth) client ID that the Security Director Insights
provides to the JIMS server as part of its authentication. Security Director Insights must
authenticate itself with the JIMS server to obtain an access token that allows it to query
the JIMS server for user identity information.

The client ID must be consistent with the API client configured on JIMS.

OAuth Client ID

Enter the client secret that Security Director Insights provides to the JIMS server as
part of its authentication. The client secret must be consistent with the API client
configured on JIMS.

OAuth Client Secret

RELATED DOCUMENTATION

About the Identity Settings Page | 1395

Edit and Delete an Identity Setting | 1397

Edit and Delete an Identity Setting

IN THIS SECTION

Edit a JIMS Configuration | 1398

Delete a JIMS Configuration | 1398
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You can edit and delete a JIMS configuration from the Identity Settings page.

Edit a JIMS Configuration

To edit a JIMS configuration:

1. Select Administration>Insights Management>Identity Settings.

The Identity Settings page appears.

2. Select the JIMS configuration that you want to modify, and click the Edit icon.

The Edit JIMS Configuration page appears, displaying the same fields that were presented when you
added the JIMS configuration.

3. Modify the JIMS configuration fields.

4. Click Save to save your changes.

You are taken to the Identity Settings page. A confirmation message appears, indicating the status of
the edit operation.

Delete a JIMS Configuration

To delete a JIMS configuration:

1. Select Administration>Insights Management>Identity Settings.

The Identity Settings page appears.

2. Select the JIMS configuration that you want to delete, and click the Delete icon.

An alert message appears, asking you to confirm the delete operation.

3. Click Yes to delete the selected JIMS configuration.

A confirmation message appears, indicating the status of the delete operation.

RELATED DOCUMENTATION

About the Identity Settings Page | 1395

Add JIMS Configuration | 1396
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Configure Mitigation Settings

In response to an incident, you can either isolate or quarantine an infected endpoint based on its IP address
and block the threat source IP address. This prevents you from downloading files that are known to be
harmful or suspicious. Mitigation is performed by either Security Director Policy Enforcer or Juniper
Advanced Threat Prevention Cloud (ATP Cloud).

To configure mitigation settings:

1. Select Administration>Insights Management>Mitigation Settings.

The Mitigation Settings page appears.

2. Complete the configuration according to the guidelines provided in Table 414 on page 1399.

3. Click Save.

The mitigation settings are saved and enabled.

Table 414: Configure Mitigation Settings

GuidelineSetting

ATP Cloud

Add an application token to allow Security Director Insights or OpenAPI users to
securely access ATP Cloud APIs over HTTPS.

Application Token

Enter an endpoint URL for the infected host (OpenAPI) and blocklisted API (Gophro).Open API (Infected hosts) URL

Enter the Threat Intelligence OpenAPI URL to program the ATP Cloud
command-and-control (C&C) server feeds.

Open API (Threat Intelligence)
URL

Enter the blocklist feed name. Security Director Insights sends the source IP addresses
to the blocklist feed with the specified feed name. You cannot modify the feed name
after it is configured.

Blocklist Feed Name

Policy Enforcer

Enter the hostname of the Policy Enforcer VM. (This is the hostname you configured
during the installation of the Policy Enforcer VM.)

To configure Policy Enforcer running on SecurityDirector Insights, enter the hostname
or IP address of the Security Director Insights VM.

Hostname
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Table 414: Configure Mitigation Settings (continued)

GuidelineSetting

Enter root as the username of the Policy Enforcer VM (for the standalone Policy
Enforcer). For the integrated Policy Enforcer running on Security Director Insights,
the 'admin' username is already prepopulated.

SSH Username

Enter the root password of the Policy Enforcer VM (for the standalone Policy
Enforcer). For the integrated Policy Enforcer running on Security Director Insights,
enter the password of the Security Director Insights CLI administrator.

SSH Password

Enter the username of the Policy Enforcer controller API.API Username

Enter the password of the Policy Enforcer controller API.API Password

Ensure that you have configured the blocklist custom feed under Configure > Threat
Prevention > Feed Sources > Create Custom Feed.

Blocklist Feed Name

Ensure that you have configured the infected host custom feed under Configure >
Threat Prevention > Feed Sources > Create Custom Feed.

Infected Host Feed Name

Click Test to verify the configuration. Also, you have an option to disable the already enabled mitigation
setting.

RELATED DOCUMENTATION

How to Monitor Mitigation | 175

About the Threat Intelligence Page

To access this page, select Administration > Insights Management > Threat Intelligence.

Look up your trusted threat intelligence providers for indicators of compromise to confirm themaliciousness
of the reported event. Indicators of compromise include IP addresses, URLs, and file hash observed in the
log data. What is considered malicious is based on available knowledge about the threat intelligence
provider’s output.
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Security Director Insights supports the following threat intelligence sources:

DataSource

IP lookup and file hashIBM X-Force

File hash and URL lookupVirusTotal

File hash, URL lookup, and IP lookupOpswat

Tasks You Can Perform

You can perform the following tasks from the Threat Intelligence page:

• Configure a threat intelligence source. See “Configure Threat Intelligence Source” on page 1402.

• Edit and delete an existing threat intelligence source. See “Edit and Delete Threat Intelligence Source”
on page 1403.

• Click Test to test the validity of the API key and check whether the Security Director VM can reach a
threat intelligence source.

Field Descriptions

Table 415 on page 1401 provides guidelines on using the fields on the Threat Intelligence page.

Table 415: Fields on the Threat Intelligence Page

DescriptionField

Specifies the threat intelligence source.Source

Specifies the corresponding API details configured for the threat intelligence source.Description

RELATED DOCUMENTATION
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Configure Threat Intelligence Source

Configure the threat intelligence providers for IP address, URL, file hash to confirm the maliciousness of
the reported event.

To configure the threat intelligence source:

1. Select Administration > Insights Management > Threat Intelligence.

The Threat Intelligence page appears.

2. Click the plus icon (+).

The Create Configuration page appears.

3. Complete the configuration according to the guidelines provided in Table 416 on page 1402.

4. Click OK.

A new threat intelligence source is configured and listed on the Threat Intelligence page.

Table 416: Configure Threat Intelligence Source

GuidelineSetting

Select the threat intelligence providers from the list. The supported threat intelligence
providers are IBM X-Force, VirusTotal, and OPSWAT Metadefender.

Source Name

Enter a valid API key to look up the threat intelligence provider’s APIs.

• VirusTotal API Key

• OPSWAT API Key

• IBM X-Force API Key

API Key

Enter a password, if you using IBM X-Force, to look up the threat intelligence provider’s
APIs.

API Password

RELATED DOCUMENTATION
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Edit and Delete Threat Intelligence Source

IN THIS SECTION

Edit a Threat Intelligence Source | 1403

Delete a Threat Intelligence Source | 1403

You can edit and delete the threat intelligence providers from the Threat Intelligence page.

Edit a Threat Intelligence Source

To edit a threat intelligence source configuration:

1. Select Administration > Insights Management > Threat Intelligence.

The Threat Intelligence page appears.

2. Select the threat intelligence source that you want to modify, and click the Edit icon (pencil).

The Modify Configuration page appears, displaying the same fields that were presented when you
configured the threat intelligence sources.

3. Modify the configuration fields as needed.

4. Click Save to save your changes.

You are taken to the Threat Intelligence page. A confirmation message appears, indicating the status
of the edit operation.

Delete a Threat Intelligence Source

To delete a threat intelligence source:

1. Select Administration>Insights Management>Threat Intelligence.

The Threat Intelligence page appears.

2. Select the threat intelligence source that you want to delete and click the Delete icon.

An alert message appears, asking you to confirm the delete operation.
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3. Click Yes to delete the selected threat intelligence source.

A confirmation message appears, indicating the status of the delete operation.

RELATED DOCUMENTATION
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About the ServiceNow Configuration Page

To access this page, select Administration > Insights Management > ServiceNow Configuration.

You can configure your ServiceNow account to create tickets for incidents.

Tasks You Can Perform

You can perform the following tasks from the ServiceNow Configuration page:

• Configure your ServiceNow account.

• Reset the already configured ServiceNow account details.

Field Descriptions

Table 417 on page 1404 provides guidelines on using the fields on the ServiceNow Configuration page.

Table 417: Fields on the ServiceNow Configuration Page

DescriptionField

Specify the URL of your ServiceNow account.

Ensure that you have provided the correct URL. For example,
https://example.service-now.com/.

ServiceNow Instance URL

Specify the username to access the ServiceNow instance URL.Username

Specify the password to access the ServiceNow instance URL.Password

After you configure the ServiceNow account successfully, you can start creating ServiceNow tickets for
any incident on the Monitor > Insights > Incidents page. Expand an incident and click Create Ticket.
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About the Backup & Restore Page

To access this page, select Administration > Insights Management > Backup & Restore.

You can back up different configurations of Security Director Insights (not the data collected by Insights)
and restore the configuration from the existing backup configuration files.

The configuration backup includes the configurations for Security Director Insights and Log Collector, but
not for Policy Enforcer. You can restore the backup configuration settings to any Security Director Insights
and Log Collector systems running the same version. There is no dependency on the data containedwithin
Security Director.

Tasks You Can Perform

You can perform the following tasks from the Backup and Restore page:

• Create a new backup. See “Create a Backup File and Restore the Configuration” on page 1406.

• Restore the configuration from a backed up configuration of Insights.

• Download and delete the backup configuration. See “Download andDelete a Backup File” on page 1407.

• View the last restoration status. It is shown in the right-hand side of the page.

Field Descriptions

Table 418 on page 1405 provides guidelines on using the fields on the Backup & Restore page.

Table 418: Fields on the Backup and Restore Page

DescriptionField

Specifies the filename of the backup configuration file.File Name

Specifies the size of the backup file.Size

Specifies the date and time when the backup was last taken.Date

Specifies the backup software version of Security Director Insights.Software Version
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You can create a new backup of the current configuration (not the data collected by Insights) from the
Backup and Restore page. You can restore the configuration from an existing backup or select a configuration
file from your local storage.

Create a New Backup File

To create a new backup file:

1. Select Administration > Insights Management > Backup & Restore.

The Backup & Restore page appears.

2. Click the plus icon (+).

The BACKUP page appears.

3. Click OK.

Backup is initiated and you are taken to the Backup & Restore page. After the backup is complete, the
backup filename and additional details are listed.

NOTE: You can backup only the configuration. The configuration backup includes the
configurations for Security Director Insights and Log Collector, but not for Policy Enforcer.
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Restore a Configuration

To restore a configuration:

1. Select Administration > Insights Management > Backup & Restore.

The Backup & Restore page appears. You can restore the configuration from an existing backup or
select a file from your local storage.

2. To restore the configuration from an existing backup, select the backup file listed on the Backup &
Restore page and click the Restore icon (clock).

OR

To restore the configuration from a file in your local storage, click the clock icon.

The RESTORE page appears. Click Browse and select the configuration file from your local storage.

3. Click OK.

NOTE: During restoration, all services are temporarily stopped. You can restore the backup
configuration settings to any Security Director Insights and Log Collector systems running the
same version. There is no dependency on the data contained within Security Director.
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Download and Delete a Backup File
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You can download a backup file to your local system. You can also delete a backup file.

Download a Backup File

To download a backup to your local system:

1. Select Administration > Insights Management > Backup & Restore.

The Backup & Restore page appears.

2. Select the backup file that you want to download and click the download icon.

The backup file is downloaded to your local system as a ZIP file.

Delete a Backup File

To delete a backup file:

1. Select Administration > Insights Management > Backup & Restore.

The Backup & Restore page appears.

2. Select the backup file that you want to delete and click the delete icon.

An alert message appears, asking you to confirm the delete operation.

3. Click Yes to delete the selected backup file.

A confirmation message appears, indicating the status of the delete operation.

RELATED DOCUMENTATION
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